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SolarWinds Account Management
Last Modified on 30 March 2022

SolarWinds Customer Portal
As of version 2021.8, you must use the SolarWinds Customer Portal to manage your account and product
licenses.

Log in with your SolarWinds account credentials or Register for an account.

Additional Information: For more information about the updated product licensing, see the SQL
Sentry, Database Mapper, and Task Factory licensing articles.

SolarWinds Self-Service Options
Once you are logged into the SolarWinds Customer Portal, you have a several important self-service options
available, including:
1. License and renewal information and management options are on the left.
2. The Technical Support option on the top menu provides a link to Open a Support Case.
3. Links to product downloads and release notes are available in the center.
4. Your open support cases appear below the product downloads section.
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SolarWinds Customer Portal

 Note: For SQL Sentry licensing, you can use the Add Note feature to keep track of the license keys
installed on your server installations.

Add Note
Add Note window
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 Note: The View Details option displays more information about license key activation, including the
computer name used for activation.

View Details

Activation Details

SolarWinds Product Downloads
On the Product Downloads view, select your products and licenses from the drop-down menus to get the
links for your products. In the example below, there are multiple downloads for the different installation and
upgrade options for SQL Sentry (e.g. Unified Setup vs. Enhanced Platform Installer).

SQL Sentry product download options
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my.sentryone.com
Deprecated: As of version 2021.8, you must use the SolarWinds Customer Portal to manage your
account and product licenses.
The my.sentryone.com page described below is only for SentryOne branded products before version
2021.8.

SentryOne Account
Go to my.sentryone.com to log into your account, create a new account, or get help with a forgotten
password.

How do I edit my SentryOne account information?
Select Edit Account Info from the Welcome banner.

The Edit Account Profile screen lets you update your name, contact address, email address, and password
information.

SentryOne Products
Where do I download SentryOne installation files?
11

The Downloads section contains links to download all the latest versions of products applicable to your
account.

 Note: If you want to use the Enhanced Platform Installer (EPI) version of SQL Sentry, see the EPI
article and SQL Sentry Enhanced Platform Installer table of downloads.

How do I get the AWS Marketplace and Azure Marketplace images for SentryOne?
Select the AWS Marketplace VM or Azure Marketplace VM link from the Resources menu on the sidebar.

SentryOne Licensing
Where can I view my SentryOne licensing information?
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On the Licenses sidebar box, there are options for Perpetual Licenses, Evaluations, and Subscriptions.
Select the applicable category, then select the license key to get additional information.

Example of a license for LHP75-1118 to monitor 10 targets with SQL Sentry

How do I add subscriptions to my SentryOne account?
Select Subscriptions from the Licenses sidebar box. You will need to contact the SentryOne sales team if
your account is not set up for subscription-based licensing.

How do I update the server name on a SentryOne license key for SQL Sentry?
Select the applicable license key from the Licenses sidebar box, then:
1. Go to the Update Server Name section and enter the new Friendly Name and Server Name for the
license key. You may optionally enter a reason for requesting this change.
2. Select the Update button.
3. Select Email Key or Copy Key to Clipboard to get a copy of the license key text.

Additional Information: See The Hardware Key and Applying a New License sections of the License
Management article for additional instructions on using the new license key.
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How do I manually activate a license for SentryOne Task Factory, SentryOne Document, or
Workbench products?
This option is needed for machines that do not have internet access to automatically activate a license during
product setup.
1. For SentryOne Document, Task Factory, SentryOne Test, BI xPress, DBA xPress, DOC xPress, LegiTest,
DTS xChange, and Pragmatic Workbench products, go to the S1 TaskFactory/Workbench Licenses
section.
2. Select the applicable Activation Key from the table. This opens the Manage License screen.
3. Go to the Manually Activate License section.
4. Enter the Environment Identifier and Environment Key for the license you are activating.
5. Select the Manually Activate License button.

How do I manage SentryOne license contacts?
1. For SentryOne Document, Task Factory, SentryOne Test, BI xPress, DBA xPress, DOC xPress, LegiTest,
DTS xChange, and Pragmatic Workbench products, go to the S1 TaskFactory/Workbench Licenses
section.
2. Select the applicable Activation Key from the table. This opens the Manage License screen.

3. On the Manage License view, select View Contacts.
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From the Contact Details view, you can add or remove contacts.
1. To add a new contact, select Add Contact from the Contact Details view.

2. On the Add Contact form, enter the Name and Email information, then select Add.

 Important: For Database Mapper (previously known as SentryOne Document), you must add
users as contacts to the license in addition to adding them as users to Organization Settings. The
Name and Email must match what is entered in Organization Settings.

How do I view license activation history for SentryOne Task Factory, SentryOne Document, or
Workbench products?
1. For SentryOne Document, Task Factory, SentryOne Test, BI xPress, DBA xPress, DOC xPress, LegiTest,
DTS xChange, and Pragmatic Workbench products, go to the S1 TaskFactory/Workbench Licenses
section.
2. Select the applicable Activation Key from the table. This opens the Manage License screen.
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3. Select View Activations from the Manage License screen. This displays the Environment Key, Date
Last Activated, and Environment Identifier information.
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SQL Sentry Installation Recommendations
Last Modified on 11 November 2021

Where to Install the SQL Sentry Components
The SQL Sentry client, monitoring service, and database are typically installed as follows:
The SQL Sentry database is installed on a SQL Server instance on your network.
The SQL Sentry client is installed on your workstation computer(s) with network connectivity to the SQL
Sentry database.
The SQL Sentry monitoring service is a Windows service and is installed on a dedicated server or VM with
network connectivity to the SQL Sentry database server and monitored targets.
For monitoring cloud targets, the SQL Sentry monitoring service may be installed either onpremises, or on a Windows virtual machine (IaaS) in the respective cloud platform.
The SQL Sentry portal service is part of the optional SQL Sentry Portal feature that may be installed. It
can be installed on a machine along with the SQL Sentry monitoring service and SQL Sentry client, or it
can be installed on a machine by itself without any other SQL Sentry components (recommended).
If you are using the EPI version of SQL Sentry, then it must be installed on a machine that has the
SQL Sentry controller service.

 Note: Installing the SQL Sentry database on Azure SQL Database Managed Instance is supported.

The SQL Sentry clients and monitoring services are each configured to connect to the same SQL Sentry
database during setup.

 Important: The SQL Sentry database must be installed on a SQL Server 2014 or higher instance. Azure
SQL Database is not supported for the SQL Sentry database. For more information, see the System
Requirements section.

Use Fast Storage for the SQL Sentry Database
High disk latency (>5ms per read IO avg, >1-2ms per write IO avg) can limit scalability and cause sluggishness
with the SQL Sentry client. The greater the number of monitored targets, the more data is collected and
stored in the SQL Sentry database, and the more fast storage becomes important. Modern flash or hybrid
storage systems should be used for maximum scalability and performance.
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Monitor the SQL Sentry Database (FREE)
You should always monitor the SQL Sentry database with SQL Sentry to ensure there are no CPU, memory, or
disk bottlenecks. A free license is included in every SQL Sentry installation for this purpose. Simply add the
SQL Server as a monitored target.

Install Components on the Same Network
Install the SQL Sentry client, monitoring service, and database on the same network for the best
performance. For example, if the SQL Sentry client or monitoring service connect to a SQL Sentry database
over a slow wide area network link or VPN over the internet, performance may suffer.
If a slow connection from your workstation to the SQL Sentry database is unavoidable, it is recommended to
install the SQL Sentry client on a “jump box” on the same network as the database, and access it via RDP or
another remote desktop technology.

Installing the SQL Sentry Monitoring Service and Database on the Same
Computer
For smaller environments, you may want to install a monitoring service on the same SQL Server machine
where the SQL Sentry database is located. Doing so minimizes network overhead for communications
between the monitoring service and the database. However, bear in mind that they will share the same
compute resources which may cause CPU contention. For more information, see System Requirements.

Installing Multiple SQL Sentry Clients and Monitoring Services
Depending on the size of your SQL Server environment, you may need to install multiple SQL Sentry clients
and monitoring services. Typically, each DBA has the SQL Sentry client installed on their workstation, and
enough monitoring services are installed to handle the monitored target load (see examples below).

 Note: There are two different options for installing SQL Sentry. The Enhanced Platform Installer
option increases the speed and simplicity of installing and upgrading SQL Sentry implementations
through a command line interface and is recommended for larger estates that will have more than one
monitoring service or client.

Installing SQL Sentry on Azure
In Azure, all the SQL Sentry components can be co-located on one IaaS VM or—to support larger numbers of
monitored targets—must be set up on multiple VMs. As noted above, the SQL Sentry database may also be
hosted on Azure SQL DB Managed Instance.
Consumption may increase if there are multiple sites (which we recommend mirroring to Azure Regions) and
require redundancy in each site. In cases where redundancy is required, we recommend an N+1 approach with
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monitoring service VMs as described in the implementation examples (below). If you want to have a cluster
for the SQL Sentry database for redundancy, that will also increase consumption.
In the SQL Sentry database implementation examples (below), the storage setup on the database is for two
disks. One OS disk at 32 GB, and one data disk at an additional size dependent on workload. Unless workload
demands moving TempDB to its own persistent disk, use the temp local disk.

Additional Information:
For the SQL Sentry database, you can constrain the CPU count on the deployed system to reduce
license cost for SQL Server. See the Azure Constrained vCPU Capable VM Sizes article from
Microsoft for details.
The storage estimates in the implementation examples (below) are simplified to request one
managed disk of the size needed for data, but additional throughput and performance can be
obtained by using multiple smaller disks as necessary. See the Performance Guidelines for SQL
Server in Azure Virtual Machines article from Microsoft for more information.
For more information about Azure consumption costs, please see the Azure Pricing Calculator from
Microsoft.

Apply the SQL Sentry Scalability Pack for more than 250 Targets
The SQL Sentry Scalability Pack implements partitioned clustered columnstore indexing, In-memory OLTP,
and additional optimizations to achieve maximum scalability and performance, with reduced CPU, memory,
and disk requirements. Contact us at support.sentryone.com to schedule pack installation, which is free of
charge. For more details, see the SentryOne & Microsoft Achieve SQL Server Monitoring Performance Goals
blog post.

Clustering SQL Sentry Monitoring Services
Multiple monitoring services can be installed to handle more than 100 monitored targets, and/or to provide
automatic redundancy and load balancing. There is no configuration required to implement a basic SQL Sentry
cluster.

 Note: Install more than one monitoring service and connect each to the same SQL Sentry database
during setup. They automatically distribute the monitoring load, and if one monitoring service fails, the
remaining monitoring service(s) picks up the load automatically. For more information, see the Load
Balancing and Fault Tolerance article.

Increased Fault Tolerance for the SQL Sentry Database
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If increased fault tolerance is required for the SQL Sentry database, install the database on a clustered SQL
Server instance.

 Note: Log shipping can also be used with the SQL Sentry database; however a separate SQL Sentry
license is required for the standby server. Customers can obtain this standby license by visiting our
Customer Portal and modifying the server name of their current license key to the name of the standby
server and applying this license key to the SQL Sentry database on the standby server.

 Note: You can also host the SQL Sentry database on an Availability group. For more information
about Hosting the SQL Sentry database on an Availability group, see the Hosting SQL Sentry Database
on an Availability group article.

 Important: Due to performance considerations, we do not support Synchronous-commit mode for
the Availability Group hosting the SQL Sentry database when monitoring over 200 targets or over high
latency network links.
We recommend using Asynchronous-commit mode in this scenario.
See the following blogs from Microsoft for more information on this topic:
Analyze Synchronous Commit Impact on High Commit Rate Workloads
AlwaysOn Asynchronous vs Synchronous Commit Performance for SharePoint

Implementation Examples - Estimates Only
Monitoring Services and Targets per Site
Number of Monitoring Services

Maximum Number of Monitored Targets Range

1

40–100

2

80–200

3

120–300

5

200–500
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Number of Monitoring Services

Maximum Number of Monitored Targets Range

10

400–1000

Each monitoring service requires a dedicated Windows server or VM with these minimum hardware
specifications:

CPU

RAM

Azure VM

EC2 Class

4 cores 2.0+
GHz

12 GB

Standard_D4_v3 (4 cores (2.0+ GHz), 16
GB RAM)
Standard SSD, E4: 32 GiB, single disk

m5.xlarge
c5.2xlarge

 Note: If monitoring and alerting redundancy is required, more than one monitoring service should be
installed in each site. When multiple monitoring services are installed in a site, use an n+1 approach to
ensure that if a service fails, the remaining services will be able to handle the monitoring load.

 Important: The actual number of services needed to optimally monitor an environment is heavily
dependent on several factors such as:
The number of databases on each target
The number of disks on each target
The workload on each target
Geographical placement of datacenters
The number of domains and the trust between those domains
SQL Sentry has settings to limit the maximum number of disks, databases, database files, and indexes to
collect for each target, and these can be easily adjusted as needed. The SolarWinds support team
(support.sentryone.com) will work with you to ensure optimal configuration and performance.

SQL Sentry Database Server
Number of
Targets

Minimum Specs

Recommended Specs
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Number of
Targets

5

Minimum Specs

Recommended Specs

CPU

4 cores 1.6GHz

CPU

6 cores 2.0+GHz

Memory

8 GB RAM

Memory

12 GB RAM

Storage

10 GB

Storage

15 GB

EC2 Class

db.m5.xlarge
db.m4.xlarge

EC2 Class

db.m5.2xlarge
db.m4.2xlarge

Azure VM

Standard_D4s_v3
P4: 32 GiB (OS)
P4: 32 GiB (Data)

Azure VM

Standard_D4s_v3
P4: 32 GiB (OS)
P4: 32 GiB (Data)

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 4 vCores
Provisioned
memory: 8 GB

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 8 vCores
Provisioned
memory: 12 GB
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Number of
Targets

10

Minimum Specs

Recommended Specs

CPU

6 cores 1.6GHz

CPU

8 cores 2.0+GHz

Memory

12 GB RAM

Memory

16 GB RAM

Storage

20 GB

Storage

30 GB

EC2 Class

db.m5.2xlarge
db.m4.2xlarge

EC2 Class

db.m5.2xlarge
db.m4.2xlarge

Azure VM

Standard_D4s_v3
P4: 32 GiB (OS)
P6: 64 GiB (Data)

Azure VM

Standard_D4s_v3
P4: 32 GiB (OS)
P6: 64 GiB (Data)

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 8 vCores
Provisioned
memory: 12 GB

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 8 vCores
Provisioned
memory: 16 GB
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Number of
Targets

Minimum Specs

Recommended Specs

CPU

8 cores 1.6GHz

CPU

8 cores 2.0+GHz

Memory

20 GB RAM

Memory

32 GB RAM

Storage

50 GB

Storage

75 GB

EC2 Class

db.m5.2xlarge
db.m4.2xlarge

EC2 Class

db.m5.2xlarge
db.m4.2xlarge

Azure VM

Standard_D8s_v3
P4: 32 GiB (OS)
P10: 128 GiB (Data)

Azure VM

Standard_D8s_v3
P4: 32 GiB (OS)
P10: 128 GiB (Data)

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 8 vCores
Provisioned
memory: 20 GB

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 8 vCores
Provisioned
memory: 32 GB
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24

Number of
Targets

Minimum Specs

Recommended Specs

CPU

8 cores 1.6GHz

CPU

8 cores 2.0+GHz

Memory

24 GB RAM

Memory

32 GB RAM

Storage

100 GB

Storage

150 GB

EC2 Class

db.m3.2xlarge
db.m4.2xlarge
db.t2.2xlarge

EC2 Class

db.m5.2xlarge
db.m2.4xlarge

Azure VM

Standard_D8s_v3
P4: 32 GiB (OS)
P15: 256 GiB (Data)

Azure VM

Standard_D8s_v3
P4: 32 GiB (OS)
P15: 256 GiB (Data)

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 8 vCores
Provisioned
memory: 24 GB

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 8 vCores
Provisioned
memory: 32 GB

50
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Number of
Targets

100

Minimum Specs

Recommended Specs

CPU

8 cores 1.6GHz

Memory

48 GB RAM

Storage

200 GB

EC2 Class

db.r3.2xlarge
db.m2.4xlarge

Azure VM

Standard_E16s_v3
P4: 32 GiB (OS)
P15: 256 GiB (Data)

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 8 vCores
Provisioned
memory: 48 GB

CPU

12 cores 2.0+GHz

Memory

64 GB RAM

Storage

300 GB

EC2 Class

db.r4.4xlarge
db.r3.4xlarge

Azure VM

Standard_E16s_v3
P4: 32 GiB (OS)
P15: 256 GiB (Data)

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 16 vCores
Provisioned
memory: 64 GB
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Number of
Targets

200

Minimum Specs

Recommended Specs

CPU

12 cores 2.0+GHz

CPU

16 cores 2.0+GHz

Memory

96 GB RAM

Memory

128 GB RAM

Storage

400 GB

Storage

600 GB

EC2 Class

db.r4.4xlarge
db.r3.4xlarge

EC2 Class

Azure VM

Standard_E16s_v3
P4: 32 GiB (OS)
P20: 512 GiB (Data)

Azure VM

Standard_E16s_v3
P4: 32 GiB (OS)
P20: 512 GiB (Data)

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 16 vCores
Provisioned
memory: 96 GB

Azure SQL
Managed
Instance

vCore model:
General Purpose
Compute hardware:
Gen5
Provisioned
compute: 16 vCores
Provisioned
memory: 128 GB

db.r5.4xlarge
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Number of
Targets

500*

Minimum Specs

Recommended Specs

CPU

16 cores 2.0+GHz

CPU

20 cores 2.0+GHz

Memory

96 GB RAM

Memory

128 GB RAM

Storage

400 GB

Storage

600 GB

EC2 Class

db.r4.4xlarge
db.r3.4xlarge

EC2 Class

Azure VM

Standard_E20s_v3
P4: 32 GiB (OS)
P20: 512 GiB (Data)

Azure VM

Standard_E20s_v3
P4: 32 GiB (OS)
P20: 512 GiB (Data)

Azure SQL
Managed
Instance

vCore model:
Business Class
Compute hardware:
Gen5
Provisioned
compute: 16 vCores
Provisioned
memory: 96 GB

Azure SQL
Managed
Instance

vCore model:
Business Class
Compute hardware:
Gen5
Provisioned
compute: 24 vCores
Provisioned
memory: 128 GB

db.r3.8xlarge
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Number of
Targets

Minimum Specs

Recommended Specs

CPU

20 cores 2.0+GHz

CPU

24 cores 2.0+GHz

Memory

192 GB RAM

Memory

256 GB RAM

Storage

800 GB

Storage

1.2 TB

EC2 Class

db.r4.8xlarge

EC2 Class

db.r4.16xlarge

Azure VM

Standard_E32s_v3
P4: 32 GiB (OS)
P20: 1 TiB (Data)

Azure VM

Standard_E32s_v3
P4: 32 GiB (OS)
P20: 1 TiB (Data)

Azure SQL
Managed
Instance

vCore model:
Business Class
Compute hardware:
Gen5
Provisioned
compute: 24 vCores
Provisioned
memory: 192 GB

Azure SQL
Managed
Instance

vCore model:
Business Class
Compute hardware:
Gen5
Provisioned
compute: 24 vCores
Provisioned
memory: 256 GB

1000*

 Important: *Requires the SQL Sentry Scalability Pack. When using Azure SQL Managed Instance, the
Scalability Pack requires Business Class for the vCore model.

 Note: The EC2 DB Instance Class Types, Azure VMs, and Azure SQL Managed Instance
recommendations are provided as examples. Please see:
The AWS DB Instance Class documentation for the latest EC2 types and specifications available
vCore model overview - Azure SQL Database and Azure SQL Managed Instance for the latest Azure
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VM and Azure SQL Managed Instance offerings available

 Important: When running the SQL SentryDatabase server on VMware, adjustments may need to be
made to the recommendations listed above to ensure that the VM is properly rightsized and vNUMAaligned. Failure to do so can result in subpar performance.
Additional Information: Please see the following blog post, Virtual Machine vCPU and vNUMA
Rightsizing – Rules of Thumb for more information.

The estimates provided are based on the default configuration of SQL Sentry. The hardware and resources
needed by the SQL Sentry database to handle a monitored environment is heavily dependent on factors such
as:
The query workload
Retention settings
Collection interval settings

Additional Information: For more information see the Performance Analysis Data Capacity Planning
article.
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SQL Sentry System Requirements
Last Modified on 12 November 2021

SQL Sentry Components
For information about the SQL Sentry components, see the SQL Sentry Components and Architecture article.
The Installation Recommendations article provides details on where to install each component, as well as
detailed implementation examples for installations of various sizes.

 Important: For performance reasons, it's not recommended that the SQL Sentry client, monitoring
service, or SQL Server (including the instance housing the SQL Sentry database) run simultaneously on
the same computer.

SQL Sentry Client Machine
Windows version from supported list below
Microsoft .NET 4.7.1 (included in the setup package)
Microsoft .NET 4.7.2 is supported and recommended
Minimum single 1.6 GHz CPU, 1 GB RAM

SQL Sentry Monitoring Service Machine
Windows version from supported list below
Microsoft .NET 4.7.1 (included in the setup package)
Microsoft .NET 4.7.2 is supported and recommended
Minimum 4 cores 2.0+ GHz and 12 GB RAM
 Important: These are the minimum requirements for a standard 5 target installation. Review
the Installation Recommendations article for detailed guidance on requirements.

 Note: The Microsoft .NET 4.7.1 (included in the setup package) involves a system restart.

SQL Sentry Database Machine
 Important: SQL Sentry version 2021.12 or newer does not support hosting the SQL Sentry Database
on SQL Server 2012 (Standard, BI, and Enterprise) .
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SQL Server 2014 (Standard, BI, and Enterprise)
SQL Server 2016 (Standard, BI, and Enterprise)
SQL Server 2017 (Standard, Linux OS, and Enterprise)
SQL Server 2019 (Standard, Linux OS, and Enterprise)
Azure SQL Database Managed Instance
Supported versions of SQL Server running on AWS RDS for SQL Server
Minimum 4 cores 1.6 GHz, 8 GB RAM, and 10 GB storage
 Important: These are the minimum requirements for a standard 5 target installation. Review
the Installation Recommendations article for detailed guidance on requirements.

 Note: SQL Sentry no longer supports hosting the SQL Sentry database on SQL Server 2008 and SQL
Server 2008 R2.

 Note: Azure SQL Database isn't currently supported as a host for the SQL Sentry database.

 Note: SQL Server Express Edition may be used to host the SQL Sentry database. The scale limits
placed on this edition make it suitable for smaller environments where only a few targets are being
monitored. Having an unusually high number of databases or disks to monitor on your targets may mean
reaching these limitations with only a few targets.

SQL Sentry Portal Service Machine
Installing the SQL Sentry Portal is optional. Review the SQL Sentry Portal Configuration article for additional
requirements, including security.
64-bit Microsoft Windows Server 2012 or greater
Microsoft .NET Core 3.1 Runtime
Install the Runtime and Hosting Bundle if you are hosting in IIS
Microsoft .NET Framework 4.8 Runtime

 Note: Both Microsoft .NET Runtime prerequisites need to be installed on the Windows Server
that will host SQL Sentry Portal.
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Supported Operating Systems (SQL Sentry Components)
Supported Operating Systems (x64)
Windows Server 2012
Windows Server 2012 R2
Windows Server 2016
Windows Server 2019
Windows 8.1
Windows 10 (Anniversary update, Creators update, or Fall creators update)

 Note: For more information, see .NET Framework system requirements for additional details on 4.7.1
requirements. Windows server 2008 is no longer supported.

Watched Targets and Instances
 Important: SQL Sentry version 2021.12 or newer does not support Windows Server 2008, Windows
Server 2008R2, Windows XP, Windows Vista, Windows 7, or Windows 8 targets or instances.

Watched (monitored) Windows Targets
Windows Server 2012
Windows Server 2012 R2
Windows Server 2016
Windows Server 2019*
Windows 10

 Important: *Windows Server 2019 may have some issues honoring firewall rules. You may need to
explicitly enable a Remote Event Log Management rule in the firewall to watch a Windows Server 2019
target.

Watched Data Warehouse Targets
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Microsoft analytics platform system (AU3)
Azure SQL Data Warehouse

Watched (monitored) SQL Server Instances
 Important: SQL Sentry version 2021.12 or newer does not support SQL Server 2005, SQL Server
2008, or SQL Server 2008R2 instances.

SQL Server 2012
SQL Server 2014
SQL Server 2016
SQL Server 2017
SQL Server 2019

Additional Information: See the SQL Sentry for SQL Server on Linux page for details on monitoring
SQL Server on Red Hat Enterprise Linux, SUSE Linux Enterprise Server, and Ubuntu.

Watched (monitored) SQL Server Analysis Services, Tabular and Multidimensional Modes
 Important: SQL Sentry version 2021.12 or newer does not support SQL Server 2005, SQL Server
2008, or SQL Server 2008R2 targets.

SQL Server 2012
SQL Server 2014
SQL Server 2016
SQL Server 2017
SQL Server 2019

Watched (monitored) Azure SQL Server Instances
Azure SQL Database V12 or higher
All service tiers
Azure SQL Database Managed Instance
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 Note: When monitoring a Windows cluster with Performance Analysis for Windows, it's
recommended to monitor cluster nodes individually.

Watched (monitored) Amazon Web Services (AWS) Instances
Amazon Relational Database Service (RDS) for SQL Server Instance
Amazon Elastic Compute Cloud (Amazon EC2) Instance

Features with Additional Requirements
SQL Sentry Portal has additional requirements as outlined in the SQL Sentry Portal Configuration article.
Storage Forecasting requires a SQL Sentry database on SQL Server 2016 or later with R/ML Services inDatabase enabled for Advanced Disk Forecasting. There are no additional requirements for Standard
Disk Forecasting.
 Important: For Advanced Disk Forecasting, you must turn on the external scripts enabled
option in SQL Server for the instance hosting the SQL Sentry database. See the External Scripts
Enabled server configuration option article in Microsoft Docs for instructions on setting that
option. The SQL Server Launchpad service must also be running before using Advanced Disk
Forecasting. See the SQL Server Launchpad service configuration article from Microsoft Docs for
more information. If these were not in place, you should restart the SQL Sentry client after setting
them and then select the Advanced Disk Forecasting mode.
Deadlock tab and associated data in Performance Analysis for SQL Server is available on SQL 2005 and
higher.
Execution plan collection requires SQL 2005 SP2 or higher.
Monitoring analysis services with Performance Analysis requires SQL Server 2005 or higher.
Indexes tab and Fragmentation manager require SQL Server 2005 or higher.
Monitoring the Windows event log with Performance Analysis for Windows is only supported for
Windows vista or higher.
Hyper-V virtualization is supported for Hyper-V v2 (included with Windows Server 2012).
Monitoring VMware hosts requires vCenter 5.5, vCenter 6, and vCenter 6.5 to get vCenter-related
metrics.
vCenter 6.5 is only supported by SQL Sentry in v11.2 or higher.
Monitoring Azure SQL database targets requires access to the SQL endpoint (over outbound port 1433)
with the appropriate Azure SQL firewall rules created.
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 Note: Windows Vista introduced Task scheduler 2.0. Task scheduler 2.0 is backwards compatible with
Task scheduler 1.0; however, Task Scheduler 1.0 isn't forwards compatible with Task Scheduler 2.0. To
watch or synchronize Task scheduler 2.0 instances, you must have a SQL Sentry monitoring service and
SQL Sentry client running Windows Vista or higher. Windows 8 and Windows 2012 also introduced
changes to Task scheduler. In order to watch or synchronize Windows 8 and Windows server 2012
targets, you must have a SQL Sentry monitoring service and SQL Sentry client running Windows 8 or
Windows 2012.

 Warning: We do not support Synchronous-commit mode for the Availability Group hosting the SQL
Sentry database in large or high latency network environments. See the Recommendations article for
more information.
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Installing SQL Sentry
Last Modified on 25 May 2021

Download
Purchase or download a trial of SQL Sentry.

Prerequisites
1. Review the Installation Recommendations article to determine where you should install the product
components and how many monitoring services you will need.
2. Ensure that your system meets all System Requirements for installation and using additional features.
Have questions about security requirements and options? Check out the Security Overview article.

Installation
Each article includes instructions for the full product installation, SQL Sentry Portal, additional monitoring
services, or additional clients (i.e. how to install only the client on workstation computers/laptops).
1. Choose an installation method:
Option 1: Original SQL Sentry Installation for smaller environments (i.e. estates with a single
monitoring service or client) and those who do not need a command line experience for
streamlining the installation or upgrade processes.
Option 2: SQL Sentry Enhanced Platform Installer increases the speed and simplicity of installing
and upgrading SQL Sentry implementations through a command line interface and is
recommended for larger estates that will have more than one monitoring service or client.
2. Once you've installed SQL Sentry, follow the Onboarding instructions for a step-by-step guide to
completing the wizard and configuring your SQL Sentry environment, including adding your first target.
You'll be asked to apply your license during onboarding. See the License Management article for
help with applying and managing licenses.

 Note: If you need additional help with getting your SQL Sentry installation up-and-running,
please reach out to our support team through: support.sentryone.com. Our friendly and
knowledgeable team is here to guide you!

What's Next?
1. After onboarding is complete, you may want to monitor additional targets, or jump into using
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Performance Analysis, setting up alerts, discovering top SQL queries, or using the calendar view.
2. Interested in setting up SQL Sentry Portal on-premises for browser-based access to your SQL Sentry
data? See the Portal Configuration article to enable access.
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Upgrading SQL Sentry
Last Modified on 01 December 2021

Notes
 Important:
A major version upgrade requires a license upgrade. See the Product Version Mismatch section of
the License Management article for more information.
Review the System Requirements before upgrading. The latest version may require a newer version
of Microsoft .NET, which could require restarts during the upgrade process.
All SQL Sentry components, including the SQL Sentry database, monitoring service(s), and client(s)
must be on the same build to work.
Versions prior to 10 must be step upgraded to 10.1.81 before upgrading to the latest release. If you
have version 10.1.81+ you may upgrade directly to the latest version. Please contact the SolarWinds
support team to get the older version.

EPI
 Note: SQL Sentry offers an Enhanced Platform Installer which allows for the automation of upgrades
and deployments of the SQL Sentry platform with a command line interface experience. To use the EPI
upgrade method, see the EPI Upgrade article

Upgrade Process
 Note: This process uses the SolarWinds Customer Portal to manage your account and product
licenses. The my.sentryone.com customer portal is only for SentryOne branded products before version
2021.8.

To upgrade your current version of SQL Sentry, complete the following steps:
1. Log into the Customer Portal.
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2. Select the Downloads section, and then download the appropriate installation file.
3. Close all connections to the SQL Sentry database.  Note: This includes client(s) and monitoring
service(s).
4. Back up your existing SQL Sentry database.
5. Run the new version's installation file on the main SQL Sentry server (the server housing the SQL Sentry
monitoring service). This upgrades the SQL Sentry database, local monitoring service, and local client.
For more information about installing SQL Sentry, see the Installation topic.
6. Run the new version's installation file on all other servers running additional monitoring services. Once
the monitoring service has been upgraded, it can be started and begin monitoring.
7. Run the new version's installation file on any computer with the client installed.

 Success: You have successfully installed the newest version of SQL Sentry for your environment!

New Version Available
Stay up to date with the latest versions of SQL Sentry software. The SQL Sentry client notifies you when a
software update is available with a message on the status bar.

 Note: The client must have internet access for the version check to work.
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Uninstalling SQL Sentry
Last Modified on 25 May 2021

Uninstall SQL Sentry through the Control Panel in Windows. Before uninstalling, please consider contacting
the SolarWinds Support team with questions or concerns.
To uninstall SQL Sentry (a monitoring service or client), do the following:
1. Open the Windows Control Panel.
2. Search for SolarWinds.
3. Select SolarWinds SQL Sentry.
4. Select Uninstall.

5. Follow the prompts to complete the uninstall process.

 Note:
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When you uninstall a SQL Sentry client or monitoring service, the associated program files are
removed.
User preferences stored in the registry are not deleted.
The SQL Sentry database is not deleted.

 Important: The .NET Framework files will not be removed when uninstalling SQL Sentry. Use
Add/Remove Programs in the Control Panel to remove .NET Framework files.

Removing Watched Server Objects
 Important: Please see the Removing Watched Server Objects article for scripts to remove the
watched server objects from the target(s) after uninstalling SQL Sentry.

 Note: When you watch events on a SQL Server, SQL Sentry places a few objects in the msdb
database that facilitate its lightweight polling architecture. No agents are placed on the server. This
enables SQL Sentry to monitor the server with performance overhead that's typically less than SQL
Agent. For more information about watched server objects, see the Watched Server Objects topic.
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SQL Sentry Enhanced Platform Installer
Last Modified on 05 April 2022

SolarWinds Note
Starting with version 2021.8, SentryOne SQL Sentry is now SolarWinds SQL Sentry. While logos and names
have rebranded, you can expect to see things like SentryOne Framework in the SolarWinds version when
using EPI. The latest EPI version of SQL Sentry is available from the SolarWinds Customer Portal. Certain
components like service provider names may also reflect the SentryOne name. See the SQL Sentry
Components and Architecture article for more details.

Introduction
EPI increases the speed and simplicity of installing and upgrading SQL Sentry implementations with multiple
monitoring services or clients, and avoids having to manually run through the original installer on every
machine. It allows the automation of upgrades and deployments of the SQL Sentry platform with a command
line interface experience. EPI minimizes the downtime required to update the monitoring solution by
removing the need to manually shut down monitoring services or close client connections.

Example of SQL Sentry Installer Command Line Interface

Getting Started
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 Warning: The Monitoring Service Account must be a member of the local machines administrator
group to complete the EPI installation. If the Monitoring Service Account is not a part of the local
machines administrator group, the EPI installation will stop and notify you of this requirement. Once the
EPI installation has completed, you can remove the Monitoring Service Account from the local machines
administrator group.

Version Availability & Components
To get started with EPI (available in v19.1.1), all installed SQL Sentry components ( database, monitoring
service, and client) must have the EPI version of SQL Sentry installed, and the SQL Sentry controller service
(EPI bootstrapper) must exist on all machines where a monitoring service or client is installed. If you are
installing SQL Sentry for the first time, or have removed all SQL Sentry components from your environment,
follow the installation instructions in the Install section. If you would like to upgrade an existing SQL Sentry
installation to use EPI, follow the Option 2. First EPI Upgrade steps in the Upgrade section.

 Note:
To use the original installation method, see the SQL Sentry Installation article. This original
installation option is recommended for smaller environments (i.e. estates with a single monitoring
service or client) and those who do not need a command line experience for streamlining the
installation or upgrade processes.

Run as Administrator
Command Prompt must use the Run as administrator option for all commands.

Case-Sensitivity
The parameters used in commands are case-sensitive.
This means that --connectionserver will not work for --connectionServer.

Parameters & Examples
The instructions include commands with placeholders for parameters specific to your SQL Sentry
environment. This section describes all of the placeholders used in the EPI instructions.
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For example, you will use the following command to register a new connection:
so addreg -n --connectionServer --connectionDatabase

When you run it with your parameter values, it might look like this:
so addreg -n SentryOneUS --connectionServer SentryOneHost --connectionDatabase SentryOne

Parameter

Description
Used with -n. The friendly name for this connection which appears
on the SQL Sentry Database Connection Management screen
(formerly called Repository Connection Management). The labeled
with a 1 in the image below, which has SentryOneUS displayed.
 Important: The name itself is arbitrary, but once you pick
one, you must stick with it for all EPI commands associated
with this connection.

<connectionName>

Example of where the parameters are used in the connection window

 Note: If you need to see your existing connections using EPI,
you can use the listreg command to see the , , and as described in
the EPI Commands article.
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Parameter

Description
Used with --connectionServer. The name of the server hosting the
SQL Sentry database or where you will install the SQL Sentry
database. This is labeled with a 2 in the image above, which has
SentryOneHost as the value.
 Note: You may use localhost, if applicable.

<serverName>
 Note: When working with a named instance, the parameter
format is serverName\instanceName.
 Note: When the SQL Sentry database is part of an availability
group, it is recommended to use the availability group listener
name instead of the SQL Server name.

<databaseName>

<SQLServerUserName>

Used with --connectionDatabase. The name of the SQL Sentry
database that will be created or updated. This is labeled with a 3 in
the image above which has SentryOne as the value.
Used with --connectionUsername in the command examples when
using SQL Server authentication. The SQL Server authentication
user name.
 Note: This is only needed when using SQL Server
authentication.
Used with --connectionPassword in the command examples when
using SQL Server authentication. The SQL Server authentication
password associated with the SQL Server user name.

<SQLServerUserPassword>

 Warning: Passwords cannot start with a dash. There is no
workaround for this.
 Note: This is only needed when using SQL Server
authentication.
Used with --connectionPort. The SQL Server connection port. The
default port is 1433.

<SQLServerConnectionPort>

 Note: This is only needed when specifying a different
parameter value for the port number. See the Connecting article
for more information about the SQL Server Connection Port.
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Parameter

Description
Used with -u. The account used to run the SQL Sentry monitoring
service.
The following command is equivalent to completing the Service
Account Information screen as shown below.
so install --IAcceptLicenseTerms -n -u

<serviceAccount>

Service Account Information screen

 Warning: Passwords cannot start with a dash. There is no
workaround for this.
See the Monitoring Service Security article for additional
information on service account requirements.
 Important: When using EPI, the monitoring service account
must be a member of the local administrator group. This is
not required for monitoring, but is required during EPI
installations and upgrades.
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Parameter

Description
Used with -p. The password associated with the service account.
The service password will be masked in the command line
interface. This is the recommended method for entering your
password.

Example of masked password.

If you want the password displayed, use the
serviceAccount as shown below:

-p

after the

so install --IAcceptLicenseTerms -n -u -p

<servicePassword>

 Note: The -p flag is only recommended for use when scripting
out commands.
 Warning: Passwords cannot start with a dash. There is no
workaround for this.

 Important: See the Password section in the EPI Commands
article for information on using non-alphanumeric (i.e. special)
characters such as spaces or quotes with the -p flag.
The command will stop, and monitoring and controller service
installations will fail if these characters are not properly
formatted with quotes and the backslash escape character.

<packageVersion>

Used with -t. The SQL Sentry version to which you are upgrading
(i.e. 19.2.2).

<packagePath>

Used with -f. The file path where the SQL Sentry upgrade package
is located.

<portalServerFQDN>

Used with --server (-s). The server that will host the SQL Sentry
Portal service. It must be the Fully Qualified Domain Name (FQDN)
of the server.

Install via EPI
Requirements
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Before installing SQL Sentry, review the following articles:
Installation Recommendations
System Requirements
Components & Architecture
Complete the following steps to install SQL Sentry for the first time. There should be no existing SQL
Sentry components on the machines where you complete this install. This process walks you through
creating the SQL Sentry database, installing the monitoring service, and launching the client. The .NET
Framework 4.7.2 is installed during this process, which may force a reboot.

 Note:
Review the Parameters & Examples section for more information about the used in the following
commands.
If you experience any Result = Timeout messages while a command is running, refer to the
Advanced section for more information. This does not mean the operation timed out.

 Important: See the Password section of the EPI Commands article for information on using nonalphanumeric (i.e. special) characters such as spaces or quotes with the -p flag.
The command will stop, and monitoring and controller service installations will fail if these characters are
not properly formatted with quotes and the backslash escape character.

Install SQL Sentry
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Deprecated: For versions prior to 2021.8 only, go to my.sentryone.com to download the Enhanced
Platform Installer version of SQL Sentry. If you are on an older version, use this SentryOneSetup.exe
the same way as the SolarWinds-SQLSentry-EPI-{Version}.exe file referenced in the instructions below.

Example: Download the Enhanced Platform Installer product from my.sentryone.com to get SentryOneSetup.exe

Go to the SolarWinds Customer Portal and download the Enhanced Platform Installer version of SQL Sentry.
It will have a file naming convention of SolarWinds-SQLSentry-EPI-{Version}.exe.
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Example: Download the full Enhanced Platform Installer version of SQL Sentry

1. On the machine that will serve as the monitoring service, double-click SolarWinds-SQLSentry-EPI{Version}.exe.

 Note: The files are unpacked to C:\Program Files\SentryOne Framework by default and that
directory is used in the examples below. If needed, change the Destination Folder during SentryOne
Setup and use that directory to run commands.

2. Run Command Prompt as Administrator and change the directory to SentryOne Framework:
cd c:\Program Files\SentryOne Framework

3. Add a new connection for the server that will host the SQL Sentry database:
Using Integrated Windows Authentication
so addreg -n --connectionServer --connectionDatabase

Using SQL Server Authentication
so addreg -n --connectionServer --connectionDatabase --connectionUseIntegrated false --connectionUsername -connectionPassword --connectionPort

See the Security topic for more information about security requirements.
4. Use the following command to verify connection registration details:
so listreg

5. Create a new SQL Sentry database using the registered connection:
so createdb -n

 Note: Packages are written to the tables during this step.
6. Install the SQL Sentry monitoring service (you will be prompted for the password):
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Starting with version 2020.8, the --IAcceptLicenseTerms switch must be added to the command to
acknowledge acceptance of the EULA.
so install --IAcceptLicenseTerms -n -u

Versions prior to 2020.8 use the following:
so install -n -u

 Note: The SQL Sentry monitoring service is now installed and running.
See the Monitoring Service Security article for more information about account requirements.
 Important: The EPI installation adds a SQL Sentry client shortcut to the desktop, but does not install
the client. Running the executable file that the shortcut points to opens the client installer and then
installs the client on the machine. You can remove the SQL Sentry client shortcut if you don't want to
install the client.
7. Launch the SQL Sentry client. You will see a loading dialog as files are downloaded from the SQL Sentry
database for the latest version of the client. It may take a few minutes for the files to download. Note that
you must do this for each machine where you wish to install the SentryOne client.

 Success: SQL Sentry is installed and ready to use. Continue below to install the SQL Sentry Portal or to
the Onboarding article for additional assistance.

Install SQL Sentry Portal
Review the System Requirements and Portal Configuration articles before installing SQL Sentry Portal.
After you have ensured that your machine meets the prerequisite requirements, you can begin installing SQL
Sentry Portal. Install SentryOne Portal on your machine with EPI by completing the following steps:
1. You must have installed or upgraded SQL Sentry to version 20 or greater using EPI before proceeding.
2. SQL Sentry Portal requires the SQL Sentry controller service on the machine where it is installed. If the
machine where you are installing SQL Sentry Portal needs the controller service, follow the Install
Additional Monitoring Services instructions below.

 Note: If you are installing SQL Sentry Portal on a machine where you have installed a
monitoring service, then it already has the required controller service, however, the
recommended setup is a dedicated machine that does not have the full monitoring service.
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3. Run the following command to complete SQL Sentry Portal installation:

 Important:
Integrated Windows Authentication is available in versions 2020.8.31 or later. It is not
available in version 2020.8.
SQL Sentry Portal. SQL Server Authentication works in all versions.
Starting with version 2020.8, the --IAcceptLicenseTerms switch must be added to the
command to acknowledge acceptance of the EULA.

Using Integrated Windows Authentication
so installmp --IAcceptLicenseTerms -n -s -u

Using SQL Server Authentication
so installmp --IAcceptLicenseTerms --connectionUseIntegrated false --server --connectionServer --connectionD
atabase --connectionUsername --connectionPassword

Versions prior to 2020.8 use the following:
so installmp -n -s -u -b

 Note:
The --server (-s) switch is for the server that will host SQL Sentry Portal
(<portalServerFQDN>) and must be the Fully Qualified Domain Name (FQDN). If needed,
this name can be found by using the list command to view the Controller Service value.
See the EPI Commands article for additional information on using list.
so list -t services -n

The switch -b is not valid in versions 2020.8.31 or later. This version uses the Portal
Configuration Utility to make updates after installing.
Prior to that release, it can be omitted if you're using the default value of 0.0.0.0:9991.
Prior versions cannot use the Portal Configuration Utility with EPI and must set the
binding duirng installation, or uninstall then reinstall to make changes.
See the Parameters & Examples section for more information on the used such as and . These
are referring to the SQL Sentry database and the SQL Server that hosts it.
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 Success: SQL Sentry Portal is installed and ready to use. Continue to the Getting Started with SQL
Sentry Portal article for additional assistance.

Install Additional Monitoring Services
In many cases, a SQL Sentry installation uses multiple monitoring services for load balancing and monitoring
an increased number of targets. See the Installation Recommendations article for advice on the
recommended number of monitoring services.
Perform the following steps to install the monitoring service on additional machines:
1. On the machine that will serve as a monitoring service, double-click SolarWinds-SQLSentry-EPI{Version}.exe. The files are unpacked to C:\Program Files\SentryOne Framework.
2. Run Command Prompt as Administrator and change the directory to SentryOne Framework:
cd c:\Program Files\SentryOne Framework

3. Add a new connection (using the same from the installation process):
Using Integrated Windows Authentication
so addreg -n --connectionServer --connectionDatabase

Using SQL Server Authentication
so addreg -n --connectionServer --connectionDatabase --connectionUseIntegrated false --connectionUsername -connectionPassword --connectionPort

4. Use the following command to verify connection registration details:
so listreg

5. Install the SQL Sentry monitoring service (using the same used during the installation). The first option is
for the full monitoring service (typical installation), while the second option is for configuring a machine for
SQL Sentry Portal.
1. Full monitoring service install option:
Starting with version 2020.8, the --IAcceptLicenseTerms switch must be added to the command to
acknowledge acceptance of the EULA:

54

so install --IAcceptLicenseTerms -n -u

Versions prior to 2020.8 use the following:
so install -n -u

 Success: The SQL Sentry monitoring service is now installed and running.

2. SQL Sentry Portal / controller service only install option:
 Note: If you are completing this step for a machine to install the SQL Sentry Portal, then the entire
monitoring service is not needed. You should run the install with the following parameter to install only
the necessary components (i.e. the SQL Sentry controller service) and not the monitoring service by using
the --installmonitoringservice flag and parameter 0:
Starting with version 2020.8, the --IAcceptLicenseTerms switch must be added to the command to
acknowledge acceptance of the EULA:
so install --IAcceptLicenseTerms --installmonitoringservice 0 -n -u

Versions prior to 2020.8 use the following:
so install --installmonitoringservice 0 -n -u

 Success: The SQL Sentry controller service is now installed and running.

Additional Information: Interested in installing the SQL Sentry monitoring service on a Windows
Server Core machine? See this blog post for a demonstration.

Install Additional Clients
When using EPI, the SQL Sentry client security requirements remain the same. See the Client Security article
for details.
To install only the SQL Sentry client on a machine:
1. Double-click the SQL Sentry executable file.
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2. Wait for the process to complete and load the client shortcut onto the desktop.
3. Double-click the shortcut to pull the client bits from the SQL Sentry database.

 Success: The SQL Sentry client is now installed and ready to use.

Uninstall via EPI
Uninstall
To uninstall the local controller and monitoring service, run the following:
so uninstall -n

 Note: The so uninstall command is a local command and is used to uninstall the local controller and
monitoring service only. It does not affect controllers and monitoring services running in other
environments.

If you want to remove the Enterprise Platform Installer entirely, you can run the executable that was used to
install it and choose the uninstall option, or you can uninstall it from Add or remove programs in Windows.
This will stop and remove the controller and monitoring services locally, in addition to removing the CLI. For
more information about uninstalling SQL Sentry , see the Uninstalling SQL Sentry article.

Uninstall SentryOne Portal
If you installed SentryOne Portal using EPI, you can uninstall it from a machine via EPI by following the steps
below.
1. Open Command Prompt (use the Run as administrator option)
2. Change to the SentryOne Framework directory (or custom directory used during installation)
cd C:\Program Files\SentryOne Framework

3. Stop the SentryOne Portal service
so stopmp -n -s

4. Uninstall the SentryOne Portal
so uninstallmp -n -s
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Upgrade via EPI
See the Upgrade SQL Sentry via EPI article.

Downgrade (non-typical process)
See the Downgrade section of the EPI Upgrade article.

Available Commands
See the EPI Commands article for a table of available commands and flag examples.

Advanced
Topics
PowerShell
PowerShell may be used with EPI. The SQL Sentry installation package with EPI must exist on the machines
where you plan to do an installation or run commands, and then PowerShell can be used to unpack it and
execute the necessary commands. See the SQL Sentry PowerShell Module article for information on
importing the SQL Sentry module to use with EPI.

 Important: PowerShell ISE is not recommended as it may cause issues. For example, use of
PowerShell ISE will lead to problems with the so install command when used without the password (as
you are instructed in the Install section).

Telemetry
By default, telemetry is disabled after completing an initial installation using EPI. If you would like to enable it
or learn more about telemetry in SentryOne, see the Telemetry article.

Troubleshooting
Problem: Timeout message displayed
Certain commands such as the so install may display a timeout message in the command line interface. This
timeout does not refer to the operation itself, but rather the display timeout. If the command has a default
timeout of 30 seconds, but the operation takes 60 seconds to complete, then the timeout message will
display while the operation continues to execute.
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Use the so help command to view the default timeout value for applicable commands. For example, the so
uninstallms has a default timeout of 30 seconds, while the so install has a default of 120 seconds.

In a high latency environment, you may want to increase the default timeout if you want to see the process
complete in the command line interface.
In this example, the -t (--timeout) is set to 1 second to illustrate what the timeout looks like, using so
installmp:

The Timeout was set to 1 second, process took longer than 1 second, Result = Timeout displayed, but process did
complete and SentryOne Portal installed.

If you have or expect to receive timeout messages and would rather see Result = Success in the command
line interface, use the -t (--timeout) flag to increase the default timeout as needed.

Error: Option 'IAcceptLicenseTerms' is unknown
If you receive this error when using the --IAcceptLicenseTerms switch, you need to run the installer
(SentryOneSetup.exe) to update the SentryOne Framework folder with the new EPI commands.

Viewing Log Files
See the SQL Sentry Troubleshooting article for information about log files.
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SQL Sentry Installation
Last Modified on 25 May 2021

Overview and Notes
 Note: The product has been rebranded since the video below was created, however, the overall
process is still the same.

 Note: The instructions in this article are recommended for smaller environments (i.e. estates with a
single monitoring service or client) and those who do not need a command line experience for
streamlining the installation or upgrade processes.
SQL Sentry offers an Enhanced Platform Installer which increases the speed and simplicity of installing
and upgrading SQL Sentry implementations through a command line interface and is recommended for
larger estates that will have more than one monitoring service or client. To use the EPI installation
method, see the EPI article.

 Note: If you are upgrading SQL Sentry from a previous version, it's strongly recommended that you
back up your SQL Sentry database prior to beginning the process. For more information about
upgrading SQL Sentry, see Steps to Upgrade to a New Version of SQL Sentry.
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 Important: SQL Sentry doesn't currently support Group Management Services (GMS) accounts.

Log into your SolarWinds account, and download the latest build of SQL Sentry. Once you've saved the
download to your computer, copy the installation file to the server where you want to install the SQL Sentry
monitoring service, and then double-click the installation file.

Choosing the Locations of the SQL Sentry Components
Determining the Monitoring Service Computer
 Note: For initial installation, it's recommended that you first determine where you will install the
monitoring service, and then install both the SQL Sentry monitoring service and client together on that
computer. This is analogous to installing the native client tool and SQL Server on the same computer.

Even if you don't plan on using the SQL Sentry client regularly from the machine, the SQL Sentry client is used
to enter your license key and enables you to complete the licensing process during the initial installation. You
are prompted to launch the SQL Sentry client and enter your license key at the end of the installation.

 Note: For more information about where components are typically installed, see the Installation
Recommendations topic.

SQL Sentry Portal
SQL Sentry Portal on-premises is part of the Complete Install. It can be installed on a machine along with the
SQL Sentry monitoring service and SQL Sentry client, or it can be installed on a machine by itself without any
other SQL Sentry components (Custom Install). Review the SQL Sentry Portal Configuration article before
installing.
Once you have gone through the SQL Sentry installation process for the SQL Sentry monitoring service or SQL
Sentry client, SQL Sentry Portal cannot be installed separately on the same machine after the installation. It
may be installed as part of the initial installation or during a SQL Sentry upgrade.
If you need to install SQL Sentry Portal on a machine that already has the SQL Sentry monitoring service or
client of the same version, you must first uninstall the SQL Sentry client and SQL Sentry monitoring service
from the machine and reinstall them as part of the SQL Sentry Portal installation. This does not require
removing/recreating an existing SQL Sentry database. You will need to choose to connect to the existing
database during the installation process.
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Choosing the Install Location
Setup shows the default install location. Select Next to use the default location. To install to a different
location, select Browse, then select the appropriate location.

Executing the SQL Sentry Application File
1. Execute the SQLSentrySetup-x64.exe file. You'll need to select Accept and Install. The Microsoft
.NET Framework and Report Viewer will be included with the SQL Sentry installation (if necessary).

2. A welcome dialog displays when the SolarWinds SQL Sentry Setup program starts. Select Next to
continue or Cancel to exit.

3. Then, the End-user license Agreement dialog appears. Select the checkbox to accept the terms, then
choose Next to continue.
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 Note: For future reference, a copy of the license file is located in the Client folder of the
installation.

 Note: If the setup program detects that SQL Sentry is already installed, it prompts for removal.
The installation process enables you to easily upgrade from previous versions and maintain all of
your existing configuration settings, including any users and groups, notification settings, etc. Any
time SQL Sentry is upgraded or another component is installed, the existing software is first
uninstalled. This ensures that all components are of the latest version, and compatible. This only
applies to the client and server files; the SQL Sentry database, where all of your settings and
history are kept, is not removed.

 Important: The NET Framework 4.7.1 is required for all installations. A reboot may be required if
the .NET Framework files are in use. Temporarily stopping any applications that make use of the
.NET Framework can help to avoid a reboot.

4. On the What would you like to install? screen, choose an installation option. By default, the Complete
Install option is selected (and used in this example). It installs the SQL Sentry client, SQL Sentry
monitoring service, SQL Sentry Portal, and a PDF copy of the user documentation.
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5. On the SolarWinds SQL Sentry Database screen, choose Create a New SolarWinds SQL Sentry
Database (default) or Connect to an Existing SolarWinds SQL Sentry Database.(most commonly used
for an upgrade or installing an additional SQL Sentry components on other machines). This example uses
Create a New SolarWinds SQL Sentry Database.

6. On the Create New SolarWinds SQL Sentry Database screen, choose a location and name for the SQL
Sentry database. Enter the server instance where you'd like to install the SQL Sentry database in SQL
Server Name. Enter a name for the SQL Sentry database in Database Name. The default Database
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Name is SQLSentry. The SQL Sentry database is created as part of the installation process. If you're
upgrading SQL Sentry, specify the name of the existing SQL Sentry database (past default SQL Sentry
database names have included SentryOne). All the necessary schema changes are applied to the existing
database during an upgrade.
The Authentication Mode options available for connecting to the SQL Server that hosts the SQL Sentry
database are Windows Authentication and SQL Server Authentication. If the Windows user account
you're using for the installation doesn't have the required privileges on the selected SQL Server, select
SQL Server Authentication and enter a SQL Server User Name and Password for an account with
required SQL Server privileges. See the Monitoring Service Security article for the account's full security
requirements.
Select Test to validate the database account information. After a successful test, select Next to
continue the setup.
Example uses Windows Authentication & includes SQL Sentry Portal
After selecting Test, a popup will confirm your
database selection:

 Note: If an existing database has been
chosen, selecting Test asks you to confirm
that you want to upgrade the database.

7. If you've selected Windows Authentication for the Monitoring Service SQL Credentials, enter the
Windows account User Name and Password on the Monitoring Service Account Information screen,
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under which the SQL Sentry monitoring service will run. Select Test to validate the chosen credentials.
After a successful test, select Next to continue the setup.

 Note: See the Monitoring Service Security article for the account's full security requirements.

Monitoring Service Account Information and Test
After selecting Test, a popup will confirm your
service account validation:

 Note: Change the service account any time after the initial installation by running the Service
Configuration Utility found in the SQL Sentry program group. See the Monitoring Service Logon
Account article for instructions.

8. On the Portal Configuration Information screen, choose an Authentication Mode for the SQL Sentry
Portal service to connect to the SQL Sentry database and enter those credentials.  Note: It is
necessary to enter the credentials on this screen for either authentication option. The Test will fail if the
credentials are blank.
SQL Sentry Portal Configuration Information and Test
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SQL Sentry Portal Configuration Information and Test
After selecting Test, a popup will confirm your
service account validation:

9. On the Ready to Install screen, select Install to begin installation.

10. Wait for the installation process to complete, then select Finish to complete setup. When SQL Sentry
Portal is installed, you'll see the URL at which it has been configured to run. You can launch the Portal
Configuration Utility to update any settings, such as the server, database, credentials, encryption, port,
or apply a certificate and use SSL.
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 Note:
If you did a custom install that didn't install SQL Sentry Portal, you won't see the Launch
Portal Configuration Utility option.
You may see an option to launch the Software Client instead if it was part of the
installation.
If you didn't install the SQL Sentry client, install it on another machine and run it to enter
your license key and complete the licensing process.

 Success: You've completed the SQL Sentry installation process! What's next?
Continue to the Onboarding article to get into SQL Sentry and start monitoring your
environment.
This is not required for an upgrade. All previous settings have been retained.
Install additional monitoring services as described below (see the Installation
Recommendations article to learn more about how many monitoring services you may need).
Install the SQL Sentry client on additional machines as described below.

Installing only the Monitoring Service
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1. On the What would you like to install? screen, choose Custom Install.

2. To install the SQL Sentry monitoring service on a machine, select only the Monitoring Service option on
the Custom Setup screen of the installation process.

Installing Additional Monitoring Services
The number of monitoring services required for your SQL Sentry enterprise depends on the number of targets
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you are monitoring and other factors related to the overall workload. After completing the installation
process, you may want to install additional monitoring services. Please see the Monitoring Services and
Targets per Site section of the Installation Recommendations article for guidance on selecting the correct
number of monitoring services for optimal performance.

Installing SQL Sentry Portal
The SQL Sentry Portal may be installed on a machine by itself. There's no need to have a SQL Sentry
monitoring service or SQL Sentry client on the machine where it is installed. When installing SQL Sentry Portal
by itself, it must be done after a SQL Sentry installation has been completed to create the database and at
least one installed monitoring service exists in the overall setup. Follow the instructions in this section to
install SQL Sentry Portal by itself and connect to an existing SQL Sentry database.

Additional Information: Review the SQL Sentry Portal Configuration article for additional security
requirements and information, how to use the Portal Configuration Utility to update settings after
installation, and details on how to access the SQL Sentry Portal in your browser.

To install SQL Sentry Portal complete the following:
1. On the What would you like to install? screen, choose Custom Install.

2. On the Custom Install screen, select the drop-down arrow next to the Portal (Web Client) component.
Select the Entire feature will be installed on local hard-drive option.
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3. Select Entire feature will be unavailable next to the other components if you are installing only the
Portal (Web Client) service.
4. Follow the instructions above for filling out SQL Sentry Portal-related screens.

Installing the SQL Sentry Client on Additional Machines
Workstation Computers
There's no need to install a monitoring service on any workstation machines . To install just the SQL Sentry
Software Client do the following:
1. On the What would you like to install? screen, choose the Software Client Install option. Select Next
to continue.
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2. On the Connect to Existing SQL Sentry Database screen enter the information needed to connect to
your existing SQL Sentry database installation.

3. Select Test to validate your connection details, then Next to continue installing the Software Client.
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SQL Sentry EPI Upgrade
Last Modified on 10 December 2021

Upgrade SQL Sentry via EPI
See the EPI article for details on using the Enhanced Platform Installer.

SQL Sentry Client Impacts
How does using EPI impact the SQL Sentry client during an upgrade?
If a SQL Sentry user has the SQL Sentry client open, they receive an alert informing them that the SQL Sentry
client must be shut down due to an upgrade. It will ask them to exit the application and display a "shutdown
countdown" starting at 120 seconds.

How does using EPI impact the SQL Sentry client after an upgrade?
When the SQL Sentry client is launched after an upgrade, a message appears, indicating to the user that the
client is checking for updates and asks them to wait while the client is updated.

Update message displayed to user in client

Things to Know Before Upgrading
 Important:
Back up the SQL Sentry database before performing an upgrade.
A major version upgrade requires a license upgrade. See the Product Version Mismatch section of
the License Management article for more information.
Review the System Requirements before upgrading. The latest version may require a newer version
of Microsoft .NET, which could require restarts during the upgrade process.
All SQL Sentry components, including the SQL Sentry database, monitoring service(s), and client(s)
must be on the same build to work.
See the Password section of this article for information on using non-alphanumeric characters such
as spaces or quotes with the -p flag. The command will stop, and monitoring and controller service
installations will fail if these characters are not properly formatted with quotes and the backslash
escape character.
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 Note:
Review the Parameters & Examples section for more information about the used in the following
commands.
If you experience any Result = Timeout messages while a command is running, refer to the
Advanced section for more information. This does not mean the operation timed out.
If you are unsure about which version of SQL Sentry you have installed (EPI or non-EPI), you can
determine this from the presence of:
The SQL Sentry controller service, which only exists in the EPI version.
See the list command in the Available Commands section to get a list of monitoring
services that are running without the controller.
The Setup.Bootstrapper table in the SQL Sentry database, which only exists in the EPI
version.
If you need additional help determining which version you have installed, please contact our
support team at support.sentryone.com.

Files referenced in upgrade instructions
There are two SQL Sentry Enhanced Platform Installer files available from the SolarWinds Customer Portal:
The full installation (Enhanced Platform Installer / SolarWinds-SQLSentry-EPI-{Version}.exe such as
SolarWinds-SQLSentry-EPI-2021.8) and the upgrade package (Enhanced Platform Upgrade Package /
SolarWinds-SQLSentry-EPIUpgradePackage-{Version}.s1package such as SolarWinds-SQLSentryEPIUpgradePackage-2021.8.s1package).

Full installation file: SolarWinds-SQLSentry-EPI-{Version}.exe
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Upgrade package file: SolarWinds-SQLSentry-EPIUpgradePackage-{Version}.s1package

DEPRECATED (SentryOne Branded SQL Sentry)

The files referenced here are only for versions prior to 2021.8.
There are two files available from my.sentryone.com: The full installation (Enhanced Platform Installer /
SentryOneSetup.exe) and the upgrade package (Enhanced Platform Upgrade Package /
current.s1package).

 Note: Depending on your environment, the current.s1package may download as current.zip.
You will need to change the file type to .s1package.

Example: Download the Enhanced Platform Installer product from my.sentryone.com to get SentryOneSetup.exe
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Example: Download the Enhanced Platform Upgrade Package from my.sentryone.com to get current.s1package

Upgrade Paths
 Warning:
There are three different upgrade paths .
If you used EPI for the installation or previous upgrade, follow the first set of instructions
under Option 1. Existing EPI Upgrade. Note that going from a pre v20 release to a v20.0+
release has some additional prerequisite steps (i.e. v19.2 to v20.0, v20.0.1, or v2020.x) that
must be completed for Option 1.
If your installation or previous upgrade did not use EPI, follow the second set of instructions
under Option 2. First EPI Upgrade.
If you used EPI for the installation or previous upgrade, and are now upgrading to Version 20.0
(or 2020.x), there is an alternate path available under Option 3. Version 20.0 Existing EPI
Alternative which allows you to upgrade from a pre v20 release to a v20+ release without
having to uninstall/install the controller service on all machines with a monitoring service at
the time of the upgrade. This is not the typical or recommended path.

Option 1. Existing EPI to EPI upgrade
 Warning: For Version 20.0, customers currently on an EPI build of SQL Sentry must follow these steps
before continuing to the steps listed in Option 1. Existing EPI Upgrade.
These steps are needed to go from any pre v20 release to a v20+ release (i.e. 19.2 to 20.0, 20.0.1, or
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2020.x). If you are upgrading from a v20+ EPI release to another v20+ EPI release, skip the perquisite
steps and continue to Option 1. Existing EPI Upgrade below.

Before starting, log in to the SolarWinds Customer Portal and download the latest EPI version of SQL Sentry.

Option 1. Prerequisite Steps for an Existing EPI Upgrade (pre v20 to v20+)
On each server with an existing SQL Sentry monitoring service, complete the following steps:
1. Run Command Prompt as Administrator and change the directory to SentryOne Framework:
cd c:\Program Files\SentryOne Framework

2. Uninstall the SQL Sentry Monitoring service.
so uninstall -n

3. Open the Control Panel > Programs > Programs and Features. Select SQL Sentry (or SentryOne), then
select Uninstall.
4. Double-click SolarWinds-SQLSentry-EPI-{Version}.exe. The files are unpacked to C:\Program
Files\SentryOne Framework.
5. Install the SQL Sentry monitoring service (you will be prompted for the password):
Starting with version 2020.8, the --IAcceptLicenseTerms switch must be added to the command to
acknowledge acceptance of the EULA.
so install --IAcceptLicenseTerms -n -u

Versions prior to 2020.8 use the following:
so install -n -u

 Success: You can now proceed to Option 1. Existing EPI Upgrade to complete your SQL Sentry EPI
Version 20.0 installation.

Option 1. Existing EPI Upgrade
Use this option if EPI was used for the initial installation or previous upgrade.
 Note: For version 20.0 follow the prerequisite steps listed above before continuing . These steps are
needed to go from any pre v20 release to a v20+ release (i.e. 19.2 to 20.0 or 20.0.1).
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1. Run Command Prompt as Administrator and change the directory to SentryOne Framework:
cd c:\Program Files\SentryOne Framework

2. Verify that you have the correct connection to the SQL Sentry database:
so listreg

3. Push the .s1package to the SQL Sentry database:
so push -n -f >
 Note: You can omit the -f option if you installed the SentryOne Frameworks installer with the version you want to
upgrade to.
 Note: If you do not enter a , then the default path and package will be used: C:\Program Files\SentryOne
Framework\SolarWinds-SQLSentry-EPIUpgradePackage-{Version}.s1package
4. Validate available packages:

so listpackage -n
5. Start the upgrade.  Note: See more about using the upgrade command in the EPI Commands article.
If your currently installed version is below 2020.8 use the following:

so upgrade -n -t
If your currently installed version is 2020.8 or later, then the --IAcceptLicenseTerms is needed:

so upgrade --IAcceptLicenseTerms -n -t
6. Wait for the upgrade to complete.
 Note: The upgrade command so upgrade is a global command that informs all controller services that a new desired state
has been marked with a version increase to version . Once this new state is detected, any monitoring service connected to
the affected SQL Sentry database will be stopped, upgraded, and restarted after the upgrade completes. If any client
processes are detected, the user will be notified that they have two minutes to exit the client before it is stopped to proceed
with the upgrade. There is no status indicator.
 Important: The EPI installation adds a SQL Sentry Client shortcut to the desktop, but does not install the client. Running
the executable file that the shortcut points to opens the Client installer and then installs the Client on the machine. You can
remove the SQL Sentry Client shortcut if you don't want to install the client.
7. Launch the SQL Sentry client. You will see a loading dialog as files are downloaded from the SQL Sentry database for the latest
version of the client. It may take a few minutes for the files to download.
 Note: To verify the status of the upgrade without launching the client, validate the package:

so listpackage -n
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 Success: The SQL Sentry installation has been upgraded and is now ready for use.

 Note: If you are using SQL Sentry Portal, see the upgrading section of this article to complete the upgrade steps for
that service.

Option 2. First EPI upgrade
Use this option if EPI was not used for the initial installation or previous upgrade. The .NET Framework 4.7.2 is installed during
this process, which may force a reboot.
1. Uninstall all current SQL Sentry monitoring services using Add/Remove Programs in Windows.
 Important: For Version 20.0, you must perform the monitoring service uninstall before proceeding.
2. Ensure all SQL Sentry clients are closed (disconnected from the SQL Sentry database). For Version 20.0, it is required that
you uninstall the SQL Sentry clients from the machines in your SQL Sentry environment before proceeding.
3. Download the Enhanced Platform Installer from the SolarWinds Customer Portal.
4. Double-click SolarWinds-SQLSentry-EPI-{Version}.exe.
 Note: The files are unpacked to C:\Program Files\SentryOne Framework.
5. Run Command Prompt as Administrator and change directory to SentryOne Framework:

cd c:\Program Files\SentryOne Framework
6. Add a new connection:
Using Integrated Windows Authentication

so addreg -n --connectionServer --connectionDatabase
Using SQL Server Authentication

so addreg -n --connectionServer --connectionDatabase --connectionUseIntegrated false --connectionUsername -connectionPassword --connectionPort
7. Verify available connections are registered:

so listreg
8.Push the upgrade package:

so push -n
 Important: If you are on a version older than 18.3, skip this step, and proceed straight to step 8 to continue.
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9. Upgrade the SQL Sentry database to the latest version and push upgrade package:

so upgradedb -n
10. Install the SQL Sentry monitoring service (you will be prompted for the serviceAccount password):
Starting with version 2020.8, the --IAcceptLicenseTerms switch must be added to the command to acknowledge acceptance of
the EULA:

so install --IAcceptLicenseTerms -n -u
Versions prior to 2020.8 use the following:

so install -n -u
 Note: The SQL Sentry monitoring service is now installed and running.
 Important: The EPI installation adds a SQL Sentry Client shortcut to the desktop, but does not install the client. Running
the executable file that the shortcut points to opens the Client installer and then installs the Client on the machine. You can
remove the SQL Sentry Client shortcut if you don't want to install the client.
11. Launch the SQL Sentry client. You will see a loading dialog as files are downloaded from the SQL Sentry database for the latest
version of the client. It may take a few minutes for the files to download.
 Note: To verify the status of the upgrade without launching the client, validate the package:

so listpackage -n

 Note: See the Install Additional Clients and Install Additional Monitoring Services sections of this article for
instructions on installing the EPI compatible versions of the SQL Sentry client and monitoring service onto additional
machines as needed.

 Success: The SQL Sentry installation has been upgraded and is now ready for use. The next time you need to upgrade,
use Option 1 for an Existing EPI Upgrade.

Option 3. An alternative option (non-typical path)
Option 3 allows you to upgrade from a pre v20 release to a v20+ release without having to uninstall/install the controller service
on all machines with a monitoring service at the time of the upgrade. This is not the typical or recommended path. This options
allows you to upgrade SQL Sentry controller services on your own schedule, if needed. It is not required to upgrade the controllers
at the same time.

 Warning: Option 1 is the recommended upgrade path. The upgrade option below does not upgrade the controller
services and future compatibility is not guaranteed with this alternative option.
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 Important: The upgraded controller services are needed to install and use SQL Sentry Portal. This option does not meet
those requirements.

For this option, you'll need to upgrade the SQL Sentry framework on one machine. The instructions vary depending on which (if
any) SQL Sentry components are installed on the machine where you are running the EPI upgrade. Read below to determine if you
should use Option A or Option B.

Option A: Machine without services
On a machine that does not have the SQL Sentry monitoring or controller services, follow these steps:
1. If there's an existing installation of the SQL Sentry framework, open the Control Panel > Programs > Programs and
Features. Select SQL Sentry, then select Uninstall to remove it before continuing.
2. Install the v20.0 SentryOne Framework. Double-click SolarWinds-SQLSentry-EPI-{Version}.exe. The files are unpacked to
C:\Program Files\SentryOne Framework.
3. Run Command Prompt as Administrator and change the directory to SentryOne Framework:

cd c:\Program Files\SentryOne Framework
4. Verify that you have the correct connection to the SQL Sentry database:

so listreg
5. Push the .s1package to the SQL Sentry database:

so push -n -f >
 Note: You can omit the -f option if you installed the SentryOne Frameworks installer with the version you
want to upgrade to.
 Note: If you do not enter a , then the default path and package will be used: C:\Program Files\SentryOne
Framework\SolarWinds-SQLSentry-EPIUpgradePackage-{Version}.s1package
6. Validate available packages:

so listpackage -n
7. Start the upgrade.  Note: See more about using the upgrade command in the EPI Commands article.
If your currently installed version is below 2020.8 use the following:

so upgrade -n -t
If your currently installed version is 2020.8 or later, then the --IAcceptLicenseTerms is needed:

so upgrade --IAcceptLicenseTerms -n -t
8. Wait for the upgrade to complete before starting the SQL Sentry client.
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 Note: If you are using SQL Sentry Portal, see the upgrading section of the SQL Sentry Portal
Configuration article to complete the upgrade steps for that service.

Option B: Machine with services
On a machine that has the SQL Sentry monitoring or controller services, follow these steps:
1. Run Command Prompt as Administrator and change the directory to SentryOne Framework:

cd c:\Program Files\SentryOne Framework
2. Verify that you have the correct connection to the SQL Sentry database:

so listreg
3. Uninstall the service:

so uninstall -n
4. Uninstall the existing installation of the SentryOne framework by opening the Control Panel > Programs >
Programs and Features. Select SQL Sentry, then select Uninstall to remove it before continuing.
5. Install the v20.0 SentryOne Framework. Double-click SolarWinds-SQLSentry-EPI-{Version}.exe. The files are
unpacked to C:\Program Files\SentryOne Framework.
6. Install the SQL Sentry monitoring service (you'll be prompted for the password):
Starting with version 2020.8, the --IAcceptLicenseTerms switch must be added to the command to acknowledge acceptance
of the EULA:

so install --IAcceptLicenseTerms -n -u
Versions prior to 2020.8 use the following:

so install -n -u
7. Push the .s1package to the SQL Sentry database:

so push -n -f >
 Note: You can omit the -f option if you installed the SentryOne Frameworks installer with the
version you want to upgrade to.
 Note: If you do not enter a , then the default path and package will be used: C:\Program
Files\SentryOne Framework\SolarWinds-SQLSentry-EPIUpgradePackage-{Version}.s1package
8. Validate available packages:

so listpackage -n
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9. Start the upgrade.  Note: See more about using the upgrade command in the EPI
Commands article.
If your currently installed version is below 2020.8 use the following:

so upgrade -n -t
If your currently installed version is 2020.8 or later, then the --IAcceptLicenseTerms is needed:

so upgrade --IAcceptLicenseTerms -n -t
10. Wait for the upgrade to complete before starting the SQL Sentry client.

 Note: If you are using SQL Sentry Portal, see the upgrading section of the SQL
Sentry Portal Configuration article to complete the upgrade steps for that service.

Upgrade SQL Sentry Portal
If you installed SQL Sentry Portal using EPI, you can upgrade via EPI by following the steps below. The upgrade process
involves uninstalling, then reinstalling SQL Sentry Portal. You must upgrade the SQL Sentry version first via EPI, before
you can upgrade the SentryOne Portal version.

 Note: The default SentryOne Framework directory is used in the instructions. If you used a
non-default location, use that path instead.

1.

Open Command Prompt (use the Run as administrator option)

2.

Change to the SentryOne Framework directory

cd C:\Program Files\SentryOne Framework

3.

Stop the SQL Sentry Portal service

so stopmp -n -s

4.

Uninstall the SQL Sentry Portal

so uninstallmp -n -s
5. Install the SQL Sentry Portal
Using Integrated Windows Authentication

so installmp --IAcceptLicenseTerms -n -s -u
Using SQL Server Authentication

83

so installmp --IAcceptLicenseTerms --connectionUseIntegrated false --server --connectionServer --connectionD
atabase --connectionUsername --connectionPassword
Versions prior to 2020.8 use the following:

so installmp -n -s -u -b
6. Start the SQL Sentry Portal service

so startmp -n -s

 Note:

The --server (-s) switch is for the server that will host SQL Sentry Portal
(<portalServerFQDN>) and must be the Fully Qualified Domain Name (FQDN). If needed, this
name can be found by using the list command to view the Controller Service value.
See the EPI Commands article for additional information on using list.

so list -t services -n

The switch -b is not valid in versions 2020.8.31 or later. This version uses the Portal
Configuration Utility to make updates after installing.
Prior to that release, it can be omitted if you're using the default value of 0.0.0.0:9991. Prior versions
cannot use the Portal Configuration Utility with EPI and must set the binding duirng installation, or
uninstall then reinstall to make changes.
See the Parameters & Examples section of the EPI article for more information on the
used such as and . These are referring to the SentryOne database and the SQL Server that hosts
it.

Downgrade (non-typical process)
In the event that a downgrade or rollback is required, the process will differ depending on whether the database schema
changed between versions.

Verify the schema
Use the listpackage command to view the details of the old and new package:

so listpackage -n

Same Schema Version
If the schema version is the same between the old and new packages, then you can downgrade to the older version using the
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upgrade command and the older package:

so upgrade --IAcceptLicenseTerms -n -t
There is no need to run any uninstall commands in this scenario.
 Note: See more about using the upgrade command in the EPI Commands article.

Different Schema Version
If the schema version is different between the old and new packages, then you should:

1.

Restore the SQL Sentry database from backup

2.

Uninstall the current version using so uninstall (see the Uninstall section in this article for details)
or through the control panel

3.

Reinstall the previous monitoring service and controller version using the so install command

Available Commands
See the EPI Commands article for a table of available commands and flag examples.

Troubleshooting
Problem: The upgrade process is being blocked
If this is for the first option, where EPI already exists, it's possible that SQL Sentry components were installed before using the
EPI. For example, there may be clients connected to the SQL Sentry database that were installed pre-EPI. In this scenario, there are
no bootstrappers running to manage those client processes, which means that the so upgrade command cannot
control those pre-EPI clients. The pre-EPI clients will continue sending a heartbeat to the SentryOne, and the upgrade will be
blocked until the clients are shut down.
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Connecting to an Installation
Last Modified on 30 July 2021

Accessing SQL Sentry Database Connection Management
When you start the SQL Sentry client, if you have more than one server in the SQL Sentry
Database Connection Management menu, you are prompted to choose an installation to connect to. You
may have more than one server in the SQL Sentry Database Connection Management menu if you have
moved the SQL Sentry database to a new location.

If you don't have more than one connection, you are brought directly to the SQL Sentry client when opening
the application. To access the SQL Sentry Database Connection Management window from the client, select
Connect to Installation from the File menu:

Connection Properties
The SQL Sentry Database Connection Management menu controls the active SQL Sentry database for the
locally installed SQL Sentry client.
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Specifying the Server
Enter the name of the server to connect to in the field provided.

Specifying the Database Name
Specify the database name that the SQL Sentry database connects to.

Using the Integrated Windows Authentication
By default, this option is selected. To use the SQL Server authentication, select No, and then enter the SQL
Server credentials. After connecting to the server, a new instance of the SQL Sentry client launches that
connects to the specified alternate installation.
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Advanced Properties
Select Show Advanced Properties to access advanced options.
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Port Number
The default port is 1433 for SQL Server. See the Performance Analysis Required Ports article for additional
information. See the Setting the Connection Properties topic from Microsoft Docs for more information on
the portNumber property.

Packet Size
The default size is 4096 bytes. See the Configure the network packet size Server Configuration Option topic
from Microsoft Docs for additional information on SQL Server network pack sizes.

Encrypt Network Traffic
The default value is No. Set to Yes to use encrypted connections between the SQL Sentry database server,
SQL Sentry monitoring services, and SQL Sentry client.

 Important: To use this property, you must first complete the steps to Enable Encrypted Connections
to the Database Engine as outlined in Microsoft Docs.

Trust Server Certificate
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The default value is No. Set to Yes to trust SQL Server's SSL Certificate without additional validation. See the
Setting the Connection Properties topic from Microsoft Docs for more information on the
trustServerCertificate property.

 Important: If you choose to Encrypt Network Traffic, then this property must be set to Yes.

Multi Subnet
The default value is No. Set to Yes if this SQL Server connection uses a Multi Subnet Failover. See the Setting
the Connection Properties topic from Microsoft Docs for more information on the multiSubnetFailover
property.

Removing a Connection
Old servers may be removed through the Edit option on the SQL Sentry Database Connection Management
window. To remove an old server from the SQL Sentry Database Connection Management menu so that you
are no longer notified about it when opening the SQL Sentry client, complete the following steps:
1. Choose the server you would like to remove, select Edit, and then at the bottom of the screen
select Remove Connection.

2. Select OK to delete the desired connection.
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SQL Sentry License Management
Last Modified on 19 April 2022

 Important: SQL Sentry versions 2021.8 or later are licensed with a SolarWinds license through the
SolarWinds License Manager. SQL Sentry versions before 2021.8 are licensed with a SentryOne license.

Licensing
SQL Sentry is generally licensed per each individually monitored target. This includes products for SQL Server,
SQL Server Analysis Services, and Azure SQL Database. No additional licensing is needed for the SQL Sentry
Portal, clients, or monitoring services installed in your environment. You may install as many of these as
needed with your SQL Sentry license.

 Important: To host the SQL Sentry database in an Availability Group, the Monitoring Service and SQL
Sentry Client Connection(s) must use the Listener name. Ensure that the Monitoring Service and any SQL
Sentry Client connections are using the Listener name before activating your license key.
To host the SQL Sentry database in a Failover Cluster Instance (FCI), the Monitoring Service and SQL
Sentry Client Connection(s) must use the virtual cluster name. Ensure that the Monitoring Service and
any SQL Sentry Client connections are using the virtual cluster name before activating your license key.

Additional Information: For more information about adding your SQL Sentry Database to an
Availability Group, see the Adding the SQL Sentry Database to an Availability Group article.

Additional Information: See the product pricing and SQL Sentry licensing options section of the
product page for more information on licensing models and what is included with each option such as
monitoring of the Hyper-V or VMware host.

Free SQL Sentry License for Monitoring the SQL Sentry Database
Instance
It's possible to obtain a free license of SQL Sentry for monitoring the SQL Server instance that contains the
SQL Sentry database. The database license is free to monitor regardless of how many licenses you already
have.
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 Note: The free license doesn't appear in the license count in the Help > About window, despite
whether the free license is used.

 Success: There are no annual software maintenance costs for the free license, and the license is
perpetual.

SQL Sentry License Usage for VMware and Windows Hyper-V
It's possible to monitor VMware vCenter hosts, Windows Servers, and Hyper-V hosts with SolarWinds SQL
Sentry. With each SQL Sentry license, you can watch 3 times the SQL Sentry license quantity to monitor
VMware vCenter hosts, Windows Servers, and Hyper-V hosts. For example, if you have 3 SQL Sentry licenses,
you can watch 9 VMware vCenter hosts, Windows Servers, and Hyper-V hosts in your preferred combination.

Additional Information: See the SQL Sentry VMware, and Windows Hyper-V product pages for more
information about the subscription licensing.

SQL Sentry License Usage Overview
View additional license information, such as the number of licenses applied throughout the environment, in
the About SolarWinds SQL Sentry window.
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Access the About SolarWinds SQL Sentry window by selecting Help > About.

Inventory View
To get an overview of how your licenses are applied throughout your environment you can also select the
Inventory node, (Navigator > Configuration > Inventory). See the Inventory View article for instructions.

SolarWinds License Manager for SQL Sentry Online
Activation
Use the SolarWinds License Manager to activate a new license key or upgrade the existing one to watch a
different number of targets. The license manager can be launched from within the SQL Sentry client.
1. Open Windows Services on the monitoring service machine(s) and then stop the SentryOne
Monitoring Service.

2. In SQL Sentry, go to Help > Manage Licenses:

3. The License Manager screen appears for SolarWinds SQL Sentry:
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 Important: If you have an existing license, the Action will have an Upgrade option. If you have
an evaluation license or just upgraded from a SentryOne licensed version of SQL Sentry and need
to apply a SolarWinds branded license, the Action will have an Activate option.

4. To apply a license, use the Upgrade or Activate option. If you have internet access, you can use the first
option to enter the activation key obtained from the SolarWinds Customer Portal. There are additional
options to use a specific proxy server or perform a manual activation if there is no internet access.
Select Next to continue.

5. Enter your information (name, email, and phone number) to register SQL Sentry. Select Next to
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continue.
6. You should see a message that reads, " SolarWinds SQL Sentry is now licensed and activated! Your

license has been imported successfully." Select Finish to return to the License Manager screen.
7. Select Exit to return to the SQL Sentry client.
8. Start the SentryOne Monitoring Service.

SolarWinds License Manager for SQL Sentry Offline
Activation
Use the SolarWinds License Manager to activate a new license key or upgrade the existing one to watch a
different number of targets. Activate your license on an offline machine by completing the following steps:
1. Open Windows Services on the monitoring service machine(s) and then stop the SentryOne Monitoring
Service.

2. In SQL Sentry, go to Help > Manage Licenses to open the SolarWinds SQL Sentry License Manager.
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 Important: If you have an existing license, the Action will have an Upgrade option. If you have an
evaluation license or just upgraded from a SentryOne licensed version of SQL Sentry and need to apply a
SolarWinds branded license, the Action will have an Activate option.

3. To apply a license, use the Upgrade or Activate option.

4. Select the This server does not have internet access option and then select Next to continue.

6. Complete the steps on the Activate Product page:
1. Select Copy Unique Machine ID and then paste the id into a text editor. Save the .txt document, and
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then move the document onto a machine with internet access.

 Note: You can transfer the document to a shared location, or copy the document onto a portal drive
for transfer.
2. On your machine with internet access, log into the SolarWinds customer portal, select Licenses >
Manage Licenses, and then navigate to the product you are trying to activate.
3. Select Activate license manually to open the Manage License Activation page.
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4. Paste the unique machine id from your .txt file into the Unique Machine ID field. Enter a computer
name for your machine, and then select Generate License File.
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5. Select Download Activation File, and then move the file onto your offline machine.

 Note: A copy of the download file is emailed to the email associated with your SolarWinds customer
account.
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7. Select Browse, select the location of your license key file, and then select Next to continue.

8. Select Finish to activate your license.

9. Select Exit to return to the SQL Sentry client, and then start the SentryOne Monitoring Service.
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Applying Multiple Licenses to the Same Installation
1. Open Windows Services on the monitoring service machine(s) and then stop the SentryOne
Monitoring Service.

2. In SQL Sentry, go to Help > Manage Licenses to open the License Manager.

3. Select Upgrade for the installed license key.

4. Enter the applicable license key and then select Next.
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5. Verify your user information on the product registration page, and then select Next.

6. Select Finish to return to the License Manager.

102

7. Repeat these steps for any additional licenses.
8. Start the SentryOne Monitoring Service.

 Success: New licenses will display in the list for the License Manager.

Deactivating your License
You may encounter circumstances where you need to make changes to your existing license, and deactivate
your license.
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 Important: To ensure optimal support and function of your SQL Sentry environment, contact
SolarWinds Customer Service before making changes to your license.

 Note: You must open Windows Services on the monitoring service machine(s) and then stop the
SentryOne Monitoring Service before deactivating your old license.

Consider the following example: you have added a new server to your environment where you want to deploy
another SQL Sentry Database; however , you have one existing license for up to 10 instances. You want to
separate your existing license into two licenses that can be used for five instances each, so you can monitor
both of your servers.
In this example, you would need to contact SolarWinds Customer Service and create a ticket to separate your
license. Once your license has been separated by customer service, you can deactivate your old license, and
then register the two new licenses.

SentryOne License Management for SQL Sentry
Deprecated: This section applies only to SentryOne-branded versions of SQL Sentry (earlier than
2021.8).

The Hardware Key
Your SentryOne SQL Sentry license has a hardware key that's tied to the location of your SQL Sentry database
(denoted by the SQL Server instance name). If you decide to relocate the SQL Sentry database, this hardware
key can be updated through the SentryOne Customer Portal by any authorized account holder (see the
SentryOne Account Management article). Contact support if you have any issues. For more information about
moving the SQL Sentry database, see the Relocating the SQL Sentry Database topic.
An exception to this process is when the SQL Sentry database is part of an Availability Group. To allow
licensing to be aware of the SQL Sentry database and to continue working, the hardware key must be tied to
the Availability Group ID. You can get this ID by executing the following query against the instance that will be
hosting the SQL Sentry database:
SELECT group_id as AG_ID, name
FROM sys.availability_groups

For more information, see the Hosting SQL Sentry Database On An Availability Group article.
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APS and DW Sentry Licensing
EOL: These products (APS Sentry and DW Sentry) are no longer for sale.

The licensing for Microsoft Analytics Platform System (APS) and SQL Data Warehouse (SQL DW) differ from
the traditional SQL Sentry licensing model. APS is licensed by the number of Compute nodes on the target,
and SQL DW is a flat monthly subscription with an annual term.

 Important: If the number of Compute nodes exceeds the number of license units, monitoring will be
suspended until additional license units are applied. For example, if a SQL DW target with six compute
nodes is being monitored with a six node license, and then two additional nodes are added to the SQL
DW environment to accommodate increased activity, monitoring will stop until an updated license that
includes additional license units is applied.

Applying a New SentryOne License
When your license is near expiration, a notification that your license is about to expire displays on the SQL
Sentry client status bar. Manage your license within the SQL Sentry client by completing the following:
1. Select Help on the client toolbar, and then select Manage License to open the License Entry dialog
box.

2. Select Edit to change your license information. Select Clear to erase the current license from the text
box.
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3. Copy your new product license from the SentryOne customer portal, and then paste the text in the textbox, or drag-and-drop a license file into the space provided. Select Save to save the changes to your
license, and then select OK to close the License Entry dialog box. This opens the License Change
Detected prompt.

4. Select OK to restart the application with your new license.

 Success: You have now successfully updated your SentryOne SQL Sentry License!

SentryOne Licensing Errors
License Key Mismatch

Receiving this error while applying the license key indicates that the hardware key of the license doesn't
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match the name of the server currently housing the SQL Sentry database. This typically happens when you
need to migrate your SQL Sentry Database to a new instance of SQL Server, or to a new server altogether.

 Note: To get the instance name, connect to the server where the SQL Sentry database will reside and
run the following query:
SELECT serverproperty('servername')

Resolve this error by logging into your Customer portal account, and then update the instance name. To
update the hardware key of the license in the Customer portal complete the following steps:
1. Scroll to the Licenses section at the bottom of the Customer portal.
2. Select the license you'd like to modify from the Perpetual License list on the left.
3. In the Update Server Name section, enter the name of the SQL Server instance housing the SQL Sentry
database, and the reason for making this change.
4. Select Update to update the license. In the License Key form, choose to email the new license key or
copy it to the clipboard.

Product Version Mismatch

Receiving this error indicates that the version number of the license that you're applying isn't valid for the
version of SQL Sentry that you're running.

 Note: This error message may be encountered when you try to apply a license after a major version
upgrade because the version number of the license keys are incremented for each major version release.

Resolve this issue by logging into your Customer portal, and then update the license version. To upgrade the
license key in the Customer portal, complete the following steps:
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1. Go to the Available Upgrades section in the portal.
2. Select the license key(s) that you'd like to upgrade, and then select Upgrade.

 Note: Once the license is upgraded, the new license key is emailed to you.

Invalid Signature

Receiving this error indicates that the license key has been modified.

 Note: Adding an extra character or space in the license key trigger this error message.

Resolve this issue by selecting the original license key attachment from the licensing email and reapplying it,
or select the original license key from the Customer portal and reapply it.

Invalid License Schema

Receiving this error indicates that the license key has been modified. This error is specific to the license key
being modified by an email-security system.
Resolve this issue by selecting the original license key attachment from the licensing email and reapplying it,
or select the original license key from the Customer portal and reapply it.
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Changing the credentials of the SQL Sentry Monitoring Service Account
To update the account credentials used for the monitoring service, see the Monitoring Service Logon Account
article for instructions on using the Service Configuration Utility.

Hosting the SentryOne Database On An Availability Group
Hosting the SQL Sentry database on an availability group gives you a License Key Mismatch error because
SQL Sentry recognizes that the SQL Sentry database is part of an Availability Group and is looking for the
Availability Group ID, rather than the server currently hosting the database.
To allow licensing to be aware of SQL Sentry database movements and continue working, the Hardware Key
must be tied to the Availability Group ID.
You can get this ID by executing the below query against the instance that will be hosting the SQL Sentry
database:
SELECT group_id as AG_ID, name
FROM sys.availability_groups

Next, update the hardware key through the Customer portal.

 Important: When running the client, use the Listener name for the Server Name. This allows the
Monitoring Service to connect regardless of where the database is currently hosted.
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SentryOne License Management (Deprecated)
Last Modified on 12 July 2021

 Important: SQL Sentry versions 2021.8 or later are licensed with a SolarWinds license through the
SolarWinds License Manager. SQL Sentry versions before 2021.8 are licensed with a SentryOne license.

SentryOne License Management for SQL Sentry
Deprecated: This section applies only to SentryOne-branded versions of SQL Sentry (earlier than
2021.8).

The Hardware Key
Your SentryOne SQL Sentry license has a hardware key that's tied to the location of your SQL Sentry database
(denoted by the SQL Server instance name). If you decide to relocate the SQL Sentry database, this hardware
key can be updated through the SentryOne Customer Portal by any authorized account holder (see the
SentryOne Account Management article). Contact support if you have any issues. For more information about
moving the SQL Sentry database, see the Relocating the SQL Sentry Database topic.
An exception to this process is when the SQL Sentry database is part of an Availability Group. To allow
licensing to be aware of the SQL Sentry database and to continue working, the hardware key must be tied to
the Availability Group ID. You can get this ID by executing the following query against the instance that will be
hosting the SQL Sentry database:
SELECT group_id as AG_ID, name
FROM sys.availability_groups

For more information, see the Hosting SQL Sentry Database On An Availability Group article.

APS and DW Sentry Licensing
EOL: These products (APS Sentry and DW Sentry) are no longer for sale.

The licensing for Microsoft Analytics Platform System (APS) and SQL Data Warehouse (SQL DW) differ from
the traditional SQL Sentry licensing model. APS is licensed by the number of Compute nodes on the target,
and SQL DW is a flat monthly subscription with an annual term.
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 Important: If the number of Compute nodes exceeds the number of license units, monitoring will be
suspended until additional license units are applied. For example, if a SQL DW target with six compute
nodes is being monitored with a six node license, and then two additional nodes are added to the SQL
DW environment to accommodate increased activity, monitoring will stop until an updated license that
includes additional license units is applied.

Applying a New SentryOne License
When your license is near expiration, a notification that your license is about to expire displays on the SQL
Sentry client status bar. Manage your license within the SQL Sentry client by completing the following:
1. Select Help on the client toolbar, and then select Manage License to open the License Entry dialog
box.

2. Select Edit to change your license information. Select Clear to erase the current license from the text
box.

3. Copy your new product license from the SentryOne customer portal, and then paste the text in the textbox, or drag-and-drop a license file into the space provided. Select Save to save the changes to your
license, and then select OK to close the License Entry dialog box. This opens the License Change
Detected prompt.
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4. Select OK to restart the application with your new license.

 Success: You have now successfully updated your SentryOne SQL Sentry License!

SentryOne Licensing Errors
License Key Mismatch

Receiving this error while applying the license key indicates that the hardware key of the license doesn't
match the name of the server currently housing the SQL Sentry database. This typically happens when you
need to migrate your SQL Sentry Database to a new instance of SQL Server, or to a new server altogether.
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 Note: To get the instance name, connect to the server where the SQL Sentry database will reside and
run the following query:
SELECT serverproperty('servername')

Resolve this error by logging into your Customer portal account, and then update the instance name. To
update the hardware key of the license in the Customer portal complete the following steps:
1. Scroll to the Licenses section at the bottom of the Customer portal.
2. Select the license you'd like to modify from the Perpetual License list on the left.
3. In the Update Server Name section, enter the name of the SQL Server instance housing the SQL Sentry
database, and the reason for making this change.
4. Select Update to update the license. In the License Key form, choose to email the new license key or
copy it to the clipboard.

Product Version Mismatch

Receiving this error indicates that the version number of the license that you're applying isn't valid for the
version of SQL Sentry that you're running.

 Note: This error message may be encountered when you try to apply a license after a major version
upgrade because the version number of the license keys are incremented for each major version release.

Resolve this issue by logging into your Customer portal, and then update the license version. To upgrade the
license key in the Customer portal, complete the following steps:
1. Go to the Available Upgrades section in the portal.
2. Select the license key(s) that you'd like to upgrade, and then select Upgrade.
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 Note: Once the license is upgraded, the new license key is emailed to you.

Invalid Signature

Receiving this error indicates that the license key has been modified.

 Note: Adding an extra character or space in the license key trigger this error message.

Resolve this issue by selecting the original license key attachment from the licensing email and reapplying it,
or select the original license key from the Customer portal and reapply it.

Invalid License Schema

Receiving this error indicates that the license key has been modified. This error is specific to the license key
being modified by an email-security system.
Resolve this issue by selecting the original license key attachment from the licensing email and reapplying it,
or select the original license key from the Customer portal and reapply it.

Changing the credentials of the SQL Sentry Monitoring Service Account
To update the account credentials used for the monitoring service, see the Monitoring Service Logon Account
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article for instructions on using the Service Configuration Utility.

Hosting the SentryOne Database On An Availability Group
Hosting the SQL Sentry database on an availability group gives you a License Key Mismatch error because
SQL Sentry recognizes that the SQL Sentry database is part of an Availability Group and is looking for the
Availability Group ID, rather than the server currently hosting the database.
To allow licensing to be aware of SQL Sentry database movements and continue working, the Hardware Key
must be tied to the Availability Group ID.
You can get this ID by executing the below query against the instance that will be hosting the SQL Sentry
database:
SELECT group_id as AG_ID, name
FROM sys.availability_groups

Next, update the hardware key through the Customer portal.

 Important: When running the client, use the Listener name for the Server Name. This allows the
Monitoring Service to connect regardless of where the database is currently hosted.
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Add Users and Groups
Last Modified on 24 January 2022

Contacts
The Contacts node in the Navigator pane contains the Users and Groups sub-nodes. Create and maintain
Users and Groups for notification purposes.

 Note: At least one User is required for SQL Sentry to send notifications. For notifications, we
recommend that you use Groups with nested Users.

Adding a New User
Add a new user with the Add a User tab. To open the Add a User tab, complete one of the following steps:
Double-click the Users node ( Contacts > Users) in the Navigator pane.

Right-click the Users node (Contacts > Users) in the Navigator pane, and then select New.
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Enter the user's first and last name, email address, optional pager address (SMTP-based), and an
optional description in their respective fields.

 Note: Add as many users and groups as you want at this point. Groups are optional.

Select Save once you've finished adding new users.
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Adding a New Group
Add a new group with the Add a Group tab. To open the Add a Group tab, complete one of the following
steps:
Double-click the Groups node (Contacts > Groups) in the Navigator pane.
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Right-click the Groups node (Contacts > Groups) in the Navigator pane, and then select New.

Enter the group's name, login, and an optional description in their respective fields. Add users to the
group by selecting the desired user(s) and selecting Add - >, or add all users by selecting Add All - > >.
Save the group by selecting Save.
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Additional Information: For more information about Users and Groups, see the Contact Management
topic.
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Removing Watched Server Objects
Last Modified on 08 October 2021

Stop Watching
Enable Watching and Stop Watching on the targets within your server environment.

 Note: If you choose to Stop Watching a target, remember to reclaim the license for that target,
allowing you to apply it elsewhere. For more information, see the License Management article.

 Note: You can use PowerShell to stop watching targets. See the PowerShell Module article for more
information.

 Note: The Inventory node provides a read-only view of what you are watching. See the Inventory
View article for details.

To Stop Watching a target in SentryOne, complete one of the following procedures:

Using the Navigator pane
Stop watching a target through the Navigator pane:
View > Navigator > Desired Target > Stop Watching
1. Open the Navigator pane (View > Navigator), and then select your desired target.
2. Right-click on the desired target, and then select Stop Watching.
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Stop watching a target hosting a SQL Server instance through the Navigator pane:
View > Navigator > Desired Target > Desired Instance > Stop Watching Instance
1. Open the Navigator pane (View > Navigator), and then expand your desired target.

2. Right click on the SQL Server Instance, and then select Stop Watching Instance.
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3. Right click on the target, and then select Stop Watching.

Using Performance Overview
Stop watching through Performance Overview:
1. Right-click All Targets (View > Navigator > All Targets), select Open, and then select Performance
Overview. This opens the All Targets tab.
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2. Right-click on the desired target, then select Stop Watching.

Removing Watched Server Objects
 Note: When you watch a SQL Server with Event Manager, SQL Sentry places a few objects in MSDB
that facilitate its lightweight polling architecture. No agents are placed on the server. This enables SQL
Sentry to monitor the server with a performance overhead that's typically less than SQL Agent. For
more information about watched server objects, see the Watched Server Objects topic.

If you've stopped watching a SQL Server instance or Azure SQL Database target with SentryOne, and don't
have plans to Watch it again, scripts are provided to automate the process of removing the objects
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SentryOne places on a watched target.

 Important: Stop Watching the server through the SentryOne client before attempting to remove the
object.

Select the appropriate tab below to view the script.

SQL Server 2000 Instances
--SQL Server 2000
USE msdb
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[sp_sentry_mail]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[sp_sentry_mail]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[sp_sentry_mail_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[sp_sentry_mail_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryEmails_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryEmails_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spGetBlockInfo_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetBlockInfo_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spGetBlockInfo_Pre8sp3]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetBlockInfo_Pre8sp3]
GO
BEGIN TRANSACTION
DECLARE @JobID BINARY(16)
DECLARE @ReturnCode INT
SELECT @ReturnCode = 0
-- Delete the job with the same name (if it exists)
SELECT @JobID = job_id
FROM msdb.dbo.sysjobs
WHERE (name = N'SQL Sentry 2.0 Queue Monitor')
IF (@JobID IS NOT NULL)
BEGIN
-- Check if the job is a multi-server job
IF (EXISTS (SELECT *
FROM msdb.dbo.sysjobservers
WHERE (job_id = @JobID) AND (server_id <> 0)))
BEGIN
-- There is, so abort the script
RAISERROR (N'Unable to import job ''SQL Sentry Queue Monitor'' since there is already a multi-server job with this na
me.', 16, 1)
GOTO QuitWithRollback
END
ELSE
-- Delete the [local] job
EXECUTE msdb.dbo.sp_delete_job @job_name = N'SQL Sentry 2.0 Queue Monitor'
SELECT @JobID = NULL
END
COMMIT TRANSACTION
GOTO EndSave QuitWithRollback:
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GOTO EndSave QuitWithRollback:
IF (@@TRANCOUNT > 0) ROLLBACK TRANSACTION
EndSave:
GO
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spGetJobInfo_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetJobInfo_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spGetDTSLog_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetDTSLog_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spQueueHeartbeat_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueHeartbeat_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spQueueJob_Start_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueJob_Start_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spQueueJob_End_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueJob_End_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spQueueMonitor_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueMonitor_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spReadLogFile_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spReadLogFile_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryQueueLog_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryQueueLog_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryLogCache_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogCache_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryLogCacheDTS_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogCacheDTS_20]
GO
BEGIN TRANSACTION
DECLARE @JobID BINARY(16)
DECLARE @ReturnCode INT
SELECT @ReturnCode = 0
-- Delete the job with the same name (if it exists)
SELECT @JobID = job_id
FROM msdb.dbo.sysjobs
WHERE (name = N'SQL Sentry 2.0 Alert Trap')
IF (@JobID IS NOT NULL)
BEGIN
-- Check if the job is a multi-server job
IF (EXISTS (SELECT *
FROM msdb.dbo.sysjobservers
WHERE (job_id = @JobID) AND (server_id <> 0)))
BEGIN
-- There is, so abort the script
RAISERROR (N'Unable to import job ''SQL Sentry Alert Trap'' since there is already a multi-server job with this name.',
16, 1)
GOTO QuitWithRollback
END
ELSE
-- Delete the [local] job
EXECUTE msdb.dbo.sp_delete_job @job_name = N'SQL Sentry 2.0 Alert Trap'
SELECT @JobID = NULL
END
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END
COMMIT TRANSACTION
GOTO EndSave QuitWithRollback:
IF (@@TRANCOUNT > 0) ROLLBACK TRANSACTION
EndSave:
GO
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spTrapAlert_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spTrapAlert_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spSetupAlertsTrap_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spSetupAlertsTrap_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryAlertLog_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryAlertLog_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryLogData_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogData_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryObjectVersion_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryObjectVersion_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[fnGetSQL_20]')
and OBJECTPROPERTY(id, N'IsScalarFunction') = 1)
drop function [dbo].[fnGetSQL_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[fnGetWaittypeDesc_20]')
and OBJECTPROPERTY(id, N'IsScalarFunction') = 1)
drop function [dbo].[fnGetWaittypeDesc_20]

SQL Server 2005+ Instances
--SQL Server 2005+
USE msdb
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[sp_sentry_mail]') and OBJECTPROPERTY(object
_id, N'IsProcedure') = 1)
drop procedure [dbo].[sp_sentry_mail]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[sp_sentry_mail_20]') and OBJECTPROPERTY(ob
ject_id, N'IsProcedure') = 1)
drop procedure [dbo].[sp_sentry_mail_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[sp_sentry_dbmail_20]') and OBJECTPROPERTY(
object_id, N'IsProcedure') = 1)
drop procedure [dbo].[sp_sentry_dbmail_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryEmails_20]') and OBJECTPROPERTY(
object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryEmails_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryDBEmails_Attachments_20]') and O
BJECTPROPERTY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryDBEmails_Attachments_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryDBEmails_20]') and OBJECTPROPER
TY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryDBEmails_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetBlockInfo_20]') and OBJECTPROPERTY(ob
ject_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetBlockInfo_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetBlockInfo_Pre8sp3]') and OBJECTPROPER
TY(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetBlockInfo_Pre8sp3]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetQueryStatsData]') and OBJECTPROPERTY
(object_id, N'IsProcedure') = 1)
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(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetQueryStatsData]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetProcedureStatsData]') and OBJECTPROPE
RTY(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetProcedureStatsData]
GO
BEGIN TRANSACTION
DECLARE @JobID BINARY(16)
DECLARE @ReturnCode INT
SELECT @ReturnCode = 0
-- Delete the job with the same name (if it exists)
SELECT @JobID = job_id
FROM msdb.dbo.sysjobs
WHERE (name = N'SQL Sentry 2.0 Queue Monitor')
IF (@JobID IS NOT NULL)
BEGIN
-- Check if the job is a multi-server job
IF (EXISTS (SELECT *
FROM msdb.dbo.sysjobservers
WHERE (job_id = @JobID) AND (server_id <> 0)))
BEGIN
-- There is, so abort the script
RAISERROR (N'Unable to import job ''SQL Sentry Queue Monitor'' since there is already a multi-server job with this na
me.', 16, 1)
GOTO QuitWithRollback
END
ELSE
-- Delete the [local] job
EXECUTE msdb.dbo.sp_delete_job @job_name = N'SQL Sentry 2.0 Queue Monitor'
SELECT @JobID = NULL
END
COMMIT TRANSACTION
GOTO EndSave QuitWithRollback:
IF (@@TRANCOUNT > 0) ROLLBACK TRANSACTION
EndSave:
GO
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetJobInfo_20]') and OBJECTPROPERTY(obje
ct_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetJobInfo_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetDTSLog_20]') and OBJECTPROPERTY(obj
ect_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetDTSLog_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spQueueHeartbeat_20]') and OBJECTPROPERT
Y(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueHeartbeat_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spQueueJob_Start_20]') and OBJECTPROPERTY
(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueJob_Start_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spQueueJob_End_20]') and OBJECTPROPERTY(
object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueJob_End_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spQueueMonitor_20]') and OBJECTPROPERTY(o
bject_id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueMonitor_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spReadLogFile_20]') and OBJECTPROPERTY(obj
ect_id, N'IsProcedure') = 1)
drop procedure [dbo].[spReadLogFile_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryQueueLog_20]') and OBJECTPROPER
TY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryQueueLog_20]
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drop table [dbo].[SQLSentryQueueLog_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryLogCache_20]') and OBJECTPROPER
TY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogCache_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryLogCacheDTS_20]') and OBJECTPRO
PERTY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogCacheDTS_20]
GO
BEGIN TRANSACTION
DECLARE @JobID BINARY(16)
DECLARE @ReturnCode INT
SELECT @ReturnCode = 0
-- Delete the job with the same name (if it exists)
SELECT @JobID = job_id
FROM msdb.dbo.sysjobs
WHERE (name = N'SQL Sentry 2.0 Alert Trap')
IF (@JobID IS NOT NULL)
BEGIN
-- Check if the job is a multi-server job
IF (EXISTS (SELECT *
FROM msdb.dbo.sysjobservers
WHERE (job_id = @JobID) AND (server_id <> 0)))
BEGIN
-- There is, so abort the script
RAISERROR (N'Unable to import job ''SQL Sentry Alert Trap'' since there is already a multi-server job with this name.',
16, 1)
GOTO QuitWithRollback
END
ELSE
-- Delete the [local] job
EXECUTE msdb.dbo.sp_delete_job @job_name = N'SQL Sentry 2.0 Alert Trap'
SELECT @JobID = NULL
END
COMMIT TRANSACTION
GOTO EndSave QuitWithRollback:
IF (@@TRANCOUNT > 0) ROLLBACK TRANSACTION
EndSave:
GO
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spTrapAlert_20]') and OBJECTPROPERTY(object
_id, N'IsProcedure') = 1)
drop procedure [dbo].[spTrapAlert_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spSetupAlertsTrap_20]') and OBJECTPROPERTY
(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spSetupAlertsTrap_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryAlertLog_20]') and OBJECTPROPERT
Y(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryAlertLog_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryLogData_20]') and OBJECTPROPERT
Y(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogData_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryObjectVersion_20]') and OBJECTPRO
PERTY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryObjectVersion_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[fnGetSQL_20]') and OBJECTPROPERTY(object_i
d, N'IsScalarFunction') = 1)
drop function [dbo].[fnGetSQL_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[fnGetWaittypeDesc_20]') and OBJECTPROPERT
Y(object_id, N'IsScalarFunction') = 1)
drop function [dbo].[fnGetWaittypeDesc_20]
if exists (select * from sys.objects where object_id = object_id(N'[SQLSentry].[SQLSentryObjectVersion_20]') and OBJE
CTPROPERTY(object_id, N'IsUserTable') = 1)
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CTPROPERTY(object_id, N'IsUserTable') = 1)
drop table [SQLSentry].[SQLSentryObjectVersion_20]

Azure SQL Database
--Azure
if exists (select * from sys.objects where object_id = object_id(N'[SQLSentry].[spGetProcedureStatsData]') and OBJECT
PROPERTY(object_id, N'IsProcedure') = 1)
drop procedure [SQLSentry].[spGetProcedureStatsData]
if exists (select * from sys.objects where object_id = object_id(N'[SQLSentry].[spGetQueryStatsData]') and OBJECTPR
OPERTY(object_id, N'IsProcedure') = 1)
drop procedure [SQLSentry].[spGetQueryStatsData]
if exists (select * from sys.objects where object_id = object_id(N'[SQLSentry].[SQLSentryObjectVersion_20]') and OBJE
CTPROPERTY(object_id, N'IsUserTable') = 1)
drop table [SQLSentry].[SQLSentryObjectVersion_20]
DECLARE @listOfSqlSentryTables VARCHAR(MAX)
DECLARE @sqlStatement VARCHAR(MAX)
select @listOfSqlSentryTables = COALESCE(@listOfSqlSentryTables+',' ,'') + 'SQLSentry.' +name from sys.objects wh
ere name like N'ProcedureStats%' and OBJECTPROPERTY(object_id, N'IsUserTable') = 1 and schema_id = schema_id('
SQLSentry')
set @sqlStatement = 'drop table ' + @listOfSqlSentryTables
exec(@sqlStatement)
SET @listOfSqlSentryTables = NULL;
select @listOfSqlSentryTables = COALESCE(@listOfSqlSentryTables+',' ,'') + 'SQLSentry.' +name from sys.objects wh
ere name like N'QueryStats%' and OBJECTPROPERTY(object_id, N'IsUserTable') = 1 and schema_id = schema_id('SQL
Sentry')
set @sqlStatement = 'drop table ' + @listOfSqlSentryTables
exec(@sqlStatement)
if schema_id('SQLSentry') is not null
drop schema SQLSentry
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SQL Sentry PowerShell Module
Last Modified on 07 April 2022

Getting Started
PowerShell Requirements
The following versions of Windows PowerShell are compatible with the SQL Sentry PowerShell module:
3.0
4.0
5.0
5.1

 Note: PowerShell Core is not supported.

The SQL Sentry installation package includes a PowerShell module that can be used to manage your SQL
Sentry environment through PowerShell. This topic includes a walkthrough of that functionality.

Importing the module
You'll find the PowerShell module in the SQL Sentry program directory (which varies depending on the
installed ):
Versions 2021.8 or later:

C:\Program Files\SolarWinds SQL Sentry\\Intercerve.SQLSentry.Powershell.psd1
Versions prior to 2021.8:

C:\Program Files\SentryOne\\Intercerve.SQLSentry.Powershell.psd1
Import the SQL Sentry PowerShell module by using the Import-Module command.
Import-Module command example for version 2021.x:
Import-Module " C:\Program Files\SolarWinds SQL Sentry\2021.0\Intercerve.SQLSentry.Powershell.psd1"

Import-Module command example for version 19.x:
Import-Module " C:\Program Files\SentryOne\19.0\Intercerve.SQLSentry.Powershell.psd1"
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Import-Module command example for version 20.x:
Import-Module " C:\Program Files\SentryOne\20.0\Intercerve.SQLSentry.Powershell.psd1"

Import-Module Example with version 2020.0

 Note: When using the Enhanced Platform Installer (EPI), the module location is as follows (if the
machine has both a client and monitoring service installed, the module will appear in both locations):
Monitoring Service
On a machine with the monitoring service installed:

C:\ProgramData\SentryOne\monitoringservice\bin\Intercerve.SQLSentry.Powershell.psd1
Client
On a machine with the client installed:

C:\Users\\Documents\sentryone\client\\\bin\Intercerve.SQLSentry.Powershell.psd1
For example:

C:\Users\mconnors\Documents\sentryone\client\QA-SRV1\SentryOne\bin\Intercerve.SQLSentry.Powershell.psd1

Verify that the module imported correctly by running the Get-Module command. You should see a listing for
Intercerve.SentryOne.Powershell.
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Get-Module Example showing the Intercerve.SQLSentry.PowerShell

Additional Information: For more information about Get-Module commands, see Microsoft Get
Module Commands.

Available Commands
See the Command Examples section for more information on using available commands.

Command

Description
Allows you to connect to a specific SQL Sentry installation that's
required before any other actions are performed. This command is
useful for navigating between repositories, and is used in
environments with more than one SQL Sentry database.

Connect-SQLSentry

Disable-User

Disconnect-SQLSentry

Enable-User

Available parameters
DatabaseName
Login
Password
ServerName
UseIntegratedSecurity

Disable a SQL Sentry user account.

Allows you to disconnect from a specific SQL Sentry installation.
Useful for environments with more than one SQL Sentry database.

Enable a SQL Sentry user account.
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Command

Description
Allows you to view computers in your environment.

Get-Computer

Available Parameters
ComputerType
{Windows | VMwareHost | ApsAppliance |
SqlDataWarehouse | AzureSqlDatabase |
AzureElasticPool}
ID
Name
Information returned
Name
HostName
DomainName
ObjectID
ID
ComputerType
AccessLevel

Allows you to view connections in your environment.

Get-Connection

Available parameters
ConnectionType
{SqlServer | SqlServerAnalysisServices | RDSSqlServer}
ID
Name
ObjectID
Information returned
Name
ServerName
InstanceName
ObjectID
ID
ConnectionType
WatchedBy

Allows you to view groups in your environment.
Available Parameters
Name
Username
Get-Group

Information returned
Name
Description
IsEnabled
ObjectID
ID
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Command

Description
Allows you to view sites in your environment.
 Note: This includes both sites and groups in the return.

Get-Site

Available Parameters
ID
Name

Allows you to view basic information about your SQL Sentry
configuration.

Get-SQLSentryConfiguration

Information returned
SQLServer
Database
UseIntegratedSecurity
DatabaseLogin
DatabaseVersion
ApplicationDatabaseVersion
ApplicationPath
ApplicationVersion
ServerTime
ServerTimeUtc

Allows you to view information about users in your environment.
 Note: See examples in the code section below for piping with
Add-GroupUser and Remove-GroupUser to manager group
memberships for users.

Get-User

Available Parameters
FirstName
Name
EmailAddress
ID
Group
Information returned
FirstName
LastName
EmailAddress
PagerAddress
Description
IsEnabled
ObjectID
ID
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Command

Description
Allows you to stop watching a connection with SQL Sentry.

Invoke-UnwatchConnection

Available Parameters
Connection

Allows you to watch a computer with SQL Sentry.
Invoke-WatchComputer

Available Parameters
Computer
LicenseMode

Allows you to watch a connection with SQL Sentry.
Invoke-WatchConnection

Available Parameters
Connection

Allows you to register a computer to be watched with SQL Sentry.

Register-Computer

Available Parameters
ComputerType
Name
AccessLevel
DatabaseName
Login
Password
Port
TargetSite
UseIntegratedSecurity
AllowAzureRemoteObjectInstallation
 Note: AllowAzureRemoteObjectInstallation is only valid for
Azure SQL Database targets.
Additional Information: For more information about adding
servers, see the Automating adding servers to SentryOne
article.
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Command

Description
Allows you to register a connection to be watched with SQL Sentry.

Register-Connection

Available Parameters
ConnectionType
Name
Login
Password
Port
TargetSite
UseIntegratedSecurity

Register-Group

Adds a new user group.

Register-User

Adds a new SQL Sentry user.

Unregister-Group

Removes an existing user group.

Unregister-User

Removes an existing SQL Sentry user.

Advisory Conditions & Configurations
 Note: The advisory condition and configuration commands in the following tables are only available
in SQL Sentry versions 2021.1.13 or later.

Advisory Conditions
The advisory condition commands use the same logic that is found in the individual import and export
features on the SQL Sentry client menu, but they allow for bulk importing and exporting of .condition files.

Command

Description
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Command

Description
Returns one or more advisory condition file items.
 Note: You can filter advisory conditions by using ConvertFromJson and then operating on any advisory condition object
properties.

Export-AdvisoryCondition

Required
Must use

to write to file system.
command can only use files.
to write out multiple files.

Out-File -FilePath

Import-AdvisoryCondition

Must use

foreach

Parameters
Name
Advisory condition name search pattern which can
include wildcards (%).

Imports one or more advisory conditions.

Import-AdvisoryCondition

Parameters
Path
File or directory name.
SearchPattern
File name pattern to use with directory can which can
include wildcards (%).
Default is *.condition

Deletes one or more advisory conditions.

Remove-AdvisoryCondition

Parameters
Name
Advisory condition name search pattern which can
include wildcards (%).

Configurations
The configuration file is stored in a JSON document and may be edited as needed.
The configuration commands include the following in the import/export:
Advisory Conditions
Conditions/Actions
Rulesets, Windows, Filters, etc.
Users and Groups (assigned)
All Global (All Targets) Settings
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Command

Description

Exports a SQL Sentry system configuration in JSON format. The
export may be written to a variable or file.
ExportEnvironmentConfiguration

Switches
ExcludeAdvisoryConditions
ExcludeContacts
ExcludeConditionActions
ExcludeGlobalSettings

Imports and applies a SQL Sentry system configuration from a
variable or file in a JSON format.

ImportEnvironmentConfiguration

Parameters
Config
Variable containing the JSON configuration.
Path
Path to the JSON configuration file.
Switches
ExcludeAdvisoryConditions
ExcludeContacts
ExcludeConditionActions
ExcludeGlobalSettings

Get-Help
Use Get-Help followed by a command to get information about the available commands in the table above.
For example, to learn more about Get-Connection:
Get-Help Get-Connection
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Get-Help Get-Connection Example

Command Examples
You can get a file of all these command examples from GitHub in the SentryOne PowerShell Module
Commands.ps1 file.

Import the SQL Sentry PowerShell Module
<# Import the SQL Sentry PowerShell Module #>
Import-Module "C:\Program Files\SentryOne\2020.0\Intercerve.SQLSentry.Powershell.psd1"

Connect to SQL Sentry Installation
<# Connect to a specific SQL Sentry Installation #>
Connect-SQLSentry -ServerName server.domain.com -DatabaseName SQLSentry

Connect to SQL Sentry Installation with SQL Authentication
<# Connect to a specific SQL Sentry Installation with SQL Authentication #>
Connect-SQLSentry -ServerName server.domain.com -DatabaseName DBname -UseIntegratedSecurity 0 -login userna
me -Password pass1234

Get SQL Sentry Installation Information
<# Get Information about your SQL Sentry Installation #>
Get-SQLSentryConfiguration

Get SQL Sentry Information for Sites
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<# Get Information about the Sites in your SQL Sentry Installation -use parameters to find information for a specific si
te #>
Get-Site

Get SQL Sentry Information for Instances
<# Get Information about the Connections (Instances) in your SQL Sentry Installation -use parameters to find informa
tion for a specific connection #>
Get-Connection

Get SQL Sentry Information for Targets
<# Get Information about the Computers (Targets) in your SQL Sentry Installation -use parameters to find information
for a specific connection #>
Get-Computer

Get SQL Sentry Information for Specific Target
<# Get Information about the Connections in your SQL Sentry Installation -use parameters to find information for a sp
ecific connection #>
Get-Connection

Register a Target
<# Register Computers (Targets), so that they can be watched in your environment #>
Register-Computer -ComputerType Windows -Name server.domain.com -AccessLevel Full Register-Computer -Comput
erType Windows -Name server.domain.com -AccessLevel Limited

Register a Target (non Windows e.g., Azure SQL DB)
<# Register a Target that cannot utilize Windows Authentication (e.g., Azure SQL Database) #>
Register-Computer -ComputerType AzureSqlDatabase -Name example.database.windows.net -DatabaseName dbNam
e -Login username -Password password -AccessLevel Full -UseIntegratedSecurity 0 -AllowAzureRemoteObjectInstallati
on $true | Invoke-WatchComputer

Register Instances
<# Register Connections (Instances), so that they can be watched in your environment #>
Register-Connection -ConnectionType SqlServerAnalysisServices -Name server.domain.com Register-Connection -Con
nectionType SqlServer -Name server.domain.com

Watch a Windows Target
<# Watch Windows Computer (Target) with SQL Sentry | -Pipe in the Computer #>
Get-Computer -Name server.domain.com -NamedServerComputerType Windows | Invoke-WatchComputer

Watch a Hyper-V Host Target
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<# Watch Hyper-V Host (Target) with SQL Sentry (core-based licensing) | -Pipe in the Computer #>
Get-Computer -Name server.domain.com -NamedServerComputerType Windows | Invoke-WatchComputer -LicenseMo
de CoreBased

Watch a SQL Server Target
<# Watch SQLServer Connection (Instance) with SQL Sentry | -Pipe in the Connection #>
Get-Connection -Name server.domain.com -NamedServerConnectionType SqlServer | Invoke-WatchConnection

Watch a SSAS Target
<# Watch SSAS Connection (Instance) with SQL Sentry | -Pipe in the Connection #>
Get-Connection -Name server.domain.com -NamedServerConnectionType SqlServerAnalysisServices | Invoke-WatchC
onnection

Unwatch Target
<# Unwatch Windows computer (Target) #>
Get-Computer -Name server.domain.com -NamedServerComputerType Windows | Invoke-UnwatchComputer

Unwatch SSAS Connection
<# Unwatch SSAS connection #>
Get-Connection -Name server.domain.com -NamedServerConnectionType SqlServerAnalysisServices | Invoke-Unwatc
hConnection

Unwatch SQL Server Connection
<# Unwatch SQLServer connection #>
Get-Connection -Name server.domain.com -NamedServerConnectionType SqlServer| Invoke-UnwatchConnection

User cmdlets
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<# User cmdlets #>
<# Add a user #>
Register-User -FirstName Test -LastName User -Email tuser@test.net -PagerAddress tuser@testPager.net -Description
Tester -Login domain\username
<# View a user by first name #>
Get-User -FirstName Test
<# View a user by name #>
Get-User -Name "Test User"
<# Disable a user by name #>
Disable-User -Name "Test User"
<# Enable a user by name #>
Enable-User -Name "Test User"
<# Remove a user by name #>
Unregister-User -Name "Test User"

Group cmdlets
<# Group cmdlets #>
<# Create a new group #>
Register-Group -Name "Test Group" -Description "A Group" -Login Domain\TestGroup
<# View group information #>
Get-Group -Name "Test Group"
<# Disable a group #>
Disable-Group -Name "Test Group"
<# Enable a group #>
Enable-Group -Name "Test Group"
<# Remove a group #>
Unregister-Group -Name "Test Group"

User and Group cmdlets
<# User = and - to the Group cmdlets #>
<# Add a user to a group #>
Get-User -Name "Test User" | Add-GroupUser -GroupName "Test Group"
<# Remove a user from a group #>
Get-User -Name "Test User" | Remove-GroupUser -GroupName "Test Group"

 Important: For performance considerations, when using scripts to bulk add targets, we recommend
limiting the text file list to batches of 50-100 targets at a time.
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PowerShell Sample Scripts
The following code samples are available in the sentryone-samples / powershell repository on GitHub.
Watch all targets listed in text file.ps1
Watch all targets listed in text file (Azure).ps1

Export/Import/Remove Advisory Conditions
$exportdirectory = "C:\Users\\Documents\conditions"
$count = 0
foreach ($ac in Export-AdvisoryCondition)
{
$acj = $ac | ConvertFrom-Json
# Use .* for all ACs; separate multiple tags with vertical pipes (|).
$tags = '.*'
if ($acj.Tags -match $tags)
{
# Replace invalid file name chars
$filename = ($acj.Name -replace '[/<>]', '_') + ".condition"
$ac | Out-File -FilePath "$exportdirectory\$filename"
Write-Host "Exported: $filename"
$count++
}
}
Write-Host "$count conditions exported."
Import-AdvisoryCondition $exportdirectory # import all ACs
Import-AdvisoryCondition "$exportdirectory\High Compiles.condition"
Import-AdvisoryCondition -Path $exportdirectory -SearchPattern "Service Broker*“
Remove-AdvisoryCondition -Name "High Compiles"
Remove-AdvisoryCondition -Name "Service Broker%"
Remove-AdvisoryCondition -Name "%" # will not cascade delete dependent ACs

Export/Import Configurations
Using a configuration file
# Using config file
$exportdirectory = "C:\Users\\Documents\conditions"
Connect-SQLSentry -ServerName "server-name-us" -DatabaseName "SQLSentry-US"
Export-EnvironmentConfiguration -ExcludeAdvisoryConditions | Out-File -FilePath "$exportdirectory\env-config.json"
Disconnect-SQLSentry
Connect-SQLSentry -ServerName "server-name-uk" -DatabaseName "SQLSentry-UK"
Import-EnvironmentConfiguration -Path "$exportdirectory\env-config.json"
Disconnect-SQLSentry

Using a variable
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# Using variable
Connect-SQLSentry -ServerName "server-name-us" -DatabaseName "SQLSentry-US"
$s1config = Export-EnvironmentConfiguration
Disconnect-SQLSentry
Connect-SQLSentry -ServerName "server-name-uk" -DatabaseName "SQLSentry-UK"
Import-EnvironmentConfiguration -Config $s1config
Disconnect-SQLSentry
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Monitoring Service Logon Account
Last Modified on 30 July 2021

Warnings and Notes
 Warning:
Running the Service Configuration Utility is the only supported way of changing the stored
monitoring service credentials. Changing the security account using the services applet in the
Windows Control Panel causes the service to fail and isn't supported. The service appears to be
running, but is unable to perform any work due to an encryption error.
Do not use the Service Configuration Utility if you are using the EPI version of SQL Sentry. Refer
to the EPI Commands article for instructions on using the update command to change a password
or service account.

 Note: To only update a password, use the services applet in the Windows Control Panel.

Additional Information: For more information about the different requirements for the monitoring
service logon account, see the Monitoring Service Security topic.

Instructions
The Service Configuration Utility is used to change the stored credentials of the SQL Sentry monitoring
service. If the user account used by the monitoring service needs to be changed, the SQL Sentry Service
Configuration Utility needs to be run for the public/private key encryption to validate the change. The
ServiceConfiguration.exe utility is in the SQL Sentry program group on the Start menu. Change your SQL
Sentry Monitoring Service credentials by completing the following steps:
1. Run the SentryOne.App.MonitoringService.Configuration.exe application to open the Set SQL
Sentry Monitoring Service Login window.
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Service Configuration from the
Windows Start menu.

2. Enter your new password, and confirm your password in the applicable boxes on the Set SQL Sentry
Monitoring Service Login window. Select OK to confirm your changes.

Enter the new information for the monitoring service account.

3. If you have more than one SQL Sentry connection, you will see the SQL Sentry Database Connection
Management screen. Select the Connect button for the SQL Sentry connection you are updating.
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Select the connection you are updating.

4. Press any key to exit the Service Configuration Utility.

Update successful.

 Success: If everything completes successfully, a Service configuration complete message displays on
the Service Configuration command prompt window. Press any key to close out of the utility.
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Using gMSA
If you are using Group Managed Service Accounts (gMSA) for your monitoring service account, use the Is
gMSA? checkbox. Follow the same process as described above in the instructions. When Is gMSA? is checked,
the password fields are disabled.

Is gMSA? option

 Note: The service account will appear with a $ after it in the Service Configuration message and
service screen to denote that it is a gMSA account.

Example of $ appended to gMSA account name

Example of Log On As appearing with $ to indicate the service account is using gMSA
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 Note: gMSA is only available from the Service Configuration Utility, it is not available during the
initial installation for the SQL Sentry Unified Setup.

Using gMSA with EPI
See the isGmsa section of the EPI Commands article for instructions and examples. EPI allows gMSA to be
used during the installation and updates to the account.
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EPI Commands
Last Modified on 09 November 2021

Introduction
This article contains the available commands and flags for the Enhanced Platform Installer (EPI) version of
SQL Sentry.

Table of Commands & Examples
Command

Description

EPI
Version

Adds a connection registration.
 Note: The addreg command is per user connection, and details are
saved in the repositories.pref file in the local appdata folder.
so addreg -n --connectionServer --connectionDatabase

All

addreg

 Note: See the Managing Connections article for a detailed guide to
the connections and their properties in SQL Sentry.
Launches the Monitor Portal Configuration Utility.
configmp

so configmp

v2020.8.31+

 Note: This command must be run locally on the machine where SQL
Sentry Portal is installed to make changes.

151

Command

Description

EPI
Version

Creates a SQL Sentry database.
 Note: This is only used during the installation process.
so createdb -n

All

createdb

Displays more information on a specific command.
so help

help

All
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Command

Description

EPI
Version

Installs the SQL Sentry controller and monitoring service software.
 Important: The account used for the SQL Sentry monitoring
service must be a local admin to install the monitoring service.

 Note: Starting with version 2020.8, the --IAcceptLicenseTerms
switch must be added to the command to acknowledge acceptance of
the EULA.
This syntax will prompt you for your password and mask it:
so install --IAcceptLicenseTerms -n -u

This syntax allows you to type in your displayed password:
so install --IAcceptLicenseTerms -n -u -p

install

 Important: See the Password section below for information on
using non-alphanumeric characters such as spaces or quotes with
the -p flag.

All

The command will stop, and monitoring and controller service
installations will fail if these characters are not properly formatted
with quotes and the backslash escape character.
 Note: The so install and so uninstall commands are related to
installing or uninstalling the local SQL Sentry controller and
monitoring service, and they do not impact SQL Sentry controllers and
monitoring services running on other servers.
 Note: To install only the controller service, add the flag -installmonitoringservice (or just -m) followed by a parameter of 0.
For example:
--installmonitoringservice 0

or
-m 0
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Command

Installs SQL Sentry Monitor Portal.
Description

EPI
Version

See the Portal Configuration article for additional information.
 Note: Starting with version 2020.8, the --IAcceptLicenseTerms
switch must be added to the command to acknowledge acceptance of
the EULA.
so installmp --IAcceptLicenseTerms -n -s
-u

v20+

installmp

The switch -b is not valid in versions 2020.8.31 or later. This version
uses the Portal Configuration Utility to make updates after installing.
Installs a SQL Sentry monitoring service to a specified server.
 Important: The account used for the SQL Sentry monitoring
service must be a local admin to install the monitoring service.
 Note: This command is designed to install the monitoring service
on a machine where the controller service is already installed.

installms

 Note: Starting with version 2020.8, the --IAcceptLicenseTerms
switch must be added to the command to acknowledge acceptance of
the EULA.

All

so installms --IAcceptLicenseTerms -n -s -u
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Command

Description

EPI
Version

Lists information for services, packages, or registrations (determined
by the -t (--type) flag).
--type = services
Lists the current services associated with the SQL Sentry installation.
The following displays the Host (server), Status, SQL Sentry Version,
Service User Account, date and time of the last Heartbeat, the
number of targets being monitored, and the FQDN of the Controller
Service (potentially an *, indicating that the monitoring service is not
managed by a controller service).
 Note: A monitoring service can only be remotely managed if it is
managed by a controller service.
so list -t services -n

v20+

list

--type = packages
This is the same as running the listpackage command. See below for
an example of the output.
so list -t packages -n

--type = reg
This is the same as running the listreg command. See below for an
example of the output.
so list -t reg
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Command

Description

EPI
Version

Lists all packages in the SQL Sentry database.
so listpackage -n

All

listpackage

Lists existing connection registrations.
 Note: The listreg command is per user connection, and lists the
connections saved in the repositories.pref file in the local appdata
folder.
listreg

so listreg

All

Pushes an upgrade package to the SQL Sentry database.
Using the default path: c:\Program Files\SentryOne Framework\ and
default package: current.s1package:
so push -n

push

If you want to specify a path and package:

All

so push -n -f

In a simple upgrade scenario, you can combine the push/upgrade steps
by adding the -u flag to tell the push to perform the upgrade after
pushing the package.
so push -n -f -u
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Command

Description

EPI
Version

Removes all connection registrations.
 Note: The removeallreg command is per user connection, and
removes the connections saved in the repositories.pref file in the local
appdata folder.
so removeallreg

removeallreg

Removing all connection registrations at once:

All

Removes a connection registration.
 Note: The removereg command is per user connection, and
removes the connection saved in the repositories.pref file in the local
appdata folder.
All

removereg
so removereg -n

Starts the SQL Sentry controller.
so start -n

start

All
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Command

Description

EPI
Version

Starts the SQL Sentry Monitor Portal service.
so startmp -n -s

v20+

startmp

Starts a SQL Sentry monitoring service.
so startms -n -s

All

startms

 Note: See the Flags section below this table for information on
using the --all option.
Stops the SQL Sentry controller.
so stop -n

All

stop

Stops the SQL Sentry Monitor Portal service.
so stopmp -n -s

stopmp

v20+
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Command

Description

EPI
Version

Stops a SQL Sentry monitoring service.
so stopms -n -s

All

stopms

 Note: See the Flags section below this table for information on
using the --all option.

Uninstalls the SQL Sentry controller and monitoring service software
(and SQL Sentry Monitor Portal service if installed).
 Note: The so uninstall -n command stops the SQL Sentry controller
and monitoring service (and SQL Sentry Monitor Portal service, if
installed) that are connected to and uninstalls them from the local
machine.
 Note: Use Add/Remove Programs to uninstall the remaining bits of
the SQL Sentry framework.
so uninstall -n

uninstall

All
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Command

Description

EPI
Version

Uninstalls the SQL Sentry Monitor Portal.
so uninstallmp -n -s

v20+

uninstallmp

Uninstalls a SQL Sentry monitoring service.
so uninstallms -n -s

uninstallms

All
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Command

Description

EPI
Version

Updates the password used for SQL Sentry service accounts. This is
designed for use after a password has been changed (i.e. expired due
to policy). It goes through all services in the SQL Sentry database
associated with the provided and updates the password for all services
with the specified .
If you are on version 2020.20.25+, you can update the service logon
account using the --replaceWith flag. See the replaceWith section
below for examples. Earlier versions cannot update the account
associated with the service and require you to uninstall/reinstall the
services.
update

 Note: There is a stop and start of the monitoring services involved
in the process in the background during the update.

v20+

 Note: This updates the password for the controller and monitoring
service if they are both found on a machine running under the .
so update -t services -n -u
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Command

Description

EPI
Version

Allows you to update the connection server or database name in a
connection registration.
Example of updating the --connectionServer:
so updatereg -n --connectionServer --connectionDatabase

This example updates the --connectionServer name from
SentryOneHost to MelissaS1.

All

updatereg

Example of updating the --connectionDatabase name from SentryOne
to SentryOneUpd .
so updatereg -n --connectionServer --connectionDatabase

 Note: The connection details saved in the repositories.pref file in
the local appdata folder with the updatereg command are per user.
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Command

Description

EPI
Version

Marks a SQL Sentry installation () for upgrade to a new version ( ).
 Note: Starting with version 2020.8, the --IAcceptLicenseTerms
switch must be added to the command to acknowledge acceptance of
the EULA.
so upgrade --IAcceptLicenseTerms -n -t

 Note: The will be in a format such as 20.0.4 for Version 20.0.4.
For example, performing an so listpackage will show you the
packages that are available, as well as the current package for your
installation:
All

upgrade

The current version is 20.0.1 as highlighted by <= CURRENT. To
upgrade to Version 20.0.4, the command would look like this:
so upgrade --IAcceptLicenseTerms -n SentryOneEPIDocs -t 20.0.4

 Note: so upgrade is a global command that informs all controller
services that an upgrade to version has been requested. Once this
request is detected, any monitoring service connected to the affected
SQL Sentry database will be stopped, upgraded, and then restarted
after the upgrade completes. If any client processes are detected, the
user will be notified that they have two minutes to exit the client
before it is stopped to proceed with the upgrade.
Upgrades a SQL Sentry database.
so upgradedb -n

All

upgradedb
 Note: This option is only used when upgrading a non-EPI database
to an EPI version of SQL Sentry. It is used in the Option 2. First EPI
Upgrade instructions on the Upgrade section of this article.
Displays the version of the installed SQL Sentry EPI framework (from
the SentryOneSetup installer exe) that is located in C:\Program
Files\SentryOne Framework.
version

so version

All
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Flags
Command

Description

EPI
Version

All
Some commands, where a server must be specified (e.g. startms, startmp, stopms, stopmp, installms,
uninstallms, installmp, and uninstallmp) also have an optional flag -a (--all) to use all servers instead of a
specified server.

 Note: It is not recommended that you use this option for installmp as you don't need to install the
SQL Sentry Monitor Portal service across all servers with a monitoring service.

Example of stopping all monitoring services at once:
so stopms -n -a

 Note: This command also works if you only have one monitoring service and do not want to type in
the FQDN to specify the server, as shown in the image above.

isGmsa
Some commands (so install, so installms, and so update) have the isGmsa flag available to support using
service accounts that are Group Managed Service Accounts (gMSA). Using the isGmsa flag means that you will
not be asked to enter a password when running the commands.

 Note: The SQL Sentry Monitor Portal service (so installmp) does not support gMSA.
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Enable gMSA

 Important: Support for gMSA must be turned on via the GmsaSupport feature flag in SQL Sentry
before using the isGmsa flag in the EPI commands.

To turn on the GmsaSupport feature flag, execute the following against the SQL Sentry database:
INSERT INTO Setup.FeatureFlag VALUES ('GmsaSupport', 1);

gMSA Command Examples
so install
Use the isGmsa flag during installation to run the SQL Sentry monitoring service and controller service under
the gMSA.
so install --IAcceptLicenseTerms -n -u --isGmsa

 Note: When a service account is running under gMSA it will appear with a dollar sign at the end of the
Log On As account name.

Example of Log On As appearing with $ to indicate the service account is using gMSA

so installms
Example of using the isGmsa flag with the monitoring service installation command:
so installms -n -u --isGmsa

so update
The so update command allows you to switch between accounts, including gMSA and domain accounts (nongMSA). The following examples show so update commands for gMSA-related workflows.
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 Note: The so update command will find all services running under the current username (appearing
after the -u flag) and update them to run with the new username (appearing after the --replaceWith
flag).

Switch from a domain account to a gMSA:
so update -t services -n -u --replaceWith --isGmsa

Switch from a gMSA to a different gMSA:
so update -t services -n -u --replaceWith --isGmsa

 Note: When an account is already running under gMSA, it has the dollar sign after it. For this
reason, you must add the $ at the end of the current username (appearing after the -u flag).

Switch from a gMSA to a domain account:
so update -t services -n -u --replaceWith -p

 Note: The password is required for the domain account. The -p (or --password) flag may be used
as described in the Password section below. When omitting the -p flag from the command, you are
prompted to enter a password to complete the execution.

Password
The EPI commands that require a password offer the -p (--password) flag to allow you to type in your
unmasked password within the command instead of being prompted to type in your masked password after
executing the command.

 Note: The -p flag is only recommended for when you are scripting commands.

Using the password flag looks like this:

As opposed to leaving the password flag out of the command for a masked prompt:
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Password Warnings & Formatting

 Warning: Passwords cannot start with a dash. There is no workaround for this.

 Important: Using non-alphanumeric (i.e. special) characters such as spaces and quotes with the -p
flag requires specific formatting around those characters.
Most special characters do not require additional formatting. For example, $$passw0rd is entered as
$$passw0rd and $$p@ssw0rd is entered as $$p@ssw0rd.
Spaces
If the password is $$pass w0rd then it must be contained in double quotes:
"$$pass w0rd"
Double Quotes
If the password is p@ss"w0rd then it must be contained in double quotes and contain an additional " to
escape the " in the password:
"p@ss""w0rd"
Single Quotes
If the password is p@ss'w0rd then it must be contained in double quotes:
"p@ss'w0rd"

replaceWith
The --replaceWith (or -r) flag is used with the so update command to update the account used for a
monitoring (& controller) service.

 Note:
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The so update command will find all services running under the current username (appearing after
the -u flag) and update them to run with the new username (appearing after the --replaceWith
flag).
The -p (or --password) flag may be used as described in the Password section above. When
omitting the -p flag from the command, you are prompted to enter a password to complete the
execution.

To change the monitoring service and controller service login account, run the following:
so update -t services -n -u --replaceWith -p

This example switches a domain account to another domain account. If you are are updating a gMSA account
to another gMSA account, or switching to/from using gMSA, see the isGmsa flag section above for examples.

Timeout
See the Advanced section of the EPI article for an example of the timeout flag.

Verbose vs. Quiet
The EPI commands offer the following flags -v (verbose, to display all logging output) and -q (quiet, to
suppress all summary messages).

V vs. Q Examples
Default example of so stop:
so stop -n

Verbose example of so stop:
so stop -n -v

168

Quiet example of so stop:
so stop -q
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Telemetry
Last Modified on 30 July 2021

Telemetry on SQL Sentry
We've worked closely with our user community and the SQL Server community to gain insight from
interviews, conversations, and our experiences from working with SQL Server over the years. We want to
continue working with our users to understand how they're using our software, and where we can improve it.
We want our users to be active in our engineering processes, from providing feedback through to testing
Beta versions. For new feature requests, we will still rely heavily on personal interaction. We've used this
information to help craft a product that best suits our user and their needs; however, this data is limited. To
build the best software for the Data Platform community, we need more feedback. This is where application
telemetry comes in.
By enabling Telemetry on SQL Sentry, you provide us with valuable information and statistics that helps to
fill the gaps in the data-collecting process, ensuring the best product improvements and features.

Data That's not Being Collected
By enabling Telemetry, SQL Sentry collects data that's a part of the SQL Sentry application. Anything that's
not a part of the application isn't collected.
SQL Sentry Telemetry doesn't collect any of the following:
T-SQL Queries
Database schema information
Data from your databases
Usernames or passwords
Server names
IP addresses

 Important: The SQL Sentry telemetry system is designed to anonymize information that the SQL
Sentry installation and client are reporting. There is a consistent identifier referred to as LocationID and
ClientID that allows us to process the data, but not determine from which customer it originated.

Data That's Being Collected
Collecting data through application telemetry for SQL Sentry allows us to better understand which features
our customers use the most, and how customers navigate through the client. Collecting this data ensures that
we update our software to provide customers with features they need as quickly as possible. Enabling
Telemetry on SQL Sentry allows the collection of the following data:
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The features of SQL Sentry a client session is using.
The navigation path through the SQL Sentryclient.
The Environmental Health Overview (EHO) score shown in the client.
The number of monitoring services shown in the client navigator.

Collecting and Sending
The telemetry engine resides in the SQL Sentry client, and each client installation handles the data sending
process.

 Important: The SQL Sentry monitoring service plays no part in Application Telemetry.

The process establishing if the client sends telemetry is illustrated with the following diagram:
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Telemetry Flow

The process checks to see if an administrator has enabled Application Telemetry. This approach avoids
different settings within a customer organization. Centralized control means if Telemetry is set to Off,
subsequent client installations maintain this setting rather than prompting an install.

 Important: The client won't attempt to send telemetry data to SQL Sentry when there isn't an
internet connection.

Receiving and Storing
The client sends telemetry data from the SQL Sentry client to our systems using a secure messaging protocol
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to Azure Event Hubs, ensuring that the data remains protected during transit with TLS. Once it reaches our
back-end systems, the data is stored in a combination of Azure Data Lake Store and CosmosDB. PowerBI is
used to visualize the usage data that we receive. Once the data has arrived in the storage and processing
layer, we make use of the various Azure functionalities that exist to secure the data at rest.

 Note: Data collected with telemetry is stored in the Microsoft Azure regions in North America.

Insights from this data influence the way we build our software. Monitoring feature usage over time provides
new navigation paths, and puts different SQL Sentry SKUs in play.

Common Questions
We're always looking to build better software. It's important that we understand how our solutions are being
used by our customers. The following are three key questions we ask about how our customers are using SQL
Sentry:
Which features deliver the most value to our users?
What are the most common navigation paths through our software that our users take?
Which features are SQL Sentry users not leveraging?
With these three questions, it's possible to understand how we can make our software more accessible. These
questions allow us to focus our efforts on building surveys for customers that focus on the areas used most
heavily, further allowing us to focus engineering time on refining these areas to add value to all SQL Sentry
customers. Focusing on these questions also highlights features in the software that need more awareness.

Enabling and Disabling Telemetry in SQL Sentry
Existing 11.2.x or above Installation
Once 11.2.x or above has been installed and configured, the option for the client to send telemetry is
managed globally. To manage Telemetry settings, select the Global settings node (Navigator >
Configuration > Global Settings) to open the SQL Sentry Monitoring Service Setting window.
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In the Monitoring Service window, select the Privacy tab. Enable Telemetry by selecting the Send
anonymous usage data to help make SQL Sentry better checkbox, and then select Save on the toolbar to
save your settings.

Disable Telemetry by deselecting the Send anonymous usage data to help make SQL Sentry
better checkbox, and then selecting Save on the toolbar to save your settings.
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SMTP Settings
Last Modified on 30 July 2021

Configuring SMTP Settings in SQL Sentry
To configure SMTP settings in SQL Sentry, open the Navigator pane ( View > Navigator), and then select the
Global Settings node (Configuration > Global Settings) to open SQL Sentry Monitoring Service Settings.
The Alerting tab displays by default.

In the Alerting tab, use the drop-down SMTP Server box to select an existing SMTP server, or select  to
open the Select an SMTP Server dialog box, and configure a new SMTP server.
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 Note: If using localhost, keep in mind this is the local SMTP server on the machine where the
monitoring service is installed because it's responsible for sending all notifications. The SQL Sentry
client doesn't send any notifications.

 Note: Contact your network administrator to ensure that the IP address of the monitoring service
computer has been granted both Connect and Relay permissions for the specified SMTP server.

Adding a New SMTP Server
1. From the Alerting tab, select  to open the Select an SMTP Server dialog box.
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2. Select New to open the SMTP Server Editor dialog box.

3. Enter the IP address or the domain name of the SMTP Server in the SMTP Server box. Enter the email
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that you want to send the notifications in the From Address box. Enter your security credentials in the
SMTP Security tab.

4. Select Test to open the Send SMTP Test Email box, and then enter an email in the slot provided. Select
Send to send the test email to the desired address.

5. Select Save on the toolbar to save the SMTP settings.

 Important: For the most accurate SMTP test, use the SQL Sentry client installed on the server
computer to send the test message. If you use a SQL Sentry client on a different computer, such as your
local workstation, the results may differ. For example, your SMTP server may allow relay from your
workstation but not from the SQL Sentry Server computer, in which case the test from your workstation
would succeed; but the SQL Sentry Server would be unable to deliver notifications.
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 Note: Configure multiple SMTP Servers in an SMTP Server group to use SQL Sentry's failover
capabilities. For more information about configuring an SMTP Server group, and the SMTP Server group
failover process, see the Monitoring Service SMTP Configuration article.
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Relocating the SQL Sentry Database
Last Modified on 01 December 2021

 Important: SQL Sentry versions 2021.8 or later are licensed with a SolarWinds license through the
SolarWinds License Manager. SQL Sentry versions before 2021.8 are licensed with a SentryOne license.

Moving the SQL Sentry database to a new SQL Server
Instance
 Warning: Moving the SQL Sentry database to a new instance before completing these steps will
invalidate your license. If you have invalidated your license, you need to log onto the SolarWinds
Customer Portal and submit a ticket to have your license reactivated.

To move your SQL Sentry database to a different instance for EPI and non-EPI versions of SQL Sentry
Versions 2021.8 or above, complete the following steps:
1. Open Windows Services on the monitoring service machine(s) and then stop the SentryOne
Monitoring Service.
2. Perform a backup of the SQL Sentry Database.
3. Select Help > Manage Licenses to open the SolarWinds License Manager.
4. Select the license for your current SQL Sentry database installation, and then select Deactivate. Close
the SQL Sentry Client.
5. Move the SQL Sentry database to the new instance.
6. Uninstall the SQL Sentry Monitoring Service(s) from the old SQL Sentry Database machine:
EPI:
1. Use the uninstallms command to uninstall the Monitoring Service.
so uninstallms -n -s

Installer:
1. Uninstall the Monitoring Service through the Control panel.
7. Install the SQL Sentry Monitoring Service and client on the new instance(s).
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EPI:
1. Add the new registration.
so addreg -n --connectionServer --connectionDatabase

2. Re-install the services.
so install --IAcceptLicenseTerms -n -u -p

 Note: Repeat these steps on all machines with a SQL Sentry controller service or monitoring
service.
Additional Information: See the EPI article for guidance on using these commands.

Installer:
1. Use the SQL Sentry Installer to install the SQL Sentry Client and Monitoring Service to your instance.

 Note: You can select to only install the SQL Sentry Client and Monitoring Service, or just
Monitoring Service depending on your needs.

8. Stop the SentryOne Monitoring Service(s).
9. Open the SQL Sentry Client and select Help > Manage Licenses to open the SolarWinds License
Manager.
10. Activate your SQL Sentry license on the new instance.
11. Start the SentryOne Monitoring Service.
12. Open the SQL Sentry Client and move the Monitoring Service to the correct Site.

 Success: You have successfully moved your SQL Sentry database to a new instance!

Moving the SentryOne database to a new SQL Server
instance
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Deprecated: This section applies only to SentryOne-branded versions of SQL Sentry (earlier than
2021.8).

Shared steps:
These steps are the same for the EPI and non-EPI versions of SentryOne. Move the SentryOne database to a
new SQL Server instance by completing the following steps:
1. Obtain the new Server Name or Group_ID that you plan to host your SentryOne database on. This is used
to regenerate your license key because it's based on one of these values.
1. If you plan to use a standalone or Failover Cluster instance for hosting your SentryOne database
then you can get the Server Name by running the following T-SQL statement SELECT
SERVERPROPERTY('SERVERNAME').
2. If you plan to host your SentryOne database in an Availability Group then you can get the Group_ID
by running the following T-SQL statement: SELECT group_id as AG_ID, name
FROM sys.availability_groups.
2. Login to the Customer Portal and go to the License Maintenance section. Select View / Modify
Existing SentryOne Licenses and complete the following:
1. In the Perpetual Licenses section your SentryOne license is listed. Select the plus symbol next to
the instance name to expand the license management options.
2. Select the License Configuration tab.
3. In the SQL Server Instance Name field enter the new instance name from step one .
4. In the Reason For Change field, enter a reason for the change.
5. Select Update and the license is automatically emailed to you.
3. Once you've received the new key, shut down all SentryOne clients and SentryOne monitoring services.
4. Perform a full backup of the SentryOne database.
5. Set the SentryOne Databases to Offline.
6. Restore the SentryOne database to the new location that's used to host the SentryOne database.

Next steps: non-EPI
7. Open the SentryOne client on any machine with a SentryOne monitoring service. After failing to
locate the SentryOne database, the Connect window appears. Enter the new location of the
SentryOne database. The SentryOne client alerts you that it needs to be restarted to connect to
the new SentryOne database. Upon restarting, you are asked for the new license key.
8. After successfully applying the license and starting the SentryOne client, run the Service
Configuration Utility, pointing the monitoring service at the new SentryOne database. The
Service Configuration Utility is found in the SentryOne program group. After running the
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Service Configuration Utility, restart the monitoring service.

 Note: Repeat steps 7 and 8 on all machines with SentryOne monitoring services. You
won't be asked for the license again. You may now start any other SentryOne client and
enter the new SentryOne database location when asked.

Next steps: EPI
7. Uninstall the services:
so uninstall -n

8. Add the new registration
so addreg -n --connectionServer --connectionDatabase

9. Re-install the services
so install -n -u

 Note: Repeat steps 7, 8, and 9 on all machines with a SentryOne controller service
or monitoring service.
Additional Information: See the EPI article for guidance on using these commands.

Final steps
Once you have validated that the SentryOne platform is working as planned with the database on the new
server, you can remove the old database from the server that was hosting it.

 Success: Your SentryOne database has been relocated.

 Important: Don't forget to set up SentryOne database maintenance on the new server.

Removing an old server from the All Instances view
Remove an old server from the All Instances view to stop prompts about it when opening the SentryOne
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client by completing the following steps:
1. Select the server name of the server you'd like to remove in the Please Specify the Server Name dropdown list, and then press Shift + Delete.
2. The new server should now be the only one listed in the drop-down list. Select the Connect command
and connect to the new installation.

 Success: The next time you open the client it will automatically connect to the new installation.
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Least Privilege General Performance Monitoring
Last Modified on 30 July 2021

For an overview of the performance monitoring features available with the SQL Sentry Event Calendar, see
the Scheduling Performance Monitoring topic.

 Note: It's possible to collect Performance Counter data in the SQL Sentry Event Calendar without
Windows Administrator privileges.

Collecting Performance Counters
Add the SQL Sentry monitoring service account to the Performance Monitor security group of the machine
where the monitoring service is installed. For the service to access the Performance Counters of your
watched instances remotely, grant the service account read access to certain registry keys. Complete the
following steps on each target that you want to collect Performance Counters:
1. Navigate to the winreg key located at the following path:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurePipeServers\winreg
2. Right click on the winreg key and select Permissions. Add the SQL Sentry monitoring service account.
3. Restart Windows.

 Note: For general information on editing the Windows Registry see Windows registry information
for advanced users.

186

SQL Sentry Components and Architecture
Last Modified on 25 May 2021

Overview

SQL Sentry Components
 Note: Due to product name changes between versions and branding, you may have SentryOne, SQL
Sentry, or a combination of these names in your installed SQL Sentry components.

SQL Sentry consists of the following components:

Component

Purpose
Provides a thin client interface for viewing and managing collected information.

SQL Sentry Client

Associated application services and processes:
SentryOne Client.exe

Collects event metadata and historical information for the monitored device(s).
SQL Sentry
Monitoring Service

Associated application services and processes:
SQLSentryServer / SentryOne.App.MonitoringService.exe
SQLSentryServer / SQLSentry.App.DiskSynchronizer (  Note: prior to
version 2021.8, it was SentryOne.App.DiskSynchronizer.exe)
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Component

Purpose
A SQL Server database that stores event metadata and historical information
collected by the SQL Sentry monitoring service.

SQL Sentry
Database

 Note: The default name for this database is SQLSentry. Other versions may
have used SentryOne as the default. Some setups may use custom names, such
as SQLSentry-US and SQLSentry-UK.
When using EPI, this service controls the SQL Sentry services, allowing them to
be managed remotely. It must exist on all machines where a monitoring service,
portal service, or client is installed for the EPI version of SentryOne.

SQL Sentry
Controller

Associated application services and processes:
SentryOneController / SentryOne.App.ClientBootstrapper.exe
SentryOneController / SentryOne.App.ServiceBootstrapper.exe

If using the self-hosted version of SQL Sentry Portal, this service runs on the
machine where the portal is installed.
SQL Sentry Portal

Miscellaneous
processes &
services (things that
may need to be
added to a safelist
in your security
software, if
applicable)

Associated application services and processes:
SentryOneMonitorPortal / SentryOne.Monitor.WebClient.Web.exe

SentryOne Report Viewer / SsrsViewer.exe
SQL Sentry Scheme Handler / SqlSentrySchemeHandler.exe
Startup Wizard / SqlSentry.StartupWizard.exe
Service Configuration Utility /
SentryOne.App.MonitoringService.Configuration.exe

Notes
One SQL Sentry monitoring service is typically required for every 50 to 100 monitored targets. Install multiple
monitoring services for scalability, redundancy, or to collect information from remote sites. Normally a SQL
Sentry client is installed on each DBA's workstation.

 Note:
See the Implementation Examples section of the Recommendations article for additional
information on the number of SQL Sentry monitoring services.
All SQL Sentry monitoring services and clients connect to the same SQL Sentry database.
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 Important:
SQL Sentry doesn't attempt to replace SQL Server Agent, Windows Task Scheduler or any other
scheduling agents. SQL Sentry communicates with these schedulers to determine event status and
collect history and performance information using a lightweight polling architecture.
SQL Sentry doesn't require installed agents on each monitored target which dramatically reduces
associated setup and maintenance overhead of agent-based systems. SQL Sentry also doesn't
install a database on every monitored SQL Server. See the Watched Target Objects article for
details on which database objects are placed on a watched SQL Server target.
There are times when the SQL Sentry client connects directly to the watched targets (monitored
servers). For more information about when that happens, and how it can be secured, see the Client
Security article.

SQL Sentry Architecture Examples
Overall Example

SQL Sentry Architecture Example
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Example with SQL Sentry Portal and EPI
When using the EPI version of SQL Sentry, the components remain the same, but there are controller services
and bootstrappers associated with some components. For example, when the SQL Sentry client is installed via
EPI, it includes the client bootstrapper which allows for updates to be pushed out automatically to the clients
during the upgrade process.

SQL Sentry architecture example with SQL Sentry installed across multiple machines (with EPI components when
applicable)

Alerting and Response System
For its alerting and response system, SQL Sentry uses the concept of conditions and actions. Conditions
describe the various states of monitored objects in your environment. Configure actions to take place when a
condition is met.
All actions work on the principle of inheritance, meaning that an action configured in response to a condition
being met at the global level (All Targets node in the Navigator pane), is automatically passed down to all
applicable objects below it. This allows you to define global actions for the most common issues across your
environment once, and have those passed down to every monitored target automatically.
Refine actions at each level as needed to determine what happens in response to events occurring in your
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server environment. Each instance type supports multiple conditions and actions.
Configuring actions globally significantly reduces the setup and configuration time required to implement
notifications. For example, by enabling the Send Email action for the global SQL Server Agent Job: Failure
condition, you automatically receive email alerts for any SQL Agent job failures across your enterprise. The
only requirement is that the SQL Server instance and its jobs are watched by SQL Sentry. For a more detailed
explanation of how conditions and actions work, see the Alerting and Response System topic.

Watching Instances and Objects
Throughout this document you'll also see the term Watch used frequently, in the context of watching
instances or objects. When you have SQL Sentry Watch an instance or object through the context menu this
simply means that SQL Sentry begins monitoring it.
Consider the following rules regarding watched instances and objects:
When an instance is Watched, SQL Sentry monitors the instance and fires any applicable conditions for
the instance based on its type.
When an object is Watched, SQL Sentry monitors the object and fires conditions for the object based on
its type.
An instance can be Watched without watching any of its objects.
If any object on an instance is set to Watched, the instance is automatically set to Watched.
An object and its instance must be Watched to utilize SQL Sentry's queuing, chaining, and performance
monitoring features.

191

Monitoring Service Load Balancing
Last Modified on 30 July 2021

 Note: See the Installing Additional Monitoring Services section of the Installation article for step-bystep instructions on adding more monitoring services to your SQL Sentry enterprise.

Load Balancing
SQL Sentry allows for the installation of multiple monitoring services to provide automatic load balancing and
fault tolerance.

 Note: There's no additional configuration required to implement this functionality.

Once an additional SQL Sentry monitoring service is installed and connected to the same SQL Sentry
site during setup, they automatically distribute the monitoring load evenly between themselves, providing
automatic fault tolerance and load balancing. If one SQL Sentry monitoring service fails, the remaining SQL
Sentry monitoring services picks up the load automatically.
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For example, if there are three SQL Sentry monitoring services associated with six servers all contained within
the same site, the SQL Sentry monitoring services divides the servers evenly among themselves, each
managing two. If one SQL Sentry monitoring service fails, the other two services would pick up the
unmanaged targets and divide the remaining two between themselves.
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Monitoring Services List
To view the status of all SQL Sentry monitoring services, right-click All Targets in the Navigator and select
Show Monitoring Services List.
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The Monitoring Services List displays all of the monitoring services by server name. From this view, you can
see the last heartbeat, account and server stats, as well as the number of monitored targets for each
monitoring service.

 Note: You can also access the Monitoring Services List by right-clicking a site node in the Navigator
to view the monitoring services for only that site.
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Watched Target Objects
Last Modified on 30 July 2021

Performance Analysis Watched Target Objects
When a SQL Server instance is watched by SQL Sentry Performance Analysis, the following database objects
are placed on the target:

Tables (msdb):
SQLSentryObjectVersion_20
SQLSentryAlertLog_20
SQLSentryDBEmails_20 (SQL Server 2005+)
SQLSentryDBEmail_Attachments_20 (SQL Server 2005+)
SQLSentryEmails_20
SQLSentryLogCache_20
SQLSentryLogData_20
SQLSentryObjectVersion_20
SQLSentryQueueLog_20

Stored Procedures (msdb):
spGetBlockInfo_20
spGetJobInfo_20
spQueueHeartbeat_20
spQueueJob_End_20
spQueueJob_Start_20
spQueueMonitor_20
spReadLogFile_20
spSetupAlertsTrap_20
spTrapAlert_20
sp_sentry_mail
sp_sentry_mail_20
sp_sentry_dbmail_20 (SQL Server 2005+)
SQLSentry.spGetProcedureStatsData
SQLSentry.spGetQueryStatsData

SQL Agent Jobs:
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SQL Sentry 2.0 Alert Trap
SQL Sentry 2.0 Queue Monitor

 Note: For information about removing these objects, see the Uninstalling SQL Sentry topic.

SentryOne Monitoring Objects in Azure SQL
Database Targets
When an Azure SQL Database is Watched by SQL Sentry Performance Analysis the user is given the option
to allow some monitoring objects to be created in the target database. If these objects are allowed they are
created under a SQLSentry schema. To remove these objects, see the Uninstalling SQL Sentry topic. Some of
the tables have unique identifiers on them after the table name (indicated below by … ).

Tables (Target Database)
SQLSentry.SQLSentryObjectVersion_20
SQLSentry.ProcedureStats_...
SQLSentry.ProcedureStats_...

Stored Procedures (Target Database)
SQLSentry.spGetProcedureStatsData
SQLSentry.spGetQueryStatsData
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SentryOne Integrations
Last Modified on 30 July 2021

The following applications may be integrated to some extent with SQL Sentry.

Application

Integration Details

Microsoft Power BI

See the Power BI Content Pack article to download a sample PBIX for Power
BI Desktop and get started using it with your SQL Sentry database. You can
also use Power BI (or Excel) to compare multiple baselines created in SQL
Sentry. This blog post explains how.

Microsoft Teams

There are a few options for this integration:
This blog post shows how to use the Execute PowerShell Action in SQL
Sentry to send notifications to Microsoft Teams.
Add the Microsoft Teams email address as a contact in SQL Sentry. Use
it in an email action for conditions to send alerts.
Use Microsoft Flow.

SCOM

This blog post explains how SQL Sentry and System Center Operations
Manager can be used to complement one another.

Slack

This blog post shows how to use the Execute PowerShell Action in SQL
Sentry to send notifications to Slack, including instructions on configuring
the WebHooks. There's also an option to receive SQL Sentry Alerts through
Slack by using IFTTT (If This Then That) as outlined in this blog post.

Splunk

This blog post demonstrates how SQL Sentry's Conditions and Actions are
used to complement a Splunk installation for an enterprise integration. It
includes detailed instructions for sending SNMP traps from SQL Sentry to
Splunk.

Tableau

See the Tableau Report Pack article to download a sample report file to get
started.

Ticketing Systems

This blog post walks through ways to use the Execute Action along with
System Parameters and T-SQL to create events in ticketing systems.
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SQL Sentry Security Overview
Last Modified on 25 May 2021

Security covers the following topics relating to SQL Sentry security, including required permissions for the
various SQL Sentry components:

Security Topic

Description

Monitoring Service Security

This topic discusses the permissions required by the SQL Sentry
monitoring service account when watching (monitoring)
instances.

Client Security

This topic discusses the permissions required when running the
SQL Sentry client, including scenarios in which the client connects
directly to a monitored target.

Portal Security

This topic provides more information about security
requirements for the SQL Sentry Portal service and users.
SQL Sentry provides multiple options for data encryption at rest
and in transit. The SQL Sentry database can be encrypted using
Transparent Data Encryption (TDE).

Encryption

To protect data in transit, the connections between the SQL
Sentry database server, SQL Sentry monitoring services, and the
SQL Sentry client can be encrypted using 128-bit Transport Layer
Security (TLS). See the Encrypt Network Traffic item in the
Advanced Properties section of the Managing Connections article
for details.
See the SQL Sentry Portal Configuration article for instructions
on using the Portal Configuration Utility to encrypt network
traffic for SQL Sentry Portal and apply an SSL certificate.

Watching Targets Across Domains

This topic is a brief overview of the options available for
Watching (monitoring) targets across domains, including
information about Pass-through Authentication and configuring
SQL Sentry sites within your environment.

Non-Windows Environment

This topic discusses the options for Watching (monitoring)
instances in a non-Windows environment, including Passthrough Authentication.

SQL Sentry Performance Analysis

This topic discusses advanced information about the
Performance Analysis security requirements, including port
requirements for monitored targets.

Azure SQL Database and Data
Warehouse

This topic covers security aspects specific to Azure SQL Database
and SQL Data Warehouse.
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Security Topic

Description

Rights Based Security

This topic discusses restricting user access within the SQL Sentry
client based on Windows and SQL Server authentication
accounts.

Role Based Security

This topic discusses restricting user access within the SQL Sentry
client based on SQL Sentry database roles.

Additional Information: For more information about SQL Sentry security, see this Hardening
SentryOne for Security blog post.
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SQL Sentry Rights Based Security
Last Modified on 04 August 2021

Introduction

SQL Sentry supports restricting server visibility within the SQL Sentry client through the application of Rights
Based Security. Assign users and groups a limited set of visible sites, target groups, or instances to restrict
what the logged-in user sees. Certain objects and commands are disabled for restricted users. For more
information, see the Objects Hidden from Restricted Users topic.

Configuring Rights Based Security in SQL Sentry
Configure Rights Based Security in the SQL Sentry client by completing the following steps:
1. Associate a SQL Sentry User or Group with a Windows or SQL Server Authentication account.
2. Assign a SQL Sentry User or Group rights that restrict server visibility within the SQL Sentry client.

 Note: Associate a Windows Active Directory security group with a SQL Sentry group. This allows you
to easily manage SQL Sentry client security for multiple users. Specify the Active Directory group from
the Group Properties tab in the Login field.

1. Associating a User with an Account
The first step in configuring Rights Based Security is to associate a SQL Sentry user with either a Windows
account or a SQL Server Authentication account. This account should be the same account that the user uses
when opening the SQL Sentry client. For more information, see the Connecting to an Installation topic.
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Associate a user with an account by completing the following steps:
1. Open the Navigator pane (View > Navigator), expand the Contacts node, and then the Users node.

2. Double-click the user you wish to assign an account to, or select Open from the context menu to open
the Edit User window. If no user exists, double-click on the Users node to create a new user.
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Assign existing user

Create a new user

3. On the properties tab, the Login field specifies which accounts are assigned rights within the SQL Sentry
client. Do one of the following:
Enter their user name in the Login field as Domain\Username if the user connects to the SQL
Sentry installation using Integrated Windows Authentication.
Enter their SQL Server Login name in the Login field if the user connects to the SQL Sentry
Installation using SQL Server Authentication.

Domain\Username

SQL Server Login name

4. Save the User by selecting Save on the toolbar.
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 Note: If the user or group is newly created, it may be necessary to Save and then reopen the User or
Group before the Rights tab becomes available.

 Note: New users have complete access in the SQL Sentry client by default.

2. Assigning Rights to a User or Group
The Rights tab is located directly beside the Properties tab when editing a User or Group. Once a user has
been associated with an account, restrict which servers are visible for that user, using the Rights tab.
Alternatively, you may choose to assign rights to groups of users. Both users and groups can be assigned a
limited set of visible instances to restrict what the logged-in user sees. Assign rights to a User or Group by
completing the following steps:
1. From either the User or Group editor, select the Rights tab at the top of the editor. Any restrictions
previously assigned are listed, otherwise the list is initially empty.
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2. At the bottom of the Rights tab, select Add to open the Search Results window that shows a list of
available instances.

3. Select the instances that you want to configure rights for from Search Results. The instances are added
to the Rights tab with checkboxes to Allow or Deny visibility.

Instance added to the Rights tab
Add an instance from the Search Results
window

4. Select the Allow or Deny checkboxes for each desired instance to Allow or Deny visibility to the user or
group.
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5. Save the changes by selecting Save from the toolbar.

 Success: The user can only see the instances in the Rights tab that are checked Allow.

 Important: If no instances exist in the Rights tab, the user or group can see all instances, unless they
are a member of another group that has a restricted set of visible instances.

Additional Information
Membership of the sysadmin fixed server role is needed to do the following actions:
Edit the login associated with a user.
Assign rights to users and groups.
To ensure that a user has rights to log in to the SQL Sentry Database, but doesn't have rights to modify their
own permissions, add the user to the allow_all database role of the SQL Sentry Database, and ensure the
user isn't a member of the db_datawriter role. For more information about the available SQL Sentry
Database roles, see the Role Based Security topic.

Server Visibility: implicit vs. explicit denial
Be aware of the following when assigning rights:

 Warning: Once you define rights for a user or group, any site, target group, or instance that doesn't
have rights explicitly defined, becomes implicitly denied to that user or group. This means a user or group
is denied visibility for any site, target group, or instance that's not listed in their Rights tab with an Allow
checkmark.
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When you configure Rights Based Security for sites and target groups be aware of the following:
Any Parent node (site or target group) with a Deny permission explicitly configured overrides any of its
Child nodes Allow permissions.
 Important: In SQL Sentry Portal, explicit permissions on a child node enable the parent(s)
within the direct path to reach the child. No siblings are enabled by default. See the Monitor
Portal Configuration article for more about SQL Sentry Portal security.

If a Parent node is being implicitly denied, Allow permissions configured for any of its Child nodes are
honored because rights aren't otherwise explicitly defined for it.

Objects Hidden from Restricted Users
The following SQL Sentry client restrictions are applied to any user with Rights Based Security configured:
The following Navigator nodes are hidden/unavailable:
Contacts
Monitoring Service Group
Monitoring Services
Object Groups

 Note: The Contacts node isn't hidden if the user is sysadmin for the SQL Sentry database.

The following commands are unavailable:
Tools > Manage Response Rulesets
All Targets context menu > Show System Status
All Targets context menu > Show Monitoring Service List

 Note: Client alerts and object notes are only visible for the instances that the user has rights to see.

Applying Users/Groups Rights
 Note:
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Deny overrides any Allow that's configured through a group.
SQL Sentry checks groups for restricted instances first. After the group membership has been
evaluated, user instance restrictions are evaluated.

Scenario Example
There are 100 servers.
There are 20 users.
There needs to be two different groups Group A (10 Users) and Group B (10 Users) with visibility to
different servers.
Group A needs access to servers 1-50
Group B needs access to servers 51-100
One of the users (AllButOne) needs access to all but one of the servers allowed in Group A and Group B.

Setup Example
1. Add the 20 users in the client.
2. Create a Group A with rights to servers 1-50 by adding them on the Rights tab and selecting Allow.
3. Create a Group B with rights to servers 51-100 by adding them on the Rights tab and selecting Allow.
4. Add the users to their respective groups on the Groups > Properties tab.
5. Create user AllButOne and add to both groups.
6. On the Rights tab for the AllButOne user, select Deny for the server the user shouldn't be able to
access.
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SQL Sentry Role Based Security
Last Modified on 18 May 2021

Introduction

To provide a more secure environment and allow non system administrators to take advantage of SQL
Sentry's features, roles are placed on the SQL Sentry database during its installation or upgrade. Users are
placed in these roles to allow them access to the features they need, while restricting access to features that
may be above and beyond their responsibility.

Setting up Role Based Security
Role Based Security is configured through T-SQL statements or by using SSMS to set up database roles in
SQL Server. There are two role-based security models to choose from:
Allow All: Create a user on the SQL Sentry database, and add them to the allow_all role. This provides
full access to the SQL Sentry database. From here, add the user to any of the custom deny_ roles to
restrict that user's access to the different functions of SQL Sentry. Typically, there's a role to deny
updating the specified information, and one to deny reading the information at all.
Least Privilege: Create a user on the SQL Sentry database, and add them to the allow_least_privilege
role. This provides a minimal level of access, with the culmination of all the explicit deny_update roles
available. From here, add the user to any of the custom allow_ roles to expand that user's access to the
different functions of SQL Sentry.

Roles
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 Warning: The roles starting with db_ are SQL Server default roles placed on every database. Using
these roles in the SQL Sentry database may cause unpredictable behavior.

Unsupported: The allow_readonly role has been deprecated. You should switch to the least privilege
model if you are currently using allow_readonly.

Allow All Model
Use the allow_all model to create users with full access to all of SQL Sentry's features, then remove access to
any desired role(s) by applying the appropriate deny_update role. The following roles are available:

Role

Description

allow_all

Provides full access to SQL Sentry's features. Place all nonsa users in this role, then add deny roles from this table to
restrict access.

deny_actions_read

Denies the ability to view all General, Failsafe, Audit, and
Custom Condition actions.

deny_actions_update

Denies the ability to make changes to any actions, but
allows the viewing of those settings, making them readonly.

deny_appsettings_update

Denies any changes made under the SQL Sentry Monitoring
Service > Settings node.

deny_contact_update

Denies the ability to update information for individual
users, but allows viewing the information, making it readonly.

deny_contactgroup_update

Denies the ability to update group information, making it
read-only.

deny_customconditions_update

Denies the ability to enable, disable, create, or edit advisory
conditions.

deny_eventchain_read

Denies the ability to view Event Chain information.

deny_eventchain_update

Denies the ability to make changes to event chains.
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Role

Description

deny_fragman_manual_analyze

Denies the ability to manually execute analyze
fragmentation now through Indexes tab.

deny_fragman_manual_defrag

Denies the ability to manually execute defragment now
through Indexes tab.

deny_quick_trace

Denies the ability to run a QuickTrace™.

deny_settings_connection_read

Denies the ability to view information under the
Settings tab at the instance level for the specified instance
type.

deny_settings_connection_update

Denies the ability to make changes under the Settings tab
at the instance level for the specified instance type.

deny_settings_object_read

Denies the ability to view information under the
Settings tab at the object level.

deny_settings_object_update

Denies the ability to make changes under the Settings tab
at the object level.

deny_settings_source_read

Denies the ability to view source information from the
Settings tab.

deny_settings_source_update

Denies the ability to make changes to Source information
from the Settings tab.

deny_site_update

Denies changes made to Site Configuration.

deny_watch_connection

Denies the ability to watch or stop watching an instance.

deny_watch_object

Denies the ability to watch or stop watching an individual
object.

Allow Least Privilege Model
Use the allow_least_privilege model to create users with basic access to SQL Sentry's features, then add
access to any desired role(s) with the appropriate allow_update role. The following roles are available:

Role

Description
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Role

Description
Provides access to read and view SQL Sentry's features, and
denies update permissions to any update action listed in
this table. You can place any non-sa users in this role, and
then add allow roles to allow access.

allow_least_privilege

For example, users that are assigned the
allow_least_privilege role can create custom event views in
the SQL Sentry Client, but can not make any changes to the
monitoring service settings without being assigned to the
appropriate allow_update role from this table
(allow_appsettings_update in this case).

allow_actions_update

Allows the ability to make changes to any actions.

allow_appsettings_update

Allows any changes made under the SQL Sentry
Monitoring Service > Settings node.

allow_contact_update

Allows the ability to update information for individual users.

allow_contactgroup_update

Allows the ability to update group information.

allow_customconditions_update

Allows the ability to enable, disable, create, or edit advisory
conditions.

allow_eventchain_update

Allows the ability to make changes to event chains.

allow_fragman_manual_analyze

Allows the ability to manually execute analyze
fragmentation now through Indexes tab.

allow_fragman_manual_defrag

Allows the ability to manually execute defragment now
through Indexes tab.

allow_quick_trace

Allows the ability to run a QuickTrace™.

allow_settings_connection_update

Allows the ability to make changes under the Settings tab
at the instance level for the specified instance type.

allow_settings_object_update

Allows the ability to make changes under the Settings tab
at the object level.

allow_settings_source_update

Allows the ability to make changes to Source information
from the Settings tab.

allow_site_update

Allows changes made to site configuration.

allow_watch_connection

Allows the ability to watch or stop watching an instance.
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Role

Description

allow_watch_object

Allows the ability to watch or stop watching an individual
object.

Role Based Example
Scenario
You have a junior DBA that needs to use SQL Sentry's Calendar view to check for any failures or long running
jobs overnight, but you don't want them to make changes to any of SQL Sentry's settings.
Solution
Add their login as a User on the SQL Sentry database. Place that user in the allow_all role. This ensures the
user has access to all the information they need while being explicitly denied any information specified in the
additional roles assigned to them. Finally, for this example, you may want to add this user to all deny_ roles
except the ones ending in _read. This denies changes to any settings along with the ability to Watch or Stop
Watching an instance or object.
It's important to remember that logins using SQL Server Authentication must be specified in the SQL Sentry
client instance information. To specify SQL Server Authentication, select File > Connect to Installation.
Uncheck the box marked Integrated Windows Authentication, and then enter the user's login and password.
Restart the SQL Sentry client to apply the settings. These new settings remain in effect on this SQL Sentry
client until explicitly changed.

Viewing Role Details
To view the full details behind any role:
1. Open SSMS
2. Navigate to your SQL Server instance  Databases  SQL Sentry (or SentryOne)  Security  Roles
 Database Roles
3. Select a role and view properties
4. Select Securables
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Example of looking at role details in SQL Server Management Studio
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SQL Sentry Monitoring Service Security
Last Modified on 04 August 2021

The SQL Sentry monitoring service is a Windows service that runs in the context of a domain account. It is
used by SQL Sentry Software (i.e. SQL Sentry) and SQL Sentry Monitor.

Security Requirements
 Important: Prior to version 19.1.1, the account must have sysadmin privileges on each watched SQL
Server. We do not support watching targets on SQL Server version 2008 R2 or earlier without
sysadmin privileges in any version of SQL Sentry.

If the monitoring service account and interactive user do not have sysadmin privileges, then:
They must, at a minimum, be a principal on the SQL Server target with the Control server
permission granted.
They must be a member of the SQLAgentOperatorRole role on the msdb database.
This automatically adds membership to the SQLAgentReaderRole and SQLAgentUserRole.
The securityadmin server role may be required to guarantee the collection of SQL Agent Log
events, depending on the exact SP/CU of the SQL Server version.
See the Update to change permissions for running sp_readerrorlog and sp_enumerrorlogs in
SQL Server article from Microsoft for additional information.
The account must also have Windows Administrator privileges on any computer with a watched
Windows Task Scheduler instance to collect system level performance metrics with SQL Sentry
Performance Analysis. If the monitoring service does not have Windows Administrator privileges,
instance level metrics can still be collected using the Limited Access option.
It isn't necessary for this account to be a domain administrator account.
It's recommended that the service account be a standard user domain account that's added to the
local administrators group of each monitored target.
For more information about security and SQL Sentry Performance Analysis, see the Performance
Analysis Security Requirements topic.
GMSA (Group Managed Service Accounts) is supported through the Service Configuration Utility (see
the Monitoring Service Logon Account article for instructions) and EPI Commands.

 Important: There are some limitations when not using sysadmin privileges:
SQL Sentry will not be able to collect VLF and log file data for targets that are on SQL Server
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version 2016 SP 1 or earlier.
Last DBCC CHECKDB time is available only if the targets have the following SQL Server versions
with the appropriate SP or CU:
2014 SP 3+
2016 SP 2+
2017 CU 7+
2019+
You will not be able to start or stop the SQL Server Agent from the SQL Sentry client unless the
target Access Level is Full Access and the interactive user is a Windows admin on the associated
Windows target for that watched SQL Server.
The watch status of SQL Agent Alerts cannot be changed.

Additional Information: See the SQL Sentry v19.1.1 : Monitoring Service Security Requirements blog
post for additional details on not using sysadmin privileges.

 Note: As of SQL Server 2008 the local administrators group of a Windows server isn't automatically
given access to a SQL Server instance installed on that Windows server. Keep this in mind when installing
SQL Sentry for use with SQL Server 2008 and above.

 Important: Adding the service account to the local Windows Administrators group for the SQL Sentry
database server doesn't automatically grant the service user access to the SQL Sentry database.

Monitoring Azure
See the Microsoft Azure SQL Database and Data Warehouse Security article for account and firewall
information required to monitor these target types.

Changing the Monitoring Service Credentials
After the initial installation, the Service Configuration Utility is used to update or change the credentials of
the SQL Sentry monitoring service account. See the Monitoring Service Logon Account article for instructions.

Monitoring Service Connection Properties
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If the Monitor Performance setting is set to False for a target, and you don't need to utilize General
Performance Monitoring features, you may configure the monitoring service to use SQL Server
Authentication. This is done through an instance's Monitoring Service Connection Properties.
To access the Monitoring Service Connection Properties for an instance complete the following steps:
1. Open the Navigator pane (View > Navigator).

2. Right-click the desired instance, and then select the Monitoring Service Connection Properties
command to open the Service Connection Properties dialog.
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3. Uncheck Use Integrated Authentication, and then enter the SQL Server Authentication account you'd
like the monitoring service to use for the instance. Select OK to save your changes.
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Adjusting Target Access Level
You may wish to monitor an instance where OS level metrics through WMI and/or the Windows Performance
Library are inaccessible. This is occasionally the case for cloud based or hosted servers. In these circumstances,
a target may be added with Limited Access. This suspends attempts to access resources that are required for
some functionality like the Disk Space and Activity tabs, and Windows Metrics on the Performance
Analysis Dashboard. If access to those resources have been resolved, the Access Level can be set to Full
Access in the Monitoring Service Connection Properties at the target level in the Navigator pane. Similarly,
if a Watched target starts generating errors due to connectivity issues with the OS level resources that can't
be resolved, changing the Access Level to Limited allows you to continue monitoring non-OS metrics
without triggering connectivity errors for the target.

 Important: If you configure SQL Authentication for an instance that's being monitored with SQL
Sentry Performance Analysis, Performance Analysis won't be able to collect Windows level metrics for
that instance. This is because Performance Analysis collects various performance and configuration data
directly from Windows, and requires a higher level of access to the operating system than Event
Calendar. For more information, see the Performance Analysis Security Requirements topic.

Starting the Monitoring Service
If the service fails to start, complete the following steps to start the service manually.

 Note: The SQL Sentry monitoring service starts automatically after installation.
For SQL Sentry Software, it activates upon detecting a valid license on the SQL Sentry database.
For SQL Sentry Monitor, it activates upon entering valid credentials to the SQL Sentry Cloud
Login dialog during onboarding. If valid credentials are not entered, the monitoring service will
not be able to validate your license.
Depending on the software version, this may be the SQL Sentry Monitoring Service or
SentryOne Monitoring Service.

1. Open the Services window in Windows by selecting Control Panel > System and Security
>Administrative Tools > Services.
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2. Select SentryOne Monitoring Service from the list of services. Right-click SentryOne Monitoring
Service, and then select Start from the context menu or select the Play button on the toolbar to start
the service.

Right-click

Select Play

 Success: You've manually started the SQL Sentry Monitoring Service.
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SQL Sentry Client Security
Last Modified on 04 August 2021

When Does the SQL Sentry Client Connect Directly to a Monitored
Server?
Although the SQL Sentry client receives the majority of its information from the SQL Sentry database, there
are times when the client must connect directly to a monitored server. The SQL Sentry client connects directly
to a monitored server during the following:
Watching an instance
Initiating a real-time action:
Killing a SPID
Defragmenting an index
Updating statistics
Getting an estimated plan
Executing a query for an actual plan
Job-related tasks:
Start
Stop
Copy
Disable
Delete
Enable
Reschedule
Changes to Agent alerts and Windows tasks (through event chains and context menus):
Start
Stop
Disable
Delete
Enable
Changes to Agent services:
Start
Stop
Reporting (uses SSRS)
Running a QuickTrace™
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 Note: The SQL Sentry client also connects directly with the monitored target when a forced
metadata and history sync is performed. Select CTRL + Refresh on the toolbar to perform this action.
This is different than just selecting Refresh, which only retrieves information from the SQL Sentry
database.

Restricting Access and Server Visibility in the SQL Sentry Client
Additional Information: You can restrict user access within the SQL Sentry client based on Windows
and SQL Server Authentication accounts (Rights Based Security) and SQL Sentry database roles (Role
Based Security).

Authentication Method Used When the Client Connects to a Monitored
Target
In cases where the client needs to connect directly to a monitored instance, the authentication method used
varies depending on the specified User Connection Properties of that instance.

 Note: By default, the client uses the credentials of the interactive user whenever it needs to connect
directly to an instance.

As an alternative to integrated authentication, specify database specific credentials in the User Connection
Properties. For example, for a SQL Server instance enter a SQL Server Authentication Account with the
desired Server Role. To specify database credentials in User Connection Properties, complete the following
steps:
1. Access the User Connection Properties for an instance by right-clicking the desired instance to open
the context menu, and then select User Connection Properties.
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2. Unselect the Use Integrated Authentication check-box, enter your desired account information, and
then select Ok to save your information.
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Shared Groups Node vs. SQL Server Registrations Node
Unsupported: As of June 2020, the SQL Server Registrations feature is deprecated and no longer
supported.

There are a few differences regarding how authentication works depending on whether you're accessing the
instance from the context of the Shared Groups node or the context of the SQL Server Registrations node in
the Navigator pane.
For SQL Server instances accessed within the context of the Shared Groups node, Windows Authentication
is used by default. However, if you've specified SQL Server credentials using the User Connection Properties
context item, those credentials are used instead.
For SQL Server instances accessed within the context of the SQL Server Registrations node, the client uses
the authentication method and credentials defined for the corresponding SSMS registration. This is also
referred to as the native registration and is accessed using the instance's Edit Registration Properties
context menu item.
If SQL Server authentication credentials are set using the User Connection Properties context item, those
credentials are used instead, and they effectively override the authentication settings of the native
registration. The initial connection to the target is always made using the native registration credentials to
allow the client to determine the identity of the SQL Server, and ensure it isn't already being watched using a
different name.
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SQL Sentry Portal Security
Last Modified on 19 April 2022

Authentication Methods
SQL Sentry Portal Service
The following authentication methods are available for connecting the SQL Sentry Portal service to your SQL
Sentry database:
Integrated Windows Authentication is available in versions 2020.8.31 or later. It is not available in
version 2020.8.
SQL Server Authentication is available in all versions.
The SQL Server account must have read, write, and execute access to the SQL Sentry database.

SQL Sentry Portal User Access Requirements
 Note: The access requirements in this section are for users logging into SQL Sentry Portal. SQL
Server Authentication is not supported for users logging in to use the portal through a browser.

Users logging into SQL Sentry Portal through a browser must have access to the Windows Server hosting SQL
Sentry Portal. For a user to access SQL Sentry Portal, at least one of the following sets of requirements must
be met:
The Windows user identity is associated with a SQL Sentry contact (or is in an Active Directory group
that is associated with a SQL Sentry contact) or it is associated with a SQL Sentry contact group (or is in
an Active Directory group that is associated with a SQL Sentry contact group).
or
The Windows user identity has login access to the SQL Server instance that hosts the SQL Sentry
database or it is in an Active Directory group that has login access to the SQL Server instance that hosts
the SQL Sentry database.
Note: Read/write access to SQL Sentry database is not validated.

Rights Based Security
Starting with version 2021.1, SQL Sentry Portal supports Rights Based Security. See the Rights Based
Security article for more information.
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Feature Based Security
Starting with version 2021.8, SQL Sentry Portal offers Feature Based Security which layers on top of Rights
Based Security.
Feature Based Security is applied to contacts or contact groups in the SQL Sentry client, which are linked to
an AD user or AD user group. Once the users are added through the client, they are available on the Users
and Groups page in the SQL Sentry Portal. Feature Based Security uses roles to control access and is Default
Deny. This means new users will only be able to access the Health view until they are assigned to roles that
add more permissions.

 Note: New Installations vs. Upgrades
During a new installation, no roles are assigned to default users/groups.
When upgrading SQL Sentry from a version that predates Feature Based Security (earlier than
2021.8) to one that supports Feature Based Security (versions 2021.8 or later), existing users and
groups receive Alerts, Performance, and Query Tuner roles to maintain their existing access.

Permissions Page
Select the Permissions button from the top right in the navigation menu to open the Permissions page.

Permissions button

The Permissions page has four main sections worth noting:
1. SQL Sentry database environment drop-down
 Note: If you are using distributed SQL Sentry databases, roles must be configured per SQL
Sentry database (if you have multiple SQL Sentry databases such as SQLSentryUS and

SQLSentryUK).
2. Users or Groups
3. User or Group Details
4. Feature Access grid
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Users
The Users section lists all users that exist as contacts in SQL Sentry.
If a user belongs to one or more groups, they will be listed under groups in the User Details section.

User Details showing user Noah in the Wombat Club group

 Note: Inherited permissions from groups are not currently displayed in the Feature Access grid for
the user in the roles.

Groups
The Groups section lists all groups that exist in SQL Sentry. Roles applied at the group level are inherited by
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the users in that group. The groups display the number of members next to the group name. Select a group to
display the list of users and Feature Access for that group.

Wombat Club group showing the 3 users in the group

Feature Access Grid
The Feature Access grid is where you assign roles to users and groups.

 Note: There are no edit or save buttons on the Permissions page. Any changes that are made in the
Feature Access grid are automatically saved and are immediately in effect.

Permissions Role assigned message

Permissions Role removed message

Roles set at the site level will flow through to the targets in that site. In this example, all sites and targets
belong to the Default Site .

Administrator, Alerts, and Query Tuner roles applied at the Default Site level apply to all targets in the site.

If a role is applied to a site within a site, then anything within that sub-site will inherit the role. In the
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following example, the Performance role is applied to site SquadD, (which is within the Default Site ). The
user (or group) will gain Performance role access to all targets within SquadD (SQUADD-PE.ENG.LOCAL,
SQUADD-STABLE.ENG.LOCAL, and SQUADD-DEV.ENG.LOCAL) without gaining that additional access to other
targets.

 Note: Use the Show Hierarchy toggle to show which targets are impacted by a setting at a higher
level in the hierarchy.

Default Roles
The following default roles are available:

Administrator
The Administrator role provides access to the Permissions page in SQL Sentry Portal. Administrators can
only see targets for which they are an administrator for on the Permissions page. The targets are also filtered
by Rights Based Security for the administrator and selected user/group. This means that an administrator
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cannot assign Feature Based Security permissions to a target that the selected user cannot already access.

 Note: The Permissions page can be accessed without the Administrator role if SQL Sentry Portal is
accessed via the localhost domain. This gives the user admin-type rights at the Default Site for every
tenant.

Alerts
The Alerts role provides access to viewing the Alerts view in SQL Sentry Portal.

 Note: Global alerts are only shown when the user has the Alerts role permission for every
target/group.

Performance
The Performance role provides access to all metrics & chart data, including the Performance Analysis
Dashboard, Custom Charts, Custom Dashboards, and charts on other views such as Top SQL, Storage, and
TempDB. Users with the Performance role may create, edit, and delete the custom charts and dashboards
that they can access.

 Note: If a dashboard contains a custom chart for a target that is restricted from the user, the chart
will display a "This data is restricted " message instead of the chart.

This data is
restricted

Query Tuner
The Query Tuner role provides access to the query and session information on the Top SQL, Blocking,
Deadlocks, and TempDB views in SQL Sentry Portal.
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 Note: The Top SQL and TempDB performance charts are hidden on these views unless the user has
both Performance and Query Tuner roles applied.

Custom Roles
Unsupported: Custom roles may be created directly through the SQL Sentry database. There is no UI or
support available at this time.

Once a custom role is inserted into the SQL Sentry database, the role appears in the Feature Access grid and
may be assigned to users and groups the same way as default roles.

Step 1. Create a custom role
Run the following to create a role.
DECLARE @newRoleID UNIQUEIDENTIFIER;
SET @newRoleID = NEWID(); /*a GUID*/
INSERT INTO [Security].[FeatureRole] ([ID], [Name]
VALUES (@newRoleID, 'CustomRoleName');

Step 2. Apply permissions to your custom role
Use the following permissions and GUIDs to build your insert statement:

Permission

GUID

Administrator

41BA7923-244B-4D44-A5A5-393EE3C22
61C1

Alerts

A99A187E-925F-49C7-9037-F4EE94438
74E

Blocking

869B8B31-AE09-4145-9B9D-964C7196D
F42
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Permission

GUID

Deadlocks

1CF9D61E-45EA-4851-B39C-0916FF1A5
A24

Performance

01E6DA0E-EDF9-4A96-8336-63E225AF4
CDA

TempDB

A8367D7C-FAB2-4979-A3BA-3887FDB6A
526

Top SQL

C5D894C2-B721-4ECB-A596-7C9002F31
783

Storage

7aff7534-912e-48c9-93cb-eb201648861
d

Run the following insert statement to apply permissions to the role. This example adds Blocking permissions
to the CustomRoleName.
INSERT INTO [Security].[FeatureRolePermission] ([RoleID], [FeatureID]
VALUES (@newRoleID, '1CF9D61E-45EA-4851-B39C-0916FF1A5A24');

On the Permissions page, a fifth role named CustomRoleName now exists and provides Deadlocks
permissions to any user/group assigned this role.
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SQL Sentry Watching Targets Across Domains
Last Modified on 18 May 2021

Introduction
It's possible to watch instances across domains with SQL Sentry even when there's no trust relationship
between them. The best way to achieve this depends on the resources available and number of targets you
wish to watch.

 Important: When watching a target in a different domain, you may need to use the fully-qualified
domain name (FQDN) when entering the name of the target in SQL Sentry.

One Monitoring Service
If you only have the resources to install one SQL Sentry monitoring service for your environment, or only have
a couple servers in non-trusted domains you wish to watch, Pass-through Authentication can be set up on
each server in the other domain. This requires each watched server on the other domain to have a local
Windows account that has the identical login and password as the SQL Sentry monitoring service's domain
account. See the Monitoring Service Security article for all requirements necessary for the monitoring service
account.

Multiple Server Services
Another option is to install a SQL Sentry monitoring service in each domain where there are servers you wish
to watch. This only requires Pass-through Authentication for each monitoring service to the machine where
the SQL Sentry database is installed. Create separate sites for each monitoring service ensuring that they only
polled the servers in their domain.

 Note: You can use SQL Authentication from the SQL Sentry monitoring service to the SQL Server
hosting the database as an alternative to Pass-through Authentication.

Options For Watching Targets Across Domains
Additional Information: See the SQL Sentry Tips and Tricks: Monitoring Targets Across Multiple
Domains blog post for a walk through how to monitor targets across multiple domains with a single SQL
Sentry database.
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Pass-Through Authentication
Pass-through Authentication enables Windows targets in different domains or in non-Windows network
environments to communicate with one another by using identical user accounts and passwords on each
computer.
This solution is ideal when you only need to monitor a few targets outside of your primary domain, and you
don't have the resources available to install another monitoring service in the secondary domain.

Site Configuration
Each monitoring service only polls the targets in their own domain. The monitoring service located outside of
your primary domain uses either Pass-through Authentication or SQL Server Authentication to
communicate with the SQL Sentry database server.
This solution is ideal if you have a need to monitor a large number of targets outside of your primary domain,
or have a need to monitor targets that are geographically separated from your main installation.
This solution also requires that you have the required resources available in the secondary location to install a
monitoring service.
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SQL Sentry Azure SQL Database and Data
Warehouse Security
Last Modified on 18 May 2021

Account Permissions
The monitoring service requires the server admin account for Azure SQL Database and Data Warehouse
targets.
The credentials provided for an Azure SQL Database target must be the server account configured in the
Azure Portal for the Azure SQL Server so that full access is available for monitoring.

Authentication Methods
The following authentication methods are supported when adding Azure SQL Database target types:
SQL Server
Azure Active Directory - Password
Azure Active Directory - Integrated

Multi-Factor Authentication
Using service accounts that require Multi-Factor Authentication (MFA) is not currently supported for
connecting the SQL Sentry monitoring service to Azure SQL Database targets. It is recommended that
generalized service accounts are used for configuring connection credentials rather than accounts that are
directly linked to users. For environments that require MFA for Azure Active Directory users, a service account
can be excluded from the MFA requirement by using an exclusion for conditional access.

Additional Information: See the Use Azure AD access reviews to manage users excluded from
Conditional Access policies article on Microsoft Docs for guidance on how to set up exclusions for MFA.

Firewall
The Microsoft Azure SQL Database and Data Warehouse services are protected by a firewall because both
services are exposed on the internet. The Azure SQL Firewall is in place to help protect access to your data.
When creating a new Azure SQL Database or Data Warehouse target, the connectivity verification ensures
that an Azure SQL Firewall rule is correctly configured and indicates a warning if it's not.

Azure SQL Database and Data Warehouse Firewall Configuration
It is important to allowlist the IP address of the server hosting the SQL Sentry monitoring service via the
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Azure Portal. Depending on the software version, this may be called the SentryOne monitoring service.
The Azure SQL Firewall settings are configured using the Azure Portal, through the command line utilities on
PowerShell, or through the Cross Platform CLI tool. For more information about the Azure SQL Firewall
and configuring it, see the How to configure an Azure SQL database firewall documentation from Microsoft.

 Important: Because the Azure SQL Firewall rules can change, the monitoring service can lose access.
If this occurs, notifications appear in the System Status and on the Dashboard as a warning.
While the firewall is blocking the monitoring service, no data is retrieved from the target.
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SQL Sentry Non-Windows Network Environment
Security
Last Modified on 18 May 2021

If you're not using Windows Active Directory for domain management, take additional steps to ensure SQL
Sentry works properly by using Windows Pass-through Authentication.
SQL Server authentication can be used for any Watched SQL Server instance in a non-Windows network using
an instance's Monitoring Service Connection Properties context item. Access an instance's Monitoring
Service Connection Properties by right-clicking on the desired instance in the Navigator pane (View >
Navigator), and then selecting Monitoring Service Connection Properties from the context menu.

SQL Sentry Client
In non-Windows networks, connect to watched SQL Servers using the SQL Sentry client by doing one of the
following:
Use SQL Server authentication for any SQL Server registrations, or the SQL Server instance.
Use Windows Pass-through Authentication, meaning the Windows user using the SQL Sentry client
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must also exist on the target SQL Server computer. The user name and password on each target must
match exactly.

SQL Sentry Monitoring Service
Pass-through authentication is the only means by which the SQL Sentry monitoring service collects Windows
performance counters or watches Windows Task Scheduler in a non-Windows network environment.

 Important: The service user account must exist both on the service target and all monitored targets,
and the user name and password must match exactly.
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SQL Sentry Pass-through Authentication
Last Modified on 04 August 2021

 Important: SQL Server authentication can be used for any Watched SQL Server instance using an
instance's Monitoring Service Connection Properties context menu item. This eliminates the need for
Pass-through Authentication if SQL Sentry's performance monitoring isn't being utilized to collect
Windows performance counters from the targets, and if you aren't monitoring the target with
Performance Analysis or Events Windows Task Scheduler.

Pass-through Authentication enables Windows computers in different domains or in non-Windows network
environments to communicate with one another by using identical user accounts and passwords on each
computer.
If performance monitoring is required either through SQL Sentry Performance Analysis or you need to watch
a Windows Task Scheduler, Pass-through Authentication may still be required.

Additional Information: See the SQL Sentry Tips and Tricks: Monitoring Targets Across Multiple
Domains blog post.

Example
For example, if user JDoeDBA with password SQLrocks! is created on SERVER1 and SERVER2, JDoeDBA can
connect and authenticate directly from SERVER1 to SERVER2, and vice versa, without using domain-level
authentication.
It's the SQL Sentry monitoring service's job to collect data from monitored targets, then store the data in the
SQL Sentry database for analysis with the SQL Sentry client. In the example above, SERVER1 may be the
computer where the SQL Sentry monitoring service is running, and SERVER2 is either the monitored
computer, or the computer where the SQL Sentry database resides.

User Access Control
Additional configuration may be required on machines running Windows Vista and higher with the
introduction of User Access Control (UAC). When a remote connection is made using Pass-through
Authentication, the machine is unable to resolve elevated permissions under UAC, and for WMI and registry
purposes the account is treated as a regular (non-admin) user, even if the account exists in the local
administrators group.

Additional Information: For more information and configuration details about using Pass-through
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Authentication on Windows Vista and higher, see the WMI Registry Access article from Microsoft.
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SQL Sentry Performance Analysis Security
Requirements
Last Modified on 18 May 2021

The SQL Sentry Performance Analysis feature collects various performance and configuration data directly
from Windows and requires a higher level of access to the operating system than other features. The easiest
approach is to either make the SQL Sentry monitoring service account a domain administrator level account
or a member of the local administrators group on any watched targets.
In some scenarios it may be possible to use a non-administrator service account, although this isn't an
officially supported approach. Complete the following steps to use a non-administrator service account:
1. Enable DCOM on the SQL Sentry server machine, the SQL Sentry client machine, and the server to be
watched. For more information, see the Securing a Remote WMI Connection article.
2. Give the SQL Sentry monitoring service account proper permissions to the required WMI namespaces by
going to the properties for WMI Control under Services and Applications in the Computer
Management client. On the Security tab, ensure that the SQL Sentry monitoring service account has at
least Enable Account and Remote Enable checked for the CIMV2 and WMI nodes.

 Note: WMI providers and versions vary from server to server, and whether non-administrative access
functions properly for a particular WMI provider is directly dependent on whether the provider was
designed to support this. Many providers can't support this, including many designed by Microsoft®.

Additional Information:
For more information about SQL Sentry requirements, see the How to check SentryOne

requirements article from Sabin.io.
To learn more about enabling a Windows Management Instrumentation (WMI) rule in Windows
Firewall, see this answer to the WMI The RPC server is unavailable. (Exception from HRESULT:

0x800706BA) question on Stack Overflow.

Example
SERVER-A is the exact same make and model as SERVER-B, and both servers are on the same domain. The SQL
Sentry monitoring service user account is a domain user, but doesn't have administrator privileges on either
server. Performance Analysis can successfully watch SERVER-A, but is unable to watch SERVER-B. The two
servers are configured identically, with one exception; an additional network adapter from Acme Networking
was installed in SERVER-B.
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Acme Networking didn't design the associated WMI provider to support non-administrative access; therefore,
Performance Analysis isn't able to successfully watch SERVER-B as a non-administrator. The only options are
to either replace the network adapter with one that's known to support non-administrative access, or to
contact Acme Networking to see if they have an updated version of the provider that supports nonadministrative access.
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SQL Sentry Performance Analysis Required Ports
Last Modified on 18 May 2021

Ports Between Targets and Monitoring Service
For Performance Analysis to properly monitor a target on the network, the following ports on the
monitored target must be accessible to the SQL Sentry monitoring service machine(s):

SQL Server Access
tcp 1433 (or whatever port is used by SQL Server)

Azure SQL Database and SQL Data Warehouse
tcp 1433

Windows Performance Counter Access
tcp 445 (SMB, RPC/NP)
For WMI access:
tcp 135 (RPC)
-andone of these ranges:
tcp 49152-65535 (RPC dynamic ports -- Windows Vista, Windows Server 2008, or later versions)
-ortcp 1024-65535 (RPC dynamic ports -- for older OS versions such as Windows NT 4.0, Windows Server 2000, or
Windows Server 2003)
-ora custom RPC dynamic port range (following)
The one that's difficult for firewalls are the RPC dynamic ports. WMI (or any other process that uses DCOM)
connects to it initially using port 135, and the target responds with a dynamic port number for WMI to use for
the rest of the session. This port can be in one of the ranges before that are quite large by default.

Custom Range
To address this problem, specify a custom range for RPC dynamic ports. You may have already done this in
your environment to enable networked DCOM access for other applications. Start no lower than port 50000,
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and allocate no fewer than 255 dynamic ports.
For example, on Server 2008 use the following command:
netsh int ipv4 set dynamicport tcp start=50000 num=255

You may need to reboot for the change to take effect.

Additional Information: For more information, see The default dynamic port range for TCP/IP has
changed since Windows Vista and in Windows Server 2008 article.

Additional Information
On other Windows versions, use DCOM config in Component Services or the registry. You need to reboot for
the change to take effect.

Additional Information: For more information, see the Configure RPC Dynamic Port Allocation article.

You also need to have your network administrator open to the same port range on the firewall between the
SQL Sentry Server machine and any servers monitored with PA.

Additional Information: For more information, see the following articles:
How to configure RPC dynamic port allocation to work with firewalls
Service overview and network port requirements for Windows
Dynamic Ports in Windows Server 2008 and Windows Vista
How to check SQL Sentry requirements

Ports Between SQL Sentry Database Server and
Monitoring Service
The SQL Sentry monitoring service expects the SQL Sentry database server to listen for requests on port 1433
by default. It needs to be specified when using a different port number. You may also need to specify it when
the SQL Server Browser Service on the SQL Sentry database server is offline or disabled.

SQL Sentry Client Connection Port
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See the Advanced Properties of the Managing Connections article for information about changing the default
port number when connecting to a SQL Sentry installation through the client.
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Data Capacity Planning
Last Modified on 04 August 2021

 Note: See the Apply SQL Server Data Compression article for information and T-SQL scripts to apply
data compression to your SQL Sentry database.
We also have the SQL Sentry Scalability Pack for large environments to take advantage of columnstore
compression and performance. See the Installation Recommendations article and SentryOne &
Microsoft Achieve SQL Server Monitoring Performance Goals blog post for additional information.

Performance Analysis uses the SQL Sentry database to store all the performance data it collects, utilizing a
high performance storage scheme. How much space is used by Performance Analysis is directly dependent
on:
The number of databases on the watched SQL Servers because some of the performance counters
collected by Performance Analysis are database specific.
The number of physical disks on the watched targets because related counters are disk specific.
The Minimum Duration specified for the Top SQL event source. The default global setting is five
seconds, meaning that any batches or stored procedures that run for longer than five seconds are
collected. If this threshold is lowered, the amount of Top SQL data collected increases. A different
Minimum Duration is specified for each SQL Server.
Whether Collect Statement Events is set to True for the Top SQL event source. The default is False. If
enabled, this may increase the amount of Top SQL data collected by a factor of two or more. This
setting is also adjustable for each SQL Server.
The Performance Data Retention settings. Different settings can be specified for detailed (or raw)
performance data, rolled up performance data, and Top SQL/Blocking SQL/Deadlock data.
For detailed performance data, retention is specified in hours for each performance counter category in the
HistoryDataRetentionHours column of the PerformanceAnalysisCounterCategory table. The default may
be either 48 or 72 hours, depending on the category. Raw data is shown by default on the Dashboard and
Disk Activity tabs when the current date range is less than or equal to 30 minutes. Over 30 minutes, rolled up
data is used.
If you have an unusually large number of databases on SQL Servers monitored by Performance
Analysis, consider reducing the retention hours for the SQLSERVER:DATABASES and
SQLPERF:VIRTUAL_FILESTATS categories. Data for these categories are stored in the
PerformanceAnalysisDataDatabaseCounter and PerformanceAnalysisDataDiskCounter tables
respectively.
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If you have an unusually large number of physical disks per target monitored by Performance Analysis,
consider reducing the retention hours for the PHYSICALDISK category. Data for this category is stored
in the PerformanceAnalysisDataDiskCounter table.
Data for all other categories is stored in the PerformanceAnalysisData table.
Keep the retention hours the same for categories that are stored in the same table, otherwise page
splitting and fragmentation may result during the pruning process that may eventually affect
performance.
For rolled up performance data, retention is specified in hours for each rollup level in the
HistoryDataRetentionHours column of the PerformanceAnalysisDataRollupLevel table. Rollup data
for each break level (specified by the LevelBreakMinutes column) is stored in a separate table, all
named PerformanceAnalysisDataRollupXX, where XX represents the ID of the break level. The only
rollup table that may get large is the table for the two minute break level, or
PerformanceAnalysisDataRollup2. The retention hours for this, or any other break level, can be
adjusted as needed.
Retention for raw Top SQL, Blocking, and Deadlock data is controlled by the Keep Performance
History setting under Configuration > Global Settings > Storage in the Navigator pane. The default is
15 days.
For viewing Performance Analysis data on the Events calendar, the raw Top SQL, Blocking, and
Deadlock data is converted to the native event storage format and stored in the EventSourceHistory
table alongside data for other event sources like SQL Agent Jobs. Retention for all event sources is
controlled by the Keep Event History setting under Configuration > Global Settings > Storage in the
Navigator pane.
Expired performance data is pruned by the SQL Sentry monitoring service every minute or so. The default
settings enable you to always have detailed performance data for the last two or three days. However, if you
find that you're frequently navigating to date ranges using the Dashboard or Disk Activity tabs where no
data is shown, it may mean that you need to increase the retention hours for the detailed and/or rolled up
performance data. Balance any changes with the resulting impact it has on database size.
When you start using Performance Analysis, you'll find that your SQL Sentry database grows quickly at first.
After a few days this levels off once the pruning of expired data begins and starts keeping pace with the
incoming new data. Get an idea of the mix of Performance Analysis data in your environment by inspecting
sizes for the related tables using the script below. Much of the data in EventSourceHistory is likely related to
the Event sources.

Additional Information: See the Enabling Higher Resolution Performance Charts in SentryOne blog
post for details on how you can dramatically increase the detail data retention when using the SQL Sentry
Scalability Pack.
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Performance Analysis Data Script
Additional Information: See the Performance Analysis Data Usage Query.sql file on GitHub to get a
list of your data consumption for the performance analysis tables in the SQL Sentry database.

Query results example

 Note: The results above are from a SQL Sentry database where the SQL Sentry Scalability Pack is
installed.
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SentryOne Database Maintenance
Last Modified on 05 August 2021

Overview

It's important that regular maintenance activities be performed on the SQL Sentry database to ensure optimal
performance. The following are suggested practices for performing such maintenance.

Maintenance Schedule Summary
Maintenance should be performed on the following schedule:

Nightly
Update Statistics
Database Backups

Weekly
Database integrity checks (some may choose nightly checks, but depending on your hardware, weekly
should be enough for most)

Monthly
Defrag Operations (consider weekly if problems arise)

Maintenance Details
SQL Sentry Database Maintenance Window
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The Maintenance Window should also be configured with the above activity scheduled to avoid excessive
Failsafe Notifications.

Statistics
Disable auto update stats
SET AUTO_UPDATE_STATISTICS OFF

Disable auto create stats
SET AUTO_CREATE_STATISTICS OFF

Update Statistics
Set daily statistics maintenance jobs. The following boxes list tables that are suggested for statistics updates.
If you have the scalability pack installed, you cannot (nor do not need to) update statistics on the

PerformanceAnalysisData... tables.

Tables to update statistics on if not using the scalability pack:
PerformanceAnalysisData

PerformanceAnalysisDataRollup2

PerformanceAnalysisDataDatabaseCounter

PerformanceAnalysisDataRollup4

PerformanceAnalysisDataDiskCounter

PerformanceAnalysisDataRollup6

PerformanceAnalysisDataTableAndIndexCounter

PerformanceAnalysisDataRollup8

EventSourceHistory

EventSourceHistoryDetail

Tables to update statistics on if using the scalability pack:
EventSourceHistory

EventSourceHistoryDetail

For a SQL Sentry database hosted on a version of SQL Server prior to 2016, consider setting trace flag 2317:
DBCC TRACEON (2371,1);

Additional Information: See the Controlling Autostat (AUTO_UPDATE_STATISTICS) behavior in SQL
Server article from Microsoft for more information about the trace flag and compatibility level settings
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for SQL Server 2016 or later.

Database Backups
The SQL Sentry database Recovery model defaults to Simple. Nightly backups should be sufficient, but
be sure to choose the backup strategy that best fits your business needs.

Database Integrity Checks
Database integrity checks should be performed as often as practical for the SQL Sentry database.

Additional Information: Database integrity checks can be scheduled through SQL Server Agent Jobs
with T-SQL or free solutions such as Ola Hallengren's Integrity Check or Maintenance Plans.

Index Maintenance
Index Rebuilds
 Important: If you are using the scalability pack, then there are partitioned tables with clustered
columnstore indexes in the SQL Sentry database that must be excluded from regular index maintenance.
Additional Information: For a complete list of tables to exclude from index and statistics maintenance
if you are using the scalability pack, see the SentryOne Scalability Pack Tables to Exclude from Index
Maintenance.sql query on GitHub.

Weekly Index rebuilds are recommended. Fragmentation Manager can be used to help you make intelligent
decisions about index management in your environment. See the Fragmentation Manager article for
additional information.
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Index Fragmentation By Database

Index Fragmentation and usage

Index Defragmentation
Fragmentation Manager can be used to help you make intelligent decisions about index management in your
monitored environment and the SQL Sentry database. See the Fragmentation Manager article for additional
information.

High Availability / Disaster Recovery
The SQL Sentry database supports all SQL Server HA/DR options available, including log shipping, clustering,
and availability groups.

 Note: If using availability groups, you will need to update your hardware key to reflect the availability
group ID. See the Hardware Key and Hosting the SQL Sentry Database On An Availability Group sections
of the License Management article for full instructions.

Other
SQL Server Agent Alerts
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Set alerts on the following SQL Server errors to alert you to potential database corruption:
Error 823
Error 824
Error 825

Additional Information: See the SQL Server Agent Alerts post from Tim Radney on the
SQLPerformance blog for more information about configuring SQL Server Agent alerts.

Apply Data Compression
SQL Server data compression may be applied to certain tables in the SQL Sentry database for increased
performance. See the Apply SQL Server Data Compression article for full details and scripts.
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SQL Sentry Troubleshooting
Last Modified on 30 November 2021

Log files
By default, a certain level of logging takes place for the SQL Sentry client and monitoring service(s). You may
increase or disable the logging level from the Help menu. Go to Help  Logging then select  Client or
Monitoring Service.

Logging options from the Help menu

Each component has the following options:
Default
Disabled
Errors
Logs errors coming from the client or monitoring service
Verbose
Logs most activity from the client or monitoring service

Client
The location may vary between versions of SQL Sentry. Check the following locations for console-log-file.txt:

SQL Sentry Unified Setup
C:\Users\\AppData\Local\SolarWinds SQL Sentry
or

C:\Users\\AppData\Local\SentryOne
or

C:\Program Files\SentryOne\
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Enhanced Platform Installer
C:\Users\\Documents\sentryone\client\\\bin\

 Note: The EPI version also has a client bootstrapper with its own logging:

C:\Users\\AppData\Local\sentryone\clientbootstrapper-log.txt

Monitoring Service
The location may vary between versions of SQL Sentry . You may have multiple log files for the monitoring
service. Check the following locations for rolling-log.txt:

SQL Sentry Unified Setup
C:\Program Files\SolarWinds SQL Sentry\
or

C:\Program Files\SentryOne\
Enhanced Platform Installer
C:\ProgramData\SentryOne\monitoringservice\bin\

 Note: The EPI version also has a monitoring service bootstrapper with its own logging:

C:\ProgramData\SentryOne\servicebootstrapper\logs\

Portal Service
 Note: Consider using the built in developer tools console in your browser (open with F12) to reveal
additional errors and information related to the SQL Sentry Portal.

The location may vary between versions of SQL Sentry . You may have multiple log files for the portal service.
Check the following locations for log.txt:
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SQL Sentry Unified Setup
C:\Program Files\SolarWinds SQL Sentry\\MonitorPortal\logs
or

:\ProgramData\SolarWinds SQL Sentry\\MonitorPortal\logs
or

:\ProgramData\SentryOne\\MonitorPortal\logs
Enhanced Platform Installer
:\ProgramData\SentryOne\monitor\monitorportal\logs

 Note: The EPI version also has a portal service bootstrapper with its own logging:

C:\ProgramData\SentryOne\servicebootstrapper\logs\

Installation and Upgrade Failure
Log files that are generated during the SQL Sentry Setup process can assist in troubleshooting a failure.
Select View Log from the SQL Sentry Setup wizard if there's a failure.
You can also look for these files in the following locations:

C:\Users\\AppData\Local\temp
and

C:\Users\\AppData\Local\temp\sqlsentry
There are immediate logs related to the setup process that following a naming convention of year-monthdayThour-minute-second-immediate (shown below in Example #2 as 2020-07-30T13-50-00-immediate and
2020-07-30T13-49-05-immediate ). Search these files for errors and exceptions.
There's also a more verbose log with a naming convention of
SolarWinds_SQL_Sentry_Version_DateTime_LogNumber_SentryOneSetup.log (shown below as
SolarWinds_SQL_Sentry_2021.8_20210519134831_000_SentryOneSetup.log)
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Example #1 of SQL Sentry Setup log files (Versions 2021.8+)

In older versions of SQL Sentry (prior to version 2021.8), the naming convention was
SentryOne_Platform_DateTime_SentryOneSetup (shown below as
SentryOne_Platform_20200730134712_000_SentryOneSetup).

Example #2 of SQL Sentry Setup log files (prior to version 2021.8)

 Note: Often a search for 1603 in the
SolarWinds_SQL_Sentry_Version_DateTime_LogNumber_SentryOneSetup (or
SentryOne_Platform_DateTime_SentryOneSetup) file can point you to the error stack that caused a
failure.

 Important: If you are using EPI, don't forget to check the service bootstrapper logs (listed above
under the components) for additional installation or upgrade errors and information.

Miscellaneous
Not all databases are being monitored
By default, SQL Sentry is set to sync 100 user databases. If you have more than 100, you can change what is
synced via the Settings pane to include more if needed by adjusting the Max User Databases to
Synchronize and Max User Database Files to Synchronize (most active & largest first) values.
These Synchronization settings exist for both Amazon RDS for SQL Server and SQL Server. Ensure you set
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them at the correct level by target type. See the Settings Pane article for more guidance on these options.

Example of the Settings pane for SQL Server

 Note: Once you change the value, you should scan for configuration changes on the monitored
target. Right click the target and select Scan For Configuration Changes from the context menu.
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Scan for Configuration Changes

AlwaysOn tab is blank
If you have AlwaysOn configured, but the AlwaysOn tab is blank or displays a message such as No AlwaysOn
resources are configured at this level or Charts Not Available , you may have orphaned registry keys.
1. To diagnose this issue, run the following query against the primary node to confirm that the correct
target has been added:
SELECT SERVERPROPERTY('servername')

2. Once that is confirmed, run the following query to check for orphaned registry keys:
USE master
SELECT * FROM sys.dm_hadr_instance_node_map
GO

3. If the query returns no results, then the Availability Group has orphaned records. Open regedit and
navigate to HKEY_Local_Machine  Cluster  HadrAgNameToIdMap.
4. Delete any orphaned keys.
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5. Complete this process on all servers that are part of the Availability Group.  Note: Some servers may
not have orphaned keys in this scenario.

 Note: Clusterless Availability Groups are not supported at this time and will also cause the AlwaysOn
tab to be blank.

tempdbObjects Query
If you are seeing aborted queries that have text data starting with something like the following, you may want
to turn off performance data collection for TempDB Object Stats:
WITH tempdbObjects AS ( SELECT ObjectType = CASE o.type_desc...

 Note: There is no additional overhead on the monitored target because of this query being logged.

In Version 2021.12.20 or later, this collection can be turned off through Settings. Go to Settings Pane  SQL
Server  SQL Server  Collect TempDB Object Stats. Set this option to False. This may be done at the
global, site, or target level.
Prior to Version 2021.12.20, there is no setting for this. To stop collecting data for TempDB object statistics
on an earlier version, for all targets in your monitored environment, do the following:
 Note: Use the name of your SQL Sentry database in the scripts. This may be the default or SQLSentry
(previously SentryOne) or a custom database name that you created such as SQLSentryUS)
1. Run this update against your SQL Sentry database:
USE [SQLSentry]
UPDATE PerformanceAnalysisCounterCategory
SET PerformanceAnalysisSampleIntervalID = 0
WHERE ID = 115

2. Restart the monitoring service(s)
To turn it back on:
1. Run this update against your SQL Sentry database:
USE [SQLSentry]
UPDATE PerformanceAnalysisCounterCategory
SET PerformanceAnalysisSampleIntervalID = 2
WHERE ID = 115
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2. Restart the monitoring service(s)

Invalid column name 'open_transaction_count'
When using the TempDB Session Usage feature, the following error message displays:

SQL Sentry encountered an error with component: 'TempDB Session Usage Data Collector' in category: 'Data
Collectors'.
The error message is: TempDB Session Usage Detector: An error has occurred:
Message: Invalid column name 'open_transaction_count'.
This occurs when the watched target does not meet the SQL Server version requirement. The
open_transaction_count column was added to the sys.dm_exec_sessions DMV in SQL Server version 2012.
Set the Collect Session TempDB Usage option to False on any targets that are running an older version of
SQL Server.

Additional Information: See the Settings Pane article for instructions on updating the settings.

SQL Sentry client crashes when starting the application
If the SQL Sentry client crashes when you are attempting to open the application, there may be an issue with
your preferences file.
Delete the preferences file.
1. Go to to C:\Users\\AppData\Local\SentryOne
2. Delete the repositories.pref file
3. Restart the SQL Sentry client

SQL Sentry client doesn't complete loading
If the SQL Sentry client gets stuck on the splash screen when you are attempting to open the application,
there may be an issue with your local user files.
1. Go to C:\Users\\AppData\Local\SentryOne.
 Note: For the EPI version, you may need to go to C:\Users\\Documents\sentryone.
2. Delete the contents of the SentryOne folder.
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Example of SentryOne folder contents (Unified Setup)

Example of SentryOne folder contents (EPI)

3. Restart the SQL Sentry client.

SQL Sentry Scalability Pack Installation Troubleshooting
For new SQL Sentry installations versions 2021.18 and higher, the SQL Sentry Scalability Pack and Imbedded
CCI feature will install automatically if your machine meets the required prerequisites.

SQL Sentry Scalability Pack Installation Diagram
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 Important: By default, the Scalability Pack installs during new installations Version 2021.18 or higher
if your SQL Sentry Database machine is using SQL Server 2016 RTM EE (Enterprise Edition) CU 5 or
higher, SQL Sever 2016 SP1 CU15 or higher, SQL Server 2017 CU 14+, or SQL Server 2019.
If your machine does not meet these requirements, you may still have Performance Counter table
compression, Event table compression, and other table compression installed as described in the
following blog posts:
Enabling Higher Resolution Performance Charts in SentryOne
SentryOne & Microsoft Achieve SQL Server Monitoring Performance Goals
Charting Custom Counters in SentryOne

To verify your machine has the Scalability Pack installed, complete the following steps:
1. Open the SQL Sentry Client, and select Help > About.
2. Verify the Scalability Pack Installed message is set to True.

3. Open SSMS and connect to your SQL Sentry Database.
4. Run the following query against the SQL Sentry Database:
EXEC Partitioning.validate;

5. View the Messages to see if there are any validation errors.
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System Parameters
Last Modified on 05 August 2021

Applies To: Execute SQL, Execute Process, and Execute PowerShell actions allow for the passing of
parameters in the command text.

System Parameters
There are nine system parameters that are available in SQL Sentry. The following is a list of the system
parameters:

System Parameter

Description

ServerName*

Name of the instance where the object exists.

ObjectName

Name of the object.

ObjectType

SQL Server Agent Job, Maintenance Plan, etc.

Owner*

Owner of the object.

StepName*

Name assigned to the step.

Message*

Output text associated with the step.

Category*

Category as defined in the properties of the object.

Condition

Failure, Completed, etc.

MessageText

Providing the body text of the standard SentryOne notification.

*Available only for General Actions.
These parameters are passed to the command text by surrounding the parameter name with < % %>, like
<%ServerName%>.

User Parameters
User defined parameters can also be defined in the output text of an event. The syntax within the output
must be: PARAM=12345, PARAM: 12345 , or PARAM:12345. Use <%PARAM%> within the command text of
the execute action to pass that value. In the following example, we'll demonstrate how user parameters are
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defined.

Scenario
Your organization keeps a table on its Issues database called FailedAccountingJobs that has columns for
JobOwner, JobName, LastOrderProcessed, and Time. The accounting jobs create a step output that
records the last OrderID processed in case of failure, using OrderID as the user defined parameter. Set up an
Execute SQL action on the SQL Agent Job: Failure condition that points to the server that holds the Issues
database with a T-SQL command:
INSERT INTO Issues..FailedJobs (JobOwner, JobName, LastOrderProcessed, Time)
VALUES (<%Owner%>, <%ObjectName%>,<%OrderID%>, GetDate())

The values for the owner, name of the object, and OrderID are automatically provided by SQL Sentry and
inserted into the command when it runs.

 Note: User defined parameters may not be retrievable from the output of retried SQL Agent Job
steps. When passing the Message Text parameter, double quotes may be needed. Remember to use
SET QUOTED_IDENTIFIER OFF in this case.

Additional Options
Other options are available for the StepName and Message parameters. StepName and Message can also be
passed using the format <%StepName:[Identifier]%> or <%Message:[Identifier]%>. If the [Identifier] is a
number, then the value from that step ID is used, starting with step one.
Additionally, the [Identifier] can also be one of the following values:
FirstStep—The value for the step name or message of the first completed step.
LastStep—The value for the step name or message of the last completed step.
FirstFailure—The value for the step name or message of the first failed step.
LastFailure—The value for the step name or message of the last failed step.

Example Script
INSERT INTO TABLE (MyCustomMessage) VALUES ('The last step failure was on step <%StepName:LastFailure%> and
the text for that was <%Message:LastFailure>')
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Apply SQL Server Data Compression
Last Modified on 05 August 2021

 Important: If you have the SQL Sentry Scalability Pack implemented in your SQL Sentry database,
most of these tables are already using partitioned columnstore compression. Do not apply the data
compression scripts to those tables.
You may, however, apply the data compression scripts for the tables under the "Event and Other Tables"
tab (EventSourceHistory, EventSourceHistoryDetail, PerformanceAnalysisTraceData,
PerformanceAnalysisPlanOpTotals, and PerformanceAnalysisTraceQueryStats).
See the Installation Recommendations article for more information about the SQL Sentry Scalability Pack.

SQL Server data compression is used to save space on disk storage, as well as in memory. The CPU overhead is
negligible in certain cases, and we recommend applying the following compression scripts as the CPU
overhead has been analyzed for the SQL Sentry application. It's also recommended that you do the following
when applying data compression:
Decide if you'll apply compression all at once or over a couple of days.
Consider running sp_spaceused before and after applying compression to see the impact in your
database.
Use sp_estimate_data_compression_savings, SSMS reports, or SQL Sentry Performance Advisor to know
the sizes of these indexes in your database.

Sort_in_tempdb may be On or Off, but On is the recommended setting. Indexes may be compressed online or
offline, while offline locks the table. Set this to the option that best suits your environment.

 Note: Consider applying compression to the smaller objects before the larger ones. This is
recommended to reduce the need for additional disk space during the index changes.
Remember that the indexes will be decompressed during index rebuilds, so you should plan to have
sufficient disk space for logs and tempdb to account for the full table size.

For more information, see the Applying Data Compression to the SQL Sentry Database Part 2 and Part 5
articles.

Compression Scripts
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 The scripts below are also available via the Apply Data Compression to SentryOne Database.sql file
in the sentryone/sentryone-sql-scripts repository on GitHub.

Performance Counter Tables

 Warning: Do not apply compression to these tables if you have the SQL Sentry Scalability Pack
implemented in your SQL Sentry database, because they are already using columnstore compression.

-- PerformanceAnalysisDataRollup2
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataRollup2',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisDataRollup
ON dbo.PerformanceAnalysisDataRollup2
REBUILD PARTITION = ALL
WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);

-- PerformanceAnalysisDataRollup4
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataRollup4',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisDataRollup ON dbo.PerformanceAnalysisDataRollup4
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
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-- PerformanceAnalysisDataRollup6
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataRollup6',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisDataRollup ON dbo.PerformanceAnalysisDataRollup6
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);

-- PerformanceAnalysisDataRollup8
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataRollup8',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisDataRollup ON dbo.PerformanceAnalysisDataRollup8
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);

-- PerformanceAnalysisDataRollup11
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataRollup11',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisDataRollup ON dbo.PerformanceAnalysisDataRollup11
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);

-- PerformanceAnalysisDataRollup12
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataRollup12',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisDataRollup ON dbo.PerformanceAnalysisDataRollup12
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
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-- PerformanceAnalysisDataRollup13
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataRollup13',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisDataRollup ON dbo.PerformanceAnalysisDataRollup13
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);

-- PerformanceAnalysisDataRollup14
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataRollup14',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisDataRollup ON dbo.PerformanceAnalysisDataRollup14
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);

-- PerformanceAnalysisData
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisData',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisData_Wide ON dbo.PerformanceAnalysisData
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);

-- PerformanceAnalysisDataDatabaseCounter
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataDatabaseCounter',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisData_Wide ON dbo.PerformanceAnalysisDataDatabaseCounter
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);

270

-- PerformanceAnalysisDataDiskCounter
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataDiskCounter',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisData_Wide ON dbo.PerformanceAnalysisDataDiskCounter
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);

-- PerformanceAnalysisDataSQLDBCounter
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataSQLDBCounter',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisData_Wide ON dbo.PerformanceAnalysisDataSQLDBCounter
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);

-- PerformanceAnalysisDataTableAndIndexCounter
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataTableAndIndexCounter',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisData_Wide ON dbo.PerformanceAnalysisDataTableAndIndexCounter
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);

-- PerformanceAnalysisDataTintriCounter
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataTintriCounter',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisData_Wide ON dbo.PerformanceAnalysisDataTintriCounter
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
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-- PerformanceAnalysisDataVMCounter
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisDataVMCounter',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
-- alter index to use page compression
ALTER INDEX IX_PerformanceAnalysisData_Wide ON dbo.PerformanceAnalysisDataVMCounter
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
Event and Other Tables

 Note: You may apply compression to the following tables with or without the SentryOne Scalability
Pack.
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-- EventSourceHistory
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'EventSourceHistory',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'PAGE';
SELECT index_id, name FROM sys.indexes WHERE object_id = OBJECT_ID('dbo.EventSourceHistory');
-- alter indexes to use page compression
ALTER INDEX IX_MaxIDs ON dbo.EventSourceHistory
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_IncompleteRecs ON dbo.EventSourceHistory
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_Unique1 ON dbo.EventSourceHistory
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_Unique2 ON dbo.EventSourceHistory
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_FailedObjectsInRange ON dbo.EventSourceHistory
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_GlobalViews ON dbo.EventSourceHistory
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_DetailInserts ON dbo.EventSourceHistory
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
--Consider using ROW compression on the clustered index if index maintenance duration is a concern.
ALTER INDEX PK_EventHistory ON dbo.EventSourceHistory
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
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-- EventSourceHistoryDetail
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'EventSourceHistoryDetail',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'ROW';
SELECT index_id, name FROM sys.indexes WHERE object_id = OBJECT_ID('dbo.EventSourceHistoryDetail');
-- alter indexes to use row compression
ALTER INDEX PK_EventHistoryDetail ON dbo.EventSourceHistoryDetail
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = ROW);
ALTER INDEX IX_EventSourceHistoryID ON dbo.EventSourceHistoryDetail
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = ROW);
-- alter indexes to use page compression
ALTER INDEX IX_Unique2 ON dbo.EventSourceHistoryDetail
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_Unique1 ON dbo.EventSourceHistoryDetail
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_MasterDetailCorrelationTrigger ON dbo.EventSourceHistoryDetail
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_IncompleteRecs ON dbo.EventSourceHistoryDetail
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_MaxIDs ON dbo.EventSourceHistoryDetail
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
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-- PerformanceAnalysisTraceData
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisTraceData',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'ROW';
SELECT index_id, name FROM sys.indexes WHERE object_id = OBJECT_ID('dbo.PerformanceAnalysisTraceData');
-- alter indexes to use page compression
ALTER INDEX IX_MaxIDs ON dbo.PerformanceAnalysisTraceData
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_PerformanceAnalysisTraceData_Wide ON dbo.PerformanceAnalysisTraceData
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
-- alter index to use row compression
ALTER INDEX PK_PerformanceAnalysisTraceData ON dbo.PerformanceAnalysisTraceData
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = ROW);
ALTER INDEX IX_PurgeProcess ON dbo.PerformanceAnalysisTraceData
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = ROW);

-- dbo.PerformanceAnalysisPlanOpTotals
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisPlanOpTotals',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'ROW';
SELECT index_id, name FROM sys.indexes WHERE object_id = OBJECT_ID('dbo.PerformanceAnalysisPlanOpTotals');
-- alter indexes to use row compression
ALTER INDEX PK_PerformanceAnalysisTracePlanOpTotals ON dbo.PerformanceAnalysisPlanOpTotals
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = ROW);
ALTER INDEX IX_PerformanceAnalysisTracePlanOpTotals_Unique ON dbo.PerformanceAnalysisPlanOpTotals
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = ROW);
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-- dbo.PerformanceAnalysisTraceQueryStats
-- estimate compression savings
EXEC sys.sp_estimate_data_compression_savings
@schema_name = N'dbo',
@object_name = N'PerformanceAnalysisTraceQueryStats',
@index_id = NULL,
@partition_number = NULL,
@data_compression = N'ROW';
SELECT index_id, name FROM sys.indexes WHERE object_id = OBJECT_ID('dbo.PerformanceAnalysisTraceQueryStats');
-- alter indexes to use row compression
ALTER INDEX PK_PerformanceAnalysisTraceQueryStats ON dbo.PerformanceAnalysisTraceQueryStats
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = ROW);
ALTER INDEX IX_PurgeProcess ON dbo.PerformanceAnalysisTraceQueryStats
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = ROW);
-- alter indexes to use page compression
ALTER INDEX IX_PerformanceAnalysisTraceQueryStats_ObjectLookup ON dbo.PerformanceAnalysisTraceQueryStats
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
ALTER INDEX IX_PerformanceAnalysisTraceQueryStats_Unique ON dbo.PerformanceAnalysisTraceQueryStats
REBUILD PARTITION = ALL WITH (SORT_IN_TEMPDB = ON, DATA_COMPRESSION = PAGE);
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Enabling Extended Events
Last Modified on 05 August 2021

SQL Trace and Extended Events
SQL Sentry XE Trace ensures that Top SQL uses the current SQL trace mechanism. It's also used to collect data
while minimizing the overhead and effectively using Extended Events.

 Important: There is a different process for enabling the SentryOne Extended Events Trace in the 18.4
upgrade.

Enable the SQL Sentry XE Trace in Version 2020+
1. Run the following query on the SQL Sentry database to replace SQL trace with extended events:
--Disable old xe trace, if exists and enabled
IF EXISTS
(
SELECT * FROM dbo.FeatureFlag
WHERE [Name] = 'XeventsTrace' and [Enabled] = 1
)
UPDATE dbo.FeatureFlag
SET [Enabled] = 0
WHERE [Name] = 'XeventsTrace';
--Enable RingBuffer XE trace
IF NOT EXISTS
(
SELECT * FROM dbo.FeatureFlag
WHERE [Name] = 'XEventsRingBuffer'
)
INSERT INTO dbo.FeatureFlag ([Name], [Enabled])
VALUES ( 'XEventsRingBuffer', 1);
SELECT * FROM dbo.FeatureFlag;

2. Restart the monitoring service.

Enabling the SentryOne XE Trace in Versions 18.4 through
19.x
1. To enable XEvents, add the following row to the [FeatureFlag] table:
INSERT INTO [FeatureFlag] ([Name], [Enabled]) VALUES ('XEventsTrace', 1)

2. Restart the monitoring service.
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Enabling the SentryOne XE Trace Pre 18.4
Locating the SentryOne Service Configuration File Pre 18.4
The SentryOne monitoring service application configuration file is located in the SentryOne installation
directory on the servers hosting the SentryOne monitoring service. Use either of the following files for x64 or
x86 SentryOne systems.

C:\Program Files\SentryOne\18.0
C:\Program Files (x86)\SentryOne\18.0
Edit the configuration file using an editor of your choice.

 Note: Remember that to edit this file for all monitoring services, the editor needs to be run as an
administrator.

Editing the SentryOne Service Configuration File
Add the following query to the appSettings section of the configuration file, and then select Save.

Complete the previous procedure for all monitoring services that are running in the monitoring solution. The
configuration files can be edited while the services are running. However, the monitoring services need to be
restarted to pick up the configuration changes.

Verifying Setup
After the services restart, the following behaviors exhibit on the monitored targets:
SQL Server 2012 and higher uses Extended Events in place of SQL Trace.
SQL Server 2008R2 and lower remains using SQL Trace.

Additional Information: For more information about Extended Events and SQL XE Trace, see the
Extended Events article.
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Multi-Server Administration (MSX/TSX)
Last Modified on 05 August 2021

SQL Sentry provides additional functionality for multi-server administration. Any server designated as a
master server has MSX after its name in the Navigator pane. You also see an additional sub-node called
Multi-server Jobs. This node provides the same functionality and context menu items as the standard Jobs
node; however, jobs under this node are distributed to target servers. Just like the Jobs node, if you open it
by single- or double-clicking, a Calendar/List view appears of all multi-server jobs across all target servers. By
default, this view is filtered to show only failed or long-running historical events just like the Global and
Group views. The filter criteria can be changed in the Filter pane.
Target servers appear in the Navigator pane with TSX: , where S ERVERNAME is the name of the master server
to which it is enlisted.

Publishing Configuration to Target Servers
Just like standard local jobs, conditions and actions can be explicitly configured for multi-server jobs by
selecting a Multi-server Job node in the Navigator pane. Also, just like local jobs, multi-server jobs on a
master server inherit any conditions explicitly configured for the master server connection, which is accessed
by selecting the Master Server node. However, multi-server jobs don't execute on the master server; they're
created and configured on the master server and then pushed out to one or more target servers for
execution.
The multi-server jobs exist on the master server strictly for configuration purposes, and this applies to a
watched status and actions as well. These settings for multi-server jobs don't do anything on the master
server; they exist only so that they can easily be applied to target servers to avoid having to manually change
configurations on each target server individually. This is accomplished by using the Publish Configuration
Wizard. When a change is made to configured conditions or watched status for multi-server jobs on the
master server, those changes can easily be pushed out to selected target servers using the wizard.
The Publish Configuration Wizard can be run for an individual multi-server job or at the master server level.
To start the wizard, right-click any job under the Multi-server Jobs node, or at the instance level by rightclicking on the MSX Server node.
Select Publish Config to Targets, and the Publish Configuration Wizard appears. After selecting Next at
the introduction, select the target servers that you wish to publish conditions and a watched status. If you
launch the wizard from the Master Server node, you have the option of publishing Watched/Unwatched
settings, SQL Server instance-level conditions, and/or job-level conditions. If you launch from an individual job,
you may only publish the Watched setting and conditions for that job; the instance-level conditions option is
unavailable.
After making your selections, the wizard confirms your actions and executes the script to make the changes
to the specified target servers. All specified targets are now configured identically to the master server, based
on the options you selected.
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 Note: Target (TSX) SQL Servers are really no different than any other SQL Servers managed by SQL
Sentry. Other than the fact that they can include a mix of local and multi-server jobs, the hierarchical
configuration process used by SQL Sentry applies to target servers and all jobs on target servers just as
with any other instance or object. For example, if you never run the Publish Actions Wizard, but have
configured global actions, the global actions are inherited by all target servers as usual.
If you set auto-watch new objects to True for SQL Agent Jobs at the global level, either manually or
using the Quick Start Setup Wizard, any local or multi-server jobs on a target server are watched by
default.
There isn't a two-way relationship for a Watched status and actions configuration between target
servers and a master server. Once you've published these settings to a target server from the master,
you can override them later on the target server as usual, but a Watched status and actions change
made on a target server have no effect on the master server configuration.
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sp_sentry_dbmail_20
Last Modified on 08 January 2021

Introduction
When a SQL Server 2005 and above instance is first set to watched status with SQL Sentry, SentryOne autoinstalls a stored procedure in the MSDB database named sp_sentry_dbmail_20 that is intended to be an
interface compatible replacement for sp_send_dbmail. sp_sentry_dbmail_20 that supports all functionality of
sp_send_dbmail without the need to configure each server to use it. Therefore, the configuration and
maintenance requirements are dramatically reduced over sp_send_dbmail.
After watching the SQL Server 2005 and above instance, all that's required is replacing any calls to
sp_send_dbmail with sp_sentry_dbmail_20 shown as follows:

 Note: For sp_sentry_dbmail_20 to function, SMTP settings must be configured first.
 Note: You may receive an error if the required components are not turned on:

Msg 15281, Level 16, State 1, Line 26
SQL Server blocked access to STATEMENT 'OpenRowset/OpenDatasource' of component
'Ad Hoc Distributed Queries' because this component is turned off as part of the security
configuration for this server. A system administrator can enable the use of 'Ad Hoc
Distributed Queries' by using sp_configure. For more information about enabling 'Ad Hoc
Distributed Queries', search for 'Ad Hoc Distributed Queries' in SQL Server Books Online.
Additional Information: Microsoft documentation for Ad hoc distributed queries Server
Configuration Option.

sp_sentry_dbmail_20 Parameters
A list of sp_sentry_dbmail_20 parameters is shown in following the table. All parameters are optional except
for @recipients. You must specify at least one of @body, @query , @file_attachments, or @subject.
Otherwise, sp_sentry_dbmail_20 returns an error. Parameters are identical to those used by sp_send_dbmail.

Parameter

Description

@profile_name

Profiles are required to be set up in SQL Server 2005 and above
before using mail functionality. Profiles aren't required for
SentryOne; therefore, this parameter is optional for
sp_sentry_dbmail_20.
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Parameter

Description

@recipients

Email addresses of recipients, delimited by semicolons.

@copy_recipients

Email addresses of recipients to be copied, delimited by
semicolons.

@blind_copy_recipients

Email addresses of recipients to be blind copied, delimited by
semicolons.

@subject

Subject line of the message.

@body

The body of the message.

@body_format

The format of the message body. May be TEXT or HTML.

@importance

The importance of the message. May be Low, Normal, or High.

@sensitivity

The sensitivity of the message. May be Normal, Personal,
Private, or Confidential.

@file_attachments

A semi-colon delimited list of files to attach to the message.

@query

A SQL statement to be executed. The results of the query is
included in the body of the email by default, or as an attachment
if @attach_query_result_as_file = one.

@execute_query_database

The name of database on which to run the query.

@attach_query_result_as_file

If one, the query results are attached as a text file. If zero
(default), the results are included in line in the body of the
message.

@query_attachment_filename

The file name to use for the result set of a query when attached.
If none is specified and the above parameter =one, an arbitrary
file name is used.

@query_result_header

If one(default), the query results is included in the column
headers. If zero, they aren't included in the column headers.

@query_result_width

The line width, in characters, for rows in the query output.

@query_result_separator

Column separator value to use for the query output. The default
is ' ' . (space)

@exclude_query_output

If one, no output is returned to the client when the message is
sent. If zero (default), Mail sent is returned to the client
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Parameter

Description

@append_query_error

If one, the message is sent with the query error in the body. If
zero (default), the message isn't sent.

@query_no_truncate

If one, query results aren't truncated. If zero (default), columns
truncate to 256 characters.

@mailitem_id

Optional output parameter returns the mailitem_id of the
message. The mailitem_id is of type int.

@from_address

The mail from address to use for the message.

Replacing Calls To Sp_send_dbmail
Change calls to sp_send_dbmail to msdb..sp_sentry_dbmail_20, shown as follows:

Old Call:
exec sp_send_dbmail @recipients = 'user@sentryone.com', …

New Call:
exec msdb..sp_sentry_dbmail_20 @recipients = 'user@sentryone.com', …

Examples
Results Embedded in Message Body
exec msdb..sp_sentry_dbmail_20
@body = 'Products selling for over $2500.',
@body_format ='Text',
@from_address = 'm@sentryone.com',
@recipients = 'e@sentryone.com',
@copy_recipients = 'm@sentryone.com',
@subject = 'Results Embedded in Message Body',
@query = 'SELECT ProductID, [Name], ProductNumber FROM Production.Product WHERE ListPrice > 2500',
@execute_query_database = 'AdventureWorks2014',
@attach_query_result_as_file = 0;

Results:
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Comma-Separated Results Attached to Message
exec msdb..sp_sentry_dbmail_20
@body = 'See attached results.',
@body_format ='HTML',
@from_address = 'm@sentryone.com',
@recipients = 'e@sentryone.com',
@copy_recipients = 'm@sentryone.com',
@subject = 'Comma-separated Results',
@query = 'SELECT ProductID, [Name], ProductNumber FROM Production.Product WHERE ListPrice > 2500',
@execute_query_database = 'AdventureWorks2014',
@attach_query_result_as_file = 1,
@query_result_separator = ',',
@query_attachment_filename = 'queryresultscomma.txt';

Results:
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Using in an Execute SQL action
Additional Information: See the blog post Using SentryOne to Alert on SQL Server Database Object
Changes for an example of using sp_sentry_dbmail_20 parameters in a custom message for condition
alerting.

Troubleshooting
Use the dbo.SQLSentryDBEmails_20 table in the msdb database to find the status of a message.
For example:
USE msdb;
SELECT *
FROM dbo.SQLSentryDBEmails_20
WHERE [status] != 4
ORDER BY send_request_date DESC;

[status]

Description

0

Ready for processing

1

Waiting for query results

2

Reserved
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[status]

Description

3

Retrieved by monitor

4

Email sent

5

Email failed

6

Message creation failed
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sp_sentry_mail_20
Last Modified on 05 August 2021

When a SQL Server instance is first set to Watched status with SQL Sentry, SQL Sentry auto-installs a stored
procedure in the MSDB database named sp_sentry_mail_20 that's intended to be an interface compatible
replacement for xp_sendmail. sp_sentry_mail_20 that supports almost all of the functionality of xp_sendmail,
including sending query results as attachments.
Aside from using SMTP, not MAPI, sp_sentry_mail_20 is a standard stored procedure, not an extended stored
procedure, so it doesn't require installation of any dll’s, scripts, or other components on every SQL Server. The
configuration and maintenance requirements are dramatically reduced over xp_sendmail and other
xp_sendmail replacements. In addition, because sp_sentry_mail_20 has no dependencies on MAPI or SQLMail,
it's inherently more reliable than xp_sendmail.
After watching the SQL Server instance, all that's required is replacing any calls to xp_sendmail with
sp_sentry_mail_20, shown as follows.

 Note: For sp_sentry_mail_20 to function, SMTP settings must be configured first.
 Note: You may receive an error if the required components are not turned on:

Msg 15281, Level 16, State 1, Line 26
SQL Server blocked access to STATEMENT 'OpenRowset/OpenDatasource' of component
'Ad Hoc Distributed Queries' because this component is turned off as part of the security
configuration for this server. A system administrator can enable the use of 'Ad Hoc
Distributed Queries' by using sp_configure. For more information about enabling 'Ad Hoc
Distributed Queries', search for 'Ad Hoc Distributed Queries' in SQL Server Books Online.
Additional Information: Microsoft documentation for Ad hoc distributed queries Server
Configuration Option.

sp_sentry_mail_20 Parameters
A list of sp_sentry_mail_20 parameters is shown in the following table. All parameters are optional except for
@recipients. Parameters are identical to those used by xp_sendmail, except for two new optional parameters,
@from_address and @email_format.

Parameter

Description

@recipients

Email addresses of recipients, delimited by semicolons.
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Parameter

Description

@message

The body of the message.

@query

A SQL statement to be executed. The results of the query are included
in the body of the email by default, or as an attachment if
@attach_results is True.

@attachments

A semi-colon delimited list of files to attach to the message. Currently
ignored. Planned for future version.

@copy_recipients

Email addresses of recipients to be copied, delimited by semicolons.

@blind_copy_recipients

Email addresses of recipients to be blind copied, delimited by
semicolons.

@subject

Subject line of the message.

@type

Ignored. used by xp_sendmail only, but provided for xp_sendmail
compatibility.

@attach_results

If True, the query results are attached as a text file. If False (default),
the results are included in line in the body of the message.

@no_output

If True, no output is returned to the client when the message is sent. If
False (default), Mail sent is returned to the client.

@no_header

If False (default), no column headers are included in the query results.

@width

The line width for rows in the query output. Zero (default) indicates no
width limit should be used.

@separator

Column separator value to use for the query output.

@echo_error

Ignored. used by xp_sendmail only, but provided for
xp_sendmail compatibility.

@set_user

The user context under which to execute the query. Currently ignored.
Planned for future version.

@dbuse

The name of database in which to run the query.

@from_address

The mail from address to use for the message.

@email_format

Allowed values are text or html only.

Replacing Calls to xp_sendmail
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Change calls from xp_sendmail to msdb..sp_sentry_mail_20, shown as follows:

Old Call:
exec xp_sendmail @recipients = 'user@SentryOne.com', …

New Call:
exec msdb..sp_sentry_mail_20 @recipients = 'user@SentryOne.com', …

Example: Results Embedded in Message Body
exec msdb..sp_sentry_mail_20
@from_address = 'm@SentryOne.com',
@recipients = 'e@SentryOne.com',
@copy_recipients = 'm@SentryOne.com',
@subject = 'Product List sp_sentry_mail_20 Results Embedded in Message Body',
@message = 'Product List Report',
@query = 'SELECT ProductID, [Name], ProductNumber FROM Production.Product WHERE ListPrice > 2500',
@dbuse = 'AdventureWorks2014';

Results:

Example: Comma-Separated Results Attached to Message
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exec msdb..sp_sentry_mail_20
@from_address = 'm@SentryOne.com',
@recipients = 'e@SentryOne.com',
@copy_recipients = 'm@SentryOne.com',
@subject = 'Product List sp_sentry_mail_20 Comma-Separated Results Attached',
@message = 'Product List Report',
@query = 'SELECT ProductID, [Name], ProductNumber FROM Production.Product WHERE ListPrice > 2500',
@dbuse = 'AdventureWorks2014',
@attach_results = 'TRUE',
@separator = ',';

Results:
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Removing Watched Server Objects
Last Modified on 08 October 2021

Stop Watching
Enable Watching and Stop Watching on the targets within your server environment.

 Note: If you choose to Stop Watching a target, remember to reclaim the license for that target,
allowing you to apply it elsewhere. For more information, see the License Management article.

 Note: You can use PowerShell to stop watching targets. See the PowerShell Module article for more
information.

 Note: The Inventory node provides a read-only view of what you are watching. See the Inventory
View article for details.

To Stop Watching a target in SentryOne, complete one of the following procedures:

Using the Navigator pane
Stop watching a target through the Navigator pane:
View > Navigator > Desired Target > Stop Watching
1. Open the Navigator pane (View > Navigator), and then select your desired target.
2. Right-click on the desired target, and then select Stop Watching.
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Stop watching a target hosting a SQL Server instance through the Navigator pane:
View > Navigator > Desired Target > Desired Instance > Stop Watching Instance
1. Open the Navigator pane (View > Navigator), and then expand your desired target.

2. Right click on the SQL Server Instance, and then select Stop Watching Instance.
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3. Right click on the target, and then select Stop Watching.

Using Performance Overview
Stop watching through Performance Overview:
1. Right-click All Targets (View > Navigator > All Targets), select Open, and then select Performance
Overview. This opens the All Targets tab.
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2. Right-click on the desired target, then select Stop Watching.

Removing Watched Server Objects
 Note: When you watch a SQL Server with Event Manager, SQL Sentry places a few objects in MSDB
that facilitate its lightweight polling architecture. No agents are placed on the server. This enables SQL
Sentry to monitor the server with a performance overhead that's typically less than SQL Agent. For
more information about watched server objects, see the Watched Server Objects topic.

If you've stopped watching a SQL Server instance or Azure SQL Database target with SentryOne, and don't
have plans to Watch it again, scripts are provided to automate the process of removing the objects

294

SentryOne places on a watched target.

 Important: Stop Watching the server through the SentryOne client before attempting to remove the
object.

Select the appropriate tab below to view the script.

SQL Server 2000 Instances
--SQL Server 2000
USE msdb
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[sp_sentry_mail]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[sp_sentry_mail]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[sp_sentry_mail_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[sp_sentry_mail_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryEmails_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryEmails_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spGetBlockInfo_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetBlockInfo_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spGetBlockInfo_Pre8sp3]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetBlockInfo_Pre8sp3]
GO
BEGIN TRANSACTION
DECLARE @JobID BINARY(16)
DECLARE @ReturnCode INT
SELECT @ReturnCode = 0
-- Delete the job with the same name (if it exists)
SELECT @JobID = job_id
FROM msdb.dbo.sysjobs
WHERE (name = N'SQL Sentry 2.0 Queue Monitor')
IF (@JobID IS NOT NULL)
BEGIN
-- Check if the job is a multi-server job
IF (EXISTS (SELECT *
FROM msdb.dbo.sysjobservers
WHERE (job_id = @JobID) AND (server_id <> 0)))
BEGIN
-- There is, so abort the script
RAISERROR (N'Unable to import job ''SQL Sentry Queue Monitor'' since there is already a multi-server job with this na
me.', 16, 1)
GOTO QuitWithRollback
END
ELSE
-- Delete the [local] job
EXECUTE msdb.dbo.sp_delete_job @job_name = N'SQL Sentry 2.0 Queue Monitor'
SELECT @JobID = NULL
END
COMMIT TRANSACTION
GOTO EndSave QuitWithRollback:
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GOTO EndSave QuitWithRollback:
IF (@@TRANCOUNT > 0) ROLLBACK TRANSACTION
EndSave:
GO
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spGetJobInfo_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetJobInfo_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spGetDTSLog_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetDTSLog_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spQueueHeartbeat_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueHeartbeat_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spQueueJob_Start_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueJob_Start_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spQueueJob_End_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueJob_End_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spQueueMonitor_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueMonitor_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spReadLogFile_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spReadLogFile_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryQueueLog_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryQueueLog_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryLogCache_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogCache_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryLogCacheDTS_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogCacheDTS_20]
GO
BEGIN TRANSACTION
DECLARE @JobID BINARY(16)
DECLARE @ReturnCode INT
SELECT @ReturnCode = 0
-- Delete the job with the same name (if it exists)
SELECT @JobID = job_id
FROM msdb.dbo.sysjobs
WHERE (name = N'SQL Sentry 2.0 Alert Trap')
IF (@JobID IS NOT NULL)
BEGIN
-- Check if the job is a multi-server job
IF (EXISTS (SELECT *
FROM msdb.dbo.sysjobservers
WHERE (job_id = @JobID) AND (server_id <> 0)))
BEGIN
-- There is, so abort the script
RAISERROR (N'Unable to import job ''SQL Sentry Alert Trap'' since there is already a multi-server job with this name.',
16, 1)
GOTO QuitWithRollback
END
ELSE
-- Delete the [local] job
EXECUTE msdb.dbo.sp_delete_job @job_name = N'SQL Sentry 2.0 Alert Trap'
SELECT @JobID = NULL
END
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END
COMMIT TRANSACTION
GOTO EndSave QuitWithRollback:
IF (@@TRANCOUNT > 0) ROLLBACK TRANSACTION
EndSave:
GO
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spTrapAlert_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spTrapAlert_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[spSetupAlertsTrap_20]')
and OBJECTPROPERTY(id, N'IsProcedure') = 1)
drop procedure [dbo].[spSetupAlertsTrap_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryAlertLog_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryAlertLog_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryLogData_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogData_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[SQLSentryObjectVersion_20]')
and OBJECTPROPERTY(id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryObjectVersion_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[fnGetSQL_20]')
and OBJECTPROPERTY(id, N'IsScalarFunction') = 1)
drop function [dbo].[fnGetSQL_20]
if exists (select * from dbo.sysobjects where id = object_id(N'[dbo].[fnGetWaittypeDesc_20]')
and OBJECTPROPERTY(id, N'IsScalarFunction') = 1)
drop function [dbo].[fnGetWaittypeDesc_20]

SQL Server 2005+ Instances
--SQL Server 2005+
USE msdb
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[sp_sentry_mail]') and OBJECTPROPERTY(object
_id, N'IsProcedure') = 1)
drop procedure [dbo].[sp_sentry_mail]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[sp_sentry_mail_20]') and OBJECTPROPERTY(ob
ject_id, N'IsProcedure') = 1)
drop procedure [dbo].[sp_sentry_mail_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[sp_sentry_dbmail_20]') and OBJECTPROPERTY(
object_id, N'IsProcedure') = 1)
drop procedure [dbo].[sp_sentry_dbmail_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryEmails_20]') and OBJECTPROPERTY(
object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryEmails_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryDBEmails_Attachments_20]') and O
BJECTPROPERTY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryDBEmails_Attachments_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryDBEmails_20]') and OBJECTPROPER
TY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryDBEmails_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetBlockInfo_20]') and OBJECTPROPERTY(ob
ject_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetBlockInfo_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetBlockInfo_Pre8sp3]') and OBJECTPROPER
TY(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetBlockInfo_Pre8sp3]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetQueryStatsData]') and OBJECTPROPERTY
(object_id, N'IsProcedure') = 1)
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(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetQueryStatsData]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetProcedureStatsData]') and OBJECTPROPE
RTY(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetProcedureStatsData]
GO
BEGIN TRANSACTION
DECLARE @JobID BINARY(16)
DECLARE @ReturnCode INT
SELECT @ReturnCode = 0
-- Delete the job with the same name (if it exists)
SELECT @JobID = job_id
FROM msdb.dbo.sysjobs
WHERE (name = N'SQL Sentry 2.0 Queue Monitor')
IF (@JobID IS NOT NULL)
BEGIN
-- Check if the job is a multi-server job
IF (EXISTS (SELECT *
FROM msdb.dbo.sysjobservers
WHERE (job_id = @JobID) AND (server_id <> 0)))
BEGIN
-- There is, so abort the script
RAISERROR (N'Unable to import job ''SQL Sentry Queue Monitor'' since there is already a multi-server job with this na
me.', 16, 1)
GOTO QuitWithRollback
END
ELSE
-- Delete the [local] job
EXECUTE msdb.dbo.sp_delete_job @job_name = N'SQL Sentry 2.0 Queue Monitor'
SELECT @JobID = NULL
END
COMMIT TRANSACTION
GOTO EndSave QuitWithRollback:
IF (@@TRANCOUNT > 0) ROLLBACK TRANSACTION
EndSave:
GO
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetJobInfo_20]') and OBJECTPROPERTY(obje
ct_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetJobInfo_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spGetDTSLog_20]') and OBJECTPROPERTY(obj
ect_id, N'IsProcedure') = 1)
drop procedure [dbo].[spGetDTSLog_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spQueueHeartbeat_20]') and OBJECTPROPERT
Y(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueHeartbeat_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spQueueJob_Start_20]') and OBJECTPROPERTY
(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueJob_Start_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spQueueJob_End_20]') and OBJECTPROPERTY(
object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueJob_End_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spQueueMonitor_20]') and OBJECTPROPERTY(o
bject_id, N'IsProcedure') = 1)
drop procedure [dbo].[spQueueMonitor_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spReadLogFile_20]') and OBJECTPROPERTY(obj
ect_id, N'IsProcedure') = 1)
drop procedure [dbo].[spReadLogFile_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryQueueLog_20]') and OBJECTPROPER
TY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryQueueLog_20]
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drop table [dbo].[SQLSentryQueueLog_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryLogCache_20]') and OBJECTPROPER
TY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogCache_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryLogCacheDTS_20]') and OBJECTPRO
PERTY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogCacheDTS_20]
GO
BEGIN TRANSACTION
DECLARE @JobID BINARY(16)
DECLARE @ReturnCode INT
SELECT @ReturnCode = 0
-- Delete the job with the same name (if it exists)
SELECT @JobID = job_id
FROM msdb.dbo.sysjobs
WHERE (name = N'SQL Sentry 2.0 Alert Trap')
IF (@JobID IS NOT NULL)
BEGIN
-- Check if the job is a multi-server job
IF (EXISTS (SELECT *
FROM msdb.dbo.sysjobservers
WHERE (job_id = @JobID) AND (server_id <> 0)))
BEGIN
-- There is, so abort the script
RAISERROR (N'Unable to import job ''SQL Sentry Alert Trap'' since there is already a multi-server job with this name.',
16, 1)
GOTO QuitWithRollback
END
ELSE
-- Delete the [local] job
EXECUTE msdb.dbo.sp_delete_job @job_name = N'SQL Sentry 2.0 Alert Trap'
SELECT @JobID = NULL
END
COMMIT TRANSACTION
GOTO EndSave QuitWithRollback:
IF (@@TRANCOUNT > 0) ROLLBACK TRANSACTION
EndSave:
GO
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spTrapAlert_20]') and OBJECTPROPERTY(object
_id, N'IsProcedure') = 1)
drop procedure [dbo].[spTrapAlert_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[spSetupAlertsTrap_20]') and OBJECTPROPERTY
(object_id, N'IsProcedure') = 1)
drop procedure [dbo].[spSetupAlertsTrap_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryAlertLog_20]') and OBJECTPROPERT
Y(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryAlertLog_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryLogData_20]') and OBJECTPROPERT
Y(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryLogData_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[SQLSentryObjectVersion_20]') and OBJECTPRO
PERTY(object_id, N'IsUserTable') = 1)
drop table [dbo].[SQLSentryObjectVersion_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[fnGetSQL_20]') and OBJECTPROPERTY(object_i
d, N'IsScalarFunction') = 1)
drop function [dbo].[fnGetSQL_20]
if exists (select * from sys.objects where object_id = object_id(N'[dbo].[fnGetWaittypeDesc_20]') and OBJECTPROPERT
Y(object_id, N'IsScalarFunction') = 1)
drop function [dbo].[fnGetWaittypeDesc_20]
if exists (select * from sys.objects where object_id = object_id(N'[SQLSentry].[SQLSentryObjectVersion_20]') and OBJE
CTPROPERTY(object_id, N'IsUserTable') = 1)
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CTPROPERTY(object_id, N'IsUserTable') = 1)
drop table [SQLSentry].[SQLSentryObjectVersion_20]

Azure SQL Database
--Azure
if exists (select * from sys.objects where object_id = object_id(N'[SQLSentry].[spGetProcedureStatsData]') and OBJECT
PROPERTY(object_id, N'IsProcedure') = 1)
drop procedure [SQLSentry].[spGetProcedureStatsData]
if exists (select * from sys.objects where object_id = object_id(N'[SQLSentry].[spGetQueryStatsData]') and OBJECTPR
OPERTY(object_id, N'IsProcedure') = 1)
drop procedure [SQLSentry].[spGetQueryStatsData]
if exists (select * from sys.objects where object_id = object_id(N'[SQLSentry].[SQLSentryObjectVersion_20]') and OBJE
CTPROPERTY(object_id, N'IsUserTable') = 1)
drop table [SQLSentry].[SQLSentryObjectVersion_20]
DECLARE @listOfSqlSentryTables VARCHAR(MAX)
DECLARE @sqlStatement VARCHAR(MAX)
select @listOfSqlSentryTables = COALESCE(@listOfSqlSentryTables+',' ,'') + 'SQLSentry.' +name from sys.objects wh
ere name like N'ProcedureStats%' and OBJECTPROPERTY(object_id, N'IsUserTable') = 1 and schema_id = schema_id('
SQLSentry')
set @sqlStatement = 'drop table ' + @listOfSqlSentryTables
exec(@sqlStatement)
SET @listOfSqlSentryTables = NULL;
select @listOfSqlSentryTables = COALESCE(@listOfSqlSentryTables+',' ,'') + 'SQLSentry.' +name from sys.objects wh
ere name like N'QueryStats%' and OBJECTPROPERTY(object_id, N'IsUserTable') = 1 and schema_id = schema_id('SQL
Sentry')
set @sqlStatement = 'drop table ' + @listOfSqlSentryTables
exec(@sqlStatement)
if schema_id('SQLSentry') is not null
drop schema SQLSentry
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Adding the SQL Sentry Database to an
Availability Group
Last Modified on 15 October 2021

To add an existing SQL Sentry Database to an Availability Group in your environment, complete the following
steps:

Registering your Listener Connection
1. Complete the following for your installation type:

EPI Installation
1. Open Windows Powershell and use the so stopms -n --all command to stop all SentryOne Monitoring
Service(s).
so stopms-n LHP85 --all

Unified Installation
1. Open Windows Services on your Monitoring Service machine(s) and Stop the SentryOne Monitoring
Service.

2. Open the SQL Sentry Client, and select Help > Manage Licenses to open the SolarWinds License Manager.

3. Select the applicable license(s), and then select Deactivate.
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 Important: Deactivate all licenses that you will use with your Availability Group connection.

4. Join the SQL Sentry Database to your Availability Group.

Additional Information: For more information about joining a database to an availability group, see
the following MSFT article.

5. In the SQL Sentry Client, select File > Connect to open the SolarWinds SQL Sentry Database Connection
Management window.

6. Select + Add New Connection to add your listener connection. Enter the friendly name under Name, enter
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the listener name under Server Name, and enter the existing SQL Sentry database under Database Name.
Select Connect to test your connection, and then select Save to save the listener connection.

 Note: Once you have successfully connected to and saved your listener connection, a SQL Sentry
window will open to the configured listener connection. Do not close the listener connection window.

7. Close the SQL Sentry Client for your previous connection.

Configuring the Monitoring Services
Configure your SentryOne Monitoring Service(s) to connect through the listener with the Unified Installer or
EPI Installer:

Unified Installation
1. Select Start > SolarWinds SQL Sentry > Service Configuration to open the SQL Sentry Service
Configuration Manager.
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2. Enter the listener connection information, and then select Ok to connect the monitoring service to the
listener.

3. Repeat step 2 for each monitoring service that will connect to the listener.

EPI Installation

 Note: To update the SQL Sentry Monitoring Service connection(s), the monitoring service(s) will
need to be uninstalled and then reinstalled. The so update command only updates the Service Account
and Service Account password.

Additional Information: For more information about EPI commands, see EPI Commands.

1. Open Windows Powershell as an Administrator.
2. Use so uninstall -n to uninstall the controller service and monitoring service. Repeat this command for each
monitoring service connection.
so uninstall -n LHP85

3. Use so addreg -n --serverName --databaseName to create a new registration for the listener.
so addreg -n ag1-listener --ag1-listener --SQLSentryDB SQLSentryDB

4. Use so install -n --IAcceptLicenseTerms -u -p to install the monitoring and controller services.
so install -n ag1-listener --IAcceptLicenseTerms -u JesseRemoteAgentUser -p TempPAssWord!

Activating Licenses
1. Stop all SentryOne Monitoring Services for the Unified installation or EPI installation:
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EPI Installation
1. Use so stopms -n --all to stop the monitoring service connections.
so stopms -n ag1-listener --all

Unified Installation
1. Log onto each machine and start the Monitoring Service.

 Note: You can right-click Services(Local) in your local services, and then select Connect to another
computer to start a service remotely. You can also use PowerShell or the Command Window to
remotely start a monitoring service.

2. Open the SQL Sentry Client and connect to your listener connection. Select Help > Manage Licenses to
open the SolarWinds License Manager.

3. Select the applicable license and then select Activate to activate your license.

Additional Information: For more information about activating your license in the SolarWinds License
Manager, see the SQL Sentry License Management article.
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4. Start the SentryOne Monitoring Service(s):
Unified Installation
1. Open Windows Services for your machine(s) and start the SentryOne Monitoring Service.

EPI Installation
1. Use the so startms -n --all command to start the SentryOne Monitoring Service(s).
so startms -n ag1-listener --all
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Getting Started Overview
Last Modified on 12 April 2022

This article provides an overview for getting started with your SQL Sentry Installation. Here we will list several
helpful links to our documentation, blogs, and important SolarWinds account links to help guide you through
the process. For information about SQL Sentry Pricing, or to download a free trial, visit SQL Sentry |
SolarWinds.

Additional Information: See the following helpful links:
SQL Sentry Blogs
SolarWinds Customer Portal
Submitting a SolarWinds Support ticket

SQL Sentry Architecture
A basic SQL Sentry installation consists of three components:

SQL Sentry
Component

Description

SQL Sentry Client

The SQL Sentry Client displays the historical and real-time data for your
monitored targets that is collected by the SQL Sentry Database.
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SQL Sentry
Component

Description

SentryOne Monitoring
Service

The SentryOne Monitoring Service remotely collects data from the target
servers and writes that data to the SQL Sentry Database.

SQL Sentry Database

The SQL Sentry Database collects and retains performance data for your
monitored targets.

Additional Information: For more information about SQL Sentry components and architecture, see the
SQL Sentry Components and Architecture article.

Account Requirements
The account used for running the SentryOne Monitoring Service should be a domain account and needs to
have local Windows Admin and Sys Admin rights on all the target server(s) that you want to monitor.

Additional Information: For more information about security options in SQL Sentry, see the SQL
Sentry Security Overview, SQL Sentry Monitoring Service Security, and SQL Sentry Portal Security articles.

SQL Sentry requires several ports open to collect data from target servers.

Additional Information: For more information about the ports required to collect information in SQL
Sentry, see the SQL Sentry Performance Analysis Required Ports article.

SQL Sentry Client users need allow_all permissions to the SQL Sentry Database for full access to the
information collected by the SentryOne Monitoring Service. Visibility and functionality for individual users can
be restricted through Rights-based or Role-based security in the SQL Sentry Client.

Additional Information: For more information about the present security options in SQL Sentry, see
the SQL Sentry Rights Based Security, and SQL Sentry Role Based Security articles.

System Requirements and Installation
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Before installing SQL Sentry, check the System Requirements to ensure your system meets the minimum
standards to run SQL Sentry. SolarWinds recommends that a dedicated VM should host the SQL Sentry
components and that no SQL Sentry components be installed directly on production servers. If a dedicated
VM hosting the SQL Sentry components isn't possible, a testing or development server that does not have a
heavy workload could work for an evaluation or proof of concept.

 Important: Clients can be installed anywhere, as long as they can communicate with the SQL Sentry
Database to pull data. It's not recommended to connect to the SQL Sentry database with the SQL Sentry
client through a VPN because doing so can affect the SQL Sentry Client's performance.

For more information about recommended system spec information for your SQL Sentry installation, see
the SQL Sentry Installation Recommendations article.

After you have checked the system requirements, you install SQL Sentry, complete the onboarding process,
and apply your license.

Additional Information: If you are installing multiple clients and monitoring services across many
targets, consider installing your SQL Sentry Installation with the Enhanced Platform Installer.
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 Important: If you plan to monitor targets in other domains with various levels of trust or have targets
in datacenters that span large geographical distances, modifications to the implementation may be
required.
Our two options for cross-domain monitoring are Site Configuration and Pass-Through Authentication.
SolarWinds always recommends Site Configuration because Pass-Through Authentication behavior can be
inconsistent.

Additional Information: For information about site configuration or watching targets across domains,
see the SQL Sentry Site Configuration and SQL Sentry Watching Targets Across Domains articles.

SQL Sentry Portal
SQL Sentry Portal is a browser-based option for accessing your SQL Sentry environment data that uses your
existing SQL Sentry database.

For information about Getting started with SQL Sentry Portal, see the Getting Started with SQL Sentry
Portal article.

310

SQL Sentry Onboarding
Last Modified on 22 March 2022

Launching the SQL Sentry Client
Additional Information: If you are using the SQL Sentry Virtual Machine on Azure, see this onboarding
video.

When you launch the SQL Sentry client for the first time, you interact with the Onboarding wizard. The
Onboarding wizard helps you understand and configure features in SQL Sentry. Once the onboarding process
is complete, add your first monitored target, and jump right in to tuning your environment! During
onboarding, you're introduced to:
Applying your license
Setting up a user for alerting purposes
Enabling your email alerts

 Note: During the onboarding process you can skip steps that may not be applicable to you, and you
can always change any options at a later time with the SQL Sentry client.

Onboarding Wizard: Initial Screen
Launch the SQL Sentry client.

Select Continue.
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 Note: If you have other SQL Sentry connections from previous installations, opening the SQL Sentry
client will display the SQL Sentry Database Connection Management screen. If this happens, select
Connect for the connection you want to onboard.

Onboarding Wizard: License Configuration
On the License Configuration screen you have three options:
1. Continue with trial - Select this option if you do not have a license and you are just getting started with
a SQL Sentry trial evaluation. You typically have 30 days from your installation to evaluate the SQL
Sentry software. See the product trial website for more information or contact sales@solarwinds.com
for more information.
2. Activate a license online - Select this option if you are an existing SQL Sentry customer and have your
license available to copy/paste into the Onboarding wizard.
3. Activate a license offline - Select this option if you are an existing SQL Sentry customer and need to
activate your license offline by using the SolarWinds Customer Portal to generate a key.
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Option 1. Continue with trial
If you downloaded the trial from the SolarWinds website, there are no additional screens, and you'll continue
directly to the Tell Us More About Yourself screen.
If you obtained your trial from an AWS or Azure Marketplace image, you will get a Trial Information screen.
Complete all enabled fields on the Trial Information screen, then select Continue with trial. The next screen
will be the Tell Us More About Yourself screen.
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Trial Information screen for trials from the AWS or Azure Marketplace

Option 2. Activate a license online
Paste your license from the SolarWinds Customer Portal into the License Key field and complete the form
with your Name, Email, and Phone information. Select Activate to continue.
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Option 3. Activate a license offline
Copy the value from the Unique ID field to generate a license key file in the SolarWinds Customer Portal. Save
the file, use Browse to load it, then select Activate to continue.
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Additional Information: See the How to manually register a SolarWinds license article for more details
on generating the key from the customer portal.

Onboarding Wizard: Tell Us More About Yourself
Enter your user information, then select Save.
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Onboarding Wizard: Enabling Email Alerts
During the onboarding process, you have the ability to enable email alerts. On the first screen, you'll be asked
if you would like to Enable Email Alerts. You can configure this now or later. See the SMTP Settings article
for more information on doing this later or making changes.
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Configure my own SMTP Server now
If you choose to Configure my own SMTP Server now , you'll see the second Enable Email Alerts screen
shown below:
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1. Enter the domain name or IP address of the SMTP server that you want to be used for routing SQL
Sentry email notifications in the SMTP Server address field.  Note: If using localhost, keep in mind
this will be the local SMTP server on the machine where the SQL Sentry monitoring service is installed,
since it's responsible for sending all notifications. The SQL Sentry client doesn't send any notifications.
2. Enter the Email from Address. This is the address that appears on the from line of all email notifications
sent by SQL Sentry.
3. Enter a Custom port number if needed.
4. Enter Security credentials if needed.
5. Select Test to generate a test email for a specific address.
6. Select Save to save your information.

 Note:
The Security (Optional) section is not required in most environments. If your environment
requires this authentication for your SMTP server, specify a User Name and Password.
 Note: You may need to contact your network administrator first to ensure that the IP address
of the monitoring service computer has been granted both connect and relay permissions for the
specified SMTP server.
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 Important: For the most accurate SMTP test, use the client installed on the SQL Sentry monitoring
service computer to send the test message. If you use a client on a different computer, such as your local
workstation, the results may be different. For example, your SMTP server may allow relay from your
workstation but not from the SQL Sentry monitoring service computer, in which case the test from your
workstation would succeed, but the SQL Sentry monitoring service would be unable to deliver
notifications.

Onboarding Wizard: Let's Go!
Select Let's Go! to launch the client.

 Success: You've configured SQL Sentry for your environment! Once the onboarding process is
complete, you'll want to add your first monitored target as described below.

Adding Targets and Instances to Watch
On the Add Target screen, select the type of target from the target type drop-down box. Enter the name of
the target you'd like to monitor in the box below.
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 Important: For Azure SQL Database and Azure SQL Data Warehouse, provide the database or data
warehouse name in addition to the Target name (which is the full URL to the endpoint). Both Azure
features require credentials to be provided. These credentials are the SQL logins defined for the
database server or data warehouse; they are not Azure account credentials. In addition, the firewall rules
must allow access to the monitoring service, either directly over the internet; or through a configured
VNet. Azure SQL Database and Azure SQL Data Warehouse only support access through port 1433.

 Important: For FCI cluster nodes, provide the client access name in the please enter the name of the
target field. For SQL Sentry Versions 2021.12 and newer, when watching a new FCI instance, you will be
prompted to add and watch all possible owners of the instance. Select Yes to add and watch all possible
owners of the FCI. For more information about the Enhanced FCI feature with SQL Sentry, see Enhanced
FCI.

 Important: For AG Availability Group Clusters, add the individual servers that are a part of the
Availability Group. It's highly recommended to monitor all Availability Group replicas for optimal
Availability Group specific alerts and functionality. Monitoring all Availability Group replicas isn't
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required, but will result in the loss of Availability Group alerts and functionality.

Select Connect to test the target for feature availability. If the connection is successful, the categories listed
show green lights next to them.

Otherwise, if there's limited access, you may be unable to collect data for some or all of the given categories:
Disk Activity
Disk Space
Performance Counters
Windows Dashboard
Windows Processes
It's recommended that you try to fix these limited access issues, though in some cases limited access is your
only option (such as using a cloud-hosted SQL Server instance). Because you won't have access to the
operating system, this would fall under Limited Access. After reviewing the feature availability chart, run this
check again with Retry, or select Next to continue.
Once the initialization process has completed, select Open to monitor the target. You may see the Start Page
populate with information about your target as soon as the initialization completes.
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 Note: If errors occur while adding targets or instances, it may be due to problems with security,
network connectivity, and/or name resolution. For more information, see the Security and the SQL
Sentry Server topic.

For more information about configuration options, see the Getting Started Cheat Sheet.

 Success: Congratulations, you have successfully installed SQL Sentry, configured global notification
settings, and you are now ready to start using the SQL Sentry client for managing events across your
enterprise.

Maintenance
Just as with any other SQL Server database, it is important that regular maintenance activities be performed
on the SQL Sentry database to ensure optimal performance. For more information, see the SQL Sentry
Database Maintenance topic.
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Monitoring Additional Targets
Last Modified on 22 March 2022

Terminology
When the word target is used, we are referring to the device that houses your data, whether it's a physical
server, cloud installation, APS appliance, or AWS RDS for SQL Server. Instance is referring to an instance of
SQL Server or SSAS.

Supported Targets and Instances
Currently, SQL Sentry supports the monitoring of Windows, Azure SQL Database, SQL DW, APS appliance
targets, AWS RDS for SQL Server targets, and Managed Instances. For more information about Managed
Instances, see the Reaching for the cloud with SQL Sentry & Managed Instance article. Supported instances
include SQL Server and SSAS. For more information about instances, including supported versions, see the
System Requirements topic.

Access Level
When adding a new target, the first step is completing a feature availability test. The results of this test
determine whether the target is added with full access or limited access. When a target is added with full
access, the monitoring service collects Windows level metrics and provides you with full access to the
features of performance analysis.
If the target fails the feature availability test, select the troubleshooting link, and attempt to resolve the
issue. After applying a solution, retest the target. There are some situations in which limited access is the only
option. For example, if you are monitoring a cloud-based SQL Server instance, you likely don't have access to
the OS. When limited access is applied, the monitoring service doesn't collect performance counters, and
access to the Windows Dashboard, Disk Activity tab, Disk Space tab, and Windows Processes tab are
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restricted. For more information about adding a Windows target, see the Performance Analysis for Windows
topic.

Adding Instances
Add additional monitored instances to your SQL Sentry environment. Right-click either the shared groups
node, a site node, a target group node, or an existing target node in the Navigator pane, and then select Add,
or select File to add an instance. In the Add dialog box, choose the desired instance type from the drop-down
menu, and then select Connect.

325

 Note:
When adding a new target, SQL Sentry attempts to resolve the name/IP address of the target
being added. There are no scans of IP ranges or subnets.
See the Watched Target Objects article for information about objects added to the target.

 Important: When adding FCI cluster nodes, provide the client access name in the please enter the
name of the target field. For SQL Sentry Versions 2021.12 and newer, when watching a new FCI instance,
you will be prompted to add and watch all possible owners of the instance. Select Yes to add and watch
all possible owners of the FCI. For more information about the Enhanced FCI feature with SQL Sentry, see
Enhanced FCI.
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 Important: When adding AG Availability Group Clusters, add the individual servers that are a part of
the Availability Group. It's highly recommended to monitor all Availability Group replicas for optimal
Availability Group specific alerts and functionality. Monitoring all Availability Group replicas isn't
required, but will result in the loss of Availability Group alerts and functionality.

Watching Instances
When you add a new instance to your environment it's monitored by default unless you explicitly decide not
to watch the new instance. SQL Sentry monitors instances or objects with a status of Watched. Instances or
objects that are not being watched are displayed with a grayed-out icon next to their name in the Navigator
pane.
Unwatched instances or objects can have their status set to Watched through their respective context menus
by selecting Watch. Once you watched a new instance, the SQL Sentry monitoring service starts actively
monitoring the instance and its objects and begins honoring any associated configured conditions and
actions.
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 Note: Immediately after adding an instance or setting an instance to a watched status, SQL Sentry
begins to synchronize with that instance. Exactly how long the synchronization process takes depends
on the number of objects associated with the instance, the amount of historical data available, and how
many instances are being watched at the same time. The watched status window keeps you informed of
the process and alerts you to any errors.

Modifying Instance Properties
After you’ve added an instance, you may need to change how SQL Sentry connects to the target. You’ll see
two options for connection properties when right-clicking on an instance:

Property

Description

User Connection
Properties

Defines how your SQL Sentry client connects to a monitored server for
the current user. These properties can vary for each client in your
environment. The SQL Sentry client only connects directly to a
monitored server under specific scenarios. For more information about
the scenarios and specific security requirements, see the Client
Security topic.

Monitoring Service
Connection Properties

Defines how the SQL Sentry monitoring service connects to the
selected server. The setting can be applied from any SQL Sentry client.
Right-click on the instance, and then select Monitoring Service
Connection Properties to configure the monitoring service
connection. For more information, see the Monitoring Service Security
topic.
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Within the connection properties window, there are several properties that can be changed:
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Property

Description

Enable Integrated
Authentication

Tells what instance to use for the integrated Windows account
information.

Credentials

Where you enter SQL Server credentials if you're not using integrated
authentication.

Alias

By default, you'll see the server name that you initially entered when
adding the instance.

Port

Used to connect to the SQL Server if it has been configured to a nonstandard port.

Access Level

Used to assign the level of access that SQL Sentry has to the selected
target. A target with limited access is not able to access Windowsbased features, such as the Windows Dashboard, Windows Processes
tab, Disk Space tab, or Disk Activity tab. Limited Access targets also
don't have access to PerfLib performance counters for that target.

 Note: All of these settings are available for SQL Server instances. SSAS instances only offer the Port
setting. Targets offer the Access Level setting.

If you're monitoring the instance with Performance Analysis, changing the Monitoring Service Connection
Properties to SQL Server credentials isn't supported. For more information, see the Performance Analysis
Security Requirements topic.
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Getting Started with SQL Sentry Event Calendar
Last Modified on 09 August 2021

Introduction
Video Overview

Opening Event Calendar
When opening a target from the SQL Sentry navigator, you'll be asked to select Event Calendar or
Performance Analysis.

 Note: As mentioned in the View Selector message, if you want to always go to the Event Calendar
or Performance Analysis by default, you can change this in User Preferences to bypass the popup.
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Deselect the Prompt me to select a product when left-clicking to open a node option, then select
Calendar View or Performance Analysis as your default.
For the Default Event View Style, you can choose Calendar View , List View , or Split View . These views
are introduced below and explained in more detail in the Calendar & List Views article.

Event Views
Calendar
The calendar view provides a visual way to understand what is happening on the target and when. The
default view shows you the current time. You can look back to troubleshoot a performance issue or jump
forward to view scheduled jobs. Looking forward is helpful to discover a hot spot of upcoming activity that
might lead to blocking or other performance issues.
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 Note: The default calendar view can be busy on some targets, so remember that you can zoom into a
shorter period of time. The view above shows a one hour view instead of the one day default. Zooming
and other navigation options are shown in the Calendar & List Views article.

List
The list view (use the View drop-down in the top navigation bar to access) provides an expandable list of
events for the selected time period. This can be a great way to view large jobs that have multiple steps. This
puts them into an organized list that you can expand for more details.
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 Note: All the columns and fields at the top of the list view have built in filter features. Hover over
Event Source Name, Object Name, Start Time, End Time, Duration, Run Status, or Message Text to
see the available filter options by selecting the  filter icon that appears.
For example, use a Run Status filter to view only events that are In Progress, or use the Custom Filter
option to build a more complex filter condition on any of these items.

Split
The split view option divides the event view between calendar and list views.
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Additional Views and Filters
In addition to a single day, the views can show multiple days at the same time, filtered views, or a combination
of views.

Multi-day view
In the split view example below, the Days option is set to 3 and the view is displaying today (Tue, 3/16/2021)
as well as yesterday (Mon, 3/15/2021) and tomorrow (Wed, 3/17/2021).

Filtered view
The Navigator pane has an Event Calendar tab that allows you to create filters for the event views. The filter
has multiple tabs and options for statuses, event text, event sources, and more. In the example below, a
multi-day view has a filter on the Event Sources tab applied to show only Windows Task Scheduler Tasks.
Set your filters, then select the Apply Filter button to apply it to the view.
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Tips and Tricks
Additional Information: See SQL Sentry Event Calendar Tips and Tricks to dive into more ways to
make the event calendar views work efficiently for you and make correlations between events and issues
on your monitored targets.
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Getting Started with SQL Sentry Performance
Analysis
Last Modified on 17 May 2021

Performance Analysis Features
Performance Analysis allows you to gather and display detailed information about your monitored servers
within your environment. Performance analysis provides ease of access through a variety of tabs.

 Note: Available tabs and features vary by target type (e.g. SQL Server, SSAS, Windows, etc.).

Dashboard
The Dashboard provides a graphical representation of the monitored server activity through a variety of
graphs. Color coded graphs distinguish between what's used by the instance versus any other processes.
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 Note: The information shown on each tab is relevant to the time shown on the toolbar. See how the
server looked at a given date or time by selecting the desired time in the Start and End drop-down
boxes. Select Sync to synchronize all the tabs within the same time frame.

The left side displays Windows metrics for the monitored server.
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The right side displays SQL server metrics for the monitored instance.
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 Note: If you are running in Limited access mode, you can only view the instance level metrics.

Additional Information: For more information about the Performance Analysis Dashboard, see the
Dashboard article.

Processes
The Processes tab presents a list of processes that are running on your monitored server. Metrics related to
the resource utilization of these processes is also shown.
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Disk Activity
The Disk Activity tab displays information about the data and log files on your server. This tab displays the
latency for reads and writes from files on your disk, and the latency from the system to the disk controllers.

Additional Information: For more information about the Disk Activity tab, see the Disk Activity article.

Disk Space
The Disk Space tab displays information about the size of the files on your disks, and the free space on your
disks. Additionally, this tab provides detailed information about Data and Log files (auto growth settings,
number of VLFs, etc).
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Additional Information: For more information about the Disk Space tab, see the Disk Space article.

Top SQL
The Top SQL tab displays potentially problematic queries and procedures running on your monitored
instance. Top SQL also provides a look at the execution plan diagrams and history of queries and procedures
captured by SQL Sentry.

Additional Information: For more information about the Top SQL tab, see the Top SQL article.
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Indexes
The Indexes tab provides a view of the collected table and index information according to the settings and
schedules chosen when enabling the fragmentation manager solution.

Additional Information: For more information about the Indexes tab, see the Indexes article.

AlwaysOn
The AlwaysOn tab displays information about configured availability groups.

Additional Information: For more information about the AlwaysOn tab, see the AlwaysOn article.
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Blocking SQL
Blocking SQL displays a view of the blocking events that were collected on your server.

 Note: Blocking SQL provides different versions of the block depending on which SPIDs were being
blocked, and which SPID was the head blocker at the time.

Additional Information: For more information about the Blocking SQL tab, see the Blocking SQL
article.

Query Plans
The Query Plans tab lists all plans collected for Top SQL events for the specified date range. This provides a
detailed chronology of all query plan changes, so you can go back to any point in time to see when a plan
change may have led to a query performance problem.

Additional Information: For more information about the Query Plans tab, see the Query Plans article.
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Deadlocks
Deadlocks displays a grid of the SPIDs that owned a lock on a resource, as well as SPIDs waiting for a
resource. This is a graphical representation, that allows you to easily identify the steps leading to the
deadlock.

Additional Information: For more information about the Deadlocks tab, see the Deadlocks article.

Quick Traces
QuickTrace is SQL Sentry's version of profiler, but without the overhead. You can specify how long
QuickTrace runs, and whether it collects statement events. Additionally, QuickTrace can be made as a
response to an event.

Additional Information: For more information about the QuickTrace tab, see the QuickTrace article.
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Introducing Conditions, Actions, and Settings
Last Modified on 11 August 2021

The Onboarding Wizard
During the onboarding setup wizard, several global settings are configured for your installation. If you enter
your SMTP settings and add a user, default conditions and actions are added to help you get started.

Alerting and Response System Concepts
Concept

Definition

Conditions

Conditions are the scenarios that are being evaluated. For example, is the % Processor
Time on the monitored target greater than 90%?

Actions

Actions are what happen in response to a condition being met. For example, the %
Processor Time was greater than 90%, so an email is sent to those configured on the
email action. There are many actions available including executing SQL or PowerShell in
response to a condition. See the full list of possibilities in the Actions article .

Settings

Defines criteria for when a condition is met. Certain settings known as source settings
are used to define what events are collected by SQL Sentry.

Settings
There are a couple ways to see how settings and conditions or actions are configured for your SQL Sentry
installation.
1. Select Reports to run the active settings list and configured actions list reports.
2. Select Reports > General, or view configured actions and settings directly in the Conditions pane (or
Settings pane).
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 Note: The Conditions pane displays on the right side of the SQL Sentry client by default. If you do
not see the Conditions and Settings pane, select View > Conditions to restore it.

Hierarchy
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There are several levels within the SQL Sentry hierarchy where you can configure applicable actions and
settings: Shared Groups  Sites  Target Groups  Target  Instance  Object.

SQL Sentry Hierarchy

Refining actions in the hierarchy
To configure global actions or settings, confirm that the Shared Groups node is selected in the Navigator
pane. The Shared Groups node is the global or root node of your SQL Sentry installation.

 Important: The SQL Sentry alerting and response system uses the principle of inheritance, so any
action or setting you configure at the Shared Groups node is passed down to all applicable objects
beneath it.
For example, if you configure a Send Email action for the SQL Server Agent Job: Failure condition
(Shared Groups), you'll receive an email anytime a SQL Server Agent Job fails across your entire
monitored enterprise.

Refine actions or settings at each level, as needed. For example, if you have a development server in your
environment that you don't want to be alerted about, disable the Send Email action at the instance level. This
configuration only applies to that instance, and it doesn't affect any other server in your environment. This
level of control gives you the ability to determine what happens in response to events occurring on your
monitored targets.
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Additional Information: For a more in-depth look at the SQL Sentry hierarchy and other alerting
related features, see the Alerting and Response System topic.
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Building SQL Sentry Advisory Conditions
Last Modified on 29 March 2021

Introduction

Advisory conditions in SQL Sentry enable you to check for many types of scenarios and apply an action to
respond or alert you to the existence of the condition. The SQL Sentry installation includes dozens of default
conditions in the advisory conditions pack that you can immediately apply actions to.
On GitHub, you'll find even more advisory conditions that have been created by members of the SQL Sentry
community (e.g. employees, partners, and customers). The conditions from GitHub must be downloaded and
imported into your SQL Sentry environment and may require some additional configuration for your exact
needs.
After exploring all the existing advisory conditions available, you may find that you want to create your own
condition (or modify an existing one). This article walks through some examples to help you get started with
building advisory conditions. See the conditions section of the SQL Sentry documentation for a complete
guide to all options available.

Tutorial: Creating a Condition
This tutorial walks through creating a condition by showing the steps to create an existing condition ( High
CPU). This condition uses a Windows performance counter to check for CPU that is greater than 90%.

Additional Information: See the comprehensive Advisory Conditions article for details about the field
definitions, features, and options not used or explained in this tutorial.
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Step 1: Select the Condition Type
There are several types of advisory conditions that you can create (e.g. Amazon RDS Instance, Analysis
Services, APS, Azure SQL Database, Azure Synapse Analytics, SentryOne, SQL Server, Tintri, VMware Host, and
Windows).
1. Select the Conditions List from the Navigator pane.  Note: The conditions list is available at
different levels in the hierarchy of targets. See the hierarchy section in the Introducing Conditions,
Actions, and Settings article.
2. Open the Conditions List (this example used the global one).
3. Select the Create Advisory Condition button to get a list of condition type options.
4. Select the condition type from the drop-down (this example uses Windows).

Opening the Global Conditions List and Creating a Windows type check.

Step 2: Set the Condition Options
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The name, description, and options available when adding a new advisory condition.

1. Enter a Name for your condition. ( This appears in emails, logs, calendar views, etc. when the condition

evaluates to true.)
This example uses " High CPU Example ".
2. Enter a meaningful Description for your condition. ( Rich text word processing options are available on

the toolbar above.)
This example uses " This is for finding high CPU ".
 Note: You may want to be more descriptive, use exact values, and provide helpful links in a
condition that you create for how someone should respond to the condition.
3. Set the Default Evaluation Frequency. (How often this condition check executes. Consider the

performance implications of the condition check and how soon someone would need to be notified
should this situation occur. It's not uncommon to have conditions that run only hourly, daily, or weekly.)
This example uses the default value of 30 Seconds.
4. Set a Trigger Threshold. (How long does this condition need to take place to evaluate to true ?)
This example uses 1 Minute .
See this blog post on the trigger threshold to learn more.
5. Select the Severity associated with this condition. ( How concerning is this condition if it occurs? )
This example uses Low.
6. Set the Evaluation Timeout. (How long can this condition run this check before failing due to timeout? )
This example uses the default value of 5 Seconds.
7. Set the Maximum Instance Count if it needs to be more than the default value of one. ( If this condition

can return multiple results, how many should be returned?)
This example uses the default value of 1.
See this blog post on maximum instance count to learn more as it requires a specific combination
of settings to use.
8. Select a Color to highlight this condition. ( Which color should be used to highlight this condition in the

application?)
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This example uses #FFFF00FF.
9. Choose where to Highlight on Dashboard Chart. (Where should this condition be highlighted on the

Performance Analysis Dashboard, using the selected Color?)
This example uses Windows: CPU Usage .
See the Send to Alerting Channels section of the Actions article for an example of how this appears
when a condition evaluates to true.
10. Constrain the condition to Supported Versions if needed. ( Control which environments this condition

checks against. Is there a minimum or maximum version of Windows where this counter is available, or is
this situation only a problem in certain versions? This uses the numerical release number of the product,
i.e. Windows Server 2019 is NT 10.0, so 10.0 would be used in these fields. Leave one or both of the
fields blank if this isn't applicable.)

Step 3: Define the Condition
Below the area where the options are set, there's the word And followed by the Add New Condition icon
(plus sign in a circle) and the Add New Condition Group icon (a Venn diagram symbol). This is where you
define the scenario for your condition. The High CPU condition is a one-step condition, so we'll ignore the And
and Add New Condition Group features for now (see more about those in the Conditions with multiple
steps section below).
1. Select the Add New Condition icon.
2. Select Add Numeric Comparison from the Add New Condition dropdown menu.

3. Select the Type box, then choose Performance Counter from the dropdown menu.

4. Select the Category box, then choose Processor Information from the dropdown menu.  Note: The
Performance Counter is set to Windows performance counters because the advisory condition type
was set to Windows in the first step.
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5. Select the Counter box, then choose % Processor Time from the dropdown list.

6. Select the Instance Type box, then choose Total from the dropdown list.

7. Select the word Equals, then choose Is greater than from the dropdown list.

8. Select the Type box, then choose Explicit Value from the dropdown list.
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9. Enter 90 in the Explicit Value box, then select the save button.

10. Your condition has been saved.

 Success: You have created a new advisory condition!

 Note: The Add Actions popup appears after saving the condition.

Select Yes if you would like to apply an action to this condition. This opens the Actions Selector
window. See the Configuring Actions article for instructions on adding and configuring actions.

Additional Examples and Resources
355

Examples
As you can see from the various menus and options available in the tutorial, there are several different types
of advisory conditions that you can create, and a staggering number of combinations that can be created. You
can compare performance counter values to the result of a SQL Server query, a current value to the last value,
match string values using Regex, perform calculations on the values, and so on. Use the existing conditions
installed with SQL Sentry and available on GitHub as a source of inspiration for building your own conditions.

Clone conditions
1. Right click on a condition in the Conditions List.
2. Select Clone from the context menu. A small window will pop up and ask you to name your copy of the
condition.
3. Enter the Name of your condition, then select OK.

 Success: You have cloned an existing condition and can now use it as a template for a new condition.
Make edits as needed and save it.

Conditions with multiple steps
The tutorial used a single step condition to check for % Processor Time > 90 . If you wanted to check for %
Processor Time > 90 and some other condition, such as Available Memory (MB) < 500 , you can do that in the
same condition. See the Using Step Logic in SQL Sentry Advisory Conditions blog post for a deep dive into
those possibilities.

Nested conditions
You can embed existing conditions into conditions to nest the steps and checks. For example, the High Ad
Hoc Query Plans condition (shown below) contains multiple checks, including the Low Page Life Expectancy
condition.

High Ad Hoc Query Plans condition
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 Note: If you take a look at the High Compiles + High CPU condition, you'll see three different
advisory conditions nested in the check in steps and condition groups. If you have a complex condition in
mind, you can build it.

Blog Posts
Creating Advisory Conditions in SQL Sentry Part 1
Creating Advisory Conditions in SQL Sentry Part 2
Create Advisory Conditions for SQL Server on Amazon RDS
Setting Up a MaxDOP Advisory Condition
Using SentryOne to Alert on SQL Server Database Object Changes
Monitoring Replication with SQL Sentry
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Configuring Actions
Last Modified on 09 August 2021

Introduction

 Note: As a reminder, conditions describe the various states of any monitored objects (e.g. %
Processor Time > 90%), and actions determine what happens when a condition is met (e.g. an email is
sent).

Displaying conditions
The conditions displayed in the Conditions pane change depending on which node or object is selected in the
Navigator pane. If you don't see the Conditions pane once you have selected your desired node in the
Navigator pane, select View > Conditions.
Select the shared groups node to see globally applied conditions in the Conditions pane.
Select any applicable object level below the shared groups node to see two specific sets of applied
conditions in the Conditions pane.

Conditions pane sections
Section

Description

Image
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Section

Description

Image

Inherited

The top section is the Inherited section that shows you any
applied conditions that are being passed down to the current
level.

The Explicit section shows you applied conditions that have been
set at the current level. Each action that you set up in your
environment has an associated behavior that controls how the
action is carried out relative to any inherited actions. See the
following table for more information about Action Behavior:

Explicit

Action
Behavior

Description

Disable

Special set of instructions that simply disallow
the passed down (inherited) set of
instructions.

Override

Special set of instructions that are followed
instead of the passed down (inherited)
instructions.

Combine

Set of instructions that are followed in
addition to the passed down (inherited)
instructions.

Additional Information: For more information about the Conditions pane, see the Conditions pane
article.

Tuning Conditions and Actions
To avoid a noisy alerting system, we recommend that you tune the conditions and actions to refine the
amount of alerts generated to the ones that are meaningful to you.
See the following resources for guidance on alert tuning:
SQL Server Alert Tuning Basics with SQL Sentry
SQL Sentry Tips & Tricks: Tuning Advisory Conditions
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SQL Sentry Tips & Tricks: Common Alert Tuning Examples
Alerting on a Call Schedule with SQL Sentry
A Million Little Things: Remediation

Adding a New Action
Add a new Action to your desired node by completing the following steps:
1. Open the Conditions pane (View > Conditions), then select the desired node in the Navigator pane to
begin adding a new action.

Conditions Pane for selected node
Select desired node

2. Select Add to open the Action Selector window.
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3. Expand the applicable object and condition. Use the checkbox(es) to select which actions should be taken in
response to the condition being met, then select OK to save your changes.
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Additional Information: For a complete list of available actions and how to configure them, see the
Actions article.

Changing Inherited Conditions
Change the behavior for an Inherited condition by completing the following steps
1. Open the Conditions pane (View> Conditions), then select the desired node in the Navigator pane.

362

2. Select the condition you want to change in the Inherited section of the Conditions pane, then select
Disable, Override, or Combine.
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 Note: When an inherited condition is overridden or disabled, it appears in the Inherited section, but
its text is grayed-out, and its status is Overridden.
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Additional Information: For more information about actions and conditions, see the Alerting and
Response System topic.
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Configuring Settings
Last Modified on 09 August 2021

 Note: As a reminder, settings define criteria for when a condition is met. Certain settings known as
source settings are used to define which events are collected by SQL Sentry.

Configuring Settings
To configure settings, select the desired node in the Navigator pane.
For example, select the shared groups node to configure settings globally, or select an individual instance
node to configure settings specific to just that instance. If you do not see the Settings pane once you have
selected your desired node in the Navigator pane, select View > Settings to open the settings pane. Then,
select the drop-down lists found in the Settings pane to select the desired settings.
See the following examples:
To configure the Top SQL Minimum Duration Collection setting globally:
1. Select the shared groups node in the Navigator pane.
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2. In the Settings pane, use the top drop-down list to select SQL Server settings.

3. Use the second drop-down list to select Top SQL Source. You should now see the Top SQL Source
settings that are being applied globally.

4. Change Minimum Duration to the desired value, then select OK to save your changes.

367

To configure the Top SQL Minimum Duration Collection setting for an individual instance:
1. Select the desired instance node in the Navigator pane.
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2. In the Settings pane, use the drop-down list to select Top SQL Source. You should now see the Top SQL
Source settings that are being applied for that instance.

3. Change Inherit from Parent to false.
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4. Change Minimum Duration to the desired value. It saves automatically.

Adjusting Global Runtime Threshold Settings
370

By default, the global Runtime Threshold settings for SQL Server Agent Jobs are set at a Minimum Runtime
Threshold of 10 percent and Maximum Runtime Threshold of 250 percent . This means that any time a job
runs for less than 10 percent of its average runtime or longer than 250 percent of its average runtime, you'll
be notified. If you find you are receiving too many notifications, these settings can be adjusted. See the
following example:
To configure the SQL Server Agent Job Maximum Runtime Threshold percent globally:
1. Select the shared groups node in the Navigator Pane.

2. In the Settings pane, use the top drop-down list to select SQL Server settings.

3. Use the second drop-down list to select SQL Server Agent Job. You should now see the SQL Server
Agent Job settings that are configured globally.

4. Change Maximum and Minimum Runtime Threshold Percent to the desired values.
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Using time-based thresholds
Time-based thresholds are usually less valuable at the global level, particularly the Minimum Runtime
Threshold that doesn't have much value globally. Explicit time-based thresholds tend to be more applicable
at the actual instance or object level for overriding the global percentage thresholds on a case-by-case basis.

 Note: Any time an explicit time-based threshold is specified, it overrides the percentage-based
thresholds for that object.

Consider a job that has a great deal of volatility in runtime such as a transaction log backup that can run from
anywhere between 30 seconds and 30 minutes, with an average runtime of five minutes. To avoid
unnecessary percentage-based threshold notifications for the job, set its Maximum Runtime Threshold to 35
minutes and Minimum Runtime Threshold to 20 seconds. Select either the job's node in the Navigator pane,
or select an instance of the job on the calendar, then follow the previous steps to access and change the job's
Runtime Threshold settings.

Additional Information: For more information about settings, see the Alerting and Responses System
topic.
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General Tasks
Last Modified on 11 August 2021

Once you've completed the Onboarding process in the Getting Started section, you're ready to start using
SQL Sentry and configure your environment. Some first steps may include adding additional servers (targets)
to monitor, organizing your targets, and using the calendar. The following is a review of some common tasks
performed using the SQL Sentry client.

Monitoring Targets and Target Groups
See the Monitoring Additional Targets article for detailed information.

Adding a Target
Select Add in the right-click context menu of one of the following nodes to add a target:
All Targets
Site
Group
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Deleting a Target
Select Delete Target in the right-click context menu of any target node to delete that target.

 Note: Before deleting a target, select Stop Watching to stop watching all of the target's associated
instances.
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 Warning: Delete Target deletes the actual registration for the target from SQL Sentry. This includes
the deletion of all historical information for any associated instances belonging to the target from the
SQL Sentry database. Delete Target is final and can't be undone. Only use this command to permanently
delete information SQL Sentry has stored about the target and its associated instances from the SQL
Sentry database.

Adding a Target Group
On any site node or existing group node, right-click and select Add, and then select Group to add a target
group.
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Deleting a Target Group
On any existing group node, right-click and select Delete Group to delete the selected target group.

 Note: You need to remove all targets and sub-groups before deleting a group.
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Monitoring Instances
Adding an Instance
Select Add in the right-click context menu of one of the following nodes to add an instance:
All Targets
Site
Target Group Target
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For more information about adding an instance, see the Monitoring Additional Targets topic.

Watching an Instance
On any instance node, select Watch to begin watching that instance. For more information about watching an
instance, see the Monitoring Additional Targets topic.
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SQL Server Registrations
Unsupported: As of June 2020, the SQL Server Registrations feature is deprecated and no longer
supported.

Viewing a SQL Server Registration
To view your local SQL Server registrations, select the Show SQL Server Registrations icon located in the
Navigator pane.

380

Creating a SQL Server Registration
Select New SQL Server Registration in the right-click context menu of the Local Server Groups node
contained beneath the SQL Server Registrations node to create a new SQL Server Registration.
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Deleting a SQL Server Registration
Select Delete Registration in the right-click context menu of any SQL Server registration to delete the
selected SQL Server Registration.

Synchronizing SQL Server Groups
On the Local Server Groups node, select Synchronize SQL Server Groups to synchronize the SQL Sentry
client groups and servers with SSMS.

 Note: You may need to close SSMS prior to synchronization for any changes you make visible.

Event Calendar Related
Jumping to a Particular Time in the Calendar View
On any node above the object level, right-click and select Jump To > Time to open the Select the time
window. Select the desired date and time, and then select Ok to open your time selection. To persist the time
setting, go to Tools > User Preferences > Navigator, and then select the appropriate parameters. This
allows you to jump to the same time for each selected view. For more information about the Event Calendar,
see the Calendar and List Views article.
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User and Group Tasks
Adding a User
Double-click or right-click the Users node, and then select New to open the Add a User window. Input the
appropriate information in the user window, and then select Save to save your changes. The new user
displays under the Users node.
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Editing a User
Double-click or right-click the Users node, and then select Open to open the Edit User window. The user
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window appears populated with that user's settings. Make any changes, and then select Save to save the
changes.

Deleting a User
On a user node, select the delete key or select Delete User from the context menu to permanently delete
the user.
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Adding a Group
Double-click or right-click the Groups node, and then select New to open the Add a Group window. Input the
appropriate information in the group window, and then select Save to save your changes. The new group
displays under the Groups node.
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Editing a Group
Double-click or right-click the Groups node, and then select Open to open the group window populated with
the group's settings. Make any changes, and then select Save to save the changes.
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Deleting a Group
On a group node, select the delete key or select Delete Group from the context menu to permanently delete
the group.
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For more information about users and groups, see the Contact Management topic.

Events
Adding an Event Object
On any event object node, select New > Job... to open SSMS and create a new SQL Server Agent Job.
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Deleting an Event Object
On any event objects node, select Delete Job to permanently delete the object.
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 Note: Not all objects support deletion from the SQL Sentry Client (Reporting Services, etc).

Watching an Event Object
On any event objects node, select Watch Job to sets the object status to Watched and enable conditions and
actions for the object, as well as queue chaining and performance monitoring features, if applicable. The
instance status will also be set to Watched if it isn't already watched.
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Stop Watching an Event Object
On any event objects node, select Stop Watching Job to set the object status to Unwatched, disable
conditions and actions for the object, as well as queue chaining and performance monitoring features, if
applicable.
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Enabling an Event Object
On the event objects node, select Enable to enable the event to run according to the schedules defined for it.
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Disabling an Event Object
On the event objects node, select Disable to disable the event from running according to the schedules
defined for it.
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Viewing an Event Object's Properties
On any event objects node, select Properties to display the object's native properties window.
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 Note: Not all objects support the properties interface (Reporting Services, etc).

Performance Monitoring
Starting Performance Monitoring
On a watched event objects node, select Monitor Performance to enable monitoring for any performance
counters linked to the object. The SQL Sentry monitoring service automatically starts any linked counters
immediately prior to an event instance starting and stops the counters shortly after the instance ends,
minimizing any associated overhead on the network and monitored instance(s).
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Stopping Performance Monitoring
On a watched event objects node, select Stop Monitoring Performance to suspend performance monitoring
for the object.

 Note: When you select to Stop Monitoring Performance, existing linked counters are not deleted, so
monitoring can easily be re-enabled for the object in the future.

Deleting a Performance Counter
On any performance counter node, select Delete to unlink the performance counter from this object.
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 Note: You can re-link the counter to the object at any point.

Jobs/Tasks
Starting a Job or Task
On any job or task node, select Start Job to start the job.

 Note: If the job has more than one step, a window appears allowing you to select the step where you
would like the job to start.
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Stopping a Job or Task
On any job or task node, select Stop Job to stop the job.

Viewing Job History
On any event objects node, select Jump To > History, and then select the range to view to open the job at
the selected time.
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Helpful SQL Sentry Client Information
The following is a list of topics that provide detailed information about aspects of the SQL Sentry Client
including information on client glyphs, icons, and indicators:

Topic

Links

Client Alerts

For more information detailing alerts within the SQL Sentry Client, see
the Client Alerts article.

Event Calendar

For information detailing the glyphs within the SQL Sentry Calendar
view, see the Calendar and List Views article.

Event Chains

For more information detailing Event Chains within the SQL Sentry
Client, see the Event Chains article.

SQL Sentry Client

For information detailing the toolbars within the SQL Sentry Client,
see the toolbars article.
For information detailing the menus within the SQL Sentry Client, see
the menus article.
For information about customizing the visuals within the SQL Sentry
Client, see the User Preferences article.
For a list of hot keys accessible within the SQL Sentry Client, see the
Hot Keys article.
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Adding Notes
Last Modified on 10 August 2021

Notes help to facilitate communication between team members. Notes can be used for change tracking,
resolution history, and a variety of other functions. You can set notes to be included in any future
notifications generated for an object, and to be displayed for all calendar instances of an object. Both of these
features are valuable for sharing escalation procedures, recovery steps, emergency contact information, etc.,
with other team members.
The notes interface can be reached through a variety of context menus in the SQL Sentry client just about
anywhere that you can act on an event object or event instance. Access the notes interface by pressing
CTRL + ALT + N when an applicable object is selected.

 Note: When adding a note, if any failures exist for the selected event object, you will be prompted to
clear them.

Field

Hotkey

Description

User

n/a

Displays the current window's username.
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Field

Hotkey

Description

Title

n/a

The subject of the note that appears in the
selection list.

Note

n/a

The body of the note that can't be blank.

Select Existing Note to
View

n/a

Enable this setting to include the note with any
notifications related to the object.

Show for All Calendar
Instances

n/a

Enable this setting to show the note information
in the pop-up of every event instance of the
object.

New

CTRL+N

Creates a new note.

Save

CTRL+S

Saves the current note.

Delete

CTRL+D

To delete a note, select the desired note from
the list, and then select Delete.

Close

CTRL+C

Closes the window.

Additional Information: For information about adding/editing notes for events in the Calendar view,
see the Failed Instances topic.
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SQL Sentry Portal Configuration
Last Modified on 05 April 2022

 Note: SQL Sentry Portal requires SQL Sentry software version 20.0 or above. The installation and
configuration options are a standard part of the setup and EPI commands in versions 2020.8.7 or later.
We strongly recommend upgrading to the latest release to install SQL Sentry Portal and get the
complete set of features. See the Release Notes for more information.

What is SQL Sentry Portal?

SQL Sentry Portal is a browser-based option for accessing your SQL Sentry environment data that uses your
existing SQL Sentry database. It replaces the previous mobile applications and Cloud Sync options.
Additional Information: See the SQL Sentry Portal article.

Prerequisites
Before installing SQL Sentry Portal on-premises, ensure your credentials and machine(s) meet the System
Requirements as well as the security and additional requirements listed below.

Security
See the SQL Sentry Portal Security article.

Additional Requirements
Chrome and Microsoft Edge (the Edge version based on Chromium) are the recommended browsers for
using SQL Sentry Portal.
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Only Windows devices are officially supported.
SQL Sentry database that's accessible by the web server hosting SQL Sentry Portal.
The preferred IP address and port that SQL Sentry Portal should use to listen for HTTP traffic.

 Note:
If you plan to change the binding address or port, ensure that there isn't already something
listening to that address and port on the machine.
The default IP address is 0.0.0.0 . SQL Sentry Portal listens to all IP addresses on the machine
that are not listening to the selected port.
If you are running SQL Sentry Portal on a virtual machine, it's recommended to keep the
default IP address of 0.0.0.0. Setting it to 127.0.0.1 may make it so that it can be
accessed from the local host, but not other locations in the domain.
The default port is 9991.
It's recommended to set the IP address to 127.0.0.1 if you're planning to route requests
through IIS or other reverse proxy on the same machine as the service. This will prevent
external requests from directly reaching the service.

Installing SQL Sentry Portal
SQL Sentry Portal may be installed via the classic SQL Sentry Setup Wizard or through the EPI commands, as
long as the method you choose matches your existing SQL Sentry installation.

Where can SQL Sentry Portal be Installed?
SQL Sentry Portal can be installed on-premises with a self-hosted configuration as a service. It can be installed
on a machine along with the SQL Sentry monitoring service and SQL Sentry client, or it can be installed on a
machine by itself without any other SQL Sentry components

 Note: When using the EPI version, the SQL Sentry controller must exist on the machine where you
install SQL Sentry Portal.

If you have more than one SQL Sentry database, you can view them with a single SQL Sentry Portal service.
See the distributed databases article for more information.

 Note: SQL Sentry Portal cannot run as an Internet Information Services (IIS) site. IIS may only be used
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as a reverse proxy to the SQL Sentry Portal service for HTTPS and request filtering. See the IIS Reverse
Proxy Configuration section below for details.

Installation Example

Example of SQL Sentry (SentryOne) components installed across multiple machines (with EPI components when applicable)

Install SQL Sentry Portal using Setup Wizard
Follow the instructions in the SQL Sentry Installation article.

Install SQL Sentry Portal using EPI
Follow the Installation, Upgrade, and Uninstall instructions in the SQL Sentry Enhanced Platform Installer
article.

SQL Sentry Portal Configuration Utility
Changes to your SQL Sentry Portal configuration must be made through the Portal Configuration Utility
(PCU).
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 Note: For the EPI version of SQL Sentry, the Portal Configuration Utility is only available in versions
2020.8.31 or later. Earlier EPI releases must uninstall/reinstall via command line to make changes.

Accessing the PCU
SQL Sentry
Locate the PCU through the file directory or use the Windows Start menu as Portal (Web Client)

Configuration. Use the Run as administrator option to open it.

SQL Sentry Portal Web Client Configuration Utility

File path:
1. Navigate to the MonitorPortal directory in your SQL Sentry installation. The default path is C:\Program
Files\SolarWinds SQL Sentry\\MonitorPortal\PCU. In this example, it is C:\Program
Files\SentryOne\2020.0\MonitorPortal.

SQL Sentry EPI Version
1. Use the so configmp command to launch the Portal Configuration Utility from Command Prompt.

 Note: You must run this command on the machine where SQL Sentry Portal is installed.
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2. You must use the EPI commands so stopmp and so startmp after making changes to the configuration.
The PCU does not restart the portal service in an EPI environment.

Using the PCU
The PCU allows you to change database, network, security, and web server binding-related properties for SQL
Sentry Portal. Select the Verify & Save button to apply any changes.
The PCU also provides an option to stop/start the SQL Sentry Portal service ( SentryOneMonitorPortal in
Windows Services).

 Note: SQL Sentry Portal supports distributed SQL Sentry databases. The drop-down menu at the top
allows you switch between the settings for each SQL Sentry database.
Additional Information: If you have multiple SQL Sentry databases and would like to view all of them
in the same SQL Sentry Portal, see the distributed databases article for setup and security details.

SQL Sentry Portal Configuration Utility

Additional Information: For more information about the settings in the Advanced Properties:
Port: See the Setting the Connection Properties topic from Microsoft Docs for more information on
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the portNumber property.
Packet Size: See the Configure the network packet size Server Configuration Option topic from
Microsoft Docs for additional information on SQL Server network pack sizes.
Encrypt Network Traffic: See the Enable Encrypted Connections to the Database Engine topic
from Microsoft Docs.
Trust Server Certificate: See the Setting the Connection Properties topic from Microsoft Docs for
more information on the trustServerCertificate property.
Multi Subnet: See the Setting the Connection Properties topic from Microsoft Docs for more
information on the multiSubnetFailover property.

Use TLS
To use TLS for SQL Sentry Portal:
1. Select the box next to Use HTTPS. Once selected, you'll see the TLS Certificate section.
2. Enter the name of the certificate in Subject.
3. Select Verify & Save.
4. The Messages section displays the progress. Note that the SQL Sentry Portal service will be restarted
during this process.
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Messages example

Use HTTP example

 Success: You have enabled TLS for SQL Sentry Portal. Use HTTPS:// at the beginning of the URL to
open it in your browser.

 Note:
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For a signed certificate from a trusted authority, you must register it on the machine so it goes into
the LocalMachine/My store.
Additional Information: See the System Store Locations and Local Machine and Current
User Certificate Stores articles on Microsoft Docs for details.
When updating a certificate, you need to add it to the machine. SQL Sentry Portal will use the
latest valid certificate (by expiration date) without requiring a restart of the machine or service.
Older, invalid, and expired certificates will be ignored.
If you do not have IIS installed and are not using port 443 on this machine as part of any other web
server, you can update the Port in the Binding section to 443. When SQL Sentry Portal uses port

443, you do not need to specify the port in the URL. For example, you can use https://localhost
instead of https://localhost:443.

IIS Reverse Proxy Configuration (Optional)
Unsupported: The following steps cover the process required to set up IIS as a reverse proxy to the
SQL Sentry Portal service for HTTPS and request filtering. For information about IIS administration, see
IIS.net.
This information is provided as an example to get you started with IIS Reverse Proxy Configuration.
Please refer to the official IIS administration documentation for support with this process and up-to-date
documentation.
See the Use TLS option in the Portal Configuration Utility section for the preferred method of enabling
HTTPS/TLS in SQL Sentry Portal.

IIS Reverse Proxy Prerequisites
The following modules must be installed before configuring your reverse proxy:
Microsoft Advanced Request Routing 3.0
Microsoft URL Rewrite 2.0

 Note: These required modules are not installed by default.

IIS Reverse Proxy Instructions
Configure a reverse proxy in IIS to host SQL Sentry Portal by completing the following steps:
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1. Create a website with your desired outward bindings. If you want to use HTTPS, this is where you will
register your certificate. Point the site to the default IIS directory.

 Note: The default IIS directory is often C:\inetpub\wwwroot. The Application Pool settings
wont have an effect on the behavior of this site because it will not be executing code. You can set
the .NET CLR version to No Managed Code, but this is not required.

2. Open the Home window for the new site, and select the URL Rewrite feature.

3. Select the Add Rule action from the right window pane, and then select Reverse Proxy rule from the
Inbound and Outbound Rules category.
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4. Enter the IP address and port of the service in the Inbound Rules server name input. Ensure that Enable
SSL Offloading is selected. Select OK to save the rule.

 Note:

Localhost:9991 is the default IP address. When you are setting this up, you may need to
use your server's DNS name (e.g. ServerDNS:9991).
If your server has no IIS conflicts with port 443, you can bind SQL Sentry Portal to port
443, and use https://ServerDNS as the URL (no port required).

 Success: IIS now routes all requests to the website to the SQL Sentry Portal service.
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DEPRECATED: Installing SQL Sentry Portal On Premises
Manually
 Important:
SQL Sentry Portal must be installed outside of the user's directory.
These steps are included only for users who do not have the current release of SQL Sentry with the
installation built in. It was added to the installer in version 2020.8. If you have version 2020.8 or
later, you must use the EPI or Setup Wizard instructions to install it.
You need the original SentryOne.Monitor.WebClient.Web artifact or version of the
Enterprise Platform Installer that was used for your SQL Sentry installation to follow these
deprecated instructions.

After you have ensured that your machine meets the prerequisite requirements, you can begin installing SQL
Sentry Portal. Install SQL Sentry Portal on your machine manually by completing the following steps:
1. Unzip the SentryOne.Monitor.WebClient.Web artifact at the desired location on the machine hosting
SQL Sentry Portal.

Select Destination and Extract Files

Extract Folder

2. Update the appSettings.json file in the root of the project with the correct connection string for the
client’s database.
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Update the Connection String
Open appSettings.json

3. Run the service install script OnPremServiceInstall.ps1 as administrator. Enter the IP address and port
that you want to bind the service to in the appropriate prompt.

Execute the PowerShell Command, enter the IP, and
enter the Port
Run Powershell as
administrator

 Note: To use integrated authentication for the database connection, you need to change the
account that the SQL Sentry portal service is running under in the Windows Services Control panel
after installation. The default account is LocalSystem .

 Note: You can re-run the service install script OnPremServiceInstall.ps1 at any time to change
the IP address or port and update the service. The SQL Sentry Portal service will be turned off
during the script's execution.
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SQL Sentry Portal Distributed Databases
Last Modified on 02 November 2021

Distributed SQL Sentry Databases
SQL Sentry Portal allows you to connect to distributed SQL Sentry databases to create a unified view across
multiple SQL Sentry environments using a single SQL Sentry Portal service.
SQL Sentry database servers show on the sidebar menu with a (server icon) at the top of the drop-down
hierarchy. In the example below there are two SQL Sentry database servers (SquadB-Dev and SQUADBSTABLE2.SentryOne), each representing a different monitoring environment.

Distributed databases on the menu

Implementation Example

Example of a single SQL Sentry Portal Service pulling data from two SQL Sentry databases
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 Note: The example above shows an EPI installation. If you are not using the EPI version, it is the
same, but does not contain the EPI controller service or client bootstrapper.

Additional Information: See the SQL Sentry Components and Architecture article to learn more about
the components in the example.

Using Distributed Databases
How are security settings used for distributed databases?
Access is at the SQL Sentry database level. A user must meet the security requirements as described in the
SQL Sentry Portal User Access Requirements section of the Portal Configuration article for each SQL Sentry
database they need to access. SQL Sentry Portal users will only see the SQL Sentry environments listed for
the SQL Sentry database servers where they meet those security requirements.

Do all SQL Sentry databases need to be the same version?

Unsupported: SQL Sentry Portal does not officially support adding SQL Sentry databases with
different versions.

SQL Sentry Portal does not prevent you from adding SQL Sentry databases that are on different versions, but
you may encounter errors or unexpected issues with this setup. It is strongly recommended that all SQL
Sentry databases are on the same version for the best experience.

Are dashboards applied across databases?
Dashboards are per SQL Sentry database. Any custom dashboards that you have added are at the SQL Sentry
database level and will not appear for other SQL Sentry databases when using distributed databases.

How is the EHO score displayed?
The Environment Health Overview score displays for a single SQL Sentry database at a time. Select the SQL
Sentry database at the top level () to view an overall EHO score for that environment.

How are the alerts displayed?
The alerts are displayed for the last SQL Sentry database environment that you selected.
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Configuration
Installation
Install SQL Sentry Portal on a machine that can reach all SQL Sentry databases that you want to add to this
view. Only one SQL Sentry Portal service is needed per SQL Sentry Portal URL for multiple SQL Sentry
databases.

Adding Distributed Databases
Distributed databases are configured in the Portal Configuration Utility (PCU). All SQL Sentry databases
added to this SQL Sentry Portal service will be visible at the same SQL Sentry Portal URL.
1. Open the PCU and select the Add New button.

2. Enter a friendly name for the New Repository Name, then select Confirm.

3. Enter the connection information for the SQL Sentry database in this additional environment, then
select Verify Connection. The connection information in the PCU is per database.
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 Success: Your SQL Sentry Portal is now configured to use distributed databases. Repeat this
process to add additional SQL Sentry databases to your view.

Deleting Distributed Databases
1. Open the PCU.
2. Select the distributed database environment to delete from this SQL Sentry Portal view, then select
Delete.
3. Select Yes on the Remove Connection window to confirm that you are sure you want to remove this
connection.
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Getting Started with SQL Sentry Portal
Last Modified on 19 April 2022

Introduction
What is SQL Sentry Portal?

SQL Sentry Portal is a browser-based option for accessing your SQL Sentry environment data that uses your
existing SQL Sentry database. It replaces the previous mobile applications and Cloud Sync options.
SQL Sentry Portal shares the same UI experience as the cloud-based SentryOne Monitor product. See the
Using SQL Sentry Portal article to familiarize yourself with the overall layout.

 Note:
Chrome and Edge are the recommended browsers for using SQL Sentry Portal.
There may be minor differences in appearance between the SentryOne Monitor product and the
SQL Sentry Portal feature for SQL Sentry. These will be noted in the documentation or related to
the released version. Hovering over an image in the article will display the version that was used
for the image.

Are all target types supported with SQL Sentry Portal?
SQL Sentry Portal currently supports the following target types:
SQL Server (including Amazon RDS)

419

Azure SQL Database
Windows

How do I install SQL Sentry Portal?
See the SQL Sentry Portal Configuration article. SQL Sentry Portal may be installed through the classic SQL
Sentry Setup Wizard or through EPI commands, as long as the method you choose matches your existing SQL
Sentry installation.

How do I open SQL Sentry Portal?
Once you've installed SQL Sentry Portal, you can open it by completing the following steps:
1. Enter your domain for the SQL Sentry Portal in your preferred browser.

 Note: In this example, the SQL Sentry Portal is bound to localhost, http://localhost/. The URL to open
SQL Sentry Portal includes the port as well: .
You may have a different port to use with your host name. This information can be viewed or changed
with the SQL Sentry Portal Configuration Utility. See the SQL Sentry Portal Configuration article for
details.

2. Enter your authentication credentials to access the SQL Sentry Portal. Use your DOMAIN\Username if
needed.

 Note: Accounts logging into the SQL Sentry Portal must have access to the Windows Server hosting
SQL Sentry Portal.
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3. The browser opens the SQL Sentry Portal. See the Using Monitor article for help navigating SQL Sentry
Portal's features.

Which features are available in Portal?
In general, the SQL Sentry Portal offers the same features available in SentryOne Monitor. It does not have
feature parity with the SQL Sentry client for SQL Sentry. By offering a simpler view, it creates an option that
can be more attractive for different stakeholders who don't need the depth of information and functionality
offered in the client, or as more of an everyday view for DBAs who may only need to open the client for more
advanced troubleshooting.

 Note: Remember, you still have access to all the additional SQL Sentry features through the SQL
Sentry client.

Health Views
The Health view is the default view when opening the SQL Sentry Portal. This screen displays wedgets for
Alerts by Severity and Alerts by Tag on the default Overview for all servers. You can drill into targets for an
individual view.
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Additional Information: For more information about Health Views in the SQL Sentry Portal, see the
Health Views article.

Top SQL
The Top SQL view displays a unified picture of collected SQL statements. It's designed to help you quickly
identify queries, applications, logins, and more that are causing the most waits, using the most resources,
taking the most time, and putting the most load on your SQL Server.

Additional Information: For more information about Top SQL in the SQL Sentry Portal, see the Top
SQL article.
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Alerts
The Alerts view displays a list of all the conditions that have evaluated to True.

Additional Information: For more information about Alerts in the SQL Sentry Portal, see the Alerts
article.

Blocking
The Blocking view maps the relationships between all blocking and blocked sessions (SPIDs) in a blocking
chain, allowing you to pinpoint the cause and fix the blocking issue.

Additional Information: For more information about Blocking in the SQL Sentry Portal, see the
Blocking article.

Deadlocks
The Deadlocks view provides details about deadlocks within your monitored environment. Use it to identify
and fix deadlock issues on your monitored servers.
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Additional Information: For more information about Deadlocks in the SQL Sentry Portal, see the
Deadlocks article.

TempDB
The TempDB view displays a wealth of information about what is using your tempdb database and how
effectively it is being used. This feature is specific to SQL Sentry Portal and is not available in the SQL Sentry
client.

Additional Information: For more information about TempDB in the SQL Sentry Portal, see the
TempDB article.

Dashboards
The Dashboard view displays the performance charts for monitored targets.
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SentryOne Monitor Custom Dashboard
example

SQL Sentry Portal Dashboard example

Additional Information: For more information about Dashboards in the SentryOne Monitor, see the
Dashboards article.

Custom Charts
SQL Sentry Portal offers the ability to create dashboards with configurable custom charts. With custom
charts, you can include the performance metric widgets that you want, and you can have custom charts for
different targets on the same dashboard. This feature is specific to SQL Sentry Portal and is not available in
the SQL Sentry client.
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Additional Information: For more information about Custom Charts in the SQL Sentry Portal, see the
Custom Charts article.

Additional Information: The SQL Sentry Portal feature page contains a feature overview.
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Using SQL Sentry Portal & SentryOne Monitor
Last Modified on 19 April 2022

Overview & Navigation
SentryOne Monitor is accessed through a browser at monitor.sentryone.com.
SQL Sentry Portal is a self-hosted feature for SQL Sentry which has a similar UI experience. See the
Getting Started with SQL Sentry Portal article for information on accessing it.

Default Home View
When you first log into SQL Sentry Portal, the home view displays the overall health of the monitored
environment.

Option

Description

1. Navigation bar

Options for expanding the sidebar, selecting your alert timeframe, providing
feedback, accessing documentation, and accessing user profile information.
Full details are provided under the Navigation Bar section below.

2. Sidebar

The sidebar has areas for overview options ( Health Overview & Alerts) and
the monitored Targets. Full details are provided under the Sidebar section
below.
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Option

Description
Health Overview is the default view when opening SQL Sentry Portal.

3. Health Overview

4. Alerts

Health Score shows a summary of overall health scores for the
monitored environment.
Alerts by Severity breaks them into Critical, High, Medium, or Low
(with a count for the number of alerts in each severity category).
Alerts by Tag breaks them into categories such as Network, CPU,
Memory, Disk, or Other (with a count for the number of alerts in each
tag).

A table of the most recent alerts that have been triggered across the
monitored environment.

Navigation Bar
This is the default view for the navigation bar:

Option

Description

1. Sidebar toggle

The  bars (or hamburger) button toggles the visibility of the left sidebar
(the overview options and targets information)

2. SolarWinds SQL
Sentry logo

Selecting the SQL Sentry logo returns you to the home (Health Overview)
view.
The Time Slicer is available on the Health Overview at the Global (All
Targets) and individual Target levels. The Time Slicer allows you to organize
the alerting events displayed on the Health Overview by the time frame in
which they occurred (within the last 24 hour interval).
Display events that occurred in the last 24 hours (the default setting) or
narrow the displayed events to the last few hours, or minutes to identify
more recent issues. The following time frames can be selected:

3. Time Slicer
24 hours

6 hours

1 hour

12 hours

3 hours

30 minutes

15 minutes

 Note: The Health Score will change depending on your selection due to
the nature of the health score calculation.
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Option

Description

4. Feedback

Select the  feedback button to submit ideas about any issues, features
you'd like to see, or suggested changes.

5. Documentation

Select the  documentation button to open the Monitor documentation in
SentryOne Docs.

6. Permissions

Select the  Permissions button to manage permissions in SQL Sentry
Portal.

Sidebar
The sidebar has five main areas:
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Option

1. Overview
Options

Description
Health displays information about events and their
severity or tag for a variety of views, such as all
server, targets, or groups.
Alerts displays a log of alerts that have been
triggered in your environment as well as some
configuration options for email.

Start typing a target name in the filter to get to a filtered
list of targets or a specific target. Use the Show
Hierarchy switch to toggle the list of targets between an
alphabetically ordered flat list and a list grouped by sites.

2. Targets
Filtering
Options

 Note: The target filtering option only appears when
there are five or more targets.
3. Targets

Targets provides a list of all targets in your monitored
environment.

4. Unwatched
Servers

Unwatched servers are targets that are not currently
being monitored by SQL Sentry. See the Unwatched
Servers section below for more details.

5. Version

The current version of SQL Sentry Portal. See the Release
Notes article for more details.

Unwatched Servers

 Applies to the following products and features: The on-premises SQL Sentry Portal feature for SQL
Sentry. See the Getting Started with SentryOne Portal article for more details.

In SQL Sentry Portal, the bottom of the sidebar contains a group for Unwatched Servers (similar to Inventory
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view). Unwatched servers are not currently being monitored by SQL Sentry. Use the SQL Sentry client to
watch a target (you may need to purchase additional licenses).

 Note: A banner appears an individual unwatched targets across the SQL Sentry Portal views.

Feature Menu
When you select a target from the sidebar, the target Health view opens by default. From a target view like
Health, the Navigation Bar toggles to a feature menu.

Feature Menu

The following options are available for individual targets:
1. Health
2. Performance
Performance Analysis is available in SQL Sentry Portal. The Dashboards view is available in
SentryOne Monitor.
3. Storage(For 2021.18 Preview Users only )
4. Top SQL
5. Blocking (SQL Sentry Portal only)
6. Deadlocks (SQL Sentry Portal only)
7. TempDB (SQL Sentry Portal only)
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Distributed Databases
 Applies to the following products and features: The on-premises SQL Sentry Portal feature for SQL
Sentry. See the Getting Started with SQL Sentry Portal article for more details.

If you are using SQL Sentry Portal for SQL Sentry and have multiple SQL Sentry databases, you can configure
your portal to display information for all your SQL Sentry databases through a single service. See the
Distributed Databases article for more information.
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SQL Sentry Portal & SentryOne Monitor
Dashboards
Last Modified on 14 March 2022

 Applies to the following products and features: The SentryOne Monitor product.

The Dashboards view displays the performance charts for monitored targets. Select a target from the
sidebar, then select Dashboards from the feature navigation menu at the top.

Dashboard Navigation
 Note: In the SQL Sentry Portal feature for SQL Sentry, versions 2021.1 and later, Custom Dashboards
have been replaced by Custom Charts and are not part of the Performance Analysis Dashboard section.

Within the Dashboard view, the options and information displayed include:
1. A drop-down menu to switch between monitored targets.
2. A pause button (which flips to a  play button) to toggle the view of live data.
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3. A date selector.
4. Default Dashboard | Performance Analysis for the default dashboard or Custom Dashboard | for a
Custom Dashboard.

Dashboard Options
Date Selector
Use the date selector to use an available Range or define a Custom Range of time for data to view on the
dashboard. Use the Days, Weeks, and Months options to select an entire day, week, or month range at once.

Chart Details
Hover over a point in a chart to view additional details.
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 Note: The chart details tool-tips vary by chart.

Filter Dots
Use the filter dots (e.g. Disk, Other, Memory, CPU, and Network in the image below) to customize what
appears on the chart from the available options:

The same chart with Disk filtered out:

Zoom
Highlight an area on the chart for options to Zoom the Dashboard charts into that time selection.
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Jump To
Highlight an area on the chart for options to jump to other feature views (e.g. Health, Dashboard, Top SQL,
Blocking, or Deadlocks) for the selected time period. For example, use this troubleshoot performance issues
by correlating a spike to a SQL query.

View Additional Metrics
Some charts, such as SQL Server Activity and SQL Server Memory may have additional metrics available in
the legend and filter dots. Use the arrows to scroll through them.

Dashboard Charts
 Note: The available charts displayed vary by target type (e.g. SQL Server vs. Azure SQL database). For
example, an Azure SQL Managed Instance target will have SQL Server charts, but not Windows charts
displayed.

Windows
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Network
The Network chart displays the total network traffic on the server as well as the network utilization on each
of the adapter present on the monitored target.

CPU Usage
The CPU Usage chart displays the total CPU Usage for the server as well as information on context switching,
user time, kernel time, and more. The total processor time percentage across all processors on the server. A
sustained value greater than 80 percent generally indicates a CPU bottleneck.

System Memory
The System Memory chart displays information about the amount of memory being used by different
processes on the server as well as page faults and page file usage.
SQL Server
The amount of physical memory used by each SQL Server. Important for determining whether available
memory is being used effectively, and whether there's memory contention between multiple instances on the
same server.
File cache
The amount of physical memory currently allocated to the system file cache.
Other
The amount of physical memory used by all processes on the server other than SQL Server or SSAS.

Disk I/O
The Disk IO chart displays the read and write latency for each of the physical disks on the server.
ms/Read
The average time in milliseconds each physical disk read is taking.
Disk latency is the only disk measurement for which there are generally accepted ranges that represent good
and bad performance from a SQL Server perspective. Disk queue metrics, for example, are not accurate for
many SAN systems, and there are also no universally agreed upon good and bad ranges for SQL Server. The
following ranges can be used as a general guideline to determine whether disk latency is acceptable:
Less than 10ms - Fast *
Between 10ms - 20ms - Acceptable
Between 20ms - 50ms - Slow
Greater than 50ms - Critical
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* For transaction log writes, between 0ms and 2ms is desirable.
ms/Write
The average time in milliseconds each physical disk write is taking.

SQL Server
SQL Server Activity
The SQL Server Activity chart displays information about what the SQL Server instance is doing.
Batches
The total number of select, insert, or delete statements per second, including those inside a stored procedure.
The name is somewhat misleading since it doesn't represent batches (groups of multiple statements) in the
traditional sense. It's one of the best measures of overall activity on a SQL Server.
Over 1000 Mb per second is generally considered moderate to high activity. A 100Mb network can reach
saturation at around 3000 Mb per second.
Compiles
The total number of initial compiles and recompiles per second. The value should generally be < 10 percent of
batches per second. Higher values indicate plan reuse is low, and will generally correlate with high CPU, since
plan compilation is a CPU intensive operation. It may also correlate with low cache hit ratios for object and/or
SQL plans.
It can also be a strong indicator of memory pressure, since there may not be enough room to keep all plans in
cache.
Recompiles
The number of recompiles per second. The value should generally be < 10 percent of initial compiles per
second.
Transactions
The total number of transactions per second across all databases on the server. A transaction can be either a
user-defined statement block surrounded by a BEGIN TRAN and END TRAN, or an individual DML statement
(insert, update or delete).
Compare with batches per second. On systems with high DML you typically want to see a low ratio of
transactions to batches. A low ratio indicates that the individual statements are being bundled together, and
can result in dramatically higher throughput and reduced IO due to log flushes.
Key Lookups
The number of times per second that the query processor had to perform a key lookup, across all queries.
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Lookups occur when the index being used is non-covering, meaning it doesn't include all of the columns
required by the query. For each row returned by the index operation, the query processor has to go back to
either the clustered index to perform a key lookup, or the base table to perform a RID lookup in the case of a
heap.
Lookups are a high overhead operation, especially when large number of rows are involved, because each
lookup incurs a random I/O and additional processing. This often correlates with higher CPU usage and page
reads. Lookups can be eliminated by using a covering index, adjusting joins to reduce the set so the lookup
isn't needed, or using multiple indexes (intersection).
Forwarded Records
The number of times per second that the query processor had to lookup forwarded records, across all queries.
Forwarded records occur in tables with no clustered index (heaps) when rows become too large to fit on the
page and have to be relocated. Over time, this can cause severe fragmentation and queries to incur much
higher than normal I/Os, specifically random reads. This can correlate with high SQL Server page reads, and
high SQL Server disk wait time, data file and physical disk latency if the disk system isn't keeping up with the
additional reads. On many systems it's not unusual for this counter to stay at zero if all tables have a clustered
index, any heaps aren't fragmented, or they just aren't accessed frequently.
Backup/Restore MB
The data rate in MB/sec for any backup operations taking place on the server.

SQL Server Waits
The SQL Server Waits chart displays information about the classes and categories of waits that occurred as
well as the duration of milliseconds that the waits were in effect during that time period.
Although there are hundreds of wait types, only the wait types that can be definitively attributed to one of
the physical resource categories (Disk, Memory, CPU, and Network) are included in the calculations for this
chart. The Other category is for a few other important wait types that can either affect performance in more
than one major category, or cannot be directly attributed to any category with absolute certainty, such as
backups and parallelism respectively.
SQL Server Waits is one of the most important charts on the dashboard, because it provides an instant profile
of the SQL Server and where it's spending the most time waiting for physical resources. If SQL Server are
consistently low, then what the other dashboard charts are showing is less important. For example, if CPU and
SQL Server Activity: Batches look unusually high, but CPU waits are low, then the server hardware is
effectively handling the load.
Total waits of less than 200ms is excellent. Between 200ms and 1000ms is average. Greater than 1000ms
likely requires some attention to determine where the bottleneck lies. Over 5000ms may indicate severe
bottle-necking.
The total wait time may be higher by virtue of a large number of processes (spids) active on the server,
because wait time is summed across all processes, it isn't a per process average. This can be especially
applicable to the Other category, because several processes experiencing parallelism at the same time can
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cause it to spike to high levels.

Additional Information:
SQL Server Best Practices Article
What to do (or not do) about top wait stats

SQL Server Memory
The SQL Server Memory chart displays information about how the Server instance is using memory that has
been allocated to it.
Buffer
The current size of the buffer cache (in MB). You want this to be as large as possible for maximum
performance, and on a dedicated SQL Server it should consume most of the SQL Server memory and physical
memory.
Plan (SQL)
The current size of the cache used for query plans (in MB). This includes ad-hoc, auto-parameterized, and
prepared plans. A high value in proportion to the buffer cache may indicate query plans aren't being
effectively reused.
Plan (Objects)
The current size of the cache used for object plans (in MB). This includes stored procedures, functions, and
triggers. A high value in proportion to the buffer cache may indicate query plans aren't being effectively
reused.

Additional Information: Caching Mechanisms

Columnstore
The current size of the Columnstore index on the SQL Server (in MB). This includes both clustered and
nonclustered columnstore indexes.
In-Mem OLTP
The current amount of memory (in MB) dedicated to In-Memory OLTP. This includes Memory-optimized
tables, non-durable tables, and natively compiled T-SQL modules.
Other
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The current size of the cache used for all other plans (in MB). This includes bound trees, extended stored
procedures, temporary tables, and table variables. This cache size should be low in proportion to the other
plan caches. If it goes over roughly 10 percent of the object or SQL plan size, further investigation may be
needed.
PLE (sec)
The average lifespan of a data page. If this value is less than 600, it's an indicator of memory pressure. Ideally,
it should be much higher than 600 if ample memory is available. In general, the larger the buffer cache size,
the higher it should be. This is the best universal indicator of memory pressure.
Plan (SQL)
The ratio of hits to lookups for the query plan cache. This value should stay above 90 percent.
Plan (Object)
The ratio of hits to lookups for the object plan cache. This value should stay above 90 percent.
Pages: Reads
The average number of buffer data pages read from disk per second. Ideally, this value should be at or near
zero most of the time. If it's above zero, it means that the data wasn't found in the buffer cache, and so it had
to be retrieved from disk. If spikes in page reads correlate with high disk latency, the disk system may not be
keeping up.
Querying newly created temp tables will also show up as page reads, as well as activity from internal tempdb
objects. This includes hash joins, hash aggregates, sort, and query spool operations. This means that you can
still see high paging from tempdb due to query activity, even though you aren't explicitly using temp tables.
When page reads and page writes correlate closely, it's a strong indicator that it's related to tempdb activity,
because pages are being written to disk when the objects are created, then immediately read back in to
memory for use by querying operations.
If lazy writes > zero and track closely with page reads, and page life expectancy < 600, it's a strong indicator of
memory pressure, because data is being moved out of buffer to make room for new data coming in.
Lazy writes also cause page writes, but generally much less than tempdb activity. If you see high page reads,
and relatively low lazy writes and page writes, it's likely memory pressure and not tempdb activity.
Pages: Writes
The average number of buffer data page writes to disk per second.
Page writes can be caused by checkpoints, lazy writes, and tempdb activity. To calculate the approximate
amount of writes related to tempdb, for any given interval, subtract checkpoints and lazy writes from total
page writes.
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If high page writes correlate with high latency, the disk system may not be keeping up.

Database I/O
The Database IO chart displays information about the read and write latency for the databases.
ms/Read
The average time in milliseconds each physical disk read is taking for a particular database file. The top 10
database files (data and transaction log) with the highest latency for the specified date range are shown.
ms/Write
The average time in milliseconds each physical disk write is taking for a particular database file.
Log Flushes
Log flushes occur with every DML operation, and are a normal part of SQL Server activity. It's important to
note that log writes to physical disk from updates to buffer pages happen immediately upon transaction
commit, whereas writes to physical disk from the changed buffer pages is delayed until the next checkpoint
occurs. It's critical that the physical disk system where the transaction log resides is fast enough to keep up
with activity. If not, it can slow down all DML operations occurring in the database.
Ideally each busy transaction log should have its own dedicated disks, so that writes can happen sequentially,
which will minimize latency. If log flushes are high and latency is high for a transaction log file, then the disk
system is likely under-powered for the current load.
Checkpoint Pages
The average pages per second written to disk by the checkpoint process. Checkpoints flush all dirty buffer
pages for a given database to disk and are a normal part of SQL Server operations. The frequency of
checkpoints and volume of checkpoint pages is dictated directly by the Recovery Interval server option. SQL
Server uses checkpoints to batch writes to disk, which is generally more efficient. However, if the volume of
each checkpoint is too high and you see a correlation with high disk latency, it may indicate that the disk
system isn't keeping up.
Lazy Writes
The average number of writes per second by the lazy writer. The lazy writer periodically scans the buffer and
evicts pages that have low use counts in order to maintain a certain number of pages on the free list. Ideally,
this value should be at or near zero most of the time. When there is no memory pressure, the lazy writer will
generally leave data pages in memory, even those with low use counts. However, when pressure exists, the
lazy writer will continually be working to make room for new data coming into the buffer.
An indicator of memory pressure is ongoing lazy writes > zero with page reads/writes > zero and page life
expectancy< 600.

Azure SQL Database
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Resource Usage
A DTU represents the power of the database engine as a blended measure of CPU, memory, and read and
write rates. This measure helps you assess the relative power of the SQL Database performance levels. Each
service tier, which sets pricing and usage limits for an Azure SQL Database, expresses the amount of resource
limits as a number of DTUs. The more DTUs an Azure SQL Database is allocated the more resources the
database will have to service the workload.

Additional Information: See the What is Azure SQL Database? article on Microsoft Docs for more
information regarding DTUs, purchasing models, and service tiers.

Total DTU %
If your database is seeing high Total DTU percentage usage it may benefit from adjusting to the next highest
service tier to improve performance. If you're consistently seeing very low total DTU percentage usage you
may save some money by scaling down to the next lower service tier.
Data I/O
This metric is the average Data I/O percentage based on the limit of the service tier. This is one of the metrics
that makes up DTU.
Log I/O
This metric is the average log I/O percentage based on the limit of the service tier. This is one of the metrics
that makes up DTU.
CPU %
This metric is the average CPU percentage based on the limit of the service tier. This is one of the metrics that
makes up DTU.

Memory Usage
Allocated Memory Usage
Each service tier has a maximum amount of memory allowed for the Azure SQL Database to use. This metric
provides the percentage of the allowed memory being used for the database.
It will be very common for this metric to be high. If much of the data your applications need is in memory it
means better performance because the database doesn't have to read from the physical disk to return the
data.

Database Size
Each service tier has a maximum allowed size for the Azure SQL Database. This chart uses that tier to
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determine the total space available.
Used Space
The space used by the database in MB.
Free Space
Amount of space remaining (in MB) from the total space allowed for the tier.
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SQL Sentry Portal Custom Charts
Last Modified on 19 April 2022

 Applies to the following products and features: The on-premises SQL Sentry Portal feature for SQL
Sentry. See the Getting Started with SQL Sentry Portal article for more details.

Introduction
Custom charts in SQL Sentry Portal allow you to create personalized dashboards with the performance
counters, labels, colors, and chart types you select.

Additional Information: See the Your Performance Data, Your Way with Custom Charts in Portal blog
post for more examples.

Viewing Dashboards
Select Dashboards from the sidebar. If dashboards with custom charts already exist, they will be listed here
under the Dashboard Digest. Select a Dashboard to view its contents.

Filter Dashboards
If you have a large number of dashboards, you may want to filter what is displayed in the Dashboard Digest.
Start typing in the Filter Dashboards box to filter the dashboard options displayed.
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Creating Dashboards with Custom Charts
To create a Custom Dashboard in SQL Sentry Portal, complete the following steps:
1. Select Dashboards from the sidebar to open the Dashboard Digest.
2. Select the Create Dashboard button.

Create a New Dashboard screen

3. Enter a Dashboard Name on the Create a New Dashboard screen. This is how the dashboard will
appear on the Dashboard Digest.
4. Select a Dashboard Template from the drop-down menu. Use Blank Dashboard to start fresh or
choose an existing dashboard name as a starting point for this dashboard.
5. Select the  Edit button to launch the Add Charts options bar.
 Note: Use Custom Chart to start fresh with the specific metrics you are looking for, or select an
existing group from one of the options (e.g. Host  CPU or SQL Server  Database I/O ). If you
select an existing chart option, you can still customize it.
6. Add a chart and use the Customize Chart screen to make changes with the custom chart options
(described below) to create a chart.
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Example Customize Chart screen

7. Select Save to save your chart and return to the edit dashboard screen.
8. Add additional charts or select Save & Exit to complete your dashboard.

Custom Chart Options
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Option

Description

Preview

The preview area displays your chart with the selected options.

Chart Name

A descriptive name for the chart. This is how it will be identified on the
Dashboards view and used for filtering.
The name of the monitored target to select metrics from for the custom chart.
When building your dashboard, you can include charts for different targets and
target types on the same dashboard.
 Note: Targets types are identified with icons in the Target drop-down list.
When you select the Target from the list you will only have access to applicable
metrics in the Performance Metrics section below. For example, a Windows
target has access the applicable Windows or host metrics and SQL Server or Azure
SQL Database targets have access to the applicable SQL Server or Azure metrics.
You must be collecting tempdb metrics to have tempdb metrics listed.

Target

Sample Period

Option to include historical metrics for 1 hour, 1 day, or 1 week.
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Option

Description

Add Metric

Select the Add Metric button to add another metric to the custom chart. You may
add up to 10 metrics per chart.
A drop-down menu of performance counter metrics ( host.disk.reads,
host.network.in.total, sqlserver.batches, etc.) applicable to the selected Target
type.
 Note: Start typing to filter the available metrics. For example, type cpu to see
all CPU-related metrics or tempdb for tempdb-related metrics.

tempdb filtered metrics

Metric

Instance

CPU filtered metrics

The instance of the metric (if applicable) such as Average or a specific Node / Core
for host.cpu.cores or a specific disk for host.wmi.disk.size.
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Option

Description
The text that appears on the chart legend to associate the metric and color.
 Note: You can use emoji in the legend label. So if certain metrics make you
happy, sad, or angry, you can add a little flair to your legend.

Legend Label

Label with emoji

The color that the metric will use on the chart.

Color

Color palette window

Select the dot to open the color palette window. To choose a color, use the color
slider and select a shade from the rectangle, enter a HEX value, or enter RGB
values for your custom color. Select Set when you have chosen the appropriate
color for the associated metric.
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Option

Description
The following chart type options are available:
Line (default)
Area
Column
 Note: There's much to debate when it comes to choosing the right type of chart
to visualize your data. Keep in mind that:

Chart Type

A line chart displays data points that are connected with a single line. Its
simplicity makes it a versatile and common chart type.
An area chart displays the data points with a connected line and fills in the
area below. It may be difficult to see all metrics in an area chart (depending
on the data being displayed).
A Column chart displays data in vertical bars, grouped by metric. It can be
particularly useful for comparing series of data.

Check the Line box to display the metric as a line on the chart.

Line

Example of a Column chart with Writes and Network In metrics added as a line.

 Note: This option only appears on Area and Column charts. It allows you to add
a metric as a line to those chart types.


Use the  button to remove the metric from the chart.
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Description

Option

A Custom Time Range allows you to configure a chart to display metrics a defined
number of minutes, hours, or days.

Custom Time
Range

Example chart using a custom time range of 3 hours

 Note: You can mix charts with custom time ranges and default time ranges on
the same dashboard. Charts that use a custom time range will not be affected
when a new time period is selected from the date selector in the top navigation
bar.

Amount

The numerical value associated with the Units. For example, if you want the past
12 hours displayed, enter 12 in Amount and select Hours from Units.

Units

The following units of time are available:
Minutes
Hours
Days

Save

Select Save to save the changes to your custom chart, and add it to your
Dashboard.

Cancel

Select Cancel to dismiss your custom chart and not save any changes.

Editing Dashboards
1. Select Dashboards from the sidebar.
2. On the Dashboard Digest screen you can either:
1. Select the  options button on the dashboard you want to edit.
2. Select the dashboard you want to edit, then select the  edit button from the Dashboards
screen.
Edit mode allows you to do any of the following:
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1. Delete the dashboard.
2. Rename the dashboard.
3. Add additional charts to the dashboard.
4.  Configure or  delete existing charts on the dashboard.
Remember to select Save & Exit after making your changes, or Cancel to dismiss them.

Organizing Charts
When you are in Edit mode, you can drag and drop the charts to change the order or position on the
dashboard. If you want more than one chart per row, drag it into a row that contains another chart to create
another chart column.

Dashboard example with charts organized across rows and columns

 Note: To remove a chart from a multi-column row and place it in a new row, drag and drop it on the

453

bar with the add symbol (plus sign in a circle).

The Add bar for new rows

Editing Custom Charts
Adding charts
Selecting  edit on the dashboard allows you to add new charts using the Add Charts option bar. See the
Custom Chart Options above to complete adding a chart.

Editing charts
1. Select the  configure button on the chart you want to edit.
2. Edit the options as needed. See the Custom Chart Options above.
3. Select Save.

Removing charts
1. Select the  edit button on the dashboard that contains the chart you want to remove.
2. Select the  delete button on the chart you want to remove.
3. Select Save & Exit to complete the chart deletion.
 Note: Select Cancel if you do not want to delete the chart.

Deleting Dashboards
An entire dashboard may be deleted from the Dashboard Digest or Dashboard screen.
From the Dashboard Digest screen:
1. Select the  options button on the dashboard you want to remove.
2. Select Delete.
3. Select Delete Dashboard on the Delete Dashboard Confirmation screen to complete the dashboard
deletion.
 Note: Select Cancel if you do not want to delete the dashboard.
From the Dashboard screen:
1. Select the  Edit button on the dashboard you want to remove.
2. Select the Delete button on the dashboard you want to remove.
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3. Select Delete Dashboard on the Delete Dashboard Confirmation screen to complete the dashboard
deletion.
 Note: Select Cancel if you do not want to delete the dashboard.
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SQL Sentry Portal & SentryOne Monitor Health
Last Modified on 19 April 2022

 Applies to the following products and features: The SentryOne Monitor product and the onpremises SQL Sentry Portal feature for SQL Sentry.

Health Overview
Overview
The Overview tab is displayed by default. As indicated in the name, this view is showing the overall health,
and the 10 most recent alerts that fall within the selected time frame (within 24 hours) for all monitored
targets in your environment.

Health Score Calculation
The Health Score (shown above) is calculated by incorporating open alerts and their associated severity. It
uses a 24-hour window in the calculation, and can be adjusted with the Time Slicer to display more recent
alerts in varying hour and minute increments. A high health score (with a maximum of 100 possible) is an
indicator of good health.
The points per severity level are:
Low - 1 point
Medium - 3 points
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High - 6 points
Critical - 9 points

 Note: The weight of an open alert diminishes with its age. The score being presented is 100 minus
the sum of the weighted value of open alerts. Closed alerts are not factored into the score. Alerts can be
closed in the Events Log in the SQL Sentry configuration client.

Select a time increment from the Time Slicer to adjust the Health Score, wedgets, and associated alerts based
on your selection:

SQL Sentry Portal EHO displaying the last 3 hours data

Alert Details
Select the  (chevron-right icon) to the right of the count to display the individual details about each logged
alert on any of the health views:
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EHO for Sites and Groups
The Environment Health Overview (EHO) is available for sites and groups in SQL Sentry Portal. Use the
Show Hierarchy switch to toggle the list of targets between a flat list and a list grouped by sites.

Example of the EHO at the site level (using Default Site)

Expand a site to view the groups within it and select a group to view a group EHO.
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Example of the EHO at the group level (using Azure SQL DB)

 Note: The Site and Group icons and labels note which type of overview you are viewing.

All SQL Servers View
Select All SQL Servers from the sidebar to display the overall health view for all SQL Servers in your
monitored environment.

 Note: Uptime is a measure of the percentage of time that SQL Sentry Portal is able to connect to the
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server to collect data.

The All SQL Servers view provides options for viewing overall health through Alerts by Severity, Alerts by
Tag, and Wait Time / Session. These views are similar to the target health views described below, but they
include the overview information for all monitored SQL Servers.

All Windows Servers View
The All Windows Servers view provides options for viewing overall health through Alerts by Severity,
Alerts by Tag, and Wait Time / Session. These views are similar to the target health views described below,
but they include the overview information for all monitored Windows Servers.

Target Health View
When selecting a target, the Health view is the default view. This screen displays wedgets for Alerts by
Severity, Alerts by Tag, and Wait Time / Session. The default view is Alerts by Severity.

Alerts by Severity
In the example below, the Alerts by Severity wedget is displaying 5 Critical and 9 Medium severity alerts. In
the Alerts table, you can see 2 rows of alerts with a severity of critical (4, and 1) totaling 5, and 8 rows of

medium alerts (with one row displaying 2 alerts) totaling 9. This is how the number in the color-coded alert is
calculated.
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Alerts by Severity example

 Note: Selecting the blue hyperlinked target name on the left provides an option to switch to the
Health, Performance, Storage, Top SQL, Blocking, Deadlocks, or TempDB view for that target.

Alerts by Tag
The Alerts by Tag view works by incorporating alerts to calculate the scores and associate them to tags on
the alerts (Network, CPU, Memory, Disk, and Other). The score for these views is based on the severity of all
open alerts within the selected time period. A high health score (with a maximum of 100 possible) is an
indicator of good health.
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Alerts by Tag example

Wait Time / Session
Wait Time / Session relies on wait stats data collected by SQL Sentry. These wait stats are broken down by
major resource category (Network, CPU, Memory, Disk, Other). In this view, the health score worsens as
waits increase. A low ms/session score is an indicator of good health.
Each category is calculated independently. The displayed value for a category is calculated as the waits for the
category divided by the user sessions. The values for waits and user sessions are based on the most recent
values present in the selected time frame. Each value is then rounded and displayed as the category’s value.
The overall score is the sum of the five rounded categories.
The Other category is for other important wait types that either affect performance in more than one major
category, or can't be directly attributed to any category with absolute certainty, such as backups and
parallelism respectively.
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Wait Time / Session example

Related Targets
As seen in the image above, there is a list of Related Targets (1 SQL Server and 1 Windows Server in this
example). When there are multiple instances on a SQL Server, they will be listed as a related target, as will the
Windows Server where the SQL Server is installed.
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SQL Sentry Portal Performance Analysis
Last Modified on 14 March 2022

 Applies to the following products and features: The on-premises SQL Sentry Portal feature for SQL
Sentry.

The Performance tab displays the performance charts for monitored targets. Select a target from the sidebar,
then select Performance from the feature navigation menu at the top.

Performance Navigation
 Note: In the SQL Sentry Portal feature for SQL Sentry, versions 2021.1 and later, Custom Dashboards
have been replaced by Custom Charts and are not part of the Performance Analysis Dashboard section.

Within the Dashboard view, the options and information displayed include:
1. A drop-down menu to switch between monitored targets.
2. A pause button (which flips to a  play button) to toggle the view of live data.
3. A date selector.

Performance tab Options
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Date Selector
Use the date selector to select an available Range or define a Custom Range of time for data to view on the
dashboard. Use the Days, Weeks, and Months options to select an entire day, week, or month range at once.

Chart Details
Hover over a point in a chart to open a tooltip that displays additional details.

 Note: The chart details tool-tips vary by chart.
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Filter Dots
Use the filter dots ( Disk, Other, Memory, CPU, and Network in the image below) to customize what appears
on the chart from the available options:

The same chart with Disk filtered out:

Zoom
Highlight an area on the chart for options to Zoom the Dashboard charts into that time selection.

Jump To
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Highlight an area on the chart for options to jump to other feature views ( Health, Performance, Storage,
Top SQL, Blocking, Deadlocks, or TempDB) for the selected time period. For example, use this option to
troubleshoot performance issues by correlating a spike to a SQL query.

View Additional Metrics
Some charts, such as SQL Server Activity and SQL Server Memory may have additional metrics available in
the legend and filter dots. Use the arrows to scroll through them.

Performance Analysis Charts
 Note: The available charts displayed vary by target type (SQL Server vs. Azure SQL database). For
example, an Azure SQL Managed Instance target will have SQL Server charts, but not Windows charts
displayed.

Windows
Network
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The Network chart displays the total network traffic on the server as well as the network utilization on each
of the adapter present on the monitored target.

CPU Usage
The CPU Usage chart displays the total CPU Usage for the server as well as information on context switching,
user time, kernel time, and more. The total processor time percentage across all processors on the server. A
sustained value greater than 80 percent generally indicates a CPU bottleneck.

System Memory
The System Memory chart displays information about the amount of memory being used by different
processes on the server as well as page faults and page file usage.
SQL Server
The amount of physical memory used by each SQL Server. Important for determining whether available
memory is being used effectively, and whether there's memory contention between multiple instances on the
same server.
File cache
The amount of physical memory currently allocated to the system file cache.
Other
The amount of physical memory used by all processes on the server other than SQL Server or SSAS.

Disk I/O
The Disk IO chart displays the read and write latency for each of the physical disks on the server.
ms/Read
The average time in milliseconds each physical disk read is taking.
Disk latency is the only disk measurement for which there are generally accepted ranges that represent good
and bad performance from a SQL Server perspective. Disk queue metrics, for example, are not accurate for
many SAN systems, and there are also no universally agreed upon good and bad ranges for SQL Server. The
following ranges can be used as a general guideline to determine whether disk latency is acceptable:
Less than 10ms - Fast *
Between 10ms - 20ms - Acceptable
Between 20ms - 50ms - Slow
Greater than 50ms - Critical
* For transaction log writes, between 0ms and 2ms is desirable.
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ms/Write
The average time in milliseconds each physical disk write is taking.

SQL Server
SQL Server Activity
The SQL Server Activity chart displays information about what the SQL Server instance is doing.
Batches
The total number of select, insert, or delete statements per second, including those inside a stored procedure.
The name is somewhat misleading since it doesn't represent batches (groups of multiple statements) in the
traditional sense. It's one of the best measures of overall activity on a SQL Server.
Over 1000 Mb per second is generally considered moderate to high activity. A 100Mb network can reach
saturation at around 3000 Mb per second.
Compiles
The total number of initial compiles and recompiles per second. The value should generally be < 10 percent of
batches per second. Higher values indicate plan reuse is low, and will generally correlate with high CPU, since
plan compilation is a CPU intensive operation. It may also correlate with low cache hit ratios for object and/or
SQL plans.
It can also be a strong indicator of memory pressure, since there may not be enough room to keep all plans in
cache.
Recompiles
The number of recompiles per second. The value should generally be < 10 percent of initial compiles per
second.
Transactions
The total number of transactions per second across all databases on the server. A transaction can be either a
user-defined statement block surrounded by a BEGIN TRAN and END TRAN, or an individual DML statement
(insert, update or delete).
Compare with batches per second. On systems with high DML you typically want to see a low ratio of
transactions to batches. A low ratio indicates that the individual statements are being bundled together, and
can result in dramatically higher throughput and reduced IO due to log flushes.
Key Lookups
The number of times per second that the query processor had to perform a key lookup, across all queries.
Lookups occur when the index being used is non-covering, meaning it doesn't include all of the columns
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required by the query. For each row returned by the index operation, the query processor has to go back to
either the clustered index to perform a key lookup, or the base table to perform a RID lookup in the case of a
heap.
Lookups are a high overhead operation, especially when large number of rows are involved, because each
lookup incurs a random I/O and additional processing. This often correlates with higher CPU usage and page
reads. Lookups can be eliminated by using a covering index, adjusting joins to reduce the set so the lookup
isn't needed, or using multiple indexes (intersection).
Forwarded Records
The number of times per second that the query processor had to lookup forwarded records, across all queries.
Forwarded records occur in tables with no clustered index (heaps) when rows become too large to fit on the
page and have to be relocated. Over time, this can cause severe fragmentation and queries to incur much
higher than normal I/Os, specifically random reads. This can correlate with high SQL Server page reads, and
high SQL Server disk wait time, data file and physical disk latency if the disk system isn't keeping up with the
additional reads. On many systems it's not unusual for this counter to stay at zero if all tables have a clustered
index, any heaps aren't fragmented, or they just aren't accessed frequently.
Backup/Restore MB
The data rate in MB/sec for any backup operations taking place on the server.

SQL Server Waits
The SQL Server Waits chart displays information about the classes and categories of waits that occurred as
well as the duration of milliseconds that the waits were in effect during that time period.
Although there are hundreds of wait types, only the wait types that can be definitively attributed to one of
the physical resource categories (Disk, Memory, CPU, and Network) are included in the calculations for this
chart. The Other category is for a few other important wait types that can either affect performance in more
than one major category, or cannot be directly attributed to any category with absolute certainty, such as
backups and parallelism respectively.
SQL Server Waits is one of the most important charts on the dashboard, because it provides an instant profile
of the SQL Server and where it's spending the most time waiting for physical resources. If SQL Server are
consistently low, then what the other dashboard charts are showing is less important. For example, if CPU and
SQL Server Activity: Batches look unusually high, but CPU waits are low, then the server hardware is
effectively handling the load.
Total waits of less than 200ms is excellent. Between 200ms and 1000ms is average. Greater than 1000ms
likely requires some attention to determine where the bottleneck lies. Over 5000ms may indicate severe
bottle-necking.
The total wait time may be higher by virtue of a large number of processes (spids) active on the server,
because wait time is summed across all processes, it isn't a per process average. This can be especially
applicable to the Other category, because several processes experiencing parallelism at the same time can
cause it to spike to high levels.
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Additional Information:
SQL Server Best Practices Article
What to do (or not do) about top wait stats

SQL Server Memory
The SQL Server Memory chart displays information about how the Server instance is using memory that has
been allocated to it.
Buffer
The current size of the buffer cache (in MB). You want this to be as large as possible for maximum
performance, and on a dedicated SQL Server it should consume most of the SQL Server memory and physical
memory.
Plan (SQL)
The current size of the cache used for query plans (in MB). This includes ad-hoc, auto-parameterized, and
prepared plans. A high value in proportion to the buffer cache may indicate query plans aren't being
effectively reused.
Plan (Objects)
The current size of the cache used for object plans (in MB). This includes stored procedures, functions, and
triggers. A high value in proportion to the buffer cache may indicate query plans aren't being effectively
reused.

Additional Information: Caching Mechanisms

Columnstore
The current size of the Columnstore index on the SQL Server (in MB). This includes both clustered and
nonclustered columnstore indexes.
In-Mem OLTP
The current amount of memory (in MB) dedicated to In-Memory OLTP. This includes Memory-optimized
tables, non-durable tables, and natively compiled T-SQL modules.
Other
The current size of the cache used for all other plans (in MB). This includes bound trees, extended stored
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procedures, temporary tables, and table variables. This cache size should be low in proportion to the other
plan caches. If it goes over roughly 10 percent of the object or SQL plan size, further investigation may be
needed.
PLE (sec)
The average lifespan of a data page. If this value is less than 600, it's an indicator of memory pressure. Ideally,
it should be much higher than 600 if ample memory is available. In general, the larger the buffer cache size,
the higher it should be. This is the best universal indicator of memory pressure.
Plan (SQL)
The ratio of hits to lookups for the query plan cache. This value should stay above 90 percent.
Plan (Object)
The ratio of hits to lookups for the object plan cache. This value should stay above 90 percent.
Pages: Reads
The average number of buffer data pages read from disk per second. Ideally, this value should be at or near
zero most of the time. If it's above zero, it means that the data wasn't found in the buffer cache, and so it had
to be retrieved from disk. If spikes in page reads correlate with high disk latency, the disk system may not be
keeping up.
Querying newly created temp tables will also show up as page reads, as well as activity from internal tempdb
objects. This includes hash joins, hash aggregates, sort, and query spool operations. This means that you can
still see high paging from tempdb due to query activity, even though you aren't explicitly using temp tables.
When page reads and page writes correlate closely, it's a strong indicator that it's related to tempdb activity,
because pages are being written to disk when the objects are created, then immediately read back in to
memory for use by querying operations.
If lazy writes > zero and track closely with page reads, and page life expectancy < 600, it's a strong indicator of
memory pressure, because data is being moved out of buffer to make room for new data coming in.
Lazy writes also cause page writes, but generally much less than tempdb activity. If you see high page reads,
and relatively low lazy writes and page writes, it's likely memory pressure and not tempdb activity.
Pages: Writes
The average number of buffer data page writes to disk per second.
Page writes can be caused by checkpoints, lazy writes, and tempdb activity. To calculate the approximate
amount of writes related to tempdb, for any given interval, subtract checkpoints and lazy writes from total
page writes.
If high page writes correlate with high latency, the disk system may not be keeping up.
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Database I/O
The Database IO chart displays information about the read and write latency for the databases.
ms/Read
The average time in milliseconds each physical disk read is taking for a particular database file. The top 10
database files (data and transaction log) with the highest latency for the specified date range are shown.
ms/Write
The average time in milliseconds each physical disk write is taking for a particular database file.
Log Flushes
Log flushes occur with every DML operation, and are a normal part of SQL Server activity. It's important to
note that log writes to physical disk from updates to buffer pages happen immediately upon transaction
commit, whereas writes to physical disk from the changed buffer pages is delayed until the next checkpoint
occurs. It's critical that the physical disk system where the transaction log resides is fast enough to keep up
with activity. If not, it can slow down all DML operations occurring in the database.
Ideally each busy transaction log should have its own dedicated disks, so that writes can happen sequentially,
which will minimize latency. If log flushes are high and latency is high for a transaction log file, then the disk
system is likely under-powered for the current load.
Checkpoint Pages
The average pages per second written to disk by the checkpoint process. Checkpoints flush all dirty buffer
pages for a given database to disk and are a normal part of SQL Server operations. The frequency of
checkpoints and volume of checkpoint pages is dictated directly by the Recovery Interval server option. SQL
Server uses checkpoints to batch writes to disk, which is generally more efficient. However, if the volume of
each checkpoint is too high and you see a correlation with high disk latency, it may indicate that the disk
system isn't keeping up.
Lazy Writes
The average number of writes per second by the lazy writer. The lazy writer periodically scans the buffer and
evicts pages that have low use counts in order to maintain a certain number of pages on the free list. Ideally,
this value should be at or near zero most of the time. When there is no memory pressure, the lazy writer will
generally leave data pages in memory, even those with low use counts. However, when pressure exists, the
lazy writer will continually be working to make room for new data coming into the buffer.
An indicator of memory pressure is ongoing lazy writes > zero with page reads/writes > zero and page life
expectancy< 600.

Azure SQL Database
Resource Usage
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A DTU represents the power of the database engine as a blended measure of CPU, memory, and read and
write rates. This measure helps you assess the relative power of the SQL Database performance levels. Each
service tier, which sets pricing and usage limits for an Azure SQL Database, expresses the amount of resource
limits as a number of DTUs. The more DTUs an Azure SQL Database is allocated the more resources the
database will have to service the workload.

Additional Information: See the What is Azure SQL Database? article on Microsoft Docs for more
information regarding DTUs, purchasing models, and service tiers.

Total DTU %
If your database is seeing high Total DTU percentage usage it may benefit from adjusting to the next highest
service tier to improve performance. If you're consistently seeing very low total DTU percentage usage you
may save some money by scaling down to the next lower service tier.
Data I/O
This metric is the average Data I/O percentage based on the limit of the service tier. This is one of the metrics
that makes up DTU.
Log I/O
This metric is the average log I/O percentage based on the limit of the service tier. This is one of the metrics
that makes up DTU.
CPU %
This metric is the average CPU percentage based on the limit of the service tier. This is one of the metrics that
makes up DTU.

Memory Usage
Allocated Memory Usage
Each service tier has a maximum amount of memory allowed for the Azure SQL Database to use. This metric
provides the percentage of the allowed memory being used for the database.
It will be very common for this metric to be high. If much of the data your applications need is in memory it
means better performance because the database doesn't have to read from the physical disk to return the
data.

Database Size
Each service tier has a maximum allowed size for the Azure SQL Database. This chart uses that tier to
determine the total space available.
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Used Space
The space used by the database in MB.
Free Space
Amount of space remaining (in MB) from the total space allowed for the tier.

SQL Database Waits
The SQL Database Waits chart displays information about the classes and categories of waits that occurred
as well as the duration of milliseconds that the waits were in effect during that time period.
Although there are hundreds of wait types, only the wait types that can be definitively attributed to one of
the physical resource categories (Disk, Memory, CPU, and Network) are included in the calculations for this
chart. The Other category is for a few other important wait types that can either affect performance in more
than one major category, or cannot be directly attributed to any category with absolute certainty, such as
backups and parallelism respectively.
SQL Database Waits is an important chart on the dashboard, because it provides an instant profile of the
Azure SQL DB and where it's spending the most time waiting for physical resources. If SQL DB waits are
consistently low, then what the other dashboard charts are showing is less important. For example, if CPU and
SQL Server Activity: Batches look unusually high, but CPU waits are low, then the server is effectively handling
the load.
The total wait time may be higher by virtue of a large number of processes (spids) active on the server,
because wait time is summed across all processes, it isn't a per process average. This can be especially
applicable to the Other category, because several processes experiencing parallelism at the same time can
cause it to spike to high levels.
Database I/O
The Database IO chart displays information about the read and write latency for the databases.
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SQL Sentry Portal Storage
Last Modified on 19 April 2022

Storage
The Storage view provides details about the disk space and disk activity in your monitored environment. Use
the Storage tab to view details about your monitored environment storage by disk, including capacity, free
space, databases, disk activity, etc.

View data about your monitored environment's disk activity and disk space. Selecting a link from the table on
the left populates details for your selection on the right in the Details and Trends tabs.
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Overview Chart
The Overview chart displays storage capacity information for your monitored environment.

 Note: Select any blue link to display more information about your selection in the Details tab.

Option

Description
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Option

Description

Name

The name of your monitored storage unit.

Type

The type of storage unit (Disk , Volume, Transaction Log, Data, etc).

% Used

The percentage of used space for the storage unit.

Size

The overall size of the Storage unit in MB or GB.

 Note: You can use the  icon to expand information for a selected disk and the  icon to minimize
information for a selected disk.

Details
The Details tab displays recorded storage metrics and any storage activity for your monitored environment.
The details tab is divided into Capacity and Activity Metrics sections that display real-time data or a selected
range of data.
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Capacity Metrics
Metric

Description

Size

The overall size of the selected Storage unit in MB or GB.

% Used

The percentage of used space for the selected storage unit.

File Group

The file group that the storage unit is associated with.

Database

The database for the selected storage unit.

File Path

The file path for the selected storage unit.

Active VLFs

The number of active virtual log files for the selected storage unit.

Autogrowth

The percentage of autogrowth and amount of autogrowth memory in (KB), or
(MB).

Autogrowth
VLF Count

The number of virtual log files that have used autogrowth for the selected storage
unit.

Autogrowth
VLF Size

The size in (KB) or (MB) of the autogrowth VLF(s).

Last Backup
Time

The time in UTC that the selected storage unit was last backed up.
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Metric

Description

Last Backup
Type

The type of backup performed during the last backup period.

Max File Size

The maximum file size for the selected storage unit.

Max VLF Size

The maximum virtual log file size for the selected storage unit.

Min VLF Size

The minimum virtual log file size for the selected storage unit.

Total VLFs

The total number of virtual log files for the selected storage unit.

Used Space

The total amount of consumed space for the selected storage unit.

Activity Metrics

 Note: Activity Metrics update automatically in five minute increments by default.

Metric

Description

Reads

The number of reads in your selected storage unit for the specified time period.

Reads/sec

The number of reads per second in your selected storage unit for the specified
time period.

Read Bytes

The total number of read bytes in your selected storage unit for the specified time
period.

Read Bytes/sec

The total number of read bytes per second in your selected storage unit for the
specified time period.

Read Bytes %

The total percentage of read bytes in your selected storage unit for the specified
time period.

Bytes/Read

The number of bytes per read in your selected storage unit for the specified time
period.

Writes

The number of writes in your selected storage unit for the specified time period.
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Metric

Description

Writes/sec

The number of writes per second in your selected storage unit for the specified
time period.

Write Bytes

The total number of write bytes in your selected storage unit for the specified time
period.

Write Bytes/sec

The total number of write bytes per second in your selected storage unit for the
specified time period.

Write Bytes %

The total percentage of write bytes in your selected storage unit for the specified
time period.

Bytes/Write

The number of bytes per write in your selected storage unit for the specified time
period.

 Note: Activity Metrics update automatically in five minute increments by default.

Trends
The Trends tab displays Latency, IOPS, and MB/sec graphs for your selected storage unit.

481

Select a spike on a trends graph to display detailed read and write tooltips for your selection.

View storage trends historically for your selection. Select the calendar, and then select the desired Range,
Days, Weeks, or Months that you want to display. Select Apply to update the trends graphs based on your
selection.
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 Note: Select the  button to switch to live data.

Historical Data example

Live Data example

Select a graph metric to remove that data from the graph.

Select metric

Metric removed from graph

Select a Disk Volume to display a disk space forecast for the selection.
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Warnings
SQL Sentry Portal tracks multiple warnings types across the storage entities in your monitored environment.
Warnings display as red  icons and are visible on the Overview chart. Select a storage entity with a warning
icon to display more information about the warning in the Details tab.

 Important: Warnings in your monitored environment display hierarchically. For example, if you select
your Controller, the Details tab will display all of the warnings in your environment. If you select an
individual disk, the Details tab will display the warnings associated to the selected disk.

Select the  on the column bar to sort by warnings.

Select a Storage Warning link to be redirected to the selection.
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Select the desired warning link

Storage Warning selection

SQL Sentry Portal will notify you if your environment encounters any of the following warnings:

Warning

Description

TotalVlfsOver100 (vlfs = virtual log
files)

Total VLFs over 100. Too many VLFs can cause long
startup and backup times.

TotalVlfsOver300 (vlfs = virtual log files

Total VLFs over 300. Too many VLFs can cause long
startup and backup times.

AutogrowthUnderTenMegabytes

Autogrowth under ten megabytes.

AutogrowthOverOneGigabyte

Autogrowth over one gigabyte.

AutogrowthOverRemainingDiskSpace

Autogrowth over remaining disk space.

NonSimpleRecoveryModelAndNotBackedUp

This database is in a non-simple recovery model and is
not backed up.

ForecastExhaustionWithinThirtyDays

The forecasted exhaustion of this volume is within 30
days.

LowFreeSpacePercentage (Free space <
10%)

This volume has low free space.
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SQL Sentry Portal & SentryOne Monitor Top SQL
Last Modified on 14 March 2022

 Applies to the following products and features: The SentryOne Monitor product and the onpremises SQL Sentry Portal feature for SQL Sentry.

Introduction
The Top SQL view displays a unified picture of collected SQL statements. It's designed to help you quickly
identify queries, applications, logins, and more that are causing the most waits, using the most resources,
taking the most time, and putting the most load on your SQL Server.

 Note: Top SQL data is retained for 15 days in SentryOne Monitor. If you're using the SQL Sentry
Portal feature for SQL Sentry, this default value may be changed and is controlled by the Monitoring
Service Settings.

Available Charts
The full viewing options for this card's charts are:
Waits
Resources
Queries ›
By App ›
By DB ›
By Host ›
By Login ›
Select the  button in the upper right for additional options such as reset, show/hide axis labels, and
show/hide axes.
Show/hide axes has the following options:
Avg Duration (ms)
CPU Time (ms)
Exec Count
Reads Logical
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Writes Logical
Reads Physical
On the options with the  (chevron-right), additional choices similar to the above are available by selecting
the  symbol. For example, By App - Duration (ms) and Queries - Reads (P) are available chart options.

Waits
The first card in Top SQL defaults to a Waits view. Waits displayed here are from the SQL Server instance
level. For a better understanding of waits, see the SQL Server Waits Stats section of the Dashboards article
and this blog post What to do (or not do) about top wait stats .

Hover over an area on the chart to view additional details about the waits:

Resources
View resource usage from Top SQL, based on query and procedure stats:
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Hover over a point on the chart to view additional details about the resources being used:

Queries
Select the  (chevron-right) to view charts for:
CPU
Duration
Exec Count
Reads (L) - The default selection
Reads (P)
Writes (L)
The information displayed here is from query stats, procedure stats, and trace data.

Hover over an area in the chart to view more details about the queries:
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By App
Select the  (chevron-right) to view charts for:
CPU
Duration
Exec Count
Reads (L) - The default selection
Writes (L)
The information displayed here is from trace data.

Hover over an area on the chart to view more details about the applications:

By DB
Select the  (chevron-right) to view charts for:
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CPU
Duration
Exec Count
Reads (L) - The default selection
Reads (P)

Hover over an area on the chart to view more details about the databases:

By Host
Select the  (chevron-right) to view charts for:
CPU
Duration
Exec Count
Reads (L) - The default selection
Writes (P)
The information displayed here is from trace data.
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Hover over an area on the chart to view more details about hosts:

By Login
Select the  (chevron-right) to view charts for:
CPU
Duration
Exec Count
Reads (L) - The default selection
Writes (P)
The information displayed here is from trace data.

Hover over an area on the chart to view more details about logins:

Totals
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The Totals table displays the text data and associated information such as database, duration, count, and CPU
for the collected SQL statements (including procedure stats, query stats, and completed queries).

 Note: By default, the Totals grid displays the top 8 queries by logical reads (descending ). For all
grids, the arrow with the circle around it highlights by which column the data is sorted; ascending  or
descending .

Trace Events
Select the  (chevron-right) under the Events column to display details for any collected Trace Events such
as RPC:Completed.

 Note: In the upper right of the Top SQL page, there is a details switch. The switch is off by default.
Select the switch to turn on details (
), which flips all totals and statements tables to the
detailed Trace Events and Trace Events Statements view on the page.

Statements

The Statements card displays additional information about Totals where applicable, including plan diagrams,
text data, parameters, and plan XML.
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Trace Events Statements
Select the  (chevron-right) under the Events column to display statement details to any collected Trace
Events such as SP:StmtCompleted.

Plan Diagram
Use the full screen button in the upper left to expand a larger plan, or use the Download Plan button to
download the entire .sqlplan file.

 Note:
Sometimes the plan XML may be populated, but there's not a statement that can be matched for
the plan diagram. This can be caused by things like nested procedures or individual statements
falling outside of the collection thresholds on their own. In this case, the plan diagram will display
a message such as "The selected statement was not found in the plan XML. Download the full plan

to view in SentryOne Plan Explorer " and provide a Download Plan XML button.
If the Query History chart shows a disabled point (i.e. a gray triangle), then the plan diagram will
display a message to indicate that there are no plans available (e.g. "There is no data to display ").

Text Data
Use the Text Data tab to view a formatted and syntax color-coded copy of the statement.
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Parameters
Use the Parameters tab to view compiled values for statement parameters.

Plan XML
Use the Plan XML tab to view or copy the ShowPlanXML output.
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 Note: The Copy button is only available when you are using HTTPS (requires an SSL certificate for
your SQL Sentry Portal installation).

Query History
Select a query or statement, then view the Query History for it. Query History displays a graphical
representation of the selected query over a specified range of time. Query History provides information
about the query execution plans, if and when they were changed, and how they impacted different resources.

Query Event
Each triangle represents a Query Event.

 Note: The triangle colors represent execution plans. Triangles of the same color are using the same
plan. If there is excessive plan drift (beyond 25 plans), then the 25 colors will start to be reused in the
same order. Select a specific event to the Plan # represented.

Query Stats Sample
Each dot represents a Query Stats Sample or a Proc Stats Sample.
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Proc Stats Sample
Each dot represents a Proc Stats Sample or a Query Stats Sample.

 Note: The Mode for the Proc Stats Sample is set to Procedure.

Additional Options
Use the options below the chart to adjust the Grouping, Show, Metric, Mode, or Dates slider window.
Grouping

None
Hour
Day
Week
Show

Actual/Average
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Totals
Metric

Duration
CPU
IO
Mode

Procedure
Statement

 Note: In Procedure mode, the chart reflects changes in the procedure stats (plan_handle), whereas
Statement mode displays the changes in query stats (query_plan_hash) .

Example with Grouping by Hour, Show Totals, Metric CPU, and Mode Statement:

An additional example with multiple plans represented:
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Additional Information:
Multiple Plans for an "Identical" Query blog post by Aaron Bertrand on SQLPerformance
Different Plans for "Identical" Servers blog post by Aaron Bertrand on SQL Performance
Analyzing "death by a thousand cuts" workloads blog post by Erin Stellato on SQLPerformance
How useful are query_hash and query_plan_hash for troubleshooting? blog post by Jonathan
Kehayias on SQLskills
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SQL Sentry Portal & SentryOne Monitor Alerts
Last Modified on 05 April 2022

Overview
 Applies to the following products and features: The SentryOne Monitor product and the onpremises SQL Sentry Portal feature for SQL Sentry.
 Note: Only the Log view is available for SQL Sentry Portal.

SentryOne Monitor delivers a workable set of alerts that have been carefully chosen by experienced
Microsoft data platform professionals for their relevance to most database monitoring situations.
From the Alerts page, you can configure alerts to send email notifications to yourself or other members of
your organization. See the Details & Emails section in this article for step-by-step instructions.

Log

Alerts view for SentryOne Monitor

 Note: The on-premises SQL Sentry Portal Alerts view only displays the Log. All alert configurations
are still managed through the SQL Sentry client.
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Example of the Alerts view available through SQL Sentry Portal

 Note: The default view on the Alerts page displays the 5 most recent alerts logged across your
environment (Start Time ). You can sort the table by any of the available columns.

 Note: The following columns are all read-only or hyperlinks.

Column

Description
The covered area of the watched target that triggered the alert.

Target

 Note: If the scope of the target is at the server or instance level (i.e. QREGRESSION and not Q-REGRESSION: SQL Server Agent Jobs), then it will be a
hyperlink to display Health, Dashboards, or Top SQL for that target).

Type

The alert type, such as SQL Server, a deadlock (Deadlocks: Deadlock), etc.

Name

The name of the alert.

State

The state of the alert (e.g. active or completed). An active alert has a start time,
but no end time, as the situation is still meeting the conditions of the alert.
The severity may be high, medium, or low.

Severity

 Note: The severity is blank unless the alert is sourced from an advisory
condition alert category.

Start Time

The time the alert started evaluating to true.

End Time

The time the alert stopped evaluating to true.
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Column

Description
The amount of time that the alert was true.

Duration

 Note: The smallest value displayed is in seconds. If an alert was active for
500ms, it would display a duration of < 1s.
Select the Details hyperlink to view a popup window containing the details
logged for the alert:

View

The available details vary depending on the condition, and may contain
information such as the step of a failed SQL Server Agent job and the error
behind the failure .
On an alert such as High CPU , which looks for CPU greater than 90, the
performance counter value collected at the time of the alert evaluation is
included (e.g. Performance Counter: Processor Information: % Processor Time,
Total [97.4264] > [90] *TRUE* ).

Configuration
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 Applies to the following products and features: The SentryOne Monitor product.

The default view on the Configuration page displays the available alerts in SentryOne Monitor. From this tab
you can select the Name to view information about the significance of the alert or configure email
notifications. Select the Status  to access the Evaluation Status details.

 Note: The following columns are all read-only or hyperlinks.

Column

Description
The descriptive name of the alert, such as Data File Shrink or High CPU .

Name

Select the name hyperlink to open the Alert window where you can view
additional information about the meaning of the alert, as well as set up email
notifications. See the Details & Emails section in this article for more information.

Type

The coverage area (e.g. Global, Top Commands , etc.), target type (e.g. SQL Server,
Azure SQL Database, Windows Computer, etc.), or SentryOne Monitor component
(e.g. Monitoring Service) affected by the alert.

Tags

These are used to group the alerts by common goals (e.g. Auditing, Performance,
CPU, Memory, etc.)

Email

Displays On if any email alerts are configured or Off if there are none.

Actions

Select the Status  hyperlink to display the Evaluation Status table.
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Alert Details & Email Notifications
 Applies to the following products and features: The SentryOne Monitor product.

Select the hyperlinked Name from the Configuration table on the Alerts page to view the Alert window:

The alert window displays a Severity at the top. Only alerts with a Category of Advisory Conditions have an
associated severity level. The severity levels may be High, Medium, or Low.

About
The About section displays information about the alert's purpose or meaning, and hints or links for how to
troubleshoot or investigate (where applicable).
Show "About" by default: When this box is selected, the About section is expanded on the Alerts
window, when it is not selected, the About section is collapsed by default.

 Note: The Show "About" by default option is a global setting for all Alert windows.

Email Notifications
You have the option to send alert emails when an alert's condition evaluates to True.

 Important: SentryOne Monitor will send a maximum of 50 alert emails per day. This maximum is for all
emails, across all alerts. It is recommended that you only configure email notifications for critical alerts
that require a fast response so that you keep your overall emails to a minimum, and do not miss emails
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for more important alerts.

Select Send alerts for [Condition Name] to me at [email@address.com] to receive email notifications for
the associated alert, at the default email address for your user name. A toast notification pops up to confirm
the change. Deselect this option to disable email notifications for the associated alert, for your user name.

Use the Send alerts for [Condition Name] to these email adresses: option to enter additional email
addresses that should receive alert emails.
1. Enter an email address, or multiple email addresses (separated by a comma).
2. Select Add.
3. Once you have the email addresses entered, use the Back to Conditions button to save the changes.

Select the X after an additional email address to stop it from receiving alert emails for the associated alert.

 Important: Changes to email addresses (adding or deleting) are not saved until you select the  Back
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to Alerts button.

 Note: You can send alert emails to yourself, others, or a combination of these emails.

Evaluation Status
 Applies to the following products and features: The SentryOne Monitor product.

The Evaluation Status table is accessed by selecting a row from the Actions column in the Configuration
table.

 Note: The following columns are all read-only or hyperlinks.

Column

Description
The name of the target associated with the evaluation.

Object Name

 Note: The hyperlink provides option to jump to other views for the target (e.g.
health or dashboard).
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Column

Description
Displays the outcome of the most recent evaluation against the alert. The result
will be True or False.
Example:

Last Result

The High CPU alert checks for sustained CPU usage over 90%.
True means that the last time this alert was evaluated that the monitored
target's CPU was over 90% for at least a minute.
False indicates that it did not sustain a value over 90% for at least a minute.

Duration

The amount of time it took to evaluate the result of the alert.

Last Evaluation
Time

The last time the evaluation completed.

Last Error

If there was an error during the evaluation attempt, it displays information here.
Displays whether the evaluation was executed as Scheduled or Manual. Each alert
in SentryOne Monitor is set to evaluate at a frequency specific to the alert.

Evaluation Type

Scheduled indicates that the evaluation was performed on schedule by the
monitoring service. For example, the High CPU alert is scheduled to evaluate
every 30 seconds, while the SQL Server Paged to Disk alert is scheduled to
evaluate every 5 minutes.
Manual means that a user chose to evaluate the alert ad-hoc through the
configuration client. This is an infrequent Evaluation Type in SentryOne Monitor
as users rarely need to access the configuration client.

Available Alerts
 Applies to the following products and features: The SentryOne Monitor product.

The following alerts are available with SentryOne Monitor.
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% Free Space - Data/Log File(s)
% Free Space - Disk
Amazon RDS for SQL Server: Offline
Amazon RDS for SQL Server: Online
Azure SQL Database: Offline
Azure SQL Database: Online
High Avg Wait Time per User Session
High CPU
High CPU for non-SQL Server process
High Pending Disk IO Count
SQL Availability Group Failover
SQL File Auto-growth Exceeds Free Space

SQL Server Agent Job: Failure
SQL Server Memory Exhaustion
SQL Server Process Paged to Disk
SQL Server Process Physical Memory Low
SQL Server Process Virtual Memory Low
SQL Server: Blocking SQL
SQL Server: Deadlock
SQL Server: Offline
SQL Server: Online
Suspect Pages - Active Corrupt Pages
Windows: Offline
Windows: Online
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SQL Sentry Portal Blocking
Last Modified on 02 November 2021

 Applies to the following products and features: The on-premises SQL Sentry Portal feature for SQL
Sentry. See the Getting Started with SQL Sentry Portal article for more details.

Introduction
Blocking occurs in SQL Server when a session places a lock on a resource, and an additional session attempts
to lock that same resource, but is unable to obtain the desired lock due to the existing lock from the first
session. Another session can come along, attempting to lock that resource before the second has even had a
chance to do so, creating a blocking chain. When these blocks become excessive and last longer, performance
starts to decline and can cause a serious issue in your database's performance.
SQL Sentry Portal Blocking maps the relationships between all blocking and blocked sessions (SPIDs) in a
blocking chain, allowing you to pinpoint the cause and fix the blocking issue.

Blocking by
At the top of the screen is the Blocking by... chart, which allows you to select Application, Wait Resource, or
Wait Type. Each chart displays the Total Blocks, Total Time (in seconds), and Average Time (in seconds).

 Note:
Hover over the charts to view more details:

Depending on the screen width and number of items in the chart legend, you may need to scroll to
see all items:
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Application
Use the Blocking by Application chart to discover which application is causing the most or longest blocks.
In the example below, we can see that the .Net SqlClient Data Provider has the longest average block time,
but it's the SQL Server Agent Job 'Block A' that has the highest number of blocks, and longest amount of total
time with blocking.

Wait Resource
SQL Server can place locks on resources, at different levels, such as a table, page, or single row. The Blocking
by Wait Resource chart shows you which resources are having the most serious blocks.

Additional Information: Transaction Locking and Row Versioning Guide on Microsoft Docs.
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Wait Type
The Blocking by Wait Type chart shows you which wait types (e.g. LCK_M_IX, PAGELATCH_SH, etc.) are
applicable to the blocks.

Additional Information:
Introduction to Wait Statistics
SQLskills Wait Types Library Now Shows SentryOne Data
What to do (or not do) about top wait stats
Why Wait Stats Alone Are Not Enough
Troubleshooting SQL Server: Where are the Waits?

Head Blockers
The Head Blockers table displays the details behind the blocks.
The top row is the head of the blocking chain and contains the blocking statement. There will be an icon at the
beginning of the row to indicate if the session has completed (check mark) or is currently still running (running
person).
Select the  arrow to expand the row and view the blocked sessions in the chain (labeled with the stop
button icon ). All blocked statements are nested underneath the blocking statement.

Head Blockers table showing the blocking session and the blocked session.
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Example of a blocking statement with multiple blocked statements.

Available Columns
Name

Description

SPID

The session process ID of the associated blocked/blocking process.

Start Time

Start time of the request.

Duration

The length of time that the block exists.

Statement

The command text associated with the request.

Wait Time

Duration of wait time in milliseconds.
Name of the wait type.

Wait Type

Additional Information: See the sys.dm_os_wait_stats (Transact-SQL) MSDN
article.

Wait
Resource

Name of the resource on which the request is currently waiting.

Host

Name of the server hosting the associated database.

Application

The associated application.

Database

The associated database.

Login

The login name associated with the session.
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Name

Description

Version

A unique record is shown for each version of a blocking chain, denoted by the
Version column. A new row is added each time the blocking chain changes, meaning
that a blocked SPID is either added or removed from the chain between polling
intervals. For some blocks this may happen frequently, creating multiple rows, while
others may not change at all for the duration of the block.

Text Data
The Text Data section displays the T-SQL for the highlighted statement in the Head Blockers table.

Additional Information: Back to Basics: The "Runaway" Query

Filters
Use the filter icon  in the upper right to apply filters to the Applications, Databases, or or Hosts.
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Make selections on the filter screen, then select Apply to apply them, or Reset to undo your changes and
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return to the default view (everything selected, no filters).

 Note:
The filter does not affect the Blocking by... charts. It filters values for the Head Blockers table
only (including the Text Data).
The filter icon  will be highlighted in blue () if a filter is applied.
At least one selection must be made from each filter category to apply a filter.
The filter does not impact the collection of blocking data.
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SQL Sentry Portal Deadlocks
Last Modified on 02 November 2021

 Applies to the following products and features: The on-premises SQL Sentry Portal feature for SQL
Sentry. See the Getting Started with SQL Sentry Portal article for more details.

Deadlocks
The Deadlocks view provides details about deadlocks within your monitored environment. Use it to identify
and fix deadlock issues on your monitored servers.

 Note: Deadlocks for Amazon RDS are not supported in SentryOne Monitor or the on-premises SQL
Sentry Portal.

Deadlock Diagram
The deadlock diagram is built from the captured deadlock XML. The victim, process, and resource (e.g.
Object Lock ) nodes are represented, as well as any relationships that exist between them.

 Note:
Resize the deadlock diagram using the magnifying and minimizing glass icons, and reset it to the
original if needed.
Select different nodes on the diagram to change the information displayed on the screen.
Use the expand button to open the deadlock diagram and XML in a full window.
Drag and drop deadlock files into the deadlock diagram space to get a diagram and view additional
information.
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The deadlock victim is highlighted in red (shown as Victim 56 [0] in the example above). The victim is
selected, and the Node Details and Locks associated with the victim are displayed to the right in the image.
There are two resource nodes (shown as Key Lock , this could also be at a different level such as an Object

Lock or a Page Lock ), and a process node (shown as Process 246 [0] ). Select any of the nodes to display the
associated Node Details and Locks (if applicable).

 Note: The numbers ( 1,2,3, and 4) and associated arrows that connect the nodes indicate the
sequence of events that took place to create the deadlock.

Deadlock Details
Column

Description

SPID [ecid]

The session process ID of the associated owner/waiter.

Host

The server or workstation name.

Application

The associated application (e.g. a SQLAgent Job, .Net SqlClient Data
Provider, name of a specific application running SQL statements against the
associated database, etc.).

Database

The associated database.

Login

The user login associated with the session.

Log Used

The amount of log space used by the process.
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Column

Deadlock Priority

Description
Specifies the Deadlock Priority. Zero (0) or Normal is the default priority.
In cases where each session has the same Deadlock Priority, SQL Server
chooses the victim based on the least expensive session to roll back.
Additional Information: For general information about the
DEADLOCK_PRIORITY option, see the Set Deadlock_Priority MSDN article.

Wait Time

Time in (ms) milliseconds spent waiting on the resource.
The requested lock mode (e.g. Shared (S) , Update (U ), Exclusive (X), etc.).

Lock Mode

Additional Information: See the Transaction Locking and Row Versioning
Guide and Lock Modes articles on Microsoft Docs.
The current transaction isolation level.

Isolation Level

Trans Name

Additional Information: For general information on isolation levels see
the Isolation Levels in the Database Engine MSDN article.
Name of the associated transaction.

Node Details
Processes

Column

Description

Type

States whether the process is the Owner or Waiter for the lock.

SPID [ecid]

The session process ID of the associated owner/waiter.
The requested lock mode (e.g. Shared (S) , Update (U ), Exclusive (X), etc.).

Lock Mode

Additional Information: See the Transaction Locking and Row Versioning
Guide and Lock Modes articles on Microsoft Docs.

Host

The server or workstation name.

Application

The associated application name.

Login

The user login associated with the session.

Text Data

The associated text data (e.g. T-SQL statement).

Call Stack
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Column

Description

Object

The associated object name.

Line Number

The line number which was being executed when the lock occurred.

Text Data

The associated text data (e.g. T-SQL statement).

Locks

Column

Description

Context

States whether the lock is held by the Owner or is a Waiter for the lock.
The requested lock mode (e.g. Shared (S) , Update (U ), Exclusive (X), etc.).

Lock Mode

Additional Information: See the Transaction Locking and Row Versioning
Guide and Lock Modes articles on Microsoft Docs.
Points to the lock type, such as a page or object.

Lock Type

Additional Information: See the Lock Granularity and Hierarchies section
of the Transaction Locking and Row Versioning Guide on Microsoft Docs.
The object involved in the deadlock, such as a table, index, or view name.

Object

Index

Additional Information: See the sys.all_objects (Transact-SQL) article for
more information about objects and the Lock Granularity and Hierarchies
section of the Transaction Locking and Row Versioning Guide on Microsoft
Docs.
Index associated with the lock (if applicable).
The resource associated with the deadlock. This could be the exact SQL
Server page of data, for example.

Wait Resource

Example with a Page Lock and PAGE Wait Resource

Deadlock XML
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Select DEADLOCK XML to view the raw XML file for the selected deadlock. Use the Copy button to copy all
the XML text to your clipboard.

 Note: The Copy button is only available when you are using HTTPS (requires an SSL certificate for
your SQL Sentry Portal installation).
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SQL Sentry Portal TempDB
Last Modified on 05 April 2022

 Applies to the following products and features: The on-premises SQL Sentry Portal feature for SQL
Sentry. See the Getting Started with SQL Sentry Portal article for more details.

Overview
The performance of the TempDB system database is critical to your overall SQL Server performance. Things
like temporary tables, work tables, the version store, sort operations, index rebuilds (when using
SORT_IN_TEMPDB) all rely on the TempDB database.
The TempDB view in SQL Sentry provides you with insight into what is using your TempDB database and how
effectively it is being used. In conjunction with other TempDB monitoring in SQL Sentry, you can be sure that
you have optimized both the TempDB configuration and your applications that are using it.

Additional Information:
See the SentryOne blog post Be Mindful of SQL Server TempDB Use (aka TempDB Parasites!) for
examples of things that use TempDB resources.
For more information about this TempDB feature, see the SentryOne Clears the Fog Around
TempDB blog post.

TempDB Summary
The TempDB Summary is the default chart when opening the TempDB view. It provides an overview of file
space usage across your TempDB data files. This chart helps you see how space is being used between
uniform and mixed extents. The values shown are in MB.

TempDB Summary chart

TempDB Summary Metrics
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Version Store
The total space reserved for the version store. When using snapshot isolation, the old versions of the rows are
stored here until they can be cleaned up by SQL Server. Trigger activity also uses the version store.

 Note: Long running open transactions can cause the version store to grow because newer versions
can't be cleaned up until the oldest version is no longer needed.

Example of TempDB Summary with high use of the Version Store compared to other metrics

Internal Objects
The total space allocated for internal objects (e.g. work tables, work files, etc.) across all TempDB data files.
This space is within uniform extents and includes all allocated space, even if it is unused.

User Objects
The total space for user objects (e.g. table variables, temporary tables, etc.) in the TempDB database from
uniform extents. This includes space that has been allocated, but is unused.

Mixed Extents
The total space that has been allocated to mixed extents across all TempDB data files. The pages in a mixed
extent can be shared and owned by different objects in SQL Server, but they do not get allocated for the
version store.

Free Space
The total amount of free space across all TempDB data files. This doesn't include unused space that is
allocated in an extent.

 See the following articles to learn more about the metrics on the TempDB Summary chart and the
differences between uniform (dedicated) and mixed extents:
sys.dm_db_file_space_usage article on Microsoft Docs
Pages and Extents Architecture Guide on Microsoft Docs
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Inside the Storage Engine: Anatomy of an extent on SQLskills

TempDB Objects
 Note:
TempDB Object Stats must be enabled through Settings.
Go to Settings Pane  SQL Server  SQL Server  Collect TempDB Object Stats. Set this
option to True. This may be done at the global, site, or target level.

The TempDB Objects charts provide a breakdown of the various TempDB objects by type ( User Tables, User
Temp Tables, Global Temp Tables, Internal Tables, System Tables, User Tables, and Query Objects ).

TempDB Objects chart  Reserved Space

TempDB Objects Chart Options

 Note: Use the Objects  menu to view the TempDB Objects chart by Reserved Space,
User Space, Row Count, or Object Count.

Used Space

Row Count

Object Count

Additional Information: See the Tables article on Microsoft Docs to learn more about these table
objects.

TempDB Activity
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This chart provides a high-level view of the type and level of activity occurring in tempdb.

TempDB Activity chart

TempDB Activity Metrics
Active Temp Tables
The number of active temp tables (system or user-generated) that exist.

Non-snapshot Version Transactions
The number of active transactions that are using the TempDB version store, but are not part of Read
Committed Snapshot Isolation (RCSI). The Non-snapshot Version Transactions metric paints an overall
profile of the server workload.

 Note: If you're not running RCSI or doing any snapshot level isolation on a system, this value is
usually caused by triggers. Triggers use snapshot isolation, so this can be a top source of TempDB
consumption if you have a lot of triggers.
Additional Information: See the How Does SQL Server 2019 Accelerated Database Recovery Affect
TempDB and TempDB Parasites blog posts for examples of triggers using TempDB.

Snapshot Transactions
The number of active transactions that are using the TempDB version store as part of RCSI. This is an explicit
representation of RCSI or snapshot isolation overhead.

TempDB Activity chart showing a spike in Active Temp Tables and Snapshot Transactions
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Additional Information: See the SQL Server, Transactions Object article on Microsoft Docs to learn
more about the TempDB Activity metrics.

TempDB Session Usage
 Note:
TempDB Session Usage must be enabled through Settings.
Go to Settings Pane  SQL Server  SQL Server  Collect Session TempDB Usage. Set
this option to True. This may be done at the global, site, or target level.
On older versions, it was located under Settings Pane  SQL Server  Miscellaneous
 Collect Session TempDB Usage.
This feature requires SQL Server 2012 or later on the watched target.

This chart shows details related to the number of sessions that were using space in TempDB, as well as how
much of TempDB was in use, grouped by the Host, Application, and Login. Use this information to
understand if there were a small number of sessions with each consuming a large amount of space, or many
sessions, each consuming a small amount of space that caused a large amount of consumption when
aggregated.

TempDB Session Usage table

 Note: The values in the TempDB Session Usage table represent the aggregated consumption over
the time period in the top navigation bar, or highlighted time period from the TempDB Summary or
TempDB Activity charts. Highlight a duration on either the charts and select Filter from the context
menu to filter into a specific period of time.
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TempDB Session Usage showing a highlighted time frame from the TempDB Activity chart

Note that selecting TempDB from this context menu will zoom the TempDB Summary and TempDB
Activity charts into the highlighted time period.

TempDB Session Usage Metrics
Column

Description

Host

The server or workstation name associated with the session(s).

Application

The name of the application associated with the session(s).

Login

The login name associated with the session(s).

Total TempDB

Aggregate of all TempDB allocations (in MB) that occurred during the
defined range.

Active TempDB

Aggregate of allocations (in MB) that were active during the defined
range. This removes deallocated usage from the total to provide the
active consumption for the associated session(s) by showing only the
allocations since the last collection of metrics.
The maximum amount of memory granted (in MB) for the associated
session(s) during the defined range.

Max Granted Mem

Total Time

 Note: Insufficient memory grants are a common cause of spills to
TempDB. The insufficient memory grants are caused by poor estimates,
which may be caused by inaccurate statistics, missing indexes, and similar
scenarios. Consider using Plan Explorer to learn more about your queries,
including estimated vs. actual plans and indexes and statistics.
Aggregate of all time spent on the associated session(s) during the
defined range.
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Column

Description

Total CPU

Aggregate of all scheduled CPU time (in milliseconds) for the associated
session(s) during the defined range.

Total Reads (L)

Aggregate of logical reads completed for the associated session(s) during
the defined range.
Aggregate of physical writes completed for the associated session(s)
during the defined range.

Total Writes (P)

Total TempDB User

Total TempDB Internal

 Note: The writes may be coming from operations or snapshot
isolation which explicitly use TempDB. You can correlate this value
against other metrics (e.g. Snapshot Transactions, Non-snapshot
Version Transactions, Version Store, and Query Objects) to get a
better picture of your Total Writes (P). If the writes are coming from
queries that are unintentionally spilling to TempDB, these are often
query tuning opportunities.
Aggregate of all space (in MB) reserved or allocated for user objects (e.g.
table variables, temporary tables, etc.) by the associated session(s) and
task(s) during the defined range.
Aggregate of all space (in MB) reserved or allocated for internal objects
(e.g. work tables, work files, etc.) by the associated session(s) and task(s)
during the defined range.

Active TempDB User

Aggregate of all space (in MB) reserved or allocated for currently active
user objects (e.g. table variables, temporary tables, etc.) by the
associated session(s) and task(s) during the defined range.

Active TempDB Internal

Aggregate of all space (in MB) reserved or allocated for currently active
internal objects (e.g. work tables, work files, etc.) by the associated
session(s) and task(s) during the defined range.

Session Count

The number of sessions associated with this aggregation during the
defined range.

 See the following articles on Microsoft Docs for additional information about the TempDB Session
Usage metrics:
sys.dm_exec_sessions
sys.dm_db_session_space_usage
sys.dm_db_task_space_usage

TempDB Data Retention
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The counter and session data collected for TempDB in SQL Sentry follows the standard Performance Analysis
Dashboard Retention & Resolution data retention policies.

TempDB Collection Settings
TempDB Session Usage collection must be enabled through the Collect TempDB Session Usage
option in the Settings pane.
The TempDB Session Usage charts are not populated when this is turned off.
It is turned off by default.
TempDB Object Statistics collection must be enabled through the Collect TempDB Object Stats
option in the Settings pane.
The TempDB Objects charts are not populated when this is turned off.
It is turned off by default.
In some environments, you may experience issues with a query that starts with this text data:

WITH tempdbObjects AS... being logged in SQL Sentry when collecting these statistics. See the
tempdbObjects Query section in the Troubleshooting article for more information.

Additional TempDB Monitoring
You have access to additional TempDB monitoring through the following features in the SQL Sentry client.

Top SQL
Top SQL in the SQL Sentry client allows you to view Tempdb Internal (KB), Tempdb Internal (KB) Dealloc,
Tempdb User (KB), and Tempdb User (KB) Dealloc metrics within the grid.

Example of TempDB metrics in Top SQL

 Note: You can highlight an area of activity and use the context menu to jump to Top SQL within SQL
Sentry Portal for that time to get more information about queries and wait stats.
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Jump to Top SQL from TempDB Activity

Disk Space Analysis
The Disk Space tab shows a high-level status of TempDB consumption, including the number of TempDB files.

Disk Activity Analysis
The Disk Activity tab shows a high-level status of TempDB activity .

SQL Server Metrics
Many SQL Server metrics on the dashboard can be correlated to TempDB as explained in the SQL Sentry
Performance Metrics article.

Advisory Conditions
The default advisory conditions pack includes the following TempDB conditions to allow you to create alerts
related to the size and number of TempDB files:
Tempdb Data Files
Tempdb Large Version Store
Tempdb Low Unallocated Page Count
Tempdb Unequal File Size
Tempdb/CPU Configuration Warning
Tempdb/CPU Configuration Warning > 8 CPUs

Reporting
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The TempDB metrics collected are available via the Performance Counter History report in SQL Sentry
Reporting.

Report example:

529

SQL Sentry Client Interface
Last Modified on 17 May 2021

The SQL Sentry client interface is divided into three main areas:
Positioned along the left side of the client are the Navigator, Event View, and Plan History panes.
Positioned in the center of the client is the workspace area. The SQL Sentry client has been designed
with an enhanced multiple document interface (MDI).
Positioned along the right side of the client are the Conditions and Settings panes.

SentryOne Client Interface
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Working With Panes
Panes within the SQL Sentry Client can be enabled or disabled. The pushpin feature

can be used to auto-

hide the panes allowing for a larger workspace area. These panes can be moved, docked, and resized allowing
the workspace to be customized to best fit your work style. If the panes are closed they can easily be restored
from the View menu.

Workspace Layout
The dimensions of the client panes and workspace area are saved automatically when you close the client.
Select Tools > Reset Layout to restore the default configuration.

Status Bar
At the bottom of the SQL Sentry client is a status bar divided into four sections:

Client Status Bar

Status Bar Section

Description

Left Section

Current status for the active view. If you recently refreshed the time or went
to a new window, it says Refreshing History Data or Refreshing Sample
Data.

Middle Section

Current progress for the active view.

Right Section

Displays if the software is up-to-date when the client has access to the
internet.
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Status Bar Section

Client Alerts Indicator

Description
A red indicator means there are errors
A yellow indicator means there are warnings
A green indicator means there are no errors or warnings
Additional Information: For more information about the Client Alerts
indicator, see the Client Alerts article.
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SQL Sentry Menu Options
Last Modified on 19 August 2021

The menus and toolbars are used to operate the SQL Sentry client. The options available within the menus
vary depending on the active window. For more information about the toolbars, see the Toolbars topic.
The following are descriptions of the commands found in the various SQL Sentry menus.

File Menu

Option

Description

Hotkey

New Target

Adds a new target to the Navigator pane.

N/A

New Plan Explorer Session

Opens a new Plan Explorer session.

N/A

Open

Opens execution plan files.

N/A

Connect to an Installation

Specifies the SQL Sentry database and authentication
information for the client.

N/A

Save

Saves changes to the active window.

CTRL
+S

Save As

Renames and saves the active view.

N/A

Save View As

Renames and saves the existing view.

N/A

Close

Closes the active window.

CTRL
+W
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Option

Description

Hotkey

Export Data

Exports event list views and various tabs of performance
analysis.

CTRL
+E

Page Setup

Sets the page options for printing.

N/A

Print

Prints the active window.

N/A

Print Preview

Previews the active window for printing, exporting, and
send email options.

N/A

Recent Files

Displays a list of recently opened Plan Explorer files.

N/A

Exit

Closes the SQL Sentry Client.

CTRL
+Q

View Menu

Option

Description

Navigator

Displays the Navigator pane.

Event View

Displays the Event View pane.

Plan History

Displays the Plan History pane.

Conditions

Displays the Conditions pane.

Settings

Displays the Settings pane.

Start Page

Displays the Start Page.
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Calendar Menu

Option

Description

Show Conflicts

Explores conflicts for specified time ranges.

View Style

Selects the view style for the Event Calendar.

Reports Menu
For more information about the reporting options in SQL Sentry, see the Reporting topic.

Option

Description

Events

Generate an Event Calendar associated report.

Performance Analysis

Generate a Performance Analysis associated report.

General

Generate a General settings report.

Report Deployment Settings

Settings for the SQL Server report server location that deploys your
reports.

Deploy Reports

Deploys the reports to the location specified in the Report
Deployment settings.

Import Reports

Imports future reports created by the SQL Sentry development team.
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Tools Menu

Option

Description

Hotkey

User Preferences

Opens the SQL Sentry Client User Preferences window and
allows you to configure your preferences.

CTRL
+O

Find Object

Opens the Event Object Search window that finds event
objects within the SQL Sentry client.

CTRL
+F

Manage Response Rulesets

Opens all response rulesets for editing.

N/A

Reset Event View Filter

Restores the event view filter settings to default.

N/A

Reset Layout

Restores the layout to default.

N/A

Download Latest Custom
Conditions Pack

Downloads the latest custom condition pack from SQL
Sentry.

N/A

Unsnooze All

Allows all snoozed SQL Sentry actions to occur again.

N/A

Window Menu
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Option

Description

Cascade

Cascades active windows in the workspace view.

Tile Vertical

Tiles active windows vertically in the workspace view.

Tile Horizontal

Tiles active windows horizontally in the workspace view.

Tabbed

Displays active windows on tabs in the workspace view.

Show Tabs on Multiple
Lines

Displays multiple rows of tabs.

Auto-rotate Performance
Advisor Tabs

Auto-rotates through the active performance analysis windows when
enabled. The rotation doesn't change the active tab of a performance
analysis window. Whichever tab is selected as active refreshes as the
windows rotate.

Active Windows Name

Displays all active windows.

Help Menu
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Option

Description

Hotkey

SQL Sentry Help

Opens the SQL Sentry user documentation.

CTRL
+H
or F1

Check for Updates

Connects with SQL Sentry's online database and verifies
that you have the latest version.

N/A

Manage Licenses

Opens the SolarWinds License Manager where you can view
and manage SQL Sentry licenses.

N/A

Logging

Options to enable trace logging for the SQL Sentry client
and monitoring service for troubleshooting purposes.
Contact support before you enable logging. Logs are stored
in the interactive user's AppData\Local\SentryOne
directory.

N/A

About

Displays current version, licensing information, and
expiration.

N/A
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SQL Sentry Toolbars
Last Modified on 19 August 2021

Save and Print Toolbar Buttons
The following describes the Save and Print toolbar buttons:

Button

Name

Description

Save

Universal save button.

Print Preview

Displays a print preview window for the selected object.

Print

Prints the selected object.

New Plan Explorer
Session

Opens a New Plan Explorer session window.

Open Plan File

Open an existing Plan Explorer session file.

Navigation Toolbar
The Navigation toolbar is used for navigating throughout the calendar view as well as performance graphs
and runtime stats, and it changes depending on what you're viewing.

 Note: The date and time text are highlighted in bold when the time crosses a clock change (i.e.
Daylight Saving Time). In 2021, Daylight Saving Time began on March 14 at 2:00 AM. When the time
range crosses that period, it appears in bold text.

Date/Time Selector
The date/time selector controls allow you to jump to a specific date or time and select the desired time
interval.
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Button

Name

Description

Date Selector

Selects the date to view on the calendar.

Time Selector

Selects the time to view on the calendar.

Go

Moves the calendar to display the time selected in the
date/time selector, maintaining the currently selected
interval.

Go to Current
Time

Jumps directly to the current time, maintaining the
current selected time slice and interval, unless the
interval is greater than one hour in which case one hour is
used.

When you select the date selector, a small calendar appears. Select any day and select the right and left
arrows to change the month. Select the bold today text at the bottom to auto-select the current day. You can
also enter values for the day or year directly.
To navigate to a specific time on the selected day, select the time selector by choosing a time increment
(hour, minute, etc.), use the up/down arrow, or type in a new value.

 Important: The workspace view doesn't refresh until you have completed your selections and select
Go.

Interval Selector
The interval selector is used to zoom the current time interval in or out.

Button

Name

Description

One Minute View

Displays the calendar in a one-minute interval.

Ten Minute View

Displays the calendar in a 10-minute interval.

One Hour View

Displays the calendar in a one-hour interval.

Four Hour View

Displays the calendar in a four-hour interval.

One Day

Displays the calendar in a one-day interval.
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Miscellaneous
Controls
Name
Description
Button
Button

Name

Description

Days Selector

Sets the total range of days to display on the calendar or graph.
Select either arrow to decrease or increase the value, or type in a
new value. The maximum value is 30 days. The currently selected
interval (one minute to four hours) as well as the start time of the
range is maintained when changing the number of days

Previous
Interval

Navigates backward in time to the previous interval.

Previous Small
Interval

Navigates backward in time using a smaller interval.

Next Interval

Navigates forward in time to the next interval.

Next Small
Interval

Navigates forward in time using a smaller interval.
Refreshes the active workspace view by retrieving the latest
information from the SQL Sentry database.
Hold down the CTRL key when you select it to force a hard refresh.
This causes the SQL Sentry client to connect directly to and collect

Refresh

event data from the target instance in case the monitoring service
is down.
 Note: Not available on custom event views or views with
multiple instances.

View Conflicts

Displays all schedule conflicts for the selected instance. For more
information, see the Conflict Viewer topic.

View Toolbar
Select from the Calendar, List, or Split views. The active range note changes only the format in which the
event data displays. For more information, see the Calendar view topic.

Performance Analysis Toolbar
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The performance analysis tabs can be synchronized to view performance data for a historical period or in a
real time mode for the previous 10 minutes. This is coordinated using the toolbar. See the following toolbar
chart:

#

Name

Description

1

Print Preview

Print preview is not active in performance analysis.

2

Print

Print function is not active in performance analysis.

3

New Plan Explorer Session

Opens a new Plan Explorer session.

4

Open Plan File

Opens an execution plan file.

5

Save

Saves an execution plan file.

6

Start Date

Sets the beginning date for viewing a range of
performance related data.

7

Start Time

Sets the beginning time for viewing a range of
performance related data

8

End Date

Sets the end date for viewing a range of performance
related data.

9

End Time

Sets the end time for viewing a range of performance
related data.

10

Go

Activates the selected start/end time range.

11

Go To Current Time

Moves forward so that the display range ends at the
current time.

12

Zoom Out

Increases the date range.

13

Zoom In

Decreases the date range.

14

Previous Interval

Skips back in time one full interval.

15

Previous Small Interval

Skips back in time one small unit of the interval scale.

16

Next Small Interval

Skips forward in time one small unit of the interval scale.

17

Next Interval

Skips forward in time a full interval.
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#

Name

Description

18

Synchronize Tabs

Automatically sets all tabs to the active date range
(enabled by default).

19

Start Auto-refresh

Enables automatic updating of real time data for the
current tab, or all tabs if synchronize tabs is enabled.

20

Pause Auto-refresh

Pauses automatic updating of real time data for the
current tab, or all tabs if synchronize tabs is enabled.

21

Refresh

Refreshes the active view by retrieving the latest data for
the active date range.

22

Show History

Toggles between history and sample modes when on the
dashboard.

23

Show Windows Processes

Opens the current Windows processes for the server.

24

Jump to Calendar

Opens the calendar tab in the workspace area.

25

Show Custom Condition
Markers

Enables and disables custom condition glyphs and event
markers

26

Show Windows + SQL
Server Performance

Opens a Windows + SQL Server Performance report.
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SQL Sentry Navigator Pane
Last Modified on 19 August 2021

The Navigator pane is the tree-view pane positioned on the left side of the client by default. The various
nodes within the Navigator pane are used as the starting point in directing many functions of the SQL Sentry
client, such as viewing an event calendar or a performance analysis dashboard. The navigator nodes are also
used as the starting point to access the various levels of conditions and settings within the Alerting and
Responses System. Right-clicking on a node accesses its context menu.

Navigator Pane Overview

Navigator Pane Elements
Each object in your SQL Sentry enterprise has an associated icon. Several of the node icons in the Navigator
pane vary based on conditions, such as instance or watched status.

Instance Status
Button

Description
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Button

Description
Indicates that the instance has an online status.
Indicates that the instance has an offline status.
Indicates that the instance requires attention. Often associated with the SQL
Server agent being offline.
Indicates that the instance has a watched status, but it isn't being actively
monitored. This can happen if the monitoring service has stopped or the instance
belongs to a site without an active monitoring service.

 Note: Instance status is determined by the SQL Sentry Monitoring Service's ability to collect
information from the instance.

The following is a simplified version of how instance status information is obtained and displayed in the SQL
Sentry client.
1. The SQL Sentry monitoring service gathers instance status information.
2. The instance status information is written to the SQL Sentry database.
3. The SQL Sentry client retrieves the instance status information from the database and displays it.

 Note: Select any instance node to access additional status information. A tool tip displays the status
(offline/online), the last monitoring service, instance time, and any applicable error information.

Watched Status
 Important: A target must be set to watched before SQL Sentry begins monitoring it.

To watch a target, right-click the target. You can also hide unwatched targets so they don't display in the
Navigator pane by selecting Tools > User Preferences > Navigator > Hide Unwatched Instances. For more
information about watching targets and objects, see the Watching Instances and Objects topic.
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Watching a Target

Button

Navigator User Preferences

Description

Indicates that the instance/object isn't being watched.

Indicates that instance/object is being watched.

Instance Icons
Instance types are represented with various icons.

Button

Description
SQL server instance
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Button

Description
Analysis services instance
Windows instance

Red Text in the Navigator Pane
If the label text for a node is red it indicates that an event object has a recent failure. Failures cascade from
the object level up to the highest group level containing the object.
Right-click on the event object, and select Cleared Failed Status to clear a job failure.

Adjust how long failures display in the Navigator pane through Tools > User Preferences > Navigator >
Highlight Event Failures in Navigator for.
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Snoozing Objects in the Navigator Pane
All Targets (global), sites, groups, and targets, can be snoozed with a right-click context menu in the
Navigator pane. Snoozing an object prevents any SQL Sentry actions from occurring while the snooze is in
effect. The snooze status is inherited by objects lower in the hierarchy. For example, snoozing the All
Targets (global) node effectively stops all SQL Sentry actions in the environment for the duration of the
snooze.
End snooze early by right-clicking a snoozed object.

 Note: Monitor the Snooze status of an object with the Audit: Settings Changed audit condition
and Log to Database action. With this condition and action configured, changing the Snooze status of
an object results in a record of this change logged to the database. For more information about
snoozing an object, see the Conditions pane topic.
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SQL Sentry Conditions Pane
Last Modified on 19 August 2021

The Conditions pane is displayed on the right side of the SQL Sentry client by default, and its scope is
determined by items selected in the Navigator pane. The Conditions pane is used to configure actions in
response to conditions being met as part of the SQL Sentry Alerting and Response System. Actions can be
defined in response to certain conditions being met within your environment. Choose from a variety of
actions, depending on which condition is being responded to.
All conditions work on the principle of inheritance. This means that if you configure an action in response to a
condition being met at the global level (All Targets), it automatically passes down to all applicable objects
beneath it. Define global conditions for the most common issues across your environment once and have
those passed down to every monitored server automatically. Further refine conditions at each level as
needed. For a visual representation of how inheritance works within SQL Sentry, see the alerting and
response system hierarchy diagram.
Each condition that you configure in your environment will have an associated behavior. The behavior controls
how the condition is carried out relative to any inherited conditions. There are three condition behaviors
available:
Override inherited actions
Combine with inherited actions
Disabled
For a complete explanation and example usage scenarios for each behavior, see the Action Behavior topic.

View Menu
The Conditions pane is displayed on the right side of the screen by default. If you don't see the Conditions
pane, use the View menu (View > Conditions). Each condition type has an associated actions tab where
actions can be configured in response to conditions being met. The following are types of conditions:
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Condition
Type

Description

Inherited
Condition

Displays the configured actions
that are inherited by the
currently selected object.

Explicit

Displays the configured actions
that are explicitly set at the
current object level.

Additional Info

Configured actions in the Inherited
section have a status column that
indicates if they apply to the currently
selected object.
Configured actions with an enabled status
have green text.
Configured actions with a disabled status
are grayed out.

An action that is explicitly disabled has red
text.
Configured actions with an enabled status
have green text.

Snoozing a Condition/Action
Conditions/Actions can be snoozed or suppressed for a period of time by right-clicking on the
condition/action in the Conditions pane and selecting one of the following options:

551

Snooze Context Menu Option

Description

Snooze this Condition/Action
Combination

Snoozes the specific condition/action that is selected.

Snooze this Condition for All
Actions

Snoozes all instances of the selected condition regardless of the
action assigned to it.

Snooze this Action for All
Conditions

Snoozes all instances of the selected action regardless of the
condition assigned to it.

Additionally, select whether the snooze affects just the hierarchical object that you selected ( site, group,
target, or instance) or if it affects all objects.

 Note: Conditions that have been snoozed have a gray background in the Conditions pane.

Once a condition/action is snoozed, right-click on the snoozed object and select Unsnooze to unsnooze the
object.
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Alternatively, unsnooze all snoozed conditions/actions through Tools > Unsnooze All.
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SQL Sentry Event Calendar View
Last Modified on 17 May 2021

Event Calendar Pane
The Event Calendar pane is used to filter what is shown in the event calendar. Select the Event Calendar tab
at the bottom of the Navigator pane to open the Event Calendar, or select View > Event Calendar.

Select View Event Calendar from the
Menu options

Select Event Calendar from the
Navigator Pane

 Note: The Event Calendar tab is active when viewing the event calendar. The tabs at the top help to
filter items in the event calendar.

The following are descriptions for the various Event Calendar tabs:

Event
Calendar tab

Description

Image
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Event
Calendar tab

Description

Filter

Used for general filter settings including run status,
review status, duration, and open text filters.

Properties

Displays a description of the view along with time
settings and an object count.

Connections

Displays the instances and instance text filters for the
current view.

Objects

Displays individual event objects added to the current
view.

Event
Sources

Allows you to determine the display properties of each
event source.

Image

Tab Formatting
The formatting of the tab text indicates whether certain filters are enabled or disabled:
If an event source is deselected, the tab name is gray.
If any objects or categories are selected for a source, the tab name is bold.
Additionally, any runtime or other filters set on the filter tab cause that tab name to bold.

Activating Filters
After making filter selections, activate the filter by selecting Apply Filter near the bottom of the filter menu.
When the filter is active, Apply Filter has a blue background.

 Note: Runtime filters don't affect status event objects .
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Using Text Filters
Multiple keywords are separated with a semicolon ( ; ). A plus sign ( + ) is used in front of any keyword(s) that
you want to apply using an And operator. Otherwise the keyword is applied with an Or operator. Text filters
can be applied to the following:
The event object name
The step text
The name of the object owner

 Note: If filters are entered in two or more of these text boxes, they will be applied with an
And operator.

Removing Filters
Any filter settings can be removed from the active view by selecting Remove Filter.

 Note: The Remove Filter button isn't available on custom Event Calendars and other views
containing multiple instances. This ensures a filter is always applied to these views, minimizing the
chance of overloading the SQL Sentry client with too much event data.

Saving a Filter as a View
To save the active filter settings to a custom Event Calendar, select Save View As from the File menu.

Properties Tab
The Properties tab displays basic descriptive information about the current view. Additionally, this tab
provides controls to set the default time slice for this view. This allows you to specify the number of days,
amount of time, and start time shown for this view every time it is opened.
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 Note: When a performance monitor is placed on a custom Event Calendar, it is applied to all
monitorable objects within the view. The View Totals box, at the bottom, allows you to see exactly how
many objects are monitored.

The following are descriptions of the view totals values:

View Total Value

Description

Connections

Total number of SQL Server instances and Windows instances associated with the
view.

Objects From
Instances

Gives a count of all objects from those instances that meet the filter criteria.

Individual
Objects

Number of objects added by the Edit Individual Objects button.

Total Objects

Total objects in the view.
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View Total Value

Description

Total Monitored
Objects

Total amount of objects that actually have performance monitors attached to
them.

Total
Monitorable

Total number of objects that have performance monitors attached to them (SQL
agent jobs, reporting services reports, and Windows tasks).
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SQL Sentry Settings Pane
Last Modified on 19 August 2021

Introduction
The Settings pane is where settings are configured for instances, sources, and objects. This tab is also where
performance counter thresholds are configured when a counter is selected. Settings can be configured
globally, at the instance level, or at the object level, and just like conditions, they work on the principle of
inheritance. The scope is determined by items selected in the Navigator pane. For more information, see the
Conditions pane topic.

Opening the Settings Pane
The Settings pane and Navigator pane are docked on the Start Page of the SQL Sentry client by default.
Select the Settings tab to display the settings pane.

Example of the Settings pane in the SQL Sentry client

 Note: If the Settings pane does not open on your default installation, select View > Settings on the
toolbar to display it. Select the desired site, group, target, or instance to begin configuring your
settings.
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Settings from the View menu

Amazon RDS for SQL Server
The following settings are configurable for Amazon RDS for SQL Server:

Amazon RDS for SQL Server

Site/Group

Global

Target

Miscellaneous Settings
Level
Configurable

Setting

Definition

Auto-enable SQL Server
Agent Tokens

Whether or not to enable SQL Server Agent
Tokens on SQL Server 2005 instances.

Global

Auto-recycle large SQL
Server Agent Logs

Whether or not to automatically recycle large
agent log files in SQL Server 2005 or greater.

Global

Collect Session TempDB
Usage

Set to True to turn on data collection for
TempDB Usage and populate the TempDB
Session Usage table.

Global
Site/Group
Target

Collect TempDB Object
Stats

Set to True to turn on data collection for
TempDB Usage and populate the TempDB
Object Stats charts.

Global
Site/Group
Target

See the Troubleshooting article for more
guidance on this setting.

560

Level
Configurable

Setting

Definition

Maximum Queue Length

The maximum number of objects that can be
queued at one time. This setting always applies
to the connection level.

Global
Site/Group
Target

Inherit from Parent (Global)

Specifies whether miscellaneous settings are
inherited from the parent object.

Site/Group
Target

Synchronization
Level
Configurable

Setting

Definition

Max User Databases to
Synchronize (largest first)

The maximum number of databases to
synchronize, ordered by total size. This includes
system databases.

Global
Site/Group
Target

Max User Database Files to
Synchronize ( most active &
largest first)

The maximum number of user database files to
synchronize (most active & largest first).

Global
Site/Group
Target

Inherit from Parent (Global)

Specifies whether Synchronization settings are
inherited from the parent object.

Site/Group
Target

Maintenance Window
Level
Configurable

Setting

Definition

Maintenance Window

The maintenance window for watched instances.
Only Log actions will be triggered for Failsafe
conditions inside the maintenance window. Send,
Execute, and other actions will not be triggered.

Global
Site/Group
Target

Inherit from Parent (Global)

Specifies whether Maintenance Window settings
are inherited from the parent object.

Site/Group
Target

Databases Source
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Site/Group

Global

Target

General Settings
Level
Configurable

Setting

Definition

Enable Table/ Index Data
Collection

Specifies whether table and index collection is
enabled. If disabled no index management
functions will be performed.

Global
Site/Group
Target

Max Partitions to Collect Per
Database

The maximum partitions to collect.

Global
Site/Group
Target

Min Index Size (MB) to
Collect Fragmentation Data

The minimum size of the index in MB to be
considered for defrag.

Global
Site/Group
Target

Max Index Size (MB) to
Collect Fragmentation Data

The maximum size of the index in MB to be
considered for defrag.

Global
Site/Group
Target

Collecting detailed buffer information is
inherently a low overhead process. However,
since it takes approximately 1 second per GB of
buffer, on larger buffers the associated query
can take some time to complete, which may
Collect Buffer Data when
Buffer >8GB

cause it to appear in Top SQL and or generate
associated alerts. It is generally safe to enable

Global
Site/Group
Target

this setting, since SQL Sentry ensures that the
total time spent per day collecting buffer data
will be roughly the same regardless of buffer
size, and that collection only occurs when the
buffer has changed.
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Level
Configurable

Setting

Definition

Inherit From Parent

Specifies whether the general database source
settings are inherited from the parent object.

Site/Group
Target

Deadlocks Source

Global

Site/Group

Target

Synchronization
Level
Configurable

Setting

Definition

History Filter

The filter used for history synchronization. Only
events that meet the filter will be written to the
database.

Global
Site/Group
Target

Inherit from Parent (Global)

Specifies whether the maximum row count
settings are inherited from the parent object.

Site/Group
Target

Collection Settings
Setting

Definition

Collect Deadlock Events

Specifies whether the deadlock statement
collection is enabled.

Inherit from Parent (Global)

Specifies whether the deadlock settings are
inherited from the parent object.

Level
Configurable
Global
Site/Group
Target

Site/Group
Target

Index Defragmentation
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Site/Group

Global

Target

General Defrag Settings
Level
Configurable

Setting

Definition

Primary Schedule

The schedule on which index analysis and or
defrag will be performed, according to the
configured reorg and rebuild thresholds.

Global
Site/Group
Target

Options for Analyze Only and Analyze & Defrag .

Global
Site/Group
Target

Operation Type

See the Fragmentation Manager article for more
details.

Reanalyze Indexes After
Defrag

Specifies whether to run the fragmentation
analysis again after defrag.

Global
Site/Group
Target

Fragmentation Scan Mode

The scan mode used when scanning for
fragmentation.

Global
Site/Group
Target

Maximum Concurrent
Operations

The maximum concurrent operations to run on a
SQL Server Instance.

Global
Site/Group
Target

Delay Between Defrag
Operations

When Maximum Concurrent Operations is set to
1, you can specify a delay between defrag
operations to prevent send/redo queue overload
when availability groups or mirroring are in use.

Global
Site/Group
Target

Maximum Duration

The maximum allowed runtime for the
defragmentation process.

Global
Site/Group
Target
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Setting

Definition

Level
Configurable

Partitions (Enterprise Only)

Which partitions to include for defragmentation.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the general database settings
are inherited from the parent object.

Site/Group
Target

Index Reorg Settings
Level
Configurable

Setting

Definition

Reorg Threshold %

The maximum fragmentation percentage before
an index reorg is performed.

Global
Site/Group
Target

Reorg Schedule

Dedicated schedule on which reorgs only will be
performed, according to the reorg threshold.
Rebuilds will not be performed even if the
rebuild threshold has been exceeded.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the index reorg settings are
inherited from the parent object.

Site/Group
Target

Index Rebuild Settings
Level
Configurable

Setting

Definition

Rebuild Threshold %

The maximum fragmentation percentage before
an index rebuild is performed.

Global
Site/Group
Target

Rebuild Schedule

Dedicated schedule on which rebuilds only
(online or offline) will be performed, according
to the rebuild threshold.

Global
Site/Group
Target

Offline Rebuild Window

If an offline rebuild will be performed as the
result of the primary schedule, then only start
the offline rebuild during this window.

Global
Site/Group
Target
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Setting

Level
Configurable

Definition

Sort in tempdb

Specifies whether to use the tempdb for sorting.

Global
Site/Group
Target

Use Online Rebuild
(Enterprise Only)

Specifies whether to rebuild the index while
online (Enterprise Only).

Global
Site/Group
Target

MAXDOP (Enterprise Only)

The max degree of parallelism to use during the
rebuild.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the index reorg settings are
inherited from the parent object.

Site/Group
Target

Top SQL

Global

Site/Group

Target

Runtime Thresholds
Setting

Definition

Level
Configurable

Maximum Duration
Threshold

The maximum allowed duration for the object.

Global
Site/Group
Target

Maximum Duration
Threshold Percent

The maximum allowed duration percentage for
the object.

Global
Site/Group
Target

The minimum allowed duration for the object.

Global
Site/Group
Target

Minimum Duration
Threshold
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Level
Configurable

Setting

Definition

Minimum Duration
Threshold Percent

The minimum allowed duration percentage for
the object.

Global
Site/Group
Target

Inherit From Parent

Specifies whether the duration thresholds
settings are inherited from the parent object.

Site/Group
Target

Top SQL Source

Site/Group

Global

Target

Collection Settings
Level
Configurable

Setting

Definition

Minimum Duration

The minimum required duration for a statement
to be logged.

Global
Site/Group
Target

Minimum CPU

The minimum required CPU for a statement to be
logged.

Global
Site/Group
Target

Minimum Reads

The minimum reads required for a statement to
be logged.

Global
Site/Group
Target

Minimum Writes

The minimum required writes for a statement to
be logged.

Global
Site/Group
Target
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Setting

Definition

Level
Configurable

Collect Trace Events

Specifies whether traces events are collected.

Global
Site/Group
Target

Collect Statement Events

Specifies whether statement events are
collected.

Global
Site/Group
Target

Running Events Polling
Interval

Specifies how often the service checks for
running events.

Global
Site/Group
Target

Collect Execution Plans

Specifies whether execution plans are collected.
Running queries will not be captured if this is set
to false.

Global
Site/Group
Target

Max Plan Size to Collect
(MB)

Specifies the max plan size to collect in MB.

Global
Site/Group
Target

Collect Query Stats

Specifies whether query stats collection is
enabled.

Global
Site/Group
Target

Query Stats Sample Interval

Specifies how often to sample query stats.

Global
Site/Group
Target

Filter Time Span

The Filter Time Span specifies the base length of
time over which the collection filters will be
applied to Query Stats. See Filter Factor for more
details.

Global
Site/Group
Target

Filter Factor

The Filter Factor is calculated by dividing the
Query Stats Sample Interval by the Filter Time
Span. The collection filters such as Minimum
Duration are multiplied by this value when
applied to Query Stats collection. For example,
using the defaults (Query Stats Sample Interval =
60 Seconds, Filter Time Span = 30 Seconds,
Minimum Duration = 5 Seconds) the total
cumulative duration of all executions of a query
over the 60 second sample interval must be
greater than 10 seconds.

Global
Site/Group
Target
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Level
Configurable

Setting

Definition

Inherit From Parent (Global)

Specifies whether the Top SQL settings are
inherited from the parent object.

Site/Group
Target

Analytics Platform System Instance
The following settings are configurable for Analytics Platform System instances:

Analytics Platform System

Site/Group
Global

Collection Settings
Setting

Definition

Level
Configurable

Monitor Performance

Controls whether performance monitoring is
enabled.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether collection settings are
inherited from the parent object.

Site/Group
Target

Definition

Level
Configurable

Maintenance Window
Setting

Maintenance Window

The maintenance window for targets. Only Log
actions will be triggered for Failsafe conditions
inside the maintenance window. Send, Execute,

Global
Site/Group
Target

and other actions will not be triggered.
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Level
Configurable

Setting

Definition

Inherit From Parent (Global)

Specifies whether maintenance window settings
are inherited from the parent object.

Site/Group
Target

APS Distributed Queries

Site/Group
Global

Runtime Thresholds
Setting

Level
Configurable

Definition

The maximum allowed duration for the object.

Global
Site/Group
Target

Minimum Duration
Threshold

The minimum allowed duration for the object.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the duration threshold
settings are inherited from the parent object.

Site/Group
Target

Maximum Duration
Threshold

APS Distributed Queries Source

Global

Site/Group

Queries Settings
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Level
Configurable

Setting

Definition

Minimum Duration

The minimum required duration for a statement
to be logged.

Global
Site/Group
Target

SQL Request Plan Collection
Enabled

This will enable collection of compute node level
execution plans.

Global
Site/Group
Target

Collect Distributed Queries
Errors

This will collect and show errors for distributed
queries.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the Top SQL Settings are
inherited from the parent object.

Site/Group
Target

APS Health Alerts Source

Site/Group
Global

Synchronization
Level
Configurable

Setting

Definition

History Filter

The filter used for history synchronization. Only
events that meet the filter will be written to the
database.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the maximum row count
settings are inherited from the parent object.

Site/Group
Target

APS Loader Backup Run
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Site/Group

Global

Runtime Thresholds
Setting

Level
Configurable

Definition

Maximum Duration
Threshold

The maximum allowed duration for the object.

Global
Site/Group
Target

Maximum Duration
Threshold Percent

The maximum allowed duration percentage for
the object.

Global
Site/Group
Target

Minimum Duration
Threshold

The minimum allowed duration for the object.

Global
Site/Group
Target

Minimum Duration
Threshold Percent

The minimum allowed duration percentage for
the object.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the duration threshold
settings are inherited from the parent object.

Site/Group
Target

Azure SQL Data Warehouse Instance
The following settings are configurable for Azure SQL Data Warehouse instances:

Azure SQL Data Warehouse

Global

Site/Group

Target
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Collection Settings
Level
Configurable

Setting

Definition

Monitor Performance

Controls whether performance monitoring is
enabled.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether collection settings are
inherited from the parent object.

Site/Group
Target

Maintenance Window
Level
Configurable

Setting

Definition

Maintenance Window

The maintenance window for targets. Only Log
actions will be triggered for Failsafe conditions
inside the maintenance window. Send, Execute,
and other actions will not be triggered.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether maintenance window settings
are inherited from the parent object.

Global
Site/Group
Target

Azure SQL Data Warehouse Distributed Queries

Global

Site/Group

Target

Runtime Thresholds
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Setting

Level
Configurable

Definition

Maximum Duration
Threshold

The maximum allowed duration for the object.

Global
Site/Group
Target

Minimum Duration
Threshold

The minimum allowed duration percentage for
the object.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the duration threshold
settings are inherited from the parent object.

Site/Group
Target

Azure SQL Data Warehouse Distributed Queries Source

Site/Group

Global

Target

Queries Settings
Level
Configurable

Setting

Definition

Minimum Duration

The minimum required duration for a statement
to be logged.

Global
Site/Group
Target

SQL Request Plan Collection
Enabled

This will enable collection of compute node level
execution plans.

Global
Site/Group
Target

Collect Distributed Queries
Errors

This will collect and show errors for distributed
queries.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the Top SQL settings are
inherited from the parent object.

Site/Group
Target
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Azure SQL Data Warehouse Loader Backup Run

Site/Group

Global

Target

Runtime Thresholds
Setting

Definition

Level
Configurable

Maximum Duration
Threshold

The maximum allowed duration for the object.

Global
Site/Group
Target

Maximum Duration
Threshold Percent

The maximum allowed duration percentage for
the object.

Global
Site/Group
Target

Minimum Duration
Threshold

The minimum allowed duration for the object.

Global
Site/Group
Target

Minimum Duration
Threshold Percent

The minimum allowed duration percentage for
the object.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the duration threshold
settings are inherited from the parent object.

Site/Group
Target

Azure SQL Database Instance
The following settings are configurable for Azure SQL Database instances:

Azure SQL Database

575

Site/Group

Global

Target

Miscellaneous

 Note: To provide the best experience, some features of monitoring an Azure SQL database require a
few small tables and procedures to be stored in the target database. These objects are created and
maintained in a SQL Sentry schema. If you choose not to allow the monitoring objects to be created, the
features dependent upon them (e.g., Top SQL collection) are disabled for the target database. This is set
to False by default, but it can be changed globally or overridden at the target level.

Setting

Allow SQL Sentry monitoring
objects in target

Definition
In order to provide the best experience, some
features of monitoring an Azure SQL Database
require a few small tables and procedures to be
stored in the target database. These objects will
be created and maintained in a SQL Sentry
schema. If you choose to not allow the
monitoring objects to be created, the features
dependent upon them will be disabled for the
target database.

Level
Configurable

Global
Site/Group
Target

Additional Information: See the Watched
Target Objects article for a complete list of
database objects that are placed on the
watched target.
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Setting

Definition

Collect Session TempDB
Usage

Set to True to turn on data collection for
TempDB Usage and populate the TempDB
Session Usage table.

Collect TempDB Object
Stats

Set to True to turn on data collection for
TempDB Usage and populate the TempDB
Object Stats charts.

Level
Configurable
Global
Site/Group
Target

Global
Site/Group
Target

See the Troubleshooting article for more
guidance on this setting.

Inherit From Parent

Specifies whether miscellaneous settings are
inherited from the parent object.

Site/Group
Target

Collection Settings
Level
Configurable

Setting

Definition

Monitor Performance

Controls whether performance monitoring is
enabled.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether collection settings are
inherited from the parent object.

Site/Group
Target

Maintenance Window
Level
Configurable

Setting

Definition

Maintenance Window

The maintenance window for targets. Only Log
actions will be triggered for Failsafe conditions
inside the maintenance window. Send, Execute,
and other actions will not be triggered.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether maintenance window settings
are inherited from the parent object.

Site/Group
Target

Blocking SQL
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Site/Group

Global

Target

Runtime Thresholds
Setting

Level
Configurable

Definition

Maximum Duration
Threshold

The maximum allowed duration for the object.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the duration threshold
settings are inherited from the parent object.

Site/Group
Target

Blocking SQL Source

Site/Group

Global

Target

Collection Settings
Setting

Definition

Minimum Block Duration

The time required to trigger a block condition.

Inherit From Parent (Global)

Specifies whether the blocking settings are
inherited from the parent object.

Level
Configurable
Global
Site/Group
Target

Site/Group
Target

Top SQL
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Site/Group

Global

Target

Runtime Thresholds
Setting

Level
Configurable

Definition

Maximum Duration
Threshold

The maximum allowed duration for the object.

Global
Site/Group
Target

Maximum Duration
Threshold Percent

The maximum allowed duration percentage for
the object.

Global
Site/Group
Target

Minimum Duration
Threshold

The minimum allowed duration for the object.

Global
Site/Group
Target

Minimum Duration
Threshold Percent

The minimum allowed duration percentage for
the object.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the duration threshold
settings are inherited from the parent object.

Site/Group
Target

Top SQL Source

Global

Site/Group

Target

Collection Settings
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Level
Configurable

Setting

Definition

Minimum Duration

The minimum duration required for a statement
to be logged.

Global
Site/Group
Target

Minimum CPU

The minimum CPU required for a statement to be
logged.

Global
Site/Group
Target

Minimum Reads

The minimum required reads for a statement to
be logged.

Global
Site/Group
Target

Minimum Writes

The minimum required writes for a statement to
be logged.

Global
Site/Group
Target

Collect Trace Events

Specifies whether trace events are collected.

Global
Site/Group
Target

Collect Statement Events

Specifies whether statement events are
collected.

Global
Site/Group
Target

Running Events Polling
Interval

Specifies how often the service checks for
running events.

Global
Site/Group
Target

Collect Execution Plans

Specifies whether execution plans are collected.
Running queries will not be captured if set to
false.

Global
Site/Group
Target

Max Plan Size to Collect
(MB)

Specifies the max plan size to collect in MB.

Global
Site/Group
Target

Collect Query Stats

Specifies whether query stats collection is
enabled.

Global
Site/Group
Target
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Setting

Definition

Level
Configurable

Query Stats Sample Interval

Specifies how often to sample query stats.

Global
Site/Group
Target

Filter Time Span

Specifies the base length of time over which the
collection filters will be applied to Query Stats.
See Filter Factor for more details.

Global
Site/Group
Target

The Filter Factor is calculated by dividing the
Query Stats Sample Interval by the Filter Time
Span. The collection filters such as Minimum
Duration are multiplied by this value when
applied to Query Stats collection.
Filter Factor

Inherit From Parent (Azure
DB)

For example, using the defaults (Query Stats
Sample Interval = 60 Seconds, Filter Time Span =
30 Seconds, Minimum Duration = 5 Seconds) the
total cumulative duration of all executions of a
query over the 60 second sample interval must
be greater than 10 seconds.
Specifies whether the Top SQL settings are
inherited from the parent object.

Global
Site/Group
Target

Site/Group
Target

Event Chain
The following settings are configurable for Event Chains:

Event Chain
Level
Configurable

Setting

Definition

Maximum Runtime
Threshold

The maximum allowed runtime for the chain.

Global

Minimum Runtime Threshold

The minimum allowed runtime for the chain.

Global

Event Chain Node
The following settings are configurable for Event Chain Nodes:
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Event Chain Node
Level
Configurable

Setting

Definition

Maximum Runtime
Threshold

The maximum allowed runtime for the chain
node.

Global

Minimum Runtime Threshold

The minimum allowed runtime for the chain
node.

Global

SQL Server
The following settings are configurable for SQL Server:

SQL Server

Global
Site/Group

Target

Miscellaneous
Setting

Definition

Level
Configurable
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Setting

Definition

Level
Configurable

Whether or not to enable SQL Server Agent
Tokens on SQL Server 2005 instances.

 Important: On SQL Server 2005 and
above, SQL Server Agent tokens are disabled
as a security measure. They must be enabled
to allow SQL Sentry to watch alerts on these
Auto-enable SQL Server
Agent Tokens

servers. Selecting True allows SQL Sentry to
automatically enable these tokens when an
alert is watched on a 2005 and above server.

Global
Site/Group
Target

Additional Information: For more
information about SQL Server Agent Tokens,
see SQL Server Books Online.

Auto-recycle large SQL
Server Agent Logs

Whether or not to automatically recycle large
agent log files in SQL Server 2005 or greater.

Collect Session TempDB
Usage

Set to True to turn on data collection for
TempDB Usage and populate the TempDB
Session Usage table.

Collect TempDB Object
Stats

Set to True to turn on data collection for
TempDB Usage and populate the TempDB
Object Stats charts.

Global
Site/Group
Target

Global
Site/Group
Target

Global
Site/Group
Target

See the Troubleshooting article for more
guidance on this setting.
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Setting

Definition

Level
Configurable

This setting specifies the maximum number of
jobs that can be queued at one time on this
server. For more information, see the Job
Queuing topic.

Maximum Queue Length

This setting is used to provide more detail than
the basic cleaner memory data, but it is higher
overhead to collect. Use caution when enabling
this setting to ensure it doesn't impact

Global
Site/Group
Target

performance. The default value for this setting is
False.
 Note: The default value for this setting is 5.

Inherit From Parent

Specifies whether miscellaneous settings are
inherited from the parent object.

Site/Group
Target

Synchronization
Level
Configurable

Setting

Definition

Max User Databases to
Synchronize (largest first)

The maximum number of databases to
synchronize, ordered by total size. This includes
system databases.

Global
Site/Group
Target

Max User Database Files to
Synchronize (most active &
largest first)

The maximum number of user database files to
synchronize (most active & largest first).

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether synchronization settings are
inherited from the parent object.

Site/Group
Target

Maintenance Window
Setting

Definition

Level
Configurable
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Level
Configurable

Setting

Definition

Maintenance Window

The maintenance window for targets. Only Log
actions will be triggered for Failsafe conditions
inside the maintenance window. Send, Execute,
and other actions will not be triggered.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether maintenance window settings
are inherited from the parent object.

Site/Group
Target

Blocking SQL

Site/Group

Global

Target

Runtime Thresholds
Setting

Level
Configurable

Definition

Maximum Duration
Threshold

The maximum allowed duration for the object.

Global
Site/Group
Target

Inherit From Parent

Specifies whether the duration threshold
settings are inherited from the parent object.

Site/Group
Target

Blocking SQL Source

Global

Site/Group

Target

Runtime Thresholds
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Setting

Level
Configurable

Definition

Minimum Block Duration

The time required to trigger a block condition.

Global
Site/Group
Target

Inherit From Parent

Specifies whether the blocking settings are
inherited from the parent object.

Site/Group
Target

Databases Source

Global

Site/Group

Target

General Settings
Level
Configurable

Setting

Definition

Enable Table/ Index Data
Collection

Specifies whether table and index collection is
enabled. If disabled no index management
functions will be performed.

Global
Site/Group
Target

Max Partitions to Collect per
Database

The maximum partitions to collect.

Global
Site/Group
Target

Min Index Size (MB) to
Collect Fragmentation Data

The minimum size of the index in MB to be
considered for defrag.

Global
Site/Group
Target

Max Index Size (MB) to
Collect Fragmentation Data

The maximum size of the index in MB to be
considered for defrag.

Global
Site/Group
Target
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Level
Configurable

Setting

Definition

Collect Buffer Data when
Buffer > 8GB

Collecting detailed buffer information is
inherently a low overhead process. However,
since it takes approximately 1 second per GB of
buffer, on larger buffers the associated query
can take some time to complete, which may
cause it to appear in Top SQL and or generate
associated alerts. It is generally safe to enable
this setting, since SQL Sentry ensures that the
total time spent per day collecting buffer data
will be roughly the same regardless of buffer
size, and that collection only occurs when the
buffer has changed.

Global
Site/Group
Target

Inherit From Parent

Specifies whether the general database source
settings are inherited from the parent object.

Site/Group
Target

Deadlocks Source

Site/Group

Global

Target

Synchronization
Level
Configurable

Setting

Definition

History Filter

The filter used for history synchronization. Only
events that meet the filter will be written to the
database.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the maximum row count
settings are inherited from the parent object.

Site/Group
Target

Collection Settings
Setting

Definition

Level
Configurable

587

Level
Configurable

Setting

Definition

Collect Deadlock Events

Specifies whether the deadlock statement
collection is enabled.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the deadlock settings are
inherited from the parent object.

Site/Group
Target

Index Defragmentation

Site/Group

Target

Global

General Defrag Settings
Level
Configurable

Setting

Definition

Primary Schedule

The schedule on which index analysis and/or
defrag will be performed, according to the
configured reorg and rebuild thresholds.

Global
Site/Group
Target

Options for Analyze Only and Analyze & Defrag .

Global
Site/Group
Target

Operation Type

See the Fragmentation Manager article for more
details.

Reanalyze Indexes After
Defrag

Specifies whether to run the fragmentation
analysis after defrag.

Global
Site/Group
Target

Fragmentation Scan Mode

The scan mode used when scanning for
fragmentation.

Global
Site/Group
Target
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Level
Configurable

Setting

Definition

Maximum Concurrent
Operations

The maximum concurrent operations to run on a
SQL Server Instance.

Delay Between Defrag
Operations

When Maximum Concurrent Operations is set to
1, you can specify a delay between defrag
operations to prevent send/redo queue overload
when availability groups or mirroring are in use.

Maximum Duration

The maximum allowed runtime for the
defragmentation process.

Global
Site/Group
Target

Partitions (Enterprise Only)

Which partitions to include for defragmentation.

Global
Site/Group
Target

Inherit From Parent

Specifies whether the general database settings
are inherited from the parent object.

Site/Group
Target

Global
Site/Group
Target

Global
Site/Group
Target

Index Reorg Settings
Setting

Definition

Level
Configurable

Reorg Threshold %

The maximum fragmentation percentage before
an index reorg is performed.

Global
Site/Group
Target

Reorg Schedule

Dedicated schedule on which reorgs only will be
performed, according to the reorg threshold.
Rebuilds will not be performed even if the
rebuild threshold has been exceeded.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the index reorg setting are
inherited from the parent object.

Site/Group
Target

Definition

Level
Configurable

Index Rebuild Settings
Setting
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Level
Configurable

Setting

Definition

Rebuild Threshold %

The maximum fragmentation percentage before
an index rebuild is performed.

Global
Site/Group
Target

Rebuild Schedule

Dedicated schedule on which rebuilds only
(online or offline) will be performed, according
to the rebuild threshold.

Global
Site/Group
Target

Offline Rebuild Window

If an offline rebuild will be performed as the
result of the primary schedule, then only start
the offline rebuild during this window.

Global
Site/Group
Target

Sort in tempdb

Specifies whether to use tempdb for sorting.

Global
Site/Group
Target

Use Online Rebuild
(Enterprise Only)

Specifies whether to rebuild the index while
online (Enterprise Only).

Global
Site/Group
Target

MAXDOP (Enterprise Only)

The max degree of parallelism to use during the
rebuild.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the index reorg settings are
inherited from the parent object.

Site/Group
Target

Maintenance Plans Source

Site/Group

Global

Target

General
Setting

Definition

Level
Configurable

590

Level
Configurable

Setting

Definition

Auto-watch New Objects

Whether or not new objects will be set to
watched when they are discovered.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether general settings are inherited
from the parent object.

Site/Group
Target

Synchronization
Level
Configurable

Setting

Definition

Maximum Rows to
Synchronize

The maximum rows of historical event data to
collect from this source. This settings is most
applicable to the initial loading process, since
subsequent synchronizations will only include
new records. Use care when increasing this value
– If it is set too high database content can result.

Inherit From Parent (Global)

Specifies whether the maximum row count
settings are inherited from the parent object.

Global
Site/Group
Target

Site/Group
Target

Reporting Services Report

Site/Group

Global

Target

Runtime Thresholds
Setting

Maximum Runtime
Threshold

Definition

The maximum allowed duration for the object.

Level
Configurable
Global
Site/Group
Target
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Setting

Definition

Level
Configurable

The maximum allowed duration percentage for
the object. See the warning below.

Maximum Runtime
Threshold Percent

Minimum Runtime Threshold

Minimum Runtime Threshold
Percent

 Note: The default value is 250. This means
that any time a job runs for less than 10 (default
Minimum Runtime Threshold Percent) or
longer than 250 percent of its average runtime, a
notification is sent. If too many messages are
being received, these settings can be adjusted as
needed.

The minimum allowed duration for the object.

The minimum allowed duration percentage for
the object.

Global
Site/Group
Target

Global
Site/Group
Target

Global
Site/Group
Target

 Note: The default value is 10.

Inherit From Parent (Global)

Specifies whether the runtime threshold settings
are inherited from the parent object.

Site/Group
Target

 Important: For the Maximum Runtime Threshold Percent setting, in cases where the average
runtime for a job is less than 30 seconds, a maximum allowed runtime value of two minutes is used
regardless of the Maximum Runtime Threshold Percent setting value.
If you wish to avoid this, you can do either of the following:
1. Use the Maximum Runtime Threshold setting rather than Maximum Runtime Threshold Percent
setting.
2. Use a Response Ruleset for the SQL Server Agent Job: Runtime Threshold Max condition that
delays alerting until the jobs have run for a duration the user defines.
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Explicit time-based thresholds can also be specified. Any time an explicit time-based threshold is
specified it overrides the percentage-based thresholds for that object. Time-based thresholds are
usually less valuable at the global level, particularly the Minimum Runtime Threshold that doesn't
have much value globally. Explicit runtime thresholds tend to be more applicable at the actual
instance or object level for overriding the global percentage thresholds on a case-by-case basis.

 Note: Runtime threshold messages for Reporting Services Reports completing in less than two
minutes aren't processed until they are complete.

Reporting Services Reports Source

Site/Group

Global

Target

General
Level
Configurable

Setting

Definition

Auto-watch New Objects

Whether or not new objects will be set to
watched when they are discovered.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether general settings are inherited
from the parent object.

Site/Group
Target
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Synchronization
Setting

Maximum Rows to
Synchronize

Level
Configurable

Definition
The maximum rows of historical event data to
collect from this source. This settings is most
applicable to the initial loading process, since
subsequent synchronizations will only include
new records. Use care when increasing this value
– If it is set too high database content can result.

Global
Site/Group
Target

 Note: The default is 5000.

History Filter

The filter used for history synchronization. Only
events that meet the filter will be written to the
database.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the maximum row count
settings are inherited from the parent object.

Site/Group
Target

SQL Agent Alerts Source

Site/Group

Global

Target

General
Level
Configurable

Setting

Definition

Auto-watch New Objects

Whether or not new objects will be set to
watched when they are discovered.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether general settings are inherited
from the parent object.

Site/Group
Target

Synchronization
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Level
Configurable

Setting

Definition

Maximum Rows to
Synchronize

The maximum rows of historical event data to
collect from this source. This settings is most
applicable to the initial loading process, since
subsequent synchronizations will only include
new records. Use care when increasing this value
– If it is set too high database content can result.

Global
Site/Group
Target

History Filter

The filter used for history synchronization. Only
events that meet the filter will be written to the
database.

Global
Site/Group
Target

Inherit From Parent

Specifies whether the maximum row count
settings are inherited from the parent object.

Site/Group
Target

SQL Server Agent Job

Site/Group

Global

Target

Runtime Thresholds
Setting

Definition

Level
Configurable

Maximum Duration
Threshold

The maximum allowed duration for the object.

Global
Site/Group
Target

Maximum Duration
Threshold Percent

The maximum allowed duration percentage for
the object.

Global
Site/Group
Target

The minimum allowed duration for the object.

Global
Site/Group
Target

Minimum Duration
Threshold

595

Level
Configurable

Setting

Definition

Minimum Duration
Threshold Percent

The minimum allowed duration percentage for
the object.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the runtime threshold settings
are inherited from the parent object.

Site/Group
Target

Behavior when Queuing Other Jobs
Level
Configurable

Setting

Definition

Queue Other For Up To

The maximum length of time this job will queue
other jobs.

Global
Site/Group
Target

Auto-Start Threshold

Any job whose next scheduled run time is
beyond the specified threshold will be started
automatically upon leaving the queue. If a job’s
next scheduled run time is before the threshold
it will not auto-start.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the queuing behavior is
inherited from the parent object.

Site/Group
Target

Behavior When This Job is Queued
Setting

Definition

Level
Configurable

Queue Type

The behavior when this job is queued.

Global
Site/Group
Target

Queue For Up To

The maximum length of time this job can be
queued.

Global
Site/Group
Target

Auto-Start Type

Controls the auto-start behavior for the job when
it leaves the queue. “Use default setting” will
cause the queuing job’s “Auto-Start Threshold”
setting to be used.

Global
Site/Group
Target
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Level
Configurable

Setting

Definition

Inherit From Parent (Global)

Specifies whether the behavior when queued is
inherited from the parent object.

Site/Group
Target

SQL Server Agent Jobs Source

Site/Group

Global

Target

General
Level
Configurable

Setting

Definition

Auto-watch New Objects

Whether or not new objects will be set to
watched when they are discovered.

Global
Site/Group
Target

Missed Run Threshold

The length of time that must pass before an
object run is considered to be missed.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether general settings are inherited
from the parent object.

Site/Group
Target

Synchronization
Setting

Definition

Maximum Rows to
Synchronize

The maximum rows of historical event data to
collect from this source. This settings is most
applicable to the initial loading process, since
subsequent synchronizations will only include
new records. Use care when increasing this value
– If it is set too high database content can result.

Level
Configurable

Global
Site/Group
Target
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Level
Configurable

Setting

Definition

Inherit From Parent (Global)

Specifies whether the maximum row count
settings are inherited from the parent object.

Site/Group
Target

SQL Server Agent Log Source

Site/Group

Global

Target

General
Setting

Definition

Level
Configurable

Auto-watch New Objects

Whether or not new objects will be set to
watched when they are discovered.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether general settings are inherited
from the parent object.

Site/Group
Target

Setting

Definition

Level
Configurable

Maximum Rows to
Synchronize

The maximum rows of historical event data to
collect from this source. This settings is most
applicable to the initial loading process, since
subsequent synchronizations will only include
new records. Use care when increasing this value
– If it is set too high database content can result.

Global
Site/Group
Target

History Filter

The filter used for history synchronization. Only
events that meet the filter will be written to the
database.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the maximum row count
settings are inherited from the parent object.

Site/Group
Target

Synchronization
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Top SQL
Setting

Level
Configurable

Definition

Site/Group

Global

Target

Runtime Thresholds
Setting

Level
Configurable

Definition

Maximum Duration
Threshold

The maximum allowed duration for the object.

Global
Site/Group
Target

Maximum Duration
Threshold Percent

The maximum allowed duration percentage for
the object.

Global
Site/Group
Target

Minimum Duration
Threshold

The minimum allowed duration for the object.

Global
Site/Group
Target

Minimum Duration
Threshold Percent

The minimum allowed duration percentage for
the object.

Global
Site/Group
Target

Inherit From Parent

Specifies whether the duration threshold
settings are inherited from the parent object.

Site/Group
Target

Top SQL Source

Target
Global

Site/Group
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Collection Settings
Level
Configurable

Setting

Definition

Minimum Duration

The minimum required duration for a statement
to be logged.

Global
Site/Group
Target

Minimum CPU

The minimum required CPU for a statement to be
logged.

Global
Site/Group
Target

Minimum Reads

The minimum required reads for a statement to
be logged.

Global
Site/Group
Target

Minimum Writes

The minimum required writes for a statement to
be logged.

Global
Site/Group
Target

Specifies whether trace events are collected.

Global
Site/Group
Target

Collect Trace Events

Specifies whether statement events are
collected.

 Warning: On systems with very high
transaction volumes that also make
extensive use of scalar functions, enabling

Collect Statement Events

Collect Statement Events may cause a
negative impact on the performance of the
monitored target, regardless of the
effective Top SQL Filter settings or the
number of events actually collected. For

Global
Site/Group
Target

more information, see Improve SQL Sever
Scalar UDF Performance in SQL Server 2019,
and Four Ways to improve Scalar function
performance in SQL Server.
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Level
Configurable

Setting

Definition

Running Events Polling
Interval

Specifies how often the service checks for
running events.

Global
Site/Group
Target

Collect Execution Plans

Specifies whether execution plans are collected.
Running queries will not be captured if this
setting is set to false.

Global
Site/Group
Target

Max Plan Size to Collect
(MB)

Specifies the max plan size to collect in MB.

Global
Site/Group
Target

Collect Query Stats

Specifies whether query stats collection is
enabled.

Global
Site/Group
Target

Query Stats Sample Interval

Specifies how often to sample query stats.

Global
Site/Group
Target

Filter Time Span

Specifies the base length of time over which the
collection filters will be applied to Query Stats.
See Filter Factor for more details.

Filter Factor

The Filter Factor is calculated by dividing the
Query Stats Sample Interval by the Filter Time
Span. The collection filters such as Minimum
Duration are multiplied by this value when
applied to Query Stats collection. For example,
using the defaults (Query Stats Sample Interval =
60 Seconds, Filter Time Span = 30 Seconds,
Minimum Duration = 5 Seconds) the total
cumulative duration of all executions of a query
over the 60 second sample interval must be
greater than 10 seconds.

Global
Site/Group
Target

Inherit From Parent

Specifies whether Top SQL Settings are inherited
from the parent object.

Site/Group
Target

Global
Site/Group
Target

SQL Server Analysis Services
The following settings are configurable for SQL Server Analysis services:
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Analysis Services

Site/Group

Global

Target

Miscellaneous
Level
Configurable

Setting

Definition

Collect Memory by Category
Data

Memory by Category data provides more detail
than the basic Cleaner memory data, but is
higher overhead to collect. Use caution when
enabling to ensure it does not impact
performance.

Global
Site/Group
Target

Inherit From Parent

Specifies whether miscellaneous settings are
inherited from the parent object.

Site/Group
Target

Maintenance Window
Level
Configurable

Setting

Definition

Maintenance Window

The maintenance window for watched instances.
Only Log actions will be triggered for Failsafe
conditions inside the maintenance window. Send,
Execute, and other actions will not be triggered.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether maintenance window settings
are inherited from the parent object.

Site/Group
Target

Top Commands

Global

Site/Group

Target
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Runtime Thresholds
Setting

Level
Configurable

Definition

Maximum Duration
Threshold

The maximum allowed duration for the object.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the duration threshold
settings are inherited from the parent object.

Site/Group
Target

Top Commands Source

Site/Group

Global

Target

Collection Settings
Level
Configurable

Setting

Definition

Minimum Duration

The minimum required duration for a statement
to be logged.

Global
Site/Group
Target

Collect
MDX/DAX/DMX/XMLA
Events

Specifies whether the command collection is
enabled.

Global
Site/Group
Target

Collect DAX Query Plan
Events

Specifies whether DAX Query Plan events are
captured. Note that collecting query plans for
complex DAX queries can have a negative impact
on performance and should only be enabled for
troubleshooting purposes.

Global
Site/Group
Target

Inherit From Parent

Specifies whether the SSAS settings are
inherited from the parent object.

Site/Group
Target

Tintri
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The following settings are configurable for Tintri:

Tintri VMstore

Site/Group

Global

Collection Settings
Level
Configurable

Setting

Definition

Monitor Performance

Controls whether performance monitoring is
enabled.

Global
Site/Group
Target

Maintenance Window
Level
Configurable

Setting

Definition

Maintenance Window

The maintenance window for targets. Only Log
actions will be triggered for Failsafe conditions
inside the maintenance window. Send, Execute,
and other actions will not be triggered.

Global
Site/Group
Target

VMware
The following settings are configurable for VMware:

VMware Host

Global

Site/Group
Target
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Collection Settings
Setting

Definition

Level
Configurable

Monitor Performance

Controls whether performance monitoring is
enabled.

Global
Site/Group
Target

Setting

Definition

Level
Configurable

Maintenance Window

The maintenance window for targets. Only Log
actions will be triggered for Failsafe conditions
inside the maintenance window. Send, Execute,
and other actions will not be triggered.

Global
Site/Group
Target

Maintenance Window

Windows
The following settings are configurable for Windows:

Windows Computer

Site/Group

Global

Target

Collection Settings
Level
Configurable

Setting

Definition

Monitor Performance

Controls whether performance monitoring is
enabled.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether collection settings are
inherited from the parent object.

Site/Group
Target
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Maintenance Window
Level
Configurable

Setting

Definition

Maintenance Window

The maintenance window for targets. Only Log
actions will be triggered for Failsafe conditions
inside the maintenance window. Send, Execute,
and other actions will not be triggered.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether maintenance window settings
are inherited from the parent object.

Site/Group
Target

Process Collection
Setting

Level
Configurable

Definition

Collect Processes

Specifies whether process collection is enabled.

Global
Site/Group
Target

Uncategorized Process Filter

The filter controls which uncategorized
processes are collected. Categorized or wellknown processes are always collected. Once a
process has passed the filter, it will continue to
be collected until it completes.

Global
Site/Group
Target

Inherit From Parent

Specifies whether process collection settings are
inherited from the parent object.

Site/Group
Target

Windows Event Logs Source

Site/Group

Global

Target

General
Setting

Definition

Level
Configurable
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Level
Configurable

Setting

Definition

Auto-watch New Objects

Whether or not new objects will be set to
watched when they are discovered.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether general settings are inherited
from the parent object.

Site/Group
Target

Synchronization
Level
Configurable

Setting

Definition

Maximum Rows to
Synchronize

The maximum rows of historical event data to
collect from this source. This setting is most
applicable to the initial load process, since
subsequent synchronizations will only include
new records. Use care when increasing this value
– if it is set too high database contention can
result.

Global
Site/Group
Target

History Filter

The filter used for history synchronization. Only
events that meet the filter will be written to the
database.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the maximum row count
settings are inherited from the parent object.

Site/Group
Target

Windows Task

Site/Group

Global

Target

Runtime Thresholds
Setting

Definition

Level
Configurable
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Level
Configurable

Setting

Definition

Maximum Runtime
Threshold

The maximum allowed duration for the object.

Global
Site/Group
Target

Maximum Runtime
Threshold Percent

The maximum allowed duration percentage for
the object.

Global
Site/Group
Target

Minimum Runtime Threshold

The minimum allowed duration for the object.

Global
Site/Group
Target

Minimum Runtime Threshold
Percent

The minimum allowed duration percentage for
the object.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the runtime threshold settings
are inherited from the parent object.

Site/Group
Target

Windows Task Source

Site/Group

Global

Target

General
Level
Configurable

Setting

Definition

Auto-watch New Objects

Whether or not new objects will be set to
watched when they are discovered.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether general settings are inherited
from the parent object.

Site/Group
Target
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Synchronization
Level
Configurable

Setting

Definition

Maximum Rows to
Synchronize

The maximum rows of historical event data to
collect from this source. This settings is most
applicable to the initial load process, since
subsequent synchronizations will only include
new records. Use care when increasing this value
– if it is set too high database contention can
result.

Global
Site/Group
Target

Inherit From Parent (Global)

Specifies whether the maximum row count
settings are inherited from the parent object.

Site/Group
Target

Performance Counter Settings
The Performance Counter settings screen is used to set the minimum and maximum values for the counter
thresholds of that particular counter. These are used to trigger the Performance Counter: Threshold Min and
Max conditions if any conditions are enabled for them. This option is only available when selecting a specific
performance counter from the Navigator pane. The following settings are configurable for Performance
Counters:

Counter Thresholds

Global

Setting

Definition

Level Configurable

Maximum

Maximum performance
counter threshold.

Global

Minimum

Minimum performance
counter threshold.

Global
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SQL Sentry Client Alerts
Last Modified on 24 February 2022

The client alert status indicator is in the bottom right hand corner of the SQL Sentry client. When an alert
status is detected, a pop-up with information about the alert displays. You may choose to:
Pin the alert
Dismiss it
Open the Client Alerts window by selecting the alert text

SQL Sentry Client Alert

SQL Sentry Client Alerts window

Client alerts are designed to provide actionable information about problems in your monitored environment.
To open the Client Alerts window, double-click the status indicator in the bottom right hand of the screen.
You may disable status alert pop-ups or change the recurrence interval through Tools > User Preferences >
System Status.
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The following colors correspond to the different alert levels:

Alert
Level

Description

Green

A green status indicates that there are no alerts.

Yellow

A yellow status is the warning level indicator. Warning level alerts are generated when
there is a problem that limits the full functionality of SQL Sentry. This could include the
SQL Server agent being offline.

Red

A red status is the error level indicator. Error level alerts are generated when there is a
significant problem in your monitored environment, such as when an instance has been
detected as offline, or if there is a problem synchronizing data.
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 Important: To configure notifications for instance status and monitoring service errors, see the
Failsafe Conditions topics.

Concerning the History Synchronization Failed Alert
History Synchronization Failed: Message: SQL Server Agent has information logging turned on. The log will
fill quickly in this state. Agent log history synchronization will be paused until information logging is turned
off.
This error message indicates that information logging is enabled for the SQL Server Agent Log. With this level
of logging enabled, the agent log quickly grows beyond one megabyte in size. The overhead associated with
reading the SQL Server Agent Log when it grows to this size can cause performance problems. SQL Sentry
doesn't synchronize the agent log until information logging is disabled.
Information logging can be turned off by completing the following steps.
1. From SSMS (SQL Server Management Studio), right-click the Error Logs folder within the SQL Server
agent group node for the associated server, and then select Configure.

2. Uncheck Information, and then select OK to save.
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Additional Information: For more information about SQL agent log synchronization issues, see the
History Synchronization Failed article.
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SQL Sentry Data Grids & Filters
Last Modified on 19 August 2021

Overview
On the different tabs in SQL Sentry, various types of grids are used to display data. The grids contain
information applicable to the tab they are on. These grids are customizable and provide the user with a
variety of organizational methods.

 Note: Customize your available grids in SQL Sentry. Add additional columns to the desired grid by
right clicking the column header and then selecting Column Chooser to open the Column Chooser.

Group by
Many of the grids found in SQL Sentry can be grouped by column fields. To group grids by column fields, drag
the column to the title area of the grid. This groups all of the data into the respective categories of the
column selected. The Group By function can also be used by right-clicking on the column header and selecting
the option from the menu.
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Group the queries by dragging a header into the Group by box.

 Note: Hide the Group by box by right clicking the Group by area, and then selecting Hide Group by
box from the context menu.

Sorting
The grids that are shown in SQL Sentry can be sorted easily to organize data. Select the column header to
automatically sort according to the values in that column.

Selecting the same column again toggles between ascending and descending order for data in that field. This
can also be done by right clicking the column header and selecting Sort Ascending or Sort Descending.
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 Note: You can also sort rows by ascending or descending order by selecting the arrow icon on the
desired column header.

Filters
A filter can be used along with different sorting methods to organize data on many of the fields found on
grids in SQL Sentry. The filters show up on applicable column headers on the top right side of the cell when
the mouse is hovering over it. Choose the filter by selecting the small filter button, which brings up the filter
menu options.

Filter Editor is also available by right-clicking the desired column header. This feature allows the user to
specify filter conditions by typing them into the window that opens.
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Exporting Grids
Data grids found in SQL Sentry provide a great deal of information to the user in customizable format. Once
the columns are organized as desired, the user can export the information in a variety of formats.
To export your data, select File from the client toolbar, and then select Export Data.

Give the data a file name, select the desired file type, and then select Save to save your exported data.
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 Note: Supported File Types include:
CSV Files (*.csv)
Microsoft Excel (*.xls)
Adobe Acrobat Files (*.pdf)
Web Pages (*.htm; *.html)

Copying Queries
Copy query cells, rows, or all data by selecting and right clicking a query, and then selecting the desired option
from the context menu.
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Additional Context Menu Options
Access the following additional context menu options by right-clicking a column header in any grid:

Context menu option

Description

Sort Ascending

Sorts the selected
column by ascending
order.

Sort Descending

Sorts the selected
column by
descending order.

Context menu
Image

Option applied
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Context menu option

Description

Clear Sorting

Clears the sorting
options for the
selected column.

Clear All Sorting

Clears all sorting
options for the
selected pane.

Group By This Column

Groups the displayed
information by the
selected column.

Context menu
Image

Option applied
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Context menu option

Description

Show Group By Box

Shows the group by
box for the selected
pane.

Hide Group By Box

Hides the Group by
Box.

Hide This Column

Hides the selected
column.

Column Chooser

Opens the Column
Chooser. The Column
Chooser provides
additional columns to
sort information.

Context menu
Image

Option applied
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Context menu option

Description

Best Fit

Expands the
information for the
selected column.

Best Fit (all columns)

Expands the
information for all
columns.

Filter Editor

Opens the filter
editor.

Show Find Panel

Opens the Find
Panel. Use this panel
to locate specific text
within your selected
pane.

Context menu
Image

Option applied
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Context menu option

Description

Show Auto Filter Row

Opens the Auto Filter
Row. Use the Auto
Filter Row to add
specific filters within
your selected pane.

Reset Grid

Reset the grid to its
default
configuration.

Context menu
Image

Option applied
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SQL Sentry User Preferences
Last Modified on 19 August 2021

User Preferences allows you to customize the behavior and appearance of your SQL Sentry client. Select
User Preferences from the Tools menu to review the User Preferences set in your SQL Sentry client. Select
Restore Defaults to reset all User Preferences to the default value. After making any changes to your User
Preferences, select Save to save your changes.

Calendar Settings

Settings

Description

Calendar Refresh Interval

Sets the refresh rate for the calendar.
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Settings

Description

Show Events As Conflicts After

Specifies the duration that two or more event instances must
overlap before being shown as a conflict.

Show Popups For

Sets the persistence of pop-up messages on the calendar.

Default days for Global and
Group views

Sets the default number of days to display when opening these
views.

Persist Calendar Filter Between
Views

Selects to save the filter settings between views.

Auto-scroll Calendar to Current
Time

Selects to enable auto-scroll for the calendar after there has
been no user activity for a period of time.

Maximum rows to return for
calendar/list views

Limiting this value helps to avoid delays in loading views due to a
large volume of data.

Show Running and Historical
Events in Recurring Window if
Duration Exceeds

Determines what events appear in the recurring window at the
top of the calendar.

Default interval when using
Jump To Instance context menus

Sets the time interval that appears when using Jump
To Instance.

Navigator Settings
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Settings

Description

Highlight Event Failures in
Navigator for

Sets the length of time to display failed events in red within the
Navigator pane. If you enable Until Cleared, failures remain in
red until they are manually cleared.

Automatically clear open
failures if a subsequent run is
successful

If the subsequent run of an object is successful, the node is no
longer marked as failed in the Navigator pane.

Show bold text for failures

Items become bold and red in the event of a failure.

Refresh Failures in Navigator
Every

Specifies how often the Navigator pane refreshes to show
failures.
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Settings

Description

Show failures for Unwatched
Objects

Enables this setting to display unwatched objects in red within
the Navigator pane after failure.

Hide Unwatched Instances

Enables this setting to hide unwatched instances in the
Navigator pane.

Default Event View Style

Selects the default view to show when opening an event
calendar.

Prompt me to select a product
when left-clicking to open a
node

Determines whether or not to prompt for the product to use
when opening an instance. When unchecked, the default view for
device/instance nodes is used.

Default view for
Target/Instance nodes

Determines which action SQL Sentry takes when you select a
target or instance node.

Auto-synch Navigator with the
selected tab

Enables this setting to synch objects selected in the current tab
with the Navigator pane.

Auto-synch Settings/Actions
with the selected tab

Enables this setting to synch objects selected in the current tab
with the Settings and Conditions pane.

Single-click opens new tabs

Enabling this setting allows the opening of new tabs with a single
click.

Persist last "Jump To Time"
value

Enables this setting, and each time Jump to Time is used the
previous time selection is highlighted by default.

Show warning when Alert watch
fails due to disabled SQL Agent
Alert Tokens

If enabled, SQL Sentry warns you if you try to watch an alert on a
SQL Server 2005 and above instance and don't have Agent
Tokens enabled.

Synchronize SQL Server
registrations any time a
registration group is expanded

If enabled, SQL Sentry synchronizes registered servers under the
SQL Servers node any time a registration group is expanded.
When not checked, Synchronize SQL Server Groups can be used
in the Navigator pane to do this.

Manually manage folders for
Reporting Services

Allows you to create and manage folders beneath the reporting
services node.

Default Startup Action

Determines the first tab displayed on startup.

Navigator Refresh Interval

Determines how often the navigator refreshes.

Colors Settings
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Most of the elements in the Event Calendar view may have their colors customized. Beside each color
selection is a Pick button. When you select Pick, the color palette displays. Default is used to reset all colors
to their defaults.

Graphs Settings

Setting

Description

Maximum rows to return for
graphs on Runtime Stats

Limits the amount of data shown in runtime graphs for
performance reasons.

Maximum rows to return for
performance graphs

Limits the amount of data shown in performance graphs for
performance reasons.
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Updates Settings

Setting

Description

Automatically check for
software updates on startup

When checked, SQL Sentry automatically checks for updates on
startup. It's checked by default. An internet connection is
required.

Automatically check for Custom
Conditions Pack updates

When checked, SQL Sentry automatically checks for an updated
custom conditions pack when launching the global level
conditions list. It's checked by default. An internet connection is
required.

System Status Settings

Setting

Description

System Status Refresh Interval

Controls how often the system status screen refreshes.

Show Successful Tasks for up to

Sets the length of time successful tasks display on the System
Status screen.

Disable Status Pop-ups

If enabled, client alert status message pop-ups display.

Client Alert Recurrence Interval

Controls the recurrence interval for alert pop-ups.
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Performance Analysis Settings

Setting

Description

Show Options on Quick Trace
launch

When checked, certain options are available when a quick trace
launches manually. When unchecked, the last options configured
are used. Options include duration, rows to collect, etc.

Tab Auto-rotation Frequency

When used in conjunction with Window > Auto-rotate
Performance Analysis, it determines how often the tab changes.

Overview Refresh Interval

Configures how often data refreshes.
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Setting

Description

Default time span for history
mode

Defines the History Mode dashboard's default time range.

Overview Skin

Selects the skin color for the Performance Analysis
Overview screen.

Warn on Actual Plan Execution

If this option is enabled, when the Actual Plan command is
selected, the user is asked to Confirm Query Execution before
the plan is collected. You can disable these warnings by
unselecting this setting.

Default Actual Plan Collection
Mode

Defines whether live profile data is collected by default when an
actual plan is retrieved.

Live Profile Data Collection
Interval

Defines how often live profile data is collected during query
execution.

Only save history when
command text or connection
settings change

If enabled, query plan sessions only generate history entries
when the command text or connection settings change.

Allow opening multiple
Performance Analysis instances
for the same Target using the
Navigator

If checked, performance analysis tabs are not reused for the same
target.

Default Link Style

Defines how often live profile data is collected during query
execution.

Default Dashboard Mode

Defines the default dashboard mode when opening performance
analysis for a target.

Prompt to Save Session Upon
Exit

If checked, a prompt displays upon an exit to save the active tabs
and panes.
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SQL Sentry Hot Key List
Last Modified on 17 May 2021

The following are the hot keys that are available in SQL Sentry:

Item

Keys

Notes

Help

F1 or Ctrl + H

Opens the User Guide.

Save

Ctrl + S

Saves changes made in the client.

Close

Ctrl + W

Closes the active tab in the client.

Exit

Ctrl + Q

Closes the client.

User
Preferences

Ctrl + O

Opens User Preferences.

Print

Ctrl + P

Opens the Print window.

Find Object

Ctrl + F

Opens the Event Object Search window.

Tab Scroll

Ctrl + Tab

Scrolls through open tabs in the client.

Select All

Ctrl + A

Selects all items in the window (where
applicable).

Copy

Ctrl + C

Copies selected items to the clipboard
(where applicable).

Paste

Ctrl + V

Pastes items from the clipboard (where
applicable).

Add Note
On note dialog:

Ctrl + Alt + N
On note dialog:

Opens the notes interface when an
applicable object is selected.
On note dialog:

- New

- Ctrl + N

- Save

- Ctrl + S

- Delete

- Ctrl + D

- Close

- Ctrl + C

- Opens new note.
- Saves note.
- Deletes note.
- Closes note dialog.
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Item

Keys

Notes

History List
(one day)

Ctrl + Alt + H

Opens the History List view for one day
when an applicable object is selected.

633

SQL Sentry Monitoring Service Settings
Last Modified on 19 April 2022

Applies to: SQL Server, Windows/Hyper-V, SSAS, VMware, Azure SQL Database, Azure Synapse Data
Pool, and APS target types.

Introduction

The SQL Sentry monitoring service is a Windows service installed on one or more servers in your enterprise.
All settings are stored in the SQL Sentry database. The SQL Sentry monitoring service does the following for
each watched instance:
Collects event history
Collects event status
Collects event performance information
Sends notifications
Performs various other tasks related to event management

 Note: The various event metadata and history information collected by the SQL Sentry monitoring
service is stored in a SQL Server database. The number of instances that can be watched in your
environment is controlled by the number of licenses you have purchased.

The SQL Sentry Monitoring Service Settings can be accessed by selecting Global Settings from the Navigator
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pane. By default, the monitoring service settings open to the SMTP Configuration tab.

The SQL Sentry monitoring service settings are global in nature, applying to the entire SQL Sentry installation.
They control the behavior and function of all installed SQL Sentry monitoring services connected to the active
SQL Sentry database.

 Note: Make changes to any desired setting, and then select
setting globally.

from the toolbar to save your

SQL Sentry Monitoring Service Settings Alerting
Email SMTP Configuration
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Additional Information: For information about configuring an SMTP server, see the SMTP
Configuration topic.

You have the option to have email alerts formatted as HTML instead of Plain Text.

SNMP Configuration
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Configure SNMP settings by selecting Global Settings > Alerting tab > SNMP settings.

SNMP Settings
Setting

Description

Determines where the SNMP trap is sent. The default setting (BROADCAST)
sends the trap to all managers. Individual managers can be sent the traps
Hostname

using the individual hostname or IP address.
 Note: Managers included in the BROADCAST group and who are also
listed individually receive two messages for each occurrence.

Port

The port used for transmission of the traps (Default 162).

637

Setting

Description

SNMP MIBS defaults are found in a folder called SNMP MIBs
SNMP MIBS

C:\Program Files\SentryOne\18.0\SNMP MIBs

SNMP Version

The version of SNMP to be used (1, 2C, or 3)

Enabled

This checkbox determines whether or not the trap is enabled.

SNMP v1/2C Configuration
Setting

Description

Community

Enter the community.

SNMP v3 Configuration
Setting

Description
Enter the Engine ID.

Engine ID

 Note: You can also use Generate button to get this value.

Username

Enter the username

Privacy Algorithm

Select the appropriate privacy algorithm

Privacy Password

Enter the privacy password

Hash Algorithm

Select the appropriate hash algorithm (MD5, SHA, or None).

Hash Password

Enter the password.

 Note: You can configure SQL Sentry to send SNMP traps to Splunk.
Splunk is an important tool that aggregates logs and events efficiently and allows you to aggregate
disparate data sources into a comprehensive overview of your environment. SQL Sentry utilizes its
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conditions and actions system where conditions represent the expert knowledge required to determine
if something is actionable, and actions provide the flexibility to act on that event. Set up SQL Sentry and
Splunk to complement one another’s functionality within your enterprise.
Configure SQL Sentry to send SNMP traps to Splunk by completing the following:
1. Configure devices to send SNMP traps.
2. Write the traps to a file for Splunk to index.
3. Monitor the file with Splunk.

Additional Information: For more information about SQL Sentry's functionality with Splunk, see
Enterprise Integration: SQL Sentry, Splunk, and SNMP .

Maintenance Window

Maintenance window settings allow you to specify a time frame where Failsafe notifications are disabled
while daily maintenance activity takes place. This prevents excessive notifications that may occur if a watched
instance is temporarily inaccessible during these activities. Log actions are still enabled during this window,
but any execute or send actions won't fire inside the maintenance window. The maintenance window
specified in this view, under the SQL Sentry monitoring service node, applies to activity on the SQL Sentry
database itself.

 Note: To specify a maintenance window for watched instances / target(s), select Settings tab from
the Settings pane for that instance / target.
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PowerShell

Configure PowerShell Execution settings by selecting Global Settings > Alerting tab > PowerShell.
PowerShell Execution Account

Setting

Description

Username

The global account that the Execute PowerShell Command can be run with.

Password

The password for the Execute PowerShell global account.

Additional Information: For more information about PowerShell, see the PowerShell topic.

Additional Information: For information about setting up a PowerShell account, the benefits of
PowerShell, and PowerShell Security, see the PowerShell MSDN article.

Webhooks
SQL Sentry Global Alerting settings can be configured to send a POST request with a JSON payload of alert
information to your configured destination URL.
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Configure Webhook settings by selecting Global Settings > Alerting tab > Webhooks.

Option

Description

Endpoint Name

The name of your integration that is used to differentiate it from other
integrations.
 Note: The Endpoint Name can be a maximum of 50 characters.
The endpoint where you want your alert request to be sent.

Endpoint URL

 Note: The Endpoint URL must begin with https:// and can be a maximum of
150 characters.
An optional field that's used to compute a unique SQLSentry-webhooksignature header to verify request origins.

Secret Token

Verify and Add

 Note: The secret token is optional. The signature is calculated by hexencoding the SHA-256 hash of the payload and token concatenated together. The
token can be a maximum of 108 characters.
After entering your connection properties, select Verify and Add to add your
webhook endpoint connection. Select Save to save your global settings.
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Option

Description

 Important: If you can't connect to your entered endpoint, you will see the following message:

Select Yes to continue adding the connection.

The following attributes are sent as a part of the JSON POST request:

Attribute

Description

Type

Example

Severity

The severity level of
the triggered event.
For more information
about Severity levels,
see Environment
Health Overview.

String

Info

Content

The overall content of
the webhook
message.

String

See the example request
below.

The time that the
event occurred in
UTC.

DateTime

2021-0818T15:09:19.1091532Z

Message

The description of the
advisory condition
event.

String

Job 'FailedJob' Failed

Condition_Name

The name of the
condition that was
triggered.

String

SQL Server Agent Job:
Failure

Timestamp_UTC
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Attribute

Description

Type

Example

Condition_Description

The description of the
condition that was
triggered.

String

SQL Server Agent Job
failed.

Monitor_Type

The internal
monitoring process
type.

String

EventHistoryMonitor

Monitor_Name

The internal
monitoring process
name. The friendly
named version of
Monitor_Type.

String

Event History Monitor

The name of the
monitored sever
where the event
occurred.

String

TARGET72

Monitor_Description

The description for
Monitor_Type.

String

Processes SQL Sentry
Client message queue
messages.

Monitor_Object_Name

The monitored object
type that triggered
the event.

String

FailedJob

Monitor_Object
_Description

The description of the
monitored object type
that triggered the
event.

String

Processes SQL Sentry
Client message queue
messages.

Monitor_Object_
Parent_Name

The monitored object
parent name.

String

JDOE-HP: SQL Server
Agent Jobs

Generated_By

The SQL Sentry client
name, version, and
target that generated
the event.

String

SolarWinds SQL Sentry
2021.18 Server
[TARGET72]

Version

The version of the
condition that was
triggered.

Number

2021.13.0.29403

Filter

The Condition
Settings Filter applied
to the triggered
condition.

String

Filter1

Monitor_Server_Name
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Attribute

Description

Type

Example

Response_Ruleset

The response ruleset
for the advisory
condition event.

String

Notify Every Time
(default)

Configured_Object_Name

The name of the
target that triggered
the event.

String

TARGET72

Configured_Object_Type

The type of target
that triggered the
event.

String

Windows Computer

Message_Recipients

The recipients that
will be notified of the
event.
 Note: This option
will always display as
null.

String

null

Links

The deep linking to
open the Target
where the event was
triggered in the SQL
Sentry Client.

String

url:sqlsentry:
TARGET72
-HP/SentryOne
Debug/
em/eventview/
?c=2&id=250

Timestamp_Local

The local time when
the alert was
collected by
monitoring service.

DateTime

10/25/2021 11:09:19 AM

Event_Time

The date and time the
event occurred.

DateTime

8/18/2021 11:09:19 AM

End_Time

The date and time the
event ended (if
applicable).

Duration

The duration of the
event.

Debugging_Information

Details debugging
information if the
Monitoring Service is
set to Verbose
logging mode.

DateTime

8/18/2021 11:09:19 AM

String

15 seconds

String

[Response Ruleset
Definition]:\r\nStart
Sending Notifications
After 1 occurrence
within 00:00:01]
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Attribute

Description

Type

Example

Server_Health_Status

The environmental
health overview score
for the monitored
target where the
event occurred.

String

null

Modified_By

The user account that
made modifications to
the advisory
condition.

String

JDOE

Host_Name

The name of the host
server.

String

JDOE(fe80::3093:70b0
:2c1c:e748%26)

Database_Login

The user account used
to login to the SQL
Sentry database.

String

JDOE

Action_Object

The action associated
to the

String

Global

Action_Condition

The name of the
advisory condition
associated to the
captured event.

String

Audit: Notes Changed

Action

The response action
associated to the
advisory condition.

String

Log To Database

TimeSent

The time the webhook
alert message sent.

DateTime

2021-0818T11:09:40.860651904:00

Example Request
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{
"Severity":"Info",
"Content":{
"Timestamp_UTC":"2021-09-30T19:01:45.1710284Z",
"Message":"Global: Actions Changed",
"Condition_Name":"Audit: Actions Changed",
"Condition_Description":"A configured Action was changed for an object.",
"Monitor_Type":"ConsoleMessageQueueProcessor",
"Monitor_Name":"SQL Sentry Client Message Queue Processor",
"Monitor_Server_Name":"JDOE-HP",
"Monitor_Description":"Processes SQL Sentry Client message queue messages.",
"Monitor_Object_Name":"Global",
"Monitor_Object_Description":"Global",
"Monitor_Object_Parent_Name":null,
"Generated_By":"SolarWinds SQL Sentry 2021.18 Server [JDOE-HP]",
"Version":"0.0.0.0",
"Filter":null,
"Response_Ruleset":"Notify Every Time (default)",
"Configured_Object_Name":"Global",
"Configured_Object_Type":"Global",
"Message_Recipients":null,
"Links":null,
"Timestamp_Local":"9/30/2021 3:01:45 PM",
"Event_Time":"9/30/2021 3:01:45 PM",
"End_Time":"9/30/2021 3:01:45 PM",
"Duration":null,
"Debugging_Information":null,
"Server_Health_Status":null
},
"TimeSent":"2021-09-30T15:01:51.9995617-04:00"
}

SQL Sentry Monitoring Service Settings Storage
There are monitoring service settings that control the retention of certain types of data within the SQL Sentry
database. Access these settings by selecting Global Settings > Storage tab.

Storage Setting

Description

Image

Controls the retention of Event Manager data
Keep Event History
For

(Event History data).
 Note: The default value is 30 days.
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Storage Setting

Description

Image

Specifies how long Performance Advisor Top
SQL, Blocking SQL, and Deadlock data is retained
Keep Performance
History For

in the SQL Sentry database. This settings also
applies to Event Manager General Performance
Monitoring data.
 Note: The default value is 15 days.

Keep SolarWinds SQL
Sentry Message
History For

This setting determines how many days worth of
Action Log information is stored.
 Note: The default value is 365 days.

Controls the retention of Index Usage statistics
counter data in Fragmentation Manager.
Keep Index Usage
History For

 Note: The default value is 365 days, the
minimum permitted value is one, and the
maximum permitted value is 396.

 Note: Top SQL, Blocking SQL, and Deadlocks data is also converted to the native Event Calendar
format and then is retained according to the Global Settings > Storage tab> Keep Event History For
setting.

 Note: All other performance data, including data displayed on the performance analysis Dashboard,
isn't affected by Monitoring Service settings. This data is subject to a high performance storage
scheme and internal rollup structure. For more information, see the Dashboard Resolutions/Retention
and Data Capacity Planning topics.

SQL Sentry Monitoring Service Settings Forecasts
See the Monitoring Service Settings section of the Forecasting article for details and instructions.
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SQL Sentry Monitoring Service Settings Privacy

The following settings are available in Global Settings > Privacy tab:

Displays the End User License Agreement.
Allows SQL Sentry to collect anonymous
information about how you use our software.
Un-check the box to stop telemetry. For more
information about telemetry, see the
telemetry topic.

SQL Sentry Monitoring Service Settings Advanced
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SQL Sentry Global Settings > Advanced tab is where you configure settings for the process that polls
watched instances for an active event status.

Setting

Description

Controls how often the SQL Sentry monitoring
service polls each watched instance for event
status information. The polling operations used
Live Event Monitor
Polling Interval

are lightweight; however, the value can be
increased to reduce network activity associated
with the SQL Sentry monitoring service.
 Note: The default Polling Interval is 15
seconds.
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Setting

Description

Controls how often the SQL Sentry Monitoring
History Polling Interval

Service polls each watched instance for event
history information.
 Note: The default value is 30 seconds.

Controls how often the SQL Sentry Monitoring
Service’s internal message queue is checked and
messages are processed. Increasing this setting
effectively lengthens the time between when a
condition is met and any associated actions are
triggered.
SolarWinds SQL Sentry
Message Polling
Interval

 Important: Adjusting the setting up or
down affects overhead on the SQL Sentry
Monitoring Service only, and won’t affect
network or monitoring overhead for
watched instances.

 Note: The default value is five seconds.

TempDB Session Usage
Polling Interval

Controls how often the SQL Sentry Monitoring
service polls each watched instances for tempdb
session usage information. The polling
operations are lightweight, however, the value
can be increased to reduce network activity
associated with the SQL Sentry Monitoring
Service.
 Note: The default value is 20 seconds.
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Setting

Description

Tells chaining how far back in the history to look
when determining whether history entries
should affect chain status. This setting is used as
a fail safe measure if for some reason you were
unable to synchronize with a server for a
specified period of time. Whenever the server
comes back online and SQL Sentry is able to resynchronize history information, any history
Event Chains are Only
Affected by History
Within

that's older than the time specified by this
setting won’t be used to impact chain execution
status.
 Note: The default value is one day and the
minimum value is ten minutes.
 Note: It's recommended to contact
support.sentryone.combefore changing the
default value.

If messages were unable to be collected for
Do Not Fire Actions for
History Older Than

some time this setting keeps actions from being
fired for these older message.
 Note: The default value is two hours.

Trigger Run Missed
Condition When
Scheduling Agent is
Offline

Used to specify whether or not to execute the
Run Missed Condition when the instance is
offline.
 Note: This setting is enabled by default.
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Setting

Minimum Block
Duration Required to
Trigger SQL Server
Agent Job: Block
Condition

Enable AlwaysOn
Health Collection

Description

Used to specify the minimum time a SQL Agent
Job must be part of a blocking chain before
triggering the SQL Server Agent Job: Block
Condition.
 Note: The default value is 15 seconds.

Used to enable AlwaysOn health collection.
 Note: This setting is disabled by default.

Change the maximum length of textdata
Query Collection
Maximum Text Length

captured for Top SQL and Top Command
events.
 Note: The default value is 10,000 characters.

Top SQL XE Ring Buffer
Size

The maximum number of events stored in the
ring buffer used for Top SQL Extended Events
(XE) collection. This buffer is polled every 10
seconds by default, so it should be large enough
to hold the number of queries that will be
captured over that interval to avoid data loss.
 Important: All monitoring services must be
restarted for changes to this setting to take
effect.
 Note: The default value is 25.

652

Setting

Description

With the release of version 8.2, there have been
improvements made to the Normalization
Engine. Users upgrading from a prior build will
need to select the Advanced option to see the
Normalization Engine

enhancements.
 Note: The default value is Advanced, and the
default value for Basic (Legacy) is 4000
characters.
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Monitoring Service SMTP Configuration
Last Modified on 14 October 2021

The SMTP server configuration options are accessed through Global Settings (View > Navigator pane >
Configuration >Global Settings > Alerting tab > Email).

Select the drop-down list to choose a previously configured SMTP server, or select  to open the Select an
SMTP Server dialog box, and configure a new SMTP server.
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 Note: The chosen SMTP server is the globally defined SMTP server, and is used for all notification
purposes unless it's overridden at the site level. For more information, see the Configuring a Site Level
SMTP Server section below.

Adding a New SMTP Server
1. From the Alerting tab email option, select  to open the Select an SMTP Server dialog box.
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2. Select New to open the SMTP Server Editor dialog box.

3. Enter the IP address or the domain name of the SMTP Server in the SMTP Server box. Enter the email
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you want to send the notifications in the From Address box.

 Note: Configure any additional security settings on the SMTP Security tab.

4. Select Test to open the Send SMTP Test Email box, and then enter an email in the slot provided. Select
Send to send the test email to the desired address.
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5. Select OK to close the SMTP Server Editor and save your SMTP server settings.

 Important: For the most accurate SMTP test, use the SQL Sentry Client installed on the Server
computer to send the test message. If you use a SQL Sentry Client on a different computer, such as your
local workstation, the results may differ. For example, your SMTP server may allow relay from your
workstation but not from the SQL Sentry Server computer, in which case the test from your workstation
would succeed; but the SQL Sentry Server would be unable to deliver notifications.

 Note: The SMTP security settings are optional, and aren't required in most environments.
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SMTP Configuration Options
SMTP Settings

Description

SMTP Server

Enter the IP Address or the Domain Name of the SMTP Server. When using
localhost, this will be the local SMTP server on the machine where the SQL Sentry
Monitoring Service is installed.

From Address

Specify the From Address for Email notifications.

SMTP Security (Optional)
SMTP Settings

Description

Username

Enter the username used to authenticate with the SMTP Server.

Password

Enter the password used to authenticate with the SMTP Server.

Enable SSL

Specify if your SMTP server uses a Secure Socket Layer (SSL) protocol.

Use Custom Port

Select the outgoing port for the SMTP Server.

Configuring a Site Level SMTP Server
SQL Sentry allows you to configure multiple SMTP servers for the different sites within your environment.
This allows you to specify an SMTP server, or an SMTP server group that is local for each site, simplifying
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permissions, and reducing traffic over WANs.
Configure site level SMTP servers through the Site settings found in the Settings pane.
1. Select your desired site in the Navigator pane, and then open the Settings pane (View > Settings).
2. In the Settings pane, select Site Settings from the top drop-down list.

3. Change the Inherit From Parent setting to False.

The SMTP Server General setting lists the current SMTP server. Select the current SMTP server and select
the command to open the Select an SMTP Server dialog box. Choose your desired SMTP server and select
the OK command to specify the SMTP server for your site.

SMTP Server Groups
To provide failover capabilities, SQL Sentry provides you with the ability to create SMTP server groups. To
create an SMTP server group, add your SMTP servers to your SQL Sentry environment, as outlined previously
in the Adding a New SMTP Server section.
Create the SMTP server group by completing these steps:
1. From the Select an SMTP Server dialog box, select New to open the SMTP Server Editor dialog box.
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2. Select the Type drop-down list and choose Server Group. Give the Server Group a name, and select Add to
open the Add SMTP Servers box.

3. Choose your desired server, and select OK to add the server to your server group.

661

4. Select OK in the SMTP Server Editor dialog box to save your server group. Your server group is now
available in the Select an SMTP Server dialog box.

SMTP Server Group Failover Process
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The SMTP servers in a group will failover in sequence, according to the order in which they are listed in the
SMTP Server Editor dialog box. Change this order by using the arrow buttons located at the bottom of the
dialog box.

An SMTP Server Fails
When an SMTP server fails, the monitoring service will attempt to use the next SMTP server in sequence to
send the message. If the Monitoring service is successful in using this SMTP server, the same SMTP Server is
used the next time the monitoring service needs to send a message.
For example, assume you have a send email action configured for the SQL Server Agent Job: Failure
Condition, and also you have the following SMTP servers defined sequentially in your group:
1. SMTP_A
2. SMTP_B
3. SMTP_C
4. SMTP_D
When the failure Condition is detected the monitoring service will attempt to complete the send email action
using SMTP_A, which is the first server in the group. If the monitoring service is unable to send the message
through SMTP_A, it tries SMTP_B. If it's successful, the monitoring service uses SMTP_B the next time it needs
to complete a send email action.

Every SMTP Server Fails
In the event that every SMTP server in the group is unavailable when the monitoring service attempts to
complete a send email action, a Monitoring Service: Action Failed Condition is triggered. Given our previous
example SMTP group above, this process would work as follows:
If the monitoring service is unable to send the email message through SMTP_A, it tries SMTP_B, then SMTP_C,
and finally SMTP_D. If the monitoring service completes a cycle through each SMTP server in the SMTP Server
group, and is still unable to complete the send email action, a Monitoring Service Action: Failed Condition is
triggered.

Resetting the Failover Process
Changes made to an SMTP server group, including changes to the evaluation order, or additions and deletions
of SMTP servers effectively reset the failover process. Once the failover process has been reset, the
monitoring service attempts to process send email actions starting with the first SMTP server defined for the
group.
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SQL Sentry Site Configuration
Last Modified on 14 October 2021

Introduction

Sites are logical groupings of targets, instances, SMTP servers, and monitoring services within your SQL
Sentry environment. Every SQL Sentry environment has at least one site configured by default; you can see
this site represented in the Navigator pane, as the Default Site.
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While every environment may not have a need for multiple sites, they offer a number of advantages for
environments which contain geographically sparse assets, existing in multiple domains. For a graphical
representation of this idea, see the SQL Sentry Enterprise Architecture topic. The following section contains
general information about sites. For more information, see the Walkthrough Section.

Site Level Monitoring Services
The SQL Sentry monitoring service is a Windows service, that is responsible for collecting and storing:
Event history
Event status
Performance related information about your servers
This information is stored in the SQL Sentry database. SQL Sentry monitoring services can be assigned to
specific sites within your environment. Once you place a monitoring service within a site, it becomes
exclusively responsible for gathering information about watched targets and instances contained within that
site.

 Note: Having a monitoring service within the same LAN as those servers it's monitoring significantly
reduces WAN traffic, because the monitoring service is able to consume data locally and write back to
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the SQL Sentry database as needed.

Site Level SMTP Servers
Once a monitoring service is assigned to a site, that monitoring service becomes responsible for the site in a
number of ways. One of the responsibilities of the monitoring service is to alert you about events which are
happening within your environment. One of the ways it does this is by communicating with your SMTP servers
when sending email alerts. For example, if you have a site in New York and another in Chicago, it doesn’t make
sense to use New York’s SMTP server to alert you about conditions happening in Chicago.
Site level SMTP servers and SMTP server groups solve this problem. When the monitoring service detects a
condition that you have configured to be notified about, it packages that alert and then marshals that
information to the local SMTP server, that you have assigned to the site. This all happens within the locality of
the site’s LAN, avoiding long distance communication over a WAN, and significantly reducing network traffic.

 Note: Site level SMTP servers can be configured through the site settings. For more information
about this, see the SMTP Configuration topic.

Site Level Policies
SQL Sentry allows you to set policies for your monitored environment by configuring settings along with
conditions and actions. Each of these settings and conditions has a hierarchical configuration. The basic idea is
that you set global policies and then reconfigure them as needed at the different levels available within the
SQL Sentry hierarchy. Sites represent a level within the SQL Sentry hierarchy. This offers a number of
possibilities, allowing you to fine tune your settings and conditions/actions with just the site level
environment in mind.

Configuring a New Site
Take the example of a company with offices in both Atlanta and Louisville, with five monitored servers at
each location. Using separate sites for Atlanta and Louisville, a SQL Sentry monitoring service can be installed
in Louisville that monitors only the five servers there, and that reports back to the SQL Sentry database in
Atlanta. This configuration will result in less network traffic across the WAN link than if the SQL Sentry
monitoring service in Atlanta watched the Louisville servers. Additionally, both the Atlanta and Louisville sites
could be configured to use their own local SMTP server or SMTP server group, further reducing WAN traffic.

Using the Navigator Pane
SQL Sentry v7 added the ability to configure sites through the Navigator pane. This example walks through
creating a site with the Navigator pane. The same general configuration options are also available through
the Site Configuration window.
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1. Right-click on the All Targets node in the Navigator pane, and then select Add > Site.

2. The new site is created beneath the Default site within the Navigator pane. Name the site.
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3. Install the new SQL Sentry monitoring service on a non-production server in the remote site. Complete
the following guidelines below:

 Important: In this step, when installing the monitoring service in your remote site, make sure
that the installation package build number is identical to the version of your existing installation.
Your SQL Sentry version can be viewed in the Help > About menu of the SQL Sentry client.

When prompted for the SQL Sentry database information, specify your existing SQL Sentry
database, and then choose your desired authentication mode.

 Note: If there is no trust between the domains, you will need to use either SQL Server
authentication or pass-through authentication to write back to the SQL Sentry database.

When prompted for the service account information make sure to use an account with the
required permissions. See the Monitoring Service Security article for a full list of requirements.
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4. Wait for the monitoring service to initialize. The monitoring service displays in the Monitoring
Service group of the Default Site. It's identified with the name of the target it's installed on.

5. Select the newly installed monitoring service and drag it to the Monitoring Service folder of the
Remote site.
6. Add any instances and targets that you want to monitor through the right-click context menu of your
newly created site.

Using the Site Configuration Window
1. Open the Site Configuration window (Navigator pane > Monitoring Service > Site Configuration).
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2. In the Site Configuration window, select New to open the Add/Edit Site dialog box.
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3. Give the site a name, and select OK.

4. Install the new SQL Sentry monitoring service on a non-production server in the remote site, completing
the following guidelines:

 Important: In this step, when installing the monitoring service in your remote site, make sure that the
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installation package build number is identical to the version of your existing installation. Your SQL Sentry
version can be viewed in the Help > About menu of the SentryOne client.

When prompted for the SQL Sentry database information, specify your existing SQL Sentry database,
and choose your desired authentication mode.

 Note: If there is no trust between the domains, you will need to use either SQL Server
authentication or pass-through authentication to write back to the SQL Sentry database.

When prompted for the service account information, be sure to use an account with the required
permissions for monitoring servers in the Remote Site. See the Monitoring Service Security article for a
full list of requirements.
5. Wait for the monitoring service to initialize. Refresh the window by selecting the refresh button in the
toolbar.

6. Select the new site in the sites area of the Site Configuration window. The new SQL Sentry monitoring
service should show up as Available. Choose it, select Add, and then select Save.

7. The newly created site and its associated monitoring service displays in the Navigator pane. Add any
instances and targets that you want to monitor through the right-click context menu of your newly created
site.
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 Note: The Default site acts as a catch-all for any SQL Sentry monitoring services and targets that are
removed from or haven't been added to any other sites.
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SQL Sentry Inventory View
Last Modified on 14 October 2021

Introduction
The Inventory view allows you to see the watched status of any target within your environment. Access the
Inventory view by double-clicking the Inventory node in the Navigator pane (Navigator > Configuration >
Inventory).

In the Inventory view, you can drag the column header to the top to group by that column. Other options are
available in the context menu for the column headers for grouping, sorting, filtering etc.
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 Note: Once applied, the filter is shown at the bottom of the pane.

Available Columns
Column

Description

Site

The management site is maintained through the Site Configuration screen, or
through the Navigator pane drag and drop functionality. Sites represent a logical
grouping of targets, instances, and monitoring services within your SQL Sentry
environment.

Monitoring
Service

A specific SQL Sentry monitoring service by machine name.

Name

The name of a specific target.
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Column

Description

Targets may be:

Type

SQL Server
Analysis services
Windows APS appliance
VMware Hosts

AWS RDS
Azure SQL DB
SQL DW
Hyper-V Hosts

The flags indicate whether the
target is currently being watched
by SQL Sentry.
A check mark indicates that the
target is currently being
watched.

Watched instance example

Watched
An empty check box indicates
that the target is not being
watched.
Unwatched instance example

 Note: This is a read-only view of the targets. See the Stop Watching Targets article
for information on how to stop monitoring a target.

Idea:
Use the Inventory view to quickly see how the licenses within your environment are distributed.
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SQL Sentry Actions Log
Last Modified on 14 October 2021

Introduction
SQL Sentry includes an interface for viewing, sorting, and filtering log and notes information.
The Actions Log is where information can be viewed relating to:
General actions
Failsafe actions
Audit actions
Advisory actions
Select Actions Log in the Navigator pane to open the Log: Actions Log window.

 Note: Whenever a condition is configured with the Log to Database action, information related to
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that condition can also be viewed in the Actions Log.

Log Filter

Filter Criteria manages results displayed in the Actions Log. Search for a specific log entry by narrowing the
selection criteria to be displayed in the log list by using Filter Criteria.

Property

Description

After

Enables the filter to only show logs with an event time after the specified time in the
date/time selection controls.

Before

Enables the filter to only show logs with an event time before the specified time in the
date/time selection controls.

Object
Name

Filters the log list by applying a like comparison to the specified value to the value stored
in the Object Name field.

Parent
Name

Filters the log list by applying a like comparison to the specified value to the value stored
in the Parent Name field.

Contains

Narrows the log list to the entries with the specified value in the message text.

Log
Type

Specify the type of actions to display in the log list.

Conditions Filters for a specific condition category.
Action

Filters for a specific action category.

Refresh

Used to refresh the list of logs and date/time filter.

Apply
Filter

Used to apply Filter Criteria settings and refresh the log list.
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Property

Description

Reset
Filter

Used to remove the filter applied to the log list.

Page

Used to show the current display page of results and how many pages are in the log list.

First

Move to the first page of log results.

Previous

Move to the previous page of log results.

Next

Move to the next page of log results.

Last

Move to the last page of log results.

Log List
The log list shows all log records retrieved. To sort a list, select a header.

 Note: Records cannot be edited; however, notes can be added.

Column

Description

Log Time

Displays the time the action was fired for the event.

Event Time

Displays the start time for the event.

Object Type

Displays the object type for the event.

Object Name

Contains the name of the object for the event.

Parent Object
Name

Contains the name of the parent object for the event.
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Column

Description

Condition

Captures the condition that caused the event.

Action

Captures the action that caused the event.

Notes Log List
Even though notes are considered a logged object, the properties are somewhat different than the logs for
other events. Thus, the log list columns vary in order to reflect these differences.

Column

Description

Log Time

Date/time note is created.

User Name

Name of the user that created the note.

Object Name

The object name that the note references.

Parent Object
Name

The name of the parent object that the note references.

Note Text

Contains the note message text.

Note Title

Contains the title or subject of the note.

Calendar

Captures the condition that caused the event.

Notifications

Captures the action that caused the event.

Message Window
The Message window is located at the bottom portion of the view, and contains a read-only area, displaying
the log messages. To add or edit notes to an event instance, right-click on the desired row in the list, and then
select the option to Add/Edit Notes to open the note editor.
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SQL Sentry System Status
Last Modified on 14 October 2021

Introduction
The System Status screen provides information about the work SQL Sentry is doing in the environment,
including monitoring service tasks, their current state, and any associated messages. By default, the System
Status screen only displays errors. Open the System Status screen by selecting System Status on the
Navigator pane.

 Note: Generally, there is no need to reference the System Status screen, but it may be helpful when
troubleshooting environmental faults.

System Status Screen
View the information displayed in the System Status screen organized by Group
by selecting the appropriate toolbar button.

or Monitoring Service
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Toolbar Options
Option

Filter Idle
Tasks

Description

Image

Filters idle tasks on the System Status Screen.
 Note: This option is enabled by default.

Displays only running and completed errors in your
environment. Unselect this option to display other
transactions in your environment.
 Note: This option is enabled by default.

Show Errors
Only

 Warning: Be aware that turning off Show
Errors triggers the SQL Sentry database to
elevate logging. This can temporarily increase
the transactions on the database until the
System Status screen is closed.
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Option

Show
Targets

Description

Image

Displays the targets within your environment.
Unselect this option to remove targets from the
display.
 Note: This option is enabled by default.

Displays System Status information organized by
groups in your environment.
Display By
Group

Display By
Monitoring
Service

 Note: This option is enabled by default.

Displays System Status information organized by the
Monitoring Service(s) in your environment.
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SQL Sentry Virtual Machine Support
Last Modified on 06 January 2022

Hyper-V Support
After monitoring a Hyper-V guest target with SQL Sentry, the host of that target appears under the
Virtualization node in the Navigator pane.
When a Hyper-V host target is monitored, the host and all of the host's guests will appear under the
Virtualization node in the Navigator pane. Additionally, memory ballooning and vCPU information are
presented on the dashboards on Hyper-V Guest targets. The host information is provided on the dashboard as
well.

VMware Support
 Important: If using SSPI authentication, be sure to select a site where the monitoring service has at
least read-only access to the vCenter.

To enable VMware support, a vCenter must be added. Complete the following steps to add a vCenter:
1. Right-click on the VMware node under the Virtualization node in the Navigator pane.
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2. Select Add vCenter to open the Add vCenter dialog box. Enter the appropriate information, and then
select Ok to save the vCenter.

Once the vCenter has been added, any VMware guest targets display the following metrics on their
dashboards:
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CPU Ready Time
Co-Stop
Memory ballooning

 Important: When adding a vCenter to a site with multiple monitoring services, it's recommended that
you use a local vSphere account to avoid potential overhead associated with Windows session
authentication.

Virtual Machine Performance Counters
Virtual machine performance counters are available for use in Custom Conditions, and are available for
viewing in the Performance Counter History Report.

 Note: Memory ballooning information is only available for guests with dynamic memory enabled.
vCPU information only displays on the sample mode dashboard CPU charts if the value is > one percent.
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Enhanced FCI
Last Modified on 17 March 2022

 Important: Enhanced FCI can be activated automatically or manually for product Versions 2021.12 or
above.

Overview

Pre 2021.12 update

Post 2021.12 Update

Prior to the 2021.12 release, each Failover Cluster Instance (FCI) node in watched WSFC Clusters displayed a
placeholder node corresponding to both the FCI and Windows metrics for the current owner. These settings
could make it difficult to see clusters that an FCI node was associated with on the Navigator pane (without
diving deeper into tables, or comparative metrics). Additionally, under these settings, there was the potential
for the client to duplicate metric collection for FCI nodes.
The Enhanced FCI feature moves FCI nodes under their current owner. Any watched placeholder targets will
be realigned under this configuration. Enhanced FCI will also create groups by cluster and organize applicable
FCI nodes into the appropriate groups. FCI and WSFC node targets watched prior to upgrading to 2021.12 will
be realigned automatically during the upgrade if they meet the proper prerequisites. Or they can be aligned
manually after the upgrade by executing a specific stored procedure on the SQLSentry database.
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 Important: Placeholder targets that were originally a parent to an FCI node may display as unwatched
to prevent duplicate metric collection between the owner and placeholder node.

Enhanced FCI Procedure
Enhanced FCI can be implemented automatically during an upgrade or manually post-upgrade. During an
automatic or manual Enhanced FCI upgrade, the Client does the following:

Align any registered FCI instance with its current
owner

FCI Instance aligned with current owner

Identify and unwatch any orphaned placeholder
targets

Unwatched Placeholder Targets
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Create a group named “ WSFC - {cluster name} ”
under the site or group containing the majority
of the cluster’s associated targets for each
WSFC associated to registered FCI(s)

Move all targets associated with each WSFC
cluster under their respective group

Cluster Group and associated FCI targets

 Note: Data collection for previously watched placeholder targets will still be available after the
upgrade. If you set up alerts or reports on the placeholder targets, you can copy any settings onto the
new watched FCI targets.

 Important: After the upgrade, FCI nodes will automatically transition to the new owner in the event of
a failover (even if they were previously associated with a placeholder node). If the FCI's new owner is
unwatched or unregistered during the failover, the FCI will be unwatched. It is strongly recommended to
watch All WSFC nodes associated to the FCI.

Automatic Alignment Prerequisites
 Note: The Enhanced FCI upgrade will only execute automatically if all watched nodes meet this
criteria.

When you upgrade to SQL Sentry 2021.12 or later, the Enhanced FCI feature set will be applied automatically
if your client meets the following requirements:
All FCI placeholder targets are Watched
All nodes associated with each FCI are registered in the client
All targets associated with each FCI are located in the same Site or Group
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Manually Configuring Enhanced FCI on your Installation
If your SQL Sentry environment does not meet the automatic alignment prerequisites, you can trigger an
Enhanced FCI upgrade manually. To manually configure the Enhanced FCI feature set, complete the following
steps:
1. Close the SQLSentry Client. Open SSMS and connect to your SQLSentry Database.
2. Execute the following query against the SQLSentry Database:
exec WSFC.AlignFailoverClusterInstances 0

Executing "exec WSFC.AlignFailoverCluster Instances 0" will align the FCI nodes with the current active
and organize the nodes into applicable groups. Executing "exec WSFC.AlignFailoverCluster Instances
1" will only align the FCI with its current owner.

3. Open the SQL Sentry client and verify the changes in the Navigator pane.

 Success: Your FCI nodes are now aligned with the current owner!

Enhanced FCI Licensing
Watching WSFC targets that are associated to a watched FCI instance will not use additional licenses. This
allows you to watch all WSFC nodes associated to an FCI instance, and ensure that you have continuous
monitoring and data retention in the event of a failover. It is recommended to watch all nodes associated to a
watched FCI instance.

Watching New FCI Targets
When adding a new FCI instance, you will be prompted to add and watch all possible owners of the instance.
Selecting Yes adds and watches all possible owners of the FCI. Selecting No only watches the current owner.
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 Warning: Any unwatched WSFC nodes will prompt a Configuration Error warning message. To ensure
continuous monitoring and data retention, it is recommended to add and watch all associated WSFC
nodes.

Inactive watched nodes contain both Windows and SQL Server metrics. This allows you to track data retention
between nodes in the event of a failover.
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Environment Health Overview
Last Modified on 26 August 2021

Introduction

SQL Sentry Portal: This feature is available in SQL Sentry Portal. To learn more about configuring your
environment to use the on-premises, browser-based option with your existing SQL Sentry database, see
the SQL Sentry Portal article.
See the Monitor Health article for an example of what this feature looks like in the SQL Sentry Portal.

The Environment Health Overview (EHO) is integrated into the dashboard of the Start Page. It provides an
at-a-glance health status of your environment with a 100-point scale score. This scale score is based on the
severity, number of occurrences, the age of the Advisory, General, Audit, and Failsafe events, and the number
of servers that you're monitoring.

 Note: Starting with Version 2021.12.1, the General, Audit, and Failsafe conditions are configured by
default and have an assigned severity that affects the score on the EHO. The severity level and tags
associated with General, Audit, and Failsafe conditions can't be changed, but can be viewed in the SQL
Sentry database in dbo.ConditionType and will be visible in the Condition Events Log when a condition
evaluates to true and is logged.

 Note: Any Advisory Condition that has a defined Severity, and a Send to Alerting Channels action
can affect the EHO score. The scale score returns to 100-points when no Advisory Condition events are
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available. For information about configuring Advisory Conditions, see the Advisory Conditions topic.

The Environment Health Overview appears automatically during the setup wizard, and allows you to
configure the Advisory Conditions to work with your performance dashboard, Event Calendar, and the
Environment Health Overview.

Unsupported: On an older version of SentryOne, select Tools > Run On-boarding Wizard (requires
client restart). The client restarts and presents you with the necessary options to configure the
Advisory Conditions to work with your performance dashboard, Event Calendar, and the Environment
Health Overview.

In the SQL Sentry client, you can change where you start in the client by going to Tools > User Preferences.
Select Start Page from the drop-down list, and the Environment Health Overview appears every time you
start the client. For more information about User Preferences, see the User Preferences topic.
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Wedgets
 Note: Version 2021.12.1 added an Info Severity category to the EHO. The Info severity doesn't
impact the EHO score, but can be useful when searching for certain information. For example, the
condition may notify you that some event object properties have been modified.

When analyzing a high volume of Advisory Conditions, two types of wedgets display on the Environment
Health Overview; the first wedget is broken out by severity and the second wedget is broken out by tags.
Selecting either wedget filters the list of events by severity or tags.

 Note: Any active filters are displayed at the bottom of the grid. Select the
filter, or select the
(X) to dismiss the filter.

(pencil icon) to edit the
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Once you've corrected the performance issue, close the affected event by selecting the link on the events list
in the Environment Health Overview. Add notes to the event, assign the note to someone else, if necessary,
or close out the event.

If you have many events that need to be closed out, right-click under Duration, select Close, and then
select All for Condition. This closes all of the current conditions in the Environment Health Overview.

As you work through the affected events in the list, you can trim down the time range using the slicer. Select
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the Slicers drop-down list, and then change the desired time limit.

Events Log
On the Environment Health Overview, select the desired event link under the Condition column. The Events
Log appears filtered by the desired condition, and the filter excludes events that are closed.

Environmental Health Overview select Condition
Events Log selected Condition

698

Favorite Targets
Last Modified on 26 August 2021

Each SQL Sentry client has its own unique Favorites group. The Favorites group is used to define a view of
targets and instances specific to that individual SQL Sentry client. This is useful in a large environment,
because it allows an individual user to specify a subset of targets and instances that they're responsible for.
Select the Show Favorite Targets icon, located directly above the Navigator pane, to toggle the Favorites
node.

When you add a target or an instance to your Favorites group, it's added to the Default Site node of the All
Targets node ( if it isn't already a part of your SQL Sentry environment). When you add a target or instance to
your Favorites group that's already a part of your shared SQL Sentry environment, the target or instance isn't
duplicated. As mentioned earlier, the Favorites group is unique to each SQL Sentry client and defines a view
of your larger SQL Sentry environment.
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Changes you make regarding the watched status, or to any configured settings, conditions, and actions from
the context of the Favorites group are mirrored in the All Targets node. In the same way, changes made to
targets and instances from the context of the All Targets node are also mirrored back to any Favorites
groups that they belong to.
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Virtualization Node
Last Modified on 06 January 2022

The Virtualization node houses the support for VMware and Hyper-V virtualization options.

VMware
To add a vCenter, right-click on the VMware node in the Navigator pane, and then select Add vCenter. Enter
the display name and your credentials, or check the box to select Use Windows session authentication.
Select the Site drop-down menu to choose which site will be responsible for the monitoring of the vCenter.
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 Note: To add a vCenter, the monitoring service must be a configured user on the vCenter
implementation and must have read-only access at minimum. For more information, see the VMware
Overview for SQL Sentry topic.

 Important: If using SSPI authentication, be sure to select a site where the monitoring service has at
least read-only access to the vCenter.
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Hyper-V
Whenever a Hyper-V guest or host is monitored with SQL Sentry, it appears under the Hyper-V node. If the
host is monitored with SQL Sentry, all of the host's guests appear as well. If only a guest is watched with SQL
Sentry, that guest's host displays. For more information, see the Windows & Hyper-V Overview topic.
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Object Groups
Last Modified on 30 March 2022

Introduction
Object Groups are useful when you need to apply similar policies to a set of objects that don't exist within
the same hierarchical group in your SQL Sentry environment. These objects could be dispersed throughout
your environment in different sites, groups, or subtrees, but if they share a similar set of characteristics, they
may be ideal candidates for a similar set of policies.

Object Groups with evaluation order.

Take for example all of the transaction log backup jobs within your environment. You may wish to suppress
Runtime Threshold alerts generated when these jobs run by disabling the Send Email action. Object Groups
allow you to do this without affecting any other agent jobs. In the past, this would involve you having to go
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and touch each of the transaction log backup job settings individually. Object Groups allow you to avoid the
tedious process, saving you time because you can quickly locate objects by name or category, add them to a
group, and apply a set of policies.
As Object Groups exist outside of the normal SQL Sentry hierarchy, a condition or setting configured for an
Object Group is applied last after any inherited or explicitly defined condition or setting. In this way, Object
Group conditions and settings have the final say within your environment.
As mentioned earlier, typical uses include disabling Runtime Threshold alerts for all transaction log backup
jobs and applying policies to QA servers that may exist within several sites of your environment. When you
create an Object Group, you choose how configured conditions and settings are applied in the group. You can
create an Object Group in which configured conditions and settings apply strictly to the group members.
Alternatively, you may create an Object Group in which configured conditions and settings apply to the group
members and their children. For more information, see the following section Creating New Object Groups.

Evaluation Order
Each Object Group you create also has an associated evaluation order . This evaluation order is specific to just
the set of Object Groups in your environment. This is valuable when you have an object that belongs to
multiple Object Groups with a divergent set of policies. The evaluation order allows you to control which
group's configured conditions and settings are applied. A configured setting or condition from the Object
Group with the highest evaluation order will be applied last, and therefore will be the effective setting or
condition. For example, if you have ten object groups, with orders 1 through 10, then 10 will be the
highest/last applied.

 Note: With object groups, the alert is applied to the first in the list. For example, if you have a Top
SQL: Duration Threshold Max alert and it was applied in 2 object groups; group 1 and group 5, then the
alert in group 1 will eclipse the alert in group 5, so only the Top SQL: Duration Threshold Max alert
defined in group 1 is sent.

Settings
When you add new objects to an Object Group, any setting that is applicable to that object type will be
configurable in the Settings pane. By default, each object in an Object Group still receives its base set of
inherited settings from its parent objects in the SQL Sentry hierarchy. If you would like to override these
settings, define a setting within the Object Group itself. Change the Defined setting to True. After you
define a setting for an Object Group, that setting is reflected in any applicable objects that belong to that
group.

Conditions
Just like settings, condition/action combinations become available as appropriate when objects are added to
a group. With any Object Group selected, you can configure conditions through the Conditions pane. For
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more information, see the following section Configuring Conditions and Settings for an Object Group.

Creating New Object Groups
Additional Information: See the blog post on Creating Object Groups in SQL Sentry.

To create a new Object Group, complete the following steps:
1. Double-click the Object Groups node in the Navigator pane to open the Object Groups Editor window.

2. Select Add in the Groups section of the Object Groups Editor window to open the Add Group dialog
window.
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 Note: The Groups section of the editor window contains any previously configured groups in your
environment. The Group Members section of the editor window allows you to view individual members
of any selected Object Group.

3. Enter a name and description for the group. Also take note of the Applies To drop-down box. The following
options are available:

Option

Description

Selected group
members and
their children

Any conditions or settings you configure for the group also apply to the children
of the group members. This makes the group's settings and conditions
inheritable.

Selected group
members only

Any conditions or setting you configure for the group only apply to the specific
members of the group and have no effect on their children. This makes the
group's settings and conditions noninheritable.
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 Note: If you're creating an Object Group to set policies for all of the QA servers in your environment,
choose Selected group members and their children because this gives you access to applicable
settings and conditions from the instance level down to the object level.
If you're creating an Object Group to set policies for just a finite set of objects and do not wish to
impact or have access to children of the object, choose Selected group members only. Given the
transaction log backup job use case discussed earlier, it wouldn't matter which Applies To option you
chose because the agent job object is a leaf node in the SQL Sentry hierarchy.

4. Select Ok to add your Object Group.

Adding Object Group Members
To add new members to a group:
1. Select a group in the Groups section of the editor window, and then select Add in the Group
Members section of the editor window.
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2. In the Select Group Members dialog screen, choose the object type of the group member you'd like to add
from the tree view, and then select Search to view objects of that type in your monitored environment.

3. Select an object, and then select OK to add it to the group.

709

 Note: You can add multiple objects by pressing Ctrl or Shift.

Configuring Conditions and Settings for an Object Group
Once you've added your desired objects to the group, you can begin configuring the conditions and settings
for the group. Configure conditions and settings, through the Conditions and Settings pane. If you don't see
the Conditions and Settings pane, use the View (View > Conditions) menu to open it.
To add a condition to a group, complete the following steps:
1. Select Object Groups in the Navigator Pane, and select the desired Object Group.
2. Open the Conditions pane, and then select Add to open the Actions Selector window.
3. Choose your desired condition/action combinations, and then select OK.

 Note: Any conditions that are applicable to the objects within your group are available for you to
configure. You can also configure settings for the Object Group through the Settings pane. Any
settings that are applicable to the objects in your group are available for you to configure. As discussed
earlier, by default, each object in an Object Group still receives its base set of inherited settings from its
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superior parent objects in the SQL Sentry hierarchy. If you would like to override these settings, you
must first define a setting within the Object Group. To do this you need to set the Defined flag to true
in the Settings pane. After you define a setting for an Object Group, that setting is reflected in any
applicable objects that belong to that group.

Additional Information: For more information about Object Groups, see the Manipulating Runtime
Thresholds with Object Groups blog post.

 Note: If you're ever unsure of where an object is receiving its inherited settings, you can check. The
Active Settings List report lists this information for each setting in the Object Name column. Access
this report from the Reports menu (Reports > General > Active Settings List).

Alternatively, you can view this information directly at the individual object level. Select the desired
object in the Navigator pane, and then open the Settings pane. The Inherent From Parent section of
each setting group contains the name of the superior object that is passing down that group of settings.
In the case where the object's setting has been defined with an Object Group, it lists that Object Group
as the parent.
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Schedules and Windows
Last Modified on 26 August 2021

Introduction

SQL Sentry employs extensive scheduling capabilities through its Schedules and Windows features.
Schedules and Windows can be managed through their respective nodes found in the Navigator pane.
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Schedules has the following application within SQL

Windows has the following applications within SQL

Sentry:

Sentry:

Fragmentation Manager Operations

Maintenance Windows
Email and Pager Windows for Users and Groups
Ruleset Windows for Configured Actions

Schedules
SQL Sentry allows you to create Schedules that can be applied in the following place:

Scenario

Description
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Scenario

Description
Enable Fragmentation Manager in your SQL Sentry environment, and then select a
schedule to perform Fragmentation Manager Operations. This schedule is initially
specified in the Fragmentation Manager wizard. After enabling Fragmentation
Manger for an instance, access the applied schedule through the Index
Defragmentation settings found in the Settings pane (View > Settings).

Fragmentation
 Note: Index Defragmentation settings, including the applied schedule, can be
Manager
configured
at the following levels: All Targets (Global), site, target group, target,
Operations
instance, database, table, and individual index.
Additional Information: For more information, see the Fragmentation Manager
topic.

Windows
SQL Sentry allows you to create Windows that can be applied in the following places:

Scenario

Maintenance
Windows

Description
Used to set a schedule for the Maintenance Window. Only Log Actions are triggered
for Failsafe Conditions inside the Maintenance Window. Maintenance Window
settings allow a time frame to be specified while scheduled maintenance activities take
place on that instance.
 Note: There are several options for configuring Maintenance Windows within SQL
Sentry, including Maintenance Windows specific to targets, instances, and the SQL
Sentry database.
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Scenario

Description
Email and Pager Windows can be assigned to a user or group. Windows control the
time frame of when alerts are sent to the user or group. When you assign an
Email or Pager Window to a user or group, you have the option to change the Window
Behavior to one of the following:

Email and
Pager
Windows
for Users
and Groups

Option

Description

Perform actions that
occur within the
window

Only email and pager actions that occur during the
Window's active time frame are carried out. Email and
pager actions that are triggered outside of the active
time frame are suppressed.

Don't Perform
actions that occur
within the window

Email and pager actions that occur during the active
time frame are filtered or suppressed. Only email and
pager actions that occur outside of the Window's
active time frame are carried out.

 Note: To apply an Email or Pager Window to a user or group, double-click the user
or group in the Navigator pane to open an Edit User/Group tab. Use the Email or
Pager Window drop-down list to choose the desired Window. Use the Email or Pager
Window Behavior drop-down list to choose the desired behavior.
Additional Information: For more information, see the Contact Management topic.
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Scenario

Description

Windows may be applied to configured actions that control the time frame of when
that action can take place. When you assign a Window to a configured action you have
the option to change the Window Behavior to one of the following:

Ruleset
Windows
for
configured
Actions

Option

Description

Perform actions that
occur within the
window

Only email and pager actions that occur during the
Window's active time frame are carried out. Email and
pager actions that are triggered outside of the active
time frame are suppressed.

Don't Perform
actions that occur
within the window

Email and pager actions that occur during the active
time frame are filtered or suppressed. Only email and
pager actions that occur outside of the Window's
active time frame are carried out.

 Note: To apply a Window to a configured action, select the action in the
Conditions pane, and then open the Ruleset tab for the selected action. Use the
Window drop-down list to select your desired Window. Edit an existing window by
selecting Edit, or create a new window by selecting New. Select Window Behavior, or
use the Window Behavior drop-down list to choose the desired behavior.
Additional Information: For more information, see the Alerting and Responses
System topic.

Creating a Schedule or Window
Expand the Schedules and Windows node in the Navigator pane to display the Schedules and Windows
nodes. Create a new Schedule or Window by completing the following steps:
1. Double-click the Schedules or Windows node to open the Select a Schedule or Select a Window
selection screen.
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Select the Schedules Node

Select the Windows Node

2. Select New to open the Schedule Properties or Window Properties window.
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Add a new schedule

Add a new window

 Note: You can also edit existing Schedules or Windows by selecting a schedule or window and then
selecting Edit.

3. Enter a name for your Schedule or Window, then configure the properties. Select OK to save your
schedule or window.

Schedule Properties

Window Properties

Schedule or Window Properties Options
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The following Schedule or Window Properties options are available:

Section

Description

Name

The name that is applied to the Schedule or Window.

Schedule
Type

Option

Description

Recurring

A recurring Schedule or Window repeats according to
the frequency and duration you choose.

One Time

A one time Schedule or Window takes place only on
the occurrence date you specify.

Compound

A compound Schedule or Window can be created that
combines previously created schedules.

Specify the duration or length of time that the Window is active.
Window
Duration

One-time
occurrence

 Note: Window Duration applies only to Windows and is not available for
Schedules.

Select the time you would like the one-time occurrence of the Schedule or Window to
take place.
 Note: This option is only applicable for schedule type: One Time.
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Section

Description

Frequency

The Frequency of the Schedule or Window can be set to either Daily, Weekly,
or Monthly. Additional Frequency options are available depending on the chosen
occurrence type.

Daily
Frequency

Use the Daily Frequency options to select the specific time(s) during the day the
Schedule or Window occurs.

Duration

Use the Duration section to specify a Start Date and End Date.

Summary

The Summary description auto-fills according to the chosen options. You may add to
the summary or change the text as desired.
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Contact Management
Last Modified on 26 August 2021

The Contacts node is used to create and maintain Users and Groups within your SQL Sentry environment.
Users and Groups are created for a couple of different reasons. They can be created for notification purposes
within the SQL Sentry Alerting and Responses System. Once you configure a Send Email or Send Page action ,
any user or group that's been created becomes available for you to choose as a target.
The other reason for defining Users and Groups is the ability to assign rights to them. These rights are used
to restrict the access of Users and Groups within the SQL Sentry client. For more information, see the SQL
Sentry Client Security topic.
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Viewing Notifications by User or Group
From the Contacts node, it's possible to view all notifications assigned to a user or group. View all
notifications assigned to a user or group on the Contacts node by completing the following steps:
1. Expand the Contacts node in the Navigator pane, and then expand the Users or Groups node.
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2. Select the desired user or group, and then open the Conditions pane to display any associated
notifications.
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3. Use the list of notifications to disable or change any of the configured actions.
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Users
Expand the Users node in the Navigator pane to list any configured users.
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Adding or Editing a User
Add a User by completing the following steps:
1. Right-click the Users node, and then select New to open the Add a User tab.
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2. Enter the applicable information for your User, and then select
user.

(Save toolbar button) to save the new
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Edit an existing user by completing the following steps:
1. Double click or right click an existing User to open the Edit User tab.
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2. Edit the applicable information for your user, and then select
changes.

(Save toolbar button) to save your
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 Note: For detailed information about the options available in the Add a User, and Edit User tabs, see
the User Fields section below.

Deleting or Disabling a User
To delete a user, right-click the user, and then select Delete User from the context menu. Select Ok to
confirm the deletion.
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To disable a user, right-click the user, and then select Disable User from the context menu. Disabled users are
grayed-out in the Navigator pane and have Disabled next to their name.

731

 Note: When you disable a user, they no longer receive notifications for any actions where they were
the selected target. If the disabled user is part of a group, that user no longer receives notifications
when that group is notified.

Enabling a User
To enable a user that has been disabled, right-click the user, and then select Enable User.
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User Fields
When you create a new user or edit an existing user, the following fields are available.

Add a User

Edit User
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Field

Description

First Name

The first name of the user. Required.

Last Name

The last name of the user.

Email Address

The email address of the user. Required.

Pager Address

The pager address of the user.
The Email Window for the selected user. When you assign an Email Window
to a user or group, be sure to take note of the Email Window Behavior
option.

Email Window

Additional Information: For more information about Schedules, see the
Schedules and Windows topic.

Option

Description

Perform actions that occur
within the window

Only email actions that occur
during the Window's active time
frame are carried out. Email
actions that are triggered
outside of the active time frame
are suppressed.

Don't Perform actions that occur
within the window

Email actions that occur during
the active time frame are
filtered or suppressed. Only
email actions that occur outside
of the Window's active time
frame are carried out.

Email Window
Behavior

The Pager Window for the selected user. When you assign a Pager Window
to a user or group, be sure to take note of the Pager Window Behavior
option.
Pager Window

Additional Information: For more information about Schedules, see the
Schedules and Windows topic.
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Field

Description

Option

Description

Perform actions that occur
within the window

Only pager actions that occur
during the Window's active time
frame are carried out. Email
actions that are triggered
outside of the active time frame
are suppressed.

Don't Perform actions that occur
within the window

Pager actions that occur during
the active time frame are
filtered or suppressed. Only
pager actions that occur outside
of the Window's active time
frame are carried out.

Pager Window
Behavior

Login

The Windows or SQL Authentication account for the user. You can associate
a SQL Sentry user with a Windows or SQL Authentication account and
restrict access to specific Sites, Target Groups, or instances, effectively
limiting what the logged-in user can see within the client.
Additional Information: For more information, see the SQL Sentry Client
Security topic.

Description

Descriptive text or notes for the user.

Groups

The Available area lists any group within your SQL Sentry enterprise. The
Selected area lists those groups that the user belongs to.

Groups
Expand the Groups node in the Navigator pane to list any configured groups.
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 Note: In versions 2020.8.31 and later, a default group named Default Alerts is created during the
onboarding process and the user added during the onboarding process is automatically added to this
group. This is the default contact group for Send Email actions.

Adding or Editing a Group
Add a Group by completing the following steps:
1. Right-click the Groups node, and then select New to open the Add a Group tab.
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2. Enter the applicable information for your Group, and then select

(Save toolbar button) to save the

new Group.
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Edit an existing Group by completing the following steps:
1. Double click or right click an existing Group to open the Edit Group tab.
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2. Edit the applicable information for your Group, and then select

(Save toolbar button) to save your

changes.
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Assigning User(s) to a Group
To assign users to the group, choose from the available users on the bottom-left side of the Properties view,
and then select Add. Select Save

in the top toolbar to save the group.
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Deleting or Disabling a Group
To delete or disable a group, right-click the desired group, and then select Disable Group. Disabled groups
are grayed-out in the Navigator pane and have Disabled next to their name.
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 Note: When you disable a group, that group no longer receives notifications for any actions that they
are the selected target of. Disabled groups are grayed-out in the Navigator pane, and they are also
listed as Disabled.

Enabling a Group
To enable a group that has been disabled, use the right-click context menu of the group, and select Enable
Group.
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Group Fields
When you create a new group or edit an existing group, the following fields are available:

Add a Group

Edit Group
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Field

Description

Group Name

The name assigned to a group. Required.
When you assign an Alert Window to a group be sure to take note of the Alert
Window Behavior option.

Alert
Window

Alert
Window
Behavior

Additional Information: For more information about Schedules, see the Schedules
and Windows topic.

Option

Description

Perform actions that occur within
the window

Only email and pager actions that
occur during the Window's active
time frame are carried out. Actions
that are triggered outside of the
active time frame are suppressed.

Don't Perform action that occur
within the window

Actions that occur during the active
time frame are filtered or
suppressed. Only email and pager
actions that occur outside of the
Window's active time frame are
carried out.

Login

The Windows active directory account for the group. You can associate a SQL Sentry
group with a Windows active directory account and restrict access to specific sites,
target groups, or instances, effectively limiting what the logged-in user can see within
the client. For more information, see the SQL Sentry Client Security topic.

Description

Descriptive text or notes for the user.

Users

The Available area lists users within your SQL Sentry enterprise. The Selected area
lists any users that belong to the group.
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All Targets
Last Modified on 26 August 2021

The All Targets node is the root node of the SQL Sentry client and is located in the top position of the
Navigator pane. All targets that are registered across the entire SQL Sentry enterprise are found within All
Targets.
The All Targets node is used to configure global conditions and settings within the SQL Sentry Alerting and
Responses System. The All Targets node is also used to view Event Calendar, Performance Overview,
or AlwaysOn Management.

All Targets Context Menu

Open context menu options

Add context menu options
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Right-click on the All Targets node to access its context menu. The following commands are available:

Command

Description

More Information

Open > Event
Calendar

Opens the global event manager view of your
SQL Sentry enterprise.

Event Calendar

Open >
Performance Overview

Opens the shared Performance Overview.

Performance Analysis
Overview

Open > AlwaysOn
Management

Opens the AlwaysOn
Management environment.

Performance Analysis
Always On

Add > Site

Adds a new Site node beneath the
Shared Groups node.

Site Configuration
Default Site

Add > Connection

Adds a new connection to the Default Site.

Connections
Default Site

Global Level of the Alerting and Response System
The All Targets node is used to configure global conditions and settings within the SQL Sentry Alerting and
Responses System. When the All Targets node is selected in the Navigator pane, the associated global level
Conditions and Settings pane is available. If you don't see the Conditions and Settings pane when the All
Targets node is selected, use the View menu to bring up the desired pane. Conditions and settings
configured at the All Targets level are global in nature. This means that when a condition or setting is set at
the Shared Group level, it automatically propagates down throughout your SQL Sentry environment.
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For example, configure a send email action for the SQL Agent Job: Failure condition at the All Targets global
level. An email is now sent anytime an agent job fails across your entire monitored environment.
Once global conditions and settings are configured, more granular configurations can be made where they
are needed at the lower levels. For more details on how global conditions and settings are inherited
throughout your SQL Sentry environment, and information about configuring alerting for your SQL Sentry
installation, see the Alerting and Responses System topic.

Global Views
Access global views in your SQL Sentry enterprise through the All Targets node. This is done by either
double-clicking the All Targets node or by using its right-click context menu. The default number of days for
the Global Calendar view is one day and can be adjusted in User Preferences.
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The primary purpose of the global views is to give you insight into what's happening across your enterprise
without having to open individual Event Calendars or Performance Analysis Dashboards at the target level.

 Note: Future and running events are disabled in the global Event Calendar view. Adjust the runtime
filter and other filter criteria on the Event View filter tab to further refine the display for personal
preferences.

For more information about the shared targets performance analysis overview, see the Performance Analysis
Overview topic.

All Targets Child Nodes
Default Site
Sites represent a logical grouping of targets, instances, and monitoring services within your SQL Sentry
environment. If you're upgrading from a previous version of SQL Sentry, you'll notice that the sites displayed
beneath the All Targets node directly reflect those sites you previously configured within the Site
Configuration node. If you're a new user, notice that the instances added using the quick start wizard are all
contained in the Default Site node.
When a Site node is selected in the Navigator pane, the associated site level Conditions and Settings pane
are available. If you don't see the Conditions and Settings pane when the Site node is selected, use the View
menu to bring up the desired pane.

 Note: Conditions and settings configured at the site level apply to all targets, instances, and objects
in that site. This means that when a condition or setting is configured at the site level, it automatically
propagates down throughout that site.
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Site Context Menu
Right-click on any Site node to access its context menu. The following commands are available:

Command

Description

More Information

Add > Target

Adds a new target to the selected site.

Targets

Add > Group

Adds a new target group to the selected site.

Targets

Add > Connection

Adds a new connection to the selected site.

Connections
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Command

Description

More Information

Deletes a site from the Shared Group node. Any
targets or groups contained within the site must
be deleted before a site can be deleted. This
command is not available from the Default
Site node.
n/a

Delete Site
 Warning: Selecting Delete Target is
permanent. For more information, see the
Targets topic.

Rename Site

Renames the currently selected site.

n/a

Open Performance
Analysis

Opens a performance analysis overview for
every target in the site.

Performance Analysis
Overview

Open AlwaysOn
Management

Opens the AlwaysOn
Management environment.

Performance Analysis
Always On

Show System Status

Shows the system status for the selected site.

System Status

Add Advisory
Condition >Target

Adds a target to an Advisory Condition.

Advisory Conditions

Snooze Alerts For >
Time

Allows you to select a time or day for when to
snooze alerts.

n/a

Monitoring Services
Beneath the Default Site node is a Monitoring Services node. The Monitoring Services node contains the
monitoring service(s), identified by their associated target name(s) that are responsible for collecting
information pertaining to the site.

 Note: The SQL Sentry monitoring service is a Windows service that's responsible for collecting event
history, event status, and performance related information and storing that information in the SQL
Sentry database. Monitoring services are also responsible for sending notifications based on events.
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The Monitoring service(s) within a site are responsible for gathering information about those watched targets
and instances contained within that same site. Assign available monitoring services to sites either through the
Site Configuration node or by dragging and dropping a monitoring service within the Navigator pane. This
enables you to control exactly which monitoring services watch what targets.

 Note: Monitoring services can be critical for scenarios where you have multiple servers located at
different geographic locations. Having a monitoring service for each geographic location minimizes
network traffic across the WAN.

Additional Information: For more information, see the monitoring service and site configuration
topics.

Targets Nodes
Beneath every Site node are its associated Target nodes, identified with the target's full name, usually
ComputerName.DomainName. Each Target node represents a physical computer, commonly a Windows
server within your SQL Sentry environment. Commonly beneath every Target node in the Navigator pane are
its associated instances.
Double-click any Target node to access its related Performance Analysis Dashboard or Event Calendar.

Targets Context Menu
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Right-click on any Target node to access its context menu. The following commands are available:

Command

Description

More Information

Open > Event
Calendar

Opens the Event Calendar view for the
associated target.

Event Calendar

Open > Performance
Analysis

Opens the Performance Analysis Dashboard
for the associated target.

Performance Analysis
Dashboard

Show Windows
Processes

Launches a Process Activity window similar to
Windows Task Manager for the associated
target.

Windows Process
Activity
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Command

Description

More Information

Add > Instance

Adds a new instance to the Default Site.

n/a

 Warning: This command deletes the
actual registration for the target from SQL
Sentry. This includes the deletion of all
historical information for any associated
connections belonging to the target from
the SQL Sentry database. This command is
final and cannot be undone. Only use this
Delete Target

command if you want to permanently delete
information SQL Sentry has stored about the

n/a

target and its associated connections from
the SQL Sentry database.
When deleting a target, you must first stop
watching the target and instances. See the
Stop Watching Targets article for more
information.

Jump to > Time

Allows you to select a date, time of day, and time
frame for an Event Manager Calendar.

n/a

Scan for
Configuration
Changes

This scan looks for any hardware, network, or
schema changes that have taken place on the
target or its associated instances. This
information is automatically gathered
periodically.

n/a

Target Conditions and Settings
Within the framework of the Alerting and Responses System Hierarchy, targets represent a level between
sites and instances. This means that when a condition or setting is configured at a target level, it automatically
propagates down to its associated instances and objects.
If you don't see the Conditions and Settings pane when a Target node is selected, use the View menu to
bring up the desired pane.

 Note: Conditions and settings configured at the target level apply to all instances and objects
beneath that target. This means that when a condition or setting is configured at the target level, it
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automatically propagates down to its associated instances and objects.

Adding a Target to your Environment
Add a new target to your installation by selecting Add in the right-click context menu of any Site node.

Deleting a Target From Your Environment
Delete a target from your installation by selecting Delete Target in the right-click context menu of any
Target node.
When deleting a target, you must first stop watching the target and instances. See the Stop Watching Targets
article for more information.
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 Warning: The Delete Target command deletes the actual registration for the target from SQL Sentry.
This includes the deletion of all historical information for any associated instances belonging to the target
from the SQL Sentry database. This command is final and cannot be undone. Only use this command if
you want to permanently delete information SQL Sentry has stored about the target and its associated
instances from the SQL Sentry database.

Target Groups
Targets can be organized into target groups beneath any Site node. A target group allows you to create
logical groups of devices for alerting, organizational, and display purposes. Use the Add Target Group
command in the right-click context menu of any Site node to add a target group.
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Target Group Conditions and Settings
Within the framework of the Alerting and Responses System Hierarchy, target groups represent an
intermediate level between the site and target. This means that when a condition or setting is configured at a
target group level, it automatically propagates down to its associated targets, instances, and objects.

Instance Nodes
Contained beneath every Target node are its associated Instance nodes. Instances are identified by their
target/instance name. Contained beneath every Instance node are its associated objects.
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Instances, Actions, and Settings
Within the framework of the Alerting and Responses System Hierarchy, instances represent the level above
objects. This means that when a condition or setting is configured at an instance level, it automatically
propagates down to its associated objects.
When an Instance node is selected in the Navigator pane, the associated instance level in the Conditions
and Settings pane is available. If you don't see the Conditions and Settings pane when an Instance node is
selected, use the View menu to bring up the desired pane.

 Note: Conditions and settings configured at the Instance level apply to all objects belonging to that
instance. This means that when a condition or setting is configured at the instance level, it automatically
propagates down to its associated objects.

Adding an Instance to Your Environment
Add additional monitored instances to your SQL Sentry environment by right-clicking either the All Targets
node, a Site node, a Target Group node, or an existing Target node in the Navigator pane, and then select
Add, or select File to add an instance. In the Add dialog box, choose the desired instance type from the drop-
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down menu, and then select Connect. For more information, see the Monitoring Additional Targets topic.
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Performance Analysis Dashboard
Last Modified on 09 September 2021

Introduction
The Dashboard provides a graphical representation of the monitored server activity through a variety of
graphs. Color coded graphs distinguish between what's used by the instance versus any other processes.

Applies to: Some tabs and features may not be available to all products or target types. Please read
further for more detail.

SQL Sentry Portal: This feature is available in SQL Sentry Portal. To learn more about configuring your
environment to use the on-premises, browser-based option with your existing SQL Sentry database, see
the SQL Sentry Portal article.
 See the SQL Sentry Portal Dashboards article for an example of the Dashboard feature in a browser,
which also allows you to build Custom Charts (feature not available in the SQL Sentry client).

Opening the Performance Analysis Dashboard
The Performance Analysis Dashboard can be opened by right-clicking any instance in the Navigator pane,
and selecting Open > Performance Analysis.
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It can also be opened by double-clicking the instance in the Navigator pane, selecting Performance Analysis
from the View Selector, and then selecting Ok.

Dashboard Overview
The Performance Analysis Dashboard provides an overview of different targets and instances, such as
Windows and SQL Server. The dashboard displays the most important metrics used for determining health
and load. Performance data is organized into two vertical panes, split into smaller sections depending on the
type of dashboard you are viewing. For example, the Dashboard for a Windows based target with a SQL
Server instance shows Windows operating system specific metrics in the left pane and SQL Server or SSAS
metrics in the right pane.
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 Note: Each instance has a unique color assigned to it that remains constant across all charts.
Hovering over colored sections of these charts displays the corresponding instance.

Network
The Network section displays the total network traffic on the server as well as the network utilization on each
of the adapters that's present on the monitored target.

CPU Usage
The CPU Usage section displays the total CPU Usage for the server as well as information on context
switching, user time, kernel time, and more.
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 Note: The Other category represents any collected processes that are not within a Well-Known
Processes group. For more information about the Processes tab, and creating your own well-known
processes groups, see the Performance Analysis Processes article.

System Memory
The System Memory section displays information about the amount of memory being used by different
processes on the server as well as page faults and page file usage.

 Note: A graph that contains multiple uses of the same color indicates the environment has multiple
NUMA nodes.

Disk IO
The Disk IO Section displays the read and write latency for each of the physical disks on the server.
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Metrics for all SQL Server or SSAS instances on the server are integrated into the Windows Network, CPU
Usage, and System Memory charts, allowing you to quickly determine exactly how much of these resources is
being used by each instance, at any point in time.

SQL Server Activity
The SQL Server Activity Section displays information about what the SQL Server instance is doing.
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SQL Server Waits
The SQL Server Waits section displays information about the classes and categories of waits that occurred as
well as the duration of milliseconds that the waits were in effect during that time period.

SQL Server Memory
The SQL Server Memory section displays information about how the Server instance is using memory that has
been allocated to it.

 Note: A graph that contains multiple uses of the same color indicates the environment has multiple
NUMA nodes.

Database IO
The Database IO Section displays information about the read and write latency for the databases.
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Understanding the Dashboard
For more information about the various performance metrics displayed on the Dashboard, see the
Performance Metrics topic.

 Note: A graph that contains multiple uses of the same color indicates the environment has multiple
NUMA nodes.

For performance reasons, the Dashboard never queries the remote server directly; all data is retrieved from
the SQL Sentry database after it's collected by the SQL Sentry monitoring service.

 Note: There may be a slight delay between the time the performance data is collected and the time
it's displayed on the Dashboard; although, typically this isn't more than a few seconds.

When in real-time mode (auto-refresh is enabled), the charts and gauges update automatically approximately
every 10 seconds to show the values for the last collected sample. Enable real-time mode by selecting the
Play button in the toolbar.

Dashboard Display Modes
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The Dashboard has two display modes: Sample and History. The display mode can be changed at any time by
toggling the mode toolbar button.

 Note: The graphic and the text changes when the mode button is toggled, and it always indicates the
mode that becomes active when you select the button, versus the currently active mode.

Sample mode uses various bar charts and digital gauges to show activity for a specific time, or sample time.
This mode includes certain metrics that aren't available in History mode, such as Network activity by
adapter, CPU Usage by individual processor, and SQL Server Waits by specific wait class.

 Note: In Sample mode, the CPU Usage chart displays Kernel time in red, and Processor time in green
for each of the cores on your monitored instance.
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 Note: In Sample mode, a Quick Report can be run directly from any of the gauges. Right-click the
desired gauge and select Quick Report to open the report.

History mode uses line and stacked area charts to show you how the Windows Server and SQL Server targets
are performing over any time range. The range can be changed by adjusting the Start and/or End times on the
toolbar, and then selecting Go.

 Note: There is no restriction on the size of the time range. The resolution of the data displays
changes, growing less detailed as you select a longer time range. For example, when selecting any range
of 30 minutes or less, you view the actual raw performance data, and if you select an eight-hour range,
10-minute averages display. For more information, see the Dashboard Resolutions/Retention topic.

Customizing SQL Server Waits Chart
One of the most common reasons our customers customize the SQL Server Waits Chart is to break down the
Other category into something more specific.

 Note: Read Justin Randall's blog post on Dashboard Custom Wait Categories for more information.

Customize the SQL Server Waits historical chart by adding an additional category to the Performance
Analysis Wait Type category table, and then assigning counters in the Performance Analysis Wait Type
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table to the newly created category.
For example, create a new category for parallelism by using the following query:
New Category Creation
INSERT INTO [SentryOne].[dbo].[PerformanceAnalysisWaitTypeCategory] (Name, SortOrder, Enabled, RGBColor)
VALUES ('Parallelism',6,1,'#bb7fd1')

After creating the Parallelism category, add the following counter to it:
Adding a Counter to the Category
UPDATE [SentryOne].[dbo].[PerformanceAnalysisWaitType] SET WaitTypeCategoryID = 7
WHERE Name = 'CXPACKET'

Interacting with the Dashboard
Changing the Active SQL Server/SSAS Instance
You can change the SQL Server or SSAS instance using the Instance drop-down control in the top middle of
the screen. The metrics in the right pane reload, but the active date range and other options are maintained.

The following functions are available in History mode:

Tooltips
Hover over any point on the chart to see tooltips with specifics about the sample, including the sample
instance Time, Name, and Value.

Select any graph metric to highlight that metric on the graph.

Select a Metric to highlight

Metric highlighted on graph
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Sample Selection
Clicking on a history chart presents a vertical red line at that position called a cursor. The selected time is
indicated by the Sample Pos box at the top right. The cursor is synchronized across all charts allowing you to
easily correlate what's happening with one performance metric with what's happening with other related
metrics at the same time.

After selecting a sample with the cursor and toggling Mode , detail data for the selected time loads in
Sample mode, allowing you to see specifics for that sample that aren't available in History mode. For
example, if you select a spike on the SQL Server Waits chart and change to Sample mode, you can see the
specific wait classes responsible for the spike, whereas in History mode only general wait categories display.

Click and Hold
If you click and hold a sample, the cursor changes color, and when you release the mouse you'll be presented
with a subset of the Jump To context items used for range selection. This allows you to jump directly to a
different tab and view only operations that overlapped the currently selected sample time.
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Range Selection
Select a history chart and drag the cursor to select a range. Range Start and Range End boxes update, and
releasing the mouse button causes context items to appear, allowing you to choose whether to Zoom In the
selected range or Jump To another part of the application using the selected range. For example, selecting a
range that includes a spike in network activity, and then selecting Jump To > Top SQL, displays and loads the
Top SQL tab with queries that ran during that range, enabling you to determine which queries may have been
responsible for the network spike.

 Note: When using Jump To, the Sync toolbar button is automatically deactivated because the
toolbar date ranges for the different tabs are no longer in sync. This allows you to jump back and forth
between the Dashboard and the other tabs using Jump To with different sub-ranges without losing the
original full range displayed on the Dashboard. You can reactivate synchronized tabs at any time by
selecting Sync; just remember that all other tabs immediately use the range that's visible and active on
the toolbar for the current tab.
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Advisory Condition Markers
Display Advisory conditions on the Performance Analysis Dashboard graphs by enabling Advisory Condition
Markers.
Select any Advisory Condition Marker to see the Advisory condition(s) that occurred.

Select the Advisory Condition Marker

Advisory Condition window

Colored lines across the bottom of each graph indicate where a condition fired, and the duration a condition
was in effect for each instance. Hover over a colored line to display this information.

Selecting the name of the condition takes you to that event in the Events Log.
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Corresponding Events Log

Advisory Condition window

Toolbars
Sample Mode Toolbar

Show History Mode - Changes the view to History
mode.

Quick Trace - Runs a Quick Trace.

Show Windows Processes - Displays Windows
processes running on the server.

Jump To Calendar- Opens the corresponding
Event Calendar.
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Report- Opens the Report viewer for Windows and
SQL Server performance data.
Show Advisory Condition Markers- Displays
Advisory Condition Markers on the Performance
Analysis Dashboard.

History Mode Toolbar

Show Sample Mode - Changes the view to
Sample mode.

Run Quick Trace - Runs a Quick Trace.

Show Windows Processes - Displays Windows
processes running on the server.

Jump To Calendar- Opens the corresponding
Event Calendar.

Report- Opens the Report viewer for Windows and
SQL Server performance data.

Show Advisory Condition Markers- Displays
Advisory Condition Markers on the Performance
Analysis Dashboard.

Controls
Sample Mode
Network
Total - Displays network activity as an aggregate across all adapters, with SQL Server/SSAS activity
integrated.
Adapters - Displays activity by the individual network adapter, enabling you to spot adapter-specific
saturation issues.
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History Mode
Disk IO
Total - Displays average latency across all physical disks.
By Disk - Displays actual latency for a specific physical disk.

Database IO
Total - Displays average latency across all database files.
By Database file - Displays actual latency for a specific database file.

Using Quick Trace™
Quick Trace gives you an instant snapshot of what all of the processes on a SQL Server are currently doing.
Trace and process-level data is collected for a specified interval and then automatically correlated, effectively
combining the functionality of Profiler and Activity Monitor together with a single click. Launch Quick Trace
by doing any one of the following:
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Select the Run Quick Trace toolbar button.

Select the Quick Traces tab, and then select Run Quick Trace.

Right-click any chart in the Dashboard, and then select Quick Trace.

For example, if you observe a spike in activity while in real-time mode, you can immediately launch Quick
Trace and see exactly which SQL Server processes or applications are responsible for the spike.

 Note: Quick Trace isn't supported on an Azure SQL Database target.

For more information, see the Quick Traces topics.

Viewing Windows Process Activity
See metrics for all Windows processes using Show Windows Processes directly from SQL Sentry, which
avoids having to open a remote desktop connection to a server, and open Windows Task Manager. The
Process Activity window loads all active operating system processes, sorted in descending order by CPU by
default.
Launch the Process Activity window by doing any one of the following:
Select the Show Windows Processes toolbar button.

Right-click a target in the Navigator pane, and then select Show Windows Processes.
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Right-click any chart in the Dashboard, and select Show Windows Processes.

 Important: Rows with zero values in the sort column are hidden by default. Unhide these rows by unselecting the associated option at the bottom of the screen.

 Note: Viewing Windows Process Activity is not supported on an Azure SQL Database target.
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 Note: Administrative access to the target server is required in order to launch the Process Activity
viewer.

Event Overlays
Specific events taking place in your environment can also be overlaid on the Performance Analysis
Dashboard. Access this feature by selecting Jump To Dashboard from a number of places within the SQL
Sentry client that display a range of historical events, including any:
Event Calendar
Top SQL
Blocking
QuickTraces
When using the Jump To Dashboard feature, events are overlaid on the x-axis for each chart. The start of
each distinct event is represented with a green circle, with the event's duration represented with a pink line,
ending in a pink dot. Hovering over an event displays a tooltip about that event.

 Note: If the selected time range is not large enough, events are represented by a green circle. If this
is the case, changing the time range to a smaller interval preserves the overlay of the event, and may
offer a better view of the impact that each event had.

From Event Calendar
When using the Jump To Dashboard feature from Event Calendar any events that are highlighted with the
Calendar Highlighting feature are overlaid on the Dashboard.
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From Top SQL
When using the Jump To Dashboard feature from Top SQL , if the Show Totals is enabled all events
belonging to the selected group are overlaid on the Dashboard. If Default mode is enabled only the selected
event is overlaid on the Dashboard.

From Blocking or QuickTraces
When using the Jump To Dashboard feature from Blocking or QuickTraces the selected event is overlaid on
the Dashboard.
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Performance Analysis Baselining
Last Modified on 09 September 2021

Applies to: Azure SQL Database, Hyper-V, SQL Server, SSAS, VMware, and Windows targets.

Baselines are created and managed from the History view of the Performance Analysis Dashboard. There
are two distinct baseline types available. The first type of baseline is the predefined type. SQL Sentry includes
several predefined baselines that are based on the historical metrics gathered in your monitored
environment. The second type of baseline is the custom type. SQL Sentry also allows you to define your own
custom baselines.
Once a baseline has been selected, it's overlaid on the various Performance Analysis Dashboard charts,
giving you information that can help you to manage change in your monitored environment. Custom
baselines can also be used in Advisory Conditions, allowing the comparison of baseline values to current
metrics, as they are captured.

 Note: At this time, you can't display a baseline created by one type of target overlaid on a different
type of target. For example, creating a baseline against a SQL Server instance running on a Windows
target can't be overlaid on an Azure SQL Database dashboard.

Predefined Baselines
Predefined baselines are available without any custom configuration. They can be accessed from the
Baseline drop-down menu on the Dashboard while in History view.
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The different predefined baselines are available based on the historical time range you are viewing on the
Dashboard. For more information, see the following table:

Baseline

Time Range Availability

Range Option Availability
(detail data)

Previous
Period

This baseline is always available. Corresponds to
the immediate preceding timeframe.

Yes

Previous Day

Zero <= 24 hrs

Yes

Previous
Week

Zero <= 168 hrs

Yes

Previous
Month

36 <= 720 hrs

No

Previous
Quarter

480 <= 2160 hrs

No

Previous Year

960 <= 8760 hrs

No

Average and Range Modes
It's important to understand that predefined baselines are based on the historical data collected in your
monitored environment. The granularity of the data-points that make up a baseline is entirely dependent on
the time range you are viewing.

Average
By default, predefined baselines are shown with data-points that show the average value over that sample
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period.

The pink line illustrates the predefined baseline average.

Range
When viewing certain predefined baselines, and within a time range that has a resolution of detail data, an
additional option is available, allowing you to view that baseline with a range of values (reference the Range
Option Availability column in the previous chart). This range includes both a minimum and maximum
observed value during the respective sample period.

The pink field illustrates the predefined baseline range.

Custom Baselines
Custom baselines can be created on demand using the Dashboard user interface while in History view. To
create a custom baseline, left-click on any Dashboard chart and drag to highlight your desired timeframe.
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Custom Baseline from the context menu.

 Note: Create a custom baseline for a more specified time frame by adjusting the start and end time
on the calendar toolbar to the time frame you'd like to baseline.

Select Create Baseline from the context menu to display the Create Baseline form.
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Create Baseline

 Note: By default, a baseline is tied to the server and instance where it's created. Enable your Custom
Baseline Globally by selecting the Global Baseline check-box.

Option for Global Baseline

Create Baseline Form
The Create Baseline form contains information about all of the metrics captured as part of a custom
baseline. For more information, see the following table:
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Field

Description

Metric

The name of the metric captured in the baseline.
Defines which metric in the chart is used when displaying the baseline.

Default

 Note: This can be changed at any time.

The value that's used for that metric in the baseline. This controls both the actual
line displayed on the respective chart and the value used for comparison
Average

purposes in Advisory Conditions. Average is calculated based on the observed
values for the metric within the baseline's time range.
 Note: To define custom values to be used with the baseline, simply edit the
pre-calculated average value.

Min

The minimum value captured during the baseline's time range.

Max

The maximum value captured during the baseline's time range.

Standard
Deviation

The standard deviation for the values captured during the baseline's time range.

 Note: You can change the Min, Max, Average, and Standard deviation values for any metric in the
Create Baseline or Edit Baseline forms. Select the desired metric, change it to your desired value, and
then select Ok to save your changes.
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Using Custom Baselines in Advisory Conditions
The values defined for metrics that make up a custom baseline can be used in Advisory Conditions. To access
a baseline in an Advisory Condition, define the Advisory Condition at that same instance level for which the
baseline is defined. For example, if you create a baseline on the server named LONDON.UK.COM, to access
the baseline in an Advisory Condition, create the Advisory Condition from the context of the
LONDON.UK.COM server in the Navigator pane. For more information about Advisory Conditions, see the
Advisory Conditions topic.

Editing Baselines
Edit baselines in the Edit Baseline form. Open the Edit Baseline form by right clicking the graph next to the
baseline,

or by selectingby the Baseline drop-down menu.
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Deleting Baselines
Delete a baseline by selecting Delete Baseline from the Edit Baseline form, and then selecting OK from the
Delete Baseline window.

Baselines and Performance Counter Mapping
When using baselines in Advisory Conditions, reference the following tables that include mapping between
the metrics captured in baselines and their associated friendly performance counter names.

SQL Server Baseline Mapping
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Chart

Metric

Associated Exposed Performance Counter
(Advisory Condition format)

Backup MB/sec

SQL Server Database Engine: SQL Server:
Databases: Backup/Restore MB/sec

Page Life Expectancy
(sec)

SQL Server Database Engine- Buffer Node PLE : Equals : "Node Name"

SQL Plans

SQL Server Database Engine Plan Cache Hit
Ratio: Equals: SQL Plans

Object Plans

SQL Server Database Engine Plan Cache Hit
Ratio: Equals: Object Plans

Checkpoint pages/sec

SQL Server Database Engine SQL Server
Buffer Manager: Checkpoint pgs

Lazy writes/sec

SQL Server Database Engine SQL Server
Buffer Manager: Lazy writes/sec

Total CPU Usage
Percent

Windows: Processor Information: Percentage
Processor Time: Total

Total ms/Read

SQL Server Database Engine: SQL Server
Virtual File Statistics: ms/Read

Total ms/Write

SQL Server Database Engine: SQL Server
Virtual File Statistics: ms/Write

Total ms/Read

Windows: PhysicalDisk: ms/Read

Total ms/Write

Windows: PhysicalDisk: ms/Write

Backup/Restore

Cache Hit Ratios

Checkpoint pgs | Lazy writes

CPU Usage

Database Latency

Disk IO

Faults (Read | Write)
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Chart

Metric

Associated Exposed Performance Counter
(Advisory Condition format)

Faults: Read

Windows: Memory: Faults: Read

Write Faults: Write

Windows: Memory: Faults: Write

Key lookups | Forwarded recs
Key lookups/sec

SQL Server Database Engine: SQL
Server:Access Methods: Key lookups/sec

Forwarded
records/sec

SQL Server Database Engine: SQL
Server:Access Methods: Forwarded
Records/sec

Log Flushes/sec

SQL Server Database Engine:
SQLServer:Databases: Log flushes/sec: Total

In Percent

Windows: Network Interface: Received
percentage: Total

Out Percent

Windows: Network Interface: Sent
percentage: Total

Page reads/sec

SQL Server Database Engine:
SQLServer:Buffer Manager: Page reads/sec

Page writes/sec

SQL Server Database Engine:
SQLServer:Buffer Manager: Page writes/sec

Batches/sec

SQL Server Database Engine:SqlServer: SQL
Statistics: Batches/sec

Transactions/sec

SQL Server Database Engine:Databases:
Transactions/sec: Total

Log Flushes

Network In

Network out

Pages

SQL Activity
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Chart

Metric

Associated Exposed Performance Counter
(Advisory Condition format)

Compiles/sec

SQL Server Database Engine:
SQLServer:Statistics: Compiles/sec

Recompiles/sec

SQL Server Database Engine:
SQLServer:Statistics: Recompiles/sec

Total SQL Memory
Usage (MB)

SQL Server Database Engine:SQLServer:
Buffer Node: Database pages: Total

Total Wait Time (ms)

SQL Server Wait Statistics: Waits by Category:
Total

Total Memory Usage
(MB)

Windows: Memory: Total used Memory (MB)

SQL Server Memory

SQL Server Waits

System Memory

SSAS Baseline Mapping
Chart

Metric

Associated Exposed Performance Counter
(Advisory Condition format)

Total CPU Usage Percent

Windows: Processor Information: Percentage
Processor Time: Total

Total ms/Read

Windows: PhysicalDisk: ms/Read

Total ms/Write

Windows: PhysicalDisk: ms/Write

CPU Usage

Disk IO

Faults (Read | Write)
Faults: Read

Windows: Memory: Faults: Read
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Chart

Metric

Associated Exposed Performance Counter
(Advisory Condition format)

Faults: Write

Windows: Memory: Faults: Write

In Percent

Windows: Network Interface: Received Percentage:
Total

Out Percent

Windows: Network Interface: Sent Percentage: Total

Network In

Network out

SSAS Activity: Rows Transferred
Query rows sent/sec

SSAS: Storage Engine Query rows sent/sec

Processing rows
read/sec

SSAS: Processing: Processing rows read/sec

SSAS Activity: Threads Formula Engine
Query pool busy threads

SSAS: Threads: Query pool busy threads

Query pool job rate

SSAS: Threads: Query pool job rate

Query pool job queue
length

SSAS: Threads: Query pool job queue length

SSAS Activity: Threads Storage Engine
Busy

SSAS: Threads: Processing pool busy I/O job threads

Processing pool job rate

SSAS: Threads: Processing pool I/O job completion
rate

Queued

SSAS: Threads: Processing pool I/O job queue length

SSAS General : Avg Time
Total Wait Time (ms)

SSAS Trace Waits: Total Wait Time (ms)

SSAS General: MDX
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Chart

Metric

Associated Exposed Performance Counter
(Advisory Condition format)

Cells calculated/sec

SSAS: MDX : Cells calculated/sec

Calculation covers/sec

SSAS: MDX : Calculation covers/sec

Sonar subcubes/sec

SSAS: MDX : Sonar subcubes/sec

Recomputes/sec

SSAS: MDX : Recomputes/sec

NON EMPTY
unoptimized/sec

SSAS: MDX : NON EMPTY unoptimized/sec

NON EMPTY for
calculated members/sec

SSAS: MDX : NON EMPTY for calculated members/sec

SSAS General: Processing
Processing rows
written/sec

SSAS: Processing: Processing rows written/sec

Index rows created/sec

SSAS: Proc Indexes: Index rows created/sec

Aggregation rows
created/sec

SSAS: Proc Aggregations: Aggregation rows
created/sec

SSAS Mem Usage (MB)
Total Cleaner Memory
(MB)

SSAS: Memory: Total Cleaner Memory (MB)

Total Category Memory
(MB)

SSAS: Memory: usage by Category: Total memory
Usage (MB)

SSAS Memory: Cache Activity
Cache inserts/sec

SSAS: Cache: Cache inserts/sec

Cache evictions/sec

SSAS: Cache: Cache evictions/sec

Flat cache inserts/sec

SSAS: MDX: Flat cache inserts/sec

KB added/sec

SSAS: Cache: KB added/sec
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Chart

Metric

Associated Exposed Performance Counter
(Advisory Condition format)

KB shrunk/sec

SSAS: Memory: KB shrunk/sec

SSAS Memory: Cache Lookups
Dimension cache
hits/sec

SSAS: Cache: Lookups/sec

Measure group cache
lookups/sec

SSAS: Storage Engine Query: Measure group cache
lookups/sec

Calculations cache
lookups/sec

SSAS: Storage Engine Query: Calculations cache
lookups/sec

Flat cache lookups/sec

SSAS: Storage Engine Query: Flat lookups/sec

SSAS Storage: Current Partitions
Indexes

SSAS: Proc Indexes: Current partitions (indexes)

Aggregations

SSAS: Proc Aggregations: Current partitions
(aggregations)

SSAS Storage: File Queries
Total queries from
file/sec

SSAS: Storage Engine Query: Total queries from
file/sec

Aggregation hits/sec

SSAS: SSAS Trace: Aggregation hits/sec: Total

SSAS Storage: File Read KB
Total System File Read
KB

Windows:System:Total System read KB/Sec

SSAS Storage: File Write KB
Total System File Write
KB

Windows:System:Total System write KB/Sec

Total Memory Usage
(MB)

Windows: Memory: Total used Memory (MB)

System Memory
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Performance Overview
Last Modified on 09 September 2021

Overview
The Performance Overview provides a summary of performance data for all watched instances within a
group or site. Open the Performance Overview by right-clicking any Group or Site node in the
Navigator pane, and selecting Open Performance Overview.

 Note: You can also open the Performance Overview by selecting the View Performance Stats for
All Servers button on the Start page.
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Access Performance Overview via the Start Page

 Note: Selecting the All Targets node opens an overview showing all of the instances that are being
watched. Selecting a custom made group node only displays the instances within that group.

Select the Show Avg Over drop-down list box to change the interval for the summarized data.

Select a different time interval.
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 Note: Select from the following time intervals:
Last Sample
30 minutes
One day

Two minutes
Two hours
Two days

10 minutes
Four hours
Three days

Select the Show drop-down list box to view either Windows, SQL Servers, or Analysis Services.

Filter by target type.

Double-click on any target or instance to open View Selector. Select Performance Analysis, and then select
OK to open Performance Analysis for that target or instance.

View selector
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Select a performance metric in Performance Overview to view a historical graph of that metric.

 Note: Historical graphs are not available for all metrics. For a detailed description of the various
performance metrics, see the Performance Metrics topic.

 Note: The default setting for the Performance Analysis Overview skin is black, but can be set to
standard in the User Preferences window (Tools > User Preferences > Performance Analysis).
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Expand targets or instances to see additional information by selecting the Expansion arrow by the desired
target or instance.

Additional Toolbar buttons
Performance Overview
Toolbar button

Description

Button applied

Expands All of the columns in
the Performance Overview.

Collapses All of the expanded
columns in the Performance
Overview.
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Performance Overview
Toolbar button

Description

Button applied

Expands columns that contain
metrics that fall outside of the
Warning and Critical
thresholds.

Failover Simulation
The Failover simulator allows administrators in large or complex environments to see what would happen in
the event of several failovers to a single host. This can be especially useful when it comes to capacity
management in your environment. When simulating a failover, the simulator displays an aggregation of all the
database metrics at the point in time the simulation started. Counters display in red if a failover simulation
overwhelms a host.

 Note: The Failover simulator is only available for monitored instances that contain AlwaysOn
availability groups.

Simulate a Failover in the Performance Overview by completing the following steps:
1. Select an instance and expand its nodes until you reach the Availability Groups level.
2. Right-click on the desired Availability Group, then select Simulate Failover to and the desired target
from the context menu.
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 Note: An Availability group that's currently the primary produces a context menu that allows you to
select the secondary replica that you want to simulate a failover to. You can also simulate failover values
from a secondary by right-clicking the secondary replica and selecting Simulate Failover from the
context menu.

 Note: You can stop a running simulation at any point. Right click the Availability group running the
failover simulation, then select Reset Simulation to stop the simulation.

 Important: Once the failover simulation has completed, simulated values display in italics.

3. Select a simulated value to display a historical graph of actual values and a graph of the simulated values.
Use these charts to compare your simulated value to the actual value.
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Filters
In the top right corner of each filter column header is a filter button. Select the filter button

to open the

Custom AutoFilter dialog box.

Once selected, choose the operator and value to filter the data. Select Ok to save the custom auto filter.

Once a filter is set, it appears along the bottom panel of the window. Edits to the filter can be made by
selecting Edit Filter and changing the criteria. It can also be disabled by clearing the checkbox or closed
completely by using the X on the left side of the window.

Color Indicators
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Instance names appear in different colors depending on the status of the instance.

Color

Status

Depiction

Gray (Black in Standard view)

Normal

Orange

A metric crossed the
Warning threshold at or below
this level.

Red

A metric crossed the
Critical threshold at or below
this level.

Black (Gray in the
Standard view)

Instance offline.

Performance Analysis Overview Thresholds
Target Level

Normal

Network Outbound
Queue

Warning

Critical

>= Three

>= Three for 20 second duration

Network Inbound Errors

> Zero

Network Outbound Errors

> Zero

Memory Free (MB)

<100

CPU Context Switches

<5000
times #
of cores

CPU Processing Time
Percent

>=5000
times # of
cores

>=7500 times # of cores

85-89

>=90

>Two times the number of cores

CPU Queue Length
Target and SQL Server
Level
Disk Reads ms/IO

<20

20-29

>=30

Disk Writes ms/IO

<20

20-34

>=35
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Target Level

Normal

Warning

Critical

SQL Server Level

SQL Server Activity Blocks

> Zero

SQL Server Activity
Deadlocks

> Zero

Average Wait Time (ms)
CPU Percent

>25

SQL Server Memory
Grants Pending

> Two

SQL Server Memory PLE

<600

Disk IO Lazy Writes

>20

SSAS Level
SSAS Formula Engine
Queued Jobs

> Zero

SSAS Storage Engine
Queued Jobs

> Zero

SSAS Memory Cache
Evictions

> Zero

SSAS Storage Temp File
(KB)
SSAS Memory (KB) Shrunk

> Zero

> Zero
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SQL Sentry Performance Metrics
Last Modified on 13 September 2021

This article provides a directory of the many sample and historical performance metrics displayed by the
Performance Analysis Dashboard and Performance Analysis Overview across SQL Sentry monitoring
solution.

 Note: Some metrics, such as Windows metrics appear not only for Windows targets, but also for SQL
Server targets. This article shows you where to find the definitions for those metrics across the
documentation.

Metrics Article

SQL Server

Included Metrics
SQL Server Activity : User Connections
SQL Server Activity : Blocked Processes
SQL Server Activity : Batches
SQL Server Activity : Transactions
SQL Server Activity : Compiles
SQL Server Activity : Recompiles
SQL Server Activity : Key Lookups
SQL Server Activity : Forwarded Records
SQL Server Activity : Backup MB/sec
SQL Server Activity : Send Queue / Redo Queue
SQL Server Waits : CPU percent of Total Waits
SQL Server Waits : Wait Time: by Category
SQL Server Waits : Wait Time: by Class
SQL Server Memory : Buffer Cache Size
SQL Server Memory : Plan Cache Size (SQL)
SQL Server Memory : Plan Cache Size (Objects)
SQL Server Memory : Other Cache Size
SQL Server Memory : In-Mem OLTP
SQL Server Memory: Query Grants
SQL Server Memory: Columnstore
SQL Server Memory : Plan Cache Hit Ratio (SQL)
SQL Server Memory : Plan Cache Hit Ratio (Objects)
SQL Server Memory : Stolen Buffer
SQL Server Memory : Page Reads
SQL Server Memory : Page Writes
SQL Server Memory : Page Life Expectancy
SQL Server Memory : Memory Grants Pending
Database IO : Read Latency by Database File
Database IO : Write Latency by Database File
Database IO : Checkpoint Pages
Database IO : Lazy Writes
Database IO : Log Flushes
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Metrics Article

Included Metrics

Includes Windows & Hyper-V metrics.

Windows

Windows

Network : Total network utilization
Network : Utilization by SQL Server/SSAS Instance
Network : Utilization by Network Adapter
Network : Network Output Queue Length
CPU Usage : Total Processor Time
CPU Usage : User Time by CPU
CPU Usage : Kernel Time by CPU
CPU Usage : Processor Time by SQL Server / SSAS Process
CPU Usage : Percent Guest Runtime*
CPU Usage : vCPU Wait Time*
CPU Usage : Context Switches
CPU Usage : Processor Queue Length
System Memory : Memory by SQL Server / SSAS instance
System Memory : Other Processes Memory
System Memory : File Cache Memory
System Memory : Ballooned memory**
System Memory : Available Memory
System Memory : Read Faults
System Memory : Write Faults
System Memory : Page File Usage
Disk IO : Read Latency by Physical Disk
Disk IO : Write Latency by Physical Disk
* Metric will only be visible for targets that are Hyper-V Hosts.
** Metric will only be visible for targets that are VM guests whose host is
also watched.

Hyper-V Host
Network (VM) : Utilization by Virtual Machine Guest
CPU Usage (VM) : Usage Time by Guest
CPU Usage (VM) : vCPU Root Usage Time
CPU Usage (VM) : Percent Guest Runtime
CPU Usage (VM) : vCPU Wait Time
System Memory (VM) : Memory by Virtual Machine Guest
Disk IO (VM) : IOPS (Read)
Disk IO (VM) : IOPS (Write)
Disk IO (VM) : Read Throughput
Disk IO (VM) : Write Throughput
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Metrics Article

Included Metrics

Includes VMware Host and Guest metrics.

VMware Host

VMware

Network In
Network Out
CPU Usage Total CPU
CPU Usage Co-stop %
CPU Usage Ready Time %
System Memory Active
System Memory Consumed
System Memory Overhead
System Memory Granted
System Memory Available
System Memory Swap In
System Memory Swap Out
Disk IO ms/Read by Datastore
Disk IO ms/Write by Datastore
Disk IO MB/sec Read by Datastore
Disk IO MB/sec Write by Datastore

VMware Guest
Network (VM) In per Guest
Network (VM) Out per Guest
CPU Usage (VM) Utilization per Guest
System Memory (VM) Utilization per Guest
Disk IO (VM) ms/Read per VM
Disk IO (VM) ms/Write per VM
Disk IO (VM) MB/sec Read per VM
Disk IO (VM) MB/sec Write per VM

Includes SSAS, Tabular, and Multidimensional metrics.

SSAS Metrics for Tabular and Multidimensional Modes
SSAS Activity : Rows Transferred: Query Rows Sent/sec
SSAS Activity : Rows Transferred: Proc Rows Read/sec
SSAS Activity : Threads: Formula Engine: Busy
SSAS Activity : Threads: Formula Engine: Job Rate
SSAS Activity : Threads: Formula Engine: Queued
SSAS Activity : Threads: Storage Engine: Job Rate
SSAS Activity : Threads: Storage Engine: Queued
SSAS General : Average Time (ms): Formula Engine
SSAS General : Average Time (ms): SE Cached
SSAS General : Average Time (ms): SE Non-Cached
SSAS General : Average Time (ms): Serialization
SSAS General : Average Time (ms): SQL Queries
SSAS General : Average Time (ms): Processing
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Metrics Article

SSAS

SSAS General : MDX: Cells Calculated
Included
SSASMetrics
General : MDX: Calculated Covers
SSAS General : MDX: Sonarsubcubes
SSAS General : MDX: Recomputes
SSAS General : MDX: NE Unopt
SSAS General : MDX: NE Calc Memb
SSAS Memory : Memory Usage (MB): Shrinkable
SSAS Memory : Memory Usage (MB): Nonshrinkable
SSAS Memory : Cache Activity: Cache Inserts
SSAS Memory : Cache Activity: Cache Evictions
SSAS Memory : Cache Activity: KB Added
SSAS Memory : Cache Activity: KB Shrunk
SSAS Storage : File Reads KB: by Category
SSAS Storage : File Writes KB: by Category
SSAS Activity : Connections
SSAS Activity : Sessions
SSAS Activity : Requests/sec
SSAS Activity : Failures/sec
SSAS General : Current Locks
SSAS General : Current Lock Waits
SSAS Memory : Cache Hit Ratio: Dim Percent
SSAS Memory : Cache Hit Ratio: Calc Percent
SSAS Memory : Cache Hit Ratio: Flat Percent
SSAS Storage : File Cache Hit Ratio: Read Percent
SSAS Storage : File Cache Hit Ration: Write Percent

SSAS Metrics for Tabular Only
SSAS Memory : Mem Usage (MB): VertiPaq Paged
SSAS Memory : Mem usage (MB): VertiPaq Nonpaged
SSAS Memory : Cache Activity: Dim Cache Lookups
SSAS Memory : Cache Activity: Calc Cache Lookups

SSAS Metrics for Multidimensional Only
SSAS General : Processing: Proc Rows Written/sec
SSAS General : Processing: Index Rows Created
SSAS General : Processing: Aggregate Rows Created
SSAS Memory : Cache Lookups: Dimension
SSAS Memory : Cache Lookups: Measure Grp
SSAS Memory : Cache Lookups: Calc
SSAS Memory : Cache Lookups: Flat
SSAS Memory : Cache Activity: Flat Cache Inserts
SSAS Storage : File Queries by Category
SSAS Storage : Current Partitions by Category
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Metrics Article

Azure SQL
Database

Azure SQL Data
Pool

APS

Included Metrics
DTU Usage : Total DTU Percent
DTU Usage : CPU
DTU Usage : Data IO
DTU Usage : Log IO
Memory Usage : Allocated Memory Usage
Database Size : Size in GB
SQL Server Activity : User Connections
SQL Server Activity : Blocked Processes
SQL Server Activity : Transactions
SQL Server Activity : Backup MB/sec
SQL Server Waits : CPU Percent of Total Waits
SQL Server Waits : Wait Time: by Category
SQL Server Waits : Wait Time: by Class
SQL Server Memory : Buffer Cache Size
SQL Server Memory : Page Life Expectancy
Database IO : Read Latency by Database File
Database IO : Write Latency by Database File
Database IO : Log Flushes

Distribution Activity : Data Movement CPU (ms)
Node Activity : Data Movement CPU (ms)
Distribution Activity : Elapsed Time (ms)
Node Activity : Elapsed Time (ms)
Distribution Activity : Rows Processed
Node Activity : Rows Processed
Distribution Activity : MB Processed
Node Activity : MB Processes
Distribution Activity : MB/sec
Node Activity : MB/sec

Processor Time : DMS
Processor Time : SQL Server
Data Movement Read/Writer Buffers : Sender Queued Buffers
Data Movement Read/Writer Buffers : Writer Queued Buffers
Distribution Activity : Data Movement CPU (ms)
Node Activity : Data Movement CPU (ms)
Distribution Activity : Elapsed Time (ms)
Distribution Activity : Rows Processed
Node Activity : Rows Processed
Distribution Activity : MB Processed
Node Activity : MB Processed
Distribution Activity : MB/sec
Node Activity : MB/sec
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Performance Analysis Dashboard Retention &
Resolution
Last Modified on 03 May 2021

Dashboard Resolutions
The Performance Analysis Dashboard displays metrics at different resolution levels, depending on the
historical time range that's selected in the toolbar. Whenever you're viewing the Dashboard in either
Sample mode or in History mode, for ranges of 30 minutes or less, the raw samples collected (detail data)
display. This detail level data has a collection frequency of anywhere from 10 seconds to one minute,
depending on the metric. As you expand the time range you are viewing, averages over the indicated
resolution interval are shown.

Default Time Range

Optional Scalability Pack Time
Range*

Resolution

0 <= 30 min

0 <= 160 minutes

Detail Data

30 min <= 8 hrs

160 minutes <= 16 hours

2 minutes

3 hrs 20 min <= 36 hrs

16 hours <= 80 hours

10 minutes

12 hrs <= 5 days

80 hours <= 10 days

30 minutes

2 days <= 20 days

10 days <= 40 days

2 hours

3 days 8 hrs <= 40
days

40 days <= 80 days

4 hours

10 days <= 1 year

unlimited

1 days

20 days <= 2 years

disabled

2 days

30 days <= 3 years+

disabled

3 days

Historical Data Retention
Performance Analysis uses the SQL Sentry database to store all of the performance data it collects.
Performance data is rolled up, or averaged based on the age of the data. Once data becomes old enough to
move into the next range, it's represented by an average over the time. The default settings for data
retention for the different resolutions are as follows:
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Resolution

Default Retention Length

Optional Scalability Pack Retention
Length*

Detail Data

3 days

15 days

2 min

5 days

59 days

10 min

10 days

113 days

30 min

20 days

176 days

2 hours

40 days

306 days

4 hours

60 days

403 days

1 day

1 year (365 days)

826 days

2 days

2 years (730 days)

disabled

3 days

3 years (1,095 days)

disabled

 Note:
The data retention period can be customized for specific needs. For more information, see the SQL
Sentry Data Capacity Planning article.
Data viewed under the Processes tab follows the same data retention and resolution policies as
outlined above for Performance Analysis.
See the Monitoring Service Settings article for information on other data retention values which
are controlled by settings on the Storage tab of Global Settings. These default values may be
changed there. Data for:
Top SQL, Blocking SQL, and Deadlocks is retained for 15 days.
Event History data is retained for 30 days.
Actions Log is retained for 365 days.
Index usage statistics (Indexes tab) is retained for 365 days.

Example One
A database administrator comes into work on Monday and wants to investigate a performance related issue
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that happened late Friday afternoon. Because detail data is retained for Three days (72 hours), they can
access it using the most granular detail resolution ( 0 <= 30 min).

Example Two
A database administrator wants to compare performance data for the last two months (60 days). The data
needs to be compared using the values for the four-hour resolution, because that's the resolution available at
60 days by default.

*Optional Scalability Pack Resolution & Retention
Feature Availability: This option is currently in a preview status and must be manually applied to your
SQL Sentry database.

The tables above have columns for optional higher resolution performance charts with expanded detail data
retention that can be applied in combination with the SQL Sentry Scalability Pack. To learn more about this
option and how to apply it to your database, see the Enabling Higher Resolution Performance Charts in SQL
Sentry blog post.
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SQL Sentry Overview
Last Modified on 20 September 2021

What is SQL Sentry?
SQL Sentry is a highly capable and scalable platform for enterprise data performance management. It's used
to monitor, diagnose, and optimize Microsoft SQL Server environments. SQL Sentry collects and retains
historical data; allowing for real-time troubleshooting and investigating long-term patterns and changes.
SQL Sentry enables users to correlate events and perform root cause analysis of performance issues and job
failures. The intelligent alerting feature is designed for customization; in addition to general and out-of-thebox conditions, it allows users to create their own Advisory Conditions and Response Rulesets. These alert
optimizations translate to receiving only the alerts that are important to you and unexpected for your system.
An alerting system isn't useful when you filter alerts to a folder that contains tens of thousands of other
alerts. With SQL Sentry, the alerts that allow you to be proactive at your job aren't buried in that type of
spam. Conditions may also be configured with Actions to execute automatically when one is met.

SQL Sentry Use Cases
Some key reasons to use SQL Sentry include the following:
Quick view of real-time and historical events and performance data
Pinpoint and resolve unexpected spikes across important Windows and SQL Server metrics
Intelligent alerting and response system
Performance tuning through identifying bottlenecks
Costly or long-running SQL queries
Blocking
Deadlocks
Processes
Baselines show the impact of code, hardware, workload, and configuration changes
Know what is normal vs. changed performance

Discovering Root Cause with SQL Sentry
Imagine that you're viewing a spike in CPU on the Performance Analysis Dashboard. With SQL Sentry, you can
highlight that CPU spike on the Dashboard and zoom in to see how other metrics were impacted during that
time period. The entire dashboard syncs to your selection. What do you do next? Use the Jump To feature to
go from the Dashboard to another area within the application such as the Calendar, Processes, Top SQL, Disk
Activity, Deadlocks, and more! This empowers you to correlate that spike with other activity and discover the
root cause.
Jump To Calendar context items are made available from various points allowing you to navigate directly to a
Calendar view for the active date range showing all associated Performance Analysis events (Top SQL,
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Blocking SQL and Deadlocks) alongside Event Calendar events such as SQL Agent Jobs, and Windows
Tasks.
Access Jump To Calendar by doing one of the following:
Right-click the desired graph on the Performance Analysis Dashboard, and then select Jump To > Calendar,

or select Jump to Calendar from the toolbar.

Example: Correlating Performance Metrics with Jump To
1. Start on the Performance Analysis Dashboard
2. Select the time period representing the CPU spike
3. Use the context menu to select Jump To
4. Jump To > Top SQL
1. Select the query consuming the most CPU at that time
5. Jump To > Dashboard
1. There's now a visual marker on the Dashboard under the CPU Usage showing the start and end
times of that query
6. Jump To > Top SQL
1. Now that the query is confirmed as the CPU usage culprit, jump back to Top SQL to explore the
query and plan history
2. Is the query trending a certain way?
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1. Verify statistics and index maintenance
3. Is the query using more CPU at noon every day?
Jump To > Calendar
1. What else is running at noon every day?
2. Need to reschedule a job?
4. Does it seem like a random, one time occurrence?
Jump To > Calendar
1. Did someone execute a large report?
There are numerous Jump To options and ways to correlate metrics to events to perform quick and
comprehensive root cause analysis.

Performance Analysis Tabs
Dashboard
The Performance Analysis Dashboard provides an overview of the targets in your SQL Sentry environment.

Processes
The Processes tab contains a grid view of all of the processes for which you are collecting information. They
are grouped by program and function, and you can add new groups for well-known processes.

Disk Activity
The Disk Activity tab provides a patented graphical disk analysis system that breaks down disk activity and
latency at the controller, physical disk, and file level, highlighting bottlenecks at any point in a disk system.

Disk Space
The Disk Space tab contains information about disk space utilization within your environment, broken down
by database and file. Use the Disk Space tab to identify disk capacity issues, understand where various
database files reside on the disk system, and to determine whether available disk space is optimally used.

Top SQL
The Top SQL tab lists all T-SQL batches, stored procedures (RPCs), and statement events collected.

Indexes
The Indexes tab helps you make intelligent decisions about index management in your environment, such as
when and how to perform defragmentation operations, when to adjust fill factors, or when an index
definition should be changed.
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AlwaysOn
AlwaysOn Management includes full alerting capability surrounding your AlwaysOn environment. Fully
customizable conditions alert you on both Health and Failover status.

Blocking SQL
The Blocking SQL tab displays all SQL Server blocks that occurred during the active date range that meet the
Minimum Block Duration. Each block is displayed in a hierarchical format, showing the relationships between
all blocking and blocked SPIDs in a blocking chain.

Deadlocks
The Deadlocks tab displays information about deadlocks happening within your environment. Use the
Deadlocks tab to identify and correct deadlocks on your monitored servers.

QuickTrace™
A QuickTrace™ is a comprehensive snapshot of activity created by combining process-level data and trace
events collected during a brief sample period. Various metrics such as CPU, I/O, recompiles, cache misses,
cursor operations, etc., are automatically aggregated, and are grouped and sorted providing a clear picture
the processes, hosts, applications, or users responsible for activity during the sample.

Navigator Pane
New Event Source nodes are added under SQL Servers for Top SQL, Blocking SQL and Deadlocks, enabling
calendars and other functions for these sources.
Access the Event Source nodes through the Navigator pane (View > Navigator), and then expand the
desired server node.
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For more information about the SQL Sentry Navigator pane, see the Navigator topic.

Event Calendar Pane
The Event Calendar pane has new options for Top SQL, Blocking SQL and Deadlocks to control whether
these sources are displayed in the view.
Open the Event Calendar pane by selecting View > Event Calendar > Event Sources. Select the events you
want to show by selecting or deselecting their respective checkbox.
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 Note: Event Sources shows all events by default.

For more information about the Event Calendar pane, see the Event View topic.

Event Calendar
View Top SQL, Blocking SQL, and Deadlocks on SQL Server, Device, and Custom View calendars.
Jump To Performance Analysis context items on all Calendar events takes you to the selected tab of
Performance Analysis preset to the current calendar date range.

Select Jump to from the Event Calendar.

Corresponding Performance Analysis Dashboard for
selected event.
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Opening a Top SQL, Block, or Deadlock event on the calendar takes you directly into Performance
Analysis with that event selected and expanded.

Select Open for Top SQL event.
Corresponding Performance Analysis Query plan for
selected event.

For more information about the SQL Sentry Event Calendar, see the Calendar topic.

Conditions, Actions, and Settings
Performance Analysis conditions are available in the Conditions pane (View > Conditions) for the following
SQL Server instances:
Blocking SQL
Blocking SQL: Output Content Match
Blocking SQL: Runtime Threshold Max
Deadlock
Deadlock: Output Content Match
Top SQL
Top SQL: Output Content Match
Top SQL: Runtime Threshold Max

The Run Quick Trace action is available for certain SQL Sentry conditions. This action executes and saves a
Quick Trace when the condition is triggered, including the following:
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Event Chain Node: Runtime Threshold Max
Event Chain: Runtime Threshold Max
Performance Counter: Threshold Max
Performance Counter: Threshold Min
SQL Server Agent Job: Block
SQL Server Agent Job: Retry
SQL Server Agent Job: Runtime Threshold Max
SQL Server: Blocking SQL
SQL Server: Blocking SQL: Runtime Threshold
Max

Performance Analysis settings are available from the Settings pane (View > Settings):

Blocking SQL
Blocking SQL Source
Deadlocks Source
Top SQL
Top SQL Source

Additional Information: For more information about Conditions in SQL Sentry, see the
Conditions topic.
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SQL Sentry Performance Metrics
Last Modified on 18 February 2021

This article covers the various performance metrics displayed by the Performance Analysis Dashboard and
Performance Analysis Overview, and how to interpret different metric values and combinations of values
across different metrics for SQL Sentry.

 Note: For Mode: S = Sample and H = History.

SQL Server Metrics
Section

Metric

Description
The total number of connections established to the SQL
Server. Details for each connection can be viewed by
querying the sys.dm_exec_connections DMV.

SQL Server
Activity

User
Connections

Mode:

S

Type:

Last value

The total number of blocked processes detected on the SQL
Server. The Dashboard is designed to give you information
about the number of blocked processes. The Blocking SQL
tab should be used for in depth troubleshooting of any
blocking issues.
SQL Server
Activity

Blocked
Processes

Mode:

S

Type:

Last Value
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Section

Metric

Description
The total number of select, insert, or delete statements per
second, including those inside a stored procedure. The
name is somewhat misleading since it doesn't represent
batches (groups of multiple statements) in the traditional
sense. It's one of the best measures of overall activity on a
SQL Server.

SQL Server
Activity

Batches

Over 1000 Mb per second is generally considered moderate
to high activity. A 100Mb network can reach saturation at
around 3000 Mb per second.
If high, use QuickTrace™ to determine which applications,
hosts, etc., are responsible.
Mode:

S, H

Type:

Avg/sec

The total number of transactions per second across all
databases on the server. A transaction can be either a userdefined statement block surrounded by a BEGIN TRAN and
END TRAN, or an individual DML statement (insert, update
or delete).
Compare with batches per second. On systems with high
DML you typically want to see a low ratio of transactions to
batches. A low ratio indicates that the individual statements
are being bundled together, and can result in dramatically
higher throughput and reduced IO due to log flushes.
SQL Server
Activity

Transactions

Transactions per second can be higher on SQL Server 2005
and 2008 due to increased system process activity.
If high, use QuickTrace to determine which applications,
hosts, etc., are responsible.
Mode:

S, H

Type:

Avg/sec
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Section

Metric

Description
The total number of initial compiles and recompiles per
second. The value should generally be < 10 percent of
batches per second. Higher values indicate plan reuse is
low, and will generally correlate with high CPU, since plan
compilation is a CPU intensive operation. It may also
correlate with low cache hit ratios for object and/or SQL
plans (see "Plan cache hit ratios" below).
It can also be a strong indicator of memory pressure, since
there may not be enough room to keep all plans in cache.

SQL Server
Activity

Compiles

If you see consistently high compiles, run QuickTrace and
sort results by Cache misses/sec, then expand details to
view the actual queries or procedure calls that are causing
the misses, which will be highlighted.
Also see:
Batch Compilation, Recompilation, and Plan Caching
Issues in SQL Server 2005
Caching Mechanisms
Mode:

S, H

Type:

Avg/sec

 May correlate:

High CPU
Low cache hit ratios

The number of recompiles per second. The value should
generally be < 10 percent of initial compiles per second.
Also see Compiles above.
SQL Server
Activity

Recompiles

Mode:

S, H

Type:

Avg/sec
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Section

Metric

Description
The number of times per second that the query processor
had to perform a key lookup, across all queries. Lookups
occur when the index being used is non-covering, meaning it
doesn't include all of the columns required by the query. For
each row returned by the index operation, the query
processor has to go back to either the clustered index to
perform a key lookup, or the base table to perform a RID
lookup in the case of a heap. Lookups are a high overhead
operation, especially when large number of rows are
involved, because each lookup incurs a random I/O and
additional processing. This often correlates with higher CPU
usage and page reads. Lookups can be eliminated by using a
covering index, adjusting joins to reduce the set so the
lookup isn't needed, or using multiple indexes
(intersection).

SQL Server
Activity

Key lookups

Also see:
Craig Freedman's SQL Server Blog A discussion of
query processing, query execution, and query plans in
SQL Server
SQLSkills blog Kimberly L. Tripp Improving my SQL
skills through your questions
Mode:

S, H

Type:

Avg/sec

 May correlate:

CPU Usage: User time
Page Reads

824

Section

Metric

Description
The number of times per second that the query processor
had to lookup forwarded records, across all queries.
Forwarded records occur in tables with no clustered index
(heaps) when rows become too large to fit on the page and
have to be relocated. Over time, this can cause severe
fragmentation and queries to incur much higher than
normal I/Os, specifically random reads. This can correlate
with high SQL Server page reads, and high SQL Server disk
wait time, data file and physical disk latency if the disk
system isn't keeping up with the additional reads. On many
systems it's not unusual for this counter to stay at zero if all
tables have a clustered index, any heaps aren't fragmented,
or they just aren't accessed frequently.
Also see:
Knowing about 'Forwarded Records' can help
diagnose hard to find performance issues.
Geek City: What's Worse Than a Table Scan?

SQL Server
Activity

Forwarded
records

Mode:

S, H

Type:

Avg/sec

 May correlate:

SQL Server Memory: Read
pages
SQL Server Waits by
Category: Disk
Disk IO
Database IO: ms/Read

The data rate in MB/sec for any backup operations taking
place on the server.
SQL Server
Activity

Backup MB/sec

Mode:

S, H

Type:

MB/sec
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Section

Metric

Description

The Send Queue and Redo Queue are applicable for
servers involved in a database Mirroring Session.

SQL Server
Activity

Send Queue /
Redo Queue

The Send Queue represents unsent the log that has
accumulated on the log disk of the principal database. The
Redo Queue is the log waiting on the mirror's disk. See also:
Database Mirroring Sessions

Mode:

S, H

Type:

MB

CPU percentage of Total Waits represents the percentage
of all waits which are signal waits. Signal wait time is the
time a thread has spent waiting on the CPU after being
signaled that its resource is available. A high CPU
percentage of Total Waits percentage may indicate CPU
pressure.
SQL Server Waits

CPU percent of
Total Waits

Mode:

S

Type:

Percent

 May correlate:

High CPU

The average wait time (in milliseconds) per second for all
processes on the server, broken down by major physical
resource category (Network, CPU, Memory, Disk). Although
there are hundreds of wait types, only the wait types that
can definitively be attributed to one of the physical
resource categories are included in the calculations for this
chart. The Other category is for a few other important wait
types that can either affect performance in more than one
major category, or cannot be directly attributed to any
category with absolute certainty, such as backups and
parallelism respectively.
Waits by category is one of the most important charts on
the dashboard, because it provides an instant profile of the
SQL Server and where it's spending the most time waiting
for physical resources. If waits by category are consistently
low, then what the other dashboard charts are showing is
less important. For example, if CPU and batches look
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Section

Metric

unusually high, but CPU waits are low, then the server
Description
hardware is effectively handling the load.
Total waits of less than 200ms is very good. Between
200ms and 1000ms is average. Greater than 1000ms likely
requires some attention to determine where the
bottleneck lies. Over 5000ms may indicate severe
bottlenecking.

SQL Server Waits

Wait Time: by
Category

The total wait time may be higher by virtue of a large
number of processes (spids) active on the server, because
wait time is summed across all processes, it isn't a per
process average. This can be especially applicable to the
Other category, because several processes experiencing
parallelism at the same time can cause it to spike to very
high levels.
To view the specific wait classes involved for a particular
interval, choose the interval by selecting on the chart, and
then select the Sample button on the toolbar.
If you hover over a category, the detailed wait types for
that time sample are shown in a tooltip. You can also see
the specific wait types for a range by running the SQL
Server Wait Stats Analysis report from the
Reports >Performance Analysis menu.

See also:
SQL Server Best Practices Article
Wait statistics, or please tell me where it hurts
What to do (or not do) about top wait stats
Adding Custom Wait Categories
Mode:

H

Type:

Avg ms/sec
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Section

Metric

Description
The average wait time (in milliseconds) per second for all
processes on the server, broken down by wait class. There
are approximately 30 different wait classes, and each
represents a particular SQL Server functional area or type of
activity. Meaningless or innocuous wait types such as timer
and queue waits are pre-filtered from view. Each class is
further broken down into resource and CPU waits.

SQL Server Waits

Wait Time: by
Class

If you hover over a class column, the detailed wait types are
shown in a tooltip.
Mode:

S

Type:

Avg ms/sec

The current size of the buffer cache, in MB. You want this to
be as large as possible for maximum performance, and on a
dedicated SQL Server it should consume most of the SQL
Server memory and physical memory.
SQL Server
Memory

Buffer cache
size

Mode:

S, H

Type:

MB

The current size of the cache used for query plans, in MB.
This includes adhoc, autoparameterized, and prepared
plans. A high value in proportion to the buffer cache may
indicate query plans aren't being effectively reused.
See also:
Caching Mechanisms
SQL Server
Memory

Plan cache size
(SQL)

Mode:

S, H

Type:

MB
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Section

Metric

Description
The current size of the cache used for object plans, in MB.
This includes stored procedures, functions, and triggers. A
high value in proportion to the buffer cache may indicate
query plans aren't being effectively reused.

SQL Server
Memory

SQL Server
Memory

Plan cache size
(Objects)

Other cache
size

See also:
Caching Mechanisms
Mode:

S, H

Type:

MB

The current size of the cache used for all other plans, in MB.
This includes bound trees, extended stored procedures,
temporary tables, and table variables. This cache size should
be low in proportion to the other plan caches. If it goes over
roughly 10 percent of the object or SQL plan size, further
investigation may be needed.
Mode:

S, H

Type:

MB

The ratio of hits to lookups for the query plan cache. This
value should stay above 90 percent.
SQL Server
Memory

Plan cache hit
ratio (SQL)

Mode:

S, H

Type:

Percent

The ratio of hits to lookups for the object plan cache. This
value should stay above 90 percent.
SQL Server
Memory

Plan cache hit
ratio (Objects)

Mode:

S, H

Type:

Percent
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Section

Metric

Description

The current amount of memory in MB dedicated to InMemory OLTP. This includes Memory-optimized tables, nondurable tables, and natively compiled T-SQL modules.
SQL Server
Memory

In-Mem OLTP
Mode:

S, H

Type:

MB

The current amount of memory in MB allocated to the
MEMORYCLERK_SQLQERESERVATIONS clerk.
Additional Information: Memory Grants Meditation: The
mysterious SQL Server memory consumer with many names
SQL Server
Memory

Query Grants

(Microsoft Tech Community article).

Mode:

S, H

Type:

MB

The amount of memory that could be used for buffer, but is
consumed by another task and is not available for buffer.
Stolen Buffer can be reduced by optimizing queries.
Granted workspace memory can reduce the amount of free
SQL Server
Memory

Stolen Buffer

memory available and increase Stolen Buffer.

Mode:

S, H

Type:

MB
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Section

Metric

Description
The current amount of memory in MB allocated to
columnstore indexes. This includes both clustered and
nonclustered indexes.

SQL Server
Memory

Columnstore

Mode:

S, H

Type:

MB
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Section

Metric

Description
The average number of buffer data pages read from disk
per second. Ideally, this value should be at or near zero
most of the time. If it's above zero, it means that the data
wasn't found in the buffer cache, and so it had to be
retrieved from disk. If spikes in page reads correlate with
high disk latency, the disk system may not be keeping up.
Querying newly created temp tables will also show up as
page reads, as well as activity from internal tempdb objects.
This includes hash joins, hash aggregates, sort and query
spool operations. This means that you can still see high
paging from tempdb due to query activity, even though you
aren't explicitly using temp tables.
When page reads and page writes correlate closely, it's a
strong indicator that it's related to tempdb activity,
because pages are being written to disk when the objects
are created, then immediately read back in to memory for
use by querying operations.

SQL Server
Memory

Page reads

If lazy writes > zero and track closely with page reads, and
page life expectancy < 600, it's a strong indicator of
memory pressure, because data is being moved out of
buffer to make room for new data coming in.
Lazy writes also cause page writes, but generally much less
than tempdb activity. If you see high page reads, and
relatively low lazy writes and page writes, it's likely memory
pressure and not tempdb activity.
See also:
Working with tempdb in SQL Server 2005
Mode:

S, H

Type:

Avg/sec

 May correlate:

Disk IO
Database IO: ms/Read
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Section

Metric

Description
The average number of buffer data pages writes to disk per
second.
Page writes can be caused by checkpoints, lazy writes, and
tempdb activity. To calculate the approximate amount of
writes related to tempdb, for any given interval, subtract
checkpoints and lazy writes from total page writes.
If high page writes correlate with high latency, the disk
system may not be keeping up.
See Page reads for more details.

SQL Server
Memory

Page writes

Mode:

S, H

Type:

Avg/sec

 May correlate:

Disk IO
Database IO: ms/Write
Lazy writes
Checkpoint pages

The average lifespan of a data page. If this value is less than
600, it's an indicator of memory pressure. Ideally, it should
be much higher than 600 if ample memory is available. In
general, the larger the buffer cache size, the higher it
should be. This is the best universal indicator of memory
pressure.
SQL Server
Memory

Page life
expectancy

Mode:

S

Type:

Last value

 Critical range:

<600
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Section

Metric

Description
The number of processes waiting for a query workspace
memory grants. Ideally, this value should be zero at all
times, but it can go above zero in cases of severe memory
pressure.

SQL Server
Memory

Memory grants
pending

When it does, RESOURCE_SEMAPHORE waits will also be >
zero, since this wait is a measure of the time that queries
had to wait for memory grants. This type will be visible in
the Waits chart tooltips for the Memory class and category.
Mode:

S

Type:

Last value

 Critical range:

> Zero

The average time in milliseconds each physical disk read is
taking for a particular database file. The top 10 database
files (data and transaction log) with the highest latency for
the specified date range are shown. In History mode, select
the dropdown box to determine whether total database
latency or a specific database file is shown on the chart.
Database IO

Read latency by
database file

See the Disk IO: Read latency section for more details and
performance ranges.
Mode:

S, H

Type:

Avg ms/Read

The average time in milliseconds each physical disk write is
taking for a particular database file.
See Database IO: Read latency and Disk IO: Read latency
sections above for more details.
Database IO

Write latency by
database file

Mode:

S, H

Type:

Avg ms/Write

The average pages per second written to disk by the
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Section

Metric

checkpoint process. Checkpoints flush all dirty buffer pages
Description
for a given database to disk and are a normal part of SQL
Server operations. The frequency of checkpoints and
volume of checkpoint pages is dictated directly by the
Recovery Interval server option. SQL Server uses
checkpoints to batch writes to disk, which is generally more
efficient. However, if the volume of each checkpoint is too
high and you see a correlation with high disk latency, it may
indicate that the disk system isn't keeping up.
 Note: SQL Server 2016 introduced Indirect Checkpoints
that are defined and configured at the database level.
Indirect Checkpoints are set by default for SQL Server 2016
databases.
Checkpoints may correlate with lower page life expectancy,
but only because when pages are flushed from memory PLE
can drop, not because there is a direct correlation with
memory pressure and checkpoints. It will also correlate
directly with high SQL Server page writes. If you see a
correlation with high disk latency or high SQL Server disk
waits, then the disk system may not be keeping up with the
checkpoint volume. By lowering the recovery interval you
can increase the frequency and at the same time lower the
volume of each checkpoint, which may lessen the overall
impact on disk waits. Every system is different in this
regard, however, so testing of different recovery intervals
should be performed and the impact observed.
This counter may, correlate with lazy writes, because it
depends more on the activity profile of the server, even
under memory pressure. If checkpoints are happening
often enough to meet the specified recovery interval, there
may not be much work for the lazywriter threads to do
when they wake up.

Database IO

Checkpoint
pages

If the lazywriter threads are staying continually busy, and
the number of dirty pages is low enough to meet the
recovery interval, the checkpoint process may never have
much, if any, work to do.
On SQL Server 2008, you can use the -k startup parameter
to control the max MB per second that can be written by
the checkpoint process, in the event that the checkpoint
process is overwhelming the disk system. This isn't a typical
scenario, however, so this option should be tested carefully
before use, and other possible solutions should be
investigated first.
If write latency exceeds 20ms, the checkpoint process will
be automatically throttle to avoid overloading the disk. This
can happen even when the disk is capable of easily
sustaining higher throughput, and can lead to abnormally
long checkpoints, and blocking of the log writer process.
DBCC TRACEON (3502, 3504, -1); will log many additional

835

Section

Metric

details about the checkpoint process to the SQL Server
Description
error log, and can be very helpful for troubleshooting
checkpoint related issues.
See also:
SQL Server I/O Basics, Chapter 2
SQL 2016 – It Just Runs Faster: Indirect Checkpoint Default
CHECKPOINT (Transact-SQL)
Changes in SQL Server 2016 Checkpoint Behavior
Mode:

S, H

Type:

Avg/sec

 May correlate:

Disk IO
Database IO ms/Write
Lazy writes

The average number of writes per second by the lazy writer.
The lazy writer periodically scans the buffer and evicts
pages that have low use counts in order to maintain a
certain number of pages on the free list. Ideally, this value
should be at or near zero most of the time. When there is no
memory pressure, the lazy writer will generally leave data
pages in memory, even those with low use counts.
However, when pressure exists, the lazy writer will
continually be working to make room for new data coming
into the buffer.
An indicator of memory pressure is ongoing lazy writes >
zero with page reads/writes > zero and page life
expectancy< 600.
Database IO

Lazy writes
Also see Checkpoint pages above.
Mode:

S, H

Type:

Avg/sec

 Critical range:

>20

 May correlate:

Page life expectancy
Page reads/writes
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Section

Metric

Description
Log flushes occur with every DML operation, and are a
normal part of SQL Server activity. It's important to note
that log writes to physical disk from updates to buffer
pages happen immediately upon transaction commit,
whereas writes to physical disk from the changed buffer
pages is delayed until the next checkpoint occurs. It's critical
that the physical disk system where the transaction log
resides is fast enough to keep up with activity. If not, it can
slow down all DML operations occurring in the database.

Database IO

Log flushes

Ideally each busy transaction log should have its own
dedicated disks, so that writes can happen sequentially,
which will minimize latency. If log flushes are high and
latency is high for a transaction log file, then the disk
system is likely underpowered for the current load.
Additional Information: Understanding log buffer
flushes
Mode:

S, H

Type:

Avg/sec
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Query Plans
Last Modified on 06 May 2021

Applies to: SQL Server and Azure SQL Database targets

The Query Plans tab lists all plans collected for Top SQL completed queries for the specified date range, and
provides a detailed chronology of all completed query plan changes. Use Query Plans to look back at any
point in time to see when a plan change led to a query performance problem.

 Note: The Query Plans tab does not currently display collected Top SQL Query Stats or Procedure
Stats query plans.

The Show Totals toolbar button controls whether the
grid lists plans are grouped by stored procedure.

Show Totals toolbar
button.

Show Totals enabled.

Show Totals disabled.

Jump To > Query Plans tab by highlighting a range on the dashboard as usual. For example, if you see a spike
in parallelism waits on the SQL Server Waits chart, highlight the spike, and then select Jump To > Query
Plans. Sort by the Parallel Operations column to determine which queries caused the spike.

Sort by Parallel Operations in Query Plans.

Highlight spike, then select Jump to > Query Plans.
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 Note: The same approach can be used to find queries with key or RID lookups because Lookups are
now displayed on the Dashboard, as well as other metrics that correlate, such as I/O and table/index
scans.

Display Panes
Display Pane

Image

The Filter pane allows you to filter the Query
Plans by SQL Server.

The Bottom pane lists the records matching the
current filters. There are two modes for this pane:
Default and Totals.

Default lists all events for the active date range in
a standard list format, sorted in order by
Database name, Object name, and Plan Creation
Time (descending).
Totals lists all events for the active date range in a
standard list format, sorted in order by
Database name, Object name, and Plan Creation
Time (descending).

Controls
Top Pane
After changing the filter, select Refresh , or press F5 to apply the filter.

Bottom Pane
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To open the plan in the Query Plan Analysis window, select the Open button under the Plan column. (If the
Show Totals button is selected, you need to expand the Database Name to see the Plan column).

 Note: The context menu provides an option to Highlight recompiles in the current date range for
a statement by enabling the checkbox.
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Performance Analysis Processes
Last Modified on 20 September 2021

Applies to: Windows, SQL Server, and SSAS targets when the target has Windows (meaning targets on
Linux, AWS RDS, and Azure Managed Instance, for example, will not have this tab). It's only available for
SQL Server when using the advanced security mode (i.e. Full Access).

Overview

Default Processes Collected
The Processes tab is available as part of Performance Analysis for Windows.
By default, Performance Analysis for Windows collects information about well-known or categorized
processes. There are several of these predefined, well-known process groups, including groups for:
SQL Server
IIS
SSAS
SSIS
SSRS

Collecting Additional Processes
To collect information about processes that aren't in these default groups, you have a couple of different
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options to do so:
Add your own well-known groups, and then specify the processes that belong to them.
Configure an Uncategorized Process Filter, that allows for the collection of uncategorized processes.
You may choose to use both of these options. For example, you may wish to define several new well-known
process groups that are relevant to the monitored computer's workload, so that information about those
processes is always collected. You may also wish to define an Uncategorized Process Filter, so that
information about processes that are consuming a large amount of resources on the computer are collected.

Processes Tab Display
The Processes tab contains a grid view of all the processes for which you are collecting information.
Processes are intelligently grouped by program and function, including groups for SSRS, SSIS, and SQL Server
(well-known process groups). Metrics are displayed for each process, giving you insight into the resource
usage for both the individual processes and their associated groups.

Display Options
Show in groups — Groups well-known processes by their assigned group or category.

Showing/Hiding Groups — Hides certain groups from view using the group drop-down list box. Uncheck
any group that you want to hide.
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Show well-known processes only — Hides any processes that aren't part of a well-known group.

Additional Columns — Access Additional Columns by right-clicking on any column header and selecting
the Column Chooser option.

Sorting Columns — Sort the grid view by specific columns by selecting any column header. Additional
sorting options are available from the context menu of any column header.

Adding New Groups of Well-Known Processes
By default, there are several well-known processes that are logically grouped by program/function, including
predefined groups for SQL Server, IIS, SSAS, SSIS, and SSRS. Add additional groups of your own by using the
following SQL Sentry database tables:
Performance Analysis Device Process Group
Performance Analysis Device Process Group Mapping

Performance Analysis Device Process Group
Use this table to define groups and your well-known processes.

Column Name

Description
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Column Name

Description

ID

Identity column

ProcessGroupName

This is the group name that displays in the Processes tab.

ProcessGroupNameFull

The full name isn't displayed in the Processes tab.

ProcessGroupDescription

The description of the process group.

Performance Analysis Device Process Group Mapping
Use this table to map specific processes to the groups you defined in the Performance Analysis Device
Process Group table.

Column Name

Description

ID

Identity column

PerformanceAnalysis
DeviceProcessGroupID

The ID of the group you would like this process to map to. Should map to
the ID column of a group found in the Performance Analysis Device
Process Group table.

ProcessName

Enter the exact name under which the process is executed, including the
executable extension. For example: services.exe

Enter the name of the service exactly as it's displayed on the General
properties tab of the service as shown from the services applet.
ServiceName

To find the actual service name, open the services applet and right-click
the service, and then choose Properties. Use the exact value found in the
Service name field.

ShowOnPADashboard

Specifies if the group displays on the Performance Analysis Dashboard.

CommandLineMatchRegex

This column is useful when differentiating processes that use the same
executable, but perform different functions based upon the passed in
parameters. The regex should use a valid .NET compatible regular
expression as defined here.
 Note: The match operation is case-insensitive.
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Group Mapping Example
As an example, if the target you are monitoring is a Microsoft Exchange server, you may want to create a new
group of well-known processes that includes those related services. In this example we create a new group of
well-known processes for Microsoft Exchange, and then we add the following Microsoft Exchange related
services to the group:
Microsoft Exchange Information Store
Microsoft Exchange Mailbox Assistants
Microsoft Exchange Transport
Create the Group
INSERT INTO dbo.PerformanceAnalysisDeviceProcessGroup (ProcessGroupName,ProcessGroupNameFull)
VALUES ('Microsoft Exchange','Microsoft Exchange Server 2010')

Add the processes and map them to the group
INSERT INTO dbo.PerformanceAnalysisDeviceProcessGroupMapping
(PerformanceAnalysisDeviceProcessGroupID,ProcessName,ServiceName,ShowOnPADashboard)
VALUES
(9,'Store.exe','MSExchangeIS',1), (9,'MSExchangeMailboxAssistants.exe','MSExchangeMailboxAssistants',1), (9,'MSExc
hangeTransport.exe','MSExchangeTransport',1)

 Important: Be sure that the PerformanceAnalysisDeviceProcessGroupID corresponds to the ID
column of your desired group in the Performance Analysis Device Process Group table.

Process Collection Settings
Process collection is controlled with the Windows Instance Settings and can be accessed by completing the
following steps:
1. Select the desired Windows instance in the Navigator pane.
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2. Open the Settings pane (View menu > Settings).

3. In the Settings pane choose the Windows instance from the drop-down menu.
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You should now see the Process Collection settings in the Settings pane. By default, when a Windows
instance is monitored, process information is collected about all well-known processes. Disable the collection
of process information by changing the Collect Processes setting to False.
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You may enable the collection of additional processes (non well-known processes) by configuring an
Uncategorized Process Filter.

Configuring an Uncategorized Process Filter
By default, Performance Analysis for Windows collects information about well-known or categorized
processes. Configure SQL Sentry to collect information about Uncategorized processes by specifying an
Uncategorized Process Filter. This filter may be built around various metrics, including percentage CPU time
or Read and Write bytes per second.

 Important: This filter exists by default for process collection. Changing the filter to allow for more
collection may add significant overhead to your network and the SQL Sentry database. Consider using
baselines to measure how your changes impact your environment.

Follow the directions in the previous section to access the Process Collection settings for your Windows
instance.
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1. Select the Uncategorized Process Filter row and use the ellipsis (...) to open the Filter Editor.

2. Add rules to the filter as desired.

Add rules to the default filter (shown here)

 Note: The Filter Editor was designed with flexibility in mind, and allows you to specify any number
of criteria around events. You can define a complex rule with multiple groups and logical operators.
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For more information about using the Filter Editor, see the Filter Editor topic.

SolarWinds Database Mapper Environment Map
The SolarWinds Database Mapper Environment Map shows data collected from the SQL Sentry database to
map connections between applications, users, clients and targets (sourced from Top SQL and Windows
processes). This information complements the lineage analysis feature by showing the dynamic usage of
targets in the lineage diagram and shedding light on the processes that are using the database.
To learn more about using Windows processes data with Database Mapper, see the Environment Map article.
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Performance Analysis Top SQL
Last Modified on 20 September 2021

Applies to: SQL Server, SSAS, and Azure SQL Database target types.

SQL Sentry Portal: This feature is available in SQL Sentry Portal. To learn more about configuring your
environment to use the on-premises, browser-based option with your existing SQL Sentry database, see
the SQL Sentry Portal article.
 See the SQL Sentry Portal Top SQL article for an example of the Top SQL feature in a browser.

Introduction

Top SQL tab

The Top SQL tab lists all T-SQL batches, stored procedures (RPCs), and statement events collected for the
current date range that exceeded the Minimum Duration specified in the Settings pane. The default filter is
Duration, but filtering using CPU and IO is also available. The default minimum duration is five seconds, but
this can be adjusted up or down as needed through the Top SQL Source settings.
To collect Top SQL metrics for Azure SQL database targets the Allow SQL Sentry Monitoring Objects in
Target setting under the Azure SQL Database Connection settings must be set to True. This option creates
a few objects within a SQL Sentry schema on the target database. See the Watched Target Objects article for
details.
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Top Section Grid View
The Top section Grid View displays queries in your environment. View Running Queries, Completed Queries,
Procedure Stats, or Query Stats by selecting the corresponding tab.

Open Plan Explorer for the expanded query by selecting Open.

Statement Grid
The Statements Grid displays the statements that were collected with the associated completed query,
procedure stats or query stats. It provides details on the key performance metrics that are associated with
each component part of the larger query. This allows you to see which resources were consumed by which
part of the batch.

Execution Plan Diagram
The Plan Diagram displays a graphical plan preview of the desired query in your environment.
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Select Open with Plan Explorer to view the query diagram in more detail. Hover over a plan diagram icon to display a
tooltip with more detailed information.

Select Open with Plan Explorer to open the integrated Plan Explorer view for the selected execution plan.
For more information about Plan Explorer, see the Plan Explorer topic.

Query History
Query History displays a graphical representation of the selected query over a specified range of time. Query
History provides information about the query execution plans, if and when they were changed, and how they
impacted different resources. Each dot represents when the query was executed. Different colors on the dots
indicate the different plans, and the plans are numbered. Adjust the time displayed on the graph with the
Range slider.

 Note: Hovering over any of the dots on the Query History graph provides you with additional
information.

 Note: Right click any dot on the Query History graph, and select Open Plan from the context menu
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to open the Plan Explorer diagram.

Open Plan

Additionally, adjust the graph to identify historical procedure and statement executions through CPU, IO, or
Duration metrics.

Query History Graph visualization options
Grouping

Metric

Mode

Hour

Duration

Statement

Day

CPU

Procedure

Week

IO

Display Tabs
Filter
The Filter tab provides the following filters for controlling which records display:
SQL Servers
Applications
Databases
Hosts

Select any combination of items to set the filters. To select more than one item, use Shift-Click or CTRLClick. View the filtered results by selecting Refresh or F5.
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Show Top Control- Controls how many rows are retrieved.

 Note: The Filter tab isn't displayed on an Azure SQL Database target.

Running Queries
The Running Queries tab shows all running queries matching the current filters and is independent of the
time range setting. The View button in the Plan column opens a Plan Explorer session for the associated
query. The Text Data column shows the original text the client sent to the server and the Active Statement
column shows the currently running statement.

Running Queries

 Note: Running queries isn't supported for SQL Server 2000 or Azure SQL Database.
 Note: The text data for the active statement is displayed in the Text Data pane when the
Active Statement cell is selected.

Completed Queries
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The Completed Queries tab lists all records matching the current filters. The View button in the Plan column
opens a Plan Explorer session for the associated query. The default filter displays all records. There are two
modes for this pane: Default and Totals.
Default mode lists all events for the active date range in a standard list format, sorted descending by End
Time by default. Default mode is activated whenever auto-refresh is enabled by selecting Play on the
toolbar, which shows the events for the last 10 minutes with new events coming in automatically at the top of
the list.
Totals mode is enabled by selecting Show Totals (the sigma Σ button). This groups all like events together
using a normalized version of the T-SQL with all variable parameters replaced, and it shows aggregates for
each group. This enables you to quickly determine which events are responsible for the most CPU or IO
activity for the active date range.

Completed Queries
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 Note: SQL Sentry 8.2 introduces enhanced SQL text data normalization. If upgrading from a build
prior to 8.2, enhanced normalization must be activated in the Monitoring Service Settings >
Performance Monitor tab.

Procedure Stats

The Procedure Stats tab provides aggregate information for all procedures matching the current filters. The
View Plan button in the Plan column opens a Plan Explorer session for the associated procedure. Additional
historical information may be available in the Runtime Stats. Open Runtime Stats by right clicking on a
procedure and selecting Jump To > Runtime Stats.

Procedure Stats
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 Note: SQL Sentry installations upgraded from a version older than 8.2 need to enable the Collect
Query Stats option in the Top SQL Source setting.
 Note: Procedure Stats isn't available for SQL Server 2000 or SQL Server 2005.

Query Stats

The Query Stats tab provides aggregate information for queries matching the current filter. This area also
provides insight into queries that run very quickly and in high volume.

Query Stats
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 Note: SQL Sentry installations upgraded from a version older than 8.2 need to enable the Collect
Query Stats option in the Top SQL Source setting.
 Note: Query Stats isn't available for SQL Server 2000 or SQL Server 2005.

Command Text
The Command Text tab shows the T-SQL text data for the currently highlighted Top SQL record with syntax
highlighting.

Command Text

Top SQL Runtime Stats
The Top SQL Runtime Stats option provides insight into the frequency and duration of the queries and
procedures that are captured by Top SQL.

Additional Information: See the Top SQL Runtime Stats article.

Top SQL Metrics
Default Metrics
Name

Description

Plan

Select Open to open a new Plan Explorer session for the captured
query plan.

Host

Name of the target where the associated captured query originated.
The event class of the associated captured query.

Event Class

Additional Information: For more information, see the SQL Server
Event Class Reference MSDN article.
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Name

Description

Text Data

Associated text data captured for the query.

Login

The Windows or SQL Server account associated with the captured
query.

Duration

The amount of time taken by the captured query.

CPU

The amount of CPU time (in milliseconds) used by the captured query.

CPU %

The percentage of CPU time used by the captured query, in relation to
any other Top SQL events that are shown in the grid.

Reads

The number of logical reads from the cache performed by the server
on behalf of the captured query.

Reads %

The percentage of bytes read by the captured query, in relation to any
other events that are shown in the Top SQL Grid view.

Writes

The number of physical disk writes performed by the server on behalf
of the captured query.

Writes %

The percentage of bytes written by the captured query, in relation to
any other events that are shown in the Top SQL Grid view.

Start Time

Time the captured query started.

End Time

Time the captured query ended.

Information

Additional data captured about the query.

Error

Error number of a given captured query.

SPID

The server process ID (SPID) that is assigned to the process.

Host Process ID

The ID assigned by the host computer to the process where the client
application is running.

Server

The SQL Server instance where the associated captured query took
place.

Additional Metrics
The following metrics do not appear by default, but can be added through the column chooser. See the Data
Grids article for additional information on choosing columns.
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Name

Description

Application

Name of the client application that created the connection.

Database

Name of the database for the associated captured query.

Granted Memory (KB)

The amount of memory in KB granted to the captured query.

Granted Query Memory
(KB)

The amount of memory in KB granted to the query.

Has Plan

True if the associated query has a captured plan.

Has Statements

True if the associated query has captured statements.

Ideal Memory (KB)
Is incomplete

True if the associated query is incomplete.

Parent ID

The ID assigned to the Parent query.

Requested Memory (KB)

The amount of memory in KB requested by the captured query.

Session Memory (KB)

The amount of memory in KB used during the session.

Tempdb Internal (KB)

The amount of memory in KB used by tempdb internal objects.

Tempdb Internal (KB)
Dealloc

The amount of memory in KB that is deallocated for tempdb internal
objects.

Tempdb User (KB)

The amount of memory in KB that is used by User objects.

Tempdb User (KB) Dealloc

The amount of memory in KB that is deallocated for User objects.

Visible

Specifies the default visibility for the select row. Queries may be
hidden in Top SQL.

Changing What's Collected for Top SQL
Change the Top SQL that's collected by SQL Sentry through the Top SQL Source settings. Change the Top
SQL events collected by SQL Sentry through the Top SQL Source settings at these levels: All Targets
(Global), site, target group, target, and instance.
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Collection Settings

 Note: As a reminder, all settings have a hierarchical configuration, and work through the principle of
inheritance. Any changes you make at one level is automatically inherited by all objects below it. For
more information about inheritance within SQL Sentry, see the Alerting and Response System topic.

Example One
To configure the Top SQL Minimum Duration Collection setting globally complete the following steps:
1. Select the All Targets node in the Navigator pane (View > Navigator).
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2. In the Settings pane (View > Settings), select SQL Server from the top drop-down list.

3. Select Top SQL Source from the second drop down list to open the Top SQL Source settings that are
being applied globally.

4. Change the Minimum Duration to the desired value; it saves automatically.
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Example Two
To configure the Top SQL Minimum Duration Collection setting for an individual instance complete the
following steps:
1. Select the desired instance node in the Navigator pane (View > Navigator).

2. In the Settings pane (View > Settings), select SQL Server from the top drop-down list.
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3. Select Top SQL Source from the bottom drop-down list to open the Top SQL Source settings that are
configured for the instance.

4. Within the Collection Settings section change the Inherit From Parent setting to False.

5. Change the Minimum Duration to the desired value; it saves automatically.
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There are a few additional things you should know regarding the Top SQL Source settings.
There is an AND relationship that exists between the Minimum Duration, Minimum CPU, Minimum Reads,
and the Minimum Writes Collection Settings, meaning that to be collected as Top SQL, the event needs to
satisfy each individual Collection Setting. For example, if you set the Minimum Duration at 10 seconds and
the Minimum Reads at 25, an event needs to meet both a Minimum Duration of 10 seconds AND a Minimum
Reads of 25 to be captured in Top SQL.
Minimum Duration can't be set below 100ms unless Minimum CPU, Minimum Reads, or Minimum Writes is
greater than zero. This lower limit is enforced because setting this threshold below 100ms for an extended
period of time dramatically increases the volume of data collected and stored by SQL Sentry, and has a
negative impact on the monitored server.

 Note: SQL Sentry's QuickTrace functionality is better suited to analyze extremely short duration
events.

Adjusting Captured TextData Length
By default textdata for captured Top SQL and Top Command events is truncated at 10,000 characters.
Change this maximum length in Global Settings (Navigator pane > Configuration > Global Settings >
Advanced tab > Query Collection Maximum Text Length).
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 Note: You may adjust the Query Collection Maximum Text Length setting up to 50,000 characters.
The default setting of 10,000 characters is adequate for most SQL Server environments.

Hiding Queries and Stopping Alerts
 Note: Hiding a query in Top SQL also hides it from the calendar view.

Hide individual queries or groups of queries with the right-click context menu Hide command.
To hide a single query, select the desired row, then right-click and select Hide.

To hide a group of queries, drag a column header to the top of the Grid View to group like items. Select
the group header in the Grid View and use the right-click context menu Hide command.
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 Important: Once a query is hidden in Top SQL, you're no longer alerted about it for any of the Top
SQL related conditions. Unhide all hidden queries by selecting Show Hidden on the toolbar. To unhide an
individual query permanently, select the Visible checkbox from the Column Chooser that toggles the
effect of Hide/Hide Group.
It's important to note that this will impact everyone using this particular SQL Sentry environment, not
just your individual SQL Sentry client view.

Top SQL Source Settings
There are three settings that can be adjusted to change how long a query runs to be collected. These settings
are in the Top SQL Source area in the Settings pane.

Setting

Description

Query Stats Sample Interval

Specifies how often to sample
query stats.

Filter Time Span

Specifies the base length of
time over which the collection
filters are applied to Query
Stats.

Minimum Duration

Specifies the minimum
duration for a statement to be
logged.

Image
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Setting

Description

Filter Factor

The Filter Factor is calculated
by dividing the Query Stats
Sample Interval by the Filter
Time Span. The collection
filters such as Minimum
Duration are multiplied by
this value when applied to
Query Stats collection.

Image

 Note: Each of these settings play a part in what's captured for Query Stats in your environment. As
an example, using the following default settings:
Query Stats Sample Interval = 60 seconds
Filter Time Span = 30 seconds
Minimum Duration = five seconds
The total cumulative duration of all executions of a query over the 60 second sample interval must be
greater than 10 seconds.

Controls
Top Pane
Control

Description

Image
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Control

Filter
button

Description

Image

Add a filter to any column by selecting the filter
button. After changing any of the filters, it's
necessary to select Refresh, or press F5 to apply
the filter.
Select on a combination of items in any of the
lists to set the filters. The default filter
displays all records.
To select more than one item in a list, use
Shift-Click or CTRL-Click.

Toolbar Options
Control

Description

Image

Show
Hidden
Rows

Hide individual lines or groups of rows. This toggles

Show
Totals

Groups like queries together by normalizing the
result set.

the display of those lines.

Context Menu Options
Option

Description

Sort Ascending

Organizes the
selected column in
Ascending order.

Sort Descending

Organizes the
selected column in
Descending order.

Context Menu
Image

Option Applied
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Option

Clear Sorting

Description

Context Menu
Image

Option Applied

Clears the sorting
options applied to
the column.

Group By This Column

Groups the queries
by the selected
column.

Show Group By Box/
Hide Group By Box

Displays or Hides the
Group by box.

Hide This Column

Hides the selected
column.

Column Chooser

Opens the Column
Chooser. The
Column Chooser
provides additional
columns to sort
information.

Best Fit

Resizes the
information for the
selected column.
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Option

Description

Best Fit All Columns

Resizes the
information for all of
the columns.

Context Menu
Image

Option Applied

Opens the Filter
Editor.
Use the Filter Editor
to add and remove
filters, and apply
Filter Editor

Boolean logic for a
more complex filter.
To adjust the
Boolean logic, simply
select the red And to
bring up the context
window.

Show Find Panel

Displays the Find
Panel. Use the Find
Panel to search for
specific strings in the
queries.

Show Auto Filter Row

Displays the Auto
Filter Row. Use the
Auto Filter Row to

Reset Grid

Resets the data on
the grid to the
default setting.
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 Important: Hide/Hide Group disables any alerts for the events, and prevents them from being
displayed on the Event Calendar.

Jump to
Jump To context
menu option

Description

Jump to Dashboard

When Show Totals
mode is enabled all
events belonging to
the selected group
are overlaid on the
Dashboard. When
the Default mode is
enabled only the
selected event is
overlaid on the
Dashboard.

Jump to Calendar

Goes to the selected
event on the Event
Calendar (requires
the server to be
watched with EM).

Jump to Runtime
Stats

Opens a tab showing
the Runtime Stats for
the event.

Top SQL Jump To
option

Corresponding data

Additional Options
Option

Kill Process

Trace Procedure

Description

Image

Kills the running process (Running
Queries tab).

Opens the Run QuickTrace dialog
box for the selected event (Query
Stats tab).

873

Option

Description

Image

Database Mapper Environment Map
The SolarWinds Database Mapper Environment Map shows data collected from the SQL Sentry database to
map connections between applications, users, clients and targets (sourced from Top SQL and Windows
processes). This information complements the lineage analysis feature by showing the dynamic usage of
targets in the lineage diagram and shedding light on the processes that are using the database.

Additional Information: To learn more about using Top SQL data with SolarWinds Database Mapper,
see the Environment Map article.
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Top SQL Runtime Stats
Last Modified on 20 September 2021

Introduction
The Top SQL Runtime Stats provides insight into the frequency and duration of the queries and procedures
that are captured by Top SQL.

Runtime Graphs
Runtime Stats provides a visualization of collected runtimes for a particular statement. Open Runtime Stats
by right-clicking any statement in the Completed Queries tab and then selecting Jump To > Runtime Stats
from the context menu.

Jump to > Runtime Stats

Top SQL Runtime Stats

There are two views available for the graph, Runtime History and Runtime Aggregates. This selection is
made from the main toolbar. These graphs make it easy to identify runtime trends, which are an indicator of
or eventually lead to performance issues with the event or the server.
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Runtime History Graph

Runtime Aggregates Graph

This graph shows an entry's actual runtime and status This graphs show the distribution of the entry’s actual
over the specified interval. A red bar indicates that the runtime over the specified interval.
instance failed.

Top SQL Runtime Stats History mode

Top SQL Runtime Stats Aggregate mode

Graph Controls
Use the Navigation toolbar to change the Start date/time and interval for the graph.

The Days control can go up to 60 days at a time. Whenever the selected interval is less than one day (one
minute through four hours), the Days control changes to one day.

Graph Control

Description

Min/Max Y Val

When a runtime graph is first displayed, SQL Sentry tries to determine
the most appropriate interval and maximum Y-axis value. Change
either of these settings at any time.

Auto-scale to Max Value

Checking this box automatically selects the appropriate Max Y Value
of the data being shown in the current view.

Interval Type

Changes the interval used for the Y-axis.
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Graph Control

Description

Show Value Labels

Deselect this checkbox to hide the bar value labels. This can become
necessary for broader ranges with hundreds or thousands of bars to
reduce the noise on the graph.

Runtime Grid
The Runtime Grid provides additional information about captured Top SQL events. This includes both events
that are captured as part of the standard Top SQL collection, and fast running events that are captured as
part of Query Stats collection. The events listed in the Runtime Grid aren't dependent on any specific time
range you're viewing, and don't update based on the selected chart view. The count represents the total
number of observed occurrences of the event that have history in SQL Sentry. The respective Min, Max, and
Average durations are updated as new occurrences of the events are observed in your environment.

Events are purged from the list according to the Global Settings > Storage tab > Keep Performance
History For setting. See the last time an event occurred by using the Last Execution column. If an event
hasn't been observed since the effective Keep Performance History For date, its record is removed.
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SQL Sentry Performance Analysis Disk Activity
Last Modified on 23 February 2022

Applies to: SQL Server, SSAS*, VMware*, and Windows* targets.

Introduction

 Note: *The Disk Activity and Disk Space tabs are focused on database files. For Windows it applies to
VMware and Hyper-V hosts for vDisks and VHDX files, respectively. The tabs will only display for SSAS,
VMware, and Windows when the applicable files are available for monitoring.

Additional Information: If the Disk Activity tab or the Disk Space tab does not display, there could be
an issue with WMI on the system you're monitoring. For more information about troubleshooting WMI on
your system, see the WMI Troubleshooting MSDN article.

Disk bottlenecks represent one of the most common sources of performance problems for Windows and SQL
Server. The Disk Activity tab provides a patented graphical disk analysis system that breaks down disk
activity and latency at the controller, physical disk, and file level, highlighting bottlenecks at any point in a
disk system.

Target

Example View
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Target

Example View

SQL Server

VMware

Windows

The top pane of the display shows a graphical representation of the entire disk system as Windows sees it.
The middle pane displays activity metrics in either a hierarchical disk system format or database/virtual hard
disk/ virtual machine disk list format. The bottom pane displays graphs showing read and write latency, IOPS
and throughput for the disk or file chosen in the top pane, or middle pane.

Target

Example View

SQL Server
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Target

Example View

VMware

Windows

Disk Activity Modes
The Disk Activity tab has two modes, Real Time and History. The active mode is controlled with the autorefresh toolbar button.
Select the auto-refresh Play button  to enter the Real Time mode.
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The System box represents the underlying storage in your monitored environment. The Controller box(es)
display the controller in your environment. A controller works as an interface between the motherboard and
other components, and makes sense of the signals going to, and coming from the CPU.
SQL Server
The top pipe represents Read activity between
the System and Controller.
The bottom pipe represents Write activity
between the System and Controller.

VMware
The top pipe represents Read activity between
the System and the Datastore.
The bottom pipe represents Write activity
between the System and the Datastore.

Windows
The top pipe represents Read activity between
the System and the Controller.
The bottom pipe represents Write activity
between the System and the Controller.
Data for the last collected sample is shown, and moving segmented lines indicates the I/O direction (read or
write) and latency for each disk, file, and controller or datastore.
The top pipe represents Read activity.
The bottom pipe represents Write activity.
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The thickness and color of the displayed segmented line indicates the amount of latency being experienced.
As latency increases, the lines grow in width and changes through green, olive, orange, and red to give a quick
visual indication of the decreased performance.
Selecting any file displays a tooltip that shows the numerical values for the reads and writes hitting a file. The
amount of overall latency being experienced by the disk is distinguished from the amount of latency for
individual files. The overall disk latency is represented with the horizontal pipe connecting all the individual
files, while the small vertical pipes represent latency at the file level.

 Note: A disk appearing red indicates a suspect offset setting. This may affect IO performance.

The following table lists the color of the segmented line and the corresponding range of latency values. All
latency values are listed in milliseconds (ms).

Color Range
Color Range

Read Latency

Write Latency
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Color Range

Read Latency

Write Latency

Green

< 10 ms

< 10 ms

Greenish-Yellow to Orangish-Yellow

10-20 ms

10-20 ms

Orange to Reddish-Orange

21-30 ms

21-40 ms

Red

> 30 ms

> 40 ms

Read and Write Latency Color Gradients

Select the auto-refresh Pause button to enter History mode. Aggregate disk metrics are displayed for the
selected date range, and the solid lines indicate latency. History mode enables you to see how your disk
system performs over any period.

 Note: In history mode the pipes display as solid lines representing latency at the selected time frame.
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Disk Activity Real-time mode

Disk Activity History mode

Toolbar
The following toolbar options are available when auto-refresh is paused:

View

Description

Disk Grid View

Toggles between showing the
File Grid view and the Disk
Grid view.  Note: When
auto-refresh is paused, these
viewing options are available.

File Grid View

Toggles between showing the
Disk Grid view and the File
Grid view.  Note: When
auto-refresh is paused, these
viewing options are available.

Show Empty Disks

Controls whether disks
without any SQL Server
database files are displayed.

Order By Activity

Sorts physical disks by activity
in descending order.

Sum

Displays the total IO
information in your
environment.  Note: When
auto-refresh is paused, these
viewing options are available.

Image
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View

Description

Average

Displays the Average IO
information in your
environment.  Note: When
auto-refresh is paused, these
viewing options are available.

Image

Context Menus
Left-click—Sets the focus to any file. Other files for the same database are highlighted along with the
corresponding grid row.

 Note: This is applicable to SQL Server, VMware, and Windows targets.

 Note: Hover over any graphical icon to display more detailed IO information.

SQL Server

VMware

Windows

Right-click—Run a Quick Trace or a Quick Report.
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 Note: Quick Trace is only available for SQL Server targets.

 Note: The following context menu options are available for VMware and Windows targets.

Jump to VM Disk Activity — Opens the Disk Activity tab for the selected SQL Server.
Stop watching— Stops the monitoring of a selected file.

Watch— Begins monitoring a selected file.
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Exporting and Reporting Options
Exporting Data—Export the Disk Activity grid through the File menu (File > Export Data).

Quick Report—Run a Quick Report from the right-click context menu of any file to access database level I/O
metrics in a report format. Run a Quick Report while in Real Time mode for the last 10 minutes of data.
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Disk Activity Metrics
The following table lists descriptions of the metrics displayed on the Disk Activity screen. For more
information about interpreting latency values, see the Disk I/O: Read latency by physical disk article.

 Note: The sample collection frequency for disk counters is 20 seconds. While in Real Time mode, the
Disk Activity screen updates according to this sample interval. A custom sample interval is specified.
This may be useful if you're monitoring a server with many database files per database, because this can
lead to increased SQL Sentry database growth and transaction log activity.

Name

Description

The virtual machine that the file is associated with.
Virtual
Machine

 Note: This column appears for targets that are also Hyper-V Hosts, and the column
populates for files directly associated with virtual machines on the host (e.g., .vhdx files,
mounted .iso files).
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Name

Description

Real Time
The average number of byte reads per second over the last polling interval.
Read Bytes

History
Average Mode—The average number of byte reads per second over the selected range.
Sum Mode—The total number of byte reads for the selected range.

Real Time
The percentage of byte reads from this file in relation to other files belonging to the
target over the last sample polling interval.
% Read
Bytes

History
Average Mode—The average percentage of byte reads from this file in relation to
other files belonging to the target over the selected historical range.
Sum Mode—n/a

Real Time
The number of read operations per second over the last sample polling interval.
Reads

History
Average Mode—The average number of read operations per second over the selected
range.
Sum Mode—The total number read operations occurring in the selected range.
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Name

Description

Real Time
Milliseconds per read. The average time in milliseconds each physical disk read took
over the last sample polling interval.
ms/Read

History
Average Mode—The average time in milliseconds each physical disk read took over the
selected time range.
Sum Mode—n/a

Real Time
The average number of bytes written per second over the last polling sample interval.
Write
Bytes

History
Average Mode—The average number of bytes written per second over the selected
range.
Sum Mode—The total number of bytes written for the selected range.

Real Time
The percentage of bytes written to this file in relation to other files belonging to the
target over the last sample polling interval.
% Write
Bytes

History
Average Mode—The average percentage of bytes written to this file in relation to
other files belonging to the target over the selected historical range.
Sum Mode—n/a
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Name

Description

Real Time
The number of write operations per second over the last sample polling interval.
Writes

History
Average Mode—The average number of write operations per second over the selected
range.
Sum Mode—The total number write operations occurring in the selected range.

Real Time
Milliseconds per write. The average time in milliseconds each physical write took over
the last sample polling interval.
ms/Write

History
Average Mode—The average time in milliseconds each physical disk write took over
the selected time range.
Sum Mode—n/a

The Other designation is assigned to files that aren't part of the SQL Server installation.

Real Time
The average number of byte reads per second over the selected range, involving files
Other Read
Bytes

that aren't part of the SQL Server installation.

History
Average Mode—The average number of byte reads per second over the selected range.
Sum Mode—The total number of byte reads for the selected range.
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Name

Description

The Other designation is assigned to files that aren't part of the SQL Server installation.

Real Time
The average number of byte writes per second over the selected range, involving files
Other
Write
Bytes

that aren't part of the SQL Server installation.

History
Average Mode—The average number of byte writes per second over the selected
range.
Sum Mode—The total number of byte writes for the selected range.

Total VLFs

See the Total VLFs topic.

TempDB Example
The Disk Activity analysis feature can also be used to monitor the activity for TempDB. The example below
shows TempDB and TempDB Log on their own respective drives and how they appear on the Disk Activity
tab.
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Example of disk activity analysis for tempdb and templog.

Troubleshooting
Mount Points
If mounted drives are not showing up under Disk Activity or Disk Space, it is likely related to the required
ports or DCOM permissions. See the following support KB articles for more information:
Port Requirements for Mount Point Support
Setting DCOM Permissions for Mount Point Support
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Performance Analysis Disk Space
Last Modified on 08 June 2021

Applies to: SQL Server, SSAS*, VMware*, and Windows* targets.

Introduction

 Note: *The Disk Activity and Disk Space tabs are focused on database files. For Windows targets it
applies to VMware and Hyper-V hosts for vDisks and VHDX files, respectively. The tabs will only display
for SSAS, VMware, and Windows targets when the applicable files are available for monitoring.

Additional Information: If the Disk Activity tab or the Disk Space tab does not display, there could be
an issue with WMI on the system you're monitoring. For more information about troubleshooting WMI on
your system, see the WMI Troubleshooting MSDN article.

The Disk Space tab contains information about disk space utilization within your environment, broken down
by database and file. Use the Disk Space tab to identify disk capacity issues, understand where various
database files reside on the disk system, and to determine whether available disk space is optimally used.
The Disk Space tab has two distinct areas. The top pane is a graphical representation of the database layout
at the disk level. Data files are represented with a unique solid color, and each associated log file is
represented with the same color with a line overlay. The solid grey areas represent the empty space per disk.
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The colors are repeated for each file in the Grid View found in the bottom pane. Selecting a file in either pane
highlights the associated representation in the other pane.

Using Disk Space
Disk Space Modes
The Disk Space tab has two modes, Real Time and History. The active mode is controlled by the AutoRefresh toolbar button. Select the auto-refresh Play button to enter the Real Time mode. Data for the last
collected sample is shown.

Select the auto-refresh Pause button to enter the History mode. History mode displays the average disk
space information over the specified time range. Change the time range you're viewing by using the Start and
End times and selecting Go in the toolbar.

Database Space Usage Band
When index collection is enabled, index information is viewable by drilling into the database level in the
Grid View. When a database is selected in the grid, a band displaying the space usage of that database's
indexes appears between the disk layout and the grid. Select a database in the Grid View to open it's
corresponding Database Space Usage Band.

895

 Note: Each box represents an index within the selected database. The size of each box illustrates the
total amount of space used in relation to the other indexes within that database. Right click any index in
the Database Space Usage Band to select the Jump to Indexes context menu option.

Storage Unit Scale
Use the Storage Unit scale to adjust the relative size of disk space in MB/GB and the corresponding graph that
displays in the Disk Space tab. Adjusting the scale to a different value changes the corresponding graph to
match that value.
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Display Disk Space data in the following increments:

MB

GB

TB

1

1

1

5

5

5

10

10

10

50

50

50

100

100

100

500

500

500

 Note: The default display for the Disk Space tab is 10GB.

Toolbar
Once the Disk Space tab is in History mode the Disk/Database Grid View button becomes available in the
toolbar. Selecting File Grid View removes the groupings, and can be helpful when you're interested in
viewing and sorting data across the entire disk subsystem.

Toolbar Button

Description

Disk Grid View

Toggles between File Grid
view and Disk Grid view. 
Note: When auto-refresh is
paused these viewing options
are available

Image
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Toolbar Button

Description

File Grid View

Toggles between Disk Grid
view and File Grid view. 
Note: When auto-refresh is
paused these viewing options
are available

Show Empty Disks

Controls whether disks
without any SQL Server
database files are displayed.

Image

Additional Options
Select any row to set focus to the associated database and log file.

Right-click to copy the cell/row/all options available.

Select the + command of any data file to show table and index information. For more information about
those metrics, see the Indexes topic.
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Exporting and Reporting Options
Exporting Data—The Disk Space grid view is exported through the File menu (File > Export Data).

Quick Report—Run a Quick Report to access database level size metrics in report format from the right-click
context menu of any file. Run a Quick Report in Real Time mode for the last seven days of data.

Disk/File Space Reports—The Disk/File Space reports provide disk and database file level metrics. Access
them through the Reports menu (Reports > Performance Analysis > Disk/File Space).
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Disk Space Metrics
Name

Description

The virtual machine that the file's associated with.
Virtual Machine

 Note: This column appears for targets that are also Hyper-V Hosts, and the
column is populated for files directly associated with virtual machines on the Host
(e.g., .vhdx files, mounted .iso files).

SQL Server

The file that's associated with the SQL Server.

Database

The file that's associated with the database.

File

The name of the file.

The filegroup of the associated file.
Filegroup

Additional Information: For more information about files and filegroups within
the SQL Server, see the Files and Filegroups Architecture article.

Type

Specifies the type of the file being either data or transaction log.

Size (MB)

The size in (MB) of the selected file.
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Name

Description

The amount of the disk space that's allocated for the file and is in use.
Used (MB)

Additional Information: For more information about page types and data files,
see the Understanding Pages and Extents topic.

Used %

The percentage of disk space that's allocated for the file and is in use.

Indicates the auto-growth properties of the selected file. If the setting is defined
as a percentage, that percentage displays along with the estimated size in
megabytes of the next file growth. If file growth is defined as an absolute value,
that size (MB) displays.

Auto-growth

 Warning:
A pink highlight indicates that the auto-growth amount is greater than
the remaining free space.
A yellow highlight indicates that auto-growth is set as a percent.
A tan highlight indicates that auto-growth is less than 10 MB or greater
than one GB.

Max File Size
(MB)

The maximum file size allowed for this data or log file.
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Name

Description

The total number of virtual log files (VLFs) that compose the transaction log. Each
physical transaction log is made up of a several smaller VLFs. When the
transaction log grows, by a manual action, or because of an auto-growth, the
number of virtual log files that compose the transaction log increase.
The actual number of corresponding VLFs that are added during any log growth is
dependent upon the size of the growth. See the following table:

Auto-growth size

VLFs created

< 64 MB

Four

>= 64 MB and < One GB

Eight

>= One GB

16

Total VLFs

If the transaction log grows frequently in small increments, you may see many
VLFs. A log file containing many VLFs decreases database performance.
Additional Information: For more information about transaction log
architecture, see the Transaction Log Physical Architecture topic.

 Warning:
A tan highlight indicates that Total VLFs are greater than 100.
A pink highlight indicates that Total VLFs are greater than 300.

Active VLFs

The number of virtual log files (VLFs) containing log records that are still needed.
There are several criteria for defining when a log record is needed. For more
information, see the TechNet topic. A log record that's still needed is defined as
an active log record, and any VLF containing at least one active log record is an
active VLF.

Min VLF Size
(MB)

The size (MB) of the smallest existing VLF.

Max VLF Size
(MB)

The size (MB) of the largest existing VLF.
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Name

Description

Avg VLF Size
(MB)

The average size (MB) of those VLFs that compose the log.

The number of VLFs that's created during the next auto-growth event. When the
transaction log grows, by either a manual action, or because of an auto-growth,
the number of virtual log files that compose the transaction log also increases.
This number is dependent upon the size of the growth. See the following table:

Auto-growth
VLF count

Auto-growth
VLF Size (MB)

Auto-growth size

VLFs created

< 64 MB

Four

>= 64 MB and < one GB

Eight

>= one GB

16

The size (MB) of each VLF that's created during the next auto-growth event, given
the current auto-growth settings.

The last recorded backup time for the associated file.

Last Backup
Time

 Warning: A pink highlight indicates that there are no recent transaction
log backups.

Last Backup
Type

The last recorded backup type for the associated file.

Log Reuse Wait

This indicates what the transaction log is waiting on, in regards to re-using
its space.

File Path

The full file path of the data or log file.
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Disk Forecasting
See the Forecasting article for a complete guide to the storage forecasting feature.

TempDB Example
The Disk Space analysis feature can also be used to monitor the number of files and size of TempDB. The
example below shows TempDB and TempDB Log on their own respective drives and how they appear on the
Disk Space tab.

Example of disk space analysis for tempdb and templog drives and files
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Performance Analysis Blocking SQL
Last Modified on 09 November 2021

Applies to: The Blocking tab is available for SQL Server and Azure SQL Database targets.

SQL Sentry Portal: This feature is available in SQL Sentry Portal. To learn more about configuring your
environment to use the on-premises, browser-based option with your existing SQL Sentry database, see
the SQL Sentry Portal article.
 See the SQL Sentry Portal Blocking article for an example of the Blocking feature in a browser.

Overview

The Blocking SQL tab displays all SQL Server blocks that occurred during the active date range that meet the
Minimum Block Duration. Each block is displayed in a hierarchical format, showing the relationships between
all blocking and blocked SPIDs in a blocking chain.

Blocking SQL Collection
Blocking SQL collection is controlled with the Blocking SQL Source settings. The Minimum Block Duration
setting determines how long a block exists before information is collected on it. The default setting is 15
seconds. Adjust Blocking Collection as desired through the Settings pane (View >Settings).
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Example One
Change blocking collection to 20 seconds globally by completing the following steps:
1. Select the All Targets (globally) node in the Navigator pane (View > Navigator).

2. In the Settings pane (View > Settings), select SQL Server from the top drop-down list.

3. Select Blocking SQL Source from the second drop-down list to show Blocking Source settings that are
being applied globally.
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4. Change the Minimum Block Duration setting to 20 seconds, and then select Ok; it's saved
automatically.

Example Two
Change the blocking collection for an individual instance by completing the following steps:
1. Select the desired instance node in the Navigator pane (View > Navigator).
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2. In the Settings pane, select Blocking SQL Source from the second drop-down list to see the Blocking
SQL Source settings that are configured for the instance.

3. Change the Inherit From Parent setting to False.

4. Change the Minimum Block Duration setting to your desired value; it's saved automatically.
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Query Collection Maximum Text Length
By default, SQL text data length for captured events is limited to 10,000 characters. Change this maximum
length in the Monitoring Service Settings (Navigator pane > Configuration > Global Settings >
Monitoring Service Settings > Advanced tab > Query Collection Maximum Text Length).

Blocking SQL Retention
By default, Performance Analysis Blocking SQL, Top SQL, and Deadlock data is retained for 15 days. This is
controlled with the Keep Performance History For setting found on the Storage tab of Global Settings
(Navigator pane > Configuration >Global Settings > Storage tab). For more information about retention,
see the Data Capacity Planning topic.
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Blocking SQL Alerting
Configure actions in response to Blocking SQL conditions. The SQL Server: Blocking SQL condition occurs
each time a block is collected, and therefore has a direct correlation to the Blocking SQL Source
Collection settings. Configure an action in response to the SQL Server: Blocking SQL: Output Content
Match (OCM) condition. The OCM condition is useful in narrowing the notifications you see concerning
blocking.

 Note: Consider applying a Response Ruleset to any action you configure with the SQL Server:
Blocking SQL condition. Response Rulesets control how often actions are taken in response to
conditions. In this case, apply a Response Ruleset to limit the Blocking alerts you receive, while still
retaining Blocking information on the Blocking SQL tab.

Display/Controls
Toolbar
The Blocking SQL tab has two modes: Real Time and History. Use the toolbar options to switch between
these modes.
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Real Time
When the auto-refresh Play button is selected, the tab enters Real Time mode. In Real Time mode, any
blocking SQL that happened within the last 10 minutes displays.

History
When the auto-refresh Pause button is selected, the tab goes into History mode. Select a time range, then
select Go on the toolbar to view blocks that happened during the specified time range.

If you want to go directly to the most recent block, use the Jump To Last Block button.

Filter
The top pane provides client filters for specifying which records to display for the defined interval.

 Note: The Filter pane is for client side filtering only and doesn't impact what's collected. For more
information, see the Blocking SQL Collection section.
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After changing any of the filters, it's necessary to select Refresh, or press F5, to apply the filter. To select
more than one item in a list, use Shift-Click or CTRL-Click. The following are available filters:

Filter

Image

SQL Servers

Applications

Databases

Hosts

Wait Resources

Show Top

Blocking SQL Grid View
Each block displays in a hierarchical format, showing the relationships between all blocking and blocked SPIDs
in a blocking chain.

The head of the blocking chain is the top node in the hierarchy which contains the blocking statement, and
displays with an orange node if the statement is still running, and a green node once it's completed.

Sub-nodes in the chain are the statements that are being blocked, and they display with a red node. Any
subsequent statements that are being blocked are nested underneath, giving you a complete picture of the
blocking chain.

912

A unique record is shown for each version of a blocking chain, denoted by the Version column. A new record
is created every time the blocking chain changes, meaning that a blocked SPID is either added or removed
from the chain between polling intervals.

 Note: For some blocks, this may happen frequently, causing multiple records to be created, while
others may not change at all for the duration of the block.

 Note: Indentations between SPIDs of the same color in the blocking chain indicate that the queries
in the chain are being blocked by the currently blocked query.

Color Code

Description

Green

The head of the blocking chain is the top node in the hierarchy which
contains the blocking statement and displays with a green node once it's
completed.

Orange

The head of the blocking chain is the top node in the hierarchy which
contains the blocking statement and displays with an orange node if the
statement is still running.

Red

When sub-nodes in the chain are the statements that are being blocked
they display with a red node.

The polling interval for blocks is determined by the Live Event Monitor Polling Interval (Navigator pane >
Configuration > Global Settings > Monitoring Service Settings > Advanced tab).
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Text Data
The bottom pane shows the T-SQL Text Data for the currently highlighted Blocking SQL record.

 Note: For some SPIDs the bottom pane may be blank if SQL Sentry is unable to collect the TSQL due
to timing issues.

Additional Options
The following are additional options available through the right-click context menu:

Context Menu Option

Description

Jump to Calendar

Opens the selected event on
the Event Calendar (requires
server to be watched with
EM).

Jump to Dashboard

Opens the Performance
Analysis Dashboard with the
selected blocking event
overlaid on each of the charts.

Depiction
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Context Menu Option

Description

Jump to Top SQL

Opens the Top SQL tab
highlighting the query
involved in the blocking event.

Right-clicking on a blocking
record

Presents a context menu that
allows you to Jump To the
instance on the calendar or kill
the process associated with
the blocking event.

Clear Sorting command

Removes any grid orderings.

Depiction

Additional context menu options include the ability to expand and collapse individual trees or all the records
in the Grid view.

Blocking SQL Metrics
Name

Description

SPID [ecid]

The session process ID of the associated blocked/blocking process.

A unique record is shown for each version of a blocking chain, denoted by the
Version column. A new record is created each time the blocking chain changes,
meaning that a blocked SPID is either added or removed from the chain between
Version

polling intervals. For some blocks this may happen frequently, creating multiple
records, while others may not change at all for the duration of the block.
 Note: The Polling Interval for blocks is determined by the Event Monitor Polling
Interval (Navigator pane > Configuration > Global Settings > Monitoring Service
Settings > Advanced tab).

SQL Server

Name of the SQL Server hosting the SPID.

Start Time

Start time of the request.

Duration

The length of time that the block exists.

Plan

Opens a Plan Explorer session for the associated query plan.

Statement

The command text associated with the request.
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Name

Description

Object

The object associated with the request.

Wait Time

Duration of wait time in milliseconds.

Wait Type

Name of the wait type. For more information about wait types, see the
sys.dm_os_wait_stats (Transact-SQL) MSDN article.

Wait
Resource

Name of the resource on which the request is currently waiting.

Host

The client workstation specific to this session.

Application

The associated application.

Database

The associated database.

Login

The login name associated with the session.
The last time a parent process involved in blocking completed a successful batch
execution.

Last Batch

Host Process
ID

 Note: This SPID metric can be useful if you have one that remains open and sends
various batches. For example, if you are looking at SPIDs that are currently running,
and see a SPID in a sleeping state, then you can see that the last batch execution was
two hours ago.

The process ID of the client program which initiated the session.
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Performance Analysis Deadlocks
Last Modified on 11 November 2021

SQL Sentry Portal: This feature is available in SQL Sentry Portal. To learn more about configuring your
environment to use the on-premises, browser-based option with your existing SQL Sentry database, see
the SQL Sentry Portal article.
 See the SQL Sentry Portal Deadlocks article for an example of the Deadlocks feature in a browser.

Overview

The Deadlocks tab displays information about deadlocks happening within your environment. Use the
Deadlocks tab to identify and correct deadlocks on your monitored servers.

Deadlock Collection
Deadlock collection is controlled through the Deadlock Source settings. The Collect Deadlock Events
setting is True by default, so whenever a new SQL Server instance is watched, deadlock events are
automatically collected for that instance. Adjust the deadlock collection as desired through the Settings pane
(View menu > Settings).
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Example One
To disable the deadlock collection globally, complete the following steps:
1. Select All Targets (globally ) in the Navigator pane (View > Navigator > All Targets).
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2. In the Settings pane (View > Settings), select SQL Server from the top drop-down list.

3. Select Deadlocks Source from the second drop-down list to open the Deadlocks Source settings that
are being applied globally.

4. Change the Collect Deadlock Events: Collection setting to False; the setting saves automatically.

Example Two
To disable the deadlock collection for an individual instance complete the following steps:
1. Select the desired instance node in the Navigator pane (View > Navigator > desired instance).
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2. In the Settings pane (View > Settings), select Deadlocks Source from the second drop-down list to
open the Deadlocks Source settings for the instance.

3. Under Synchronization, change the Inherit From Parent setting to False.
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4. Change the Collect Deadlock Events: Collection setting to False; it saves automatically.

Deadlock Retention
By default, Performance Analysis Blocking, Top SQL, and Deadlock data is retained for 15 days. This is
controlled with the Keep Performance History For Setting found on the Storage tab of Global Settings
(Navigator pane > Configuration > Global Settings > Storage tab). For more information about retention,
see the Data Capacity Planning topic.
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Deadlock Alerting
Configure actions in response to two SQL Server deadlock conditions. The SQL Server: Deadlock condition
occurs each time there's a deadlock in your environment. There are numerous actions that you can take in
response to this condition occurring.

Configure an action in response to the SQL Server Deadlock: Output Content Match (OCM) condition
through the Conditions pane (View > Conditions). The OCM condition is useful in narrowing the
notifications you see concerning deadlocks. The OCM condition uses the entire deadlock XML to match
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against, making it a powerful tool in pinpointing specific deadlocks.

Display / Controls
Toolbar
The Deadlocks tab has two modes, Real Time and History. The active mode is controlled through the
toolbar. When the auto-refresh Play button  is selected, the tab enters Real Time mode. In Real
Time mode, any deadlocks that happened within the last 10 minutes display.

When the auto-refresh Pause button is selected, the tab goes into History mode. Select a time range and
then use the Go toolbar button to view deadlocks that happened during that time period.
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Alternatively, use the Jump To Last Deadlock button to navigate to the last deadlock.

Filter
The Top pane provides client filters for specifying which records to display for the selected interval.

 Note: The Filter pane is for client side filtering only and doesn't impact what's collected. For more
information, see the Deadlock Collection section in this article.

After changing any of the filters, it's necessary to select Refresh, or press F5, to apply the filter. To select
more than one item in a list, use Shift-Click or CTRL-Click. The available filters are as follows:

Filter type

Description

SQL Servers

Filters deadlocks by selected
SQL Server within your
environment.

Show Top

Depending on the length of
the displayed interval, you may
have a lot of data to work with.
This setting controls how many
of the rows are retrieved.

Image
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Deadlock Gridview
The Deadlock Gridview lists the records matching the current filters. The default filter displays all records.
Each record is expandable to view the details regarding the processes that were involved in the deadlock.

Additional Information: For general background information about what constitutes a SQL Server
deadlock, see the Deadlocking MSDN articles.

For general information about the metrics displayed, see the Deadlock Metrics section at the end of this
article.

Deadlock Graph
The Deadlock Graph is formed according to the captured deadlock XML. Process and Resource nodes are
independently represented, along with any relationships that exist between them.
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The deadlock victim is highlighted with a red background.
The numbers and associated arrows between each node indicate the actual sequence of events that
took place, leading to the deadlock.
The letters indicate the requested Lock mode.

Using the Deadlock Graph
Select object nodes in the graphical representation to focus on that object in the Gridview.
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Zoom in and out on the Deadlock Graph using CTRL + Mouse Wheel or through the right-click context menu.

Deadlock Playback Functionality
Playback the sequence of events for a selected Deadlock by completing the following:
1. Select a desired Deadlock in the Grid view to display the Deadlock in the Deadlock Graph.
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2. Select the Play button  from the Deadlock Graph toolbar to start the Deadlock Playback.

Deadlock Playback Toolbar
 Note: Many of the deadlocks in the table below show an orange dotted line. This indicates that a
lock was requested, but could not be granted. When the arrow points from the resource to the lock, it
wasn't granted. When the arrow points from the lock to the resource, it was granted.

Toolbar Option

Description

Image
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Toolbar Option

Description

Play

Plays the Deadlock sequence
in the order of events.

Skip Forward

Goes to the end of the
Deadlock event.

Skip Backwards

Goes to the beginning of the
Deadlock event.

Fast Forward

Goes to the next sequence of
the Deadlock event.

Rewind

Goes to the previous sequence
of the Deadlock event.

Image
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Toolbar Option

Speed

Description

Image

Sets the speed that the
Deadlock playback sequence
displays. The default speed is
1x. Speed options include:
1/4x
1/2x
1x
2x
4x

Zoom In/ Zoom Out

Increase or decrease the size
of the displayed Deadlock
graph. Use the + or - symbols
to zoom in or out, or click and
drag the zoom toolbar.

Auto Fit

Auto sizes the Deadlock
display to fit in the Deadlock
graph area.
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Toolbar Option

Description

Image

Circular Deadlock Graph Layout

Layout Type

Select the Deadlock graph
display. Display options
include:
Circular
Force Directed
Layered Digraph

Force Directed Deadlock Graph
Layout

Layered Digraph Deadlock Graph
Layout

Optimize Layout

Configures the best layout for
the Deadlock graph.

Additional Options
The following options are available through the right-click context menu:

Feature

Description

Jump to Calendar

Opens the selected event on
the Event Calendar (requires
server to be watched with
EM).

Image
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Feature

Description

Jump to Top SQL

Opens the Top SQL tab
highlighting the query
involved in the deadlock
event.

Export Deadlock to XML

Exports the deadlock in XML
format.

Page divider

The divider between each of
these panes that can be
dragged to resize or hide each
pane.

Image

 Note: Open exported Deadlock XML files (*.xdl) in the SQL Sentry client (File > Open). Whenever
you open a deadlock, a new tab displaying the deadlock information, including the deadlock graph, is
created.

Deadlock Metrics
Deadlock Overview
Name

Description

SQL Server

The SQL Server where the deadlock took place.

Time

The time the deadlock occurred.

Victim SPID

The session process ID of the victim involved in the deadlock.

Victim Host

The workstation belonging to the victim thread.

932

Name

Description

Victim
Application

The application name belonging to the victim thread.

Victim
Database

The name of the database on which the process took place

Victim Text
Data

The associated text data of the victim.

Deadlock
XML

This is the actual captured Deadlock XML.

Lock Details
The Lock Details area breaks down the deadlock by specific lock types, including the owners and waiters
involved in each lock.

Name

Description

SPID [ecid]

The session process ID of the associated owner/waiter.

Plan

Uses the Plan button to open a Plan Explorer session for the associated query plan.

Host

The workstation name.

Application

The associated application

Database

The associated database.

Log Used

The amount of Log Space used by the process.

Deadlock
Priority

Specifies the Deadlock Priority. Zero (0) or Normal is the default priority. In cases
where each session has the same Deadlock Priority, SQL Server chooses the victim
based on the least expensive session to roll back. Additional Information: For
general information about the DEADLOCK_PRIORITY option, see the Set
Deadlock_Priority MSDN article.

Wait Time

Time in (ms) milliseconds spent waiting on the resource.

Transaction
Start Time

Time that the transaction began.
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Name

Description

Last Batch
Start Time

The last time a client process started batch execution.

Last Batch
Completion
Time

The last time a client process completed batch execution.

Mode/Type

The mode/type designates the resource lock mode. Additional Information: For
general information on Lock modes see the Lock modes MSDN article.

Status

State of the task.

Isolation
Level

The current transaction isolation level. Additional Information: For general
information on isolation levels see the Isolation Levels in the Database Engine MSDN
article.

Login Name

The Login Name associated with the session.

Owner/Waiter Details
Name

Description

Object

Indicates the associated object name.

Line
Number

The line number which was being executed when the lock occurred.

Text Data

The associated text data.
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Performance Analysis AlwaysOn
Last Modified on 20 September 2021

Access the SQL Sentry AlwaysOn Management page by right-clicking the All Targets node in the
Navigator pane and selecting Open > AlwaysOn Management.
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Open AlwaysOn Management from the context menu of any Site or Group level node as applicable. The
AlwaysOn tab is available within SQL Sentry for any monitored SQL Server instance hosting an availability
group replica.
The AlwaysOn Management page is divided into the following three areas:

AlwaysOn Management Page
area

Description

Overview area

Offers several unique
actionable views of your
AlwaysOn environment,
including easily digestible at-aglance status information.

History area

Displays both historical charts
and AlwaysOn health events
from your environment.

Image
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AlwaysOn Management Page
area

Description

Details Grid view area

Displays both high level and
detailed level metrics
concerning your environment.

Image

Customize visual aspects of the AlwaysOn views around your unique environment, including the default
thresholds for Log and Recovery Queues. For more information, see the Customization section.
AlwaysOn Management includes full alerting capability surrounding your AlwaysOn environment. Fully
customizable Conditions alert you on both Health and Failover status. For more information, see the
AlwaysOn Alerting topic.

Server Visibility
When you monitor the SQL Server instance hosting the Primary Replica of an availability group with SQL
Sentry, the entire topology of that availability group displays as part of the Overview area. Unwatched
instances hosting replicas display with a gray background.

 Note: To enable complete AlwaysOn monitoring and alerting, watch each replica in the availability
group with SQL Sentry. Status information is unavailable for unwatched replicas, including historical
metrics, charts, and data pertaining to any associated Send or Recovery Queues.

To monitor a server, right-click the desired node, and then select Watch from the context menu.

Overview Area
The Overview area contains several layouts for managing your AlwaysOn environment from several
perspectives, including the Windows Server Failover Cluster level, the Availability Group level, the SQL
Server instance level, and the Replica level.
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Change the Layout Style by selecting options from the drop-down list located in the top corner of the
Overview area.

 Note: Status information that's common to several views is found in the Status Information section.

Status Information
Each of the Overview diagrams contains a unique representation of individual availability replicas/WSFCs that
are part of your managed AlwaysOn environment. Regardless of the selected view, these nodes and the pipes
connecting them all share a common set of visual status information.

Context Menu Options
Context Menu Option

Description

Watch

Watch the SQL Server
instance hosting the replica
with SQL Sentry Performance
Analysis.

Image

Node Specific
Nodes convey status and configuration information about the replica, including Queue Health, Connection
mode, and overall Health Status.

938

Labels
Label

Description

Instance Name

On applicable views, the node contains a label
with the SQL Server instance name.

Availability Replica Role

Each node is labeled indicating the role of the
availability replica, as AG Primary, AG Secondary,
or FCI Secondary.

Indicator bars
Indicator bar

Description

Health Status

The health status or availability group state is
represented by the left bar of the node. Green
represents a healthy availability group state. Pink
represents an unhealthy availability group state.
The Health Status bar is also be pink if
connectivity is lost between the SQL Sentry
monitoring service and the SQL Server instance.
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Indicator bar

Description

Queue Indicator

The Log Send Queue / Recovery Queue status
is visually represented by the bar on the right. As
the respective queue grows, the color changes
from a dark green, to light green, to orange.
Once the Queue KB Threshold passes, the color
changes to red.

Status boxes
Status box

Description

Failover Mode

The Failover mode of the availability replica is
indicated in the left status box.

Automatic Failover mode

Represented with a play icon.

Manual mode

Doesn't contain an icon.

Client Connection mode

The client connection mode of the availability
replica is represented in the center status box. If
the availability replica is a readable secondary it's
represented with a small glyph.

Failover Cluster Instances

If the node is a Failover Cluster Instance (FCI),
it's represented in the right status box.

Availability mode
The availability mode of the availability replica is represented as follows:

Availability mode

Description

Asynchronous-commit mode

Represented by two black lines drawn on the
pipe between availability replicas.

Synchronous-commit mode

Represented by the absence of these two black
lines drawn on the pipe.

Additional Information: For information about troubleshooting data movement latency between
synchronous-commit AlwaysOn availability groups, see the following MSDN article.
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Pipe and Color Specifics
The visual characteristics of the pipes connecting the nodes convey status information about the health
relationship between nodes. Pipe saturation is an indicator of the amount of information moving between
replicas. Pipe color is dependent on the recovery queue of the secondary.

Pipe Saturation
The pipe becomes saturated as the amount of data being transferred increases. More notably, the pipe
becomes saturated as the KB To Replica/sec value approaches the KB To Replica/sec threshold.
When opening the AlwaysOn tab, the KB To Replica/sec threshold value is dynamic and is the highest global
value seen between all availability groups and replicas for the current session by default.
Customize the KB To Replica/sec threshold with the AlwaysOn.AvailabilityReplicaTransferThreshold
table in the SQL Sentry database. For more information, see the Customization section.

Pipe Color
The pipe color changes as the recovery queue grows; the color changes from a dark green, to light green, to
orange, and finally once the Recovery Queue KB Threshold is passed the color changes to red.
By default, the Recovery Queue KB Threshold value is one MB or 1024 KB. Customize the Recovery Queue
KB Threshold with the AlwaysOn.AvailabilityReplica table in the SQL Sentry database. For more
information, see the Customization section.

History Area
The History area contains tabs for Charting, Error Log, and Replica State Changes. Information in each tab
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displays based on the selected time range. In Live mode, each tab includes the last 10 minutes of collected
data. Updating the time range on the tool bar changes this displayed range. Each of the History tabs is
context aware and displays information based on the node or row selected in the Overview or Grid
view area. Selecting on the diagram background displays log information for all nodes and replicas.

AlwaysOn Health Collection
The Error Log and Replica State Changes tabs are initially disabled because AlwaysOn health collection is
disabled by default. This prevents innocuous entries associated with Extended Events from being repeatedly
logged to the SQL Server Error Log without your knowledge or approval. For more information, see the
following update for a link to CU 6 for SQL Server 2012 SP1, that contains a fix for this issue.

 Note: To enable health collection, select Enable on the Error Log or Replica State Changes tab.

 Important: Enabling automated AlwaysOn health (error and state change info) collection causes
innocuous entries associated with Extended Events to be repeatedly logged to the SQL Server Error
Log, as described in Microsoft Connect item 783036. We are working closely with Microsoft to correct
this unfortunate behavior. Until it's corrected, the entry Using 'dbghelp.dll' version '4.0.5', is sent to the
Error Log on all SQL Servers with Availability Groups monitored by SQL Sentry, at the rate specified by
the collection interval.
Additional Information: Cumulative Update package 6 for SQL Server 2012 SP1 addresses this issue.
Once the update is applied, innocuous entries associated with Extended Events are no longer logged to
the SQL Server Error Log.

Adjust the enabled status and interval from the Advanced Global Settings ( Navigator > Configuration >
Global Settings > Advanced tab).
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Charting Area
Various charts related to your managed AlwaysOn environment are available in the expandable History area
of the AlwaysOn Management tab. The Charting area is context aware and displays charts based on the
selected node or row.

For example, from the WSFC Node Group/Matrix layout, select a Primary Availability Replica, to display
charts for the KB to Replicas/sec and Log Send Queue KB metrics.
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Selecting a Secondary Availability Replica displays charts with the KB from Replicas/sec and Recovery
Queue KB metrics.

Selecting a WSFC in the WSFC Members layout displays relevant metrics for each respective Availability
Group hosted on the WSFC, including KB To Replicas/sec and KB from Replicas/sec metrics.

Error Log
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The Error Log allows you to view any AlwaysOn Health events that are classified as errors in your managed
environment. This log is equivalent to viewing AlwaysOn Error Health Events accessed from the native
AlwaysOn Dashboard, but offers a number of advantages.
The Error Log is context aware and displays only errors related to the selected node or row. In Live mode,
this includes the last 10 minutes of collected data. Updating the time range on the toolbar changes this
displayed range, allowing you to view a historical subset of errors for any server.

Replica State Changes
The Replica State Changes tab displays AlwaysOn Health events that are classified as Replica State
Changes. This log is equivalent to viewing AlwaysOn availability_replica_state_change health events
accessed from the native AlwaysOn Dashboard, but offers several advantages.
The Replica State Changes tab is context aware and displays only state changes related to the selected node
or row. In Live mode, this includes the last 10 minutes of collected data. Updating the time range on the
toolbar changes this displayed range, allowing you to view a historical subset of state changes for any server.

AlwaysOn Alerting
SQL Sentry AlwaysOn Management includes the ability to configure customizable alerts specific to the
status and health of your monitored Availability Groups.
The following Failsafe Conditions are available:
SQL Availability Group Failover
SQL Availability Replica Healthy
SQL Availability Replica Unhealthy
Each of these conditions exposes several Condition Filters that help you customize your desired alerts.
The following Advisory Conditions are available:
Availability Replicas Hosted on Same Virtual Host
Availability Replicas With Disks in Same Datastore
High Database Replica Send or Recovery Queue
High Redo Completion Time
See the Advisory Conditions Pack article for details on each.

Configuring Alerts
1. Select the desired node for the level you'd like to configure the action for in the Navigator pane
(View > Navigator), and then select Failsafe Conditions from the drop-down list in the
Conditions pane (View > Conditions).
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2. Select Add to open the Select Action window, and then expand the applicable object and condition.

3. Use the check box(es) to select which actions should be taken in response to this condition being met,
and then select OK to save your settings.
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For more information about actions that can be taken when a condition is met, see the Actions topic.

Customization
Customizing Pipe Saturation
When opening the AlwaysOn tab, the KB To Replica/sec threshold value is dynamic and is the highest global
value seen between all availability groups and replicas for the current session by default. Customize the KB
To Replica/sec Threshold with AlwaysOn.AvailabilityReplicaTransferThreshold table in the SQL Sentry
database.

 Note: The AlwaysOn.AvailabilityReplicaTransferThreshold table acts as a mapping table allowing
you to define a specific value/threshold for the maximum allowed bytes (KB to Replica/sec Threshold).
By default, the table doesn't have any records, and in this state the threshold is dynamic.

Example One
Set a new KB To Replica/sec threshold value specific for all replicas involved in a WSFC node – WSFC node
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relationship, by completing the following:
1. Add a record with the PrimaryNodeName, SecondaryNodeName, and
MaxBytesSentToSecondaryPerSec values defined. The WSFC node names are found in the
AlwaysOn.ClusterNode and AlwaysOn.AvailabilityReplica tables.
INSERT INTO [SentryOne].[AlwaysOn].[AvailabilityReplicaTransferThreshold]
(PrimaryNodeName, SecondaryNodeName, MaxBytesSentToSecondaryPerSec)
VALUES ('MyPrimaryNode','MySecondaryNode', 1024);

ID

PrimaryNodeName

SecondaryNodeName

MaxBytesSentToSecondaryPerSec

1

MyPrimaryNode

MySecondaryNode

1024

 Success: The KB To Replica/sec threshold value is now 1 KB for the defined replicas.

Example Two
Set a new global KB To Replica/sec Threshold value by completing the following steps:
1. Add a record with just a MaxBytesSentToSecondaryPerSec value. For example, to set a global value of
5 KB.
2. Set a global value of 5 KB.
INSERT INTO [SentryOne].[AlwaysOn].[AvailabilityReplicaTransferThreshold]
(MaxBytesSentToSecondaryPerSec)
VALUES (5120);

ID

PrimaryNodeName

SecondaryNodeName

MaxBytesSentToSecondaryPerSec

1

Null

Null

5120

 Success: The new global KB To Replica/sec threshold value is now 5 KB.

Example Three
Set a new KB To Replica/sec Threshold value specific to a Primary Replica - Secondary Replica
relationship, by completing the following steps:
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1. Add a record with the PrimaryNodeName, SecondaryNodeName, and
MaxBytesSentToSecondaryPerSec values defined.
2. Set a value specific to a Relationship.
INSERT INTO [SentryOne].[AlwaysOn].[AvailabilityReplicaTransferThreshold]
(PrimaryNodeName, SecondaryNodeName, MaxBytesSentToSecondaryPerSec)
VALUES ('MyPrimary','MySecondary', 5120);

ID

PrimaryNodeName

SecondaryNodeName

MaxBytesSentToSecondaryPerSec

1

MyPrimary

MySecondary

5120

 Success: The KB To Replica/sec threshold value for the specific MyPrimary and MySecondary is now
5 KB.The default global value is used for all other replicas.

Example Four
Set a new KB To Replica/sec Threshold value for a specific Primary Replica, to be used with all of
its Secondary Replicas, by completing the following steps:
1. Add a record with just the PrimaryNodeName and MaxBytesSentToSecondaryPerSec values defined.
2. Set a value specific to a Primary Replica to be used with all of its Secondaries.
INSERT INTO [SentryOne].[AlwaysOn].[AvailabilityReplicaTransferThreshold]
(PrimaryNodeName, SecondaryNodeName, MaxBytesSentToSecondaryPerSec)
VALUES ('MyPrimary', Null, 5120);

ID

PrimaryNodeName

SecondaryNodeName

MaxBytesSentToSecondaryPerSec

1

MyPrimary

Null

5120

 Success: The KB To Replica/sec Threshold value for all Secondary Replicas in a relationship with the
MyPrimary replica is now 5 KB.

 Note: Add multiple records to the AlwaysOn.AvailabilityReplicaTransferThreshold table, allowing
you to easily define KB To Replica/sec thresholds specific to your environment.
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Customizing Pipe and Queue Indicator Colors
By default, there's a global Recovery Queue and Log Send Queue KB Threshold value of 1 MB or 1024 KB.
These values can be customized with the AlwaysOn.AvailabilityReplica table in the SQL Sentry database
using the LogSendQueueKBMax and RecoveryQueueKBMax columns.
Each Replica in your monitored environment has an entry in the AlwaysOn.AvailabilityReplica table. By
default, the LogSendQueueKBMax and RecoveryQueueKBMax columns are null. When this is the case, the
default global value (1 MB) is used for each respective queue. Set these columns to your desired value for
each of your replicas.

Example One
Update the Log Send Queue KB Threshold value for the replica named MyPrimary to 10 MBs.
Set a new Log Send Queue KB Threshold value for my replica MyPrimary
UPDATE [SentryOne].[AlwaysOn].[AvailabilityReplica]
SET LogSendQueueKBMax = 10240
WHERE ReplicaServerName = 'MyPrimary';

 Success: The replica MyPrimary now has a Log Send Queue KB Threshold value of 10,240 KB or 10
MB.

ID

ReplicaServerName LogSendQueueKBMax

RecoveryQueueKBMax

1

MyPrimary

Null

10240

Distributed Availability Groups
 Note: See the information above in this article for details on icons and the data flow pipeline as the
general features for Availability Groups within the AlwaysOn tab remain the same for Distributed
Availability Groups.

DAG-01 Example View
The following Distributed Availability Group setup is used in the SQL Sentry AlwaysOn tab examples below:

950

Distributed Availability Group Configuration Example

DAG-01 has a primary availability group ( AG-02) and a secondary availability group ( AG-01). Within those
availability groups, there's a primary to secondary replica relationship (e.g. Node 008 primary flowing to Node
007 secondary).

AG-01 View
Looking at AG-01, AG-02 is listed under the Distributed AG column:

Viewing AG-01 in a Distributed Availability Group

In this view, AG-02 is labeled with the name of the Distributed AG ( DAG-01 ). The data pipeline animates the
data flow between the Distributed AG (Node 008) and the primary replica of AG-01 (Node 005).

 Note: Rows represent availability groups (e.g. AG-01) and columns represent replicas within that
availability group.
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AG-02 View
When selecting AG-02, the relationship between the two availability groups displays in the opposite direction.
The data flow pipeline goes from WSFC Node 008 to the distributed node ( 005). The links continue to work
between the distributed nodes and their associated replicas as described for Availability Groups in this
article.

Viewing AG-02 in a Distributed Availability Group

 Note: Hover over the pipeline for more information about the connection (e.g. data flow metrics and
direction).

Pipeline showing KB To Replica/sec and Total Log Send Queue KB details
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QuickTrace™
Last Modified on 20 September 2021

QuickTrace™
A QuickTrace is a comprehensive snapshot of activity created by combining process-level data and trace
events collected during a brief sample period. Various metrics such as CPU, I/O, recompiles, cache misses,
cursor operations, etc., are automatically aggregated, and are grouped and sorted providing a clear picture
the processes, hosts, applications, or users responsible for activity during the sample. For a full list of the
metrics gathered, see the QuickTrace Collected metrics table below.
Top SQL trace uses filters to collect only the heaviest events by default to maintain low overhead. A
QuickTrace isn't filtered and collects all events and it's both time and row limited, to avoid impacting the
performance of the target SQL Server.
A QuickTrace is typically run manually from the Dashboard in response to observing high utilization in one or
more metrics. For example, if there's a spike in Transactions/sec on the SQL Server Activity, run
a QuickTrace by completing the following steps:
1. Highlight the spike, and then right-click to open the context menu. Select Jump To > QuickTraces to
open the QuickTraces tab.
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2. Select Run QuickTrace to open the Run a QuickTrace dialog box, configure your desired metrics, and
then select Ok.

3. Sort by Events to determine the cause.

Column Set
There are four Column Sets that can be selected and modified to provide a pre-determined view of the data
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with preset columns and sorting. If a QuickTrace is launched by right clicking the Network, CPU, SQL Server
Activity, or Disk IO charts, the appropriate column set is used by default. Change the active column set by
right-clicking the master or detail column header row, and then selecting the Column Chooser menu item.

 Note: When you run a QuickTrace from the QuickTraces tab the SQL Activity Column Set is used.

The QuickTraces tab lists all QuickTraces occurring during the active date range. Execute QuickTraces
manually or automatically using the Run QuickTrace action in response to a condition such as Runtime
Threshold Max or Performance Counter Threshold Max.

Running a QuickTrace
Select Run QuickTrace from the QuickTraces tab or from the right-click menu on the other applicable tabs,
to open the options menu. Enter the length of time the QuickTrace runs in the first dialog box. Choose to
Collect statement events or not by selecting the checkbox in the second dialog box. Limit the number of
Trace Data rows in the third dialog box. Select Ok to run the QuickTrace.

 Note: You can enable a QuickTrace to run when certain conditions are met by configuring the Run
QuickTrace action. For more information about Actions in SQL Sentry, see the Actions article.
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Default Settings
The QuickTrace runs for 15 seconds.
Collect statement events is unselected.
Limit Trace Data To 10000 rows.

 Note: Generally, these settings are fine but may need to be adjusted in certain situations.

Restrictions
To avoid impacting server performance on very busy systems, SQL Sentry restricts QuickTrace functionality
under some circumstances.
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QuickTrace Restrictions
A QuickTrace isn't allowed if a 100Mb adapter is present, and the last sample indicates there are >300 users
or >3000 transactions per second for the targeted server.
This state is also checked before automated QuickTraces are run. The QuickTrace is disallowed if the state is
detected.
A QuickTrace isn't recommended in the case where 1000 Mb or above adapters are present, and the last
sample indicates there are >500 users or >5000 transactions per second for the targeted server.
If this state is detected during a manually initiated QuickTrace, a warning generates indicating that the
QuickTrace isn't recommended. The state is also checked before automated QuickTraces are run. The
QuickTrace is disallowed if the state is detected.

 Warning: SQL Sentry Version 7 introduced the above restrictions for QuickTrace functionality. For
prior versions, use the above restrictions as a guideline when running a QuickTrace. Failure to follow
these guidelines may cause a temporary suppression of transaction throughput. The risk of impact on
performance is much greater if the network speed between the SQL Sentry client and the target server is
less than 1000Mbps.

Exporting a QuickTrace
Once a QuickTrace is complete, it opens automatically for viewing.

Export the QuickTrace by selecting Export Data from the File menu ( File > Export Data).

The following are four formats a QuickTrace can be exported in:
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Adobe Acrobat Files (*.pdf)
CSV Files (*.csv)
Microsoft Excel (.xls)
Web Pages (.htm, .html)

Display
The top pane provides a series of filters and controls for specifying which records to display for the specified
interval.

Display Filters
Image

Filter

SQL Servers

Owner

Sources

The bottom pane lists the records matching the current filters. The default filter is to display all records.

Controls
Top Pane
Control

Description

Set filter

After changing any of the
filters, select Refresh,or press
F5 to apply the filter.

Image

List box filters
Select on a combination of items
in any of the lists to set the
filters.

The default filter displays all
records.
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Control

Description

Image

Select more than one item in a
list.

Shift-Click or CTRL-click

SQL Servers (dropdown)

Select server instance to run a
QuickTrace.

Run QuickTrace

Start a QuickTrace against the
select SQL Server instance.

Bottom Pane
Control

Description

Sort Column

Select any column header to sort by that column.

Group By box

Drag any column header here to group by that
column.

Double click on a row

View the selected QuickTrace.

Context Items
Context item

Description

Jump to Dashboard

Opens the Dashboard with
the selected
QuickTrace event overlaid on
each of the charts.

Open

View the selected
QuickTrace.

Image

QuickTrace Viewer
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The QuickTrace Viewer presents a set of nested controls to inspect the trace. These controls behave the
same as on the QuickTraces tab.
Right-clicking on a trace record presents a context menu that allows you to copy the event row data to the
clipboard or kill the process associated with that trace event.

 Note: The individual text can be copied from the Text Data column, once highlighted, using (Ctrl +
C) or the context menu.

Additional controls presented include:

Control

Description

Reload

Runs a new QuickTrace of the
same target.

Refresh

Available when a QuickTrace
is run in real-time, and causes
the QuickTrace to execute
with same parameters.

Options

Opens the Options pane.
Available options in the
Viewer are:
Auto-highlight detail
rows when sorting by an
event totals column
Freezes metadata
columns
Hides rows with empty
values in sort column
Maintains row position
when changing sort
Shows the QuickTrace
process
Shows statement events
if available
Shows system processes

Image
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Control

Description

Close

Closes the QuickTrace
Viewer.

Image

QuickTrace Collected Metrics
The following metrics are collected per application when running a QuickTrace:

Metric

Column Set

SPID

CPU, Network, SQL Activity, Disk

Application

CPU, Network, SQL Activity, Disk

Host

CPU, Network, SQL Activity, Disk

Database

CPU, Network, SQL Activity, Disk

Login

CPU, Network, SQL Activity, Disk

Login Time

CPU, Network, SQL Activity, Disk

Logout Time

CPU, Network, SQL Activity, Disk

Events

CPU, Network, SQL Activity, Disk

Duration

CPU, Network, SQL Activity, Disk

CPU (Description)

CPU, Network, SQL Activity, Disk

CPU %

CPU, Network, SQL Activity, Disk

Logical Reads

CPU, Network, SQL Activity, Disk

Logical Reads %

CPU, Network, SQL Activity, Disk

Physical Writes

CPU, Network, SQL Activity, Disk

Physical Writes %

CPU, Network, SQL Activity, Disk
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Metric

Column Set

Physical Reads

CPU, Network, SQL Activity, Disk

Physical Reads %

CPU, Network, SQL Activity, Disk

Recompiles

CPU, Network, SQL Activity, Disk

Recompiles %

CPU, Network, SQL Activity, Disk

Cache Misses

CPU, Network, SQL Activity, Disk

Cache Misses %

CPU, Network, SQL Activity, Disk

Cursors

CPU, Network, SQL Activity, Disk

Cursors %

CPU, Network, SQL Activity, Disk

Physical IO

CPU, Network, SQL Activity, Disk

Physical IO %

CPU, Network, SQL Activity, Disk

Batches

CPU, Network, SQL Activity, Disk

Batches %

CPU, Network, SQL Activity, Disk

Transactions

CPU, Network, SQL Activity, Disk

Transactions %

CPU, Network, SQL Activity, Disk

SPs

CPU, Network, SQL Activity, Disk

SPs %

CPU, Network, SQL Activity, Disk

RPCs

CPU, Network, SQL Activity, Disk

RPCs %

CPU, Network, SQL Activity, Disk

Prep SQL

CPU, Network, SQL Activity, Disk

Prep SQL %

CPU, Network, SQL Activity, Disk
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Metric

Column Set

Network Reads

CPU, Network, SQL Activity, Disk

Network Reads %

CPU, Network, SQL Activity, Disk

Network Writes

CPU, Network, SQL Activity, Disk

Network Writes %

CPU, Network, SQL Activity, Disk

Cursor Ops

CPU, Network, SQL Activity, Disk

Cursor Ops %

CPU, Network, SQL Activity, Disk

Logins

CPU, Network, SQL Activity, Disk

Logins %

CPU, Network, SQL Activity, Disk

Objects Created

CPU, Network, SQL Activity, Disk

Objects Created %

CPU, Network, SQL Activity, Disk

Instance Resets

CPU, Network, SQL Activity, Disk

Instance Resets %

CPU, Network, SQL Activity, Disk

Client Network
Address

CPU, Network, SQL Activity, Disk

Client Interface
Name

CPU, Network, SQL Activity, Disk

Network Transport

CPU, Network, SQL Activity, Disk

Network Auth
Scheme

CPU, Network, SQL Activity, Disk

Network Packet
Size

CPU, Network, SQL Activity, Disk

% Complete

CPU, Network, SQL Activity, Disk
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Metric

Column Set

Est Completion
Time

CPU, Network, SQL Activity, Disk
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SQL Sentry Indexes
Last Modified on 19 May 2021

Applies to: SQL Sentry

 Note:
As of version 2020.8.31, the table and index data collection is enabled by default during
installation. In older versions of SQL Sentry, this feature is disabled by default.
It can be turned on by using the in-app wizard in any version.
The defragmentation schedule must be created manually in all versions.

Indexes Tab
The Indexes tab displays information about your tables and indexes that are collected by SQL Sentry
Fragmentation Manager. The Indexes tab helps you make intelligent decisions about index management in
your environment, such as when and how to perform defragmentation operations, when to adjust fill factors,
or when an index definition should be changed.
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Indexes Tab Sections
Section

Description

Overview
Charts

The Overview Chart section, located at the top
of the tab, displays a set of charts that contain
aggregate statistics about all the indexes
analyzed by Fragmentation Manager.

Index Grid
View

The index Grid view section, located in the
middle portion of the tab, allows you to view
index related statistics in a tabular format.

Index Tree
View

The index Tree view section, located in the
middle portion of the tab allows you to view
index related statistics in a hierarchical tree
format.

Detail
Charts

The Detail Chart section, located at the bottom
of the tab, displays a set of charts that display
statistics unique to the individual index.
Selecting an index in the grid view area updates
the detail level charts.

Image
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Section

Description

Image

The Filter section, located at the top of

Filter

Indexes tab, is collapsed by default. It's used to
filter what's shown in the Grid view section.
Filter by SQL Server or database, and control the
number of rows shown in the Grid view with the
Show Top option.

 Note: Customize the layout of the Indexes tab, by right clicking any section heading, and then
selecting the Customize Layout option.

Overview Charts
The Overview Charts contain aggregate statistics about all of the indexes analyzed on the target by
Fragmentation Manager.

Total Fragmentation
The Total Fragmentation chart displays a once a day aggregation of the fragmentation levels for all indexes
that have been analyzed by Fragmentation Manager. Each index's fragmentation level for the day is
summarized, and the indexes are next grouped by range; <10%, 10-20% , 20-30%, and >30%.
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The Y-axis numbers represent the total number of indexes belonging to the target that have been analyzed
by Fragmentation Manager. When you select a range on the chart, the indexes that fall into the
corresponding range are highlighted in the index Grid view.

Total Space Usage (MB)
The Total Space Usage chart summarizes disk usage for each index that's had data collected over the
specified time frame. As a reminder, adjust the minimum and maximum index size collection thresholds in the
Database Source settings.
The chart has individual representations for Unused space, Used space, and Empty space. Unused space is
represented at the bottom of the chart, Used space in the middle, and Empty space at the top. See the
following table for explanations of each metric.

Metric

Description

Unused

Unused space is the amount of disk space that's
been allocated for index pages, but doesn't
contain any index pages.

Image
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Metric

Description

Used

Used space is the amount of disk space that's
been allocated for index pages, and does contain
index pages.

Empty

This is the amount of empty or unfilled space,
within any index pages. The lack of page fullness
indicates that index fill factors need to be
adjusted.

Image

Total Buffer Usage (MB)
The Total Buffer Usage chart summarizes SQL Server buffer usage, during the specified time range, for each
index that's had data collected. There are individual representations of Used space and Empty space.

Metric

Description

Used

Represents the size of the Used index pages
contained within the SQL Server Buffer pool.

Image

Represents the amount of empty or unfilled
space within those index pages that reside in the
SQL Server Buffer Pool.
Empty

The Empty Buffer metric can be directly mapped
to the Empty Disk metric because a page that's
only 50 percent full on disk is only 50 percent full
when it's contained in the buffer.

Detail Charts
The Detail Charts contain statistics about individual indexes analyzed on the target.
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Index Fragmentation
The Index Fragmentation chart shows the fragmentation percentage of the selected index, measured during
each scheduled Fragmentation Scan. If a reorganization or rebuild operation is performed on the index, and
the Run Post-defrag Analysis setting is enabled, data points that represent the fragmentation percent after
the rebuild or reorganization operation is complete display. Use this chart to help you determine what kind of
fragmentation management schedule should be applied to the index.

Each data point on the chart represents a Fragmentation Manager operation. Double-click on any data point
to open the Event Calendar for the selected operation. The background colors of the chart correspond to the
same ranges and colors as found in the Total Fragmentation chart.

Index Space Usage
The Index Space Usage chart shows how much of the selected index is located on the disk and in the buffer,
over the selected time frame. It can also give you an idea about how much disk and buffer space is being
wasted by the index due to non-full pages.

Metric

Description

Unused
Disk

The amount of disk space that's allocated for
index pages, but doesn't contain index pages.

Used Disk

The amount of disk space that's allocated for
index pages, and does actually contain index
pages.

Empty Disk

This is the amount of empty or unfilled space,
within any of the index pages.

Image
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Metric

Description

Empty
Buffer

Represents the amount of disk space taken up by
empty or unfilled space, within those index
pages, that resides in the SQL Server Buffer
Pool.

Used
Buffer

Represents the size of the Used index pages
contained within the SQL Server Buffer Pool for
the specified index.

Image

Index Activity
The Index Activity chart gives you a view of how the selected index is being used over the specified time
frame. Use this chart to help identify unused indexes and the cost of your heavily used indexes.

Metric

Description

User Scans

The number of scan operations on the index
caused by user activity.

User Seeks

The number of seek operations on the index
caused by user activity.

Image

The number of lookups caused by user activity.

User
Lookups

User
Updates

For a clustered index, this represents the
number of key lookups done against the
index.
N/A for non-clustered index
For a heap, this indicates the number of RID
lookups.

The number of updates caused by user activity.
Indicates the level of maintenance on the index
caused by insert, update, or delete operations
done to the underlying table.
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Metric

Description

System
Scans

The number of scan operations on the index due
to system queries.

Image

Additional Information: For general information about the Index usage statistics, see the
sys.dm_db_index_usage_stats (Transact-SQL) MSDN article.

Index Grid View
The Index Grid View, located in the center of the Indexes tab, contains various statistics about your
individual indexes. When you select an index in the Grid view, the Detail index charts update with
information specific to that index.
Apply filters and order the data by various columns. To apply a filter to the Grid view, scroll over a column,
and then select the filter symbol located in the upper right hand corner of the column header.

After you apply a filter, the filter symbol persists in the column's header, allowing you to see which columns
have filters applied.

Additionally, the column name and any associated filtered text displays at the bottom of the Grid View. Use
the X button located beside the filtered text to remove the filter, or use the drop-down box to cycle through
filtered columns.
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Edit the applied filters with the Edit Filter button found in the bottom of the Grid view. Filters can also be
applied through the right-click context menu of any column.

 Note: The information displayed in the Overview Charts isn't effected by filters applied in the Grid
view.

To order the Grid view by a column's value, select the column header. An arrow displays in the column's
header indicating that the Grid view is being ordered by that column. Cycle through ascending and
descending order by selecting the column's header.

Index Grid View Columns
Column

Description

SQL Server

The name of the SQL Server where the index resides.

Database

The name of the database where the index resides.

Table

The name of table where the index resides.

Index

The name of the index.
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Column

Description
The type of index. Heap, Clustered index, Non-clustered index,
Primary index, Spatial index, or XML index.

Type
Additional Information: For more information about the different types
of indexes, see the Types of Indexes MSDN article.
Primary Key

Specifies if the index is part of a primary key constraint.

Unique

Specifies if the index is part of a unique constraint.

Specifies the Data Space Type:
Data Space Type

FG- FileGroup
PS- Partition Scheme
FD- Filestream data filegroup

Size (MB)

The amount of disk space represented in megabytes taken up by the index.

Used (MB)

The amount of disk space that's allocated for index pages, and does contain
index pages.

Used (MB) in Buffer

Represents the size of the Used Index pages contained within the SQL
Server Buffer Pool.

Empty (MB) in Buffer

Represents the amount of empty or unfilled space, within those index pages
that reside in the SQL Server Buffer Pool.
The number of rows of data belonging to the index.

Row Count

Avg % Fragmented

 Note: Not available for Limited Scan mode.
The average fragmentation percentage of the index as recorded during the
last fragmentation scan.
 Note: Not available with a Sampled Scan for heaps.

The average percentage of available data storage space used in all the
Avg % Page Space
Used

pages of the selected index. This indicates page fullness.
 Note: Not available for Limited Scan mode.
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Column

Description
The Fill Factor set for the selected index.

Fill Factor

Additional Information: For more information, see the Specify Fill Factor
for an Index MSDN topic.

User Scans Delta

The number of scan operations on the index caused by user activity since the
last sample time (every 15 minutes).

Status

The current status of any defragmentation operations being performed on
the selected index.

Start Time

The start time of the last defragmentation operation that was performed on
the selected index.

End Time

The end time of the last defragmentation operation that was performed on
the selected index.

Duration

The duration of the last defragmentation operation that was performed on
the selected index.

Last Message

Indicates the last defragmentation operation related to this index, including
the last defragmentation method used on the selected index.

Avg Record Size
(bytes)

Indicates the average record size in bytes for the selected index.
 Note: Not available for Limited Scan mode.

Compressed Pages

The number of compressed pages for the selected index.

Enabled

Indicates if the index has been made available. Set in the index properties of
the native SQL Server tools.

Forwarded Records

Represents the number of records in a heap that have forward pointers to
another data location. Forward pointers can be added during updates, when
there isn't enough room to store the new row in the original location.
 Note: Only available for Index Type: Heap. Not available with a Limited
Scan.
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Column

Description

Number of ghost records ready for removal by the ghost cleanup task in the
allocation unit. Ghost records are records that have been logically deleted
from a page but not physically deleted.

Ghost Records

Additional Information: For more information about Ghost Records, see
the following two SQL Skills articles:
Inside the Storage Engine: Ghost cleanup in depth
Ghost cleanup redux
 Note: Not available with a Limited Scan.

Pages

The total number of index pages for the selected index.

Unused Disk (MB)

The amount of disk space that's allocated for index pages, but doesn't
contain index pages.

Used %

The percent of disk space that's allocated for index pages and contains
index pages.

Version Ghost
Records

Number of ghost records retained by an outstanding snapshot isolation
transaction in an allocation unit.
 Note: Not available with a Limited Scan.

LOB Data

Specifies if the index contains one or more LOB data type.

Index Grid View Context Menu Commands
The following commands are available through the right-click context menu of the Index Grid and Tree View:

Command

Description

Index Properties

Views the Index Properties of the selected index in the native SQL Server
tools.
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Command

Description

Selected your desired mode to perform a fragmentation analysis on the
selected item.

Analyze
Fragmentation Now

Limited mode is the fastest mode and scans the smallest number of
pages. For an index, only the parent-level pages of the B-tree are
scanned. For a heap, only the associated PFS and IAM pages are
examined; the data pages of the heap are not scanned.
Sample mode returns statistics based on a one percent sample of all
the pages in the index or heap. If the index or heap has fewer than
10,000 pages, use Detail mode instead of Sample mode.
Detail mode scans all pages and returns all statistics.
Additional Information: For more information about Scan Modes, see the
sys.dm_db_index_physical_stats (Transact-SQL) MSDN article.

Use the Rebuild (offline), Rebuild (online), or Reorganize command to
immediately perform the selected operation.
Additional Information: For more information about reorganizing and
Defragment Now

rebuilding indexes, see the Reorganizing and Rebuilding Indexes MSDN
article.
Indexes that contain LOB columns cannot be Rebuilt online. When the
Defragment Now > Rebuild (online) command is used on indexes that
contain LOB columns an offline rebuild is performed.

Exclude Index from
Automated Defrag or
Analysis

The Exclude Index from Automated Defrag or Analysis excludes the
selected index from future Fragmentation Manager operations. After an
index has been excluded it displays with a gray background in the data grid.

Reset Fragmentation
Stats

The Reset Fragmentation Stats command resets statistics for the selected
item, including the Avg percentage Fragmented statistic.

Jump To Navigator opens the selected item in the Navigator pane.
Jump To

Jump To Calendar opens the Calendar for the last analysis or
defragmentation event start time.

Copy

Copies the selected row or cell.
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SQL Sentry Fragmentation Manager
Last Modified on 20 September 2021

Heavily fragmented indexes degrade the performance of your database and the applications running on it.
Resolve index fragmentation by reorganizing or rebuilding an index. Fragmentation Manager automatically
collects table and index information, analyzes the data, takes the appropriate reorganization or rebuild
operations, and then performs post defragmentation analysis.
Fragmentation Manager has a dedicated tab in SQL Sentry, Indexes. The Indexes tab displays index related
statistics and charts, from the target level down to the individual index level, giving you a complete view of
the fragmentation levels on your server. Having this information allows you to make intelligent decisions
about index management in your environment such as when and how to perform defragmentation
operations, when to adjust fill factors, or when an index definition should be changed.
Set different schedules for instances and databases down to the individual table or index level, giving you
complete granular control over any defragmentation actions. Additionally, set specific schedules for rebuilds
or reorganizations explicitly. Several additional settings are available to help you calibrate the actions SQL
Sentry takes, including:
The ability to set the scan level or mode that's used to obtain fragmentation statistics.
The ability to set minimum and maximum index size thresholds for the collection of fragmentation data.
The ability to set reorganization and rebuild fragmentation threshold percentages.
All index defragmentation settings work within the normal SQL Sentry hierarchy meaning that settings
can be configured at one level and are automatically inherited by objects below it, allowing for easy
automation within your environment.
For a complete explanation of all the available settings, see the Fragmentation Manager Settings section.

Enabling Fragmentation Manager
Enable Fragmentation Manager through the right-click context menu of any instance or by opening the
Indexes tab of SQL Sentry and selecting Enable Now. The first time you enable it, the Fragmentation
Manager Wizard displays.
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 Note: In versions 2020.8.31 and later, this feature is enabled by default for all targets, for new users.
It may be disabled manually.

Fragmentation Manager Wizard Options

Option

Description
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Option

Collect table and index size
information

Description
The base level of Fragmentation Management. Every 15 minutes
SQL Sentry collects table and index size information for the top
500 indexes in each database.
 Note: Indexes are collected that meet the criteria specified in
the Minimum and Maximum size thresholds, with values ranging
from 10 MB to 50,000 MB.

Determines if SQL Sentry collects buffer data when the buffer size
Collect buffer data when
buffer size > eight GB

is > eight GB.
See the Database Source setting Collect Buffer Data when Buffer
> eight GB description for a complete explanation.

Retain historical data [FM]

Retains table and index historical data.

SQL Sentry analyzes index fragmentation statistics based on the
schedule you specify on the next screen and displays those
statistics on the Indexes tab of SQL Sentry.
Analyze fragmentation
The Limited Mode obtains fragmentation statistics. Change the
Fragmentation Scan mode after the wizard completes from the
Index Defragmentation settings.

Defragment indexes over
specified thresholds [FM]

Reanalyze indexes after
defragmentation

SQL Sentry performs defragmentation operations based on the
schedule you specify in the next screen.
Selects your desired reorganization and rebuild thresholds for
defragmentation operations.

SQL Sentry reanalyzes fragmentation statistics after any
defragmentation operations are performed.

Selecting a Schedule
To select a schedule to be used for analysis and/or defragmentation, choose a pre-existing schedule, or select
the New command to create a new schedule.
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Select Next to confirm your settings, and then select Finish to complete the Wizard.

Fragmentation Manager Related Settings
The following are two groups of settings relevant to Fragmentation Manager:
Database Source settings—Used to configure the general collection of table and index information,
including size collection thresholds, buffer collection thresholds, and index partition options.
Index Defragmentation settings—Used to configure the defragmentation and analysis operations,
including scheduling, setting index reorganization, and rebuild thresholds.

Database Source Settings
Synchronization

Description

Default Value
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Synchronization

Description

Default Value

Inherit From Parent

Specifies whether settings in this group are being
inherited. For more information about inheritance, see
the hierarchy chart in the Alerting and Response
System topic.

True

Maximum Rows to
Synchronize

Maximum rows of historical event data to collect from
this source.

5000

General Settings

Description

Default
Value

Inherit From
Parent

Specifies whether settings in this group are being inherited. For
more information about inheritance, see the hierarchy chart in
the Alerting and Response System topic.

True

Specifies whether table and index collection is enabled. When
enabled every 15 minutes SQL Sentry collects table and index
Enable
Table/Index
Data Collection

size information.
True
 Note: This setting must be True to perform
Analysis operations and Automated Defragmentation
operations.

Max Partitions
to collect per
Database

The maximum number of partitions information that's collected
per database.
 Note: Partitions are collected by size. The partitions are
ordered by ReservedSpaceMB, that’s using
reserved_page_count from sys.dm_db_partition_stats.

500

Min Index Size
(MB) to Collect
Fragmentation
Data

Specifies how large an index must be before statistics are
captured. If you keep the default value of 10 MB, any indexes
that are smaller than 10 MB aren't analyzed or considered for
defragmentation operations.

10 MB

Max Index Size
(MB) to Collect
Fragmentation
Data

Sets the maximum size an index can be, and still be considered
for defragmentation operations.

50000 MB

Specifies whether to collect buffer data when buffer size is >
eight GB.
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General Settings

Collecting detailed buffer information is inherently a low
Description
overhead process. However, because it takes approximately one

Default
Value

second per GB of buffer, on larger buffers the associated query
takes some time to complete, which causes it to appear in Top
SQL and/or generate associated alerts.
It's safe to enable this setting because SQL Sentry ensures that
the total time spent per day collecting buffer data is roughly the
same regardless of buffer size, and collection only occurs when
buffer has changed.
When collecting buffer data, SQL Sentry uses a variable collection
frequency, that's based on the size of the buffer. The following
chart shows the variable collection frequency along with the
approximate time it takes to collect buffer data for different
buffer sizes.
Maximum Buffer Data Collection Frequency

Collect Buffer
Data when
Buffer > eight
GB

Buffer Size
(GB)

Collection
Frequency
(Min)

Time to
Collect
(Sec)

Time to
Collect
(Min)

4

15

4

0.1

8

15

8

0.1

16

30

16

0.3

32

60

32

0.5

64

120

64

1.1

96

240

96

1.6

128

240

128

2.1

256

480

256

4.3

384

720

384

6.4

512

1440

512

8.5

768

1440

768

12.8

Set with
Wizard
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General Settings

Description
Buffer Size
(GB)

1024

Collection
Frequency
(Min)

Time to
Collect
(Sec)

Time to
Collect
(Min)

2880

1024

17.1

Default
Value

Index Defragmentation Settings
After you enable Fragmentation Manager the Index Defragmentation settings are accessed through the
Settings pane. Index Defragmentation settings are configured at the following levels: global (All Targets),
sites, target group, target, instance, database, table, or at the individual index.
To configure the Index Defragmentation settings for a specific instance, complete the following steps:
1. Select the instance in the Navigator (View > Navigator), and then open the Settings pane (View >
Settings).
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2. Select Index Defragmentation from the bottom drop-down menu to configure your settings.

Index Defragmentation Settings
General Defrag Settings

Description

Default Value

Inherit From Parent

Specifies whether settings in this
group are being inherited. For more
information about inheritance, see the
hierarchy chart in the Alerting and
Response System topic.

False

Primary Schedule

The schedule where index analysis
and/or defrag performs, according to
the configured reorg and rebuild
thresholds. For more information
about schedules, see the Schedules
topic.

Set with Wizard
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General Defrag Settings

Description

Default Value

Operation Type

Specifies whether analysis only or
analysis and defrag operations occur
under the Primary schedule.

Analyze Only

Reanalyze Indexes after
Defrag

Specifies whether to run the
fragmentation analysis again after any
scheduled defrag.

False

Fragmentation Scan
Mode

The Scan mode used for obtaining
fragmentation statistics:
Limited mode is the fastest
mode and scans the smallest
number of pages. For an index,
only the parent-level pages of
the B-tree are scanned. For a
heap, only the associated PFS
and IAM pages are examined; the
data pages of the heap aren't
scanned.
Sample mode returns statistics
based on a one percent sample
of all the pages in the index or
heap. If the index or heap has
fewer than 10,000 pages, Detail
mode is used instead of
Sample mode.
Detail mode scans all pages and
returns all statistics.

Limited

Additional Information: For more
information about Scan modes, see
the sys.dm_db_index_physical_stats
(Transact-SQL) MSDN article.

Maximum Concurrent
Operations

Specifies the maximum number of
concurrent operations. Operations are
defined as an analysis, rebuild, or
reorganization. This setting is capped
at five.

one

Delay Between Defrag
Operations

When Maximum
Concurrent operations is set to one,
specify a delay between defrag
operations to prevent send/redo
queue overload when availability
groups or mirroring are in use.

30 seconds
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General Defrag Settings

Description

Default Value

This sets the maximum allowed
runtime for the defragmentation
process.

Maximum Duration

If the maximum duration is met during
a rebuild operation the rebuild still

two hours

completes. If the maximum duration is
met during a reorganization operation,
the reorganization stops and starts
again during the next scheduled cycle.

Partitions to include in the rebuild.
This option is applicable for indexes
that have a sliding windows partition
scheme.
Additional Information: For more
information about partition schemes,
see the Implementing Partitioned
Tables and Indexes MSDN article.

Partitions

All —All partitions belonging to
the index that meet the
defragmentation criteria are
either rebuilt or reorganized.
Max Only —If the maximum
numbered partition of the index
meets the defragmentation
criteria it's rebuilt or
reorganized.
Exclude Max —All partitions
that meet the defragmentation
criteria, excluding the maximum
numbered partition, are either
rebuilt or reorganized.

All Partitions

 Note: Online rebuilds for
partitioned indexes only perform if
the Partitions setting is set to All and
all partitions in the index meet the
defragmentation criteria. If the above
criteria isn't met, an Offline Rebuild
performs instead.
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General Defrag Settings

Description

Default Value

Index Reorg Settings

Description

Default Value

Inherit From Parent

Specifies whether settings in this
group are inherited. For more
information about inheritance, see the
hierarchy chart in the Alerting and
Response System topic.

True

Reorg Threshold%

Sets the fragmentation threshold
percent at which indexes are
reorganized. If the default threshold
of 10 percent is kept, indexes that
have an index fragmentation
percentage below 10 percent , as
determined during the
Fragmentation Scan, aren't
reorganized. Indexes with a
fragmentation percent exceeding 10
percent are reorganized.

10 percent

Additional Information: For more
information about reorganizing
indexes, see the Reorganizing and
Rebuilding Indexes MSDN article.

Reorg Schedule

Dedicated schedule where reorgs only
are performed, according to the reorg
threshold. Rebuilds aren't performed
even if the rebuild threshold has been
exceeded, and are reorganized.

Index Rebuild Settings

Description

Default Value

Inherit From Parent

Specifies whether settings in this
group are inherited. For more
information about inheritance, see the
hierarchy chart in the Alerting and
Response System topic.

True
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General Defrag Settings

Rebuild Threshold %

Description
Sets the fragmentation threshold
percent for the indexes that are
rebuilt. If the default value of 30
percent is kept, only indexes that have
an index fragmentation percent of 30
percent or greater, as determined
during the Fragmentation Scan are
rebuilt.

Default Value

30 percent

Additional Information: For more
information about rebuilding indexes,
see the Reorganizing and Rebuilding
Indexes MSDN article.

Rebuild Schedule

Dedicated schedule where rebuilds
only (online or offline) are performed,
according to the rebuild threshold.

Offline Rebuild Window

If an offline rebuild performs, it starts
the offline rebuild during the specified
window.
Specifies if tempdb is to be used for
sorting during rebuild operations.

Sort in tempdb

Additional Information: For more
information about tempdb and index
creation, see the tempdb and Index
Creation MSDN article.

False

Determines if the index rebuild
operations perform online.
Use Online Rebuild
(Enterprise Only)

Additional Information: For more
information about performing index
operations online, see the Performing
Index Operations Online MSDN article.

True
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General Defrag Settings

Description

Default Value

Determines the max degree of
parallelism (MAXDOP) that's used
when rebuilding the index. The default
value is zero, which allows the server
to determine the number of CPUs that
are used.
Additional Information: For more
information about configuring Parallel
MAXDOP (Enterprise
Only)

Index Operations, see the Configuring
Parallel Index Operations MSDN
article.

zero

 Note: When Fragmentation
Manager is working on an index, it
uses the MaxDOP to determine how
parallel each concurrent connection
can run. Increasing the Concurrent
Connections increases how many
indexes are being worked by the tool
at any given time.

 Note: Indexes that can't be rebuilt online, such as those with LOB columns, are never defragmented
by a Rebuild schedule if Use Online Rebuild is set to True except within a specified Offline Rebuild
Window. Otherwise, they are only analyzed.

 Note: When there are multiple partitions, Fragmentation Manager works on one partition at a time
in a serial fashion. Parallelize the Index analysis and defragmentation in Fragmentation Manager by
using one of the following methods:
Build multiple schedules that can be scheduled to run in an overlapping manner.
Increase the Maximum Concurrent Operations.

Manual Fragmentation Operations
Fragmentation Operations can also be initiated manually. Within the Navigator use the right-click context
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menu of any database, table, or index to initiate fragmentation operations, including analysis, reorganizations,
or rebuilds.
Manual Fragmentation Operations can also be initiated within the Indexes tab. From the Grid/Tree view
found in the center of the screen, use the context menu of any database, table, or index to access
fragmentation operations.

Fragmentation Alert Conditions
The following fragmentation related conditions are available to configure actions for:
Defragmentation Completed
Defragmentation Started
Defragmentation Failure
To configure a fragmentation related condition, complete the following steps:
1. Select the node appropriate to the level you'd like to configure the action for in the Navigator pane
(View > Navigator), and then open the General Conditions section in the Conditions pane (View >
Conditions).
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2. Select Add in the Conditions pane to open the Actions Selector window.
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3. Expand the Index actions and then the appropriate condition. Use the check box(es) to select which
actions should be taken in response to this condition being met. Select OK to save your setting.
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For more information about actions that can be taken when a condition is met, see the Actions topic.

Indexes Tab
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For more information about the charts and statistics displayed in the Indexes tab, see the Indexes topic.

Database Space Usage Band
By enabling the Fragmentation Manager, the functionality of the Disk Space tab is also enhanced by
providing additional information regarding the space usage of indexes. For more information, see the Disk
Space topic.

Buffer Size (GB)

Collection
Frequency (Min)

Time to Collect
(Sec)

Time to Collect
(Min)

4

15

4

0.1

8

15

8

0.1

16

30

16

0.3

32

60

32

0.5

64

120

64

1.1

96

240

96

1.6

128

240

128

2.1

256

480

256

4.3

384

720

384

6.4
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Buffer Size (GB)

Collection
Frequency (Min)

Time to Collect
(Sec)

Time to Collect
(Min)

512

1440

512

8.5

768

1440

768

12.8

1024

2880

1024

17.1
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SSAS Overview for SQL Sentry
Last Modified on 05 May 2021

 Download: To learn more about SQL Sentry pricing and downloading a trial, see the SQL Sentry
product page.

 Note: Monitoring SSAS targets is now part of SQL Sentry. See the SQL Sentry product page for more
details about subscription pricing.

Overview
SQL Sentry allows you to continuously monitor and troubleshoot SQL Server Analysis Services (SSAS) issues
in a Multidimensional or Tabular mode. The two primary types of activities that occur in SSAS are querying
and processing. Processing involves creating and updating data, while the storage engine queries the file
system to retrieve data from the SSAS caches with baselining and alerting functionality and partition usage
totals. For more information about usage totals, see the SSAS Usage Totals topic. Common issues you may
encounter in SSAS include the following:
VertiPaq memory limits and paging policy. For more information about Vertipaq, see the Analyzing
VertiPaq Memory Usage in SSAS Tabular in SQL Sentry article.
Bottlenecking during DAX and MDX queries.
In SQL Sentry, you can monitor the CPU, Memory, Disk, and Network servers resources to determine what's
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causing an issue.

SSAS Layout
Similar to the SQL Server Performance Analysis Dashboard, in SQL Sentry the Windows
Performance metrics are on the left and Analysis Services are on the right. The color coding on the Memory,
CPU, and Network graphs provide a way to see what is responsible for different types of traffic.

 Note: For a complete list and description of metrics available in the SQL Sentry Dashboard, see the
Performance Metrics article.

SSAS Tabular

SSAS Multidimensional

Chart Area

Description

SSAS
Activity

Allows correlation between
rows transferred and Formula
and Storage Engine threads. It's
important to identify if your
main bottleneck is in the
Formula Engine or Storage
Engine.

Multidimensional

Tabular
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Chart Area

SSAS
General

SSAS
Memory

SSAS
Storage

Description

Multidimensional

Tabular

Monitors all of the activity for
you continuously at a fraction of
the overhead a Profiler Trace
tends to impart. Average Time
is a unique chart with average
time metrics calculated by SQL
Sentry. These counters are not
available through Windows
Performance Counters.
Discover what the instance is
spending the most time on with
this chart. It divides the
information into more detail for
you:
Serialization is handled by
the Formula Engine and is
related to NON_EMPTY
behavior.
Processing and SQL
queries are handled by the
Storage Engine.

Memory monitoring is very
different between
Multidimensional and Tabular
modes, and different counters
are available depending on the
mode. Specific to the
Tabular mode, the Mem Usage
chart allows you to see memory
counters, and the VertiPaq
Memory Limit allows you to see
where memory pressure might
be causing performance issues.
The chart also displays the
VertiPaq paging policy that is
important for monitoring the
performance metrics. For more
information about the VertiPaq
paging policy, see the Analyzing
VertiPaq Memory Usage in SSAS
Tabular in SQL Sentry article.

To determine whether the disk
system is a bottleneck for your
SSAS instance, you need to
verify that SSAS is accessing the
disk system. Use this chart to
correlate storage counters to
other activity on your system.
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SSAS Overview
Additional Information: For a complete overview of SSAS, see the About SQL Server Analysis Services
Microsoft article.

SQL Server Analysis Services (SSAS) is a multi-threaded storage engine with detailed query analysis and
data processing. SQL Sentry performs queries in the Storage and Formula engines to aggregate and calculate
data. The two most common types of queries performed include:
MDX Queries—Cumulative MDX workloads across the server, cell-by-cell operations, and potentially
high-impact operations in the Multidimensional mode.
DAX Queries—Shows the storage engine time per query, internal VertiPaq cache matches and scans,
and it allows you to identify possible bottlenecks in the Tabular mode.
Memory in SSAS is stored in KB, and is both shrinkable and non-shrinkable. For more information about
memory in SSAS, see the Analysis Services Memory Limits article. The following are three groups of metrics
that monitor memory in the SQL Sentry Dashboard:
Mem Usage (MB)—Total memory SSAS is using on the server. Right-click to choose the Low and High
limit. You can also show by category to see the portions of the non-shrinkable memory being used.
Cache Lookups—Shows memory performance in the Flat cache and Calculation cache on the formula
engine and in the Dimension cache and Measure Group cache on the storage engine.
Cache Activity—Indicates the memory pressure on the server. Shrink counters indicated that you're
exceeding your defined memory limit.

 Note: Monitoring memory is different in Tabular mode from Multidimensional mode because the
Storage engine operates in-memory. The dashboard is also labeled to denote Tabular or (MDX)
Multidimensional mode.

 Note: SSAS isn't just an interaction with the disk system, it's also an interaction with the file system
as a whole. Analysis Services, unlike the SQL Server, makes extensive use of the windows file cache.

SSAS Events
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SQL Sentry provides the popular Event Calendar feature that many are familiar with from SQL Sentry. The
SQL Sentry Outlook-style Event Calendar view provides visibility into specific events occurring over a range of
time. With the Event Calendar, you can see the entire chain of events and often identify what led up to a
specific performance issue.

 Note: Consider creating a Custom Events View calendar called SSAS Event View that shows
instances of Analysis Services. Right-click the SQL Sentry target, and then select Event Calendar to
open the SSAS Event View.

This view shows commands and queries (including text, start and end times, as well as duration) that were
executed against SSAS. Events are color-coded to indicate things such as failures. Processing can be a
bottleneck in SSAS, and with the Event Calendar, you can see an XLMA command that performed processing
and quickly visualizes the other queries that were executing at the same time to identify what might have
been impacted by that processing to better understand the performance hits.
If you've set up alerts for certain conditions, such as the SSAS Storage Engine Processing Pool Job Queuing
and those alerts are triggered, they appear on the Event Calendar next to the other events for that time
period.

 Note: If you have performance issues with Processing, confirm the following:
Check scheduled jobs and activities that may exist for that time frame. Move them to a less busy
time, if possible, to mitigate resource contention.
Verify that you're using the correct Processing option. For example, ProcessFull refreshes
everything whether there is new data or not. While this option may be necessary at times, you may
not need to use it for all cases. Use a less resource-intensive Processing option when possible. 
Additional Information: For additional information on available options, see the Processing
Options and Settings (Analysis Services) Microsoft article.
Confirm you are using partitions that provide additional performance benefits that minimize
activity to what you need.
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SSAS Queries
For a further breakdown of SSAS activity on a query-by-query basis in SQL Sentry, see the Top Commands tab.
You'll see whether your query experienced more Formula Engine or Storage Engine time, and you can expand
the view for a complete breakdown by Measure Group, Partition, Aggregation, and Dimension.

 Download: To learn more about SSAS Performance, download our free eBook Optimizing SSAS
Performance or watch this hour-long presentation on our Vimeo channel called Getting Peak
Performance for SQL Server Analysis Services (SSAS).

SQL Sentry Alerts
Alerts allow the user to define global actions for the most common issues across your environment.

General Condition Alerts
Blocking SQL
Conditions

Descriptions

SQL Server: Blocking SQL

A block was detected that was subject to
the Minimum Block Duration set for the
Blocking SQL Source. View the block on the
Event Calendar or the Blocking SQL tab.
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Conditions

Descriptions

SQL Server: Blocking SQL: Duration Threshold Max

Block exceeded the maximum duration
threshold.

SQL Server: Blocking SQL: Output Content Match

A match condition was found in the output
content of a block.

Deadlocks
Conditions

Descriptions

SQL Server: Deadlock

A deadlock was detected. View the deadlock on
the Event Calendar or the Deadlocks tab.

SQL Server: Deadlock: Output Content Match

A match condition was found in the output
content for a deadlock.

Index
Conditions

Descriptions

Index: Defragmentation Completed

Index Defragmentation completed

Index: Defragmentation Failure

Index Defragmentation failed.

Index: Defragmentation Started

Index Defragmentation started.

Top Commands
Conditions

Descriptions

Analysis Services: Top Commands: Completed

An Analysis Services command (MDX or XMLA)
completed.  Note: It is highly recommended
that a ruleset be used with this condition to
avoid excessive logging.

Analysis Services: Top Commands: Duration
Threshold Max

The duration threshold maximum was exceeded
for an Analysis Services command (MDX or
XMLA).

Analysis Services: Top Commands Error

An Analysis Services command (MDX or XMLA)
completed with an error.
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Conditions

Descriptions

Analysis Services: Top Commands: Output Content
Match

A match condition was found in a completed
Analysis Services command (MDX or XMLA).

Top SQL
Conditions

Descriptions

SQL Server: Top SQL: Completed

Top SQL event completed.  Note: It is highly
recommended that a ruleset be used with this
condition to avoid excessive logging.

SQL Server: Top SQL: Duration Threshold Max

Top SQL event exceeded the maximum duration
threshold.

SQL Server: Top SQL: Duration Threshold Min

Top SQL event didn't exceed the minimum
duration threshold.

SQL Server: Top SQL: Error

Top SQL event completed with an error.

SQL Server: Top SQL: Output Content Match

A match condition was found in the content of a
completed Top SQL event.

Windows Computer
Condition

Description

Virtual Machine: VM Moved

The Virtual Machine moved.

Failsafe Condition Alerts
Analysis Services
Conditions

Descriptions

Analysis Services: Offline

Analysis Services is offline or otherwise
inaccessible.

Analysis Services: Online

Analysis Services is online and accessible.

SQL Server
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Conditions

Descriptions

SQL Availability Group Failover

The SQL Availability Group failed over.

SQL Availability Replica Healthy

The SQL Availability Replica is healthy.

SQL Availability Replica Unhealthy

The SQL Availability Replica is unhealthy.

SQL Server Agent: Offline

SQL Server Agent is offline or otherwise
inaccessible.

SQL Server Agent: Online

SQL Server Agent is online and accessible.

SQL Server Cluster Failover

SQL Server cluster failed over.

SQL Server: Offline

SQL Server is offline or otherwise inaccessible.

SQL Server: Online

SQL Server is online and accessible.

Windows Computer
Conditions

Descriptions

Windows Computer: Offline

Windows Computer is offline or otherwise
inaccessible.

Windows Computer: Online

Windows Computer is online and accessible.

Advisory Condition Alerts
For more information about the advisory condition alerts, see the Advisory Conditions Pack topic and the
Advisory Conditions for Monitoring SSAS Performance article.
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SSAS Performance Metrics
Last Modified on 05 May 2021

Overview
This article covers the various SSAS performance metrics displayed by the Performance Analysis Dashboard
and Performance Analysis Overview, and how to interpret different metric values and combinations of
values across different metrics for SQL Sentry.

 Note: For Mode: S = Sample and H = History.

SSAS Metrics for Tabular and Multidimensional Modes
Section

Metric

Description
The rate of rows sent by the server to the clients.

SSAS Activity

Rows
Transferred:
Query Rows
Sent / Sec

Mode:

S, H

Type:

Average rows sent per sec

The rate of rows read from all relational databases. If you
are connected to SQL Server, you should be reading at least
80,000 rows per sec per table being processed.

SSAS Activity

Rows
Transferred:
Proc rows read
/ Sec

Mode:
Type:

S, H
Average rows read per sec
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Section

SSAS Activity

Metric

Threads:
Formula Engine:
Busy

Description
The Processor performance object consists of counters that
measure aspects of processor activity. The processor is the
part of the computer that performs arithmetic and logical
computations, initiates operations on peripherals, and runs
the threads of processes. A computer can have multiple
processors. The processor object represents each
processor as an instance of the object.
Mode:

S, H

Type:

Last Value

The rate of jobs through the query thread pool.

SSAS Activity

Threads:
Formula Engine:
Job Rate

Mode:

S, H

Type:

Last Value

The number of jobs in the queue of the query thread pool.

SSAS Activity

Threads:
Formula Engine:
Queued

Mode:

S, H

Type:

Last Value

The number of busy threads in the thread pool.

SSAS Activity

Threads:
Storage Engine:
Busy

Mode:

S, H

Type:

Last Value

The rate of non IO jobs through the thread pool.

SSAS Activity

Threads:
Storage Engine:
Job Rate

Mode:

S, H

Type:

Last Value
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Section

Metric

Description
The number of jobs in the processing thread pool queue.

SSAS Activity

Threads:
Storage Engine:
Queued

Mode:

S, H

Type:

Last Value

The average amount of time for a query to be executing in
the formula engine.

SSAS General

Average Time
(ms): Formula
Engine

Mode:

S, H

Type:

Avg/ms

 Warning range:

20 Sec

 Critical range:

One Min

The average amount of time spent returning data from the
storage engine cache.

SSAS General

Average Time
(ms): SE cached

Mode:

S, H

Type:

Avg/ms

 Warning range:

> One Sec

The average amount of time spent returning non-cached
data from the storage engine cache.

SSAS General

Average Time
(ms): SE noncached

Mode:

S, H

Type:

Avg/ms
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Section

Metric

Description
The average amount of time spent serializing data to disk (
as in data aggregations).

SSAS General

Average Time
(ms):
Serialization

Mode:

S, H

Type:

Avg/ms

The average amount of time spent executing SQL queries
from the relational database.

SSAS General

Average Time
(ms): SQL
Queries

Mode:

S, H

Type:

Avg/ms

Displays the average processing time in milliseconds.
Processing in SSAS Involves the SE, and can cause the Cache
to become outdated and flushed. This causes a
performance hit because when the query is run after
processing completes, the SE has to retrieve the necessary
data from the Windows file cache or from disk (cold cache).
Non 0 values on the indicate that processing is taking place.
Processing can be improved by:

SSAS General

Average Time
(ms): Processing

Re-scheduling processing when the least querying
activity is going on. This helps to avoid resource
contention.
Check the processing type that is being used; Use
ProcessIndex instead of ProcessFull when possible.
Break the measure groups into partitions to reduce
the overall amount of work that is done.

Mode:

S, H

Type:

Avg/ms
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Section

Metric

Description

The total number of cell properties calculated. High values
for Cells calc’d while the query is executing indicates that
the query is doing cell by cell calculations (this is like row by

SSAS General

MDX: Cells
Calculated

agonizing row in SQL Server) instead of Subspace (block by
block) execution.

Mode:

S, H

Type:

Last Value/sec

The total number of evaluation nodes built by MDX
execution plans including active, and cached. High values
for Calc Covers while the query is executing indicates that
the query is doing cell by cell calculations (this is like row by
SSAS General

MDX:
Calculated
Covers

agonizing row in SQL Server) instead of Subspace (block by
block) execution.

Mode:

S, H

Type:

Last Value/sec

The total number of subcubes that the query optimizer
generated. High values for Sonarsubcubes while the query
is executing indicates that the query is doing cell by cell
calculations (this is like row by agonizing row in SQL Server)
instead of Subspace (block by block) execution.
SSAS General

MDX:
Sonarsubcubes

Mode:

S, H

Type:

Last Value/sec
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Section

Metric

Description

The total number of cells recomputed due to error.
Recomputes indicate that there were errors in the
calculations during query execution. Non 0 values indicate
where unnecessary recalculations are taking place and can
SSAS General

MDX:
Recomputes

fall back to cell by cell executions.

Mode:

S, H

Type:

Last Value/sec

The total number of times unoptimized the NON EMPTY
algorithm is used. NE unopt helps determine if performance
degradation is occurring due to a slower code path. Using a
non-empty algorithm can speed up performance.
SSAS General

MDX: NE unopt
Mode:

S, H

Type:

Last Value/sec

The total number of times the NON EMPTY algorithm was
looping over calculated members. NE calc memb help
determine if performance degradation is occurring due to a

SSAS General

MDX: NE calc
memb

slower code path. Using a non-empty algorithm can speed
up performance.

Mode:

S, H

Type:

Last Value/sec
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Section

Metric

Description
SSAS has two general categories of memory, shrinkable and
nonshrinkable. Shrinkable memory can be easily reduced
and returned back to the OS. Shrinkable memory is the
amount of memory in KB that's subject to purging by the
background cleaner.

SSAS Memory

SSAS Memory

Memory Usage
(MB): Shrinkable

Memory Usage
(MB):
Nonshrinkable

Mode:

S, H

Type:

MB

SSAS has two general categories of memory, shrinkable and
nonshrinkable. Nonshrinkable memory is generally used for
more essential system-related tasks such as memory
allocators and metadata objects, and is not easily reduced.
Nonshrinkable memory is the amount of memory in KB
that's not subject to purging by the background cleaner.

Mode:

S, H

Type:

MB

The rate of inserts from the cache.

SSAS Memory

Cache Activity:
Cache Inserts

Mode:

S, H

Type:

Last Value/sec

The rate of evictions from the cache.  Note: This is per
partition per cube per database.

SSAS Memory

Cache Activity:
Cache Evictions

Mode:

S, H

Type:

Last Value/sec

 May correlate:

Background cleaner
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Section

Metric

Description
The rate of memory added to the cache (KB / Sec).

SSAS Memory

Cache Activity:
KB added

Mode:

S, H

Type:

KB/sec

The rate of shrinking in KB / Sec.

SSAS Memory

SSAS Storage

SSAS Storage

Cache Activity:
KB Shrunk

File Reads KB:
by category

File Writes KB:
by category

Mode:

S, H

Type:

KB/sec

Mode:

S, H

Type:

KB/sec

Mode:

S, H

Type:

KB/sec

The current number of client connections established to the
Analysis Services server.

SSAS Activity

Mode:

S

Type:

Last Value

 Warning range:

> 50

Connections
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Section

Metric

Description
The current number of user sessions established to the
Analysis Services server.

SSAS Activity

Sessions

Mode:

S

Type:

Last Value

The rate of incoming connection requests per second.

SSAS Activity

Requests/Sec

Mode:

S

Type:

Last Value/sec

The rate of connection failures per second.

SSAS Activity

Failures/Sec

Mode:

S

Type:

Last Value/sec

The current number of locked objects.

SSAS General

Current Locks

Mode:

S

Type:

Last Value

The current number of clients waiting for a lock.

SSAS General

Current Lock
Waits

Mode:

S

Type:

Last Value
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Section

Metric

Description
The ratio of cache hits from the dimensions.

SSAS Memory

Cache Hit ratio:
Dim percent

Mode:

S

Type:

Percentage

The ratio for measure groups.

SSAS Memory

SSAS Memory

SSAS Memory

Cache Hit ratio:
MG percent

Cache Hit ratio:
Calc percent

Cache Hit ratio:
Flat percent

Mode:

S

Type:

Percentage

Mode:

S

Type:

Percentage

Mode:

S

Type:

Percentage

The percent reading to the storage engine cache.

SSAS Storage

File Cache Hit
Ratio: Read
percent

Mode:

S

Type:

Percentage
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Section

Metric

Description
The percent writing to the storage engine cache.

SSAS Storage

File Cache Hit
Ratio: Write
percent

Mode:

S

Type:

Percentage

SSAS Metrics for Tabular Mode Only
Section

Metric

Mode:

S, H

SSAS Memory

Mem Usage
(MB): VertiPaq
paged

Type:

MB

Mem Usage
(MB): VertiPaq
nonpaged

Mode:

S, H

Type:

MB

Cache Activity:
Dim Cache
Lookups

Mode:

S, H

Type:

Last Value/sec

Cache Activity:
Calc Cache
Lookups

Mode:

S, H

Type:

Last Value/sec

SSAS Memory

SSAS Memory

SSAS Memory

Description
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SSAS Metrics for Multidimensional Only
Section

Metric

Description
Displays the rate of Processing rows written during
processing. Processing in SSAS Involves the SE, and can
cause the Cache to become outdated and flushed. This
causes a performance hit because when the query is run
after processing completes, the SE has to retrieve the
necessary data from the Windows file cache or from disk
(cold cache). Non 0 values on the indicate that processing is
taking place.
These metrics can also help determine the effectiveness of
any processing tuning efforts. If your tuning efforts are
effective, you should see an increase in these values
accordingly.

SSAS General

Processing: Proc
rows Written /
Sec

Processing can be improved by:
Re-scheduling processing when the least querying
activity is going on. This helps to avoid resource
contention.
Check the processing type that is being used; Use
ProcessIndex instead of ProcessFull when possible.
Break the measure groups into partitions to reduce
the overall amount of work that is done
Mode:

S, H

Type:

Last Value/sec
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Section

Metric

Description
Displays the rate of rows from MOLAP files used to create
indexes. Processing in SSAS Involves the SE, and can cause
the Cache to become outdated and flushed. This causes a
performance hit because when the query is run after
processing completes, the SE has to retrieve the necessary
data from the Windows file cache or from disk (cold
cache).Non 0 values on the indicate that processing is
taking place.
These metrics can also help determine the effectiveness of
any processing tuning efforts. If your tuning efforts are
effective, you should see an increase in these values
accordingly.

SSAS General

Processing:
Index rows
created

Processing can be improved by:
Re-scheduling processing when the least querying
activity is going on. This helps to avoid resource
contention.
Check the processing type that is being used; Use
ProcessIndex instead of ProcessFull when possible.
Break the measure groups into partitions to reduce
the overall amount of work that is done.
Mode:

S, H

Type:

Last Value/sec
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Section

Metric

Description
Displays the rate Aggregate rows are created during
processing. Processing in SSAS involves the SE, and can
cause the Cache to become outdated and flushed. This
causes a performance hit because when the query is run
after processing completes, the SE has to retrieve the
necessary data from the Windows file cache or from disk
(cold cache).Non 0 values on the indicate that processing is
taking place.
These metrics can also help determine the effectiveness of
any processing tuning efforts. If your tuning efforts are
effective, you should see an increase in these values
accordingly.

SSAS General

Processing:
Aggregate rows
created

Processing can be improved by:
Re-scheduling processing when the least querying
activity is going on. This helps to avoid resource
contention.
Check the processing type that is being used; Use
ProcessIndex instead of ProcessFull when possible.
Break the measure groups into partitions to reduce
the overall amount of work that is done.
Mode:

S, H

Type:

Last Value/sec

The rate of cache lookups.

SSAS Memory

Cache Lookups:
Dimension

Mode:

S, H

Type:

Last Value/sec

The rate of Measure group queries.

SSAS Memory

Cache Lookups:
Measure grp

Mode:

S, H

Type:

Last Value/sec
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Section

Metric

Description

The rate of calculation cache lookups, including global,
session, and query scope calculation caches.
SSAS Memory

Cache Lookups:
Calc

Mode:

S, H

Type:

Last Value/sec

The rate of Flat Cache lookups, including global, session,
and query scope flat caches.

SSAS Memory

Cache Lookups:
Flat

Mode:

S, H

Type:

Last Value/sec

The rate of insertions into the cache.  Note: This is per
partition per cube per database.

SSAS Memory

Cache Activity:
Flat Cache
inserts

Mode:

S, H

Type:

Last Value/sec

Mode:

S, H

Type:

Last Value/sec

.

SSAS Storage

File Queries by
Category

The amount of partitions during querying .

SSAS Storage

Current
Partitions by
Category

Mode:

S, H

Type:

Last Value/sec
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Section

Metric

Description
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SSAS Top Commands
Last Modified on 30 November 2021

The Top Commands tab shows Analysis Services query level collection and any MDX, DAX, DMX, and XMLA
commands that have run longer than one second. All of the like queries have been rolled up and grouped
together so you can see their total impact. Drill down to see individual queries and group by event class to do
discovery on the grid data.
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Columns

Descriptions

Event Class

The event class of the associated event. Additional Information: For more
information, see the SQL Server Event Class Reference MSDN article.

Text Data

Associated text data captured for the event.

Parameters

Contains the parameters for parameterized queries and commands associated with the
query event.

Application

Name of the client application that created the connection.

Database

Name of the database for the associated event.

Host

Name of the target where the associated event is running.

Login

The Windows or SQL Server account associated with the event.

Duration

The amount of time taken by the associated event.

CPU

The amount of CPU time (in milliseconds) used by the event.

CPU %

The percentage of CPU time used by this event, in relation to any other Top Commands
events that are shown in the grid.

FE Time

Time spent by workload on the Formula Engine.

SE Time

Time spent by workload on the Storage Engine.
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Columns

Descriptions

Processing
Time

Time spent by workload processing.

SQL Query
Time

Time spent by workload in SQL queries.

SE Noncache Ops

Number of Non-cache Storage Engine operations.

SE Cache
Ops

Number of Cache Storage Engine operations.

Callbacks

Applies to Tabular mode only. Provides the number of callbacks from the VertiPaq
Storage Engine to the Formula Engine associated with the query.

Measure
Groups

Provides a count of the number of Measure Groups accessed by the query or command.

Partitions

Provides a count of the number of Partitions accessed by the query or command.

Agg Hits

Applies to Multidimensional mode only. Provides a count of the number of
Aggregations accessed by the query.

Dimensions

Provides the dimensions of the query hierarchy.

Attributes

Provides a count of the number of Attributes accessed by the query.

Rows Sent

Provides a count of the number of rows returned by the query.

Processing
Rows

Provides a count of the number of rows processed by the command.

Errors

Error number of a given event.

Error Text

Contains the text data associated with the error event.

Reads

The number of logical disk reads performed by the server on behalf of the event.

Reads %

The percentage of bytes read by this event, in relation to any other events that are
shown in the Top Commands tab.

Writes

The number of physical disk writes performed by the server on behalf of the event.
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Columns

Descriptions

Writes %

The percentage of bytes written by this event, in relation to any other events that are
shown in the Top Commands tab.

Start Time

Time the event started.

End Time

Time the event ended.

Information

Additional data captured about the event.

Right-click on any query, and Jump To the dashboard. You can also Jump To > Calendar to see what else is
running at the same time, or Jump To > Runtime Stats to see if there are any outliers on runtime.

Additional Information: For more information about Disk Activity and Disk Space, see the Disk Activity
and Disk Space topics.

Name

Description

Jump To >

Jumps to the corresponding tab.

Calendar
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Name

Description

Dashboard

SSAS Usage
Totals

Runtime
Stats

Add/Edit
Notes

Adds or edits a note to the query.
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Name

Description

Hide

Hides the query from the list.

Copy >

Copies the cell, row, or entire query to the clipboard.
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SSAS Usage Totals
Last Modified on 30 November 2021

The SSAS Usage Totals tab provides information that can be used to determine what responses to take
based on activity levels.

Multidimensional Instances

For Multidimensional instances, the information is divided into three different groups:

Tab

Description

Attributes

Use the Attributes tab to view which attribute combinations are hit the most to
determine if creating an aggregation would improve performance. Expand a command
to see the different queries, and to display more detailed information for each query.

Aggregations

Use the Aggregations tab to view the aggregations that are being used. Expand an
aggregation to see text data for the queries.

Partitions

Use the Partitions tab to view the partitions that are being read the most.

 Note: If there are aggregations and partitions that don't display in these tabs, it's possible they
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aren't being used.

Tabular Instances

For Tabular instances, the only tab that displays in SSAS Usage Totals is the Object Memory Usage tab. Use
the Object Memory Usage tab to view the objects that are using the most memory in your instance. Expand
objects to drill down and display more detailed information about the memory usage.

Filter Pane

The Filter pane provides a series of filters and controls for specifying which records to display. The following
filter categories are available:
SQL Servers
Databases
Cubes
Measure Groups
Select the desired filter, then select the Refresh button or press F5 to apply the filter. Select a combination of
items in any of the lists to set the filters. Use shift-click or ctrl-click to select more than one item in a list.
Depending on the length of the displayed interval, you may have a lot of data to work with. The Show Top
setting controls how many of the rows are retrieved.
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Performance Analysis Disk Activity
Last Modified on 05 May 2021

Applies to: SQL Server, SSAS*, VMware*, and Windows* targets.

Introduction

 Note: *The Disk Activity and Disk Space tabs are focused on database files. For Windows it applies to
VMware and Hyper-V hosts for vDisks and VHDX files, respectively. The tabs will only display for SSAS,
VMware, and Windows when the applicable files are available for monitoring.

Additional Information: If the Disk Activity tab or the Disk Space tab does not display, there could be
an issue with WMI on the system you're monitoring. For more information about troubleshooting WMI on
your system, see the WMI Troubleshooting MSDN article.

Disk bottlenecks represent one of the most common sources of performance problems for Windows and SQL
Server. The Disk Activity tab provides a patented graphical disk analysis system that breaks down disk
activity and latency at the controller, physical disk, and file level, highlighting bottlenecks at any point in a
disk system.

Target

Example View

1030

Target

Example View

SQL Server

VMware

Windows

The top pane of the display shows a graphical representation of the entire disk system as Windows sees it.
The middle pane displays activity metrics in either a hierarchical disk system format or database/virtual hard
disk/ virtual machine disk list format. The bottom pane displays graphs showing read and write latency, IOPS
and throughput for the disk or file chosen in the top pane, or middle pane.

Target

Example View

SQL Server
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Target

Example View

VMware

Windows

Disk Activity Modes
The Disk Activity tab has two modes, Real Time and History. The active mode is controlled with the autorefresh toolbar button.
Select the auto-refresh Play button  to enter the Real Time mode.
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The System box represents the underlying storage in your monitored environment. The Controller box(es)
display the controller in your environment. A controller works as an interface between the motherboard and
other components, and makes sense of the signals going to, and coming from the CPU.
SQL Server
The top pipe represents Read activity between
the System and Controller.
The bottom pipe represents Write activity
between the System and Controller.

VMware
The top pipe represents Read activity between
the System and the Datastore.
The bottom pipe represents Write activity
between the System and the Datastore.

Windows
The top pipe represents Read activity between
the System and the Controller.
The bottom pipe represents Write activity
between the System and the Controller.
Data for the last collected sample is shown, and moving segmented lines indicates the I/O direction (read or
write) and latency for each disk, file, and controller or datastore.
The top pipe represents Read activity.
The bottom pipe represents Write activity.
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The thickness and color of the displayed segmented line indicates the amount of latency being experienced.
As latency increases, the lines grow in width and changes through green, olive, orange, and red to give a quick
visual indication of the decreased performance.
Selecting any file displays a tooltip that shows the numerical values for the reads and writes hitting a file. The
amount of overall latency being experienced by the disk is distinguished from the amount of latency for
individual files. The overall disk latency is represented with the horizontal pipe connecting all the individual
files, while the small vertical pipes represent latency at the file level.

 Note: A disk appearing red indicates a suspect offset setting. This may affect IO performance.

The following table lists the color of the segmented line and the corresponding range of latency values. All
latency values are listed in milliseconds (ms).

Color Range
Color Range

Read Latency

Write Latency
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Color Range

Read Latency

Write Latency

Green

< 10 ms

< 10 ms

Greenish-Yellow to Orangish-Yellow

10-20 ms

10-20 ms

Orange to Reddish-Orange

21-30 ms

21-40 ms

Red

> 30 ms

> 40 ms

Read and Write Latency Color Gradients

Select the auto-refresh Pause button to enter History mode. Aggregate disk metrics are displayed for the
selected date range, and the solid lines indicate latency. History mode enables you to see how your disk
system performs over any period.

 Note: In history mode the pipes display as solid lines representing latency at the selected time frame.
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Disk Activity Real-time mode

Disk Activity History mode

Toolbar
The following toolbar options are available when auto-refresh is paused:

View

Description

Disk Grid View

Toggles between showing the
File Grid view and the Disk
Grid view.  Note: When
auto-refresh is paused, these
viewing options are available.

File Grid View

Toggles between showing the
Disk Grid view and the File
Grid view.  Note: When
auto-refresh is paused, these
viewing options are available.

Show Empty Disks

Controls whether disks
without any SQL Server
database files are displayed.

Order By Activity

Sorts physical disks by activity
in descending order.

Sum

Displays the total IO
information in your
environment.  Note: When
auto-refresh is paused, these
viewing options are available.

Image
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View

Description

Average

Displays the Average IO
information in your
environment.  Note: When
auto-refresh is paused, these
viewing options are available.

Image

Context Menus
Left-click—Sets the focus to any file. Other files for the same database are highlighted along with the
corresponding grid row.

 Note: This is applicable to SQL Server, VMware, and Windows targets.

 Note: Hover over any graphical icon to display more detailed IO information.

SQL Server

VMware

Windows

Right-click—Run a Quick Trace or a Quick Report.
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 Note: Quick Trace is only available for SQL Server targets.

 Note: The following context menu options are available for VMware and Windows targets.

Jump to VM Disk Activity — Opens the Disk Activity tab for the selected SQL Server.
Stop watching— Stops the monitoring of a selected file.

Watch— Begins monitoring a selected file.
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Exporting and Reporting Options
Exporting Data—Export the Disk Activity grid through the File menu (File > Export Data).

Quick Report—Run a Quick Report from the right-click context menu of any file to access database level I/O
metrics in a report format. Run a Quick Report while in Real Time mode for the last 10 minutes of data.

1039

Disk Activity Metrics
The following table lists descriptions of the metrics displayed on the Disk Activity screen. For more
information about interpreting latency values, see the Disk I/O: Read latency by physical disk article.

 Note: The sample collection frequency for disk counters is 20 seconds. While in Real Time mode, the
Disk Activity screen updates according to this sample interval. A custom sample interval is specified.
This may be useful if you're monitoring a server with many database files per database, because this can
lead to increased SQL Sentry database growth and transaction log activity.

Name

Description

The virtual machine that the file is associated with.
Virtual
Machine

 Note: This column appears for targets that are also Hyper-V Hosts, and the column
populates for files directly associated with virtual machines on the host (e.g., .vhdx files,
mounted .iso files).
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Name

Description

Real Time
The average number of byte reads per second over the last polling interval.
Read Bytes

History
Average Mode—The average number of byte reads per second over the selected range.
Sum Mode—The total number of byte reads for the selected range.

Real Time
The percentage of byte reads from this file in relation to other files belonging to the
target over the last sample polling interval.
% Read
Bytes

History
Average Mode—The average percentage of byte reads from this file in relation to
other files belonging to the target over the selected historical range.
Sum Mode—n/a

Real Time
The number of read operations per second over the last sample polling interval.
Reads

History
Average Mode—The average number of read operations per second over the selected
range.
Sum Mode—The total number read operations occurring in the selected range.
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Name

Description

Real Time
Milliseconds per read. The average time in milliseconds each physical disk read took
over the last sample polling interval.
ms/Read

History
Average Mode—The average time in milliseconds each physical disk read took over the
selected time range.
Sum Mode—n/a

Real Time
The average number of bytes written per second over the last polling sample interval.
Write
Bytes

History
Average Mode—The average number of bytes written per second over the selected
range.
Sum Mode—The total number of bytes written for the selected range.

Real Time
The percentage of bytes written to this file in relation to other files belonging to the
target over the last sample polling interval.
% Write
Bytes

History
Average Mode—The average percentage of bytes written to this file in relation to
other files belonging to the target over the selected historical range.
Sum Mode—n/a
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Name

Description

Real Time
The number of write operations per second over the last sample polling interval.
Writes

History
Average Mode—The average number of write operations per second over the selected
range.
Sum Mode—The total number write operations occurring in the selected range.

Real Time
Milliseconds per write. The average time in milliseconds each physical write took over
the last sample polling interval.
ms/Write

History
Average Mode—The average time in milliseconds each physical disk write took over
the selected time range.
Sum Mode—n/a

The Other designation is assigned to files that aren't part of the SQL Server installation.

Real Time
The average number of byte reads per second over the selected range, involving files
Other Read
Bytes

that aren't part of the SQL Server installation.

History
Average Mode—The average number of byte reads per second over the selected range.
Sum Mode—The total number of byte reads for the selected range.
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Name

Description

The Other designation is assigned to files that aren't part of the SQL Server installation.

Real Time
The average number of byte writes per second over the selected range, involving files
Other
Write
Bytes

that aren't part of the SQL Server installation.

History
Average Mode—The average number of byte writes per second over the selected
range.
Sum Mode—The total number of byte writes for the selected range.

Total VLFs

See the Total VLFs topic.

TempDB Example
The Disk Activity analysis feature can also be used to monitor the activity for TempDB. The example below
shows TempDB and TempDB Log on their own respective drives and how they appear on the Disk Activity
tab.
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Example of disk activity analysis for tempdb and templog.

Troubleshooting
Mount Points
If mounted drives are not showing up under Disk Activity or Disk Space, it is likely related to the required
ports or DCOM permissions. See the following support KB articles for more information:
Port Requirements for Mount Point Support
Setting DCOM Permissions for Mount Point Support
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Performance Analysis Disk Space
Last Modified on 05 May 2021

Applies to: SQL Server, SSAS*, VMware*, and Windows* targets.

Introduction

 Note: *The Disk Activity and Disk Space tabs are focused on database files. For Windows targets it
applies to VMware and Hyper-V hosts for vDisks and VHDX files, respectively. The tabs will only display
for SSAS, VMware, and Windows targets when the applicable files are available for monitoring.

Additional Information: If the Disk Activity tab or the Disk Space tab does not display, there could be
an issue with WMI on the system you're monitoring. For more information about troubleshooting WMI on
your system, see the WMI Troubleshooting MSDN article.

The Disk Space tab contains information about disk space utilization within your environment, broken down
by database and file. Use the Disk Space tab to identify disk capacity issues, understand where various
database files reside on the disk system, and to determine whether available disk space is optimally used.
The Disk Space tab has two distinct areas. The top pane is a graphical representation of the database layout
at the disk level. Data files are represented with a unique solid color, and each associated log file is
represented with the same color with a line overlay. The solid grey areas represent the empty space per disk.
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The colors are repeated for each file in the Grid View found in the bottom pane. Selecting a file in either pane
highlights the associated representation in the other pane.

Using Disk Space
Disk Space Modes
The Disk Space tab has two modes, Real Time and History. The active mode is controlled by the AutoRefresh toolbar button. Select the auto-refresh Play button to enter the Real Time mode. Data for the last
collected sample is shown.

Select the auto-refresh Pause button to enter the History mode. History mode displays the average disk
space information over the specified time range. Change the time range you're viewing by using the Start and
End times and selecting Go in the toolbar.

Database Space Usage Band
When index collection is enabled, index information is viewable by drilling into the database level in the
Grid View. When a database is selected in the grid, a band displaying the space usage of that database's
indexes appears between the disk layout and the grid. Select a database in the Grid View to open it's
corresponding Database Space Usage Band.
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 Note: Each box represents an index within the selected database. The size of each box illustrates the
total amount of space used in relation to the other indexes within that database. Right click any index in
the Database Space Usage Band to select the Jump to Indexes context menu option.

Storage Unit Scale
Use the Storage Unit scale to adjust the relative size of disk space in MB/GB and the corresponding graph that
displays in the Disk Space tab. Adjusting the scale to a different value changes the corresponding graph to
match that value.
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Display Disk Space data in the following increments:

MB

GB

TB

1

1

1

5

5

5

10

10

10

50

50

50

100

100

100

500

500

500

 Note: The default display for the Disk Space tab is 10GB.

Toolbar
Once the Disk Space tab is in History mode the Disk/Database Grid View button becomes available in the
toolbar. Selecting File Grid View removes the groupings, and can be helpful when you're interested in
viewing and sorting data across the entire disk subsystem.

Toolbar Button

Description

Disk Grid View

Toggles between File Grid
view and Disk Grid view. 
Note: When auto-refresh is
paused these viewing options
are available

Image
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Toolbar Button

Description

File Grid View

Toggles between Disk Grid
view and File Grid view. 
Note: When auto-refresh is
paused these viewing options
are available

Show Empty Disks

Controls whether disks
without any SQL Server
database files are displayed.

Image

Additional Options
Select any row to set focus to the associated database and log file.

Right-click to copy the cell/row/all options available.

Select the + command of any data file to show table and index information. For more information about
those metrics, see the Indexes topic.
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Exporting and Reporting Options
Exporting Data—The Disk Space grid view is exported through the File menu (File > Export Data).

Quick Report—Run a Quick Report to access database level size metrics in report format from the right-click
context menu of any file. Run a Quick Report in Real Time mode for the last seven days of data.

Disk/File Space Reports—The Disk/File Space reports provide disk and database file level metrics. Access
them through the Reports menu (Reports > Performance Analysis > Disk/File Space).
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Disk Space Metrics
Name

Description

The virtual machine that the file's associated with.
Virtual Machine

 Note: This column appears for targets that are also Hyper-V Hosts, and the
column is populated for files directly associated with virtual machines on the Host
(e.g., .vhdx files, mounted .iso files).

SQL Server

The file that's associated with the SQL Server.

Database

The file that's associated with the database.

File

The name of the file.

The filegroup of the associated file.
Filegroup

Additional Information: For more information about files and filegroups within
the SQL Server, see the Files and Filegroups Architecture article.

Type

Specifies the type of the file being either data or transaction log.

Size (MB)

The size in (MB) of the selected file.
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Name

Description

The amount of the disk space that's allocated for the file and is in use.
Used (MB)

Additional Information: For more information about page types and data files,
see the Understanding Pages and Extents topic.

Used %

The percentage of disk space that's allocated for the file and is in use.

Indicates the auto-growth properties of the selected file. If the setting is defined
as a percentage, that percentage displays along with the estimated size in
megabytes of the next file growth. If file growth is defined as an absolute value,
that size (MB) displays.

Auto-growth

 Warning:
A pink highlight indicates that the auto-growth amount is greater than
the remaining free space.
A yellow highlight indicates that auto-growth is set as a percent.
A tan highlight indicates that auto-growth is less than 10 MB or greater
than one GB.

Max File Size
(MB)

The maximum file size allowed for this data or log file.
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Name

Description

The total number of virtual log files (VLFs) that compose the transaction log. Each
physical transaction log is made up of a several smaller VLFs. When the
transaction log grows, by a manual action, or because of an auto-growth, the
number of virtual log files that compose the transaction log increase.
The actual number of corresponding VLFs that are added during any log growth is
dependent upon the size of the growth. See the following table:

Auto-growth size

VLFs created

< 64 MB

Four

>= 64 MB and < One GB

Eight

>= One GB

16

Total VLFs

If the transaction log grows frequently in small increments, you may see many
VLFs. A log file containing many VLFs decreases database performance.
Additional Information: For more information about transaction log
architecture, see the Transaction Log Physical Architecture topic.

 Warning:
A tan highlight indicates that Total VLFs are greater than 100.
A pink highlight indicates that Total VLFs are greater than 300.

Active VLFs

The number of virtual log files (VLFs) containing log records that are still needed.
There are several criteria for defining when a log record is needed. For more
information, see the TechNet topic. A log record that's still needed is defined as
an active log record, and any VLF containing at least one active log record is an
active VLF.

Min VLF Size
(MB)

The size (MB) of the smallest existing VLF.

Max VLF Size
(MB)

The size (MB) of the largest existing VLF.
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Name

Description

Avg VLF Size
(MB)

The average size (MB) of those VLFs that compose the log.

The number of VLFs that's created during the next auto-growth event. When the
transaction log grows, by either a manual action, or because of an auto-growth,
the number of virtual log files that compose the transaction log also increases.
This number is dependent upon the size of the growth. See the following table:

Auto-growth
VLF count

Auto-growth
VLF Size (MB)

Auto-growth size

VLFs created

< 64 MB

Four

>= 64 MB and < one GB

Eight

>= one GB

16

The size (MB) of each VLF that's created during the next auto-growth event, given
the current auto-growth settings.

The last recorded backup time for the associated file.

Last Backup
Time

 Warning: A pink highlight indicates that there are no recent transaction
log backups.

Last Backup
Type

The last recorded backup type for the associated file.

Log Reuse Wait

This indicates what the transaction log is waiting on, in regards to re-using
its space.

File Path

The full file path of the data or log file.
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Disk Forecasting
See the Forecasting article for a complete guide to the storage forecasting feature.

TempDB Example
The Disk Space analysis feature can also be used to monitor the number of files and size of TempDB. The
example below shows TempDB and TempDB Log on their own respective drives and how they appear on the
Disk Space tab.

Example of disk space analysis for tempdb and templog drives and files
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Performance Analysis Top SQL
Last Modified on 05 May 2021

Applies to: SQL Server, SSAS, and Azure SQL Database target types.

SQL Sentry Portal: This feature is available in SQL Sentry Portal. To learn more about configuring your
environment to use the on-premises, browser-based option with your existing SQL Sentry database, see
the SQL Sentry Portal article.
 See the SQL Sentry Portal Top SQL article for an example of the Top SQL feature in a browser.

Introduction

Top SQL tab

The Top SQL tab lists all T-SQL batches, stored procedures (RPCs), and statement events collected for the
current date range that exceeded the Minimum Duration specified in the Settings pane. The default filter is
Duration, but filtering using CPU and IO is also available. The default minimum duration is five seconds, but
this can be adjusted up or down as needed through the Top SQL Source settings.
To collect Top SQL metrics for Azure SQL database targets the Allow SQL Sentry Monitoring Objects in
Target setting under the Azure SQL Database Connection settings must be set to True. This option creates
a few objects within a SQL Sentry schema on the target database. See the Watched Target Objects article for
details.
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Top Section Grid View
The Top section Grid View displays queries in your environment. View Running Queries, Completed Queries,
Procedure Stats, or Query Stats by selecting the corresponding tab.

Open Plan Explorer for the expanded query by selecting Open.

Statement Grid
The Statements Grid displays the statements that were collected with the associated completed query,
procedure stats or query stats. It provides details on the key performance metrics that are associated with
each component part of the larger query. This allows you to see which resources were consumed by which
part of the batch.

Execution Plan Diagram
The Plan Diagram displays a graphical plan preview of the desired query in your environment.
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Select Open with Plan Explorer to view the query diagram in more detail. Hover over a plan diagram icon to display a
tooltip with more detailed information.

Select Open with Plan Explorer to open the integrated Plan Explorer view for the selected execution plan.
For more information about Plan Explorer, see the Plan Explorer topic.

Query History
Query History displays a graphical representation of the selected query over a specified range of time. Query
History provides information about the query execution plans, if and when they were changed, and how they
impacted different resources. Each dot represents when the query was executed. Different colors on the dots
indicate the different plans, and the plans are numbered. Adjust the time displayed on the graph with the
Range slider.

 Note: Hovering over any of the dots on the Query History graph provides you with additional
information.

 Note: Right click any dot on the Query History graph, and select Open Plan from the context menu
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to open the Plan Explorer diagram.

Open Plan

Additionally, adjust the graph to identify historical procedure and statement executions through CPU, IO, or
Duration metrics.

Query History Graph visualization options
Grouping

Metric

Mode

Hour

Duration

Statement

Day

CPU

Procedure

Week

IO

Display Tabs
Filter
The Filter tab provides the following filters for controlling which records display:
SQL Servers
Applications
Databases
Hosts

Select any combination of items to set the filters. To select more than one item, use Shift-Click or CTRLClick. View the filtered results by selecting Refresh or F5.
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Show Top Control- Controls how many rows are retrieved.

 Note: The Filter tab isn't displayed on an Azure SQL Database target.

Running Queries
The Running Queries tab shows all running queries matching the current filters and is independent of the
time range setting. The View button in the Plan column opens a Plan Explorer session for the associated
query. The Text Data column shows the original text the client sent to the server and the Active Statement
column shows the currently running statement.

Running Queries

 Note: Running queries isn't supported for SQL Server 2000 or Azure SQL Database.
 Note: The text data for the active statement is displayed in the Text Data pane when the
Active Statement cell is selected.

Completed Queries
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The Completed Queries tab lists all records matching the current filters. The View button in the Plan column
opens a Plan Explorer session for the associated query. The default filter displays all records. There are two
modes for this pane: Default and Totals.
Default mode lists all events for the active date range in a standard list format, sorted descending by End
Time by default. Default mode is activated whenever auto-refresh is enabled by selecting Play on the
toolbar, which shows the events for the last 10 minutes with new events coming in automatically at the top of
the list.
Totals mode is enabled by selecting Show Totals (the sigma Σ button). This groups all like events together
using a normalized version of the T-SQL with all variable parameters replaced, and it shows aggregates for
each group. This enables you to quickly determine which events are responsible for the most CPU or IO
activity for the active date range.

Completed Queries
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 Note: SQL Sentry 8.2 introduces enhanced SQL text data normalization. If upgrading from a build
prior to 8.2, enhanced normalization must be activated in the Monitoring Service Settings >
Performance Monitor tab.

Procedure Stats

The Procedure Stats tab provides aggregate information for all procedures matching the current filters. The
View Plan button in the Plan column opens a Plan Explorer session for the associated procedure. Additional
historical information may be available in the Runtime Stats. Open Runtime Stats by right clicking on a
procedure and selecting Jump To > Runtime Stats.

Procedure Stats
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 Note: SQL Sentry installations upgraded from a version older than 8.2 need to enable the Collect
Query Stats option in the Top SQL Source setting.
 Note: Procedure Stats isn't available for SQL Server 2000 or SQL Server 2005.

Query Stats

The Query Stats tab provides aggregate information for queries matching the current filter. This area also
provides insight into queries that run very quickly and in high volume.

Query Stats
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 Note: SQL Sentry installations upgraded from a version older than 8.2 need to enable the Collect
Query Stats option in the Top SQL Source setting.
 Note: Query Stats isn't available for SQL Server 2000 or SQL Server 2005.

Command Text
The Command Text tab shows the T-SQL text data for the currently highlighted Top SQL record with syntax
highlighting.

Command Text

Top SQL Runtime Stats
The Top SQL Runtime Stats option provides insight into the frequency and duration of the queries and
procedures that are captured by Top SQL.

Additional Information: See the Top SQL Runtime Stats article.

Top SQL Metrics
Default Metrics
Name

Description

Plan

Select Open to open a new Plan Explorer session for the captured
query plan.

Host

Name of the target where the associated captured query originated.
The event class of the associated captured query.

Event Class

Additional Information: For more information, see the SQL Server
Event Class Reference MSDN article.

1065

Name

Description

Text Data

Associated text data captured for the query.

Login

The Windows or SQL Server account associated with the captured
query.

Duration

The amount of time taken by the captured query.

CPU

The amount of CPU time (in milliseconds) used by the captured query.

CPU %

The percentage of CPU time used by the captured query, in relation to
any other Top SQL events that are shown in the grid.

Reads

The number of logical reads from the cache performed by the server
on behalf of the captured query.

Reads %

The percentage of bytes read by the captured query, in relation to any
other events that are shown in the Top SQL Grid view.

Writes

The number of physical disk writes performed by the server on behalf
of the captured query.

Writes %

The percentage of bytes written by the captured query, in relation to
any other events that are shown in the Top SQL Grid view.

Start Time

Time the captured query started.

End Time

Time the captured query ended.

Information

Additional data captured about the query.

Error

Error number of a given captured query.

SPID

The server process ID (SPID) that is assigned to the process.

Host Process ID

The ID assigned by the host computer to the process where the client
application is running.

Server

The SQL Server instance where the associated captured query took
place.

Additional Metrics
The following metrics do not appear by default, but can be added through the column chooser. See the Data
Grids article for additional information on choosing columns.
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Name

Description

Application

Name of the client application that created the connection.

Database

Name of the database for the associated captured query.

Granted Memory (KB)

The amount of memory in KB granted to the captured query.

Granted Query Memory
(KB)

The amount of memory in KB granted to the query.

Has Plan

True if the associated query has a captured plan.

Has Statements

True if the associated query has captured statements.

Ideal Memory (KB)
Is incomplete

True if the associated query is incomplete.

Parent ID

The ID assigned to the Parent query.

Requested Memory (KB)

The amount of memory in KB requested by the captured query.

Session Memory (KB)

The amount of memory in KB used during the session.

Tempdb Internal (KB)

The amount of memory in KB used by tempdb internal objects.

Tempdb Internal (KB)
Dealloc

The amount of memory in KB that is deallocated for tempdb internal
objects.

Tempdb User (KB)

The amount of memory in KB that is used by User objects.

Tempdb User (KB) Dealloc

The amount of memory in KB that is deallocated for User objects.

Visible

Specifies the default visibility for the select row. Queries may be
hidden in Top SQL.

Changing What's Collected for Top SQL
Change the Top SQL that's collected by SQL Sentry through the Top SQL Source settings. Change the Top
SQL events collected by SQL Sentry through the Top SQL Source settings at these levels: All Targets
(Global), site, target group, target, and instance.
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Collection Settings

 Note: As a reminder, all settings have a hierarchical configuration, and work through the principle of
inheritance. Any changes you make at one level is automatically inherited by all objects below it. For
more information about inheritance within SQL Sentry, see the Alerting and Response System topic.

Example One
To configure the Top SQL Minimum Duration Collection setting globally complete the following steps:
1. Select the All Targets node in the Navigator pane (View > Navigator).
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2. In the Settings pane (View > Settings), select SQL Server from the top drop-down list.

3. Select Top SQL Source from the second drop down list to open the Top SQL Source settings that are
being applied globally.

4. Change the Minimum Duration to the desired value; it saves automatically.

1069

Example Two
To configure the Top SQL Minimum Duration Collection setting for an individual instance complete the
following steps:
1. Select the desired instance node in the Navigator pane (View > Navigator).

2. In the Settings pane (View > Settings), select SQL Server from the top drop-down list.
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3. Select Top SQL Source from the bottom drop-down list to open the Top SQL Source settings that are
configured for the instance.

4. Within the Collection Settings section change the Inherit From Parent setting to False.

5. Change the Minimum Duration to the desired value; it saves automatically.
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There are a few additional things you should know regarding the Top SQL Source settings.
There is an AND relationship that exists between the Minimum Duration, Minimum CPU, Minimum Reads,
and the Minimum Writes Collection Settings, meaning that to be collected as Top SQL, the event needs to
satisfy each individual Collection Setting. For example, if you set the Minimum Duration at 10 seconds and
the Minimum Reads at 25, an event needs to meet both a Minimum Duration of 10 seconds AND a Minimum
Reads of 25 to be captured in Top SQL.
Minimum Duration can't be set below 100ms unless Minimum CPU, Minimum Reads, or Minimum Writes is
greater than zero. This lower limit is enforced because setting this threshold below 100ms for an extended
period of time dramatically increases the volume of data collected and stored by SQL Sentry, and has a
negative impact on the monitored server.

 Note: SQL Sentry's QuickTrace functionality is better suited to analyze extremely short duration
events.

Adjusting Captured TextData Length
By default textdata for captured Top SQL and Top Command events is truncated at 10,000 characters.
Change this maximum length in Global Settings (Navigator pane > Configuration > Global Settings >
Advanced tab > Query Collection Maximum Text Length).
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 Note: You may adjust the Query Collection Maximum Text Length setting up to 50,000 characters.
The default setting of 10,000 characters is adequate for most SQL Server environments.

Hiding Queries and Stopping Alerts
 Note: Hiding a query in Top SQL also hides it from the calendar view.

Hide individual queries or groups of queries with the right-click context menu Hide command.
To hide a single query, select the desired row, then right-click and select Hide.

To hide a group of queries, drag a column header to the top of the Grid View to group like items. Select
the group header in the Grid View and use the right-click context menu Hide command.
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 Important: Once a query is hidden in Top SQL, you're no longer alerted about it for any of the Top
SQL related conditions. Unhide all hidden queries by selecting Show Hidden on the toolbar. To unhide an
individual query permanently, select the Visible checkbox from the Column Chooser that toggles the
effect of Hide/Hide Group.
It's important to note that this will impact everyone using this particular SQL Sentry environment, not
just your individual SQL Sentry client view.

Top SQL Source Settings
There are three settings that can be adjusted to change how long a query runs to be collected. These settings
are in the Top SQL Source area in the Settings pane.

Setting

Description

Query Stats Sample Interval

Specifies how often to sample
query stats.

Filter Time Span

Specifies the base length of
time over which the collection
filters are applied to Query
Stats.

Minimum Duration

Specifies the minimum
duration for a statement to be
logged.

Image

1074

Setting

Description

Filter Factor

The Filter Factor is calculated
by dividing the Query Stats
Sample Interval by the Filter
Time Span. The collection
filters such as Minimum
Duration are multiplied by
this value when applied to
Query Stats collection.

Image

 Note: Each of these settings play a part in what's captured for Query Stats in your environment. As
an example, using the following default settings:
Query Stats Sample Interval = 60 seconds
Filter Time Span = 30 seconds
Minimum Duration = five seconds
The total cumulative duration of all executions of a query over the 60 second sample interval must be
greater than 10 seconds.

Controls
Top Pane
Control

Description

Image
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Control

Filter
button

Description

Image

Add a filter to any column by selecting the filter
button. After changing any of the filters, it's
necessary to select Refresh, or press F5 to apply
the filter.
Select on a combination of items in any of the
lists to set the filters. The default filter
displays all records.
To select more than one item in a list, use
Shift-Click or CTRL-Click.

Toolbar Options
Control

Description

Image

Show
Hidden
Rows

Hide individual lines or groups of rows. This toggles

Show
Totals

Groups like queries together by normalizing the
result set.

the display of those lines.

Context Menu Options
Option

Description

Sort Ascending

Organizes the
selected column in
Ascending order.

Sort Descending

Organizes the
selected column in
Descending order.

Context Menu
Image

Option Applied
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Option

Clear Sorting

Description

Context Menu
Image

Option Applied

Clears the sorting
options applied to
the column.

Group By This Column

Groups the queries
by the selected
column.

Show Group By Box/
Hide Group By Box

Displays or Hides the
Group by box.

Hide This Column

Hides the selected
column.

Column Chooser

Opens the Column
Chooser. The
Column Chooser
provides additional
columns to sort
information.

Best Fit

Resizes the
information for the
selected column.
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Option

Description

Best Fit All Columns

Resizes the
information for all of
the columns.

Context Menu
Image

Option Applied

Opens the Filter
Editor.
Use the Filter Editor
to add and remove
filters, and apply
Filter Editor

Boolean logic for a
more complex filter.
To adjust the
Boolean logic, simply
select the red And to
bring up the context
window.

Show Find Panel

Displays the Find
Panel. Use the Find
Panel to search for
specific strings in the
queries.

Show Auto Filter Row

Displays the Auto
Filter Row. Use the
Auto Filter Row to

Reset Grid

Resets the data on
the grid to the
default setting.
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 Important: Hide/Hide Group disables any alerts for the events, and prevents them from being
displayed on the Event Calendar.

Jump to
Jump To context
menu option

Description

Jump to Dashboard

When Show Totals
mode is enabled all
events belonging to
the selected group
are overlaid on the
Dashboard. When
the Default mode is
enabled only the
selected event is
overlaid on the
Dashboard.

Jump to Calendar

Goes to the selected
event on the Event
Calendar (requires
the server to be
watched with EM).

Jump to Runtime
Stats

Opens a tab showing
the Runtime Stats for
the event.

Top SQL Jump To
option

Corresponding data

Additional Options
Option

Kill Process

Trace Procedure

Description

Image

Kills the running process (Running
Queries tab).

Opens the Run QuickTrace dialog
box for the selected event (Query
Stats tab).
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Option

Description

Image

Database Mapper Environment Map
The SolarWinds Database Mapper Environment Map shows data collected from the SQL Sentry database to
map connections between applications, users, clients and targets (sourced from Top SQL and Windows
processes). This information complements the lineage analysis feature by showing the dynamic usage of
targets in the lineage diagram and shedding light on the processes that are using the database.

Additional Information: To learn more about using Top SQL data with SolarWinds Database Mapper,
see the Environment Map article.
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Performance Analysis Processes
Last Modified on 11 November 2021

Applies to: Windows, SQL Server, and SSAS targets when the target has Windows (meaning targets on
Linux, AWS RDS, and Azure Managed Instance, for example, will not have this tab). It's only available for
SQL Server when using the advanced security mode (i.e. Full Access).

Overview

Default Processes Collected
The Processes tab is available as part of Performance Analysis for Windows.
By default, Performance Analysis for Windows collects information about well-known or categorized
processes. There are several of these predefined, well-known process groups, including groups for:
SQL Server
IIS
SSAS
SSIS
SSRS

Collecting Additional Processes
To collect information about processes that aren't in these default groups, you have a couple of different
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options to do so:
Add your own well-known groups, and then specify the processes that belong to them.
Configure an Uncategorized Process Filter, that allows for the collection of uncategorized processes.
You may choose to use both of these options. For example, you may wish to define several new well-known
process groups that are relevant to the monitored computer's workload, so that information about those
processes is always collected. You may also wish to define an Uncategorized Process Filter, so that
information about processes that are consuming a large amount of resources on the computer are collected.

Processes Tab Display
The Processes tab contains a grid view of all the processes for which you are collecting information.
Processes are intelligently grouped by program and function, including groups for SSRS, SSIS, and SQL Server
(well-known process groups). Metrics are displayed for each process, giving you insight into the resource
usage for both the individual processes and their associated groups.

Display Options
Show in groups — Groups well-known processes by their assigned group or category.

Showing/Hiding Groups — Hides certain groups from view using the group drop-down list box. Uncheck
any group that you want to hide.
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Show well-known processes only — Hides any processes that aren't part of a well-known group.

Additional Columns — Access Additional Columns by right-clicking on any column header and selecting
the Column Chooser option.

Sorting Columns — Sort the grid view by specific columns by selecting any column header. Additional
sorting options are available from the context menu of any column header.

Adding New Groups of Well-Known Processes
By default, there are several well-known processes that are logically grouped by program/function, including
predefined groups for SQL Server, IIS, SSAS, SSIS, and SSRS. Add additional groups of your own by using the
following SQL Sentry database tables:
Performance Analysis Device Process Group
Performance Analysis Device Process Group Mapping

Performance Analysis Device Process Group
Use this table to define groups and your well-known processes.

Column Name

Description
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Column Name

Description

ID

Identity column

ProcessGroupName

This is the group name that displays in the Processes tab.

ProcessGroupNameFull

The full name isn't displayed in the Processes tab.

ProcessGroupDescription

The description of the process group.

Performance Analysis Device Process Group Mapping
Use this table to map specific processes to the groups you defined in the Performance Analysis Device
Process Group table.

Column Name

Description

ID

Identity column

PerformanceAnalysis
DeviceProcessGroupID

The ID of the group you would like this process to map to. Should map to
the ID column of a group found in the Performance Analysis Device
Process Group table.

ProcessName

Enter the exact name under which the process is executed, including the
executable extension. For example: services.exe

Enter the name of the service exactly as it's displayed on the General
properties tab of the service as shown from the services applet.
ServiceName

To find the actual service name, open the services applet and right-click
the service, and then choose Properties. Use the exact value found in the
Service name field.

ShowOnPADashboard

Specifies if the group displays on the Performance Analysis Dashboard.

CommandLineMatchRegex

This column is useful when differentiating processes that use the same
executable, but perform different functions based upon the passed in
parameters. The regex should use a valid .NET compatible regular
expression as defined here.
 Note: The match operation is case-insensitive.
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Group Mapping Example
As an example, if the target you are monitoring is a Microsoft Exchange server, you may want to create a new
group of well-known processes that includes those related services. In this example we create a new group of
well-known processes for Microsoft Exchange, and then we add the following Microsoft Exchange related
services to the group:
Microsoft Exchange Information Store
Microsoft Exchange Mailbox Assistants
Microsoft Exchange Transport
Create the Group
INSERT INTO dbo.PerformanceAnalysisDeviceProcessGroup (ProcessGroupName,ProcessGroupNameFull)
VALUES ('Microsoft Exchange','Microsoft Exchange Server 2010')

Add the processes and map them to the group
INSERT INTO dbo.PerformanceAnalysisDeviceProcessGroupMapping
(PerformanceAnalysisDeviceProcessGroupID,ProcessName,ServiceName,ShowOnPADashboard)
VALUES
(9,'Store.exe','MSExchangeIS',1), (9,'MSExchangeMailboxAssistants.exe','MSExchangeMailboxAssistants',1), (9,'MSExc
hangeTransport.exe','MSExchangeTransport',1)

 Important: Be sure that the PerformanceAnalysisDeviceProcessGroupID corresponds to the ID
column of your desired group in the Performance Analysis Device Process Group table.

Process Collection Settings
Process collection is controlled with the Windows Instance Settings and can be accessed by completing the
following steps:
1. Select the desired Windows instance in the Navigator pane.
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2. Open the Settings pane (View menu > Settings).

3. In the Settings pane choose the Windows instance from the drop-down menu.
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You should now see the Process Collection settings in the Settings pane. By default, when a Windows
instance is monitored, process information is collected about all well-known processes. Disable the collection
of process information by changing the Collect Processes setting to False.
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You may enable the collection of additional processes (non well-known processes) by configuring an
Uncategorized Process Filter.

Configuring an Uncategorized Process Filter
By default, Performance Analysis for Windows collects information about well-known or categorized
processes. Configure SQL Sentry to collect information about Uncategorized processes by specifying an
Uncategorized Process Filter. This filter may be built around various metrics, including percentage CPU time
or Read and Write bytes per second.

 Important: This filter exists by default for process collection. Changing the filter to allow for more
collection may add significant overhead to your network and the SQL Sentry database. Consider using
baselines to measure how your changes impact your environment.

Follow the directions in the previous section to access the Process Collection settings for your Windows
instance.
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1. Select the Uncategorized Process Filter row and use the ellipsis (...) to open the Filter Editor.

2. Add rules to the filter as desired.

Add rules to the default filter (shown here)

 Note: The Filter Editor was designed with flexibility in mind, and allows you to specify any number
of criteria around events. You can define a complex rule with multiple groups and logical operators.
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For more information about using the Filter Editor, see the Filter Editor topic.

SolarWinds Database Mapper Environment Map
The SolarWinds Database Mapper Environment Map shows data collected from the SQL Sentry database to
map connections between applications, users, clients and targets (sourced from Top SQL and Windows
processes). This information complements the lineage analysis feature by showing the dynamic usage of
targets in the lineage diagram and shedding light on the processes that are using the database.
To learn more about using Windows processes data with Database Mapper, see the Environment Map article.
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VMware Overview for SQL Sentry
Last Modified on 06 January 2022

 Note: Monitoring VMware host targets is now part of SQL Sentry. See the SQL Sentry product page
for more details about subscription pricing.

SQL Sentry provides a unique view of resource utilization, allowing you to analyze network, CPU, memory, and
storage performance for VMware hosts and their virtual machines. The Dashboard displays a breakdown of
how each server resource is being used and determines whether a CPU is over-committed.
When you're experiencing performance issues, use the performance Dashboard to view real-time
performance metrics, or switch to History mode to access your performance data.

Monitoring VMware Targets
 Note: SQL Sentry requires vCenter 5.5, vCenter 6, vCenter 6.5, and vCenter 6.7 to monitor VMware
machines. vCenter 6.5 is only supported by SQL Sentry in v11.2 or higher. vCenter 6.7 is only supported
by SQL Sentry in v19.0. See the System Requirements article for full requirements.

 Important: If using SSPI authentication, be sure to select a site where the monitoring service has at
least read-only access to the vCenter.
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To monitor a VMware host, monitor the associated vCenter. Right-click VMware in the Navigator pane, and
then select Add vCenter in the context menu.

Add the appropriate parameters for monitoring the vCenter, and select OK to perform a connection test.
Once the test passes, the vCenter is registered and starts collecting configuration and performance data.

 Note: If you select the Use Windows Session authentication option, your account and the SQL
Sentry monitoring service account need to have at least read-only access to the vCenter server. If you
don't already have access, the VMware administrator at your company can grant you access.

Name

Description

Display Name

Alias for the vCenter in the SQL Sentry client.

Address

The vCenter name or IP address.

Account Credentials

Credentials used for pulling data from the
vCenter. Select Use Windows session
authentication to use the SQL Sentry account.
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Name

Description

Site

Specifies which monitoring service(s) are used
for data collection.

Add any associated VMware hosts by right-clicking the appropriate site where you want the VMware host to
be monitored, select Add, and then select VMware Host. Provide the server name for the VMware host >
Connect. For more information about VMware hosts, see the Virtualization Node topic.

Virtualization Support
The left side of the VMware dashboard displays the resource utilization of the host, and the right side of the
dashboard allows you to see which guests are making use of the host resources. The right side also provides
you with the ability to identify who is using too many resources.
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The Disk Activity and Disk Space tabs show the activity and size of the VMware files. For more information
about these tabs, see the Disk Activity and Disk Space topics.

Jump To
You can right-click on a spike in the VMware dashboard, and then select Jump To. This opens the guest
dashboard for that period, allowing you to identify what might be causing the spike. You can also jump from a
virtualized guest to the host where you can see if other guests on that host might be causing resource
restrictions.

Sample Mode
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Sample Mode allows you to see more detail on that point in time where the problem occurs. You can see if the
problem was isolated to a single CPU in the CPU graph, and you can see more detail on how memory is being
used.
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VMware Performance Metrics
Last Modified on 06 May 2021

Overview
This article covers the various VMware performance metrics displayed by the Performance Analysis
Dashboard and Performance Analysis Overview, and how to interpret different metric values and
combinations of values across different VMware metrics for SQL Sentry.

 Note: For Mode: S = Sample and H = History.

VMware Host Metrics
Section

Metric

Description
The percent of network bandwidth across the VMHost used
for downloads.

Network

IN

Mode:

S, H

Type:

Percent

The percent of network bandwidth across the VMHost used
for uploads.

Network

OUT

Mode:

S, H

Type:

Percent

The total amount of CPU used across the VM as a percent.

CPU Usage

Total CPU

Mode:

S

Type:

Percent
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Section

Metric

Description
Co-Stop time measures when a virtual machine is ready to
run, but unable to run due to co-scheduling constraints. See
blog on VMware Advisory Conditions in SQL Sentry for more
information.

CPU Usage

Co-stop %

Mode:

H

Type:

Percent

Percentage of time when a vCPU is ready to do work, but
must wait for the hypervisor to schedule that work on one
or more physical CPUs. CPU ready time is a summation, and
is dependent on the number of virtual machines on the host
and their CPU loads. See the blog on VMware Advisory
Conditions in SQL Sentry for more information.
CPU Usage

Ready Time %
Mode:

H

Type:

Percent

Amount of memory that is actively used, as estimated by
VMkernel based on recently touched memory pages.

System Memory

Active

Mode:

S, H

Type:

MB

Amount of machine memory used on the host. Consumed
memory includes memory used by the service console, the
VMkernel, vSphere services, and the total consumed
metrics for all running virtual machines.
System Memory

Consumed

Mode:

S, H

Type:

MB
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Section

Metric

Description
Total of all overhead metrics (including VM overhead and
VMKernel overhead) for powered-on virtual machines, and
the overhead of running vSphere services on the host.

System Memory

Overhead

Mode:

S, H

Type:

MB

Amount of machine memory or physical memory that's
mapped for the host.

System Memory

Granted

Mode:

S, H

Type:

MB

Amount of machine memory or physical memory that's
available for the host.

System Memory

Available

Mode:

S, H

Type:

MB

The percentage of memory read in by the VMkernel swap
file from memory to disk across all the virtual machines on
the VMHost.
System Memory

Swap In

Mode:

S, H

Type:

Percent
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Section

Metric

Description
The percentage of memory written by the VMKernel swap
file from memory across all the virtual machines on the
VMHost.

System Memory

Swap Out

Mode:

S, H

Type:

Percent

The amount of time it takes in milliseconds for the VMHost
to read data from each Logical Unit Number (LUN) on the
datastore.
Disk IO

ms/ Read by
Datastore

Mode:

S, H

Type:

ms

The amount of time it takes in milliseconds for the VMHost
to write data from each Logical Unit Number (LUN) on the
datastore.
Disk IO

ms/ Write by
Datastore

Mode:

S, H

Type:

ms

The amount of data in megabytes read by the VMHost from
each Logical Unit Number (LUN) on the datastore per
second.
Disk IO

MB/sec Read by
Datastore

Mode:

S, H

Type:

MB
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Section

Metric

Description
The amount of data in megabytes written to the VMHost
from each Logical Unit Number (LUN) on the datastore per
second.

Disk IO

MB/sec Write
by Datastore

Mode:

S, H

Type:

MB

VMware Guest Metrics
Section

Metric

Description
The amount of network bandwidth in megabytes per
second used for downloads by the VM Guest(s).

Network (VM)

IN per Guest

Mode:

S, H

Type:

MB per second

The amount of network bandwidth in megabytes per
second used for uploads by the VM Guest(s).

Network (VM)

OUT per Guest

Mode:

S, H

Type:

MB per second

The percentage of CPU used by the VM per guest.

CPU Usage (VM)

Utilization Per
Guest

Mode:

S, H

Type:

Percentage
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Section

Metric

Description
The amount of system memory in megabytes actively used
by each VM Guest.

System Memory
(VM)

Utilization per
Guest

Mode:

S, H

Type:

MB

The average amount of time it takes in milliseconds for the
VM to read data from the virtual disk.

Disk IO (VM)

ms/Read per
VM

Mode:

S, H

Type:

ms

The average amount of time it takes in milliseconds for the
VM to write data to the virtual disk.

Disk IO (VM)

ms/Write per
VM

Mode:

S, H

Type:

ms

The average amount of data used for reads by each VM in
megabytes per second.

Disk IO (VM)

MB/sec Read
per VM

Mode:

S, H

Type:

MB per second

The average amount of data used for writes by each VM in
megabytes per second.

Disk IO (VM)

MB/sec Write
per VM

Mode:

S

Type:

MB per second
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Performance Analysis Disk Activity
Last Modified on 06 May 2021

Applies to: SQL Server, SSAS*, VMware*, and Windows* targets.

Introduction

 Note: *The Disk Activity and Disk Space tabs are focused on database files. For Windows it applies to
VMware and Hyper-V hosts for vDisks and VHDX files, respectively. The tabs will only display for SSAS,
VMware, and Windows when the applicable files are available for monitoring.

Additional Information: If the Disk Activity tab or the Disk Space tab does not display, there could be
an issue with WMI on the system you're monitoring. For more information about troubleshooting WMI on
your system, see the WMI Troubleshooting MSDN article.

Disk bottlenecks represent one of the most common sources of performance problems for Windows and SQL
Server. The Disk Activity tab provides a patented graphical disk analysis system that breaks down disk
activity and latency at the controller, physical disk, and file level, highlighting bottlenecks at any point in a
disk system.

Target

Example View
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Target

Example View

SQL Server

VMware

Windows

The top pane of the display shows a graphical representation of the entire disk system as Windows sees it.
The middle pane displays activity metrics in either a hierarchical disk system format or database/virtual hard
disk/ virtual machine disk list format. The bottom pane displays graphs showing read and write latency, IOPS
and throughput for the disk or file chosen in the top pane, or middle pane.

Target

Example View

SQL Server
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Target

Example View

VMware

Windows

Disk Activity Modes
The Disk Activity tab has two modes, Real Time and History. The active mode is controlled with the autorefresh toolbar button.
Select the auto-refresh Play button  to enter the Real Time mode.
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The System box represents the underlying storage in your monitored environment. The Controller box(es)
display the controller in your environment. A controller works as an interface between the motherboard and
other components, and makes sense of the signals going to, and coming from the CPU.
SQL Server
The top pipe represents Read activity between
the System and Controller.
The bottom pipe represents Write activity
between the System and Controller.

VMware
The top pipe represents Read activity between
the System and the Datastore.
The bottom pipe represents Write activity
between the System and the Datastore.

Windows
The top pipe represents Read activity between
the System and the Controller.
The bottom pipe represents Write activity
between the System and the Controller.
Data for the last collected sample is shown, and moving segmented lines indicates the I/O direction (read or
write) and latency for each disk, file, and controller or datastore.
The top pipe represents Read activity.
The bottom pipe represents Write activity.
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The thickness and color of the displayed segmented line indicates the amount of latency being experienced.
As latency increases, the lines grow in width and changes through green, olive, orange, and red to give a quick
visual indication of the decreased performance.
Selecting any file displays a tooltip that shows the numerical values for the reads and writes hitting a file. The
amount of overall latency being experienced by the disk is distinguished from the amount of latency for
individual files. The overall disk latency is represented with the horizontal pipe connecting all the individual
files, while the small vertical pipes represent latency at the file level.

 Note: A disk appearing red indicates a suspect offset setting. This may affect IO performance.

The following table lists the color of the segmented line and the corresponding range of latency values. All
latency values are listed in milliseconds (ms).

Color Range
Color Range

Read Latency

Write Latency
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Color Range

Read Latency

Write Latency

Green

< 10 ms

< 10 ms

Greenish-Yellow to Orangish-Yellow

10-20 ms

10-20 ms

Orange to Reddish-Orange

21-30 ms

21-40 ms

Red

> 30 ms

> 40 ms

Read and Write Latency Color Gradients

Select the auto-refresh Pause button to enter History mode. Aggregate disk metrics are displayed for the
selected date range, and the solid lines indicate latency. History mode enables you to see how your disk
system performs over any period.

 Note: In history mode the pipes display as solid lines representing latency at the selected time frame.
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Disk Activity Real-time mode

Disk Activity History mode

Toolbar
The following toolbar options are available when auto-refresh is paused:

View

Description

Disk Grid View

Toggles between showing the
File Grid view and the Disk
Grid view.  Note: When
auto-refresh is paused, these
viewing options are available.

File Grid View

Toggles between showing the
Disk Grid view and the File
Grid view.  Note: When
auto-refresh is paused, these
viewing options are available.

Show Empty Disks

Controls whether disks
without any SQL Server
database files are displayed.

Order By Activity

Sorts physical disks by activity
in descending order.

Sum

Displays the total IO
information in your
environment.  Note: When
auto-refresh is paused, these
viewing options are available.

Image
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View

Description

Average

Displays the Average IO
information in your
environment.  Note: When
auto-refresh is paused, these
viewing options are available.

Image

Context Menus
Left-click—Sets the focus to any file. Other files for the same database are highlighted along with the
corresponding grid row.

 Note: This is applicable to SQL Server, VMware, and Windows targets.

 Note: Hover over any graphical icon to display more detailed IO information.

SQL Server

VMware

Windows

Right-click—Run a Quick Trace or a Quick Report.
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 Note: Quick Trace is only available for SQL Server targets.

 Note: The following context menu options are available for VMware and Windows targets.

Jump to VM Disk Activity — Opens the Disk Activity tab for the selected SQL Server.
Stop watching— Stops the monitoring of a selected file.

Watch— Begins monitoring a selected file.
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Exporting and Reporting Options
Exporting Data—Export the Disk Activity grid through the File menu (File > Export Data).

Quick Report—Run a Quick Report from the right-click context menu of any file to access database level I/O
metrics in a report format. Run a Quick Report while in Real Time mode for the last 10 minutes of data.
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Disk Activity Metrics
The following table lists descriptions of the metrics displayed on the Disk Activity screen. For more
information about interpreting latency values, see the Disk I/O: Read latency by physical disk article.

 Note: The sample collection frequency for disk counters is 20 seconds. While in Real Time mode, the
Disk Activity screen updates according to this sample interval. A custom sample interval is specified.
This may be useful if you're monitoring a server with many database files per database, because this can
lead to increased SQL Sentry database growth and transaction log activity.

Name

Description

The virtual machine that the file is associated with.
Virtual
Machine

 Note: This column appears for targets that are also Hyper-V Hosts, and the column
populates for files directly associated with virtual machines on the host (e.g., .vhdx files,
mounted .iso files).
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Name

Description

Real Time
The average number of byte reads per second over the last polling interval.
Read Bytes

History
Average Mode—The average number of byte reads per second over the selected range.
Sum Mode—The total number of byte reads for the selected range.

Real Time
The percentage of byte reads from this file in relation to other files belonging to the
target over the last sample polling interval.
% Read
Bytes

History
Average Mode—The average percentage of byte reads from this file in relation to
other files belonging to the target over the selected historical range.
Sum Mode—n/a

Real Time
The number of read operations per second over the last sample polling interval.
Reads

History
Average Mode—The average number of read operations per second over the selected
range.
Sum Mode—The total number read operations occurring in the selected range.
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Name

Description

Real Time
Milliseconds per read. The average time in milliseconds each physical disk read took
over the last sample polling interval.
ms/Read

History
Average Mode—The average time in milliseconds each physical disk read took over the
selected time range.
Sum Mode—n/a

Real Time
The average number of bytes written per second over the last polling sample interval.
Write
Bytes

History
Average Mode—The average number of bytes written per second over the selected
range.
Sum Mode—The total number of bytes written for the selected range.

Real Time
The percentage of bytes written to this file in relation to other files belonging to the
target over the last sample polling interval.
% Write
Bytes

History
Average Mode—The average percentage of bytes written to this file in relation to
other files belonging to the target over the selected historical range.
Sum Mode—n/a
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Name

Description

Real Time
The number of write operations per second over the last sample polling interval.
Writes

History
Average Mode—The average number of write operations per second over the selected
range.
Sum Mode—The total number write operations occurring in the selected range.

Real Time
Milliseconds per write. The average time in milliseconds each physical write took over
the last sample polling interval.
ms/Write

History
Average Mode—The average time in milliseconds each physical disk write took over
the selected time range.
Sum Mode—n/a

The Other designation is assigned to files that aren't part of the SQL Server installation.

Real Time
The average number of byte reads per second over the selected range, involving files
Other Read
Bytes

that aren't part of the SQL Server installation.

History
Average Mode—The average number of byte reads per second over the selected range.
Sum Mode—The total number of byte reads for the selected range.
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Name

Description

The Other designation is assigned to files that aren't part of the SQL Server installation.

Real Time
The average number of byte writes per second over the selected range, involving files
Other
Write
Bytes

that aren't part of the SQL Server installation.

History
Average Mode—The average number of byte writes per second over the selected
range.
Sum Mode—The total number of byte writes for the selected range.

Total VLFs

See the Total VLFs topic.

TempDB Example
The Disk Activity analysis feature can also be used to monitor the activity for TempDB. The example below
shows TempDB and TempDB Log on their own respective drives and how they appear on the Disk Activity
tab.
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Example of disk activity analysis for tempdb and templog.

Troubleshooting
Mount Points
If mounted drives are not showing up under Disk Activity or Disk Space, it is likely related to the required
ports or DCOM permissions. See the following support KB articles for more information:
Port Requirements for Mount Point Support
Setting DCOM Permissions for Mount Point Support
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Performance Analysis Disk Space
Last Modified on 06 May 2021

Applies to: SQL Server, SSAS*, VMware*, and Windows* targets.

Introduction

 Note: *The Disk Activity and Disk Space tabs are focused on database files. For Windows targets it
applies to VMware and Hyper-V hosts for vDisks and VHDX files, respectively. The tabs will only display
for SSAS, VMware, and Windows targets when the applicable files are available for monitoring.

Additional Information: If the Disk Activity tab or the Disk Space tab does not display, there could be
an issue with WMI on the system you're monitoring. For more information about troubleshooting WMI on
your system, see the WMI Troubleshooting MSDN article.

The Disk Space tab contains information about disk space utilization within your environment, broken down
by database and file. Use the Disk Space tab to identify disk capacity issues, understand where various
database files reside on the disk system, and to determine whether available disk space is optimally used.
The Disk Space tab has two distinct areas. The top pane is a graphical representation of the database layout
at the disk level. Data files are represented with a unique solid color, and each associated log file is
represented with the same color with a line overlay. The solid grey areas represent the empty space per disk.
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The colors are repeated for each file in the Grid View found in the bottom pane. Selecting a file in either pane
highlights the associated representation in the other pane.

Using Disk Space
Disk Space Modes
The Disk Space tab has two modes, Real Time and History. The active mode is controlled by the AutoRefresh toolbar button. Select the auto-refresh Play button to enter the Real Time mode. Data for the last
collected sample is shown.

Select the auto-refresh Pause button to enter the History mode. History mode displays the average disk
space information over the specified time range. Change the time range you're viewing by using the Start and
End times and selecting Go in the toolbar.

Database Space Usage Band
When index collection is enabled, index information is viewable by drilling into the database level in the
Grid View. When a database is selected in the grid, a band displaying the space usage of that database's
indexes appears between the disk layout and the grid. Select a database in the Grid View to open it's
corresponding Database Space Usage Band.
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 Note: Each box represents an index within the selected database. The size of each box illustrates the
total amount of space used in relation to the other indexes within that database. Right click any index in
the Database Space Usage Band to select the Jump to Indexes context menu option.

Storage Unit Scale
Use the Storage Unit scale to adjust the relative size of disk space in MB/GB and the corresponding graph that
displays in the Disk Space tab. Adjusting the scale to a different value changes the corresponding graph to
match that value.
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Display Disk Space data in the following increments:

MB

GB

TB

1

1

1

5

5

5

10

10

10

50

50

50

100

100

100

500

500

500

 Note: The default display for the Disk Space tab is 10GB.

Toolbar
Once the Disk Space tab is in History mode the Disk/Database Grid View button becomes available in the
toolbar. Selecting File Grid View removes the groupings, and can be helpful when you're interested in
viewing and sorting data across the entire disk subsystem.

Toolbar Button

Description

Disk Grid View

Toggles between File Grid
view and Disk Grid view. 
Note: When auto-refresh is
paused these viewing options
are available

Image
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Toolbar Button

Description

File Grid View

Toggles between Disk Grid
view and File Grid view. 
Note: When auto-refresh is
paused these viewing options
are available

Show Empty Disks

Controls whether disks
without any SQL Server
database files are displayed.

Image

Additional Options
Select any row to set focus to the associated database and log file.

Right-click to copy the cell/row/all options available.

Select the + command of any data file to show table and index information. For more information about
those metrics, see the Indexes topic.
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Exporting and Reporting Options
Exporting Data—The Disk Space grid view is exported through the File menu (File > Export Data).

Quick Report—Run a Quick Report to access database level size metrics in report format from the right-click
context menu of any file. Run a Quick Report in Real Time mode for the last seven days of data.

Disk/File Space Reports—The Disk/File Space reports provide disk and database file level metrics. Access
them through the Reports menu (Reports > Performance Analysis > Disk/File Space).
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Disk Space Metrics
Name

Description

The virtual machine that the file's associated with.
Virtual Machine

 Note: This column appears for targets that are also Hyper-V Hosts, and the
column is populated for files directly associated with virtual machines on the Host
(e.g., .vhdx files, mounted .iso files).

SQL Server

The file that's associated with the SQL Server.

Database

The file that's associated with the database.

File

The name of the file.

The filegroup of the associated file.
Filegroup

Additional Information: For more information about files and filegroups within
the SQL Server, see the Files and Filegroups Architecture article.

Type

Specifies the type of the file being either data or transaction log.

Size (MB)

The size in (MB) of the selected file.
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Name

Description

The amount of the disk space that's allocated for the file and is in use.
Used (MB)

Additional Information: For more information about page types and data files,
see the Understanding Pages and Extents topic.

Used %

The percentage of disk space that's allocated for the file and is in use.

Indicates the auto-growth properties of the selected file. If the setting is defined
as a percentage, that percentage displays along with the estimated size in
megabytes of the next file growth. If file growth is defined as an absolute value,
that size (MB) displays.

Auto-growth

 Warning:
A pink highlight indicates that the auto-growth amount is greater than
the remaining free space.
A yellow highlight indicates that auto-growth is set as a percent.
A tan highlight indicates that auto-growth is less than 10 MB or greater
than one GB.

Max File Size
(MB)

The maximum file size allowed for this data or log file.
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Name

Description

The total number of virtual log files (VLFs) that compose the transaction log. Each
physical transaction log is made up of a several smaller VLFs. When the
transaction log grows, by a manual action, or because of an auto-growth, the
number of virtual log files that compose the transaction log increase.
The actual number of corresponding VLFs that are added during any log growth is
dependent upon the size of the growth. See the following table:

Auto-growth size

VLFs created

< 64 MB

Four

>= 64 MB and < One GB

Eight

>= One GB

16

Total VLFs

If the transaction log grows frequently in small increments, you may see many
VLFs. A log file containing many VLFs decreases database performance.
Additional Information: For more information about transaction log
architecture, see the Transaction Log Physical Architecture topic.

 Warning:
A tan highlight indicates that Total VLFs are greater than 100.
A pink highlight indicates that Total VLFs are greater than 300.

Active VLFs

The number of virtual log files (VLFs) containing log records that are still needed.
There are several criteria for defining when a log record is needed. For more
information, see the TechNet topic. A log record that's still needed is defined as
an active log record, and any VLF containing at least one active log record is an
active VLF.

Min VLF Size
(MB)

The size (MB) of the smallest existing VLF.

Max VLF Size
(MB)

The size (MB) of the largest existing VLF.
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Name

Description

Avg VLF Size
(MB)

The average size (MB) of those VLFs that compose the log.

The number of VLFs that's created during the next auto-growth event. When the
transaction log grows, by either a manual action, or because of an auto-growth,
the number of virtual log files that compose the transaction log also increases.
This number is dependent upon the size of the growth. See the following table:

Auto-growth
VLF count

Auto-growth
VLF Size (MB)

Auto-growth size

VLFs created

< 64 MB

Four

>= 64 MB and < one GB

Eight

>= one GB

16

The size (MB) of each VLF that's created during the next auto-growth event, given
the current auto-growth settings.

The last recorded backup time for the associated file.

Last Backup
Time

 Warning: A pink highlight indicates that there are no recent transaction
log backups.

Last Backup
Type

The last recorded backup type for the associated file.

Log Reuse Wait

This indicates what the transaction log is waiting on, in regards to re-using
its space.

File Path

The full file path of the data or log file.
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Disk Forecasting
See the Forecasting article for a complete guide to the storage forecasting feature.

TempDB Example
The Disk Space analysis feature can also be used to monitor the number of files and size of TempDB. The
example below shows TempDB and TempDB Log on their own respective drives and how they appear on the
Disk Space tab.

Example of disk space analysis for tempdb and templog drives and files
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Windows & Hyper-V Overview
Last Modified on 09 November 2021

 Note: Monitoring Windows and Hyper-V host targets is now part of SQL Sentry. See the SQL Sentry
product page for more details about subscription pricing.

SQL Sentry supports monitoring Windows targets even if the target doesn't have an active SQL Server
installation. This gives you the ability to independently monitor any Windows target, such as a web server. In
this case, SQL Sentry delivers a complete historical record of which processes are consuming which resources.
If you're familiar with SQL Sentry, you'll recognize the Windows charts on the dashboard. Several
enhancements have been made to the dashboard with Windows-only monitoring in mind. The System
Memory and CPU Usage charts contain visual representations for several different well-known process
groups, including groups for SSRS, SSIS, and IIS. If you have a specialized group of applications, SQL Sentry
gives you the ability to define your own well-known process groups.

 Note: SQL Sentry provides additional details for Hyper-V hosts. The images below highlight some
differences such as the (VM) charts on the right side of the dashboard. See the Hyper-V Host Metrics
section of the Performance Metrics article for more information.
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Windows Server

Hyper-V Host

The Processes tab contains a grid view of all the processes that you're collecting information about, including
related metrics. By default, processes are shown in their well-known process groups, giving you a complete
picture of how application groups are consuming resources within your environment. Processes are also autocorrelated with related services.

Windows Server

Hyper-V Host

Adding a Windows Target
To monitor a Windows computer with SQL Sentry, add a Windows target using Add > Target in the right-click
context menu of the following Navigator pane nodes:
All Targets
Site
Group
You can also add a target through the File menu.
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From the Add Target dialog box, select Windows Computer from the Target Type drop-down menu, enter
the desired target, and then select Connect.

SQL Sentry also provides you with the following additional features:

Features

Descriptions

Browser-based
Access

You can get customizable cloud access to
your performance data. Server Health
Status allows you to view the health of your
entire environment. For more information,
see the Server Health Status topic.

Screenshots
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Features

Descriptions

Enhanced Global
Baselines

You can view application performance over
multiple servers from a common baseline to
identify when systems deviate from normal
behavior. For more information, see the
Baselining topic.

History and Alert
Filtering

Use the configurable process and
history filters to control which events are
collected, displayed on the calendar, and
available for alerting.

Job Chaining

Define dependencies and workflows
involving Windows tasks with advanced
chaining features. For more information, see
the Event Chains topic.

Performance
Reporting

Allows you to generate pre-formatted
reports from a global level down to
individual counters that enable an effective
root cause analysis. For more information,
see the Reporting topic.

Screenshots
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Features

Descriptions

Alerting Conditions

Allows you to discover potential problems
before users do using built-in alerting
conditions. For more information, see the
Conditions and Advisory Conditions Pack
topics.

Screenshots

 Important: Monitor the individual Windows machines that are part of a Windows Cluster. SQL Sentry
isn't cluster aware.
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Windows & Hyper-V Performance Metrics
Last Modified on 06 May 2021

Overview
This article covers the various Windows performance metrics displayed by the Performance Analysis
Dashboard and Performance Analysis Overview, and how to interpret different metric values and
combinations of values across different Windows metrics for SQL Sentry.

 Note: For Mode: S = Sample and H = History.

Windows Metrics
Section

Metric

Description
The total combined percentage utilization for all adapters
on the server.

Network

Total network
utilization

Mode:

S, H

Type:

Percent

 May correlate:

CPU Usage: Kernel time

The percentage utilization for each instance is overlaid on
top of the total percentage utilization, enabling you to see
how much of the network traffic is related to SQL Server,
SSAS, or other processes on the server.

Network

Utilization by
SQL
Server/SSAS
instance

If SQL Server-related network activity is high, use Quick
Trace to determine which processes may be responsible.
Mode:

S, H

Type:

Percent
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Section

Metric

Description
Select the adapters radio group item to view activity for up
to four network adapters on the server. This enables you to
spot adapter-specific saturation issues.

Network

Utilization by
network
adapter

Mode:

S

Type:

Mb/sec

 May correlate:

CPU Usage: Kernel time

The length of the network output packet queue, in packets.
This is the total value across all adapters on the machine. A
sustained value of > three may indicate a network
bottleneck.

Network

Network output
queue length

Mode:

S

Type:

Last value

 Warning range:

> three

 Critical range:

>three for more than
approx. 20 sec

The total processor time percentage across all processors
on the server. A sustained value greater than 80 percent
generally indicates a CPU bottleneck.
CPU
Usage

Total processor
time

Mode:

S

Type:

Percent
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Section

Metric

Description
The user time percentage for each individual CPU.
Represented by the color green. If user time for individual
CPUs are at or near 100 percent for a sustained period, SQL
Server or other applications may not be parallelizing
effectively.

CPU
Usage

CPU
Usage

User time by
CPU

Kernel time by
CPU

Mode:

S, H

Type:

Percent

 Warning range:

> 85 percent

 Critical range:

> 95 percent

The kernel (or privileged) time percentage for each
individual CPU. Represented by the color red. Kernel time
should typically be < 40 percent total, and < 25 percent of
user time. If kernel time for individual CPUs are high for a
sustained period, a driver may be responsible. For example,
a network driver may cause high kernel time, and it may be
isolated to specific CPUs, in which case it may correlate with
network activity.
Mode:

S

Type:

Percent

 May correlate:

Network activity
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Section

Metric

Description
CPU time related to SQL Server and SSAS processes is
overlaid on top of the total CPU series. There is only one
SSAS chart series and it represents all SSAS instances on the
server combined.
Use Top SQL and QuickTrace to determine which queries
are utilizing the most CPU resources.

CPU
Usage

Mode:

S, H

Type:

Percent
SQL Server:
Compiles
Recompiles
Batches
Transactions
Key lookups

Processor time
by SQL Server
/SSAS process

 May correlate:

CPU wait time
Queries:
Parallelism
Hash joins
Sort operations
Index rebuilds &
defrag
Consistency checks
SSAS:
Formula Engine time
Cells calculated
Recomputes
Flat cache lookups
Aggregation rows
created
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Section

Metric

Description

For the Hyper-V Hypervisor Logical Processor , the
average percentage of time guest code is running on a
logical processor.

CPU
Usage

Percent Guest
Runtime*

Additional Information: See Also: Performance
Management: Monitoring CPU Resources
Mode:

S, H

Type:

Percent

The percentage time the guest virtual machine spent
waiting for a host kernel resource.

CPU
Usage

vCPU Wait
Time*

Additional Information: See Also: Hyper-V Equivalent to
VMware CPU Ready Time
Mode:

S, H

Type:

Percent

The combined rate at which all processors on the computer
are switched from one thread to another. Consistently high
values can mean that the server is spending too much time
switching threads instead of actively running threads.

CPU
Usage

Context
switches

Mode:

S

Type:

Avg/sec

 Warning range:

>5,000
times # of processors

 Critical range:

>7,500
times # of processors

 May correlate:

CPU Usage: Kernel time
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Section

Metric

Description
The number of threads in the processor queue. If this value
goes over two per processor, and CPU usage for SQL Server
is high, it can be indicative of high compiles/recompiles, or a
high rate of key lookups, which can often be addressed by
covering indexes. Use Quick Trace to troubleshoot.

CPU
Usage

System
Memory

Processor
queue length

Memory by SQL
Server
/SSAS instance

Mode:

S

Type:

Last value

 Critical range:

> two times the # of
processors

The amount of physical memory used by each SQL Server
and SSAS instance. Important for determining whether
available memory is being used effectively, and whether
there's memory contention between multiple instances on
the same server.
Mode:

S, H

Type:

MB

The amount of physical memory used by all processes on
the server other than SQL Server or SSAS. If a SQL Server or
SSAS instance isn't being watched by SQL Sentry, the
memory it uses is included here.
System
Memory

Other processes
memory

Mode:

S, H

Type:

MB
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Section

Metric

Description
The amount of physical memory currently allocated to the
system file cache.

System
Memory

File Cache
memory

SSAS —SSAS database files may be loaded into and served
from the file cache, even if the associated file data doesn't
exist in the SSAS internal caches. Monitoring the file cache
is important to ensure that physical memory is being used
effectively, and that memory contention doesn't occur
between the SSAS process, the file cache, and other
processes on the server.
SQL Server —This isn't an important metric to monitor for
dedicated SQL Servers.
Mode:

S, H

Type:

MB

Memory ballooning allows a physical host to recapture
unused memory on a virtual machine, and use it elsewhere.
The portion of memory being ballooned is determined in
different ways depending on the hypervisor.

Additional Information:

System
Memory

Ballooned
memory**

(Hyper-V) See Also: Running SAP Applications on the
Microsoft Platform
(VMware) See Also: Memory (Balloon)
Mode:

S, H

Type:

MB
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Section

Metric

Description
The amount of physical memory not in use by any
processes. If this value is consistently very low, it can be a
strong indicator of memory pressure. When available
memory gets too low, Windows signals applications like SQL
Server of the low memory condition, and this can cause SQL
Server to page its own data to disk. It's generally a good
idea to have a few hundred MB available, to avoid this
signaling, and so Windows can make use of it as needed.

System
Memory

Available
memory

Mode:

S, H

Type:

MB

 Critical range:

<100MB
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Section

Metric

Description
Pages read from disk into memory by Windows. This metric
includes both page file and file reads, but not SQL Server
file reads. Hard faults can be caused by various activities,
including:
Copying files, locally or across the network
Anti-virus or other security-related scans
File indexing activity by Windows or other apps
including SQL Server full text indexing
SQL Server backups written to the local disk system.
If high hard faults correlate with high network activity, it
may be related to copying files across the network, such as
with Windows backup software. If the backup software has
a local agent or service, use the Process Activity Viewer to
monitor page faults/sec (sort descending) to confirm. If
there's no local agent, it can be more difficult to determine
the source of the activity; however, the best place to start is
typically the Sessions list under Windows Target
Management.

System
Memory

Read faults

SQL Server —Windows hard faults are not caused by SQL
Server itself because it manages its own memory and
memory/disk access. Heavy Windows paging can impact
SQL Server performance by contending with normal SQL
Server disk activity. The only scenario where SQL Server
may contribute to hard faults is when its process memory
(working set) is being paged to disk by the operating
system. This can happen with severe memory pressure
when SQL server doesn't respond quickly enough by
releasing its own memory. This can have a dramatic impact
on performance, especially on 64-bit systems where a
restart of SQL Server may be required to recover.
SSAS —Windows paging will often strongly correlate with
SSAS file IO activity. Because SSAS databases consist of
many files on the disk system and SSAS doesn't manage its
own memory/disk access as does SQL server, reads from
and writes to the SSAS files will show up as hard page
faults.
Mode:

S, H

Type:

Avg pages/
sec

 May correlate:

Network activity
SSAS:File IO activity
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Section

Metric

Description
Pages written from memory to disk by Windows. If you see
high write faults in combination with an increase in page
file usage, it may mean that the SQL Server or SSAS process
is being paged to disk. For SQL Server, this can be
confirmed by querying the sys.dm_os_ring_buffers DMV for
RESOURCE_MEMPHYSICAL_LOW events with
MemoryUsage < 100.

System
Memory

Write faults

See Page file usage and Read faults for more details.
Mode:

S, H

Type:

Avg pages/
sec

The percentage of page (or swap) file currently in use.
Windows uses the page file to store pages of memory used
by processes that are not contained in other files. If the file
is adequately sized and usage percentage is high, it's a
likely indicator of memory pressure.

System
Memory

Page file usage

SQL Server —If SQL Server doesn't respond quickly enough
to a low physical memory condition, memory for the SQL
Server process (working set) can be swapped to the page
file. This can have a dramatic impact on performance,
especially on 64-bit systems where a restart of SQL Server
may be required to recover. If AWE or the Lock pages in
memory option is in use, Windows can't send SQL Server
process memory to the page file. This option is
recommended on 64-bit systems.
SSAS -- SSAS doesn't acknowledge or respond to Windows
low memory conditions, so it's more likely that its process
memory can be sent to the page file when there is memory
pressure. SSAS performance can suffer when this happens.
Mode:

S

Type:

Percent
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Section

Metric

Description
The average time in milliseconds each physical disk read is
taking. Logical disks on the same physical disks are grouped
together, because they share the same set of disk spindles
and latency between them will always be the same.
Disk latency is the only disk measurement for which there
are generally accepted ranges that represent good and bad
performance from a SQL Server perspective. Disk queue
metrics, for example, are not accurate for many SAN
systems, and there are also no universally agreed upon
good and bad ranges for SQL Server. The following ranges
can be used as a general guideline to determine whether
disk latency is acceptable:

Disk IO

Read latency by
physical disk

Less than 10ms - Fast *
Between 10ms - 20ms - Acceptable
Between 20ms - 50ms - Slow
Greater than 50ms - Critical
* For transaction log writes, between 0ms and 2ms is
desirable.
 Note: The Disk Activity tab shows you the actual layout
of controllers, disks, and database files, and detailed
latency/volume metrics for each. Whereas the
Dashboard gives you at a glance and historical trending
information for latency, the Disk Activity tab should be used
for more in depth troubleshooting of high latency issues.

Mode:

S, H

Type:

Avg ms/
Read

The average time in milliseconds each physical disk write is
taking. See Disk IO: Read latency above for details.

Disk IO

Write latency by
physical disk

Mode:

S, H

Type:

Avg ms/
Write

Hyper-V Host Metrics
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Section

Metric

Description
The data transfer rate in Mb per second for each guest,
enabling you to see how much of the network traffic is
related to each individual guest machine.

Network (VM)

Utilization by
Virtual Machine
Guest

Mode:

S, H

Type:

Mbps

The usage time percentage for each individual guest
machine. Represented by the color selected for each
individual Virtual Machine guest (consistent over the
dashboard section).
CPU Usage (VM)

Usage time by
Guest

Mode:

S, H

Type:

Percent

The usage percentage time for the Hypervisor root virtual
processor.
Additional Information: See Also: BizTalk Server 2006 R2
Retired Technical documentation
CPU Usage (VM)

vCPU Root
usage time

Mode:

S, H

Type:

Percent

For the Hyper-V Hypervisor Logical Processor, the average
percentage of time guest code is running on an logical
processor.
Additional Information: See Also: Performance
Management: Monitoring CPU Resources
CPU Usage (VM)

Percent Guest
Runtime
Mode:

S, H

Type:

Percent
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Section

Metric

Description
The percentage time the guest virtual machine spent
waiting for a Host kernel resource.
Additional Information: See Also: Hyper-V Equivalent to
VMware CPU Ready Time

CPU Usage (VM)

vCPU Wait Time
Mode:

S, H

Type:

Percent

The amount of physical memory used by each guest on the
host machine.
System Memory
(VM)

Memory by
Virtual Machine
Guest

Mode:

S, H

Type:

MB

The number of read operations per second across all virtual
machines belonging to the host. In Sample mode read
operations are broken down by individual virtual machine.
Use the drop-down menu to select an individual guest
machine.
Disk IO (VM)

IOPS (Read)
Mode:

S, H

Type:

Reads/sec

The number of write operations per second across all virtual
machines belonging to the host. In Sample mode write
operations are broken down by individual virtual machine.
Use the drop-down menu to select an individual guest
machine.
Disk IO (VM)

IOPS (Write)
Mode:

S, H

Type:

Writes/sec
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Section

Metric

Description
The average MB per second read across all virtual machines
belonging to the host. Use the drop-down menu to select
an individual guest machine.

Disk IO (VM)

Read
Throughput

Mode:

S, H

Type:

MB/sec

The average MB per second written across all virtual
machines belonging to the host. Use the drop-down menu
to select an individual guest machine.

Disk IO (VM)

Write
Throughput

Mode:

S, H

Type:

MB/sec

* Metric will ONLY be visible for targets that are Hyper-V Hosts
** Metric will ONLY be visible for targets that are VM guests whose host is also watched
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Performance Analysis Processes
Last Modified on 11 November 2021

Applies to: Windows, SQL Server, and SSAS targets when the target has Windows (meaning targets on
Linux, AWS RDS, and Azure Managed Instance, for example, will not have this tab). It's only available for
SQL Server when using the advanced security mode (i.e. Full Access).

Overview

Default Processes Collected
The Processes tab is available as part of Performance Analysis for Windows.
By default, Performance Analysis for Windows collects information about well-known or categorized
processes. There are several of these predefined, well-known process groups, including groups for:
SQL Server
IIS
SSAS
SSIS
SSRS

Collecting Additional Processes
To collect information about processes that aren't in these default groups, you have a couple of different
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options to do so:
Add your own well-known groups, and then specify the processes that belong to them.
Configure an Uncategorized Process Filter, that allows for the collection of uncategorized processes.
You may choose to use both of these options. For example, you may wish to define several new well-known
process groups that are relevant to the monitored computer's workload, so that information about those
processes is always collected. You may also wish to define an Uncategorized Process Filter, so that
information about processes that are consuming a large amount of resources on the computer are collected.

Processes Tab Display
The Processes tab contains a grid view of all the processes for which you are collecting information.
Processes are intelligently grouped by program and function, including groups for SSRS, SSIS, and SQL Server
(well-known process groups). Metrics are displayed for each process, giving you insight into the resource
usage for both the individual processes and their associated groups.

Display Options
Show in groups — Groups well-known processes by their assigned group or category.

Showing/Hiding Groups — Hides certain groups from view using the group drop-down list box. Uncheck
any group that you want to hide.
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Show well-known processes only — Hides any processes that aren't part of a well-known group.

Additional Columns — Access Additional Columns by right-clicking on any column header and selecting
the Column Chooser option.

Sorting Columns — Sort the grid view by specific columns by selecting any column header. Additional
sorting options are available from the context menu of any column header.

Adding New Groups of Well-Known Processes
By default, there are several well-known processes that are logically grouped by program/function, including
predefined groups for SQL Server, IIS, SSAS, SSIS, and SSRS. Add additional groups of your own by using the
following SQL Sentry database tables:
Performance Analysis Device Process Group
Performance Analysis Device Process Group Mapping

Performance Analysis Device Process Group
Use this table to define groups and your well-known processes.

Column Name

Description
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Column Name

Description

ID

Identity column

ProcessGroupName

This is the group name that displays in the Processes tab.

ProcessGroupNameFull

The full name isn't displayed in the Processes tab.

ProcessGroupDescription

The description of the process group.

Performance Analysis Device Process Group Mapping
Use this table to map specific processes to the groups you defined in the Performance Analysis Device
Process Group table.

Column Name

Description

ID

Identity column

PerformanceAnalysis
DeviceProcessGroupID

The ID of the group you would like this process to map to. Should map to
the ID column of a group found in the Performance Analysis Device
Process Group table.

ProcessName

Enter the exact name under which the process is executed, including the
executable extension. For example: services.exe

Enter the name of the service exactly as it's displayed on the General
properties tab of the service as shown from the services applet.
ServiceName

To find the actual service name, open the services applet and right-click
the service, and then choose Properties. Use the exact value found in the
Service name field.

ShowOnPADashboard

Specifies if the group displays on the Performance Analysis Dashboard.

CommandLineMatchRegex

This column is useful when differentiating processes that use the same
executable, but perform different functions based upon the passed in
parameters. The regex should use a valid .NET compatible regular
expression as defined here.
 Note: The match operation is case-insensitive.
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Group Mapping Example
As an example, if the target you are monitoring is a Microsoft Exchange server, you may want to create a new
group of well-known processes that includes those related services. In this example we create a new group of
well-known processes for Microsoft Exchange, and then we add the following Microsoft Exchange related
services to the group:
Microsoft Exchange Information Store
Microsoft Exchange Mailbox Assistants
Microsoft Exchange Transport
Create the Group
INSERT INTO dbo.PerformanceAnalysisDeviceProcessGroup (ProcessGroupName,ProcessGroupNameFull)
VALUES ('Microsoft Exchange','Microsoft Exchange Server 2010')

Add the processes and map them to the group
INSERT INTO dbo.PerformanceAnalysisDeviceProcessGroupMapping
(PerformanceAnalysisDeviceProcessGroupID,ProcessName,ServiceName,ShowOnPADashboard)
VALUES
(9,'Store.exe','MSExchangeIS',1), (9,'MSExchangeMailboxAssistants.exe','MSExchangeMailboxAssistants',1), (9,'MSExc
hangeTransport.exe','MSExchangeTransport',1)

 Important: Be sure that the PerformanceAnalysisDeviceProcessGroupID corresponds to the ID
column of your desired group in the Performance Analysis Device Process Group table.

Process Collection Settings
Process collection is controlled with the Windows Instance Settings and can be accessed by completing the
following steps:
1. Select the desired Windows instance in the Navigator pane.
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2. Open the Settings pane (View menu > Settings).

3. In the Settings pane choose the Windows instance from the drop-down menu.
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You should now see the Process Collection settings in the Settings pane. By default, when a Windows
instance is monitored, process information is collected about all well-known processes. Disable the collection
of process information by changing the Collect Processes setting to False.
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You may enable the collection of additional processes (non well-known processes) by configuring an
Uncategorized Process Filter.

Configuring an Uncategorized Process Filter
By default, Performance Analysis for Windows collects information about well-known or categorized
processes. Configure SQL Sentry to collect information about Uncategorized processes by specifying an
Uncategorized Process Filter. This filter may be built around various metrics, including percentage CPU time
or Read and Write bytes per second.

 Important: This filter exists by default for process collection. Changing the filter to allow for more
collection may add significant overhead to your network and the SQL Sentry database. Consider using
baselines to measure how your changes impact your environment.

Follow the directions in the previous section to access the Process Collection settings for your Windows
instance.
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1. Select the Uncategorized Process Filter row and use the ellipsis (...) to open the Filter Editor.

2. Add rules to the filter as desired.

Add rules to the default filter (shown here)

 Note: The Filter Editor was designed with flexibility in mind, and allows you to specify any number
of criteria around events. You can define a complex rule with multiple groups and logical operators.
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For more information about using the Filter Editor, see the Filter Editor topic.

SolarWinds Database Mapper Environment Map
The SolarWinds Database Mapper Environment Map shows data collected from the SQL Sentry database to
map connections between applications, users, clients and targets (sourced from Top SQL and Windows
processes). This information complements the lineage analysis feature by showing the dynamic usage of
targets in the lineage diagram and shedding light on the processes that are using the database.
To learn more about using Windows processes data with Database Mapper, see the Environment Map article.
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Performance Analysis Disk Activity
Last Modified on 06 May 2021

Applies to: SQL Server, SSAS*, VMware*, and Windows* targets.

Introduction

 Note: *The Disk Activity and Disk Space tabs are focused on database files. For Windows it applies to
VMware and Hyper-V hosts for vDisks and VHDX files, respectively. The tabs will only display for SSAS,
VMware, and Windows when the applicable files are available for monitoring.

Additional Information: If the Disk Activity tab or the Disk Space tab does not display, there could be
an issue with WMI on the system you're monitoring. For more information about troubleshooting WMI on
your system, see the WMI Troubleshooting MSDN article.

Disk bottlenecks represent one of the most common sources of performance problems for Windows and SQL
Server. The Disk Activity tab provides a patented graphical disk analysis system that breaks down disk
activity and latency at the controller, physical disk, and file level, highlighting bottlenecks at any point in a
disk system.

Target

Example View
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Target

Example View

SQL Server

VMware

Windows

The top pane of the display shows a graphical representation of the entire disk system as Windows sees it.
The middle pane displays activity metrics in either a hierarchical disk system format or database/virtual hard
disk/ virtual machine disk list format. The bottom pane displays graphs showing read and write latency, IOPS
and throughput for the disk or file chosen in the top pane, or middle pane.

Target

Example View

SQL Server
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Target

Example View

VMware

Windows

Disk Activity Modes
The Disk Activity tab has two modes, Real Time and History. The active mode is controlled with the autorefresh toolbar button.
Select the auto-refresh Play button  to enter the Real Time mode.
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The System box represents the underlying storage in your monitored environment. The Controller box(es)
display the controller in your environment. A controller works as an interface between the motherboard and
other components, and makes sense of the signals going to, and coming from the CPU.
SQL Server
The top pipe represents Read activity between
the System and Controller.
The bottom pipe represents Write activity
between the System and Controller.

VMware
The top pipe represents Read activity between
the System and the Datastore.
The bottom pipe represents Write activity
between the System and the Datastore.

Windows
The top pipe represents Read activity between
the System and the Controller.
The bottom pipe represents Write activity
between the System and the Controller.
Data for the last collected sample is shown, and moving segmented lines indicates the I/O direction (read or
write) and latency for each disk, file, and controller or datastore.
The top pipe represents Read activity.
The bottom pipe represents Write activity.
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The thickness and color of the displayed segmented line indicates the amount of latency being experienced.
As latency increases, the lines grow in width and changes through green, olive, orange, and red to give a quick
visual indication of the decreased performance.
Selecting any file displays a tooltip that shows the numerical values for the reads and writes hitting a file. The
amount of overall latency being experienced by the disk is distinguished from the amount of latency for
individual files. The overall disk latency is represented with the horizontal pipe connecting all the individual
files, while the small vertical pipes represent latency at the file level.

 Note: A disk appearing red indicates a suspect offset setting. This may affect IO performance.

The following table lists the color of the segmented line and the corresponding range of latency values. All
latency values are listed in milliseconds (ms).

Color Range
Color Range

Read Latency

Write Latency
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Color Range

Read Latency

Write Latency

Green

< 10 ms

< 10 ms

Greenish-Yellow to Orangish-Yellow

10-20 ms

10-20 ms

Orange to Reddish-Orange

21-30 ms

21-40 ms

Red

> 30 ms

> 40 ms

Read and Write Latency Color Gradients

Select the auto-refresh Pause button to enter History mode. Aggregate disk metrics are displayed for the
selected date range, and the solid lines indicate latency. History mode enables you to see how your disk
system performs over any period.

 Note: In history mode the pipes display as solid lines representing latency at the selected time frame.
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Disk Activity Real-time mode

Disk Activity History mode

Toolbar
The following toolbar options are available when auto-refresh is paused:

View

Description

Disk Grid View

Toggles between showing the
File Grid view and the Disk
Grid view.  Note: When
auto-refresh is paused, these
viewing options are available.

File Grid View

Toggles between showing the
Disk Grid view and the File
Grid view.  Note: When
auto-refresh is paused, these
viewing options are available.

Show Empty Disks

Controls whether disks
without any SQL Server
database files are displayed.

Order By Activity

Sorts physical disks by activity
in descending order.

Sum

Displays the total IO
information in your
environment.  Note: When
auto-refresh is paused, these
viewing options are available.

Image
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View

Description

Average

Displays the Average IO
information in your
environment.  Note: When
auto-refresh is paused, these
viewing options are available.

Image

Context Menus
Left-click—Sets the focus to any file. Other files for the same database are highlighted along with the
corresponding grid row.

 Note: This is applicable to SQL Server, VMware, and Windows targets.

 Note: Hover over any graphical icon to display more detailed IO information.

SQL Server

VMware

Windows

Right-click—Run a Quick Trace or a Quick Report.
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 Note: Quick Trace is only available for SQL Server targets.

 Note: The following context menu options are available for VMware and Windows targets.

Jump to VM Disk Activity — Opens the Disk Activity tab for the selected SQL Server.
Stop watching— Stops the monitoring of a selected file.

Watch— Begins monitoring a selected file.
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Exporting and Reporting Options
Exporting Data—Export the Disk Activity grid through the File menu (File > Export Data).

Quick Report—Run a Quick Report from the right-click context menu of any file to access database level I/O
metrics in a report format. Run a Quick Report while in Real Time mode for the last 10 minutes of data.

1167

Disk Activity Metrics
The following table lists descriptions of the metrics displayed on the Disk Activity screen. For more
information about interpreting latency values, see the Disk I/O: Read latency by physical disk article.

 Note: The sample collection frequency for disk counters is 20 seconds. While in Real Time mode, the
Disk Activity screen updates according to this sample interval. A custom sample interval is specified.
This may be useful if you're monitoring a server with many database files per database, because this can
lead to increased SQL Sentry database growth and transaction log activity.

Name

Description

The virtual machine that the file is associated with.
Virtual
Machine

 Note: This column appears for targets that are also Hyper-V Hosts, and the column
populates for files directly associated with virtual machines on the host (e.g., .vhdx files,
mounted .iso files).
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Name

Description

Real Time
The average number of byte reads per second over the last polling interval.
Read Bytes

History
Average Mode—The average number of byte reads per second over the selected range.
Sum Mode—The total number of byte reads for the selected range.

Real Time
The percentage of byte reads from this file in relation to other files belonging to the
target over the last sample polling interval.
% Read
Bytes

History
Average Mode—The average percentage of byte reads from this file in relation to
other files belonging to the target over the selected historical range.
Sum Mode—n/a

Real Time
The number of read operations per second over the last sample polling interval.
Reads

History
Average Mode—The average number of read operations per second over the selected
range.
Sum Mode—The total number read operations occurring in the selected range.
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Name

Description

Real Time
Milliseconds per read. The average time in milliseconds each physical disk read took
over the last sample polling interval.
ms/Read

History
Average Mode—The average time in milliseconds each physical disk read took over the
selected time range.
Sum Mode—n/a

Real Time
The average number of bytes written per second over the last polling sample interval.
Write
Bytes

History
Average Mode—The average number of bytes written per second over the selected
range.
Sum Mode—The total number of bytes written for the selected range.

Real Time
The percentage of bytes written to this file in relation to other files belonging to the
target over the last sample polling interval.
% Write
Bytes

History
Average Mode—The average percentage of bytes written to this file in relation to
other files belonging to the target over the selected historical range.
Sum Mode—n/a
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Name

Description

Real Time
The number of write operations per second over the last sample polling interval.
Writes

History
Average Mode—The average number of write operations per second over the selected
range.
Sum Mode—The total number write operations occurring in the selected range.

Real Time
Milliseconds per write. The average time in milliseconds each physical write took over
the last sample polling interval.
ms/Write

History
Average Mode—The average time in milliseconds each physical disk write took over
the selected time range.
Sum Mode—n/a

The Other designation is assigned to files that aren't part of the SQL Server installation.

Real Time
The average number of byte reads per second over the selected range, involving files
Other Read
Bytes

that aren't part of the SQL Server installation.

History
Average Mode—The average number of byte reads per second over the selected range.
Sum Mode—The total number of byte reads for the selected range.
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Name

Description

The Other designation is assigned to files that aren't part of the SQL Server installation.

Real Time
The average number of byte writes per second over the selected range, involving files
Other
Write
Bytes

that aren't part of the SQL Server installation.

History
Average Mode—The average number of byte writes per second over the selected
range.
Sum Mode—The total number of byte writes for the selected range.

Total VLFs

See the Total VLFs topic.

TempDB Example
The Disk Activity analysis feature can also be used to monitor the activity for TempDB. The example below
shows TempDB and TempDB Log on their own respective drives and how they appear on the Disk Activity
tab.
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Example of disk activity analysis for tempdb and templog.

Troubleshooting
Mount Points
If mounted drives are not showing up under Disk Activity or Disk Space, it is likely related to the required
ports or DCOM permissions. See the following support KB articles for more information:
Port Requirements for Mount Point Support
Setting DCOM Permissions for Mount Point Support
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Performance Analysis Disk Space
Last Modified on 06 May 2021

Applies to: SQL Server, SSAS*, VMware*, and Windows* targets.

Introduction

 Note: *The Disk Activity and Disk Space tabs are focused on database files. For Windows targets it
applies to VMware and Hyper-V hosts for vDisks and VHDX files, respectively. The tabs will only display
for SSAS, VMware, and Windows targets when the applicable files are available for monitoring.

Additional Information: If the Disk Activity tab or the Disk Space tab does not display, there could be
an issue with WMI on the system you're monitoring. For more information about troubleshooting WMI on
your system, see the WMI Troubleshooting MSDN article.

The Disk Space tab contains information about disk space utilization within your environment, broken down
by database and file. Use the Disk Space tab to identify disk capacity issues, understand where various
database files reside on the disk system, and to determine whether available disk space is optimally used.
The Disk Space tab has two distinct areas. The top pane is a graphical representation of the database layout
at the disk level. Data files are represented with a unique solid color, and each associated log file is
represented with the same color with a line overlay. The solid grey areas represent the empty space per disk.
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The colors are repeated for each file in the Grid View found in the bottom pane. Selecting a file in either pane
highlights the associated representation in the other pane.

Using Disk Space
Disk Space Modes
The Disk Space tab has two modes, Real Time and History. The active mode is controlled by the AutoRefresh toolbar button. Select the auto-refresh Play button to enter the Real Time mode. Data for the last
collected sample is shown.

Select the auto-refresh Pause button to enter the History mode. History mode displays the average disk
space information over the specified time range. Change the time range you're viewing by using the Start and
End times and selecting Go in the toolbar.

Database Space Usage Band
When index collection is enabled, index information is viewable by drilling into the database level in the
Grid View. When a database is selected in the grid, a band displaying the space usage of that database's
indexes appears between the disk layout and the grid. Select a database in the Grid View to open it's
corresponding Database Space Usage Band.
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 Note: Each box represents an index within the selected database. The size of each box illustrates the
total amount of space used in relation to the other indexes within that database. Right click any index in
the Database Space Usage Band to select the Jump to Indexes context menu option.

Storage Unit Scale
Use the Storage Unit scale to adjust the relative size of disk space in MB/GB and the corresponding graph that
displays in the Disk Space tab. Adjusting the scale to a different value changes the corresponding graph to
match that value.
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Display Disk Space data in the following increments:

MB

GB

TB

1

1

1

5

5

5

10

10

10

50

50

50

100

100

100

500

500

500

 Note: The default display for the Disk Space tab is 10GB.

Toolbar
Once the Disk Space tab is in History mode the Disk/Database Grid View button becomes available in the
toolbar. Selecting File Grid View removes the groupings, and can be helpful when you're interested in
viewing and sorting data across the entire disk subsystem.

Toolbar Button

Description

Disk Grid View

Toggles between File Grid
view and Disk Grid view. 
Note: When auto-refresh is
paused these viewing options
are available

Image
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Toolbar Button

Description

File Grid View

Toggles between Disk Grid
view and File Grid view. 
Note: When auto-refresh is
paused these viewing options
are available

Show Empty Disks

Controls whether disks
without any SQL Server
database files are displayed.

Image

Additional Options
Select any row to set focus to the associated database and log file.

Right-click to copy the cell/row/all options available.

Select the + command of any data file to show table and index information. For more information about
those metrics, see the Indexes topic.
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Exporting and Reporting Options
Exporting Data—The Disk Space grid view is exported through the File menu (File > Export Data).

Quick Report—Run a Quick Report to access database level size metrics in report format from the right-click
context menu of any file. Run a Quick Report in Real Time mode for the last seven days of data.

Disk/File Space Reports—The Disk/File Space reports provide disk and database file level metrics. Access
them through the Reports menu (Reports > Performance Analysis > Disk/File Space).
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Disk Space Metrics
Name

Description

The virtual machine that the file's associated with.
Virtual Machine

 Note: This column appears for targets that are also Hyper-V Hosts, and the
column is populated for files directly associated with virtual machines on the Host
(e.g., .vhdx files, mounted .iso files).

SQL Server

The file that's associated with the SQL Server.

Database

The file that's associated with the database.

File

The name of the file.

The filegroup of the associated file.
Filegroup

Additional Information: For more information about files and filegroups within
the SQL Server, see the Files and Filegroups Architecture article.

Type

Specifies the type of the file being either data or transaction log.

Size (MB)

The size in (MB) of the selected file.
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Name

Description

The amount of the disk space that's allocated for the file and is in use.
Used (MB)

Additional Information: For more information about page types and data files,
see the Understanding Pages and Extents topic.

Used %

The percentage of disk space that's allocated for the file and is in use.

Indicates the auto-growth properties of the selected file. If the setting is defined
as a percentage, that percentage displays along with the estimated size in
megabytes of the next file growth. If file growth is defined as an absolute value,
that size (MB) displays.

Auto-growth

 Warning:
A pink highlight indicates that the auto-growth amount is greater than
the remaining free space.
A yellow highlight indicates that auto-growth is set as a percent.
A tan highlight indicates that auto-growth is less than 10 MB or greater
than one GB.

Max File Size
(MB)

The maximum file size allowed for this data or log file.
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Name

Description

The total number of virtual log files (VLFs) that compose the transaction log. Each
physical transaction log is made up of a several smaller VLFs. When the
transaction log grows, by a manual action, or because of an auto-growth, the
number of virtual log files that compose the transaction log increase.
The actual number of corresponding VLFs that are added during any log growth is
dependent upon the size of the growth. See the following table:

Auto-growth size

VLFs created

< 64 MB

Four

>= 64 MB and < One GB

Eight

>= One GB

16

Total VLFs

If the transaction log grows frequently in small increments, you may see many
VLFs. A log file containing many VLFs decreases database performance.
Additional Information: For more information about transaction log
architecture, see the Transaction Log Physical Architecture topic.

 Warning:
A tan highlight indicates that Total VLFs are greater than 100.
A pink highlight indicates that Total VLFs are greater than 300.

Active VLFs

The number of virtual log files (VLFs) containing log records that are still needed.
There are several criteria for defining when a log record is needed. For more
information, see the TechNet topic. A log record that's still needed is defined as
an active log record, and any VLF containing at least one active log record is an
active VLF.

Min VLF Size
(MB)

The size (MB) of the smallest existing VLF.

Max VLF Size
(MB)

The size (MB) of the largest existing VLF.
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Name

Description

Avg VLF Size
(MB)

The average size (MB) of those VLFs that compose the log.

The number of VLFs that's created during the next auto-growth event. When the
transaction log grows, by either a manual action, or because of an auto-growth,
the number of virtual log files that compose the transaction log also increases.
This number is dependent upon the size of the growth. See the following table:

Auto-growth
VLF count

Auto-growth
VLF Size (MB)

Auto-growth size

VLFs created

< 64 MB

Four

>= 64 MB and < one GB

Eight

>= one GB

16

The size (MB) of each VLF that's created during the next auto-growth event, given
the current auto-growth settings.

The last recorded backup time for the associated file.

Last Backup
Time

 Warning: A pink highlight indicates that there are no recent transaction
log backups.

Last Backup
Type

The last recorded backup type for the associated file.

Log Reuse Wait

This indicates what the transaction log is waiting on, in regards to re-using
its space.

File Path

The full file path of the data or log file.
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Disk Forecasting
See the Forecasting article for a complete guide to the storage forecasting feature.

TempDB Example
The Disk Space analysis feature can also be used to monitor the number of files and size of TempDB. The
example below shows TempDB and TempDB Log on their own respective drives and how they appear on the
Disk Space tab.

Example of disk space analysis for tempdb and templog drives and files
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Azure SQL Database Overview
Last Modified on 09 November 2021

Introduction

 Note: Monitoring Azure SQL Database targets is now part of SQL Sentry. See the SQL Sentry product
page for more details about subscription pricing.

SQL Sentry helps you optimize performance by providing metrics you can use to better forecast resource
allocation based on utilization. Using SQL Sentry to monitor your Azure SQL Database gives you the ability to
see transactions per second, diagnose performance problems with Top SQL, and optimize the data platform
with Plan Explorer.
SQL Sentry helps you monitor performance metrics, including DTU usage, or vCore usage and be notified of
events occurring on your system. It gives you the ability to distinguish consistent performance patterns from
anomalies, which is critical to ensuring your data platform delivers optimal performance for the end users of
your applications.

Additional Information: For more information about vCore, see the Choosing a vCore service tier,
compute, memory, storage, and IO resources article.

SQL Sentry vs. Azure Monitor
While the Azure Monitor shows you some information about your Azure SQL Database performance, SQL
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Sentry gives you more actionable and detailed information.
For example, SQL Sentry
Can show you up to 5,000 of your Top SQL queries.
Has a robust alerting capability that can alert on information going on within the database itself
(something that isn't possible with Azure Monitor).
Azure Monitor is limited to metrics that are available from the telemetry the platform exposes, or
from query store.
Offers more data retention.

Azure SQL Database Dashboard
The Azure SQL Database Dashboard gives you deeper visibility into what's going on with your database.
Correlate values on the dashboard to make educated decisions on what's happening over time. See your DTU
usage, vCore usage, database size, memory usage, SQL Waits, and more.

Left side graphs
Displays machine level performance metrics for your Azure SQL Database environment.
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Resource Usage
The Resource Usage chart displays Database Throughput Units (DTUs), or vCore usage in your environment
for a selected time period or in real-time. DTUs represent the power of the database engine as a blended
measure of CPU, memory, and read and write rates. This measurement helps you assess the relative power of
the SQL Database performance levels.

Additional Information: For more information about Azure SQL Database DTUs, see Azure SQL
Database Performance and Service Tiers Explained.

 Note: Easily tell when your target databases have changed service tiers at any given timeframe.
Hover over the Resource Usage chart to display a tooltip. The tooltip displays DTUs or vCores based on
the mode being used at that given time.
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Memory Usage
Displays Allocated Memory Usage for your Azure SQL Database environment for a selected time period, or in
real-time.

Database Size
Displays the Database Size percentage for your Azure SQL Database environment for a selected time period,
or in real-time.
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Right Side Graphs
Displays SQL Server performance metrics for your Azure SQL Database environment.

SQL Server Activity
Displays SQL Server Activity metrics within your environment for a selected time period, or in real-time.

SQL Server Database Waits
Displays SQL Server Database Waits metrics within your environment for a selected time period, or in realtime.
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Quick Report

Open the SQL Server Wait Stat Analysis report to display more detailed information about your Azure SQL
Database waits. Right-click the SQL Database waits chart, and then select Quick Report to display your
report.
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Database IO
Displays Database IO metrics for SQL Server within your environment for a selected time period, or in realtime.
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 Note: View the SQL Sentry Dashboard in History or Sample mode.

History Mode

Sample Mode

Select the Sample or History button on the toolbar to change your view, or right-click on the
Dashboard and then select Sample mode or History mode from the context menu.

History mode toolbar

Sample mode toolbar

button

button

History mode context menu

Sample mode context menu

Dashboard features
Navigating to a Relevant Time Period
Navigate to a specific recorded time, or view events in real-time by using the toolbar. Enter a specific day and
time in the toolbar, and then select Go to display that time period.

For more information about the SentryOne toolbar, see the Toolbars topic.

Zooming In
Zoom-in to pinpoint time periods where activity is the highest in your Azure SQL Database environment.
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Using Click and Drag
1. Click and drag the cursor over a period of interest on a desired graph.
2. Release the cursor, and select Zoom In from the context menu.

Using the Toolbar
Zoom in or Zoom out of a time period by using the Zoom in and Zoom out toolbar buttons.

Toolbar Button

Image

Zoom In

Zoom Out

Using Jump To
Toggle between other SQL Sentry diagnostic and optimization tools using the Jump To context menu item.
Use Jump to by completing the following steps:
1. Highlight the desired time frame in a History mode graph.
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2. Right click the highlighted section, and then select Jump to > (Calendar, Top SQL ) from the context
menu.

Baselines
Capture and overlay baselines on your dashboard by selecting a pre-defined baseline from the Baseline dropdown menu. For example, you can easily check if the rollout you did last night is affecting your memory usage
by comparing the previous day's baseline, or you can capture a baseline to compare performance in your
production Azure SQL Database instance against your test Azure SQL Database.
For more information about Baselines, see the Baselines topic.

Top SQL
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Get details about historical long-running and/or high-impact statements from procedure and query stats for
your Azure SQL Database environment.

For more information about Top SQL, see the Performance Analysis Top SQL topic.

Plan Analysis and Query Tuning
Use the features and functionality of Plan Explorer to optimize queries and improve performance of your
Azure SQL Databases. Open Plan Explorer by selecting Open with Plan Explorer from the Plan Diagram
grid.
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For more information about Plan Explorer, see the Integrated Plan Explorer topic.

Event Calendar
Visualize how specific activities might impact others and jump to run-time performance graphs, which show
specific query performance trends and activity details.
Navigate to the Event Calendar by selecting Jump To > Calendar from the context menu, or by selecting the
Jump To Calendar toolbar button.

Jump To > Calendar from context menu

Jump to Calendar toolbar button

Creating Custom Advisory Conditions
Custom Advisory Conditions allow you to tailor and specify metrics for customized alerting based on
performance counter metrics, query results, and duration of events. Create Custom Advisory Conditions for
your Azure SQL DB environment by completing the following steps:
1. Expand the desired Azure SQL DB instance in the Navigator pane (View > Navigator), and then select
Conditions List.
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2. Select Azure SQL DB from the Create Advisory Condition drop-down list.

3. Enter a name, description, and appropriate recording metrics in their respective fields.

4. Select Save on the toolbar to save and apply your Custom Advisory Condition.

 Note: The WMI query, SQL Server Query, and Performance Counter (User) aren't possibilities for
Azure SQL Database conditions.

For more information about Advisory Conditions, see the Advisory Conditions topic.
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Azure SQL Database Performance Metrics
Last Modified on 02 September 2020

This article covers the various Azure SQL Database performance metrics displayed by the Performance
Analysis Dashboard and Performance Analysis Overview, and how to interpret different metric values and
combinations of values across different Azure SQL DB metrics for SQL Sentry.

 Note: For Mode: S = Sample and H = History.

Azure SQL Database Metrics
Section

Metric

Description
A DTU represents the power of the database engine as a
blended measure of CPU, memory, and read and write
rates. This measure helps you assess the relative power of
the SQL Database performance levels. Each service tier,
which sets pricing and usage limits for an Azure SQL
Database, expresses the amount of resource limits as a
number of DTUs. The more DTUs an Azure SQL Database is
allocated the more resources the database will have to
service the workload.

DTU Usage

Total DTU
percent

If your database is seeing high total DTU percentage usage
it may benefit from adjusting to the next highest service
tier to improve performance. If you're consistently seeing
very low total DTU percentage usage you may save some
money by scaling down to the next lower service tier.
Additional Information: For more information regarding
DTUs, see the documentation on Azure.com. For variable
performing workloads and sharing resources across
multiple Azure SQL Databases, see Elastic Database Pools.
Mode:

S, H

Type:

Percent
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Section

Metric

Description
This metric is the average CPU percentage based on the
limit of the service tier. This is one of the metrics that
makes up DTU.

DTU Usage

CPU

Mode:

S, H

Type:

Percent

This metric is the average Data I/O percentage based on the
limit of the service tier. This is one of the metrics that
makes up DTU.

DTU Usage

Data IO

Mode:

S, H

Type:

Percent

This metric is the average log I/O percentage based on the
limit of the service tier. This is one of the metrics that
makes up DTU.
DTU Usage

Log IO

Mode:

S, H

Type:

Percent

Each service tier has a maximum amount of memory
allowed for the Azure SQL Database to use. This metric
provides the percentage of the allowed memory being used
for the database.

Memory Usage

Allocated
Memory Usage

It will be very common for this metric to be high. If much of
the data your applications need is in memory it means
better performance because the database doesn't have to
read from the physical disk to return the data.
Mode:

S, H

Type:

Percent
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Section

Metric

Description
Each service tier has a maximum size allowed for the Azure
SQL Database. This metric provides the size of the database,
not including the transaction log.
If you're approaching the maximum size allowed you may
need to increase your service tier size or look to scale out
your database using sharding techniques.

Database Size

Size in GB

Additional Information: For more information about
sharding with Azure SQL Database, see Elastic Database
tools.
Mode:

S, H

Type:

Percent, GB

The total number of connections established to the Azure
SQL Database. Details for each connection can be viewed by
querying the sys.dm_exec_connections DMV.
SQL Server
Activity

User
Connections

Mode:

S

Type:

Last value

The total number of blocked processes detected on the
Azure SQL Database. The Dashboard is designed to give
you at a glance information about the number of blocked
processes.
SQL Server
Activity

Blocked
Processes

Mode:

S, H

Type:

Last value
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Section

Metric

Description
The average number of transactions per second for the
Azure SQL Database. A transaction can be either a userdefined statement block surrounded by a BEGIN TRAN and
END TRAN, or an individual DML statement (insert, update
or delete).

SQL Server
Activity

Transactions
Mode:

S, H

Type:

Avg/sec

The data rate in MB/sec for any backup operations taking
place on the server.

SQL Server
Activity

Backup MB/sec

In Azure SQL Database the platform creates backups
automatically for you. While you don't have direct control
over the backup times, this does allow you to help
determine if backups are negatively affecting your
performance.
Mode:

S, H

Type:

MB/sec

CPU percentage of Total Waits represents the percentage
of all waits which are signal waits. Signal wait time is the
time a thread has spent waiting on the CPU after being
signaled that its resource is available. A high CPU
percentage of Total Waits percentage may indicate CPU
pressure.
SQL Server Waits

CPU Percent of
Total Waits

Mode:

S

Type:

Percent

 May correlate:

High CPU

1201

Section

Metric

Description
The average wait time (in milliseconds) per second for all
processes on the database, broken down by major physical
resource category (CPU, Memory, etc.). Only the wait types
that can definitively be attributed to one of the physical
resource categories are included in the calculations for this
chart. The Other category is for a few other important wait
types that can either affect performance in more than one
major category, or can't be directly attributed to any
category with absolute certainty, such as backups and
parallelism respectively.

SQL Server Waits

Wait Time: by
Category

Waits by category is one of the most important charts on
the dashboard, because it provides an instant profile of the
SQL Database and where it's spending the most time
waiting for physical resources. If waits by category are
consistently low, then what the other dashboard charts are
showing is less important.
To view the specific wait classes involved for a particular
interval, choose the interval by selecting on the chart, and
then click the Sample button on the toolbar.
If you hover over a category, the detailed wait types for
that time sample are shown in a tooltip.
Additional Information: See also:
SQL Server Best Practices Article
Wait statistics, or please tell me where it hurts
Mode:

H

Type:

Avg ms/sec
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Section

Metric

Description
The average wait time (in milliseconds) per second for all
processes on the server, broken down by wait class. There
are approximately 30 different wait classes, and each
represents a particular SQL Server functional area or type of
activity. Meaningless or innocuous wait types such as timer
and queue waits are pre-filtered from view. Each class is
further broken down into resource and CPU waits.

SQL Server Waits

Wait Time: by
Class

If you hover over a class column, the detailed wait types are
shown in a tooltip.

Mode:

S

Type:

Avg ms/sec

The current size of the buffer cache, in MB. You want this to
be as large as possible for maximum performance.
SQL Server
Memory

Buffer Cache
Size

Mode:

S, H

Type:

MB

The average lifespan of a data page. If this value is less than
600, it's an indicator of memory pressure. Ideally, it should
be much higher than 600 if ample memory is available. In
general, the larger the buffer cache size, the higher it
should be. This is the best universal indicator of memory
pressure.

SQL Server
Memory

Page Life
Expectency

Azure SQL Database is a multi-tenant environment and this
metric represents more than just your database. Use this
metric more as an indicator of overall memory pressure and
trends.
Mode:

S

Type:

Last value

1203

Section

Metric

Description
The average time in milliseconds each physical disk read is
taking for a particular database file. For Azure SQL
Database the log and data file are shown.

Database IO

Read latency by
database file

The log and data files in Azure SQL Database are handled
for you as part of the Platform as a Service offering.
Mode:

S, H

Type:

Avg ms/Read

The average time in milliseconds each physical disk write is
taking for a particular database file.

Database IO

Database IO

Write Latency
by Database
File

Log Flushes

The log and data files in Azure SQL Database are handled
for you as part of the Platform as a Service offering.
Mode:

S, H

Type:

Avg ms/Write

Log flushes occur with every DML operation, and are a
normal part of SQL Server activity. It's important to note
that log writes to physical disk from updates to buffer
pages happen immediately upon transaction commit,
whereas writes to physical disk from the changed buffer
pages is delayed until the next checkpoint occurs. It's critical
that the physical disk system where the transaction log
resides is fast enough to keep up with activity. If not, it can
slow down all DML operations occurring in the database.
Mode:

S, H

Type:

Avg/sec
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Query Plans
Last Modified on 06 May 2021

Applies to: SQL Server and Azure SQL Database targets

The Query Plans tab lists all plans collected for Top SQL completed queries for the specified date range, and
provides a detailed chronology of all completed query plan changes. Use Query Plans to look back at any
point in time to see when a plan change led to a query performance problem.

 Note: The Query Plans tab does not currently display collected Top SQL Query Stats or Procedure
Stats query plans.

The Show Totals toolbar button controls whether the
grid lists plans are grouped by stored procedure.

Show Totals toolbar
button.

Show Totals enabled.

Show Totals disabled.

Jump To > Query Plans tab by highlighting a range on the dashboard as usual. For example, if you see a spike
in parallelism waits on the SQL Server Waits chart, highlight the spike, and then select Jump To > Query
Plans. Sort by the Parallel Operations column to determine which queries caused the spike.

Sort by Parallel Operations in Query Plans.

Highlight spike, then select Jump to > Query Plans.
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 Note: The same approach can be used to find queries with key or RID lookups because Lookups are
now displayed on the Dashboard, as well as other metrics that correlate, such as I/O and table/index
scans.

Display Panes
Display Pane

Image

The Filter pane allows you to filter the Query
Plans by SQL Server.

The Bottom pane lists the records matching the
current filters. There are two modes for this pane:
Default and Totals.

Default lists all events for the active date range in
a standard list format, sorted in order by
Database name, Object name, and Plan Creation
Time (descending).
Totals lists all events for the active date range in a
standard list format, sorted in order by
Database name, Object name, and Plan Creation
Time (descending).

Controls
Top Pane
After changing the filter, select Refresh , or press F5 to apply the filter.

Bottom Pane
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To open the plan in the Query Plan Analysis window, select the Open button under the Plan column. (If the
Show Totals button is selected, you need to expand the Database Name to see the Plan column).

 Note: The context menu provides an option to Highlight recompiles in the current date range for
a statement by enabling the checkbox.
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Performance Analysis Top SQL
Last Modified on 06 May 2021

Applies to: SQL Server, SSAS, and Azure SQL Database target types.

SQL Sentry Portal: This feature is available in SQL Sentry Portal. To learn more about configuring your
environment to use the on-premises, browser-based option with your existing SQL Sentry database, see
the SQL Sentry Portal article.
 See the SQL Sentry Portal Top SQL article for an example of the Top SQL feature in a browser.

Introduction

Top SQL tab

The Top SQL tab lists all T-SQL batches, stored procedures (RPCs), and statement events collected for the
current date range that exceeded the Minimum Duration specified in the Settings pane. The default filter is
Duration, but filtering using CPU and IO is also available. The default minimum duration is five seconds, but
this can be adjusted up or down as needed through the Top SQL Source settings.
To collect Top SQL metrics for Azure SQL database targets the Allow SQL Sentry Monitoring Objects in
Target setting under the Azure SQL Database Connection settings must be set to True. This option creates
a few objects within a SQL Sentry schema on the target database. See the Watched Target Objects article for
details.
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Top Section Grid View
The Top section Grid View displays queries in your environment. View Running Queries, Completed Queries,
Procedure Stats, or Query Stats by selecting the corresponding tab.

Open Plan Explorer for the expanded query by selecting Open.

Statement Grid
The Statements Grid displays the statements that were collected with the associated completed query,
procedure stats or query stats. It provides details on the key performance metrics that are associated with
each component part of the larger query. This allows you to see which resources were consumed by which
part of the batch.

Execution Plan Diagram
The Plan Diagram displays a graphical plan preview of the desired query in your environment.
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Select Open with Plan Explorer to view the query diagram in more detail. Hover over a plan diagram icon to display a
tooltip with more detailed information.

Select Open with Plan Explorer to open the integrated Plan Explorer view for the selected execution plan.
For more information about Plan Explorer, see the Plan Explorer topic.

Query History
Query History displays a graphical representation of the selected query over a specified range of time. Query
History provides information about the query execution plans, if and when they were changed, and how they
impacted different resources. Each dot represents when the query was executed. Different colors on the dots
indicate the different plans, and the plans are numbered. Adjust the time displayed on the graph with the
Range slider.

 Note: Hovering over any of the dots on the Query History graph provides you with additional
information.

 Note: Right click any dot on the Query History graph, and select Open Plan from the context menu
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to open the Plan Explorer diagram.

Open Plan

Additionally, adjust the graph to identify historical procedure and statement executions through CPU, IO, or
Duration metrics.

Query History Graph visualization options
Grouping

Metric

Mode

Hour

Duration

Statement

Day

CPU

Procedure

Week

IO

Display Tabs
Filter
The Filter tab provides the following filters for controlling which records display:
SQL Servers
Applications
Databases
Hosts

Select any combination of items to set the filters. To select more than one item, use Shift-Click or CTRLClick. View the filtered results by selecting Refresh or F5.
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Show Top Control- Controls how many rows are retrieved.

 Note: The Filter tab isn't displayed on an Azure SQL Database target.

Running Queries
The Running Queries tab shows all running queries matching the current filters and is independent of the
time range setting. The View button in the Plan column opens a Plan Explorer session for the associated
query. The Text Data column shows the original text the client sent to the server and the Active Statement
column shows the currently running statement.

Running Queries

 Note: Running queries isn't supported for SQL Server 2000 or Azure SQL Database.
 Note: The text data for the active statement is displayed in the Text Data pane when the
Active Statement cell is selected.

Completed Queries
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The Completed Queries tab lists all records matching the current filters. The View button in the Plan column
opens a Plan Explorer session for the associated query. The default filter displays all records. There are two
modes for this pane: Default and Totals.
Default mode lists all events for the active date range in a standard list format, sorted descending by End
Time by default. Default mode is activated whenever auto-refresh is enabled by selecting Play on the
toolbar, which shows the events for the last 10 minutes with new events coming in automatically at the top of
the list.
Totals mode is enabled by selecting Show Totals (the sigma Σ button). This groups all like events together
using a normalized version of the T-SQL with all variable parameters replaced, and it shows aggregates for
each group. This enables you to quickly determine which events are responsible for the most CPU or IO
activity for the active date range.

Completed Queries
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 Note: SQL Sentry 8.2 introduces enhanced SQL text data normalization. If upgrading from a build
prior to 8.2, enhanced normalization must be activated in the Monitoring Service Settings >
Performance Monitor tab.

Procedure Stats

The Procedure Stats tab provides aggregate information for all procedures matching the current filters. The
View Plan button in the Plan column opens a Plan Explorer session for the associated procedure. Additional
historical information may be available in the Runtime Stats. Open Runtime Stats by right clicking on a
procedure and selecting Jump To > Runtime Stats.

Procedure Stats
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 Note: SQL Sentry installations upgraded from a version older than 8.2 need to enable the Collect
Query Stats option in the Top SQL Source setting.
 Note: Procedure Stats isn't available for SQL Server 2000 or SQL Server 2005.

Query Stats

The Query Stats tab provides aggregate information for queries matching the current filter. This area also
provides insight into queries that run very quickly and in high volume.

Query Stats

1215

 Note: SQL Sentry installations upgraded from a version older than 8.2 need to enable the Collect
Query Stats option in the Top SQL Source setting.
 Note: Query Stats isn't available for SQL Server 2000 or SQL Server 2005.

Command Text
The Command Text tab shows the T-SQL text data for the currently highlighted Top SQL record with syntax
highlighting.

Command Text

Top SQL Runtime Stats
The Top SQL Runtime Stats option provides insight into the frequency and duration of the queries and
procedures that are captured by Top SQL.

Additional Information: See the Top SQL Runtime Stats article.

Top SQL Metrics
Default Metrics
Name

Description

Plan

Select Open to open a new Plan Explorer session for the captured
query plan.

Host

Name of the target where the associated captured query originated.
The event class of the associated captured query.

Event Class

Additional Information: For more information, see the SQL Server
Event Class Reference MSDN article.
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Name

Description

Text Data

Associated text data captured for the query.

Login

The Windows or SQL Server account associated with the captured
query.

Duration

The amount of time taken by the captured query.

CPU

The amount of CPU time (in milliseconds) used by the captured query.

CPU %

The percentage of CPU time used by the captured query, in relation to
any other Top SQL events that are shown in the grid.

Reads

The number of logical reads from the cache performed by the server
on behalf of the captured query.

Reads %

The percentage of bytes read by the captured query, in relation to any
other events that are shown in the Top SQL Grid view.

Writes

The number of physical disk writes performed by the server on behalf
of the captured query.

Writes %

The percentage of bytes written by the captured query, in relation to
any other events that are shown in the Top SQL Grid view.

Start Time

Time the captured query started.

End Time

Time the captured query ended.

Information

Additional data captured about the query.

Error

Error number of a given captured query.

SPID

The server process ID (SPID) that is assigned to the process.

Host Process ID

The ID assigned by the host computer to the process where the client
application is running.

Server

The SQL Server instance where the associated captured query took
place.

Additional Metrics
The following metrics do not appear by default, but can be added through the column chooser. See the Data
Grids article for additional information on choosing columns.
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Name

Description

Application

Name of the client application that created the connection.

Database

Name of the database for the associated captured query.

Granted Memory (KB)

The amount of memory in KB granted to the captured query.

Granted Query Memory
(KB)

The amount of memory in KB granted to the query.

Has Plan

True if the associated query has a captured plan.

Has Statements

True if the associated query has captured statements.

Ideal Memory (KB)
Is incomplete

True if the associated query is incomplete.

Parent ID

The ID assigned to the Parent query.

Requested Memory (KB)

The amount of memory in KB requested by the captured query.

Session Memory (KB)

The amount of memory in KB used during the session.

Tempdb Internal (KB)

The amount of memory in KB used by tempdb internal objects.

Tempdb Internal (KB)
Dealloc

The amount of memory in KB that is deallocated for tempdb internal
objects.

Tempdb User (KB)

The amount of memory in KB that is used by User objects.

Tempdb User (KB) Dealloc

The amount of memory in KB that is deallocated for User objects.

Visible

Specifies the default visibility for the select row. Queries may be
hidden in Top SQL.

Changing What's Collected for Top SQL
Change the Top SQL that's collected by SQL Sentry through the Top SQL Source settings. Change the Top
SQL events collected by SQL Sentry through the Top SQL Source settings at these levels: All Targets
(Global), site, target group, target, and instance.
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Collection Settings

 Note: As a reminder, all settings have a hierarchical configuration, and work through the principle of
inheritance. Any changes you make at one level is automatically inherited by all objects below it. For
more information about inheritance within SQL Sentry, see the Alerting and Response System topic.

Example One
To configure the Top SQL Minimum Duration Collection setting globally complete the following steps:
1. Select the All Targets node in the Navigator pane (View > Navigator).
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2. In the Settings pane (View > Settings), select SQL Server from the top drop-down list.

3. Select Top SQL Source from the second drop down list to open the Top SQL Source settings that are
being applied globally.

4. Change the Minimum Duration to the desired value; it saves automatically.
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Example Two
To configure the Top SQL Minimum Duration Collection setting for an individual instance complete the
following steps:
1. Select the desired instance node in the Navigator pane (View > Navigator).

2. In the Settings pane (View > Settings), select SQL Server from the top drop-down list.
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3. Select Top SQL Source from the bottom drop-down list to open the Top SQL Source settings that are
configured for the instance.

4. Within the Collection Settings section change the Inherit From Parent setting to False.

5. Change the Minimum Duration to the desired value; it saves automatically.
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There are a few additional things you should know regarding the Top SQL Source settings.
There is an AND relationship that exists between the Minimum Duration, Minimum CPU, Minimum Reads,
and the Minimum Writes Collection Settings, meaning that to be collected as Top SQL, the event needs to
satisfy each individual Collection Setting. For example, if you set the Minimum Duration at 10 seconds and
the Minimum Reads at 25, an event needs to meet both a Minimum Duration of 10 seconds AND a Minimum
Reads of 25 to be captured in Top SQL.
Minimum Duration can't be set below 100ms unless Minimum CPU, Minimum Reads, or Minimum Writes is
greater than zero. This lower limit is enforced because setting this threshold below 100ms for an extended
period of time dramatically increases the volume of data collected and stored by SQL Sentry, and has a
negative impact on the monitored server.

 Note: SQL Sentry's QuickTrace functionality is better suited to analyze extremely short duration
events.

Adjusting Captured TextData Length
By default textdata for captured Top SQL and Top Command events is truncated at 10,000 characters.
Change this maximum length in Global Settings (Navigator pane > Configuration > Global Settings >
Advanced tab > Query Collection Maximum Text Length).
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 Note: You may adjust the Query Collection Maximum Text Length setting up to 50,000 characters.
The default setting of 10,000 characters is adequate for most SQL Server environments.

Hiding Queries and Stopping Alerts
 Note: Hiding a query in Top SQL also hides it from the calendar view.

Hide individual queries or groups of queries with the right-click context menu Hide command.
To hide a single query, select the desired row, then right-click and select Hide.

To hide a group of queries, drag a column header to the top of the Grid View to group like items. Select
the group header in the Grid View and use the right-click context menu Hide command.
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 Important: Once a query is hidden in Top SQL, you're no longer alerted about it for any of the Top
SQL related conditions. Unhide all hidden queries by selecting Show Hidden on the toolbar. To unhide an
individual query permanently, select the Visible checkbox from the Column Chooser that toggles the
effect of Hide/Hide Group.
It's important to note that this will impact everyone using this particular SQL Sentry environment, not
just your individual SQL Sentry client view.

Top SQL Source Settings
There are three settings that can be adjusted to change how long a query runs to be collected. These settings
are in the Top SQL Source area in the Settings pane.

Setting

Description

Query Stats Sample Interval

Specifies how often to sample
query stats.

Filter Time Span

Specifies the base length of
time over which the collection
filters are applied to Query
Stats.

Minimum Duration

Specifies the minimum
duration for a statement to be
logged.

Image
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Setting

Description

Filter Factor

The Filter Factor is calculated
by dividing the Query Stats
Sample Interval by the Filter
Time Span. The collection
filters such as Minimum
Duration are multiplied by
this value when applied to
Query Stats collection.

Image

 Note: Each of these settings play a part in what's captured for Query Stats in your environment. As
an example, using the following default settings:
Query Stats Sample Interval = 60 seconds
Filter Time Span = 30 seconds
Minimum Duration = five seconds
The total cumulative duration of all executions of a query over the 60 second sample interval must be
greater than 10 seconds.

Controls
Top Pane
Control

Description

Image
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Control

Filter
button

Description

Image

Add a filter to any column by selecting the filter
button. After changing any of the filters, it's
necessary to select Refresh, or press F5 to apply
the filter.
Select on a combination of items in any of the
lists to set the filters. The default filter
displays all records.
To select more than one item in a list, use
Shift-Click or CTRL-Click.

Toolbar Options
Control

Description

Image

Show
Hidden
Rows

Hide individual lines or groups of rows. This toggles

Show
Totals

Groups like queries together by normalizing the
result set.

the display of those lines.

Context Menu Options
Option

Description

Sort Ascending

Organizes the
selected column in
Ascending order.

Sort Descending

Organizes the
selected column in
Descending order.

Context Menu
Image

Option Applied
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Option

Clear Sorting

Description

Context Menu
Image

Option Applied

Clears the sorting
options applied to
the column.

Group By This Column

Groups the queries
by the selected
column.

Show Group By Box/
Hide Group By Box

Displays or Hides the
Group by box.

Hide This Column

Hides the selected
column.

Column Chooser

Opens the Column
Chooser. The
Column Chooser
provides additional
columns to sort
information.

Best Fit

Resizes the
information for the
selected column.
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Option

Description

Best Fit All Columns

Resizes the
information for all of
the columns.

Context Menu
Image

Option Applied

Opens the Filter
Editor.
Use the Filter Editor
to add and remove
filters, and apply
Filter Editor

Boolean logic for a
more complex filter.
To adjust the
Boolean logic, simply
select the red And to
bring up the context
window.

Show Find Panel

Displays the Find
Panel. Use the Find
Panel to search for
specific strings in the
queries.

Show Auto Filter Row

Displays the Auto
Filter Row. Use the
Auto Filter Row to

Reset Grid

Resets the data on
the grid to the
default setting.
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 Important: Hide/Hide Group disables any alerts for the events, and prevents them from being
displayed on the Event Calendar.

Jump to
Jump To context
menu option

Description

Jump to Dashboard

When Show Totals
mode is enabled all
events belonging to
the selected group
are overlaid on the
Dashboard. When
the Default mode is
enabled only the
selected event is
overlaid on the
Dashboard.

Jump to Calendar

Goes to the selected
event on the Event
Calendar (requires
the server to be
watched with EM).

Jump to Runtime
Stats

Opens a tab showing
the Runtime Stats for
the event.

Top SQL Jump To
option

Corresponding data

Additional Options
Option

Kill Process

Trace Procedure

Description

Image

Kills the running process (Running
Queries tab).

Opens the Run QuickTrace dialog
box for the selected event (Query
Stats tab).
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Option

Description

Image

Database Mapper Environment Map
The SolarWinds Database Mapper Environment Map shows data collected from the SQL Sentry database to
map connections between applications, users, clients and targets (sourced from Top SQL and Windows
processes). This information complements the lineage analysis feature by showing the dynamic usage of
targets in the lineage diagram and shedding light on the processes that are using the database.

Additional Information: To learn more about using Top SQL data with SolarWinds Database Mapper,
see the Environment Map article.
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DW Sentry Overview
Last Modified on 06 May 2021

The Azure Synapse SQL Pool Performance Monitoring
Solution

DW Sentry monitors the performance of your Azure Synapse SQL Pools (formerly Azure SQL Data
Warehouses) so you can deliver accurate, business-critical information to your end users. DW Sentry provides
detailed visibility into the queries, loads, backups, and restores of all your data. It includes features such as the
Event Calendar and intelligent movement dashboard (shown below), allowing you to discover what's
impacting your workload.

Data Movement Dashboard
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Using the DW Sentry Data Movement Dashboard allows you to identify data movement activity quickly and
easily. Zoom-in on key periods of activity, go back in time to any specified time, and Jump To other features
within the product. The Data Movement Dashboard contains the following charts that provide an at a glance
view of your environment:

Graph

Description

Distribution
Activity

Displays a graphical representation of the
distribution activity for a selected metric
across compute nodes within your
environment in milliseconds. Each color on
the graphs represents an individual
compute node in your environment.

Node Activity

Displays a graphical representation of the
node activity for a selected metric across
the compute nodes within your
environment. Each color on the graph
represents an individual compute node in
your environment.

Data Movement
CPU (ms)

Displays a graphical representation of data
movement CPU activity across the compute
nodes within your environment in
milliseconds. Each color on the graph
represents an individual compute node in
your environment.

Image
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Graph

Description

Elapsed Time
(ms)

Displays a graphical representation of
elapsed time of data movement across the
compute nodes within your environment in
milliseconds. Each color on the graph
represents an individual compute node in
your environment.

Rows Processed

MB Processed

MB/Sec

Image

Displays a graphical representation of the
rows processed across the compute nodes
within your environment in milliseconds.
Each color on the graph represents an
individual compute node in your
environment.

Displays a graphical representation of MB
processed across the compute nodes
within your environment. Each color on the
graph represents an individual compute
node in your environment.

Displays a graphical representation of MB
processed per second across the compute
nodes within your environment. Each color
on the graph represents an individual
compute node in your environment.

 Note: Selecting a graph on the bottom pane automatically updates and displays the selected metric
data on graphs in the top pane. For example, select the bottom pane graph Rows Processed to show
detail data for Distribution Activity: Rows Processed and Node Activity: Rows Processed in the top
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pane graphs.

Data Movement CPU example

Rows Processed example

Zooming in to Pinpoint Periods of Activity
Zoom-in to pinpoint time periods where activity is the highest in your Azure Data Warehouse environment.

Using Click and Drag
Zoom in to specific periods on a desired graph using Click and Drag by completing the following steps:
1. Click and drag the cursor over a period of interest on a bottom pane graph.

2. Release the cursor, and select Zoom In from the context menu.
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 Success: You have zoomed into a selected time period.

 Note: Selecting a time period on one bottom pane graphs, selects the same time period across all
graphs. This allows you to identify correlating issues within your environment.

Using the Toolbar
Zoom in or Zoom out of a time period by using the Zoom in and Zoom out toolbar buttons.

Toolbar button

Image

Zoom In
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Toolbar button

Image

Zoom Out

Navigating to a relevant time period
Review relevant historical data, or get real-time updates on the metrics within your Azure Data Warehouse
environment with DW Sentry.

Using the Toolbar
Navigate to a specific time period on the Data Movement Dashboard by completing the following steps:
1. Select a start-date from the Start drop-down list on the toolbar, and then select a Start time from the
drop-list.

2. Select an end-date from the End drop-down list on the toolbar, and then select an end time from the
drop-list.

3. Select Go on the toolbar to display your desired time period.

 Success: Your desired time frame displays in the Data Movement Dashboard.
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Using Jump to
Easily toggle between other SentryOne diagnostic and optimization tools using the Jump To context menu
item. Use Jump to by completing the following steps:
1. Highlight the desired time frame in a bottom pane graph.

2. Right click the highlighted section, and then select Jump to > ( Calendar, Distributed Queries, Or
Loads/Backups/Restores) from the context menu.
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Distributed Queries Tab
View details of each Massively Parallel Processing (MPP) query. Filter, sort, and group historical information,
including query step details.

Loads, Backups, and Restores Tab
View information about both in-process and historical events through the Loads, Backups, and Restores grid .
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Additional Features
Intelligent alerting
Save time by using Advisory Conditions that notify you about overall data system health, distributed query
performance thresholds, as well as load and backup performance.
The following is a list of the most common issues that impact the performance of an Azure SQL Data
Warehouse and an associated advisory condition in DW Sentry:

Advisory Condition

Description

Outdated Statistics

Outdated statistics can be a root cause of performance issues in Azure DW
because updating statistics is a manual process on these platforms, and if
statistics are up to date on the individual compute nodes, they may not be
caught up on the control node. This advisory condition provides an effective
way to determine if statistics are out of date by comparing row count
estimates between the control node and the compute nodes for each table
in a database. By default, this condition evaluates to true if there's at least
20 percent discrepancy on any table.  Note: When configuring this
advisory condition for your environment, be sure to import at the individual
target level, not All Targets. Update the database name to the database
you wish to evaluate. This condition only evaluates row counts and not
cardinality. It doesn’t consider whether statistics exist on more than one
column, nor for which column(s) the statistics exist.

Data Distribution
Skew

If the data isn’t evenly distributed across compute nodes, you’re likely to
demand more resources from some nodes rather than others, and not get
the most benefit out of the MPP architecture. This advisory condition allows
you to detect data skew of your data at rest, before it impacts your query
performance. By default, this condition checks row counts for each
distribution for each table, and alerts you if it detects a 10 percent or more
difference between the smallest and largest distributions for a given table.
 Note: As with the Outdated Statistics advisory condition, update the
Database name to the database you wish to evaluate.
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Advisory Condition

Suspended Requests

Description
Requests can utilize more than one concurrency slot based on their resource
class. This advisory condition checks for any active requests in suspended
status to alert you to concurrency slot saturation. This is only true for active
requests in this state. After they execute, they show a normal completed
status.
 Note: This advisory condition is global and only needs to be set up once
under All Targets, because it queries the SentryOne database directly
instead of any DMV’s on the target.

High Request Queue
Times

If locking and other mechanisms are excessive, you may notice a high
percentage of the Total Elapsed Time for the request was spent in queue
as represented in Queue Duration. This advisory condition queries the
SentryOne database every 10 minutes and evaluates to true if any
completed or running queries in the last 10 minutes have a total queueing
time greater than one minute (60000 ms). It reports up to 10 device name +
request ID combinations by default. This condition is global and only needs
to be set up once.

Low Available
Memory

Memory can be a common root cause for slow performance and out-ofmemory issues on any SQL Server and Microsoft’s MPP platforms are no
exception. In Azure, consider scaling your data warehouse if you find SQL
Server memory usage reaching its limits during query execution.

Long Running
Requests

This advisory condition, Distributed Queries: Duration Threshold Max, should
be configured to detect and alert on any long-running requests.

 Download: Download the aforementioned advisory conditions to use in your environment here.

 Note: Advisory Condition markers are set by default.

Event Calendar
See activities in a calendar format to quickly identify potential resource constraint problems in massively
parallel processing (MPP) systems, where concurrency is an important aspect of performance.
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Additional Information: For more information about the Event Calendar in SentryOne, see the
Calendar and List views topic.

Runtime Statistics
View Runtime Statistics graphs for Loader Backup Runs through the Navigator pane (View > Navigator).
Expand your desired SQL DW environment in the Navigator, expand the Event Manager node, and then
expand the Loader Backup Runs node to display the Backup, Load, and Restore nodes.
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Select and Expand the desired node, and then select Runtime stats > Open to display the Runtime Statistics
graph.

The Runtime Statistics graph can be displayed in History or Aggregate view.
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History View

Aggregate View

Creating Custom Advisory Conditions
Custom Advisory Conditions allow you to tailor and specify metrics for customized alerting based on
performance counter metrics, query results, and duration of events. Create Custom Advisory Conditions for
your Azure SQL Data Warehouse environment by completing the following steps:
1. Expand the desired Azure SQL Data Warehouse instance in the Navigator pane (View > Navigator), and
then select Conditions List.
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2. Select SQL DW from the Create Advisory Condition drop-down list.

3. Enter a name, description, and appropriate recording metrics in their respective fields.

4. Select Save on the toolbar to save and apply your Custom Advisory Condition.

 Note: For more information about Advisory Conditions, see the Advisory Conditions topic.
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DW Sentry Performance Metrics
Last Modified on 10 September 2020

This article covers the various performance metrics displayed by the Performance Analysis Dashboard and
Performance Analysis Overview for DW Sentry.

 Note: For Mode: S = Sample and H = History.

Azure Synapse SQL Pool Metrics
Section

Metric

Description

Distribution
Activity

Data Movement
CPU (ms)

Mode:

H

Node Activity

Data Movement
CPU (ms)

Mode:

H

Distribution
Activity

Elapsed time
(ms)

Mode:

H

Node Activity

Elapsed time
(ms)

Mode:

H

Distribution
Activity

Rows Processed

Mode:

H

1247

Section

Metric

Node Activity

Rows Processed

Distribution
Activity

MB Processed

Node Activity

MB Processed

Distribution
Activity

MB/sec

Node Activity

MB/sec

Description

Mode:

H

Mode:

H

Mode:

H

Mode:

H

Mode:

H
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DW Sentry Distributed Queries
Last Modified on 25 May 2021

Distributed Queries tab
View details of each Massively Parallel Processing (MPP) query. Filter, sort, and group historical information,
including query step details.

Active Requests Grid

The Active Requests grid displays active queries that are running at the time of collection in your Azure
Synapse environment. Each column header in the Active Requests grid provides you with detailed data about
your environment. See the following table for descriptions about these data metrics:

Default Column
header

Column Description

Command

Displays the Query command text for the active request.

Status

Displays the status of the active request (Completed, Active, Failed).

Login

Displays the login of the active request's user.
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Default Column
header

Column Description

Login time

Displays the corresponding login time for the active request.

Submit time

Displays the submittal time for the active request.

Queue Duration

Displays the amount of time the active request was in the query queue.

Compile Duration

Displays the amount of time taken for the active request to be compiled.

Execution Duration

Displays the time the active request spent actively using processor
resources.

Total Elapsed time

Displays the Total Elapsed time that the active request was running at the
time of data collection.

End time

Displays the end time of the active request.

Application

Displays the Application where the active request is running.

Label

Displays any label(s) associated with the active request.

Resource Class

Displays the resource class for the active request.

Client ID

Displays the Client ID of the active request.

SQL Spid

Displays the SQL Server process ID for the active request.

Transactional

Displays the database statements that are either entirely committed or
rolled back. For more information about transactions in SQL Data
Warehouse, see the Transactions MSDN article.

Error

Displays any associated error information for the active request.

Request ID

Displays the Request ID of the active request.

Session ID

Displays the Session ID of the active request.

Add additional columns to the Active Requests grid by right clicking the column header and then selecting
Column Chooser to open the Column Chooser.
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See the following table for additional columns that can be added in the Active Requests grid:

Optional Column

Column Description

End Compile time

Displays the time when the active request finished compiling.

ID

Displays the ID number of the active request.

Start Time

Displays the time when the active request began.

Completed Requests Grid
The Completed Requests grid displays the completed queries in your environment. Expand the Completed
Requests tab by selecting the arrow icon at the bottom of the grid.

Select the arrow to expand
Completed Requests Expanded

Each column header in the Completed Requests grid provides you with detailed data about your environment.
See the following table for descriptions about these data metrics:

Default Column
header

Column Description

Command

Displays the Query command text of the completed request.

Status

Displays the status of the completed request ( Completed, Active, Failed).

Login

Displays the login of the completed request's user.

Login time

Displays the corresponding login time for the completed request.
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Default Column
header

Column Description

Submit time

Displays the submit time for the complete request.

Queue Duration

Displays the amount of time the completed request was in the query queue.

Compile Duration

Displays the amount of time taken for the completed request to be
compiled.

Execution Duration

Displays the time the completed request spent actively using processor
resources.

Total Elapsed time

Displays the total time the completed request was running.

End time

Displays the time the completed request ended.

Applications

Displays the application(s) where the completed request was running.

Label

Displays any label(s) associated with the completed request.

Resource class

Displays the resource class of the completed request.

Client ID

Displays the Client ID of the completed request.

SQL Spid

Displays the SQL Server process ID for the completed request.

Transactional

Displays the database statements that are either entirely committed or
rolled back. For more information about transactions in SQL Data
Warehouse, see the Transactions MSDN article.

Error

Displays any error(s) associated with the completed request.

Error ID

Displays the Error ID associated with the completed request.

Request ID

Displays the Request ID of the completed request.

Session ID

Displays the Session ID of the completed request.

Add additional columns to the Completed Requests grid by right clicking a column header and then selecting
Column Chooser to open the Column Chooser.
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See the following table for additional columns that can be added in the Completed Requests grid:

Optional Column

Column Description

End Compile time

Displays the time when the completed request finished compiling.

ID

Displays the completed request ID number.

Start Time

Displays the time when the completed request began.

Request Steps Grid
The Request Steps grid displays the request steps of the selected completed query. Select a query in the
Completed Requests grid to display that query's steps.
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 Note: The Request Steps grid has the Group by box hidden by default. Unhide the Group by box by
right clicking the top of the grid and then selecting Show Group by box.

Each column header in the Request Steps grid provides you with detailed data about your environment. See
the following table for descriptions about these data metrics:

Default Column
header

Column Description

Step Index

Displays the step index number of the selected query.

Command

Displays the Query command text of the selected query.

Status

Displays the status of the selected query (Completed, Active, Failed).

Total Elapsed time

Displays the total time the selected query was running.

Operation type

Displays the operation category associated with the selected query.

Distribution type

Displays the distribution category associated with the selected query.

Location type

Displays the location category of the selected query.

Start time

Displays the time when the selected query began.

End time

Displays the time when the selected query ended.

Error ID

Displays any Error ID associated with the selected query.

Row count

Displays the number of rows processed by the selected query.

Request ID

Displays the Request ID of the selected query.
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Add additional columns to the Request Steps grid by right clicking the column header and then selecting
Default Column
Column Chooser.
Description
Column Chooser to open the Column
header

See the following table for additional columns that can be added in the Request Steps grid:

Optional column

Column Description

Appliance

Displays the name of the hardware and software product your environment
is using for analytical processing.

Command

Displays the Query command text for the selected query.

End time

Displays the time when the selected query ended.

ID

Displays the ID number associated with the selected query.

Start time

Displays the time when the selected query began.

Step Index

Displays the Step index associated with the selected query.

Time Zone Factor
Minutes

Utc offset

Displays the date and time of day for the query that is based on a 24 hour
time cycle with time zone awareness.

SQL Requests Grid
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The SQL Requests grid displays SQL request metrics for the selected completed query. Select a query in the
Completed Requests grid to display that query's SQL Requests.

 Note: The SQL Requests grid has the Group by box hidden by default. Unhide the Group by box by
right clicking the top of the grid and then selecting Show Group by box.

Each column header in the SQL Requests grid provides you with detailed data about your environment. See
the following table for descriptions about these data metrics:

Default Column
header

Column Description

Plan

Open the Plan diagram for the selected query.

Step index

Displays the SQL Step index associated with the selected query.

Remote Node ID

Displays the Remote Node ID of the selected query.

Distribution ID

Displays the Distribution ID of the selected query.
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Default Column
header

Column Description

Command

Displays the Query command text of the selected query.

Status

Displays the status of the selected query (Completed, Active, Failed).

Total Elapsed time

Displays the total time the selected query was running.

Start time

Displays the time when the selected query began.

End time

Displays the time when the selected query ended.

Error ID

Displays the Error ID associated with the selected query.

Row Count

Displays the number of rows processed by the selected query.

Spid

Displays the Service Profile Identifier associated with the selected query.

Add additional columns to the SQL Requests grid by right clicking the column header and then selecting
Column Chooser to open the Column Chooser.

See the following table for additional columns that can be added in the Request Steps grid:

Optional Column

Appliance

Appliance ID

Column Description

Displays the name of the hardware and software product your environment
is using for analytical processing.

Displays the Identification number for the appliance your system is using.
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Optional Column

Column Description

ID

Displays the ID of the selected query.

Request ID

Displays the Request ID of the selected query.

Time Zone Factor
Minutes

Utc offset

Displays the date and time of day for the query that is based on a 24 hour
time cycle with time zone awareness.

Additional Information
Grouping Queries
Group the queries in any grid by dragging a header into the Group by box. For more information about
grouping queries, see the Data Grids topic.

Sorting Queries by columns
Sort rows by ascending or descending order in any grid by selecting the arrow icon on the desired column
header. For more information about sorting queries in data grids, see the Data Grids topic.

Filtering Queries
Add a filter to any desired row by selecting the filter button. For more information about filtering queries, see
the Data grids topic.

Copying Queries
Copy query cells, rows, or all data by selecting and right clicking a query, and then selecting the desired option
from the context menu. For more information about copying queries in a data grid, see the Data Grids topic.

Additional Context menu options
Access the following additional context menu options by right-clicking a column header in any grid:

Context menu option

Description

Context menu
Image

Option applied

1258

Context menu option

Description

Sort Ascending

Sorts the selected
column by ascending
order.

Sort Descending

Sorts the selected
column by
descending order.

Clear Sorting

Clears the sorting
options for the
selected column.

Clear All Sorting

Clears all sorting
options for the
selected grid.

Group by this column

Groups the displayed
information by the
selected column.

Context menu
Image

Option applied
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Context menu option

Description

Show Group by box

Shows the group by
box for the selected
grid.

Hide This Column

Hides the selected
column.

Column Chooser

Opens the Column
Chooser. The
Column Chooser
provides additional
columns to sort
information.

Best Fit

Expands the
information for the
selected column.

Context menu
Image

Option applied
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Context menu option

Description

Best Fit (all columns)

Expands the
information for all
columns.

Filter Editor

Opens the filter
editor.

Show Find Panel

Opens the Find
Panel. Use this panel
to locate specific text
within your selected
grid.

Show Auto Filter Row

Opens the Auto Filter
Row. Use the Auto
Filter Row to add
specific filters within
your selected grid.

Context menu
Image

Option applied
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Using Jump to
Jump To takes you to any of the following four options when selecting any query on the Distributed Queries
tab:
Calendar
DMS Dashboard
Loads/Backups/Restores
Runtime Stats
To use the Jump to context menu option complete the following steps:
1. Select a query in any grid, and then right click the query to open the context menu.

2. Select Jump to > desired option from the context menu to open the desired option.

Jump to options
Jump to Option

Description

Jump to > Calendar

Opens the Event Calendar
view for the selected query.

Image
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Jump to Option

Description

Jump to > DMS Dashboard

Opens the Data Movement
Dashboard for the selected
query.

Jump to >
Loads/Backups/Restores

Opens the
Loads/Backups/Restores tab
for the selected query.

Jump to > Runtime stats

Opens a Runtime Statistics
graph for the selected query.
The Runtime Statistics graph
displays in history view by
default.

Image

History View

Aggregate View
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Loads/Backups/Restores
Last Modified on 06 May 2021

Loads/Backups/Restores tab
View information about both in-process and historical events through the Loads/Backups/Restores tab.

Loader Backup Runs Grid
The Loader Backup Runs grid displays data loads entering into the Azure Synapse target, as well as backups
and restores of the Azure Synapse target itself. Organize the displayed information to quickly correlate
performance activity in your Azure Synapse environment.

Loader Backup Run Details Grid
The Loader Backup Run Details grid displays detailed information about data loads entering into the Azure
Synapse target, as well as backups and restores of the Azure Synapse target itself. Organize the displayed
information to quickly correlate performance activity in your Azure Synapse environment.

Grouping Queries
For information about grouping queries in the Loader Backup Runs grid, see the Data Grids topic.

 Note: Hide the Group by box by right-clicking the Group by area, and then selecting Hide Group by
box from the context menu. Open the Group By Box by right-clicking a header, and then selecting Show
Group By Box from the context menu.
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Sorting Queries by Columns
For information about sorting queries by column, see the Data Grids topic.

Filtering Columns
For information about filtering columns, see the Data Grids topic.

Additional Context Menu Options
Access the following additional context menu options by right-clicking a column header in any grid:

Context menu option

Description

Sort Ascending

Sorts the selected
column by ascending
order.

Sort Descending

Sorts the selected
column by
descending order.

Context menu
Image

Option applied
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Context menu option

Description

Clear Sorting

Clears the sorting
options for the
selected column.

Clear All Sorting

Clears all sorting
options for the
selected pane.

Group By This Column

Groups the displayed
information by the
selected column.

Show Group by box

Shows the group by
box for the selected
pane.

Hide This Column

Hides the selected
column.

Context menu
Image

Option applied
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Context menu option

Description

Column Chooser

Opens the Column
Chooser. The Column
Chooser provides
additional columns to
sort information.

Best Fit

Expands the
information for the
selected column.

Best Fit (all columns)

Expands the
information for all
columns.

Filter Editor

Opens the filter
editor.

Context menu
Image

Option applied
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Context menu option

Description

Show Find Panel

Opens the Find
Panel. Use this panel
to locate specific text
within your selected
pane.

Show Auto Filter Row

Opens the Auto Filter
Row. Use the Auto
Filter Row to add
specific filters within
your selected pane.

Context menu
Image

Option applied

Using Jump to
Jump To takes you to any of the following options when selecting any query on the Loads/Backups/Restores
tab:
Calendar
DMS Dashboard
Distributed Queries
To use the Jump To context menu option complete the following steps:
1. Select a query in any grid, and then right click the query to open the context menu.

2. Select Jump To > desired option from the context menu to open the desired option.
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Jump To Options
Jump to Option

Description

Jump To > Calendar

Opens the Event Calendar
view for the selected query.

Jump To > DMS Dashboard

Opens the DMS Dashboard
with metrics for the selected
query.

Jump To > Distributed
Queries

Opens the Distributed
Queries tab with metrics for
the selected query.

Image

Copying Queries
Copy query cells, rows, or all data by selecting and right clicking a query, and then selecting the desired option
from the context menu.
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APS Sentry Overview
Last Modified on 06 May 2021

Data Movement Dashboard
View important Microsoft APS activity, including key CPU metrics, elapsed time, rows processed, and MB/sec
processed. The dashboard also helps you visualize the correlation of that activity against the compute nodes
and the associated distributions.

Using the APS Sentry Data Movement Dashboard allows you to identify data movement activity quickly and
easily. Zoom-in on key periods of activity, go back in time to any specified time, and Jump To other features
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within the product. The Data Movement Dashboard contains the following charts that provide an at a glance
view of your environment:

Graph

Description

Distribution Activity

Displays a graphical representation of the distribution activity
for a selected metric across compute nodes within your
environment in milliseconds. Each color on the graph
represents an individual compute node in your environment.

Node Activity

Displays a graphical representation of the node activity for a
selected metric across the compute nodes within your
environment in milliseconds. Each color on the graph represent
an individual compute node in your environment.

Data Movement CPU (ms)

Displays a graphical representation of data movement CPU
activity across the compute nodes within your environment in
milliseconds. Each color on the graph represents an individual
compute node in your environment.

Elapsed Time (ms)

Displays a graphical representation of elapsed time of data
movement across the compute nodes within your environment
in milliseconds. Each color on the graph represents an
individual compute node in your environment.

Rows Processed

Displays a graphical representation of the rows processed
across the compute nodes within your environment in
milliseconds. Each color on the graph represents an individual
compute node in your environment.

MB Processed

Displays a graphical representation of MB processed across the
compute nodes within your environment. Each color on the
graph represents an individual compute node in your
environment.

MB/Sec

Displays a graphical representation of MB processed per
second across the compute nodes within your environment.
Each color on the graph represents an individual compute node
in your environment.

 Note: Selecting a graph on the bottom pane automatically updates and displays the selected metric
data on graphs in the middle pane. For example, select the bottom pane graph Rows Processed to
show detail data for Distribution Activity: Rows Processed and Node Activity: Rows Processed in the
top pane graphs.

Distributed Queries Tab
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Get details about any live or historical requests and the associated request steps across the APS environment.
APS Sentry lets you set query collection thresholds based on duration, and displays the executed request,
client, application, login, label, and resource class, along with pertinent performance metrics. For more
information about the Distributed Queries tab, see the Distributed Queries article.

Loads, Backups, and Restores Tab
View information about both in-process and historical events across your APS environment through the
Loads, Backups, and Restores grid. For more information, see the Loads, Backups, Restores article.

Health Alerts Tab
Get critical information about the overall health of your APS environment through Advisory Conditions, which
display the description, type, severity, and current/previous value of outlying conditions.

Event Calendar
View of all your Microsoft APS activity in a convenient calendar format. Use the Event Calendar to help you
visualize how specific activities affect one another, and jump to run-time performance graphs to see specific
query performance trends.
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APS Sentry Performance Metrics
Last Modified on 21 August 2020

This article covers the various performance metrics displayed by the Performance Analysis Dashboard and
Performance Analysis Overview, and how to interpret different metric values and combinations of values
across different metrics for APS Sentry.

 Note: For Mode: S = Sample and H = History.

APS Sentry Metrics
Section

Metric

Description

Mode:

H

Type:
Processor Time

DMS

 Warning range:
 Critical range:
 May correlate:

Mode:

H

Type:
Processor Time

SQL Server

 Warning range:
 Critical range:

 May correlate:
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Section

Metric

Description

Mode:

H

Type:
Data Movement
Read/Writer
Buffers

Sender Queued
Buffers

 Warning range:
 Critical range:
 May correlate:

Mode:

H

Type:
Data Movement
Read/Writer
Buffers

Writer Queued
Buffers

 Warning range:
 Critical range:
 May correlate:

Mode:

H

Type:
Distribution
Activity

Data Movement
CPU (ms)

 Warning range:
 Critical range:
 May correlate:
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Section

Metric

Description

Mode:

H

Type:
Node Activity

Data Movement
CPU (ms)

 Warning range:
 Critical range:
 May correlate:

Mode:

H

Type:
Distribution
Activity

Elapsed Time
(ms)

 Warning range:
 Critical range:
 May correlate:

Mode:

H

Type:
Node Activity

Elapsed Time
(ms)

 Warning range:
 Critical range:
 May correlate:
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Section

Metric

Description

Mode:

H

Type:
Distribution
Activity

Rows Processed

 Warning range:
 Critical range:
 May correlate:

Mode:

H

Type:
Node Activity

Rows Processed

 Warning range:
 Critical range:
 May correlate:

Mode:

H

Type:
Distribution
Activity

MB Processed

 Warning range:
 Critical range:
 May correlate:
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Section

Metric

Description

Mode:

H

Type:

Node Activity

MB Processed

 Warning range:
 Critical range:
 May correlate:

Mode:

H

Type:
Distribution
Activity

MB/Sec

 Warning range:
 Critical range:
 May correlate:

Mode:

H

Type:
Node Activity

MB/Sec

 Warning range:
 Critical range:
 May correlate:
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Section

Metric

Description

Mode:
Type:
 Warning range:
 Critical range:
 May correlate:
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Distributed Queries
Last Modified on 25 May 2021

Distributed Queries tab
View details of each Massively Parallel Processing (MPP) query. Filter, sort, and group historical information,
including query step details.

Active Requests Grid

The Active Requests grid displays active queries that are running at the time of collection in your Azure
Synapse environment. Each column header in the Active Requests grid provides you with detailed data about
your environment. See the following table for descriptions about these data metrics:

Default Column
header

Column Description

Command

Displays the Query command text for the active request.

Status

Displays the status of the active request (Completed, Active, Failed).

Login

Displays the login of the active request's user.
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Default Column
header

Column Description

Login time

Displays the corresponding login time for the active request.

Submit time

Displays the submittal time for the active request.

Queue Duration

Displays the amount of time the active request was in the query queue.

Compile Duration

Displays the amount of time taken for the active request to be compiled.

Execution Duration

Displays the time the active request spent actively using processor
resources.

Total Elapsed time

Displays the Total Elapsed time that the active request was running at the
time of data collection.

End time

Displays the end time of the active request.

Application

Displays the Application where the active request is running.

Label

Displays any label(s) associated with the active request.

Resource Class

Displays the resource class for the active request.

Client ID

Displays the Client ID of the active request.

SQL Spid

Displays the SQL Server process ID for the active request.

Transactional

Displays the database statements that are either entirely committed or
rolled back. For more information about transactions in SQL Data
Warehouse, see the Transactions MSDN article.

Error

Displays any associated error information for the active request.

Request ID

Displays the Request ID of the active request.

Session ID

Displays the Session ID of the active request.

Add additional columns to the Active Requests grid by right clicking the column header and then selecting
Column Chooser to open the Column Chooser.
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See the following table for additional columns that can be added in the Active Requests grid:

Optional Column

Column Description

End Compile time

Displays the time when the active request finished compiling.

ID

Displays the ID number of the active request.

Start Time

Displays the time when the active request began.

Completed Requests Grid
The Completed Requests grid displays the completed queries in your environment. Expand the Completed
Requests tab by selecting the arrow icon at the bottom of the grid.

Select the arrow to expand
Completed Requests Expanded

Each column header in the Completed Requests grid provides you with detailed data about your environment.
See the following table for descriptions about these data metrics:

Default Column
header

Column Description

Command

Displays the Query command text of the completed request.

Status

Displays the status of the completed request ( Completed, Active, Failed).

Login

Displays the login of the completed request's user.

Login time

Displays the corresponding login time for the completed request.
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Default Column
header

Column Description

Submit time

Displays the submit time for the complete request.

Queue Duration

Displays the amount of time the completed request was in the query queue.

Compile Duration

Displays the amount of time taken for the completed request to be
compiled.

Execution Duration

Displays the time the completed request spent actively using processor
resources.

Total Elapsed time

Displays the total time the completed request was running.

End time

Displays the time the completed request ended.

Applications

Displays the application(s) where the completed request was running.

Label

Displays any label(s) associated with the completed request.

Resource class

Displays the resource class of the completed request.

Client ID

Displays the Client ID of the completed request.

SQL Spid

Displays the SQL Server process ID for the completed request.

Transactional

Displays the database statements that are either entirely committed or
rolled back. For more information about transactions in SQL Data
Warehouse, see the Transactions MSDN article.

Error

Displays any error(s) associated with the completed request.

Error ID

Displays the Error ID associated with the completed request.

Request ID

Displays the Request ID of the completed request.

Session ID

Displays the Session ID of the completed request.

Add additional columns to the Completed Requests grid by right clicking a column header and then selecting
Column Chooser to open the Column Chooser.
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See the following table for additional columns that can be added in the Completed Requests grid:

Optional Column

Column Description

End Compile time

Displays the time when the completed request finished compiling.

ID

Displays the completed request ID number.

Start Time

Displays the time when the completed request began.

Request Steps Grid
The Request Steps grid displays the request steps of the selected completed query. Select a query in the
Completed Requests grid to display that query's steps.
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 Note: The Request Steps grid has the Group by box hidden by default. Unhide the Group by box by
right clicking the top of the grid and then selecting Show Group by box.

Each column header in the Request Steps grid provides you with detailed data about your environment. See
the following table for descriptions about these data metrics:

Default Column
header

Column Description

Step Index

Displays the step index number of the selected query.

Command

Displays the Query command text of the selected query.

Status

Displays the status of the selected query (Completed, Active, Failed).

Total Elapsed time

Displays the total time the selected query was running.

Operation type

Displays the operation category associated with the selected query.

Distribution type

Displays the distribution category associated with the selected query.

Location type

Displays the location category of the selected query.

Start time

Displays the time when the selected query began.

End time

Displays the time when the selected query ended.

Error ID

Displays any Error ID associated with the selected query.

Row count

Displays the number of rows processed by the selected query.

Request ID

Displays the Request ID of the selected query.
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Add additional columns to the Request Steps grid by right clicking the column header and then selecting
Default Column
Column Chooser.
Description
Column Chooser to open the Column
header

See the following table for additional columns that can be added in the Request Steps grid:

Optional column

Column Description

Appliance

Displays the name of the hardware and software product your environment
is using for analytical processing.

Command

Displays the Query command text for the selected query.

End time

Displays the time when the selected query ended.

ID

Displays the ID number associated with the selected query.

Start time

Displays the time when the selected query began.

Step Index

Displays the Step index associated with the selected query.

Time Zone Factor
Minutes

Utc offset

Displays the date and time of day for the query that is based on a 24 hour
time cycle with time zone awareness.

SQL Requests Grid
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The SQL Requests grid displays SQL request metrics for the selected completed query. Select a query in the
Completed Requests grid to display that query's SQL Requests.

 Note: The SQL Requests grid has the Group by box hidden by default. Unhide the Group by box by
right clicking the top of the grid and then selecting Show Group by box.

Each column header in the SQL Requests grid provides you with detailed data about your environment. See
the following table for descriptions about these data metrics:

Default Column
header

Column Description

Plan

Open the Plan diagram for the selected query.

Step index

Displays the SQL Step index associated with the selected query.

Remote Node ID

Displays the Remote Node ID of the selected query.

Distribution ID

Displays the Distribution ID of the selected query.
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Default Column
header

Column Description

Command

Displays the Query command text of the selected query.

Status

Displays the status of the selected query (Completed, Active, Failed).

Total Elapsed time

Displays the total time the selected query was running.

Start time

Displays the time when the selected query began.

End time

Displays the time when the selected query ended.

Error ID

Displays the Error ID associated with the selected query.

Row Count

Displays the number of rows processed by the selected query.

Spid

Displays the Service Profile Identifier associated with the selected query.

Add additional columns to the SQL Requests grid by right clicking the column header and then selecting
Column Chooser to open the Column Chooser.

See the following table for additional columns that can be added in the Request Steps grid:

Optional Column

Appliance

Appliance ID

Column Description

Displays the name of the hardware and software product your environment
is using for analytical processing.

Displays the Identification number for the appliance your system is using.
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Optional Column

Column Description

ID

Displays the ID of the selected query.

Request ID

Displays the Request ID of the selected query.

Time Zone Factor
Minutes

Utc offset

Displays the date and time of day for the query that is based on a 24 hour
time cycle with time zone awareness.

Additional Information
Grouping Queries
Group the queries in any grid by dragging a header into the Group by box. For more information about
grouping queries, see the Data Grids topic.

Sorting Queries by columns
Sort rows by ascending or descending order in any grid by selecting the arrow icon on the desired column
header. For more information about sorting queries in data grids, see the Data Grids topic.

Filtering Queries
Add a filter to any desired row by selecting the filter button. For more information about filtering queries, see
the Data grids topic.

Copying Queries
Copy query cells, rows, or all data by selecting and right clicking a query, and then selecting the desired option
from the context menu. For more information about copying queries in a data grid, see the Data Grids topic.

Additional Context menu options
Access the following additional context menu options by right-clicking a column header in any grid:

Context menu option

Description

Context menu
Image

Option applied
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Context menu option

Description

Sort Ascending

Sorts the selected
column by ascending
order.

Sort Descending

Sorts the selected
column by
descending order.

Clear Sorting

Clears the sorting
options for the
selected column.

Clear All Sorting

Clears all sorting
options for the
selected grid.

Group by this column

Groups the displayed
information by the
selected column.

Context menu
Image

Option applied
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Context menu option

Description

Show Group by box

Shows the group by
box for the selected
grid.

Hide This Column

Hides the selected
column.

Column Chooser

Opens the Column
Chooser. The
Column Chooser
provides additional
columns to sort
information.

Best Fit

Expands the
information for the
selected column.

Context menu
Image

Option applied
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Context menu option

Description

Best Fit (all columns)

Expands the
information for all
columns.

Filter Editor

Opens the filter
editor.

Show Find Panel

Opens the Find
Panel. Use this panel
to locate specific text
within your selected
grid.

Show Auto Filter Row

Opens the Auto Filter
Row. Use the Auto
Filter Row to add
specific filters within
your selected grid.

Context menu
Image

Option applied
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Using Jump to
Jump To takes you to any of the following four options when selecting any query on the Distributed Queries
tab:
Calendar
DMS Dashboard
Loads/Backups/Restores
Runtime Stats
To use the Jump to context menu option complete the following steps:
1. Select a query in any grid, and then right click the query to open the context menu.

2. Select Jump to > desired option from the context menu to open the desired option.

Jump to options
Jump to Option

Description

Jump to > Calendar

Opens the Event Calendar
view for the selected query.

Image
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Jump to Option

Description

Jump to > DMS Dashboard

Opens the Data Movement
Dashboard for the selected
query.

Jump to >
Loads/Backups/Restores

Opens the
Loads/Backups/Restores tab
for the selected query.

Jump to > Runtime stats

Opens a Runtime Statistics
graph for the selected query.
The Runtime Statistics graph
displays in history view by
default.

Image

History View

Aggregate View
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Loads/Backups/Restores
Last Modified on 06 May 2021

Loads/Backups/Restores tab
View information about both in-process and historical events through the Loads/Backups/Restores tab.

Loader Backup Runs Grid
The Loader Backup Runs grid displays data loads entering into the Azure Synapse target, as well as backups
and restores of the Azure Synapse target itself. Organize the displayed information to quickly correlate
performance activity in your Azure Synapse environment.

Loader Backup Run Details Grid
The Loader Backup Run Details grid displays detailed information about data loads entering into the Azure
Synapse target, as well as backups and restores of the Azure Synapse target itself. Organize the displayed
information to quickly correlate performance activity in your Azure Synapse environment.

Grouping Queries
For information about grouping queries in the Loader Backup Runs grid, see the Data Grids topic.

 Note: Hide the Group by box by right-clicking the Group by area, and then selecting Hide Group by
box from the context menu. Open the Group By Box by right-clicking a header, and then selecting Show
Group By Box from the context menu.
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Sorting Queries by Columns
For information about sorting queries by column, see the Data Grids topic.

Filtering Columns
For information about filtering columns, see the Data Grids topic.

Additional Context Menu Options
Access the following additional context menu options by right-clicking a column header in any grid:

Context menu option

Description

Sort Ascending

Sorts the selected
column by ascending
order.

Sort Descending

Sorts the selected
column by
descending order.

Context menu
Image

Option applied
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Context menu option

Description

Clear Sorting

Clears the sorting
options for the
selected column.

Clear All Sorting

Clears all sorting
options for the
selected pane.

Group By This Column

Groups the displayed
information by the
selected column.

Show Group by box

Shows the group by
box for the selected
pane.

Hide This Column

Hides the selected
column.

Context menu
Image

Option applied
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Context menu option

Description

Column Chooser

Opens the Column
Chooser. The Column
Chooser provides
additional columns to
sort information.

Best Fit

Expands the
information for the
selected column.

Best Fit (all columns)

Expands the
information for all
columns.

Filter Editor

Opens the filter
editor.

Context menu
Image

Option applied
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Context menu option

Description

Show Find Panel

Opens the Find
Panel. Use this panel
to locate specific text
within your selected
pane.

Show Auto Filter Row

Opens the Auto Filter
Row. Use the Auto
Filter Row to add
specific filters within
your selected pane.

Context menu
Image

Option applied

Using Jump to
Jump To takes you to any of the following options when selecting any query on the Loads/Backups/Restores
tab:
Calendar
DMS Dashboard
Distributed Queries
To use the Jump To context menu option complete the following steps:
1. Select a query in any grid, and then right click the query to open the context menu.

2. Select Jump To > desired option from the context menu to open the desired option.
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Jump To Options
Jump to Option

Description

Jump To > Calendar

Opens the Event Calendar
view for the selected query.

Jump To > DMS Dashboard

Opens the DMS Dashboard
with metrics for the selected
query.

Jump To > Distributed
Queries

Opens the Distributed
Queries tab with metrics for
the selected query.

Image

Copying Queries
Copy query cells, rows, or all data by selecting and right clicking a query, and then selecting the desired option
from the context menu.
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SQL Sentry Calendar & List Views
Last Modified on 22 November 2021

Introduction
Applies to: SQL Server, Windows, SSAS, Azure SQL Database, Azure Synapse Data Pool, and APS target
types. *Some features may not be available for all target types. Read further for more information.

Opening the Event Calendar
The SQL Sentry Event Calendar can be opened by selecting Open > Event Calendar from the context menu
of any applicable node in the Navigator pane. It can also be opened by double-clicking the instance and
choosing Event Calendar from the product selection form.
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Calendar View
The Calendar view is the default display in the workspace area. It combines both historical and future event
data to present an accurate visual representation of the schedule. Visual indicators highlight overlapping
active event instances, event status, and duration. Additional detail information is available by selecting the
pop-up windows. You can use drag-and-drop to reschedule future jobs or tasks to level a schedule, thus
minimizing contention between multiple events fighting for the same resources.
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The diagram highlights features of the Event Calendar, including the following:
Navigation Control

Date Bar

Recurring Events Pane

Current Time Bar

Too Many Data Indicators
identifier

Calendar Glyphs

Current Time Column

Pop-up Windows

To navigate to the Calendar view, double-click on any root, group, instance, source, object Event View, or
Custom Event View node in the Navigator pane.

 Note: The actual event instances displayed on the view vary depending on the node selected. For
example, if you select the Jobs node under a SQL Server, only jobs display; all other events
(maintenance plans, etc.) are filtered from the view, and only the Jobs tab is available in the
corresponding Event View filter.

Recurring Events Pane
This pane displays events that run frequently or long enough that they would clutter the calendar in the
current interval view. Exactly which events are displayed in the Recurring Events pane depends on the active
interval and the schedule frequency of the respective events. For example, future instances of a job that runs
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every five minutes is pinned to the recurring Events View when in a 24 hour interval, but is displayed on
the calendar in a one hour view. To determine how long events must run before showing in this window, go to
the Calendar tab in the User Preferences menu.

 Note: Events listed in the recurring pane don't register as conflicts with other events on the
calendar.

Calendar Context Menus
A Context menu is available for all event instances by right-clicking the instance in the calendar. The context
items displayed depend on the event source type of the selected instance.

Navigation Control
The navigation toggle button at the top left of the calendar allows you to move forwards and backwards
through the calendar.
Select the Up ▲ or Down ▼ arrows to move to the previous or next time interval . The Right ► or Left ◄
arrows move forward or backward one day, keeping the same interval and start time. The Plus + and Minus
- buttons are used to zoom in or out in the time ruler, one interval at a time, keeping the interval start time
the same.
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Date Bar
The Date bar shows the day of the week and date for each day displayed in the current view.

When in a Multi-day view, selecting any date on the Date bar makes that date active, highlighting the date.
Zoom into a single date by double-clicking the date on the Date bar. You can drill into any interval for one or
more days by double-clicking on the time ruler at the left of the calendar.

Time Ruler
On the left side of the calendar, a vertical time ruler shows the current time-range for the selected interval.
By default, hours are displayed. You can use the time ruler to zoom in or out to a desired time interval display.
When you hover over the time ruler, the ruler highlights a time-range. Double-click to zoom into the timerange. This is like selecting Zoom In, except that Zoom In doesn't change the start time.
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Current Time
The current time is displayed (when in view) with a horizontal red bar. The bar moves as the time changes.

Current Time Column
1305

To see the exact time, hover over the narrow column between the time ruler and the calendar or between
adjacent days.

Zoom In/Out
Use the calendar to zoom in or out to any time intervals. Right-click where there is empty space on the
calendar or on the time ruler to bring up the context menu. Select a time interval to zoom in and out.

Interval Buttons
Hover over the top or bottom of the time ruler, and pop-up arrows display that you can use to quickly move to
the previous or next interval, just like you can do with the Up ▲ or Down ▼ navigation control arrows.
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Event Instances on the Calendar
All event instances on the calendar appear with a rectangular block. Future instances don't include a run
status indicator bar.

Event Instances display the following information:
Start Time
Duration Bar
Run Status
Job Name
Step Details
Step details are accessible by selecting the bottom right corner of the event instance. By default, an event
instance background is white.
Default run status colors are as follows:

Color

Description

Green

Successful

Yellow

Warning

Red

Failed

Orange

Running

Black

Stopped

Glyphs
Glyphs are used to provide quick visual cues about event instances on the calendar, including their event
source type, queuing settings and status, block status, etc. Each instance contains at least one glyph
representative of its type that matches the icon shown in the Navigator pane for the source object.

1307

Other informational glyphs are listed as follows:

Item

Description
Advisory Condition indicator
Database and Fragmentation Manager indicator
Top SQL indicator
Procedure Stats indicator

Query Stats indicator

SQL Server Agent Job Watched indicator

SQL Server Agent Job Watched and Performance Monitored

SQL Server Agent Job Unwatched indicator

SQL Server Agent Job Disabled indicator
Task Scheduler Task Watched indicator

Task Scheduler Task Unwatched indicator

Task Scheduler Task Disabled indicator

SQL Server Agent Alert indicator
Windows Event Log indicator
Windows Task indicator
Blocking SQL indicator
Job actively being queued

Job can't be queued
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Item

Description
Job set to queue
Job actively queuing
Event instance or event object contains a note
Event instance was run as part of an event chain
Analysis Services Top Commands indicator
Deadlock indicator
Reporting Services Report indicator

Pop-up Windows
To view details for any event instance, select anywhere to the right of the duration bar to bring up a pop-up
window. The pop-up window reveals details about the instance, including the last step output, start and end
time, duration, runtime statistics, schedules, queuing settings, notes, etc. The actual data contained in the
pop-up window varies based upon the instances event source type. Clear the window by moving your mouse
away from the instance.

Highlighting Related Events
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The calendar provides several options for grouping events on the calendar. Right-clicking an event and
selecting Highlighting Options displays the applicable highlighting options for the event.

Once the highlight option(s) are chosen, similar events to the one selected are highlighted on the calendar.
The selected elements are persisted for all identical event sources across the installation. Using the Jump
To > Performance Analysis > Dashboard feature overlays each of the selected events on the Performance
Analysis Dashboard.
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Event Conflicts
A conflict is defined as two active event instances running on the same server at the same time. When an
instance's runtime (as indicated by the duration bar) overlaps with one or more other instances in the same
view, it's considered conflicting and its background color is orange, otherwise the background is white.
Resolve most conflicts by dragging-and-dropping future instances on the calendar. The amount of time
instances must overlap before showing as in conflict can be adjusted in User Preferences.

 Note: Events listed in the recurring window won't register as conflicts with other events on the
calendar.

The diagram above outlines the colors for several event instance statuses including:
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Running (Orange bar)

Conflicting (Orange container)

Successful (Green bar)

Failed (Red bar)

No Conflicts (White container)

Too Many Data Indicators
On very busy schedules, if too many event instances exist within a given range to display all of them in a
meaningful fashion, a small hashed box is shown on the right side of the pane. Hovering over the box shows a
tooltip with the number of additional events in that time period. Double-clicking the box zooms in so each
actual event can be seen. If conflicts exist within the specified range, by default the box displays in orange. A
filter can be applied to reduce the number of event instances on the calendar.

Selecting an Event Instance
Select any event instance on the calendar and it displays with a blue border on the top and bottom. All other
instances of the same object on the calendar change background color at the same time for easy reference.

Rescheduling by Dragging-and-Dropping
After you select a future job or task instance, move it to a different time slot by dragging-and-dropping the
instance. After you move an instance, you'll receive a confirmation dialog box. Select OK to confirm the move,
or select Cancel to return the instance to its original position.

 Note: This feature is disabled in the evaluation version of SQL Sentry.

Viewing Step Details
To view full step details for an event instance, select the small gray triangle in the lower right corner of the
instance, and the Step Callout window appears. Move the window by selecting the gray bar at the top, and
resize it by selecting the small dashed triangle in the lower right corner. Event instances that don't contain
steps, such as status events or Windows tasks, don't have a step callout button.
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Open the Event Instance Step Details

Event Instance Step Details displayed

List View
To view event history in a list format, select List from the View toolbar. The list view shows all event data that
would otherwise be displayed on the calendar but in a list format. Select the [+] icon to expand and view the
full step details for the event, if any exist. Failed instances are highlighted in red.

 Note: The History List view for one day is opened by pressing CTRL + ALT + H when an applicable
object is selected

Split View
Show both the Calendar view and the List view simultaneously by selecting Split from the View toolbar.
When you select an event instance on the calendar, it's auto-selected in the List window and vice versa.
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Grouping and Sorting
You can drag-and-drop any column heading into or out of the area directly above the List view to change the
active grouping. Select any column heading to sort by that column.
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SQL Sentry Custom Event Views
Last Modified on 22 November 2021

Introduction

Custom Event Views are used to tailor views to display and monitor specific activity across the enterprise.
For example, to monitor all backup jobs across all your servers to determine if there's contention for a backup
device, you can easily bring up that specific information to your Calendar view and drag-and-drop those jobs
to level your backup schedule or view performance information. After you set up a Custom Event View, it
operates like other views selected from the Navigator pane. Custom Event Views may also be set as the
Default View when the SQL Sentry client starts by right-clicking the View node and selecting the appropriate
context menu item.

Additional Information: See the Creating Custom Event Views in SQL Sentry blog post for more
examples.

Viewing New Custom Event Views
To see new Custom Event Views created by other client users, right-click on the Shared sub-node, and then
select Refresh.
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From the Navigator pane, expand the Event Calendar node. This provides the Local and Shared sub-nodes.
Local Views are only available to the user that created them. Shared Views are available to any user on any
SQL Sentry client. The setup of the view is the same for either option.
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Adding New Custom Event Views
Add a new Custom Event View by double-clicking on the Local or Shared node or selecting New from the
context menu. This brings up the Add a Custom Event View window in the workspace. The Creator field is
already populated with your username and is non-editable.
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Complete the Name and Description fields with information that's relevant to anyone who uses the view.

Adding Instances
Choose Select Instances to add objects that are included in the view. The top box allows you to select by
individual instances. Additionally, it allows you to specify all instances of a specific type. The middle box
allows you to select entire SQL Server groups. The bottom section allows you to filter for specific objects
from those instances. This specifies which objects are monitored by performance counters in this view.
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 Important: Instance text filters directly control which event objects in the view will be available for
monitoring when performance monitoring is enabled for a view, versus the General tab text filters which
control only which objects are displayed on the active Calendar/List view. Instance text filters are always
applied first, before General text filters. It's very important to ensure the Instance-level text filters are
set properly to avoid monitoring other objects unnecessarily. For more information, see the Filtering
Process topic.

Select OK to save your instances and to return to the View Configuration window. The box next to
Select Instances verifies that instances are now assigned to this view.

Selecting Objects
Choose Select Individual Event Objects to select additional individual objects to view.
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The Select Individual Events Objects window has three sections. Use the top section to search for objects by
type, object name, or step text. Once the criteria are entered, select Search and the results are populated in
the middle Search Results section.
Add an object by selecting the object in the Search Results section. The Selected Objects section shows
what objects are included in the view.
Select OK to save your selections and to return to the View Configuration window. The box next to Select
Individual Event Objects verifies that objects are now assigned to this view.
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Selecting Event Sources
Choose Select Event Sources to open the Select Event Sources window and define which event sources will
be associated with your custom view. For example, if you only wanted SQL agent Jobs in the view, ensure that
the Show checkbox is checked next to SQL Server Agent Jobs and the remaining sources in the box are
unchecked. You also have the option of selecting specific objects or categories when available.
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Setting Filters
Select Set Filters to select specific filters to apply to the view. The filter tabs are restricted by the instance
types selected previously and the event sources available on those instances. For example, if Reporting
Services doesn't exist on any selected instances, the Reports tab doesn't display.
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 Important: General tab text filters are used only to control which event objects are displayed on the
active Calendar/List view. They don't affect which objects are available for monitoring when
performance monitoring is enabled for a view; this is directly controlled by the instance text filters that
are always applied before the general text filters. For more information, see the Instances and Filtering
Process topics.

After configuring your filter settings, select OK to save and return to the View Configuration window. The
box next to Set Filters verifies that the filter is set for this view.

Saving Your View
Select Save on the toolbar to save your view.

Your new view is added in the Navigator pane. Double-click on the view to open it, or expand the node to add
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Performance Counters.

Adding a Performance Counter
Select the desired Sample View sub-node, and then double-click or right-click Performance Counters. The
Add Performance Counters window appears. Set the following parameters, and then select Connect.
The Performance Counter appears in the list.

Saving View as a Menu Item
Another way to create a Custom Event View is by selecting Save View As under the File menu. Anytime a
Calendar view is active that contains the instances and filter settings you'd like to save for a Custom Event
View, go to File > Save View As. You'll be asked for a name and optional description for the view. You may
also check the box to make it public. This places it under the Shared node in Custom Event Views for use in
any SQL Sentry client.
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 Note: If a view has Performance Monitoring enabled, using Save View As doesn't transfer
Performance Counter settings to the new view.

Creating a new shared Custom Event View triggers an Audit: Custom Event View: Created condition.
Deleting and/or modifying existing shared Custom Event Views also triggers similar Audit: Custom Event
View: Deleted or Audit: Custom Event View: Modified conditions in SQL Sentry.

Organizing Custom Event Views
Both Local and Shared Custom Event Views can be organized using custom folder names. Create a folder by
selecting New Folder from the context menu on the Shared or Local nodes. Once folders are created, views
can be moved between folders by dragging and dropping the view into the desired folder.
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SQL Sentry Event Architecture
Last Modified on 06 July 2021

The concepts and terminology covered in this section are important for a full understanding of SQL Sentry
software.
Earlier versions of SQL Sentry focused primarily on SQL Server agent jobs; however, this is no longer the case.
Event manager's new Event Connector Architecture now enables monitoring and management of different
types of scheduling systems and various types of jobs, tasks, and status events.
This necessitated some dramatic changes to both our system architecture and terminology. As a result,
throughout this guide more generic terms such as event store connection and event object (or simply
connection and object) are used where before references to SQL Servers or jobs were used. The following
topics cover these architectural and terminology changes in detail.

Event Connector Architecture
SQL Sentry's Event Connector System encompasses the entire process by which SQL Sentry collects historical
and active status information from various event stores, and translates the data into the calendars, lists, and
graphs in the SQL Sentry client. The data collected is also used to trigger the various actions carried out by the
SQL Sentry monitoring service, such as sending email notifications.
Execution agents trigger execution engines that write data to event stores. There are many different types of
agents, engines, and stores, and it's important to remember that this process isn't new, and isn't something
we invented. However, SQL Sentry's primary focus is collecting data from the respective stores, translating it,
correlating it, rendering it in a meaningful fashion to the DBA, and enabling automated actions based upon it.
We've had to define some terms that abstract these components to make the process by which SQL Sentry
collects and uses this data more understandable. Creating new terms isn't something we do for fun, but
rather something we've had to do here simply because all other existing enterprise schedulers utilize their
own proprietary execution agents and engines. Because they don't wrap other agents and engines as we do,
there probably wasn't much of a need for these terms before now.
We believe our agent-less approach is superior to the proprietary scheduling agent approach employed by
enterprise schedulers in many ways, including significantly reduced installation, configuration, and
maintenance overhead, as well as the ability to integrate with systems such as the SQL Server agent in a much
more native fashion. For example, we don't work with SQL agent jobs from the command line using
osql.exe as other schedulers do, instead we talk directly to SQL Server in its native languages (DMO, SMO,
ADO.NET, etc.). In general, we let existing scheduling agents do what they do best, schedule jobs and tasks,
and we don't try to replace them.
The part of the process that's proprietary to SQL Sentry is how it uses event providers to access and translate
the event store data over event store connections into the event objects used by the SQL Sentry client and
Server. We aren't just dealing with SQL agent jobs any more, so we've had to come up with a few terms to
abstract these components to make them more understandable and manageable. It's important to note that
SQL Sentry is a 100% .NET-based application, so this object-oriented approach is very much in line with how
we've designed the software, and in many ways these concepts and terms are descended from it.
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Execution Agents
Execution agents represent any process responsible for the execution of one or more execution engines.
There are two types of execution agents: schedulers and ad hoc.

Schedulers
Schedulers trigger execution engines on an automated basis at predetermined times and/or intervals. There
are many different types of scheduling agents; there are those like SQL agent and task scheduler that can be
used by anyone to schedule jobs and tasks. There are also proprietary schedulers. These are schedulers that
exist as part of some application but don’t operate as standalone schedulers, and therefore can’t be used to
schedule tasks unrelated to the application itself. Many anti-virus systems, disk defragmentation systems,
and network backup systems fall into this category.
The schedulers that SQL Sentry is most interested in are those executing tasks that can impact SQL Server
performance and have dependency relationships with other SQL Server-related jobs or tasks.
Schedulers always have job (or task) history logs that record data such as start time, end time, duration, and
job output. If the Scheduler allows ad hoc (unscheduled) execution of its jobs, this is also normally logged.
Examples of this are manually executed SQL agent jobs and Windows task scheduler tasks that are written to
the respective history logs just as scheduled executions are.
The SQL Server agent isn't only a scheduling agent, it has job subsystems that manage job steps and
schedules, but it also contains an alert engine that detects various conditions of the SQL Server process and
performance counters, and it can auto-restart a failed SQL Server agent or SQL monitoring service.
Schedulers sometimes have their own separate logs that record general information, errors, or warning
conditions not necessarily related to jobs. A good example of this is the SQL Server agent log. Unlike the SQL
Server agent, the Windows task scheduler doesn't have its own log, only a task history log. In the case of the
SQL Server agent, SQL Sentry collects data from both the SQL Server agent log itself as well as its job history
log.

Ad Hoc
Non-scheduled executions are triggered by ad hoc agents, which include users and response-based systems.
When a user executes a job manually, it's considered an ad hoc execution. Likewise, when some other active
process detects a transient condition in the environment and triggers an execution engine, it's considered a
response-based ad hoc execution.
SQL Sentry is a great example of a response-based system; it's able to detect various conditions related to
event sources and trigger a variety of pre-defined actions in response. For more information, see the Alerting
and Responses Overview topic.
In the case where a user executes an engine directly, there are no scheduler logs, and SQL Sentry is
dependent on the engine’s own execution logs if they exist. If the engine doesn't log or support active status
queries from an API or other interface, then SQL Sentry can’t do anything with it; we can’t show the event
instances on a calendar, trigger conditions, and actions, and/or monitor performance for the event. An
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example of this is an SSIS package that is run from within SSMS without package logging enabled, or a
manually executed VBScript (.vbs) file that doesn’t perform any logging.
The most important point to remember regarding execution agents is that if the scheduler and/or the
execution engine logs event data, and/or either allows active status queries, then SQL Sentry can work with it.

Execution Engines
An execution engine is a name for any application or program that does some type of work, typically
background processing. Examples include the following:
SQL Agent Jobs
sqlmaint.exe—The executable responsible for SQL agent maintenance plan functions.
ReportServer service—A Windows service that processes Reporting Services reports and produces
associated output.
Task Scheduler—A Windows service responsible for running tasks.
Disk defragmentation software—An executable that defragments logical disk drives.
Anti-virus software—An executable that scans a system for viruses.
One of the primary differences between execution engines and other programs is that they usually run as
background processes, meaning they quietly go about their work without any significant user interface or user
interaction. Execution engines aren't like UI-driven productivity applications like Microsoft® Word ® or Excel ®.
Most execution engines throw off status information, typically in the form of an execution log. This element is
key for many of the functions of SQL Sentry, including notifications, chaining, queuing, etc. If an execution
engine doesn't log status information to its own execution log, then SQL Sentry defaults to use the logs of
the associated scheduler. The fact that it doesn't have an execution log doesn't mean that it's not an
execution engine, just that for SQL Sentry’s purposes there isn't much that can be done with it; we need some
type of execution log data with an associated provider to show the event instance on the calendar, trigger
conditions and actions, monitor performance, etc.

Event Stores
An event store is a collection of like event instances kept in a common location, typically a database or filebased storage. Some examples are shown in the following table:

Event Provider

Provider Type

Event Type

Event Store

SQL Server Agent

Scheduler

Status

File Storage

SQL Server Agent Job

Execution Engine

Active

SQL Server Database
(MSDB)
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Event Provider

Provider Type

Event Type

Event Store

Windows Task
Scheduler

Scheduler

Active

Windows API + FIle
Storage

Windows Event Log

Event Log

Status

Windows API

Event Logs
Event logs are a type of event store that hold only status event instances. The Windows event logs, SQL
Server logs, and SQL Server agent logs are examples of event logs.

Event Store Connections
An event store connection, usually referred to as a connection, is used by event sources to access data in
event stores from some network transport mechanism.
In the SQL Sentry client, each SQL Server and Windows Instance node represents a single connection.
For example, the previous jobs event source utilizes the SQL Server agent job event provider over an
ADO.NET connection to the SQL Server to access event data stored in the MSDB database.
For maximum efficiency and performance, SQL Sentry allows a connection to be shared by multiple event
sources simultaneously; all event sources under the SQL Server Instance node above (jobs, maintenance
plans, alerts, reporting services, and SQL agent log) utilize the same physical network connection. This
concept is illustrated in more detail in the following Enterprise Architecture Diagram.
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Configuring Instance Level Settings
Whenever you select an Instance node in the Navigator pane, the Conditions and Settings pane
automatically refreshes to display all conditions, actions, and settings for the selected instance. Any changes
made here apply to the selected instance only, overriding any globally configured settings.

1332

Instance level settings can be overridden at the object level by selecting an Object node in the Navigator
pane.
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Event Providers
An event provider is a module that enables SQL Sentry to communicate with and translate data from an event
store over an event store connection into a common format that can be used by the various parts of the SQL
Sentry system, including calendars, graphs, and notifications. A SQL Sentry event provider is analogous to an
OLEDB provider or ODBC driver. There are three types of event providers: schedulers, execution engines, and
event logs.

Event
Provider

Description

Scheduler

Enables interfacing with the native scheduler logs, such as for SQL Server agent or
Windows task scheduler.

Execution
Engine

Connects with the native stores for execution engines for collecting historical
information and active status information if supported by the provider. Not all
providers support active status queries.

Event Log

Enables translation of status event data contained in log-type stores, such as for the
SQL agent alert log or the Windows event log.
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SQL Sentry Providers
Event Provider

Provider Type

SQL Server Agent

Scheduler

SQL Server Agent Job

Execution Engine

SQL Server Agent Alert

Event Log

Maintenance Plan

Execution Engine

Reporting Services

Execution Engine

Window Task Scheduler

Scheduler

SQL Sentry uses a plug-in architecture that allows future modules to be added on, typically without requiring
the installation of a new version of the SQL Sentry software.
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SQL Sentry Event Objects
Last Modified on 22 November 2021

At a high level, an event object is any job, task, or other event type that can be managed using SQL Sentry.
There are two general types of events: active event objects and status events. The two are actually
completely different, with the exception that their event instances occur at some measurable point in time,
and therefore can be represented chronologically in Calendar and List views. A third sub-type is a hybrid
event object that contains some characteristics of both active and/or status events.

Types of Event Objects
When you view a calendar in SQL Sentry, you'll see a combination of various types of active and status event
instances. Active event objects include SQL Agent jobs, maintenance plans, and reporting services reports,
along with Windows task scheduler tasks. Status events include SQL Agent alerts and SQL Agent log records.
Busy calendars can include some or all of these event types, so it's important to be able to differentiate them
to make the most of the information presented. The SQL Sentry client indicates the type of event object using
a small glyph on each event instance, as well as in event instance pop-up windows.

Event Objects

Type

Instance Type

SQL Server Agent Job

Active

SQL Server

SQL Server Agent Alert

Status (hybrid)

SQL Server

SQL Server Agent Log Record

Status

SQL Server

Maintenance Plan

Active (hybrid)

SQL Server

Reporting Services Report

Active

SQL Server

Windows Task

Active

Windows

Windows Event Logs Event

Status

Windows

Active Event Objects
An active event object is commonly referred to as a job or a task, and contains all of the information
necessary to perform some measurable work. This can include instructions in some scripting language (T-SQL,
VBScript, etc.), connection information, configuration parameters, etc. Active events always have a start time
and an end time, (they have duration), and they are schedulable. SQL Agent jobs and Windows tasks are
examples of active event objects.

Status Events
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A status event represents the discrete occurrence of some condition of a process, usually a persistent process.
Status events don't have duration, they aren't schedulable, and they don't perform any measurable work. For
example, the SQL Server Agent log contains various status events given off by the SQL Server process at
specific points in time.

 Note: It's important to know that active event objects have runtime and performance graphs, as well
as runtime and performance conditions, while status events don't.

Status Event Objects
A status event object is any status event that is predefined and/or configurable, such as a SQL Server Agent
error condition. Most entries in the SQL Agent logs are instances of a status event object.
For example, an attempt was made to send an email when no email session was established.
Although this event object isn't configurable, it represents an error condition that is predefined and static.

Ad Hoc Status Events
Not all status events can be pre-defined; for example, an ad hoc message for a transaction log backup
recorded in the SQL Server log:

Log backed up: Database: Northwind, creation date(time): 2004/07/27(11:51:24), first LSN:
238:292:1, last LSN: 238:292:1, number of dump devices: 1, device information: (FILE=1,
TYPE=DISK: {'D:\Program Files\Microsoft SQL Server\MSSQL\BACKUP\
In this case, a discrete status event is logged as the result of some process, but it doesn't specify a start or end
time, nor is the output constant, i.e., it changes every time. It's also not entirely pre-defined nor is it
configurable; therefore we consider this an ad hoc status event.

Hybrid Event Objects
Hybrid event objects are those that don't necessarily fall cleanly into the active or status event categories.
For example, a SQL Agent maintenance plan is an active event object that is comprised of several other active
event objects; SQL Agent jobs. The plan itself doesn't do any work, the jobs do; they handle the various
activities associated with the plan such as backups, optimizations, etc. In this case, the jobs act as surrogates
for the plan itself. The plan does, however, contain configuration information, as well as an execution engine
and log, and its associated jobs do work and have duration. Therefore, we consider the plan a variant of an
active event object. If it didn't have its own configuration info or execution log, it would simply be a collection
of jobs.
A SQL Agent alert is a variant of a status event object. Alerts can be triggered by various conditions of the SQL
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Server process, such as a full transaction log, a corrupt database, etc. The SQL Server logs a status event to
the Windows application log, then the SQL Agent picks it up and fires any defined alerts that match the
condition. Although alerts don't have their own log, when they fire SQL Sentry is able to capture the output
as a discrete status event instance and log it to a table in MSDB, effectively an event log. SQL Agent alerts are
more of a tool for the DBA to define the events that they want to be notified or take some other action; they
aren't really status event objects in the strictest sense. For our purposes, it helps to think of them that way.

Event Instances
An event instance is any individual historical or future occurrence of an active event object or status event.
Event instances correlate to the rectangular placeholders displayed on a SQL Sentry calendar, or the master
records shown in a list view. An individual execution of a SQL Agent job represents an active event instance.
Every occurrence of a SQL Agent error in the SQL Agent logs is an individual status event instance.

Event Object Information Window
When you right-click any event object in the Navigator pane, and then select Open or double-click an event
instance on the Calendar view, Navigator pane, or Runtime Graph, a tab for the event object's Information
Window appears. The window contains various metadata about the object, and the information displayed
changes based upon the type of object.

The active event objects, runtime statistics, and the Calculate Runtime Statistics Since option are shown, as
well as schedules for objects that may be scheduled such as jobs, tasks and reports. Tasks include additional
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data like the option to define a success exit code.

Recalculating Runtime Statistics

On the information window for all active event objects, you'll see the Calculate Runtime Statistics Since
option. Use this feature whenever a major change is made to an event definition that may cause its typical
runtime to increase or decrease dramatically. An example might be removing a long-running step from a job.
Re-calculating runtime statistics in this case can help avoid erroneous notifications for changes in minimum or
maximum runtime. Check the box next to Calculate Runtime Statistics Since, and enter the date and time
the event was changed, and then select Save on the toolbar. This causes SQL Sentry to immediately
recalculate runtime statistics using only run history since the specified date/time. This value is also used
whenever the SQL Sentry monitoring service auto-calculates statistics for the event in the future.
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SQL Sentry Event Sources
Last Modified on 22 November 2021

An event source represents a unique instance of an event provider operating over a single event store
connection. In SQL Sentry's Navigator pane, every sub-node underneath a SQL Server node represents a
unique event source.
The following is a listing of all event sources currently supported by SQL Sentry, along with their associated
event objects, providers, and instances:

Item

Navigator Node

Event Provider

Instance Type

SQL Server Agent Jobs

Jobs

SQL Server Agent
Job

SQL Server

SQL Server Agent
Alerts

Alerts

SQL Server Agent
Alert

SQL Server

SQL Server Agent Log

SQL Server Agent
Log

SQL Server Agent

SQL Server

Maintenance Plans

Maintenance Plans

Maintenance Plan

SQL Server

Reporting Services
Reports

Reporting Services

Reporting Services

SQL Server

Windows Tasks

Tasks

Window Task
Scheduler

Windows Instance

Windows Event Logs

Windows Event Logs

Windows Event Log

Windows Instance

SQL Server Agent Jobs
SQL Server agent jobs are listed for each SQL Server instance under the Jobs node. Expand the node to view
the list of jobs, or select the node to view a calendar for all jobs. The SQL Server agent job event provider is
used behind the scenes to access job metadata, history, and active status information.
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Using the SQL Sentry client, perform all the same tasks related to jobs that you'd previously do with SSMS,
plus more features such as visual scheduling, performance monitoring, reporting, queuing, and chaining.

SQL Server Agent Alerts

SQL Server agent alerts are listed for each SQL Server instance under the Alerts node. Expand the node to

1341

view the list of alerts, or select the node to view a calendar for all alerts. The SQL Server Agent alert event
provider is used to access alert metadata and history information.
SQL Sentry supports SQL Server Agent event alerts, but SQL Sentry can be configured to alert you on SQL
Server agent WMI event alerts. Additionally, SQL Sentry can alert you about general performance conditions.

 Note: To enable the server alert collection and notification without the use of agents on each SQL
Server, SQL Sentry must install the SQL Sentry alert trap and one small table

msdb.dbo.SQL_Sentry_AlertLog_20 on each watched server, and store the procedure
msdb.dbo.spTrapAlert_20.

SQL Sentry must also make a minor configuration change to each server alert to enable alert collection and
notification; the Execute job setting updates to use the SQL Sentry Alert Trap job. If an alert is already set
to execute another job, the Execute job settings for that alert doesn't update, and SQL Sentry is unable to
generate notifications for the alert.
One of the most common reasons the Execute job setting may already be set to a job is for logging and/or
notification purposes, in which case SQL Sentry may be able to safely assume control of this function. Some
of the advantages instead of using SQL Sentry are that its logging and notification processes are centralized
versus distributed on each server. They aren't MAPI-dependent, and they can easily be made redundant by
using more than one SQL Sentry monitoring service.
For a complete list of objects SQL Sentry places on a watched server, see the Watched Server Objects topic.

 Note: To watch alerts on SQL Server 2005 and above instances, token replacement must be enabled
for the SQL Server agent. This is disabled by default as a security precaution. Configure SQL Sentry to
auto-enable SQL agent tokens at the global and instance level.

Additional Information: For more information about the token replacement setting for the SQL Server
agent, see the SQL Server Books Online.

Reporting Services Reports
If a reporting services database exists on a SQL Server, the Reporting Services node displays under the SQL
Server agent node, under which all reports are listed by name. Expand the node to view the list of reports, or
select the node to view a calendar for all reports. The reporting services event provider is used to access
report metadata and history information.
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For scheduled reports, Reporting Services jobs are listed under the Jobs node using a combination of the
report name and schedule type. Not all reports have schedules, and some reports have multiple schedules, so
the associated object nodes shown under Jobs and Reporting Services nodes may not match exactly. Shared
report schedules are listed under the Jobs node.
Reports are displayed on the Calendar pane by a friendly name and offer many details through their pop-up
window.

SQL Server Agent Log
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The SQL Server Agent Log node is listed under each SQL Server Instance node. Select the node to view a
calendar for all SQL Server agent events. The SQL Server agent event provider accesses historical information
through the event calendar.

Windows Tasks
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SQL Sentry supports the task scheduler event source for Windows targets. Windows tasks are listed for each
Windows instance under the Tasks node. Expand the node to view the list of tasks, or select the node to view
a calendar for all tasks. The Windows Task Scheduler event provider is used behind the scenes to access task
metadata, history, and active status information.

 Important: Windows Vista introduced Task Scheduler 2.0. Task Scheduler 2.0 is backwards compatible
with Task Scheduler 1.0; however, Task Scheduler 1.0 is not forwards compatible with Task Scheduler 2.0.
For this reason, to watch or synchronize Task Scheduler 2.0 connections, you need a SQL
Sentry monitoring service and SQL Sentry client running Windows Vista or higher. Windows 8 and
Windows 2012 also introduced changes to the Task Scheduler. To watch or synchronize Windows 8 and
Windows Server 2012 instances, you need a SQL Sentry monitoring service and SQL Sentry client running
Windows 8 or Windows 2012.

Some task scheduler tasks don't return zero for success. In these cases, SQL Sentry may misinterpret this nonzero exit code as a task failure. To prevent these false negatives, specify an exact text string that SQL Sentry
recognizes as the success code for that particular task. Select on the task in the Navigator pane, and then
enter the value next to Exit code if task was successful.

Specifying Non-zero Success Codes for Windows Tasks
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 Note: Occasionally, Windows tasks may show as running even after they have completed. For this
reason, while a task is running, the Close Running Event context menu item is available to manually
close this event. This menu item should only be used when you're sure the task has completed, but
shows as running in SQL Sentry.

Windows Event Logs
SQL Sentry includes the Windows event logs event source for Windows targets. The monitoring of the
Application, Security, and System event logs is supported. When you monitor a Windows instance the
Application and System logs are initially watched. If you'd like to monitor the Security log, select Watch
Windows Event Log from the Security node's context menu.
The Windows event logs source has a default History Filter in place. The default filter is tailored to capture
information about both SQL Sentry and SQL Server. With the History Filter, define rules that control exactly
what types of events the monitoring service writes into event history concerning the Windows event logs. If
an event doesn't meet the criteria you've defined in the History Filter, information about that event isn't
written to your SQL Sentry database. Change the filter to best fit your environment.
The Windows event logs History Filter can be accessed in the Settings pane as follows:
1. Select the Windows Instance node in the Navigator pane.
2. Open the Settings pane (View > Settings).
3. Select Windows Event Logs Source from the drop-down menu.

 Note: Monitoring the Windows event logs is supported for Windows Vista or higher.
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SQL Sentry Event Chains
Last Modified on 22 November 2021

Introduction

An event chain is a series of dependencies between events running on the same server or different servers.
There is no limit to the length of a chain or the number of events that can be defined for a chain. To navigate
to event chains, select the Event Chains node from the Navigator pane.

Item

Description
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Item

Description

Name

Contains the name of the event chain. This also is the value displayed in the tree
view under the Event Chains node.

Description

Descriptive text for the event chain.

Created by

Displays the chain creator and the date/time of chain creation.

Updated by

If the chain is updated, displays the updater and date/time of update.

Select Chain
Instance

Use this drop-down list to select a past runtime for the chain to view its history.

End Time

When viewing a historical chain instance, this shows the time the chain
completed.

Status

Displays the status of the chain being viewed as Ready, Running, or Completed.

Chain Enabled

Option to enable or disable the event chain.

Edit

To add nodes or make changes to a chain, select this button.

Cancel

Cancels adding an event chain.

Auto refresh

Determines how often the chain workspace refreshes to show updated
information when the chain is currently running.

 Note: Only the initial job of the event chain needs to be scheduled for the chain to run.

Event Chain Examples
Example A
When Job1 (SQL Server job) completes, execute Job2 (SQL Server job). If Job2 succeeds, execute Task A
(Windows Task Scheduler Task). If Job2 fails, execute Job3.
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To accommodate a path that encompasses the same event more than once, and to avoid a circular reference,
the concept of nodes are used. A node is simply a unique representation of an event. Even though Job1 is
listed twice, the chain can treat the event as two separate instances and apply varying conditions to each
instance that provides a greater degree of flexibility.

Circular References
An event chain is a logical workflow through a series of one or more event objects, with each occurrence of an
event object represented by a unique event node. A circular reference occurs if the workflow was built to
reference an event node a second time. Such a workflow is not allowed in an event chain.
For example, when Event A completes, execute Event C . When Event C completes, execute Event A .

To allow an event to occur a second time in an event chain, add the object Event A a second time to the object
list. Change the To Node in the second link to reference the newly created node. This method can be
repeated to allow the event to occur a discrete number of times.
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Adding an Event Chain
1. Double-click the Event Chains node in the Navigator pane, or select New in the context menu.

2. Assign the event chain a name and optional description.

3. Right-click to add objects that are used in the event chain, or drag-and-drop jobs from the
Navigator pane onto the Event Chain diagram. Node names are given to each object.
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4. Add links to the chain by right-clicking the appropriate node, and then select Workflow.

5. Select the status condition for execution and the Target node. Nodes can be dragged and dropped to
reposition for easier viewing of the chain. The Auto Layout toolbar button may also be used once links
are established.
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6. Select Save in the File menu or select the Save icon

to save the chain.

Editing an Event Chain
1. Select the Event Chain node from the tree view in the Navigator pane, and then select Edit.

2. Select the necessary properties of the event chain.
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3. Select Save in the File menu to save the chain.

Remapping Nodes in an Event Chain
Event Chain nodes can be remapped to other event objects. This can save you time over deleting and
recreating nodes in your event chain. When you remap a node in an event chain, the next step(s) in the
workflow remain intact. To remap a node, select Remap Node available through the node context menu.
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 Important: If any Event Chain nodes or workflow steps are changed, including the remapping of a
node, the history for the chain becomes invalid and is lost.

Chain History
To view a historical run of a chain, select the runtime from the Select Chain Instance box. Runtime and status
information is displayed for each node. If the object is completed successfully, it has a green background. If it
fails, it has a red background. This is also shown for currently executing chains. Currently executing nodes
have an orange background.

Context Menus
Navigator Pane
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Item

Description

Open

Opens the event chain.

Edit

Opens the event chain in edit mode.

Start Chain

Starts all lead nodes of this event chain.

Stop Tracking Node
Failures

Stops tracking any node failures.

Delete

Deletes the chain.

Reset

Resets a currently running chain.

Disable

Disables the chain.

Change Folder

Allows you to move the specified chain to a different organizational folder.

View Mode
Workspace
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Item

Description

Refresh

Refreshes the current view. Also done by
pressing F5.

Print

Prints the chain diagram.

Print Preview

Previews the printed chain layout.

Zoom >

Zooms in or out to view entire chain.

Node - Chain Instance
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Item

Description

Execute Node

Allows you to manually run a node in a chain. If the node is a lead node for a
chain, then any child nodes are executed upon completion. No child nodes
start if the node being executed is not a lead node.

Jump To >
-- This Instance

Brings up a calendar displaying the selected node's current instance.

-- Last Failure

Brings up a calendar displaying the last failure for the selected node.

-- Last Instance

Brings up a calendar displaying the last instance of the selected node.

-- Next Instance

Brings up a calendar displaying the next instance of the selected node.

-- Navigator

Navigates to the selected node in the Navigator pane.

Show >
-- History >
---- 4 Hours

Displays the last four hours of job history for the selected node.
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Item

Description

---- 1 Day

Displays the last one day of job history for the selected node.

---- 3 Days

Displays the last three days of job history for the selected node.

---- 7 Days

Displays the last seven days of job history for the selected node.

---- 14 Days

Displays the last 14 days of job history for the selected node.

---- 30 Days

Displays the last 30 days of job history for the selected node.

-- Runtime Stats

Shows the current runtime stats for the selected node.

Properties

Views the properties of the object.

Node - Historical Chain Instance
Item

Description

Execute Node

Allows you to manually run a node in a chain. If the node is a lead
node for a chain, then any child nodes is executed upon
completion. No child nodes starts if the node being executed is not
a lead node.

Jump To >

-- This Instance

Brings up a calendar displaying the selected node's current
instance.

-- Last Failure

Brings up a calendar displaying the last failure for the selected
node.

-- Last Instance

Brings up a calendar displaying the last instance of the selected
node.

-- Next Instance

Brings up a calendar displaying the next instance of the selected
node.

-- Navigator

Navigates to the selected node in the Navigator pane.

Show >
-- History >
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Item

Description

---- 4 Hours

Displays the last four hours of job history for the selected node.

---- 1 Day

Displays the last one day of job history for the selected node.

---- 3 Days

Displays the last three days of job history for the selected node.

---- 7 Days

Displays the last seven days of job history for the selected node.

---- 14 Days

Displays the last 14 days of job history for the selected node

---- 30 Days

Displays the last 30 days of job history for the selected node.

-- Runtime stats

Shows the current runtime stats for the selected node.

Start Chain Here

Allows you to execute a chain from a node other than a lead node.
When this option is selected, a new chain instance is created that
contains a copy of the nodes status for the instance you are
viewing.

Properties

Views the properties of the object.

Edit Mode
Workspace
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Item

Description

Add Nodes

Allows you to add new jobs or tasks as nodes in
the chain.

Save

Saves any changes to the chain.

Print

Prints the chain diagram.

Print Preview

Previews the printed chain layout.

Auto Layout

Organizes and arranges the chain into a default
flowchart pattern.

Zoom >

Zooms in or out to view the entire chain.

Node
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Item

Description

Workflow

Allows you to specify the condition on which one node executes
another.

Rename Node

Renames the node. This doesn't rename the actual job or task.

Delete Node

Deletes the existing node from the chain.

Remap Node

Remaps the node.

Properties

Views the properties of the job or task.

Event Chain Notifications
General Actions
Condition

Fired When

Event Chain: Started

Any lead node for an event chain has completed.
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Condition

Fired When

Event Chain: Completed

After last node in an event chain has completed.

Event Chain: Success

Every node in an event chain runs.

Event Chain: Failure

One or more nodes in an event chain don't run.

Event Chain: Runtime Threshold
Max

The event chain runtime exceeds the Maximum Runtime
Threshold settings specified for the event chain.

Event Chain: Runtime Threshold
Min

The event chain runtime exceeds the Minimum Runtime
Threshold settings specified for the event chain.

Event Chain Node: Started

The Event Chain node starts.

Event Chain Node: Completed

The Event Chain node completes.

Event Chain Node: Success

The Event Chain node completes, reporting a success.

Event Chain Node: Failure

The Event Chain node completes, reporting a failure.

Event Chain Node: Runtime
Threshold Max

The Event Chain node exceeds the maximum runtime
threshold specified for the node.

Event Chain Node: Runtime
Threshold Min

The Event Chain node exceeds the minimum runtime
threshold specified for the node.

When more than one workflow path exists in a chain, the Chain Success and Chain Failure conditions
become less valuable since they are based exclusively on whether or not all nodes completed. At that point
the Node Success and Node Failure conditions should be used for more accurate status information about
the respective nodes and/or paths.

Settings
Event chains and Event Chain nodes support Runtime Threshold settings. These settings are specified as
absolute runtimes for both the minimum and maximum runtime thresholds.
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Setting

Description

Inherit From Parent

Specified whether the Runtime Threshold
settings are inherited from the parent object.

Maximum Runtime Threshold

The maximum allowed runtime for the
chain/node.

Minimum Runtime Threshold

The minimum allowed runtime for the
chain/node.

Audit Actions
Condition

Fired When

Event Chain Modified

Modifications are made and saved to an event
chain.

Event View
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All event chains contain an Event View sub-node. Double-clicking or selecting Open from the context menu
produces a calendar of all the objects that are a part of the selected chain. As with any Custom Event View,
you have the ability to add Performance Counters to any Event Chain View.

Event Chain Calendar Info

All event source objects that appear on a calendar because of an event chain display a small chain glyph in the
top left corner.
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Additionally, the event source object tooltip displays information about any chain(s) that this object is
associated with. An * is placed next to the actual chain that created this instance.

Reporting Services Jobs in Event Chains
It is a known limitation that Reporting Services jobs don't work within chains in versions prior to 2.7. This
limitation occurs because Reporting Services jobs are filtered out of SQL Sentry as they have no duration and
don't reflect the accurate information about the report.
A workaround is available in version 2.7 and later. Normally, SQL Sentry filters out a Reporting Services job.
You can force them to stay in the history and alert chaining that they have completed by placing an additional
space after the AddEvent call.
For example, if you currently have:

AddEvent @EventType='Test', @EventData= '5B0537EA-7A87-4C8B-B002-03A51DD5100C'
You could change it to:

AddEvent @EventType='Test', @EventData= '5B0537EA-7A87-4C8B-B002-03A51DD5100C'
After the change is made, reset the chain.

 Important: If you manually modify the SSRS scheduler job step text as described previously, and at a
later date make modifications to the report schedule in any SSRS tool, the manual step text changes you
made will be overwritten. It is important to remember to make these modifications to the step text again
if you have included an SSRS report as a node in an event chain.

Copy Chain
You may run into a situation where you want to create a second chain that is similar to an existing chain, or
you want to use an existing chain as a template for a new chain. You can effectively copy a chain using the
Save Chain As option on the File menu.
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You will then be asked to enter a new name and optional description for the chain.

 Note: To see new event chains created by other client users, right-click on the Event Chains root
node, and then select Refresh.

Organizing Event Chains
Event chains can be organized using custom folder names. Any event chain can be moved into another folder
by dragging and dropping it into another folder.
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SQL Sentry Filtering Events
Last Modified on 18 May 2021

History Filter
SQL Sentry provides advanced source history filtering for your monitored targets and instances.
Source History Filter settings are available in the Synchronization group for select Event Sources (View >
Settings).

With the History Filter, you define rules that control the types of events the monitoring service writes into
Event History concerning your monitored servers. If an event doesn't meet the criteria you've defined in the
History Filter, information about that event isn't written to your SQL Sentry database.
Using the History Filter, you may choose to ignore certain types of events, as you can filter multiple columns
including Duration, Message Text, and Run Status. The filter was designed with flexibility in mind. For
example, you may define a filter as simple as Event Duration being greater than five seconds, or you may
choose to create complex filter conditions, using conditional groups and multiple logical operators.
Depending on your environment and the type of information you collect, using a History Filter with the
various Event Sources can also decrease the size of your SQL Sentry database. On busy servers, applying a
History Filter tailored for those specific environments can also significantly reduce the amount of noise,
leaving you with a smaller set of actionable information. One powerful application of the source History
Filter is that it can be used with the Windows Event Logs source. The Windows Event Logs source is available
when you are monitoring a Windows target.

 Note: If you're looking for more control over alerts, Condition settings give you granular control
over what you're being alerted about within your environment.
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Configuring History Filters
The Source History Filter settings are available in the Synchronization group for select Event Sources
(View > Settings). For more information about using the Filter Editor, including context menu information,
see the Filter Editor topic.

Synchronization of Performance Analysis Sources
It's important to understand that the History Filter synchronization settings for Deadlocks affect only what's
displayed on the Event Calendar and doesn't impact what's captured or displayed within SQL Sentry.
The synchronization of the Deadlocks source uses a different process than those sources that are strictly
Event Calendar only. This data is first written to various Performance Analysis specific tables within the SQL
Sentry database, and is then used to populate the Performance Analysis Deadlocks tab.
This data is then correlated and written into Event Calendar tables according to your defined synchronization
settings, including any filters you have specified with the History Filter. This Event History data is used to
populate the Event Calendar, showing you Deadlocks alongside your regularly scheduled agent jobs and
various other event objects.
If you're looking for more control over alerts related to Performance Analysis sources, Condition settings
provide granular control over what you're being alerted about within your environment. Condition settings
allow you to build complex alert criteria for conditions, including those related to Top SQL, Blocking SQL,
and Deadlocks.

Custom Event View Filtering
When setting up a Custom Event View, it's important to understand the two levels of object filtering that
take place. The first level of filtering, source level filtering, determines which objects are included in the view.
Any performance counters that are applied to this view are applied to every object that's included after this
level of filtering. The second level of filtering, general filtering, only determines under which circumstances
the above objects are visible on the calendar. They still have performance counters applied to them whether
they are visible or not.

Source Level Filtering
Any filter text specified from the Add Instances window when setting up or making changes to a view is at the
source level. This restricts the number of objects associated with the view, and therefore the number of
objects that are monitorable.
After the view is created, additional source level filtering can be applied through the Event Sources tab such
as Jobs, Alerts, Tasks, etc. By checking or deselecting Show > Source > checkboxes, you determine whether
objects of this type will be included in the view.
On the Event Sources tab are Event Objects and Categories boxes that allow you to further filter objects
from the view. These boxes are typically populated when working with a view with only one instance.
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General Filtering
Any filters applied from the Filter tab of the Event Views pane determine whether certain event objects are
visible on the Calendar. Even if they're made invisible by this filter, they still have any performance counters
applied to them that are applied to the view. This is an important distinction for performance purposes. If you
don't want a performance counter activated for an object in a view, you must ensure that it's filtered at the
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source level, and not simply made invisible by the Filter tab.

Event View Filter Process Flowchart
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SQL Sentry Job Queuing
Last Modified on 22 November 2021

Introduction
Job queuing allows a resource intensive job to delay other jobs from executing until it completes. This allows
the resource intensive job to utilize more of the server resources, allowing all jobs to finish faster and more
efficiently. Unlike event chains, job queuing applies only to the jobs on an individual SQL Server instance.
Each SQL Agent Job has its own queuing settings. Choose the desired job, and then select the Settings tab
from the Conditions and Settings pane. Configure default queuing settings at both the global and instance
levels, and those settings are inherited by any associated jobs.

Behavior When Queuing Other Jobs
Inherit From Parent
Select False if you want to configure the queuing behavior differently than the Inherited settings.
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Queue Type
Under Queue Type there are three options:
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Queue Type

Description

Never queue

This job doesn't queue any other jobs.

Queue for specified time

This job queues other jobs for the specified time.

Queue indefinitely

This job queues other jobs until this job has
completed.

Queue Others For Up To
The maximum amount of time this job queues other jobs. This setting isn't available globally, because it could
be disastrous if it were accidentally enabled for all jobs on all SQL Servers.
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Auto-Start Threshold
Any queued job whose next scheduled run time is beyond the specified threshold starts automatically upon
leaving the queue. If a job's next scheduled run time is before the threshold it doesn't auto-start but resumes
with its next scheduled run. This setting is extremely valuable for avoiding having to configure the auto-start
type for every possible job that can be queued. It effectively provides a safeguard so that jobs that don't run
very frequently auto-start and thus don't miss a scheduled run, and those that do run frequently resume their
schedules since it usually doesn't matter if they miss a few runs. It also helps to automatically even the load
when a queuing job finishes, so that all queued jobs don't auto-start at the same time and cause resource
contention issues.
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 Note: The maximum number of jobs that can be queued on a server is specified by the Maximum
Queue Length setting under SQL Server Instance settings.

Behavior When This Job is Queued
Inherit From Parent
Select False to configure the queuing behavior differently than the Inherited settings.
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Queue Type
Under Queue Type there are three options:
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Queue Type

Description

Never queue

This job can't be queued by another job.

Queue for specified time

This job only queues for the specified time.

Queue indefinitely

This job queues indefinitely.

Queue For Up To
The maximum amount of time this job can be queued.
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Auto-Start Type
Controls the auto-start behavior for the job when it leaves the queue.
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Auto-Start Type

Description

Don't Auto-Start, resume schedule

Skip the job until its next scheduled run.

Auto-start immediately

If this option is checked, the job executes as soon
as it leaves the queue. However, sometimes you
may not want this behavior for jobs that should
only run at a specific time, or for recurring jobs
(jobs that run multiple times per day) where a
single missed run isn't critical.
 Note: If this option isn't selected and the job
is always queued by another job, such as two
jobs with the exact same schedule, it may never
run.

Use default setting

The job uses the queuing job's Auto-Start
Threshold setting. This is the default setting,
and it's recommended for most cases.

 Note: Jobs that use shared schedules on SQL Server 2005 and above will not be queued.
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Queue Log
The Queue Log can be viewed by selecting Show Queue Log from the context menu of the Jobs node of a
SQL Server or an individual job node. The Queue Log provides details about all recent queuing activity that
has taken place on the server or for the job.

Example Scenario
The primary reason for queuing jobs is to ensure that a high priority, resource intensive job has full access to
the server's resources to complete its task without competing with other jobs that can be delayed until the
high priority job is done.
Consider a full backup job that runs once a week, every Sunday at 1:00 AM. If this is the only job running,
having full use of the server's resources, it can complete in about 45 minutes. However, there are typically
other recurring jobs on the same server that can cause contention for resources, resulting in the backup
taking almost two hours to complete. This in turn causes delays in many other recurring jobs being able to
successfully complete. While it's not plausible to reschedule a five minute recurring job to recur once an hour
for the sake of this one weekly backup, it may be acceptable to temporarily queue that job for one hour once
a week until the backup is complete.
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SQL Sentry Sample Views & Shared Resources
Last Modified on 22 November 2021

Sample Views Overview
Sample Views can be modified to further restrict event instances shown to only those utilizing the same
shared resource, such as a Network Attached Storage (NAS), Storage Area Network (SAN) device, or even a
network segment.
From the Navigator pane, expand the Event Calendars node. This opens the Local and Shared sub-nodes.
Local views are only available to the user that created them. Shared views are available to any user on any
SQL Sentry client. The setup of a view is the same for either option.

Sample Views Example
In this example, we'll demonstrate the steps required to modify an existing Sample View to create a shared
resource view for all Red-Gate backups writing to a SAN to level the backup activity across the SAN to
eliminate any bottlenecks, thus reducing contention and maximizing performance of the SAN and network.
If you expand the Shared node, you'll notice the pre-existing Sample Views sub-node. Select the Sample
View for the backup system you use. We'll use the Sample View for the Red-Gate SQL backups.
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The first time you double-click on Sample Views or select Open from the context menu, the following
message box appears.

Select Yes to open the Select Instances box.
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The Select Instances box has three sections:
Connections
SQL Server Groups
Connection Text Filters
This allows you to select individual instances (SQL Server or Task Scheduler), all SQL Servers in a group, or a
combination of both. Since we want to see all Red-Gate backup jobs across all SQL Servers in the enterprise,
we'll select All under SQL Server Groups.
The key to each Sample View is the Instance Text Filter. With it you can easily restrict the jobs placed in the
view by the actual T-SQL or CmdExec text used in a job's steps. Multiple keywords are separated with a
semicolon, and a plus sign (+) is used in front of any keyword(s) that you want to apply using an and,
otherwise the keyword is applied with an or.
The default Step Text filter for the Red-Gate SQL backups sample view is master sqlbackup; SqlBackupC . This
filter returns only jobs that contain any of those strings somewhere in the step command text. It returns all
matching backup jobs, not just those writing to a particular SAN.
To restrict to only those jobs writing to a SAN, one minor adjustment to the filter should be made, shown as
follows. Add an and filter using the base SAN name or IP address. In this example we've used +\\SAN01. This

1384

causes the view to return any jobs that contain master sqlbackup, SqlBackupC, and contain \\SAN01.
After selecting OK, the Custom Event View is ready to use.

Custom Event View Filters
The jobs with an orange background indicate scheduling conflicts; we have several cases where backups
coming from different servers hit the SAN at the same time. The drag-and-drop functionality can be used on
future job instances on the calendar to eliminate the scheduling conflicts and reduce associated contention
on the SAN or network.
When all jobs have a white background, you have a leveled schedule. A leveled schedule ensures that any
bottlenecks and associated IO errors on the SAN's disk subsystem and network are minimized and that
backup jobs run at optimal speed.
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SQL Sentry Job Step / SSIS Logging
Last Modified on 22 November 2021

The SQL Sentry Event Calendar can collect and display extended step log data for SQL Server agent job steps
on the SQL Server 2005 and above. For this data to be collected, certain options must be enabled at the job
step level.
These options are only available for the following step subsystems:
Operating System (CmdExec)
Analysis Services Command
Analysis Services Query
Transact-SQL script (T-SQL)
By default, the step history for SQL Server agent jobs includes a maximum of 1024 characters of output, and
it's not typically cleanly formatted. If you need to see more of the history data using the native output format,
in the SQL Server 2005 and above you can enable extended logging for a job step. Once enabled, SQL Sentry
collects and process the first 512 KB of step output.

 Note: Logging for SQL Server Integration Services (SSIS) packages should always be enabled using
the SQL Sentry client.

To enable extended logging for a job step, open the properties for the job step in SQL Server Management
Studio, and then select Edit.
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Select Advanced on the left side of the form, choose Log to table to enable extended step logging, and then
select OK.

 Warning: Don't select the Append output to existing entry in table option, or SQL Sentry doesn't
collect the extended step log data.

Once enabled, extended job step log data can be viewed in the SQL Sentry client, both in the job Step Callout
windows on the Calendar pane and in the History List view. A new level is added underneath any job steps
with extended logging enabled. Select [+] to expand the level and view the history details.
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For job steps where SSIS Logging has been enabled through the SQL Sentry client, the step log is parsed and
displayed as one row per SSIS event.
On watched SQL Server 2005 and above instances, SQL Server Agent Jobs that have one or more steps with a
subsystem type of SQL Server Integration Services package has an SSIS Logging Options command within
their context menu; this includes SQL Server Maintenance Plan jobs. The SSIS Logging Options command
makes it easy to enable or disable SSIS Logging.
Once SSIS Logging has been enabled for a SQL agent job, a new message text level is added beneath any SSIS
job steps in both the Event Calendar step callouts and in History List views. A row is added for each SSIS
event, up to the first 512 KB of log data.
When you enable SSIS Logging for a SQL agent job, the following takes place:
All SSIS subsystem steps change to CmdExec subsystem steps.
The append /CONSOLELOG and other appropriate parameters are added to the command line of each
SSIS step.
The Log to Table option is set for each SSIS step.

Logging Level
The SSIS Logging Options dialog box allows you to set the Logging Level to one of the following:

Setting

Description

Disabled

SSIS log data isn't collected or displayed.

Enabled

SSIS log data is collected and displayed for the following package
events:
PackageStart
PackageEnd
OnError
OnTaskFailed
OnWarning
 Note: This is the recommended setting.

Enabled (Verbose)

SSIS log data is collected and displayed for all package events. Since
large amounts of data are collected and processed with verbose
logging, to avoid possible performance issues, it is highly
recommended that this setting only be used for troubleshooting
purposes and is immediately set back to Enabled when complete.

 Note: SQL Sentry collects and processes only the first 512 KB of SSIS log data for each job step.
Typically, the only time a job would ever exceed this limit is when verbose logging has been enabled.
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Run As
When enabling SSIS Logging, using the Run As drop-down list, select to run the package as follows:

Run As

Keep current proxy
settings

Description
When you select Keep current proxy settings, the account specified
within the Job Step properties is used to run the SSIS job step.
 Note: The current proxy must have active rights to the operating
system (CmdExec) subsystem to enable SSIS logging within SQL Sentry.

SQL Agent Service Account

When you select SQL Agent Service Account, the SQL Server agent
service account is used to run each SSIS job step instead of the account
specified within the Job Step properties.

Additional proxy accounts

Additional proxy accounts with the necessary operating system
(CmdExec) subsystem rights are also listed as an option.

Changing the SSIS Logging options for a job triggers the event object: properties modified audit conditions
within SQL Sentry.
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SQL Sentry Runtime Stats
Last Modified on 22 November 2021

Introduction
The Runtime Stats node displays an active event object's historical runtime information. The following two
views are provided:
Runtime History
Runtime Aggregates

Opening Runtime Stats
1. Open the Event Calendar.
2. Right-click on an event object.
3. Select Jump To > Runtime Stats to open the Runtime Statistics graph.

You can also view Runtime Stats graphs for individual jobs.
1. Open the Navigator pane
2. Expand the local jobs node for the desired instance
3. Expand the desired job
4. Double click Runtime Stats to open the Runtime stats graph for your selection
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Aggregate vs. History
Select from the drop-down menu to choose between the Aggregate and History graph. These graphs make it
easy to identify runtime trends that can be indicators of or eventually lead to performance issues with the
event or server.

Runtime History Graph
This graph shows a job’s actual runtime and status over the specified interval. A red bar indicates that the
instance failed.
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Runtime Aggregates Graph
This graph shows the distribution of the job’s actual runtime over the specified interval. This data can be
valuable when deciding where to place a job in the schedule to minimize contention.

Graph Controls
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Use the Navigation toolbar to change the start date/time and interval for the graph. The Days control can go
up to 60 days. Whenever the selected interval is less than one-day (1 minute through 4 hours), the Days
control changes to one-day.

Item

Description

Min/Max Y Val

When a runtime graph is first displayed, SQL Sentry tries to determine the
most appropriate interval and maximum Y-axis value. You can change
either of these settings at any time.

Auto-scale To Max

Checking this box automatically selects the appropriate Max Y Value of the
data being shown in the current view.

Interval Type

Changes the interval used for the Y-axis.

Show Value Labels

Deselect this checkbox to hide the bar value labels. This can become
necessary for broader ranges with hundreds or thousands of bars to
reduce the noise on the graph.

 Note: For information on the Top SQL runtime stats, see Top SQL runtime stats.

Additional Information: See the blog post Have You Been Using Runtime Statistics? for an in-depth
look at this feature.
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SQL Sentry Failed Instances
Last Modified on 22 November 2021

Identifying a Failed Instance
When a certain event has failed, there are several ways the SQL Sentry client alerts you.
In the Navigator pane, the text of the object is red to indicate a failed instance. In the Calendar view, the
status bar for that event's instance is red. In the List view, the first cell has a red background.

Clearing the Failure
To clear a failure, right-click on any of the above-mentioned instance views, and then select Clear Failed
Status.

Clear Failed Status History View

Clear Failed Status List View

Selecting Clear Failed Status opens the Add Note? window and you'll be asked if you want to leave a note
before clearing.
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Alternatively, select Add/Edit Notes from the context menu to open the Notes window. Enter details about
the failure and resolution taken, then select Save.

A message box appears asking if you'd like to clear the failed status for the object. Select Yes to clear all open
failures for the object, and change Navigator nodes shown in red back to black. When clearing the failed
status for a maintenance plan job, maintenance plan, etc., any related child or parent objects also clear.
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SQL Sentry Conflict Viewer
Last Modified on 22 November 2021

Event conflicts are often one of the greatest contributors to performance problems on a SQL Server. The
Conflict Viewer provides valuable insight into how event schedules are contending with each other. It
enables quick and easy cleanup of conflict conditions, ensuring your event schedules are leveled. To open the
Conflict Viewer, select the View Schedule Conflicts icon

on the Toolbar.

The Conflict Viewer is initially sorted in descending order by Total Conflict Time, which is the total time an
event conflicts with other events. This measure is extremely valuable in determining which event objects may
be causing the most resource contention. The primary event object is listed with its detail information,
including Name, Start Time, End Time, and Duration. The event objects that are conflicting with it are listed
beneath it along with their detail information, as well as the actual time in conflict.

Double-click any conflict record to jump directly to the corresponding job instance on the calendar. From
there, you can use drag-and-drop to reschedule the associated events and clean up the conflict condition. This
is the quickest and most effective way to level an event schedule.
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 Note: The Drag-and-Drop feature is disabled in the evaluation copy of SQL Sentry.

Viewer Settings
The following options are available in the Conflict Viewer:

Option

Description

Show Schedule
Conflicts Over

Use this setting to set the time range over which you want to view conflicts.
The Conflict Viewer starts at the current time and projects out into the future
by the specified amount.

Minimum Conflict
Time

Use this setting to eliminate noise caused by short-running events.

Close

Closes the Conflict Viewer window.

Apply

Apply any selected Show Schedule Conflicts Over and Minimum Conflict
Time filter changes.
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SQL Sentry Conditions
Last Modified on 18 May 2021

Overview

Conditions describe the various states of an Event Object or associated Performance Counter. Configure
actions to take place when a condition is met. All actions work on the principle of inheritance, meaning that
configuring an action in response to a condition being met at the global level (Shared Groups) automatically
passes it down to all applicable objects beneath it. This allows the user to define global actions for the most
common issues across their environment once, and have those passed down to every monitored server
automatically. Further refine actions at each level, as needed.
For a general overview of the alerting and response system, see the Alerting and Response System topic. For
a visual representation of how inheritance works within SQL Sentry, see the Alerting and Response System
Hierarchy Diagram.

Types of Conditions
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Conditions fall into the following four categories:
General

Audit

Failsafe

Advisory

Condition

Description
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Condition

Description

General Conditions are applicable to monitored Event Objects or associated
Performance Counters. These are the most common conditions that you'll
configure actions for in your environment. Not all General Conditions apply to
all Event Object types. Condition settings are available for most General
Conditions. Condition settings define additional rules that a condition must
meet for the condition to be fully satisfied.
General Conditions

Example General Conditions include SQL Agent job failure, completed Event
Chains, and Runtime Threshold conditions. For a complete list of General
Conditions, see the General Conditions topic.
Configure actions in response to General Conditions being met at the global
level (Shared Groups), site level, target level, instance level, and individual
object level.

Failsafe Conditions fall into the following two categories:
Instance Status
Error
Instance Status Failsafe Conditions are met when an instance goes offline or
online. Error Failsafe Conditions are met when there's an error detected in a
SQL Sentry monitoring service or related monitoring process.

Failsafe Conditions

Failsafe Conditions falling under the instance status category include SQL
Server Agent offline and Analysis Server offline. Example Failsafe Conditions
of the error category include monitoring service errors and reporting services
monitor errors. For a complete list of all Failsafe Conditions, see the Failsafe
Conditions topic.
Configure actions in response to Instance Status Conditions being met at the
global level (Shared Groups), site level, target level, or individual instance
level. Configure actions in response to Error Conditions being met at the
global level (Shared Groups) or site level.
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Condition

Description

Audit Conditions are applicable to various activities carried out inside and
outside of the SQL Sentry client. Audit Conditions provide a way to notify you
when various settings are changed, or monitored objects are modified from
within the SQL Sentry client.
Audit Conditions

Example Audit Conditions include changed settings, actions, or Response
Rulesets. For a complete list of all Audit Conditions, see the Audit Conditions
topic.
Configure actions in response to Audit Conditions being met at the global
level (Shared Groups), site level, target level, or individual instance level.

Advisory Conditions

Advisory Conditions allow for the creation of conditions that are customized
to your environment as you see fit. For a complete list of all Advisory
Conditions, see the Advisory Conditions Pack topic.
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SQL Sentry Condition Settings
Last Modified on 28 December 2021

Condition Settings define rules that a condition must meet for the condition to be fully satisfied. Conditions
describe the various states of monitored objects within your environment. SQL Sentry defines actions to be
taken when conditions are met. With advanced filtering, the Condition Settings tab provides complete
control of when an action should be taken for a given condition.
Condition Settings define any number of criteria surrounding captured events. The criteria you define must
be met for the condition to be satisfied. Condition Settings are accessed in the Condition Settings tab of
any configured condition/action combination. Logical operators are used to form complex conditional groups,
allowing you to define criteria across any number of columns.
When you configure a condition you also specify an action to take place when that condition is met. If an
event doesn't meet the Condition Settings criteria, the condition isn't considered to be met, and the
associated action won't be taken.

Configuring Condition Settings
Condition Settings are available for most General Conditions and all Audit and Failsafe Conditions.
Condition Settings are accessed from the General Conditions pane for configured condition/action
combinations. The Condition Settings tab contains a Visual Filter Editor and a Text Filter Editor.
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Additional Information: For more information about the Text Filter Editor, see the Condition
Filter topic.

Message Text
Message Text is a useful column to configure a Condition Settings filter. Message Text corresponds to the
entire body of an alert notification received for each respective condition. Any text in the body of alert emails
is evaluated as part of the Message Text filter.
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Event Text
The Event Text filter is available for select conditions. Event Text commonly corresponds to the raw output
text of an event. For Deadlock events, this filters the captured raw XML of the Deadlock. For
Defragmentation Events, the filter is applied to the last operation text that contains events like a successful
offline rebuild or error information that happened during the operation.

Condition Settings Examples
The following section contains example walkthroughs for configuring different filters within the Condition
Settings tab.

Completed Index Defragmentation Example
The Fragmentation Manager performs reorganization or rebuild operations based on fragmentation
thresholds you specify. You may wish to be notified if the fragmentation level of an index is still above a
certain threshold after a Defragmentation Operation has completed.
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In this example, we configure an email alert for the Index: Defragmentation Completed Condition that fires
after a Defragmentation Operation has taken place and the fragmentation level remains above 15 percent.

 Note: There are several actions that can be taken in response to conditions being met. Choose to
execute an Agent Job or a T-SQL command, either in conjunction with, or instead of sending an alert
email.

Adding a Condition
1. Select the Shared Groups node in the Navigator pane to set the action globally. Open the General
Conditions pane (View > Conditions).

2. In the Conditions pane, select Add to open the Actions Selector.
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3. Expand the Index Group, and then expand the Index: Defragmentation Completed. Select the
checkbox next to Send Email, and then select OK.
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4. In the Actions Settings tab, select your desired user or group to target the Send Email Action.

The configured Send Email Action for the Index: Defragmentation Completed Condition is listed in the
Conditions pane.

Adding a Condition Setting to the Condition

 Note: Condition Setting options will vary depending on your Condition selection.

In this example, we will add a Condition Setting to an Index: Defragmentation Completed Condition. Add a
Condition setting to Index: Defragmentation Completed Condition by completing the following steps:
1. Select your desired Condition, and then select the Condition Settings tab in the Conditions pane.
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 Note: The Condition Filter is initially empty.

2. Select New to create a new Condition Filter. Select the plus symbol + next to the And logical operator
to add a new Condition Filter.
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3. Select the Column name [Table Name] to open a drop-down list of available choices, and then choose
[Current Fragmentation Level].
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4. Select the Equals Criteria Operator to open the context menu, and then select Is greater than.

5. Select the field, and then enter your desired value. For this example, enter 15.

6. Select Save to save your Condition Filter.
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 Success: The Condition Setting is now configured. If you select the Condition Settings Text tab, you
should see the filter string defined as follows:

[Current Fragmentation Level.Value] > 15.0
With the Condition Setting defined, the Index: Defragmentation Completed Condition is met, and its
associated Send Email Action fires for the following case:
A Defragmentation Operation has completed on an index, and the fragmentation level is above 15
percent.

SQL Server Deadlock Example
SQL Sentry collects information about deadlocks happening within your environment. View this information
in the Deadlocks tab of Performance Analysis.
Depending on your environment, you may not wish to be alerted about every deadlock that takes place. In this
example, configure an alert for the SQL Server: Deadlock Condition and limit the notifications you receive to
a specific database using Condition Settings.

Adding a Condition
1. Select the Shared Groups node in the Navigator pane to set the action globally. Open the Conditions
pane (View > Conditions).
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2. In the Conditions pane, select Add to open the Actions Selector.

3. Expand the Deadlock group, and then expand the SQL Server: Deadlock Condition. Select the checkbox
next to Send Email, and then select the OK.
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4. In the Actions Settings tab, select your desired user or group to target the Send Email Action.

Adding a Condition Setting to the Condition
In this example, use the Condition Settings to limit the notifications you receive to a specific database for your
SQL Server: Deadlock Condition. Add a Condition Settings to your SQL Server: Deadlock Condition by
completing the following steps:
1. Select your desired Condition, and then select the Condition Settings tab in the Conditions pane.
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2. Select New to create a new Condition Filter. Select the plus symbol + next to the And logical operator
to add a new Condition Filter.
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3. Select the Column name [ Application Name] to open a drop-down list of available choices, and then
choose [Database Name].
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4. Select the Begins with Criteria Operator to open the context menu, and then select Equals.

5. Select the field, and then enter your desired value. For this example, enter AdventureWorks.

6. Select Save to save your Condition Filter.

 Success: The Condition Setting is now configured. If you select the Condition Settings Text tab, you
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should see the filter string defined as follows:

[Database Name] = 'AdventureWorks'
With the Condition Setting defined previously, the SQL Server: Deadlock Condition is met, and its
associated Send Email Action fires for the following case:
A Deadlock is detected and the victim database is the AdventureWorks.

 Note: String comparison is case insensitive.

 Note: As you become more comfortable with the Condition Setting process, you may wish to build
Condition Filters within the Text tab. If you make a mistake while doing so, the syntax error is
underlined and the Visual tab becomes disabled until you fix the problem.
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SQL Sentry Condition Filter
Last Modified on 18 May 2021

SQL Sentry allows you to build complex filters for the purposes of History Filtering and defining Condition
settings. This topic covers the functionality of the Condition Filter that's common to History Filtering and
Condition Settings.

 Note: The Condition Filter is case-insensitive for all string comparisons.

Condition Filter Overview
The following diagram identifies the various aspects of the Condition Filter.
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Condition Filter Overview

Condition Filter Rules
When using the Condition Filter, build criteria that an event must meet by defining rules.
Each filter rule is made up of three distinct parts:

Option

Description

Column Name

Defines the scope of the rule.

Operator

(Criteria operator) defines an instruction for testing the value (operand
value).
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Option

Description

Value

(Operand value) for this filter rule.

Rule Groups
Individual rules are logically grouped into rule groups. Each group contains a logical operator that defines how
the rules are combined within the group. Each group uses the And logical operator. When a group is created
with the And logical operator, each filter rule that's part of the group must be true for the group to evaluate
as true. Change the logical operator defined for a group by selecting it; a drop-down menu appears, allowing
you to choose an alternative (And, Or, Not And, Not Or).

Context Menus

When you select any logical operator, additional options are available from the drop-down menu:

Option

Description

Add Condition

Adds a new filter rule to the condition group.

Add Group

Creates a new sub-group beneath the existing group with the default And
Logical operator.

Remove Group

Deletes the selected group.

Clear All

Available from the root logical operator; deletes all filter rules.

Selecting the plus + symbol next to any group's Logical operator adds a new filter rule to the group. Selecting
the x symbol next to any filter rule deletes that rule from the group.
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SQL Sentry Condition Events Log
Last Modified on 28 December 2021

Introduction
The Events Log displays all the Advisory, General, Audit, and Failsafe condition events that are active or have
completed.

 Note: Prior to version 2021.1, only advisory conditions appeared in the events log. See the SQL
Sentry Event Log Updates Provide a Centralized View of Events blog post for more information.

 Note: Select the Column Chooser and add the Condition Type column to the grid view to easily
view each condition's type (General, Audit, Failsafe, or Advisory).
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Event Log Information
Advisory, General, Audit, and Failsafe conditions will display different information in the Condition
Evaluation and Condition Description panels. For example:
Select an Advisory Condition entry in the Grid view to display the following:

Option

Description

1. Condition
Evaluation Panel

The starting state of the event on the left panel.

2. Condition
Description

A description of the advisory condition on the right panel.

Select the End Time column of an Advisory Condition to display the following:

Option

Description

1. Condition
Evaluation Panel

The result state that closed the active event on the left panel.

2. Condition
Description

A description of the advisory condition on the right panel.
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Select a General, Audit, or Failsafe Condition entry in the Grid view to display the following:

Option

Description

1. Condition
Evaluation Panel

The message associated with the general, audit, or failsafe condition on the left
panel.

2. Condition
Description

A description of the general, audit, or failsafe condition on the right panel.
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Adding Notes and Assigning Users
Select the Expansion node in the Notes column to add notes to the event. Select OK to save any added
notes.

 Note: Any notes that you add to the condition will be included in the future notifications of that
condition.

You also can assign users to events. Select the Assigned User column, and then select a user from the dropdown list.
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 Note: You can also automatically assign a user to all events of a particular Advisory Condition by
selecting an Advisory Condition in the Conditions pane that has the Send to Alerting Channels action
assigned to it, and selecting the user in the Action Settings tab.

 Note: Assigning users to Advisory Condition events allows for users to quickly sort events and
investigate any events that they've been assigned.

Context Menu Options
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Option

Description

Jump To > Performance Analysis
Dashboard

Jumps to the time frame of the Advisory Condition event.

Jump To > Navigator

Jumps to the target or instance where the Advisory Condition
event was evaluated.

Edit Advisory Condition

Opens the Advisory Condition Editor for the selected Advisory
Condition.

Disable/Enable Advisory
Condition

Disables or enables the selected Advisory Condition.

Snooze > This Condition/This
Object

Disables actions alerting on the selected Advisory Condition on
the selected object for the selected period.

Snooze > This Condition/All
Objects

Disables actions and alerting on the selected Advisory
Condition on all objects for the selected period.

Close > All for Object

Close all event logs for objects.

Close > All for Condition

Close all event logs for conditions.
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SQL Sentry General Conditions
Last Modified on 28 December 2021

General Conditions are applicable to monitored Event Objects or associated Performance Counters. These
are the most common conditions that configure actions within your environment. Not all General Conditions
apply to all Event Object types. A condition must be supported by an object's underlying event provider for
conditions and actions to be available in SQL Sentry. General Conditions have an assigned default severity
and associated tags, and will affect your environment's Environmental Health Score (EHO).

 Note: General conditions only impact the EHO in versions 2021.1 and later.

Configuring Actions for General Conditions
Configure actions in response to General Conditions being met at these levels : shared groups (global), sites,
target groups, targets, and instances.
To add a General Condition, complete the following steps:
1. Open the Navigator pane (View > Navigator), and then select the desired node where you want to
configure an action.

2. Open the Conditions Pane (View > Conditions) and then select General Conditions from the dropdown
menu.
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3. Select Add in the Conditions pane to open the Actions Selector. Expand the applicable object and
condition. Use the checkbox(es) to select which actions should be taken in response to this condition being
met, and then select OK.

Additional Information: For more information about actions that can be taken when a condition is
met, see the Actions topic.

Common General Conditions
The following table contains a description of common General Conditions.

Conditions

Is Met When
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Conditions

Is Met When

Started

Occurs when an event instance begins.

Completed

Occurs when an event instance finishes running, regardless of success
or failure status.

Success

Occurs when an event instance completes and returns a success
status.

Failure

Occurs when an event instance completes and returns a failure status.

Output Content Match

This condition is met when specific content that you define exists in
the output message text for an event instance. For more information,
see the Output Content Match topic.

Runtime Threshold Min

Occurs when an event runs shorter than x% of its average runtime, or
shorter than an explicit duration.

Runtime Threshold Max

Occurs when an event runs longer than x% of its average runtime, or
longer than an explicit duration.

Performance Counter
Threshold Min

Occurs when a minimum performance threshold has been set for a
performance counter, and the counter's value falls beneath it.

Performance Counter
Threshold Max

Occurs when a maximum performance threshold has been set for a
performance counter, and the counter's value exceeds it.

General Conditions Comprehensive list
Use the following links to jump to a description of the various conditions. For each condition, find a column
that lists related settings that affect the condition. Settings define criteria for when a condition is met,
including runtime thresholds for events that are captured. Certain settings, known as Source Settings, define
what events are collected by SQL Sentry. For more information about settings, see the Settings topic.

APS Distribution Queries
Conditions

Descriptions

Completed

APS Distribution query completed.

Duration Threshold Max

APS Distributed Queries exceeded the maximum duration threshold.

Duration Threshold Min

APS Distributed Queries exceeded the minimum duration threshold.
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Conditions

Descriptions

Failure

APS Distribution query failed.

Output Content Match

A match condition was found in the output content of an APS
Distribution query.

Started

APS Distribution query started.

Step Failure

APS Distribution query step failed.

Success

APS Distribution query succeeded.

APS Health Alert
Conditions

Descriptions

Critical error

A critical error event occurred.

Non-critical error

A non-critical error occurred.

Output Content Match

A match condition was found in the output content of an APS Health
Alert.

APS Loader Backup Run
Conditions

Descriptions

Completed

APS Loader Backup run completed.

Duration Threshold Max

APS Loader Backup Run exceeded the maximum duration threshold.

Duration Threshold Min

APS Loader Backup Run exceeded the minimum duration threshold.

Failure

APS Loader Backup run failed.

Output Content Match

A match condition was found in the output content of an APS Loader
Backup run.

Started

APS Loader Backup run started.

Step Failure

APS Loader Backup run step failed
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Conditions

Descriptions

Success

APS Loader Backup run succeeded.

Azure SQL Data Warehouse Distributed Queries
Conditions

Descriptions

Completed

Azure SQL Data Warehouse Distributed query completed.

Duration Threshold Max

Azure SQL Data Warehouse Distributed Queries exceeded the
maximum duration threshold.

Duration Threshold Min

Azure SQL Data Warehouse Distributed Queries exceeded the
minimum duration threshold.

Failure

Azure SQL Data Warehouse Distributed query failed.

Output Content Match

A match condition was found in the output content of an Azure SQL
Data Warehouse Distributed query.

Started

Azure SQL Data Warehouse Distributed query started

Step Failure

Azure SQL Data Warehouse Distributed query step failed.

Success

Azure SQL Data Warehouse Distributed query succeeded.

Azure SQL Data Warehouse Loader Backup Run
Conditions

Descriptions

Completed

Azure SQL Data Warehouse Loader Backup run completed.

Duration Threshold Max

Azure SQL Data Warehouse Loader Backup Run exceeded the
maximum duration threshold.

Duration Threshold Min

Azure SQL Data Warehouse Loader Backup Run exceeded the
minimum duration threshold.

Failure

Azure SQL Data Warehouse Loader Backup run failed.

Output Content Match

A match condition was found in the output content of an Azure SQL
Data Warehouse Loader Backup run.
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Conditions

Descriptions

Started

Azure SQL Data Warehouse Loader Backup run started.

Step Failure

Azure SQL Data Warehouse Loader Backup run step failed.

Success

Azure SQL Data Warehouse Loader Backup run succeeded.

Blocking SQL
Conditions

Description

Related Setting

Blocking SQL

A Block is detected, subject to
the Minimum Block Duration
set for the Blocking SQL
Source. View the Block on
the Event Calendar or the
Performance Analysis
Blocking SQL tab.

Blocking SQL Source: Minimum
Block Duration

Blocking SQL: Duration
Threshold Max

Block exceeded the maximum
duration threshold.

Blocking SQL Source: Minimum
Block Duration
Blocking SQL: Maximum
Duration Threshold

Blocking SQL Source: Minimum
Blocking SQL: Output Content
Match

A match condition is found in
the output content of a Block.

Block Duration
Condition Settings

Deadlocks
Conditions

Description

Related Setting

Amazon RDS for SQL Server:
Deadlock: Output Content
Match

A match condition is found in
the output content of an
Amazon RDS for SQL
deadlock.

Deadlocks Source: Collect
Deadlock Events
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Conditions

Description

Related Setting

Deadlock

A Deadlock was detected.
View the Deadlock on the
Event Calendar or the
Performance Analysis
Deadlocks tab.

Deadlocks Source: Collect
Deadlock Events

Deadlock: Output Content
Match

A match condition is found in
the output content of a Block.
Define which strings to search
for in the event output to
trigger this condition. For
more information, see the
Condition Settings topic.

Deadlocks Source: Collect
Deadlock Events
Condition Settings

Event Chain
Conditions

Description

Related Setting

Completed

Event Chain execution
completed.

N/A

Failure

Event Chain execution failed.

N/A

Runtime Threshold Max

Event Chain exceeded the
maximum runtime threshold.

Event Chain: Maximum
Runtime Threshold

Runtime Threshold Min

Event Chain didn't meet the
minimum runtime threshold.

Event Chain: Minimum
Runtime Threshold

Started

Event Chain execution started.

N/A

Success

Event Chain execution
succeeded.

N/A

Conditions

Description

Related Setting

Completed

Event Chain node execution
completed.

N/A

Failure

Event Chain node execution
failed.

N/A

Event Chain Node
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Conditions

Description

Related Setting

Runtime Threshold Max

The runtime threshold
maximum for an Event Chain
node was exceeded.

Event Chain Node: Maximum
Runtime Threshold

Runtime Threshold Min

Event Chain node didn't meet
the minimum runtime
threshold.

Event Chain Node: Minimum
Runtime Threshold

Started

Event Chain node execution
started.

N/A

Success

Event Chain node execution
succeeded.

N/A

Conditions

Description

Related Setting

Defragmentation Complete

Index Defragmentation
completed.

Index Defragmentation

Defragmentation Failure

Index Defragmentation failed.

Index Defragmentation

Defragmentation Started

Index Defragmentation
started.

Index Defragmentation

Conditions

Description

Related Setting

Output Content Match

A match condition was found
in the output content of a
maintenance plan.

Condition Settings

Step Failure

Maintenance plan step failed.

N/A

Description

Related Setting

Index

Maintenance Plan

Performance Counter
Conditions
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Conditions

Description

Related Setting

Threshold Max

Performance Counter value
exceeded the maximum
threshold.

Performance Counter: Counter
Thresholds Maximum

Threshold Min

Performance Counter didn't
meet the minimum threshold

Performance Counter: Counter
Thresholds Minimum

Conditions

Description

Related Setting

Completed

Reporting Services Report
completed.

N/A

Failure

Reporting Services Report
failed.

N/A

Runtime Threshold Max

Reporting Services Report
exceeded the maximum
runtime threshold.

Reporting Services Report:
Maximum Runtime Threshold

Runtime Threshold Min

Reporting Services Report
didn't meet the minimum
runtime threshold.

Reporting Services Report:
Minimum Runtime Threshold

Started

Reporting Services Report
started.

N/A

Success

Reporting Services Report
succeeded.

N/A

Conditions

Description

Related Setting

Alert Fired

SQL Server Agent Alert was
fired.

N/A

Output Content Match

A match condition is found in
the output content of a SQL
Server Agent Alert.

Condition Settings

Reporting Services Report

SQL Server Agent Alert

SQL Server Agent Job
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Conditions

Description

Related Setting

The minimum block duration
required to trigger SQL Server

Block

SQL Server Agent Job is
blocked or is blocking.

Agent Job: Block condition can
be changed in the Monitoring
Service Setting.
Monitoring Service >
Settings > Event Monitor

Completed

SQL Server Agent Job
completed.

N/A

Conflict

There's a job conflict, meaning
two or more jobs were seen
running concurrently.

N/A

Failure

SQL Server Agent Job failed.

N/A

Output Content Match

A match condition is found in
the output content of a SQL
Server Agent Job.

Condition Settings

Queued

SQL Server Agent Job is
queued via SQL Sentry's
queuing system.

SQL Server Agent Job: Queue
Type

Retry

SQL Server Agent Job step
was retried.

N/A

Run Missed

The scheduled run for a job
was missed for some reason.
This may be because SQL
Server Agent was offline.

SQL Server Agent Jobs Source:
Missed Run Threshold

Runtime Threshold Max

SQL Server Agent Job
exceeded the maximum
runtime threshold.

SQL Server Agent Job:
Maximum Runtime Threshold

Runtime Threshold Min

SQL Server Agent Job didn't
meet the minimum runtime
threshold.

SQL Server Agent Job:
Minimum Runtime Threshold

Started

SQL Server Agent Job started.

N/A
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Conditions

Description

Related Setting

Step Failure

SQL Server Agent Job step
failed.

N/A

Success

SQL Server Agent Job
succeeded.

N/A

Conditions

Description

Related Setting

Error

An error event occurred in the
SQL Server Agent Log.

N/A

Output Content Match

A match condition is found in
the output content of a SQL
Server Agent Log.

Condition Settings

Warning

A warning event occurred in
the SQL Server Agent Log.

N/A

SQL Server Agent Log

Top Commands
Conditions

Description

Related Setting

An Analysis Services command
(MDX or XMLA) completed.
Top
Commands:
Completed

 Important: It's highly
recommended that a response
ruleset be used with this
condition to avoid excessive
logging.

Top
Commands:
Duration
Threshold Max

The duration threshold maximum
was exceeded for an Analysis
Services command (MDX or XMLA).

Top
Commands:
Error

An Analysis Services command
(MDX or XMLA) completed with an
error.

Top Commands Source: Collect
MDX/DMX/XMLA Events
Top Commands Source: Minimum
Duration

Condition Settings

Top Commands Source: Collect
MDX/DMX/XMLA Events
Top Commands Source: Minimum
Duration
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Conditions

Top
Commands:
Output
Content Match

Description

Related Setting
Top Commands Source: Collect
MDX/DMX/XMLA Events

A match condition is found in a
completed Analysis Services
command (MDX or XMLA).

Top Commands Source: Minimum
Duration
Condition Settings

Top SQL
Conditions

Description

Related Setting

Amazon RDS for SQL Server:
Top SQL: Duration Threshold
Max

Top SQL event exceeded the
maximum duration threshold.

Top SQL Source

Amazon RDS for SQL Server:
Top SQL: Duration Threshold
Min

Top SQL event exceeded the
minimum duration threshold.

Top SQL Source

Amazon RDS for SQL Server:
Top SQL: Output Content Match

A match condition is found in
the output content of an
Amazon RDS for SQL Top SQL.

Top SQL Source

Azure SQL DB: Top SQL:
Duration Threshold Max

Top SQL event exceeded the
maximum duration threshold.

Top SQL Source

Azure SQL DB: Top SQL:
Duration Threshold Min

Top SQL event exceeded the
minimum duration threshold.

Top SQL Source

Azure SQL DB: Top SQL: Output
Content Match

A match condition is found in
the output content of an
Azure SQL DB Top SQL.

Top SQL Source

Top SQL event completed.

Top SQL: Completed

Top SQL: Duration Threshold
Max

 Important: It's highly
recommended that a
ruleset be used with this
condition to avoid
excessive logging.

Top SQL event exceeded the
maximum runtime threshold.

Top SQL Source

Top SQL Source
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Conditions

Description

Related Setting

Top SQL: Duration Threshold
Min

Top SQL event exceeded the
minimum runtime threshold.

Top SQL Source

Top SQL: Error

Top SQL event completed
with an error.

Top SQL Source

A match condition is found in
the content of a completed
Top SQL event.

Top SQL Source

Top SQL: Output Content Match

Condition

Description

Related Setting

Virtual Machine: VM Moved

The Virtual Machine Moved.

Virtual Machine: VM Support

Description

Related Setting

Condition Settings

Windows Computer

Windows Event Log
Conditions

An event occurred in a
Windows Event Log.
Windows Event Log: Event

 Note: Condition Settings

Windows Event Logs Source:
History Filter

can help to restrict which
events you are alerted about

Windows Task
Conditions

Description

Related Setting

Completed

Windows Task completed.

N/A

Failure

Windows Task failed, as
determined by the success
Exit Code setting for the task.

N/A
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Conditions

Description

Related Setting

Output Content Match

A match condition is found in
the output content for a
Windows Task.

Condition Settings

Runtime Threshold Max

Windows Task exceeded the
maximum runtime threshold.

Windows Task: Maximum
Runtime Threshold

Runtime Threshold Min

Windows Task didn't meet the
minimum runtime threshold.

Windows Task: Minimum
Runtime Threshold

Started

Windows Task started.

N/A

Success

Windows Task succeeded, as
determined by the success
Exit Code setting for the task.

N/A
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SQL Sentry Failsafe Conditions
Last Modified on 28 December 2021

Failsafe Conditions have an assigned default severity and associated tags, and will affect your environment's
Environmental Health Score (EHO). Failsafe Conditions fall into the following two categories:
Connection Status
Error
Instance Status Failsafe Conditions are met when an instance goes Offline or Online. The Offline condition
for an instance is met if a server crashes or becomes unavailable. The Online condition is met once that
instance becomes available again. Failsafe Error Conditions are met when there's an error detected in a SQL
Sentry monitoring service or related monitoring process.

 Note: The Log to Database action and the Send Email action are configured by default for all
Failsafe Conditions. You can be alerted when an instance goes offline, or when the SQL Sentry
monitoring service experiences an error and is unable to perform its work.

Configure Actions for Failsafe Conditions
Configure actions in response to Instance Status Failsafe Conditions being met at these levels: shared
groups (Global), site, computer group, computer, and instance. Configure actions in response to Failsafe
Error Conditions being met at the global level (shared groups) or at the site level.
To add a Failsafe Condition, complete the following steps:
1. Open the Navigator pane (View > Navigator), and then select the desired node where you want to
configure an action.
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2. Open the Conditions Pane (View > Conditions) and then select Failsafe Conditions from the dropdown
menu.

3. Select Add in the Conditions pane to open the Actions Selector. Expand the applicable object and
condition. Use the checkbox(es) to select which actions should be taken in response to this condition being
met, and then select OK.
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Additional Information: For more information about actions that can be taken when a condition is
met, see the Actions topic.

The following is a complete list of all Failsafe Conditions.

Amazon RDS for SQL Server
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Condition

Description

Offline

Amazon RDS is offline or otherwise inaccessible.

Online

Amazon RDS is online and accessible.

Analysis Services
Condition

Description

Offline

Analysis Services is offline or otherwise
inaccessible.

Online

Analysis Service is online and accessible.

Analytics Platform System
Condition

Description

Offline

Analytics Platform System is offline or otherwise
inaccessible.

Online

Analytics Platform System is online and
accessible.

Azure SQL Data Warehouse
Condition

Description

Offline

Azure SQL Data Warehouse is offline or
otherwise inaccessible.

Online

Azure SQL Data Warehouse is online and
accessible.

Azure SQL Database
Condition

Description

Offline

Azure SQL Database is offline or otherwise
inaccessible.
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Condition

Description

Online

Azure SQL Database is online and accessible.

Monitoring Service
 Note: Depending on your product version, the condition names and descriptions may reference SQL
Sentry or SentryOne for the monitoring service and database.

Condition

Description

Device Connection Status Monitor: Error

An error was encountered by the Device
Connection Status Monitor, the process
responsible for monitoring device connections.

Event History Monitor: Error

An error was encountered by the Event History
Monitor, the process responsible for historical
data collection from various sources.

Job Monitor: Error

An error was encountered by the Job Monitor,
the process responsible for collecting data for
running SQL Server Agent Jobs.

Message Processor: Message Action Throttled

The Message Processor reached its max
messages per interval threshold, and at least one
message was throttled. Subsequent messages
are sent to the Actions Log. For more
information, see SQL Sentry Monitoring
Service > Settings.

Monitoring Service: Action Failed

The SQL Sentry Monitoring Service attempted
to execute an action, but the action failed. For
example, the Send Email Action can fail if the
SMTP Server is unavailable.

Monitoring Service: Performance Collection Failed

The Performance Monitor encountered an error
while collecting data for a specific performance
counter.

Monitoring Service: Repository Error

An error occurred while writing data to the SQL
Sentry database.

Monitoring Service: Send Heartbeat Error

The Monitoring Service encountered a critical
error while sending a heartbeat to the SQL
Sentry database.
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Condition

Description

Monitoring Service: SQL Sentry Database Offline

The SQL Sentry database is offline or otherwise
inaccessible.

Monitoring Service: SQL Sentry Database Online

The SQL Sentry database is online and
accessible.

Monitoring Service: Synchronization Error

The SQL Sentry Monitoring Service
encountered a critical error while synchronizing
settings from the SQL Sentry database with its
configuration management thread.

Performance Analysis Data Writer: Error

The Performance Analysis data writer
encountered an error

Performance Monitor: Error

An error was encountered by the Performance
Monitor, the process responsible for collecting
performance data.

Reporting Services Monitor: Error

An error is encountered by the Reporting
Services Monitor, the process responsible for
collecting data for SSRS reports.

vCenter Collector: Error

The vCenter collector encountered an error.

Windows Task Scheduler Monitor: Error

An error was encountered by the Task
Scheduler Monitor, the process responsible for
collecting data for Windows Tasks.

SQL Server
 Note: Make use of Condition Settings when configuring alerts for conditions. Condition filters are
available which can help fine tune exactly when a condition is considered met.

Condition

Description

SQL Server Availability Group
Failover

The SQL Availability Group failed over.

SQL Availability Replica Healthy

The SQL Availability Replica is healthy.

SQL Availability Replica Unhealthy

The SQL Availability Replica is unhealthy.
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Condition

Description

SQL Server Agent: Offline

SQL Server Agent is offline or otherwise
inaccessible.

SQL Server Agent: Online

SQL Server Agent is online and accessible.

SQL Server Cluster Failover

The SQL Server cluster failed over.

SQL Server Instance: Offline

SQL Server is offline or otherwise inaccessible.

SQL Server Instance: Online

SQL Server is online and accessible.

Trintri VMstore
Condition

Description

Offline

Trintri VMstore is offline or otherwise
inaccessible.

Online

Trintri VMstore is online and accessible.

vCenter
Condition

Description

Offline

vCenter is offline or otherwise inaccessible.

Online

vCenter is online and accessible.

VMware Host
Condition

Description

Offline

VMware host is offline or otherwise inaccessible.

Online

VMware host is online and accessible.

Windows
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Condition

Description

Offline

Windows is offline and other inaccessible.

Online

Windows is online and accessible.

Windows Instance
Condition

Description

Offline

Windows instance is offline or otherwise
inaccessible.

Online

Windows instance is online and accessible.
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SQL Sentry Audit Conditions
Last Modified on 28 December 2021

Audit Conditions are applicable to various activities inside and outside of the SQL Sentry client. Audit
Conditions provide a way to be notified when various settings are changed, or monitored objects are
modified from within the SQL Sentry client. Audit Conditions have an assigned default severity and
associated tags, and will affect your environment's Environmental Health Score (EHO).

 Note: The Log to Database action is configured by default for all Audit Conditions. This gives you
an audit trail concerning changes to your SQL Sentry environment. If you'd like to be notified about
Audit Conditions happening in your environment, configure the Send Email Action.

Configuring Actions for Audit Conditions
To add a Audit Condition, complete the following steps:
1. Open the Navigator pane (View > Navigator), and then select the desired node where you want to
configure an action.

2. Open the Conditions Pane (View > Conditions) and then select Audit Conditions from the dropdown
menu.
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3. Select Add in the Conditions pane to open the Actions Selector. Expand the applicable object and
condition. Use the checkbox(es) to select which actions should be taken in response to this condition being
met, and then select OK.

Additional Information: For more information about actions that can be taken when a condition is
met, see the Actions topic.

For a complete listing of all Audit Conditions, see the following tables.

Event Chain
Condition

Description
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Condition

Description

Audit: Event Chain Created

An Event Chain is created.

Audit: Event Chain Deleted

An Event Chain is deleted.

Audit: Event Chain Modified

An Event Chain is modified.

Global
Condition

Description

Audit: Actions Changed

A configured action is changed for an object.

Audit: Event Object Created

An Event Object (job, task, etc.) is created.

Audit: Event Object Deleted

An Event Object (job, task, etc.) is deleted.

Audit: Event Object Properties Modified

An Event Object's (job, task, etc.) properties are
modified.

Audit: Event Object Rescheduled

An Event Object (job, task, etc.) is rescheduled.
For some object types, this condition is only
detected when rescheduling in the SQL Sentry
client by dragging-and-dropping.

Audit: Notes Changed

A note is changed.

Audit: Settings Changed

Object or application settings are changed.

Audit: Watched Flag Changed

The watched flag is changed for an object.

Performance Counter
Condition

Description

Audit: Performance Counter Added

A Performance Counter is added to an event
object or event view.

Audit: Performance Counter Deleted

A Performance Counter is deleted from an
event object or event view.
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Condition

Description

Audit: Performance Monitored Flag Changed

The Performance Monitored flag is changed for
an event object or event view.
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SQL Sentry Advisory Conditions
Last Modified on 28 December 2021

Introduction

Advisory Conditions are a Performance Analysis feature that allows for customized alerting based on
performance counter metrics, query results, WMI queries, duration of events, and state changes. Advisory
Conditions can be applied globally or at specific targets and instances.

Downloading the Advisory Conditions Pack
When opening the Conditions List at the global level, you'll be prompted to download the latest Advisory
Conditions Pack. This pack contains predefined Advisory Conditions that help illustrate the functionality
that the Advisory Conditions feature has to offer. If you decide not to download the Advisory Conditions
Pack at this point, access it through the Download Latest Advisory Conditions Pack option in the Tools
menu. If you choose to disable the automatic checking for Advisory Conditions Packs, checking can be reenabled in User Preferences in the Updates section.

After downloading the Advisory Conditions Pack, you'll be prompted to apply actions. Selecting Yes opens
the Actions Selector to apply actions to your new Advisory Conditions.
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 Note: Scheduled evaluations won't occur until an action is assigned to the Advisory Condition.

Building an Advisory Condition
Additional Information: See the Building SQL Sentry Advisory Conditions article for a tutorial style
walk through of building a condition.

Create an Advisory Condition by selecting Create Advisory Condition in the Conditions List, or right-click
on the All Targets (Global) node, group node, target node, or instance node in the Navigator pane, and then,
select Add Advisory Condition. Owner object of the Advisory Condition is dependent on where the
Advisory Condition is defined. The following sections explain all the options available when creating an
Advisory Condition.

Defining an Advisory Condition
In the Navigator pane, there are Advisory Condition folders located at various levels. All preconfigured
Advisory Conditions are created at the global level. The following chart outlines the various levels and which
types of conditions can be configured at those levels.

Location in
Hierarchy

Advisory Condition Types Available
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Location in
Hierarchy

Root
Global
Site
Target

Advisory Condition Types Available

Amazon RDS for SQL Server
Analysis Services
APS
Azure SQL Database
SQL Sentry (or SentryOne)
SQL DW
SQL Server
Trintri
VMware Host
Windows

SQL
Server Instance

Windows/SQL Server

SSAS Instance

Windows/SSAS

 Note: While SQL Server and SSAS Advisory Conditions can be defined higher in the hierarchy,
defining them at the instance provides the added benefit of being context aware allowing you to utilize
performance counter instances specific to that instance and execute SQL queries within the context of
that instance.

Advisory Condition Types
Type is the first option presented when creating an Advisory Condition. The type determines where the
condition is evaluated and which metrics are available.

Type

Description

Amazon RDS
Instance

Examples: See the Amazon RDS conditions on GitHub such as Amazon RDS High CPU 80% or Amazon RDS - % Free Space - Disk .
This condition is evaluated at the SSAS instance level and has access to
Windows and SSAS performance metrics.

Analysis Services
Examples: See the SSAS conditions on GitHub such as SSAS Formula Engine
Query Pool Job Queuing or SSAS Sustained Cache Evictions .
APS

Examples: See the DataWarehouse conditions on GitHub such as APS
Inaccurate Statistics or APS High Memory Utilization Detected .
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Type

Description
This condition is evaluated at the Azure SQL Database level and has access to
Azure SQL Database performance metrics.

Azure SQL Database

Azure Synapse
Analytics

SQL Sentry (or
SentryOne)

Examples: See the community-submitted Azure SQL DB conditions on GitHub
such as Azure SQL Server Operation Failed or Azure SQL DB High Resource
Utilization.
Examples: See the DataWarehouse conditions on GitHub such as Azure DW
High Memory Utilization Detected or Azure DW Distribution Skew Exceeds
10%.
This condition type is evaluated against the SQL Sentry database and is used to
query the SQL Sentry database for information.
Examples: See the 'Incorrect Compatibility Level or Page Verification Check
conditions in your installation or the Advisory Conditions Pack article.
This condition is evaluated at the SQL Server instance level and has access to
Windows and SQL Server performance metrics.

SQL Server

Examples: See the 'Cost Threshold of Parallelism' Changed or High Avg Wait
Time per User Session conditions in your installation or the Advisory Conditions
Pack article.

Tintri

Examples: See the Tintri High VM Throttle or Tintri High Datastore Throttle
Latency conditions in your installation or the Advisory Conditions Pack article.

VMware Host

This condition is evaluated at the VMware Host level and has access to vCenter
performance metrics associated with a VMware Host.
This condition is evaluated at the Target level and has access to Windows
performance metrics.

Windows

Examples: See the High Context Switches or VMware High Ballooning
conditions in your installation or the Advisory Conditions Pack article.

Advisory Condition Options
Option

Description
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Option

Description

Defines how often the condition is evaluated. The evaluation frequency can be
adjusted individually throughout the hierarchy.
 Note: Scheduled evaluations won't occur until an action is assigned to the
Advisory Condition.
Default Evaluation
Frequency

 Note: Query data is cached for one minute in the monitoring service before
it is written to the SQL Sentry database. If you have a condition that uses T-SQL
queries, and you evaluate more often than once per minute (e.g. a Default
Evaluation Frequency of 30 Seconds), the result data will be retrieved from
the cache and may not be current. Wait at least one minute to evaluate (e.g. a
Default Evaluation Frequency of every 1 Minute or 5 Minutes ) to obtain a
new result.

Defines how long the condition must be true before the associated action is
taken.
Trigger Threshold
Additional Information: See this blog post for detailed instructions on using
the trigger threshold.
Defines the setting of severity that can be used as a sorting parameter in the
Events Log.
Severity

 Important: Advisory Conditions with a severity of High or Critical can also
cause the Advisory Conditions folder in the Navigator pane to turn red when
true.

Evaluation Timeout

Defines the limit on how long each evaluation can run before a timeout occurs.
Defines the number of results returned when the Any instance option is used
in used in the comparison (instead of Value).

Maximum Instance
Count

Color

Additional Information: See this blog post for detailed instructions on using
Maximum Instance Count, Any, and returning a key/value pair in the results
to know which instance in the set of results met the defined condition.
Defines the color of the duration line that appears on the Performance
Analysis Dashboard.

Highlight on Dashboard Chart
Defines which chart(s) will show the duration line (in the selected color from the options) on the
Performance Analysis Dashboard. See the Send to Alerting Channels section of the Actions article for an
example of how this appears when a condition evaluates to true.

1458

Supported Versions
When creating an Advisory Condition in the higher levels of the hierarchy, restrict certain conditions to run
only on designated versions of Windows and/or SQL Server. For example, if you wanted to restrict the
condition to only evaluate on servers with Windows Server 2008 R2 and newer, put 6.1 in the minimum field.

Defining an Advisory Condition

Select one of the following logical operators:

Logical Operator

Description

And

All conditions must be true for an action to occur.

Or

One or more condition(s) must be true for an action to occur.

Not And

One or more condition(s) must be false for an action to occur.

Not Or

All conditions must be false for an action to occur.

Select the plus + icon, and then select a comparison type or an existing Advisory Condition. For more
information about logical operators, see the Logical Choice article.

 Note: When creating a multi-statement Advisory Condition while using And as a logical operator, be
conscious of the order of the logical operators so you don’t short circuit the condition. With the And
operator, if the first statement is false, the subsequent statements will be skipped.

1459

 Warning: If an Advisory Condition is altered, it is altered in all other Advisory Conditions that are
using it as an existing condition.

The following table shows which value retriever types are available for the various comparison types.

Value Retriever Types

Comparison Types
Numeric Comparison
Expression Left Side
Expression Right Side

Performance Counter

 Note: Performance Counter instances are
only available at the appropriate instance
context for Additional AC Type Restrictions.

Numeric Comparison
Expression Left Side
Expression Right Side
Performance Counter Baseline

 Note: User-defined baselines must exist on
the instance for Additional AC Type Restrictions.

SQL Server Query

Numeric Comparison
String Comparison
Date/Time Comparison
Expression Left Side
Expression Right Side
 Note: SQL Server only for Additional AC Type
Restrictions.

SQL Sentry Database Query (formerly SentryOne
Database Query or Repository Query)

Numeric Comparison
String Comparison
Date/Time Comparison
Additional AC Type Restrictions
Expression Left Side
Expression Right Side

SSAS Query

Numeric Comparison
Expression Left Side
Expression Right Side
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Value Retriever Types

Resource Exhaustion

Azure SQL Database Query

Comparison Types
Windows Advisory Condition Type
Date/Time Comparison
Expression Left Side
Expression Right Side

Numeric Comparison
String Comparison
Date/Time Comparison
Expression Left Side
Expression Right Side
 Note: Azure SQL Database only for Additional
AC Type Restrictions.

VMware Host

WMI Query

Explicit Value

 Note: VMware Host only.

Numeric Comparison
String Comparison
Additional AC Type Restrictions
Expression Left Side
Expression Right Side

Numeric Comparison
String Comparison
Date/Time Comparison
Additional AC Type Restrictions
Expression Left Side
Expression Right Side

Last Value

Numeric Comparison
String Comparison
Date/Time Comparison
Additional AC Type Restrictions
Expression Right Side

Expression

Numeric Comparison
Additional AC Type Restrictions
Expression Left Side
Expression Right Side
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Comparison Types

Value Retriever Types

Numeric Comparison
Additional AC Type Restrictions
Expression Left Side
Expression Right Side

Duration

Additional AC Type Restrictions

Existing Condition

Value Retriever Types
Type

Description

Performance Counters are available based on the type of condition that's
being created. Conditions being built at the target and instance level are
context aware and have access to specific counter instances. When defined
at the target level or lower, use baselines that are associated with
Performance Counters.
Performance Counter
 Note: SQL Sentry provides virtual Performance Counters for use in
Advisory Conditions. These virtual counters are gathered using stored
procedures and may cause more overhead than counters collected through
PerfLib. Virtual Performance Counters are identified by the lack of a colon.
For example, SQL Server Data File Size is a virtual counter.

The Performance Counter (User) option allows for the selection of any
performance counter. After selecting this option, select Connect, enter a
server name, and then select Connect again. After connecting to the server,
select the category field to view a list of all of the Performance
Performance Counter
(User)

Counter categories on that server. After selecting a category, select the
counter that's to be evaluated.
 Note: Connecting to a server is only necessary to provide a list of
Performance Counter categories and counters. During evaluation, the
counter is evaluated in the context of each monitored instance.

Performance Counter
Baseline

Performance Counter Baselines are available when the Advisory Condition
is created at the target or instance level. A user defined baseline must exist
at the instance level to be used.
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Type

Description

SQL Server Query

Enter the database that the query runs against in the first field. If the
condition is being defined at the instance level, there's a button next to the
field that provides a list of databases available for that instance. The next
field is for the query. The query can be entered manually or can be selected
from a list of queries using the Query Editor. If a query returns multiple
results, the first result is used for the evaluation.

Azure SQL Database
Query

Enter the database that the query runs against in the first field. The next
field is for the query. The query can be entered manually or can be selected
from a list of queries using the Query Editor. If a query returns multiple
results, the first result is used for the evaluation.
Allows you to perform a query against the SQL Sentry database. See the
Availability Replicas Hosted on Same Virtual Host , Availability Replicas With
Disks in Same Datastore, and SQL Sentry Monitoring Service Offline
conditions as examples.
When writing a SQL Sentry Database Query, use the variables
@ComputerID and @ConnectionID in your query to dynamically adjust
depending on the computer or connection that the Advisory Condition is
evaluating against.

SQL Sentry Database
Query (formerly SQL
Sentry Database
Query or Repository
Query)

@ComputerID = the [ID] column in the [dbo].[Device] table
@ConnectionID = the [ID] column in the [dbo].[EventSourceConnection]
table
The error message " The query string must contain a reference to
@ComputerID or @ConnectionID" appears if a required reference is missing.
SQL Sentry Database Query usage example:
SELECT ServiceConnectionStatus FROM dbo.EventSourceConnection WHERE
ID = @ConnectionID
SELECT ServiceConnectionStatus
FROM dbo.EventSourceConnection C
INNER JOIN dbo.Device D
ON D.ID = C.DeviceID
WHERE D.ID = @ComputerID

Resource Exhaustion

Allows you to perform a check against a Relative Date Value when using the
Forecasting feature. For more information on enabling Disk Forecasting, see
the Disk Space and Monitoring Service Settings articles.

SSAS Query

Allows you to issue DMV queries in Advisory Conditions. DMV queries offer
additional insight into SSAS metadata, and can be executed as MDX or DMX
queries. Enter a query string in the provided field, or use the Query Editor to
enter the query manually.
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Type

Description

WMI Query

Allows you to query WMI using WQL. For more information, see the Querying
with WQL article.

Explicit Value

Allows for an explicitly defined value.

Last Value

This is a right side specific option that returns the previous evaluations value
of the left side of the argument.

Expression

Using the expression option allows for basic mathematical operation to be
applied to other values. Operations include addition, subtraction,
multiplication, and division. These mathematical operations can be
performed against any of the other numeric value options.

This option returns the amount of time elapsed to acquire the specified
value. Various time units are available, ranging from milliseconds to days.
 Note: When using any query retriever types in conjunction with the
Duration

Any qualifier to compare multiple results, the query is required to return a
key/value pair in order to identify which value met the defined condition.
This also ensures that conditions using queries on both sides of the
condition, or comparing the last value, automatically matches values with the
same key.

Query Editor
When using a query retriever type like the SQL Server or SQL Sentry Database query, select the button to the
right of the query input box to launch the Query Editor.

The Query Editor is where queries can be edited and saved for future use in Advisory Conditions.
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Button

Description

New

Opens the New Query window.

Test

Opens an instance dialog window. Specify the server and database name that the query
is to be executed against. The resulting value is displayed in the field to the right of the
test button.

Delete

Deletes the selected query.

 Note: Only queries that have been tested and have a value data type can be selected for use from
the Query Editor.

Conditions List
The Conditions List is accessed from various locations within the hierarchy of the Navigator pane. The
number in parentheses beside the Advisory Conditions folder indicates how many Advisory Conditions are
defined at that level within the hierarchy. An exception to this is the Advisory Conditions folder located
beneath the Contacts node in the Navigator pane. The number here indicates the total number of Advisory
Conditions defined across the environment.

 Note: What's seen in the Conditions List depends on where the list is opened within the hierarchy.
Wherever the list is opened, the list contains Advisory Conditions defined at that level, its parent's
levels, and children’s levels.

Conditions Pane
The Conditions pane provides a list of all available conditions. This pane also displays the owner object,
creation date, and last modified date of the condition as well as which user modified it. Disable an Advisory
Condition by unchecking the checkbox in the Enabled column. Also add tags to assist with sorting and
organizing the conditions.
Select Add Advisory Condition to open Windows, Windows/SQL Server, or Windows/SSAS. Select the
condition type to open the Condition Editor. For more information about adding a condition, see the
Condition Settings topics.
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Select Edit Advisory Condition to open the Condition Editor for the condition that is currently selected in
the Conditions pane.

Edit Advisory Condition tab
Edit Advisory Condition Context Menu Option

 Note: You cannot edit an Advisory Condition if it was created by SQL Sentry. You must make a copy
of the condition, and then you can edit the copy. Consider disabling the original Advisory Condition if
you do not want it to execute going forward.

The Show Events Log button takes you to the Events Log filtered by the Advisory Condition that is selected
in the Conditions list.

Select Show Events Log

The

Events Log for Selection

row allows you to search in each row.
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The following is a list of important columns to remember:

Column

Description

Type

The target type applicable to the condition.

Object

Actual name of the object where the condition was created (may be Global).

Object Type

Specifies what the object is (e.g. Global, SQL Server, etc.).

Enable

Allows you to enable or disable the Advisory Condition in each row.

Tags

Used to organize the Advisory Conditions by keywords.

Context Menu
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Task

Description

Edit

Allows for editing of the selected Advisory Condition.

Show Events Log

Opens the Events Log filtered by the selected Advisory Condition.

Snooze > This Condition/All
Objects

Disables actions and alerting on the selected Advisory Condition for
the selected period.

Snooze > All Conditions/All
Objects

Disables actions and alerting on all Advisory Conditions for the
selected period.

Unsnooze > This
Condition/All Objects

Re-enables actions and alerting on the Advisory Condition.

Unsnooze > All
Conditions/All Objects

Re-enables actions and alerting for all Advisory Conditions.

Clone

Creates a copy of the selected Advisory Condition with a new name
with the owner object being in the context of the Conditions List.
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Task

Description

Export

Exports the selected Advisory Condition to a .condition file.

Import

Imports an Advisory Condition from a .condition file.

Disable

Disables the selected Advisory Condition.

Delete

Deletes the selected Advisory Condition.

Evaluation Status Pane
The Evaluation Status pane displays the last evaluation for the selected condition. This pane shows the
object that was evaluated, the result of the evaluation, the duration and time of the evaluation, and
information pertaining to any errors that may have occurred. The bottom of the pane provides a count of the
objects that were evaluated. Selecting an evaluation in this pane displays the results of that evaluation in the
Evaluation Results pane.

Evaluate Selected and Evaluate All
The Evaluate Selected button performs an evaluation of the Advisory Condition against the selected object
in the Evaluation Status pane. The Evaluate All button performs an evaluation of the Advisory
Condition against all legal targets.
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With Logging
The Evaluate Selected and Evaluate All options have a drop-down menu which contains a With Logging
option. The With Logging option generates an entry in the SQL Sentry Events Log if the condition doesn't
have the Log to Alerting Channels action assigned to it.

To view events generated by the With Logging option, select Show Events Log from the Conditions List.

The Events Log displays entries for the conditions that evaluated to true when With Logging was selected
for the evaluation.
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 Note: The With Logging option is not the same as the Log to Windows Event Log Action. See the
Actions article to learn more about logging to the Windows Event Log.

Context Menu

Task

Description

Snooze This Condition/This
Object

Disables actions and alerting for the selected Advisory
Condition on the object for the selected amount of time.

Jump To Performance Analysis
Dashboard

Jumps to the time frame of the Advisory Condition event.

Show Events Log

Opens the Events Log filtered by the selected Advisory
Condition.

Evaluation Results Pane
The Evaluation Results pane, located at the bottom, shows the evaluation step results of an Advisory
Condition along with any values retrieved through Performance Counters or queries. Hover over any of the
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values to open a tooltip with additional information like the duration of retrieving that value, the nonrounded value, error messages, and Performance Counter instance names.

 Note:
If you use the logical operator Any (instead of Value), the number of values that can be listed is
tied to the Maximum Instance Count value (which can be up to 100).
Using the Any option requires two columns in the query selection to return a key/value pair in the
list of results.
Additional Information: For a detailed explanation and example of using the Maximum Instance
Count, Any, and two columns for a key/value pair, see this blog post.

 Note: Query data is cached for one minute in the monitoring service before it is written to the SQL
Sentry database. If you have a condition that uses T-SQL queries, and you evaluate more often than once
per minute (e.g. a Default Evaluation Frequency of 30 Seconds), the result data will be retrieved from
the cache and may not be current. Wait at least one minute to evaluate (e.g. a Default Evaluation
Frequency of every 1 Minute or 5 Minutes ) to obtain a new result.

Events Log
Additional Information: For information about the Events Log, see the Condition Events Log article.
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SQL Sentry Advisory Conditions Pack
Last Modified on 28 December 2021

SQL Sentry provides a base set of conditions that you can download from inside the client. This set of
conditions gives you a starting point for monitoring and can serve as a reference when creating your own
conditions. See the Advisory Conditions article for information on cloning and customizing any of the
conditions below to your specific environment and needs, as well as building new ones. Additional conditions
are also available on GitHub.

Available Advisory Conditions
Availability Replicas Hosted on Same Virtual Host
This condition evaluates to true when multiple Availability Replicas from the same Availability Group are
hosted on the same VMware/Hyper-V host.
In the event of an issue with the host server, there could be an outage that nullifies the Always On
Availability Group configuration within the virtual machines hosted on the VMware Infrastructure.
For more information, see the Always On Availability Group and VMS article.
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--// AG Replicas on the same VM host
--// Applies to : VMware & Hyper-V
--// ConditionKey column breakdown as follows;
--// Host : {VMwareHost Name} | WSFC : {Windows Cluster Name} | AG : {AG Name} - {AG Replicas on Host}
SELECT
'Host : ' + QUOTENAME(HS1.Name) + ' | WSFC : ' + CR.ClusterName + ' | AG : ' + AG1.Name + ' - ' +
STUFF((SELECT N', ' + QUOTENAME(NodeName) + '(' + CASE Role WHEN 1 THEN 'P' ELSE 'S' END + ')'
FROM AlwaysOn.AvailabilityReplica AS AR2
INNER JOIN VM.VirtualMachine AS VM2
ON AR2.NodeName = VM2.Name
WHERE AR2.GroupID = AR1.GroupID
AND VM2.HostSystemID = VM1.HostSystemID
ORDER BY Role, NodeName
FOR XML PATH(N''), TYPE).value(N'.[1]', N'nvarchar(max)'), 1, 2, N'') as ConditionKey
,COUNT(VM1.Name) AS ReplicaCount
FROM VM.HostSystem HS1
INNER JOIN VM.VirtualMachine AS VM1
ON HS1.ID = VM1.HostSystemID
INNER JOIN AlwaysOn.AvailabilityReplica AR1
ON AR1.NodeName = VM1.Name
INNER JOIN AlwaysOn.AvailabilityGroup AS AG1
ON AG1.GroupID = AR1.GroupID
INNER JOIN AlwaysOn.ClusterReference CR
ON AR1.EventSourceConnectionID = CR.EventSourceConnectionID
GROUP BY
CR.ClusterName
,AR1.GroupID
,AG1.Name
,VM1.HostSystemID
,HS1.Name
HAVING COUNT(VM1.Name) > 1
ORDER BY CR.ClusterName, AG1.Name, HS1.Name
;

Availability Replicas With Disks in Same Datastore
This condition evaluates to true when multiple Availability Replicas from the same Availability Group have
their VMDKs in the same VMware Datastore.
If there's an issue with the datastore for the VMware server, this could result in an outage that nullifies the
Always On Availability Group configuration within the virtual machines hosted on the VMware
Infrastructure.
For more information, see the Always On Availability Groups and VMS article.
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--// AG nodes with storage in the same data store.
--// Applies to : VMware
--// ConditionKey column breakdown as follows;
--// Data Store : {Data Store Name} | WSFC : {Windows Cluster Name} | AG : {AG Name} | {Replica:Disk}
select 'Data Store : ' + quotename(ds.name) + N' | WSFC : ' + cr.ClusterName
+ ' | AG : ' + ag.name + ' | ' +
stuff((select ', ' + ar2.nodename + '('
+ case [Role] WHEN 1 THEN 'P' ELSE 'S' END
+'):{'+ right(vd.[filename],(charindex('/',reverse(vd.[FileName]))-1)) +'}'
from vm.virtualMachineVirtualDisk as vd
join vm.datastore as ds2
on replace(replace(left(vd.filename,charindex(']', vd.filename)),'[',''),']','') = ds2.name
join vm.virtualMachine as vm2 on vd.virtualMachineId = vm2.id
join AlwaysOn.AvailabilityReplica as ar2 on vm2.name = ar2.NodeName
where ar2.GroupId = ag.GroupId
and ds2.name = ds.name
order by vm2.name
for xml path(''), type).value(N'.[1]',N'nvarchar(max)'),1,2,N'') as conditionKey,
count(vmdk.[filename]) as DiskOverlapCount
from vm.datastore as ds
join vm.virtualMachineVirtualDisk as vmdk
on replace(replace(left(vmdk.[filename],charindex(']', vmdk.[filename])),'[',''),']','') = ds.name
join vm.virtualmachine as vm on vmdk.virtualMachineId = vm.id
join AlwaysOn.AvailabilityReplica as ar on ar.nodename = vm.name
join AlwaysOn.AvailabilityGroup as ag on ar.GroupId = ag.GroupId
join AlwaysOn.ClusterReference as cr on ar.EventSourceConnectionID = cr.EventSourceConnectionID
group by cr.ClusterName, ag.Name, ds.Name, ag.GroupId
order by cr.ClusterName, ag.Name, ds.Name
;

Check Constraints Not Trusted
This condition evaluates to true when it finds sys.check_constraints.is_not_trusted values on objects that it
expects to be trusted.
When check constraints are not trusted, SQL Server may be unable to use them for query plans and
optimization, affecting the performance of your queries. Check constraints that were disabled, perhaps for
bulk loading of data, and then enabled, may not be trusted. The table must be altered for those check
constraints to be trusted again.
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DECLARE @sql nvarchar(max);
SET @sql = N'';
SELECT @sql = @sql + N'UNION ALL
SELECT DBName = N''' + name + ''' COLLATE Latin1_General_BIN,
CCsNotTrusted =
(
SELECT COUNT(*) AS CCsNotTrusted
FROM ' + QUOTENAME(name) + '.sys.check_constraints AS c'
+ N'
WHERE c.is_not_trusted = 1
AND c.is_not_for_replication = 0
AND c.is_disabled = 0
)
' FROM sys.databases
WHERE database_id > 4 AND state = 0;
SET @sql = N'SELECT DBName, CCsNotTrusted FROM
(' + STUFF(@sql, 1, 10, N'')
+ N') AS x WHERE CCsNotTrusted > 0;';
EXEC sys.sp_executesql @sql;

Check Data File Size
Verifies that a data file is at least 5120 MB. This condition is used to build other conditions.

Check Error Log Size
Checks the size of the error log. This condition is used in other custom conditions that query the error log to
prevent performance issues associated with larger log files.
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DECLARE @currentlogid int
DECLARE @createdate datetime
DECLARE @currfilesize int
CREATE TABLE #err_log_tmp(ArchiveNo int, CreateDate nvarchar(128), Size int)
INSERT #err_log_tmp exec master.dbo.sp_enumerrorlogs
SELECT TOP 1
@currentlogid = er.ArchiveNo,
@createdate = CONVERT(datetime, er.CreateDate, 101),
@currfilesize = er.Size
FROM #err_log_tmp er
ORDER BY [ArchiveNo] ASC
DROP TABLE #err_log_tmp
SELECT @currfilesize;

Check Transaction Log File Size
Verifies that the transaction log file is at least 1024 MB. This condition is used to build other conditions.

Common Criteria Compliance Enabled
Queries sys.configurations to determine if common criteria compliance is enabled.
Common criteria compliance is an advanced option in the SQL Server Enterprise and Datacenter editions that
can have a dramatic impact on server performance. The value field indicates that the setting is enabled;
however, the value_in_use field indicates whether it has been activated. Activating common criteria
compliance requires a server restart.
For more information, see the Common Criteria Compliance article.
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SELECT value
FROM sys.configurations
WHERE name = N'common criteria compliance enabled'

Cost Threshold of Parallelism Changed
Queries sys.configurations to detect whenever the server-wide Cost Threshold of Parallelism configuration
setting changes on a monitored server, by comparing the last value retrieved to the current value.
SELECT value_in_use
FROM sys.configurations
WHERE name = N'cost threshold for parallelism'

CPU Schedulers Failed to Create Worker
This condition evaluates to true when there are schedulers that couldn't create a new worker, most likely due
to memory constraints.
For more information, see the sys.dm_os_schedulers article.
SELECT COUNT(*) AS 'Failed Workers'
FROM sys.dm_os_schedulers WITH (NOLOCK)
WHERE failed_to_create_worker = 1;
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CPU Schedulers Hot Added
This condition evaluates to true when there are schedulers that have been added due to a hot add CPU event.
For more information, see the sys.dm_os_schedulers article.
SELECT COUNT(*) AS 'Hot Added'
FROM sys.dm_os_schedulers WITH (NOLOCK)
WHERE [status] = N'HOT_ADDED';

CPU Schedulers Visible Offline Status
This condition evaluates to true when there are CPU cores that are visible to SQL Server, but are offline.
SQL Server licensing might prevent a server from using all available cores. Not only can this limit performance,
but it can cause additional harm by unbalancing NUMA nodes.
For more information, see the Balancing Your Available SQL Server Core Licenses and Performance Problems
with SQL Server 2012 articles.
SELECT COUNT(*) AS 'Offline Schedulers'
FROM sys.dm_os_schedulers WITH (NOLOCK)
WHERE [status] = N'VISIBLE OFFLINE'
and scheduler_id < 255;

1479

CPU Unused Schedulers
This condition evaluates to true when CPU schedulers are disabled (is_online = zero).
This indicates that a CPU is offline and SQL Server can't use it for processing (e.g. queries, batches, etc.). A
disabled CPU could be caused by affinity masking or licensing issues, and can impact performance.
For more information, see the CPU Schedulers Visible Offline Status section, previously.
SELECT COUNT(*) AS 'Unused Schedulers'
FROM sys.dm_os_schedulers WITH (NOLOCK)
WHERE [is_online] = 0
and scheduler_id < 255;

Data File Growth
This condition evaluates to true if any data file (> five GB) is larger than it was during the last evaluation of
this condition.
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Data File Shrink
Evaluates to true if any data file is smaller than it was during the last evaluation of this condition. Shrinking
data files is rarely recommended.
For more information, see the Why You Should Not Shrink Your Data Files article.

Database Files Count Change
This condition evaluates to true when the number of database files changes. It checks the count of database
files in master.sys.master_files, regardless of file type (e.g. ROWS, LOG, etc.) A highlight appears on the
backups chart of the dashboard to show that backup jobs might need to be created or removed depending on
the scenario.
select count(*) from sys.master_files;

Foreign Keys Not Trusted
This condition evaluates to true when it finds sys.foreign_keys.is_not_trusted values on objects that it expects
to be trusted.
When foreign keys are not trusted, SQL Server may be unable to use them for query plans and optimization,
affecting the performance of your queries. Foreign keys that were disabled, perhaps for bulk loading of data,
and then enabled, may not be trusted. The table must be altered for those foreign keys to be trusted again.

1481

DECLARE @sql nvarchar(max);
SET @sql = N'';
SELECT @sql = @sql + N'UNION ALL
SELECT DBName = N''' + name + ''' COLLATE Latin1_General_BIN,
FKsNotTrusted =
(
SELECT COUNT(*) AS FKsNotTrusted
FROM ' + QUOTENAME(name) + '.sys.foreign_keys AS f'
+ N'
WHERE f.is_not_trusted = 1
AND f.is_not_for_replication = 0
AND f.is_disabled = 0
)
' FROM sys.databases
WHERE database_id > 4 AND state = 0;
SET @sql = N'SELECT DBName, FKsNotTrusted FROM
(' + STUFF(@sql, 1, 10, N'')
+ N') AS x WHERE FKsNotTrusted > 0;';
EXEC sys.sp_executesql @sql;

High Active User Sessions
This condition is triggered if the count of user sessions with recent activity goes over a specified threshold.
High active sessions by itself doesn't universally correlate with performance or other problems, but on some
systems it can precede an overload state, and/or be an indicator of malicious denial of service (DoS) activity.
As such, this condition should be enabled selectively and the threshold adjusted appropriately.
select count(*)
from sys.dm_exec_sessions
where is_user_process = 1 and
last_request_start_time > DATEADD(minute, -1, GETDATE())
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High Ad Hoc Query Plans
This condition checks for plan cache bloat that may be alleviated by enabling optimize for ad hoc workloads.
If optimize for ad hoc workloads is False, a high percentage of plan cache is dedicated to single use plans,
and page life expectancy is low, then this condition evaluates to True.
A high percentage of plan cache in this condition is defined as greater than 10 percent when the server has
less than or equal to 64 GB of memory and greater than five percent when it has greater than 64 GB of
memory.
For more information, see the Plan Cache and Optimizing for Ad Hoc Workloads article.
SELECT sum(cast((CASE WHEN usecounts = 1 THEN size_in_bytes ELSE 0 END) as decimal(19,3)))/1024/1024
FROM sys.dm_exec_cached_plans

High Average Work Queue Count
This condition evaluates to true when sys.dm_os_schedulers.work_queue_count has an average value greater
than one.
A high average work queue count can indicate that max worker threads for the server should be increased.
For more information, see the Max Worker Threads and When You Should Change It article.
SELECT AVG (work_queue_count)
FROM sys.dm_os_schedulers WITH (NOLOCK)
WHERE [status] = N'VISIBLE ONLINE';
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High Avg Wait Time per User Session
Wait time measures how long queries are waiting for CPU, disk, memory, or other resources, across all
sessions. High average wait time per second by itself may not be indicative of a problem, because it doesn't
consider the activity level of the system. For example, 5,000 ms of average wait time/sec would be poor on a
system with only 30 active users, but excellent on a system with 3,000 active users.
For this reason, this condition divides average wait time/sec (total) by the number of active user sessions to
calculate the average wait time per session. If this value is over 50 ms, users may be experiencing noticeable
delays.
This value shouldn't be considered a universally hard threshold, but more of a guideline, and may need to be
adjusted for different systems.
For more information, see the Wait Statistics article and the Waits category on SQLPerformance.com.

 Note: SQL Sentry filters out innocuous waits, so the wait time used here is lower than if collected
directly from SQL Server, and more accurately reflects user-impacting waits.

select count(*)
from sys.dm_exec_sessions
where is_user_process = 1 and
last_request_start_time > DATEADD(minute, -1, GETDATE())
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High Compiles
Query plan compiles should generally be < 15 percent of batches per second. Higher values indicate plan
reuse is low and will often correlate with high cpu since plan compilation can be a cpu-intensive operation.
High compiles may correlate with low plan cache hit ratios, and can be an indicator of memory pressure
because there may not be enough room to keep all plans in cache.
If you see consistently high compiles, run a Quick Trace and sort the results by Cache Misses, then expand
details to view actual compiling statements (SP:CacheMiss events, highlighted) along with the reason
(SubClass) and procedure (Object).
For more information, see the Batch Compilation, Recompilation, and Plan Caching Issues and Caching
Mechanisms articles.

High Compiles + High CPU
Query plan compiles can be a CPU-intensive operation. If total CPU is high for an extended period and
compiles are also high, they may be causing or at least contributing to the high CPU.
For more information on troubleshooting, see the High Compiles conditions section, previous.

High Context Switches
Context switches represent the combined rate at which all processors on the computer are switched from one
thread to another. Consistently high values over 7,500 per logical processor can mean that the server is
spending too much time switching threads instead of actively running threads.
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High Context Switches - Warning
Context switches represent the combined rate at which all processors on the computer are switched from one
thread to another. Consistently high values over 5,000 per logical processor can mean that the server is
spending too much time switching threads instead of actively running threads.

High CPU
Sustained CPU utilization greater than 90 percent may indicate a CPU bottleneck.
Use Windows Processes tab in Performance Analysis to ascertain the processes causing the high CPU. On
dedicated SQL Server machines most CPU should be associated with the SQL Server process(es). If the SQL
Server is causing the high CPU, use Top SQL and/or QuickTrace to determine which sessions and queries are
consuming the most CPU.

 Note: If you launch QuickTrace by highlighting a range on the CPU Usage chart, the results are presorted by CPU percent descending, so the greatest consumers are on top.
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High CPU for Non-SQL Server Process
On dedicated SQL Servers, most of the CPU utilization should generally be related to the SQL Server process
(sqlservr.exe). This condition detects when CPU utilization is high, and at least 25 percent is related to some
process other than SQL Server.

High CPU for Single Core
Sustained CPU utilization greater than 90 percent on a single core may indicate a CPU bottleneck. The CPU
Total usage value is checked against 100/Number of cores used by the SQL Server instance.
Use the Windows Processes tab in Performance Analysis to ascertain the processes causing the high CPU.
On dedicated SQL Server machines, most CPU should be associated with the SQL Server process(es). If the
SQL Server is causing the high CPU, use Top SQL and/or QuickTrace to determine which sessions and queries
are consuming the most CPU.

 Note: If you launch QuickTrace by highlighting a range on the CPU Usage chart, the results are presorted by CPU percent descending, so the greatest consumers are on top.

SELECT 100.0/COUNT(*)
FROM SYS.DM_OS_SCHEDULERS
WHERE STATUS = 'VISIBLE ONLINE' AND IS_ONLINE = 1;

High CPU Signal Waits
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This condition evaluates to true when total signal waits are above 20 percent. High signal waits are often
indicative of CPU pressure, but the threshold may vary by system.
For more information, see the A DMV a Day and Troubleshooting SQL Server Wait Stats articles.
SELECT CAST(100.0 * SUM(signal_wait_time_ms)/ SUM (wait_time_ms)AS NUMERIC(20,2))
FROM sys.dm_os_wait_stats WITH (NOLOCK);

High Database Replica Send or Recovery Queue
Large log send or recovery queues can be an indicator of a system or network bottleneck. This condition is
triggered if either queue goes over 3 MB.
Use the Always On Management interface in the Performance Analysis dashboard to troubleshoot.
For more information, see the AlwaysOn Architecture Guide article.

High Disk Waits and Latency
This condition detects if high disk latency is potentially causing high disk wait time in SQL Server.
To troubleshoot, view the Performance Analysis Disk Activity tab to locate bottlenecks in the disk system
or specific database files. On the dashboard, highlight a range with high latency and Jump To > Top SQL to
determine which queries may be contributing to and/or suffering from high disk waits.
Disk latency is the only disk measurement for which there are generally accepted ranges that represent good
and bad performance from a SQL Server perspective. The following ranges can be used as a general guideline
to determine whether disk latency is acceptable:
Less than 10 ms—Fast*
Between 10 ms - 20 ms—Acceptable
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Between 20 ms - 50 ms—Slow
Greater than 50 ms—Critical
*For transaction log writes, between 0 ms and 2 ms is desirable.

High Mirroring Send or Redo Queue
Large log send or redo queues can be an indicator of a system or network bottleneck. This condition is
triggered if either queue goes over three MB.
Use the Performance Analysis Dashboard to troubleshoot.

High Number of Failed Logins
This condition evaluates to true when there are more than 10 failed logins in the last two minutes. The first
query ensures that the error log isn't more than two MB (for performance consideration) and the second
query checks for the number of failed logins.
A high number of failed login attempts may indicate that an unauthorized user is trying to access the system.
SQL Server security properties must have login auditing enabled for this condition to function.
In SQL Server Management Studio, go to Server Properties > Security to check on these settings. The login
auditing option must be set to Failed logins only or Both failed and successful logins.
For more information, see the Server Properties article.
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DECLARE @currentlogid int
DECLARE @createdate datetime
DECLARE @currfilesize int
CREATE TABLE #err_log_tmp(ArchiveNo int, CreateDate nvarchar(128), Size int)
INSERT #err_log_tmp exec master.dbo.sp_enumerrorlogs
SELECT TOP 1
@currentlogid = er.ArchiveNo,
@createdate = CONVERT(datetime, er.CreateDate, 101),
@currfilesize = er.Size
FROM #err_log_tmp er
ORDER BY
[ArchiveNo] ASC
DROP TABLE #err_log_tmp
SELECT @currfilesize;
CREATE TABLE #log
(
logdate DATETIME,
info VARCHAR (25) ,
data VARCHAR (200)
);
INSERT INTO #log
EXECUTE sp_readerrorlog 0, 1, 'Login failed';
SELECT count(*) AS occurences
FROM #log
WHERE logdate > dateadd(minute, -2, getdate());
DROP TABLE #log;

High Pending Disk IO Count
This condition evaluates to True when sys.dm_os_schedulers.pending_disk_io_count has an average value
greater than zero. A high pending disk I/O count may be indicative of an I/O bottleneck.
For more information, see the sys.dm_os_schedulers and Easy Ways to Detect I/O Pressure in SQL Server
articles.
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SELECT AVG (pending_disk_io_count)
FROM sys.dm_os_schedulers WITH (NOLOCK)
WHERE [status] = N'VISIBLE ONLINE';

High Performance Power Plan not Enabled
If the High Performance power plan isn't enabled, Windows may be throttling CPU performance. This in turn
can have a significant negative impact on both Windows and SQL Server performance, so it's highly
recommended that a dedicated SQL Server always use the High Performance plan.
This condition uses a WMI query to determine whether the High Performance plan is active, and it triggers if
it's not.
For more information, see the Slow Performance on Windows Server when Using the Balanced Power Plan
and Ensuring Maximum CPU Performance via HTML articles.

 Note: It's possible to use a custom power plan that doesn't throttle CPU, although this is not a
common practice. If the WMI query returns the error, The program is blocked by group policy, it may
mean that your network admin has applied a power plan from the group policy as described in the
following post. If so, check with them to ensure that the plan doesn't throttle CPU.

High Recompiles
Query plan recompiles should generally be less than 15 percent of initial compiles, and often correlates with
high cpu, since plan compilation can be a cpu-intensive operation. They may be caused by statistics updates,
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schema changes, etc., and may correlate with low plan cache hit ratios.
If you see consistently high recompiles, run a Quick Trace and sort the results by recompiles, then expand
details to view actual recompiling statements (sp:recompile events, highlighted) along with the reason
(subclass) and procedure (object).
For more information, see the Batch Compilation, Recompilation, and Plan Caching Issues and Caching
Mechanisms articles.

High Redo Completion Time
This condition divides the log_send_rate and redo_rate values found in the
sys.dm_hadr_database_replica_states DMV to determine the average redo completion time.
Log Send Rate is the rate at which the logs are being sent to secondary databases in an availability group,
and Redo Rate is the rate in which the log records are being redone on the secondary databases.
By default, this condition evaluates to true if the average redo completion time is greater than five mins (in
secs). In addition, this condition is designed to return rows only when it is executed against the primary
replica.
For more information, see the Availability Group Replica Sync article.
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SELECT [AG Name, Replica, & Database] = AG.name
+ N' [' + AR.replica_server_name + N']'
+ N': (' + DB.database_name + N')',
[Average Redo Completion Time (Sec)]
= COALESCE( RS.log_send_rate / NULLIF (RS.redo_rate, 0),0)
FROM sys.dm_hadr_database_replica_states AS RS
INNER JOIN sys.availability_databases_cluster AS DB
ON RS.group_id = DB.group_id
AND RS.group_database_id = DB.group_database_id
INNER JOIN sys.availability_groups AS AG
ON AG.group_id = RS.group_id
INNER JOIN sys.availability_replicas AS AR
ON RS.group_id = AR.group_id
AND RS.replica_id = AR.replica_id
INNER JOIN sys.dm_hadr_availability_group_states AS AGS
ON AGS.group_id = AG.group_id
INNER JOIN sys.dm_hadr_availability_replica_states AS ars
ON ar.replica_id = ars.replica_id
WHERE ars.role_desc = 'SECONDARY'
AND AGS.primary_replica = @@SERVERNAME
ORDER BY AG.name, AR.replica_server_name, DB.database_name;

High Runnable Tasks Count
This condition evaluates to true when sys.dm_os_schedulers.runnable_tasks_count has an average value
greater than 10. A high runnable tasks count is indicative of CPU pressure.
For more information, see the A DMV a Day article.
SELECT AVG (runnable_tasks_count)
FROM sys.dm_os_schedulers WITH (NOLOCK)
WHERE [status] = N'VISIBLE ONLINE';
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High VLF Count
SQL Server database transaction logs contain multiple virtual log files or VLFs. The number of VLFs is dictated
by the initial size and auto-growth size for the transaction log. Too many VLFs can lead to increased
backup/recovery times and possible performance problems.
See the Performance Analysis Disk Space tab for VLF counts for all log files, as well as configured autogrowth size and how many VLFs result from each auto-growth.
If VLFs are too high, the count can be reset by shrinking and resizing the log. For more information, see the 8
Steps and Transaction Log VLFs articles

Hyper-V High vCPU Wait Time
The vCPU Wait Time is a SQL Sentry virtual counter. It's calculated by multiplying CPU wait time per dispatch
(the average time, in nanoseconds, spent waiting for a virtual processor to be dispatched onto a logical
processor) by the number of dispatches per second onto the logical processor.

Incorrect Compatibility Level
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This condition evaluates to true when a database in the SQL Sentry database has a compatibility level that
doesn't match that of the master database (current compatibility level).
Compatibility mode allows an older database to run on a newer version of SQL Server at the expense of not
being able to run newer features. While some databases need to use an older compatibility mode, not all of
them do.
If there are databases that must run in compatibility mode, make provisions to exclude them to reduce false
positive values.
SELECT
CAST (pasd.CompatabilityLevel AS NVARCHAR(3)) + ' ' + esc.ServerName + ': (' + pasd.Name + ')' as [Current Level,
Server, Database],
der.MaxCompatabilityLevel
FROM [dbo].[PerformanceAnalysisSqlDatabase] pasd
INNER JOIN [dbo].[EventSourceConnection] esc
ON esc.ID = pasd.EventSourceConnectionID
INNER JOIN
(SELECT EventSourceConnectionID, CompatabilityLevel [MaxCompatabilityLevel]
FROM [dbo].[PerformanceAnalysisSqlDatabase]
WHERE DatabaseID = 1) der
ON der.EventSourceConnectionID = pasd.EventSourceConnectionID
WHERE pasd.DatabaseID = 2
AND esc.IsPerformanceAnalysisEnabled = 1
AND pasd.CompatabilityLevel = der.MaxCompatabilityLevel;

Large Windows File Cache
The Windows file (or system) cache stores in memory file data that is read from or written to disk. Since SQL
Server manages its own memory, this cache typically doesn't grow large on a dedicated SQL Server. However,
if some other process is causing it to unexpectedly grow large it can lead to memory pressure for SQL Server.
In the case of Analysis Services, database files may be loaded into and served from the Windows file cache,
even if the associated file data doesn't exist in the SSAS internal caches. For this reason, monitoring the file
cache is important to ensure that physical memory is being used effectively, and that memory contention
doesn't occur between the SSAS process, the file cache, and other processes on the server, including SQL
Server.
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Log File Growth
This conditions evaluates to true if any transaction log, of at least 1024 MB in size, is larger than it was during
the last evaluation of this condition.
Frequent log file growth can lead to the creation of too many Virtual Log Files (VLFs). You can prevent this by
optimizing the initial size and auto-growth size for the transaction log.
For more information, see the High VLF Count custom condition.

Long Running Open Transactions
This condition evaluates to True if any running transactions have been open for at least 90 seconds. The query
returns a list containing the query text and value (in seconds) of the longest running open transactions.
Additional Information: This is a modified version of a query in Paul Randal’s blog. For more information,
see the Script Open Transactions With Text and Plans article.

1496

SELECT [Last T-SQL Text], [Transaction Length]
FROM (
SELECT
[s_tst].[session_id],
[s_es].[login_name] AS [Login Name],
DB_NAME (s_tdt.database_id) AS [Database],
[s_tdt].[database_transaction_begin_time] AS [Begin Time],
DATEDIFF(ss, [s_tdt].[database_transaction_begin_time], GETDATE()) [Transaction Length],
[s_tdt].[database_transaction_log_bytes_used] AS [Log Bytes],
[s_tdt].[database_transaction_log_bytes_reserved] AS [Log Rsvd],
CASE [s_tdt].database_transaction_type
WHEN 1 THEN 'Read/write transaction'
WHEN 2 THEN 'Read-only transaction'
WHEN 3 THEN 'System transaction'
END [Transaction Type],
CASE [s_tdt].database_transaction_state
WHEN 1 THEN 'The transaction has not been initialized.'
WHEN 3 THEN 'The transaction has been initialized but has not generated any log records.'
WHEN 4 THEN 'The transaction has generated log records.'
WHEN 5 THEN 'The transaction has been prepared.'
WHEN 10 THEN 'The transaction has been committed.'
WHEN 11 THEN 'The transaction has been rolled back.'
WHEN 12 THEN 'The transaction is being committed. In this state the log record is being generated, but it has not be
en materialized or persisted.'
END [Transaction State],
[s_est].text AS [Last T-SQL Text]FROM sys.dm_tran_database_transactions [s_tdt]
INNER JOIN sys.dm_tran_session_transactions [s_tst]
ON [s_tst].[transaction_id] = [s_tdt].[transaction_id]
INNER JOIN sys.[dm_exec_sessions] [s_es]
ON [s_es].[session_id] = [s_tst].[session_id]
INNER JOIN sys.dm_exec_connections [s_ec]
ON [s_ec].[session_id] = [s_tst].[session_id]
CROSS APPLY sys.dm_exec_sql_text ([s_ec].[most_recent_sql_handle]) AS [s_est]
WHERE [s_tst].is_user_transaction = 1
) RunningTransactions
WHERE [Transaction Length] IS NOT NULL
ORDER BY [Transaction Length] DESC
(' + STUFF(@sql, 1, 10, N'')
+ N') AS x WHERE CCsNotTrusted > 0;';
EXEC sys.sp_executesql @sql;

Low Available Windows Memory
Most Windows servers require at least 100 MB of available memory to ensure proper function and avoid
expensive disk paging operations. This condition alerts if available memory drops beneath this threshold.
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Low Page Life Expectancy
Page Life Expectancy (PLE) is the average lifespan in seconds of a data page in buffer, and is one of the best
indicators of memory pressure. The larger the buffer cache size, the higher it should be. The formula* used in
this condition takes the size of the buffer pool into account when determining whether the current PLE value
is problematic:

PLE < (DataCacheSizeInGB/4GB * 300)
Each NUMA node has its own PLE value, so some nodes may be suffering from memory pressure while others
are not. This condition checks all NUMA nodes via the Any instance that automatically iterates all nodes and
applies the formula in a synchronized fashion across all counters.
The first check in the condition ensures that the buffer size is at least two GB (default) before processing the
formula, to avoid false positives caused by small buffers.
For more information, see the Finding What Queries in the Plan Cache use a Specific Index and Page Life
Expectancy Isn't What you Think articles.

Network Bottleneck - Outbound
The Output Queue Length is the size of the network output packet queue, in packets. A sustained value of
more than three may indicate a network bottleneck. This condition detects a queue length of more than three
on any network adapter.
For more information, see the Wait Statistics article and the Waits category on SQLPerformance.com.
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NUMA Disabled
This condition evaluates to True when NUMA is disabled. For more information, see the A DMV a Day article.
SELECT COUNT(DISTINCT parent_node_id)
FROM sys.dm_os_schedulers WITH (NOLOCK)
WHERE parent_node_id <> 32;

Optimize for Ad Hoc Workloads Changed
Detects whenever the optimize for ad hoc workloads server config setting changes by comparing the last
value retrieved to the current value.
SELECT value_in_use
FROM sys.configurations
WHERE name = N'optimize for ad hoc workloads';
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Page Verification Check
This condition evaluates to true when it locates databases in the SQL Sentry database with an inadequate
level of page protection. From release 2005 databases should be using Checksum. Databases upgraded or
scripted from an earlier version may still be using torn protection. The result set format is as follows:
Key (server name: (Database), value (one if incorrect).
For more information, see the Alter Database Set Options article.
To change a single database on a server, run the following code after changing the database name:
USE [master]
GO
ALTER DATABASE [AdventureWorks] SET PAGE_VERIFY CHECKSUM WITH NO_WAIT;
GO

To generate the commands to change all databases on a server, run the following code:
SELECT N'ALTER DATABASE [' + db.name + N'] SET PAGE_VERIFY CHECKSUM WITH NO_WAIT;'
FROM sys.databases AS db
WHERE db.page_verify_option_desc <> N'CHECKSUM';
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SELECT
esc.ServerName + ': (' + pasd.Name + ')',
CASE
WHEN pasd.CompatibilityLevel <= 80 AND pasd.PageVerifyOption
WHEN pasd.CompatibilityLevel >= 90 AND pasd.PageVerifyOption
ELSE 0
END [IsBad],
pasd.CompatibilityLevel,
pasd.PageVerifyOption
FROM [dbo].[PerformanceAnalysisSqlDatabase] pasd
INNER JOIN [dbo].[EventSourceConnection] esc
ON esc.ID = pasd.EventSourceConnectionID
WHERE pasd.DatabaseID <> 2
AND esc.IsPerformanceAnalysisEnabled = 1
AND
(CASE
WHEN pasd.CompatibilityLevel <= 80 AND pasd.PageVerifyOption
WHEN pasd.CompatibilityLevel >= 90 AND pasd.PageVerifyOption
ELSE 0
END) = 1;

<> 1 THEN 1
<> 2 THEN 1

<> 1 THEN 1
<> 2 THEN 1

Server MAXDOP Changed
Detects when the server-wide max degree of parallelism (MAXDOP) server config setting changes on a server
with more than one processor by comparing the last value retrieved to the current value.
SELECT value_in_use
FROM sys.configurations
WHERE name = N'max degree of parallelism';

Service Broker - Activation Error Occurred
Checks for Service Broker procedures exiting due to errors.
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Service Broker - Login Connection Error
Checks sys.dm_broker_connections for a login_state of 13, which indicates a connection error.

Service Broker - 'Poison Message Handling' Disabled
Checks sys.service_queues to see if is_poison_message_handling_enabled is false.

Service Broker - Queues with Issues
Checks sys.service_queues for entries that have an activation_procedure, but is_activation_enabled,
is_receive_enabled, or is_enqueue_enabled is disabled.

Service Broker - Task Limit Reached/Sec
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Checks for Task Limit Reached/sec Total counter >= 1.

Service Broker - Transmission Queue Errors
Counts the number of messages in sys.transmission_queue where is_conversation_error is true.

Sleeping Sessions With Old Open Transactions
Detects when there are sleeping sessions with open transactions older than 10 minutes by default. Such
sessions can cause blocking, and can prevent the transaction log from clearing, leading to excessive log file
growth, and space exhaustion. When snapshot isolation is used, they can prevent version cleanup from
occurring in tempdb.
The start time, session_id, host, application and database are returned for the oldest five transactions by
default. The query itself only returns transactions older than five minutes by default, to avoid bringing back
unnecessary results on systems with many short-running transactions.
SELECT TxDesc = '[' + CONVERT(varchar, es.last_request_start_time, 120) + '] (' + CAST(es.session_id AS varchar(6))
+ ') ' + host_name + ':' + program_name + ' [' + DB_NAME(dt.database_id) + ']'
, OpenMinutes = DATEDIFF(minute, es.last_request_start_time, GETDATE())
FROM sys.dm_exec_sessions es
JOIN sys.dm_tran_session_transactions st
ON es.session_id = st.session_id
JOIN sys.dm_tran_database_transactions dt
ON dt.transaction_id = st.transaction_id
WHERE dt.database_id <> 32767
AND status = 'sleeping'
AND es.last_request_start_time < DATEADD(MINUTE, -5, GETDATE())
ORDER BY es.last_request_start_time
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SQL File Auto-growth Disabled
This condition queries the SQL Sentry database to detect when auto-growth has been disabled for any data or
transaction log file.
Although auto-growth should be considered a contingency for unexpected file growth vs. the primary means
of managing growth, disabling it can lead to eventual free space exhaustion that halts all DML activity.
For more information, see the Consideration for the Autogrow and Autoshrink settings article.
SELECT
DBFileName = EC.ObjectName + '.' + SF.Name
,SF.Growth
FROM EventSourceConnection EC
JOIN PerformanceAnalysisSqlFile SF
ON EC.ID = SF.EventSourceConnectionID
WHERE EC.IsPerformanceAnalysisEnabled = 1

SQL File Auto-growth Exceeds Free Space
Queries the SQL Sentry database to detect when the next auto-growth exceeds either available free disk
space or the max file size. The key column represents the server and file name, and the value column
represents the space debt in MB.
The space debt is the minimum of the free space (PerformanceAnalysisDeviceLogicalDisk.FreeSpace) minus
the growth size setting (PerformanceAnalysisSqlFile.Growth) or the maximum size
(PerformanceAnalysisSqlFile.MaxSize) minus the current size plus growth size.
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SELECT
DBFileName
,SpaceDebtMB = MIN(SpaceDebtMB)
FROM
(
SELECT
DBFileName = EC.ObjectName + '.' + SF.Name
,SpaceDebtMB = (LD.FreeSpace / 1024.0 / 1024.0) - (SF.Growth / 128)
FROM EventSourceConnection EC
JOIN PerformanceAnalysisSqlFile SF
ON EC.ID = SF.EventSourceConnectionID
JOIN PerformanceAnalysisDeviceLogicalDisk LD
ON LD.DeviceID = EC.DeviceID
AND LD.Name = LEFT(SF.FileName, LEN(LD.Name))
WHERE SF.Growth > (LD.FreeSpace / 8192)
AND EC.IsPerformanceAnalysisEnabled = 1
UNION
SELECT
DBFileName = EC.ObjectName + '.' + SF.Name
,SpaceDebtMB = (SF.MaxSize - (SF.Size + SF.Growth)) / 128
FROM EventSourceConnection EC
JOIN PerformanceAnalysisSqlFile SF
ON EC.ID = SF.EventSourceConnectionID
JOIN PerformanceAnalysisDeviceLogicalDisk LD
ON LD.DeviceID = EC.DeviceID
AND LD.Name = LEFT(SF.FileName, LEN(LD.Name))
WHERE SF.MaxSize = -1
AND (SF.Growth + SF.Size) > SF.MaxSize
AND EC.IsPerformanceAnalysisEnabled = 1
) DBFiles
GROUP BY DBFileName

SQL Sentry Monitoring Service Offline
Returns the SQL Sentry (or SentryOne) monitoring service that's been offline the longest in any site with
actively watched connections. This condition only works when two or more monitoring services are used.
To avoid triggering this condition when intentionally stopping a service, temporarily move it into a site with
no watched connections using Site Configuration.
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SELECT TOP 1 dbo.ManagementEngine.ServerName
FROM
(
SELECT Device.ID
, Device.SiteID
FROM dbo.Device
WHERE IsPerformanceAnalysisEnabled = 1
UNION
SELECT Device.ID
, Device.SiteID
FROM dbo.EventSourceConnection
INNER JOIN dbo.Device
ON dbo.EventSourceConnection.DeviceID = dbo.Device.ID
WHERE EventSourceConnection.IsWatched = 1
OR EventSourceConnection.IsPerformanceAnalysisEnabled = 1
) WatchedDevices
INNER JOIN dbo.ManagementEngine
ON WatchedDevices.SiteID = dbo.ManagementEngine.SiteID
WHERE dbo.ManagementEngine.HeartbeatDateTime < DATEADD(minute, -3, GETUTCDATE())
OR dbo.ManagementEngine.HeartbeatDateTime IS NULL
ORDER BY ISNULL(dbo.ManagementEngine.HeartbeatDateTime, dbo.ManagementEngine.LastInitializationDateTime)

SQL Server Memory Exhaustion
Memory Grants Pending is the number of processes waiting for a query workspace memory grant. This value
should be zero, but it can go above zero in cases of severe memory pressure.
When it does, RESOURCE_SEMAPHORE waits are greater than zero, since this wait is a measure of the time
that queries had to wait for memory grants. This type is visible in the Waits chart tooltips for the Memory
class and category.

SQL Server Process Paged to Disk
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Under severe memory pressure, Windows can page the SQL Server process to disk, which can dramatically
impact SQL Server performance. This custom condition queries the ring buffer for the latest working set
utilization value for the SQL Server process, and it alerts if it drops beneath 75 percent. If no record exists,
100(%) is returned, which is the optimal state.
For more information, see the Reduce Paging of Buffer Pool Memory , Lock Pages in Memory, and SQL Server
Debates articles.

 Note: If the Lock pages in memory user right has been assigned to the SQL Server service user
account, it will prevent Windows from paging the SQL Server process.

SELECT MIN(MemUtilization)
FROM
(
SELECT
ISNULL(rec.x.value('(MemoryRecord/MemoryUtilization)[1]','tinyint'), 100) As MemUtilization
FROM (
SELECT TOP 1 CAST(orb.record AS XML) AS xmlRec
FROM sys.dm_os_ring_buffers AS orb
CROSS JOIN sys.dm_os_sys_info AS osi
WHERE orb.ring_buffer_type = 'RING_BUFFER_RESOURCE_MONITOR'
AND DATEADD(second, -((osi.cpu_ticks/(osi.cpu_ticks/osi.ms_ticks) - orb.timestamp) / 1000), GETDATE()) > DATEA
DD(minute, -120, GETDATE())
ORDER BY timestamp DESC
) rb
CROSS APPLY rb.xmlRec.nodes('Record') rec(x)
UNION
SELECT 100
) MU

SQL Server Process Physical Memory Low
This condition evaluates to true when sys.dm_os_process_memory.process_physical_memory_low is true. It
indicates that the process is responding to low physical memory.
For more information, see the sys.dm_os_process_memory article.
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SELECT process_physical_memory_low
FROM sys.dm_os_process_memory WITH (NOLOCK);

SQL Server Process Virtual Memory Low
This condition evaluates to true when sys.dm_os_process_memory.process_virtual_memory_low is true. It
indicates that more virtual memory is needed for the SQL Server process.
For more information, see the sys.dm_os_process_memory article.
SELECT process_virtual_memory_low
FROM sys.dm_os_process_memory WITH (NOLOCK);

Suspect Pages - Active Corrupt Pages
This condition queries the dbo.suspect_pages table located in the MSDB database. If there are any pages with
a status of one, two, or three, it evaluates to true, advising that there is potential corruption in databases on
the server being queried.
For more information, see the Monitoring for Suspect Pages article.
SELECT db_name(database_id) as databaseName, count(*) as corruptPages
FROM dbo.suspect_pages
WHERE event_type in (1,2,3)
GROUP BY database_id;
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Suspect Pages - High Row Count
This condition counts the number of rows present in the dbo.suspect_pages table in the MSDB database.
When the total count of rows in the table is greater than or equal to 900, it evaluates to true. This is because
the dbo.suspect_pages table is only allowed a maximum of 1,000 rows before it fills, at which point any new
suspect pages that are detected don't have information logged about them.
For more information, see the Monitoring for Suspect Pages article.
SELECT count(*) as suspectPageCount
FROM dbo.suspect_pages;

Suspect Pages - Increase in Fixed Pages
This condition queries dbo.suspect_pages in the MSDB database, checking the number of fixed pages (event
types 4, 5, and 7) per database. This condition evaluates to true if the number of fixed pages has increased
since the last check.
If this condition is true, it can mean that DBCC CHECKDB has corrected or deallocated pages. If Enterprise
Edition is in use and the database is in either an Availability Group or Mirroring session, it could indicate
that pages were fixed in Automatic Page Repair, alerting you to a potential corruption issue you might not
have otherwise observed.
For more information, see the Monitoring for Suspect Pages article.
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SELECT db_name(database_id) as databaseName, count(*) as fixedPages
FROM dbo.suspect_pages
WHERE event_type in (4,5,7)
GROUP BY database_id;

Tempdb Data Files
This condition evaluates to true when there are more data files than logical cores in use by SQL Server, or
there are more than four logical cores in use and fewer than four tempdb data files.
If the number of logical processors is less than or equal to eight, use the same number of data files as logical
processors. If the number of logical processors is less than eight, use eight data files, and then if contention
continues, increase the number of data files by multiples of four (up to the number of logical processors) until
the contention is reduced to acceptable levels or make changes to the workload/code.
For more information, see the Recommendations to Reduce Allocation Contention, Correctly Adding Data
Files, Trace Flag Usage , and TEMPDB – Files and Trace Flags and Updates articles.
DECLARE @TempDBFiles TinyInt
DECLARE @CPUCount TinyIntSELECT @CPUCount = COUNT(*)
FROM sys.dm_os_schedulers
WHERE STATUS = N'VISIBLE ONLINE' AND IS_ONLINE = 1;SELECT @TempDBFiles = COUNT(*)
FROM master.sys.master_files
WHERE database_id = 2
AND file_id <> 2;SELECT
CASE
WHEN @TempDBFiles = @CPUCount THEN 0
/* If there are more data files than CPU Cores then this may cause overhead */
WHEN @TempDBFiles > @CPUCount THEN 1
/* If there are 4 or more cores and less than 4 TempDB Data files there could be contention */
WHEN @CPUCount >= 4 AND @TempDBFiles < 4 THEN 2
ELSE 0
END [Contention];
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Tempdb Large Version Store
Checks for a tempdb version store that is greater than 100,000 KB.

Tempdb Low Unallocated Page Count
This condition evaluates to true when less than 10 percent when tempdb's page count is unallocated. This
may indicate that tempdb is running out of space and will soon experience autogrowth or hit a size limit.
For more information, see the sys.dm_db_file_space_usage article.
SELECT (CONVERT(DECIMAL(18,0),(SUM(unallocated_extent_page_count)))/(SUM(total_page_count))*100) as percent_
used
FROM tempdb.sys.dm_db_file_space_usage;

Tempdb Unequal File Size
The benefits of having multiple tempdb files can be lost if one of those files grows larger than the other files.
This condition evaluates to true if your tempdb files are not the same size. The query counts the distinct
tempdb file sizes from sys.master_files.
For more information, see the SQL Server tempdb Fixes and Adding Data Files articles.
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SELECT count(distinct size) as unique_sizes
FROM sys.master_files
WHERE database_id = 2
AND type_desc <> 'LOG';

Tempdb/CPU Configuration Warning
Check that you have one tempdb file per CPU core; up to eight files. As with most SQL Server topics, an it
depends caveat accompanies tempdb recommendations; however, starting with SQL Server 2016, Microsoft
creates a default number of eight tempdb files. It uses the number of cores if there are fewer than eight cores
or just one file it is SQL Server Express.
The first query counts the visible online CPUs from sys.dm_os_schedulers, and the second query counts the
number of tempdb files from sys.master_files. This condition evaluates to True when the count of CPUs isn't
equal to the count of tempdb files.
For more information, see the Install SQL Server from the Command Prompt and tempdb Should Always Have
one Data File per Processor Core articles.

 Note: As a general rule, if the number of logical processors is less than or equal to 8, use the same
number of data files as logical processors. If the number of logical processors is greater than 8, use 8
data files and then if contention continues, increase the number of data files by multiples of 4 (up to the
number of logical processors) until the contention is reduced to acceptable levels or make changes to
the workload/code.

SELECT count(cpu_id) as cpu_count
FROM sys.dm_os_schedulers
WHERE status = 'VISIBLE ONLINE';
SELECT count(Name) as tempdb_files
FROM sys.master_files
WHERE database_id = 2
AND type_desc <> 'LOG';
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Tempdb/CPU Configuration Warning > 8 CPUs
If you have many cores, set the number of tempdb files as a quarter to half the number of cores. This
condition verifies that you have at least the quarter ratio. This means if you have 32 cores and eight files, it
evaluates to false, but if there are more than 32 cores and only the eight default tempdb files, then it
evaluates to true.
The first query counts the visible online CPUs from sys.dm_os_schedulers and the second query counts the
number of tempdb files from sys.master_files.
Customize this based on contention or performance issues you have seen in your environments. Microsoft
recommends adding files in multiples of four, so you would likely want to go from eight to 12, 16, 20, etc.
For more information, see the Tempdb Fixes and Tempdb Should Always Have one Data File per Processor
Core articles.
SELECT count(cpu_id) as cpu_count
FROM sys.dm_os_schedulers
WHERE status = 'VISIBLE ONLINE';
SELECT count(Name) as tempdb_files
FROM sys.master_files
WHERE database_id = 2
AND type_desc <> 'LOG';
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Tintri High Datastore Throttle Latency
Checks for Tintri Datastore : Throttle Latency (ms) > 10.

Tintri High vDisk Throttle Latency
Checks for Tintri Virtual Disk : Throttle Latency (ms) Any > 10.

Tintri High VM Throttle Latency
Checks for Tintri Virtual Machine : Throttle Latency (ms) Any > 10.
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Trace Flags Number Turned On Changed
This condition evaluates to true when the number of trace flags set to ON (status = one) has changed. The
query analyzes the results of DBCC TRACESTATUS WITH NO_INFOMSGS to determine the status of the trace
flags.
CREATE TABLE [#TraceFlagsOn]
([TraceFlag] INT, [Status] INT, [Global] INT, [Session] INT);
INSERT INTO #TraceFlagsOn EXEC ('DBCC TRACESTATUS WITH NO_INFOMSGS');
SELECT Count(*) as TraceFlagsStatusOn
FROM #TraceFlagsOn
WHERE #TraceFlagsOn.Status = 1;
DROP TABLE [#TraceFlagsOn];

Trace Flags Total Number Changed
This condition evaluates to True when the number of trace flags enabled on the system has changed. The
query analyzes the results of DBCC TRACESTATUS WITH NO_INFOMSGS to determine the status of the trace
flags.
CREATE TABLE [#TraceFlags]
([TraceFlag] INT, [Status] INT, [Global] INT, [Session] INT);
INSERT INTO #TraceFlags EXEC ('DBCC TRACESTATUS WITH NO_INFOMSGS');
SELECT Count(*) as TraceFlagsTotal
FROM #TraceFlags;
DROP TABLE [#TraceFlags];
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VMware High Ballooning
This VMware-specific condition evaluates to true when a significant amount of memory has been reclaimed by
the host machine from the guest virtual machine(s).
For more information, see the vSphere Memory Management article.

VMware High Co-Stop %
This condition evaluates to true when the VMware Co-Stop time value is greater than three percent. This is
the time that a virtual machine is ready to run, but unable to run due to co-scheduling constraints. May be
indicative of too many vCPU resources.
For more information, see the CPU Counters article.

VMware High Ready Time % per vCPU
This VMware-specific condition evaluates to True when Ready Time % per vCPU is critically high.
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When a vCPU is ready to do work but is waiting for the hypervisor to schedule that work on one or more
physical CPUs, the vCPU accumulates Ready Time. This is often caused by having a high ratio of vCPUs to
physical CPUs on the host machine or having VMs of significantly different sizes (by vCPU count) on the same
host.
For more information, see the CPU Ready Time in VMware article.

VMware High Ready Time % per vCPU - Warning
This VMware-specific condition evaluates to True when Ready Time % per vCPU is within the warning
threshold.
When a vCPU is ready to do work but is waiting for the hypervisor to schedule that work on one or more
physical CPUs, the vCPU accumulates Ready Time. This is often caused by having a high ratio of vCPUs to
physical CPUs on the host machine or having VMs of significantly different sizes (by vCPU count) on the same
host.
For more information, see the CPU Ready Time in VMware article.

Windows Low Memory Notification
This condition queries the SQL Server ring buffer for recent occurrences of system-level
RESOURCE_MEMPHYSICAL_LOW alerts. These occur when Windows signals that physical memory is low and
can cause the SQL Server to release its memory in response.
For more information, see the Ring Buffer Resource Monitor and Diagnose Memory Issues in SQL Server blog

1517

posts.
SELECT COUNT(*) AS AlertCount
FROM (
SELECT CAST(orb.record AS XML) AS xmlRec
FROM sys.dm_os_ring_buffers AS orb
CROSS JOIN sys.dm_os_sys_info AS osi
WHERE orb.ring_buffer_type = 'RING_BUFFER_RESOURCE_MONITOR'
AND DATEADD(second, -((osi.cpu_ticks/(osi.cpu_ticks/osi.ms_ticks) - orb.timestamp) / 1000), GETDATE()) > DATEAD
D(minute, -6, GETDATE())
) rb
CROSS APPLY rb.xmlRec.nodes('Record') rec(x)
WHERE rec.x.value('(ResourceMonitor/IndicatorsSystem)[1]','tinyint') = 2
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SQL Sentry Advisory Conditions on GitHub
Last Modified on 28 December 2021

Introduction
Additional SQL Sentry Advisory Conditions are available through GitHub. In sentryone / advisoryconditions, there is a folder called s1-team-submitted that contains conditions outside of the standard
Advisory Conditions Pack. These conditions have been created by SQL Sentry team members (often the sales
engineering and support teams) and used across many of our customer installations. They are now available
on GitHub to make it easier to share them with everyone.

 Note:
These conditions may be less-universally applicable than the ones in the standard download pack
and you're encouraged to pick and choose the ones applicable to your needs.
These advisory conditions are provided as samples to get you started.
They may require additional setup or configuration to meet your needs (setting variables and
changing predicates in T-SQL, how often they evaluate, color highlighting, etc.). Please read
the descriptions for guidance.
The conditions listed in the sentryone / advisory-conditions / download-pack folder are already
part of your installation. Please ignore these for now as they are part of the standard Advisory
Conditions Pack.

Downloading
 Download: Go to https://github.com/sentryone/advisory-conditions

Downloading conditions from GitHub
Download zip file of all conditions (recommended)
This method will download all the advisory conditions available from the repository and allow you to import
the conditions you want to configure for your SQL Sentry environment.

 Note: Individual advisory conditions are tiny text files, so the entire zip file is currently under 1 MB.
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From sentryone / advisory conditions, select the Clone or download button, then select Download ZIP.

Download the ZIP file of all advisory conditions from GitHub

You'll be prompted to save advisory-conditions-master.zip:

Save the zip file when prompted

Once you have the files, you import them into SQL Sentry through the client. See the Advisory Conditions
article for instructions on accessing Import from the context menu.
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Import the conditions you want

Import the individual conditions that you want to configure for your environment. Don't forget to set up the
appropriate alerts and actions.

Download an individual condition
Navigate to an individual condition that you want to download and select the Raw button:

Select the Raw button from the individual condition

On the Raw page, you should be able to do a Save Page As command in your browser and save it as a text
file that ends in .condition:
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Perform a Save Page As from the browser

Now you'll have the individual condition to import through the SQL Sentry client:

Individual .condition file saved

Available Conditions
s1-team-submitted / auditing
Additional Information: See the Using SQL Sentry to Alert on SQL Server Database Object Changes
blog post for instructions on how to use/customize these auditing conditions and apply the Execute SQL
actions.

1522

Results format:
These advisory conditions return a list of databases ( Key) and the number of objects ( Value) meeting the
condition criteria. The default results look like this:

In the example above, the AdventureWorksDW2017 and AdventureWorksLT2017 databases each have
objects (11 and 2, respectively) that meet the condition criteria. To get the list of objects (e.g. stored
procedures, tables) you must run an additional query (manually) or set an action to run the query and email
the full list of results to you (automatically).

Stored Procedures - Created
This condition evaluates to True when it finds databases with stored procedures that have been created with
the past hour.
The results returned are number of procedures in a database that meet the condition ( Value) and the name of
the database that has the created procedures (Key).
If the condition evaluates to True, run the following query against the database(s) in the result set to get a list
of all procedures created today:
SELECT schema_name(schema_id), [name], create_date
FROM sys.procedures
WHERE create_date >= (SELECT CONVERT(DATE,GETDATE()))
ORDER BY create_date DESC;

An Execute SQL action can also be used to automatically email a list to you. See the sentryone-samples
repository on GitHub for a sample you can use.

Stored Procedures - Modified
This condition evaluates to True when it finds databases with stored procedures that have been modified with
the past hour.
The results returned are number of procedures in a database that meet the condition ( Value) and the name of
the database that has the modified procedures (Key).
If the condition evaluates to True, run the following query against the database(s) in the result set to get a list
of all procedures modified today:

1523

SELECT schema_name(schema_id), [name], modify_date
FROM sys.procedures
WHERE modify_date >= (SELECT CONVERT(DATE,GETDATE()))
AND modify_date != create_date
ORDER BY modify_date DESC;

An Execute SQL action can also be used to automatically email a list to you. See the sentryone-samples
repository on GitHub for a sample you can use.

Tables - Created
This condition evaluates to True when it finds databases with tables that have been created with the past
hour.
The results returned are number of tables in a database that meet the condition ( Value) and the name of the
database that has the created tables (Key).
If the condition evaluates to True, run the following query against the database(s) in the result set to get a list
of all tables created today:
SELECT schema_name(schema_id), [name], create_date
FROM sys.tables
WHERE create_date >= (SELECT CONVERT(DATE,GETDATE()))
ORDER BY create_date DESC;

An Execute SQL action can also be used to automatically email a list to you. See the sentryone-samples
repository on GitHub for a sample you can use.

 Note: If you have the SQL Sentry Scalability Pack, it's normal to see a table named [Partitioning].
[PartitionTracking_backup] created in the SQL Sentry database on a regular basis. You may want to
filter out this table name in the queries.

Tables - Modified
This condition evaluates to True when it finds databases with tables that have been modified with the past
hour.
The results returned are number of tables in a database that meet the condition ( Value) and the name of the
database that has the modified tables (Key).
If the condition evaluates to True, run the following query against the database(s) in the result set to get a list
of all tables modified today:
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SELECT schema_name(schema_id), [name], modify_date, create_date
FROM sys.tables
WHERE modify_date >= (SELECT CONVERT(DATE,GETDATE()))
AND modify_date != create_date
ORDER by modify_date DESC;

An Execute SQL action can also be used to automatically email a list to you. See the sentryone-samples
repository on GitHub for a sample you can use.

 Note:
The modified date is updated when there are changes to indexes and partitions associated with
the table (i.e. adding a new partition, deleting an index, etc.).
If you have the SQL Sentry Scalability Pack, it's normal to see a number of tables modified in
the SQL Sentry database on a regular basis due to the partitioning. You may want to filter
out these tables in the queries. See the SQL Sentry Scalability Pack Tables to Exclude from
Index Maintenance.sql query on GitHub to get a complete list of those tables.

Triggers - Created
This condition evaluates to True when it finds databases with triggers that have been created with the past
hour.
The results returned are number of triggers in a database that meet the condition ( Value) and the name of
the database that has the created triggers (Key).
If the condition evaluates to True, run the following query against the database(s) in the result set to get a list
of all triggers created today:
SELECT t.[name] as [trigger name],
t.is_instead_of_trigger as [is instead of],
SCHEMA_NAME(s.schema_id) as [parent schema],
OBJECT_NAME(t.parent_id) as [parent object],
o.type_desc as [parent type],
t.create_date
FROM sys.triggers t
JOIN sys.objects o
ON o.object_id = t.parent_id
JOIN sys.schemas s ON o.schema_id = s.schema_id
WHERE t.create_date >= (SELECT CONVERT(DATE,GETDATE()))
ORDER BY t.create_date DESC;

An Execute SQL action can also be used to automatically email a list to you.

Autogrowth Disabled for Database Files
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This condition evaluates to True when it finds database files in sys.master_files that are not set to auto grow.
The default query checks for rows and log files that are online and not read-only.
SELECT [name], growth
FROM sys.master_files
WHERE growth = 0 --fixed file size, no growth
AND [type] < 2 --includes Rows and Log only
AND [state] = 0 --include ONLINE only
AND is_read_only = 0; --exclude files that are read-only

Additional Information: See the sys.master_files article on Microsoft Docs for more information on the
options in this query to customize to the condition.

s1-team-submitted / backups
There are six backup advisory conditions:
The ones that have "with AGs" in their name work in environments that have a mix of Availability Groups
and no Availability Groups.
If you are using the "with AGs" conditions, you do not need to use the other three, unless you have
monitored targets that are running versions of SQL Server that are older than 2012.
The conditions that do not include Availability Groups are appropriate for environments not using
Availability Groups, including monitored targets that are on SQL Server versions earlier than 2012.

Database Backup Diff SLA Breached - with AGs
Checks all user databases to find the last differential backup for each database.
Works in environments with and without availability groups
Restricted to SQL Server 2012 and higher
Ignores all system databases, distribution, and ReportServerTempDB databases
Ignores read-only databases
Ignores databases in a standby state
Ignores databases identified as a database snapshot
Default threshold is 48 hours, please change to meet your own service level agreements (SLA).
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Database Backup Full SLA Breached - with AGs
Checks all user databases to find the last full backup for each database.
Works in environments with and without availability groups
Restricted to SQL Server 2012 and higher
Ignores TempDB and ReportServerTempDB databases
Ignores read-only databases
Ignores databases in a standby state
Ignores databases identified as a database snapshot
Default threshold is 24 hours, please change to meet your own service level agreements (SLA).

Database Backup Log SLA Breached - with AGs
Checks all user databases to find the last t-log backup for each database.
Works in environments with and without availability groups
Restricted to SQL Server 2012 and higher
Ignores model, tempdb, and ReportServerTempDB databases
Ignores read-only databases
Ignores databases in a standby state
Ignores databases identified as a database snapshot
Ignores databases in simple recovery mode
Default threshold is 4 hours, please change to meet your own service level agreements (SLA).
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Legacy Backup Conditions
The following versions of the backup conditions that work in older versions of SQL Server:
Database Backup Diff SLA Breached
Checks all user databases to find the last differential backup for each database.
Ignores all system databases, distribution, and ReportServerTempDB databases
Ignores read-only databases
Ignores databases in a standby state
Ignores databases identified as a database snapshot
Default threshold is 48 hours, please change to meet your own service level agreements (SLA).

Database Backup Full SLA Breached
Checks all user databases to find the last full backup for each database.
Ignores TempDB and ReportServerTempDB databases
Ignores read-only databases
Ignores databases in a standby state
Ignores databases identified as a database snapshot
Default threshold is 24 hours, please change to meet your own service level agreements (SLA).
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Database Backup Log SLA Breached
Checks all user databases to find the last t-log backup for each database.
Ignores model, tempdb, and ReportServerTempDB databases
Ignores read-only databases
Ignores databases in a standby state
Ignores databases identified as a database snapshot
Ignores databases in simple recovery mode
Default threshold is 4 hours, please change to meet your own service level agreements (SLA).

s1-team-submitted / miscellaneous
Advisory Condition Cleared (% Free Space - Disk Per Server)
This condition will, per server, monitor whether a given advisory condition that has been met, has changed
back to a cleared status.

 Note: This has been tested with SQL Sentry advisory conditions but not with global advisory
conditions, so it may not work as expected against global ones.

 Important: You must create a copy per advisory condition you wish to get an all clear on. This requires
editing the SQL Sentry database Query as well, and substituting the name of the advisory condition in the
condition name and query. In this example, the name used is % Free Space - Disk Per Server.
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-- *** CHANGE THE ADVISORY CONDITION NAME BELOW ***
SELECT
AlertingChannelLog.ParentObjectName + ':' + CAST(AlertingChannelLog.ID AS NVARCHAR(800)),
COALESCE(CAST(NormalizedEndTimeUtc AS NUMERIC), 0)
FROM (
-- Make sure we always pull the most recent AlertingChannelLog log entry for a given
-- server/advisory condition combination
SELECT
MAX(AlertingChannelLog.ID) AS MaxAlertingChannelLogID,
AlertingChannelLog.ObjectID
FROM dbo.DynamicConditionDefinition
INNER JOIN dbo.AlertingChannelLog
ON AlertingChannelLog.DynamicConditionID = DynamicConditionDefinition.ID
-- *** CHANGE THE ADVISORY CONDITION NAME BELOW ***
WHERE DynamicConditionDefinition.Name = '% Free Space - Disk Per Server'
GROUP BY AlertingChannelLog.ObjectID
) AS MaxAlertingChannelLog
INNER JOIN dbo.AlertingChannelLog
ON AlertingChannelLog.ID = MaxAlertingChannelLog.MaxAlertingChannelLogID
INNER JOIN dbo.EventSourceConnection
ON AlertingChannelLog.ObjectID = EventSourceConnection.ObjectID
WHERE EventSourceConnection.ID = @ConnectionID

Database State - Offline
Lists all databases that are in an offline state.
Condition is met if the list changes.
On some servers, having databases offline is expected.
Review the CSV output list of databases offline to see if there is a new result.
Also checks databases that are part of an availability group.
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Database State - Suspect or Emergency
Lists all databases that are in a Suspect and/or Emergency state.
Condition is met if the list changes.
Review the CSV output list of databases.
Also checks databases that are part of an availability group.

Database State - Changed
Detects if a database has changed state from the state it was in at the prior evaluation.

 Note: This applies for any state change, so will alert for databases that are come ONLINE, are
intentionally taken OFFLINE, and so on. You can adjust this behavior to filter out database states that
are not relevant to you, by adding a predicate filter to the SQL Server Query (see the other Database
State... conditions for examples).
Additional Information: See the sys.databases article on Microsoft Docs for a complete list of the
state values.
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Has KB Been Installed
Example advisory condition to check if a specific KB or hot-fix was applied to all SQL Servers.
Substitute the KB of interest into WMI Query and Explicit Value. This example uses KB4049179.
SELECT HotFixID FROM Win32_QuickFixEngineering WHERE HotFixID = 'KB4049179'

Tables Approaching Maximum Number of Table Partitions
This condition evaluates to True when it finds databases with tables that have a number of partitions that is
greater than 14,500. Current versions of SQL Server support 15,000 partitions maximum, and versions prior to
2012 support up to 1,000. Current versions of SQL Server may experience performance issues when there are
more than 1,000 partitions (as explained in the Microsoft Docs article on Partitioned Tables and Indexes).
The results returned are number of tables in a database that meet the condition (Value) and the name of the
database that has the tables (Key). If the condition evaluates to True, run the following query against the
database(s) in the result set to get a list of all tables meeting the condition and the number of partitions in
each:
SELECT DISTINCT [t].[name], [p].[partition_number]
FROM sys.partitions p WITH (NOLOCK)
INNER JOIN sys.tables t WITH (NOLOCK)
ON p.object_id = t.object_id
WHERE [p].[partition_number] = (SELECT MAX([sp].[partition_number])
FROM sys.partitions sp WITH (NOLOCK)
WHERE [sp].[object_id] = [t].[object_id]
AND [sp].[partition_number] > 14500)
AND [p].[partition_number] > 14500;
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 Note:
This returns up to 100 databases in the alert (this is the Maximum Instance Count).
It uses SQL Server 2012 as the Minimum version ( 11.0) which allows for up to 15,000 partitions. If
you are monitoring SQL Servers on lower versions, you may want to copy/change this condition to
use lower versions and change the 14500 value in the query to something less than 1,000.
Adjust the 14500 value in the SQL Server Query depending on the needs of your environment and
how often new partitions are created.
This is set to run daily (every 24 hours) in the Default Evaluation Frequency and that may need to
be adjusted based on how often new partitions are created, as well as the Severity level.
If your primary concern is potential performance issues associated with having more than 1,000
partitions, consider creating a clone of this condition and updating the name/settings to reflect
that scenario.

s1-team-submitted / scalability-pack
These conditions are only for SQL Sentry databases that have the SQL Sentry Scalability Pack installed. While
the default scalability pack settings work for most environments, it's important that you contact the support
team if any errors surface related to the scalability pack to ensure that your settings are configured for
optimal performance and data flow.

CCI Partitioning Errors Exist
Contact our support team for assistance. Query the [Partitioning].[ActionErrorLogging] table to view error
details. Table holds 7 days worth of information.
To view error messages:
SELECT * FROM [Partitioning].[ActionErrorLogging]
WHERE [Action] = 0
ORDER BY ActionTime DESC;

1533

 Note: Errors are often caused by enabling index maintenance jobs or statistics updates against tables
that should be excluded.
This usually surfaces as an error message like Transaction (Process ID 123) was deadlocked on lock
resources with a... related to a process such as ALTER PARTITION SCHEME
[PerfromanceDataCurrentScheme] NEXT USED [Primary] and statements such as SELECT StatMan([SC0])
FROM (SELECT TOP 100 PERCENT [DeviceID] AS [SC0] FROM [dbo].[PerfromanceDataAnalysis] showing
up in Top SQL around the same time as the error.
Any tables found by the SQL Sentry Scalability Pack Tables to Exclude from Index Maintenance.sql
script on GitHub should be excluded from any index maintenance you perform against the SQL Sentry
database when the scalability pack is installed.

High Number of Table Partitions in SQL Sentry Database
Evaluates to True when there are 10,000 or more partitions in a table in the SQL Sentry database. Microsoft
SQL Server has a limit of 15,000 partitions per table.
Contact our support team to determine if there are configuration changes needed to adjust the rate of table
partitioning for this environment.

High Rows in In-memory Staging Table
Returns all in-memory performance data staging tables with an unusually high number of rows.
Default=500,000, but this may need to be adjusted per environment.
When the number of rows is over the threshold, it means that the MovePABufferData procedure is not
keeping up with the volume of incoming performance data, and thus is not moving data from the in-memory
tables into the CCI tables quickly enough.
This can be caused by:
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1. High latency network links between the SQL Sentry monitoring service(s) and the SQL Sentry database
which is causing the performance data for some targets to be written too slowly. The
MovePABufferData process will wait up to 60 seconds by default for committing each new timestamp,
and continual lag may lead to an accumulation of staging data. Contact our support team for assistance
troubleshooting slow links.
2. The MovePABufferData process is not running -- the associated thread may have experienced an error
and not restarted successfully. Restart the primary SQL Sentry monitoring service to reset it -- this is the
one with with the oldest Last Initialized time under All Targets -> Show Monitoring Services List.
3. Transient maintenance activities like index rebuilds, backups, etc., which can cause resource contention
and/or blocking leading to temporary queuing of the staging data. The max value can be adjusted to
account for these spikes, or a Response Ruleset can be used to wait for n minutes before alerting.

Partition with High Number of Rows
Evaluates to True on columnstore partitions with more than 20 million rows in the SQL Sentry database.
Please contact our support team if this happens as the partitioning configuration options will need to be
analyzed and perhaps adjusted for optimal performance.

s1-team-submitted / ssas
SSAS Formula Engine Query Pool Job Queuing
The query pool refers to Formula Engine activity for queries. If you're seeing consistently high queue lengths,
but not high CPU utilization, adjust your MaxThreads and/or CoordinatorExecutionMode properties for your
SSAS instance.
Remember that the Formula Engine is single threaded, so increasing the query pool setting may not improve
performance of any one query, but it may improve the performance in handling multiple simultaneous
requests.
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Additional Information: See section 6.11 of the SSAS 2008 Performance Guide.

SSAS High Memory Limit Exceeded
SSAS uses memory limit settings to determine how it allocates and manages its internal memory.
Memory\LowMemoryLimit defaults to 65 percent of the total available physical memory on the machine (75
percent on AS2005), and Memory\TotalMemoryLimit (also sometimes called the High Memory Limit) defaults
to 80 percent. This is the total amount of memory that the SSAS process itself (msmdsrv.exe) can consume.
Once memory usage hits the low limit, the memory cleaner threads starts moving data out of memory. If
memory hits the total limit, the cleaner goes into crisis mode. It spawns additional threads and gets more
aggressive about memory cleanup, and this can dramatically impact performance.

SSAS Low Memory Limit Exceeded
SSAS uses memory limit settings to determine how it allocates and manages its internal memory.
Memory\LowMemoryLimit defaults to 65% of the total available physical memory on the machine (75% on
AS2005), and Memory\TotalMemoryLimit (also sometimes called the High Memory Limit) defaults to 80
percent. This is the total amount of memory that the SSAS process itself (msmdsrv.exe) can consume.
Once memory usage hits the low limit, the memory cleaner threads start moving data out of memory. If
memory hits the total limit, the cleaner goes into crisis mode. It spawns additional threads and gets more
aggressive about memory cleanup, and this can dramatically impact performance.
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SSAS Storage Engine IO Job Queuing
The IOProcess thread pool separates reads from other activities. If the I/O job queue length is consistently
above zero, you may be experiencing an I/O bottleneck.
For more information, see the Analysis Services MOLAP Guide for SQL Server 2012 and 2014.

SSAS Storage Engine Processing Pool Job Queuing
Depending on your version of SSAS, queuing of jobs in this pool can be related to all Storage Engine activity
(SSAS 2005 to 2008R2), or strictly processing activity in SSAS 2012 and above.
For more information on optimizing this activity for your version of SSAS, see the appropriate Microsoft SSAS
Performance Guide.

SSAS Sustained Cache Evictions
If Cache Evictions/sec or Memory : KB shrunk/sec are consistently above zero, you may have memory
pressure on the SSAS instance. This is often seen when SSAS memory usage exceeds configured limits.

SSAS Sustained Connection Failures
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A sustained value above zero indicates an inability for users to successfully connect to SSAS. This could be
related to overburdened resources on the server.

s1-team-submitted / storage
% Free Space - Disk Per Server
A SQL Sentry database Query that returns all disks (per monitored server) with less than 10% free space. The
alert format is returned as follows: Key (server name), value (% free space).

 Note: The type is SQL Server, not SQL Sentry (or SentryOne), which is useful if you wish to set
different thresholds on different types of servers (dev vs. prod).

Windows Volume Exhaustion Date Changed
This condition evaluates to True if any forecasted exhaustion dates for any drives are within one year of the
current date and have had that date change to be at least 30 days earlier than previously forecast.
This can help identify situations where a new database has been deployed, or a workload changed, possibly
leading to accelerated database growth. That might lead to a much earlier exhaustion date, without you
being caught by surprise.
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Additional Information: Introducing Storage Forecasting with SQL Server Machine Learning Services

Windows Volume Forecasted Exhaustion Within 90 Days
This condition checks the Resource Exhaustion Dates (REDs) for all forecasted volumes and evaluates to
True if any occur within the next 90 days.
The value can be extended past 90 days, but note the REDs will only be provided if they are calculated within
the forecast range, which is 180 days by default.
This condition returns up to 100 records, which is the maximum configurable for any advisory condition.

Additional Information: Introducing Storage Forecasting with SQL Server Machine Learning Services
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SQL Sentry Actions & Alerts Overview
Last Modified on 18 May 2021

SQL Sentry Portal: This feature is available in SQL Sentry Portal. To learn more about configuring your
environment to use the on-premises, browser-based option with your existing SQL Sentry database, see
the SQL Sentry Portal article.
 See the Monitor Alerts article for an example of how alerts appear in the SQL Sentry Portal.
 Note: The configuration option shown for SentryOne Monitor does not exist in SQL Sentry Portal as
that is all done through the SQL Sentry client.

Alerting and Response System
SQL Sentry employs a comprehensive alerting and response system. The alerting and response system uses
the concept of Conditions and Actions. Conditions describe the various states of monitored objects. SQL
Sentry allows you to define criteria for when Conditions are met using various Settings like Condition
Settings. As a response to Conditions taking place, Actions can be configured. You can refine how often
Actions are carried out using Response Rulesets. To control the time frame of when an Action is processed
you may apply a Window directly to any configured Action.
Conditions and Settings are all hierarchical, working through the principle of inheritance. Conditions and
Settings applied at the global level (All Targets node), are automatically inherited by all objects below that
node. Any inherited Conditions or Settings can then be overridden at each lower level as needed. Open the
Conditions pane by selecting View > Conditions; open the Settings pane by selecting View > Settings.
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Conditions pane

Settings pane

 Note: You can design your alerts and responses at a high level (global / All Targets) and then fine
tune them as necessary at the lower levels (sites, targets, target groups, instances, objects). For a visual
representation of these different levels, see the Alerting and Response System Hierarchy diagram.

The following table contains a brief description of the different concepts within the SQL Sentry alerting and
response system. For detailed information concerning each concept, select the links to open the individual
sub-topics.

Concepts
Concept

Description

1541

Concept

Description

Contact Management

The Contacts node is used to create and
maintain Users and Groups within your SQL
Sentry environment. Once a User or Group is
created they can be chosen as a target for the
Send Email /Send Page action.

Conditions

Conditions describe the various states of
monitored Event Objects or associated
Performance Counters. You define Actions to
take when Conditions are met.

Condition Settings

Condition Settings allow you to define rules
that a Condition must meet for the Condition to
be fully satisfied. Condition Settings are
applicable to most General Conditions and all
Audit and Failsafe conditions and are
configured using a visual Filter Editor.

Actions

Actions determine what happens when a
Condition is met, including sending
notifications, executing a process, etc.

Settings

Settings define criteria for when a Condition is
considered to be met, including runtime
thresholds for events that are captured. Source
Settings define what events are collected by
SQL Sentry.

Response Rulesets

Response Rulesets control how often Actions
are taken in response to Conditions being met.
Response Rulesets assign additional criteria on
top of the Condition itself that must be met
before an Action takes place. The default setting
is Notify EveryTime.

Windows

Windows may be applied directly to any
configured Action to control the time frame of
when that Action is processed. Windows may
also be applied to Users or Groups.

Object Groups

Object Groups exist outside of the normal SQL
Sentry Hierarchy. An Action or Setting
configured for an Object Group is applied last,
after any inherited or explicitly defined
Action or Setting. Object Groups are useful
when you need to apply like policies to a set of
objects that don't exist within the same
hierarchical groups in your SQL Sentry
environment.
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Alerting and Response System Hierarchy

Actions and Settings have a hierarchical configuration, meaning that Settings applied at the global level (All
Targets) are automatically inherited by all objects below that node. Inherited Conditions and Settings can
then be overridden at each level as needed. These new Conditions and Settings are then inherited by each
object below that level. The following diagram shows the flow of inherited Conditions and Settings. It also
shows those levels at which the Conditions and Settings panes are available for configuration.
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Example of the SQL Sentry SQL Sentry Hierarchy. Connections and Objects may vary by target type.
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SQL Sentry Alerting and Response System
Settings
Last Modified on 06 December 2021

Settings are especially relevant in the context of the alerting and response system because certain
Settings define the criteria of when a Condition is considered to be met. This includes Runtime Threshold
Settings.
Other Settings, known as Source Settings define the events that are collected by SQL Sentry. Source
Settings define minimum duration thresholds for the collection of events taking place in the monitored
environment. Certain Settings control the synchronization of events, including History Filter settings.
History Filters are available for select Event Sources. With History Filters you define rules that control the
types of events the Monitoring Service writes into Event History concerning your monitored servers. If an
event doesn't meet the criteria you've defined in the History Filter, information about that event isn't
written to your SQL Sentry database.
All Source Settings have a direct correlation to Conditions being met, because an event must first be
captured before any Condition related to it can be evaluated.

 Note: These Settings include various Collection Settings.

Where to Configure Settings
Settings can be configured at the following levels:
Global (All Targets)
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Site
Target Group
Target
Instance
Individual object
Settings are hierarchical, and work through the principle of inheritance, meaning that Settings applied at the
Global level (All Targets) are automatically inherited by all the sites, target groups, targets, instances, and
objects in your environment.

 Note: Generally it's a good idea to first configure your Settings globally, and then adjust individual
Settings as needed at the lower levels.

Configuring Settings
To Configure a Setting, do the following:
1. Select the desired node where you want to configure settings in the Navigator pane (View >
Navigator > desired node). For example, select the All Targets node if you want to configure Settings
Globally, or select an individual instance node if you'd like to configure Settings specific to that instance.

2. Select View > Settings to open the Settings pane for your desired node.
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3. Select the Settings you'd like to configure from the drop-down list in the Settings pane.

Within the Settings pane, directly beneath the drop-down lists, the full path of each Settings group is
displayed. This path contains all of the ancestor objects for the selected Setting. Each Setting also has an
Inherit From Parent flag that specifies if the Setting is being inherited. When this flag is set to true the name
of the ancestor object that's passing down the inherited Settings is listed.

For example, if you initially configure your Settings globally, as you get to the target and instance level, you'll
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see that each child Setting contains an Inherit From Parent (Global) listing, with the flag set to True. This
lets you know that these Settings are being inherited from the Global level ( All Targets).

Configuring Settings Example
If you wanted to configure the Top SQL Minimum Duration Collection Setting Globally:
1. Select the All Targets node in the Navigator pane.

2. In the Settings pane, select SQL Server Settings from the first drop-down list.

3. Select Top SQL Source from the second drop-down list. You should now see the Top SQL Source
Settings that are being applied Globally.
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4. Change the Minimum Duration to the desired value, it's saved automatically.

If you wanted to configure the SQL Server Agent Job Maximum Runtime Threshold Percent for an
individual Instance:
1. Select the desired instance node in the Navigator pane.

2. In the Settings pane, use the top drop-down list and select SQL Server Settings.
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3. Use the second drop-down list to select SQL Server Agent Job. You should now see the SQL Server
Agent Job Settings that are configured for the instance.

4. In Runtime Thresholds change the Inherit From Parent Setting to False.
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5. Change the Maximum Runtime Threshold Percent to the desired value, it's saved automatically.

Comprehensive Listing of Settings
For more information about various settings, see the following topics:
SQL Server Settings
SSAS Settings
Windows Settings

Additional Information: For information about Fragmentation Manager related settings, including
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database source settings, see the Fragmentation Manager topic.

General Information About Select Settings
Runtime Thresholds Settings
Runtime Thresholds can be set for a number of sources such as SQL Server Agent Jobs.

Percent Based
A value for Minimum Runtime Threshold Percent and Maximum Runtime Threshold Percent can be
specified. The global Minimum Threshold Percent default is 10 percent. The Maximum Threshold Percent
default is 250 percent. Anytime a job runs for less than 10 percent or longer than 250 percent of its average
runtime the associated condition is met and any actions configured for that condition take place.

 Note: If too many messages are being received, these settings can be adjusted as needed.

Time Based
Explicit time-based thresholds can be specified. Anytime an explicit time-based threshold is specified it
overrides the percentage based thresholds for that object. Time-based thresholds are usually less valuable at
the Global level, particularly the Minimum Runtime Threshold. Explicit runtime thresholds tend to be more
applicable at the actual instance or object level for overriding the global percentage thresholds on a case-bycase basis.

 Note: One notification will be sent once the Maximum Runtime Threshold is met and a separate
notification is sent once it's completed.

For example, consider a job that has a great deal of volatility in runtime such as a transaction log backup,
which can run for anywhere between 30 seconds and 30 minutes, and its average runtime is five minutes. To
avoid unnecessary percentage-based threshold notifications for the job, one option is to set its Maximum
Runtime Threshold to 35 Minutes and Minimum Runtime Threshold to 20 Seconds. This can be done by
selecting either the job's node in the Navigator pane or an instance of the job on the Event calendar, then
follow the same steps as above to access and change the job's runtime threshold settings.

 Note: Runtime Threshold messages for Reporting Services Reports completing in less than two
minutes aren't processed until they are complete.
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Performance Counter Threshold Settings
Used to set the minimum and maximum values for the counter thresholds of that particular counter. These
trigger the Performance Counter: Threshold Min and Max conditions if any actions are enabled for them.
This option is only available when selecting a specific performance counter from the Navigator Pane.

 Note: There can be only one minimum and one maximum value for a given counter, regardless of
how many objects are linked to the counter. For more information about Performance Counters, see
the Performance Counter topic.

Target Settings
Setting

Description

Related Condition

Used to set a schedule for the
Maintenance Window. Only Log
Actions trigger for Failsafe conditions
inside the Maintenance
Window. Maintenance Window setting
Maintenance Window

allow a time frame to be specified while

Failsafe Conditions

daily maintenance activities take place on
that instance.
For more information, see the Schedules
and Windows topic.

Event Chain Settings
Setting

Description

Related Condition

Maximum Runtime Threshold

Define the maximum allowed
runtime for the Event Chain.

Event Chain: Runtime
Threshold Max

Minimum Runtime Threshold

Define the minimum allowed
runtime for the Event Chain.

Event Chain: Runtime
Threshold Min
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Event Chain Node Settings
Setting

Description

Related Condition

Maximum Runtime Threshold

Define the maximum allowed
runtime for the Event Chain
node.

Event Chain Node: Runtime
Threshold Max

Minimum Runtime Threshold

Define the minimum allowed
runtime for the Event Chain
node.

Event Chain Node: Runtime
Threshold Min

Setting

Description

Related Condition

General SMTP Server

The SMTP server or server
group used for email
notifications. For more
information, see the SMTP
Configuration topic.

N/A

Site Settings

 Note: SNMP Traps Settings
Locate the files for configuring SNMP MIBs in the SentryOne application folder C:\Program
Files\SentryOne\18.0\SNMP MIBs.

Additional Information: SQL Sentry is capable of interfacing with SCOM for purposes of alerting
through SNMP traps. See the SQL Sentry and System Center Operations Manager blog for more details.
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SQL Sentry Actions
Last Modified on 09 December 2021

Introduction

The alerting and response system in SQL Sentry uses the concept of Conditions and Actions. Actions can be
defined in response to certain Conditions being met within your environment. You can choose from a variety
of Actions, depending on which Condition is being responded to.
All Actions work on the principle of inheritance, meaning that if you configure an Action in response to a
Condition being met at the Global level ( All Targets), it's automatically passed down to all applicable
objects below it. This allows you to define global Actions for the most common issues across your
environment once, and have those passed down to every monitored server automatically. You can further
refine Actions at each level as needed. For a visual representation of how inheritance works within SQL
Sentry, see the Alerting and Response System Hierarchy diagram.
Each Action that's configured in your environment has an associated behavior. The behavior controls how the
Action is carried out relative to any inherited Actions. There are three action behaviors available:
Override Inherited Actions
Combine with Inherited Actions
Disabled
For a complete explanation and example usage scenario for each behavior, see Action Behaviors below.
Configure Actions for a specific group of objects or an individual object to give you control over how SQL
Sentry works throughout your environment. SQL Sentry comes with a number of global Actions predefined to
get you up and running quickly. These Actions can be changed, as needed to fit the specific needs of your
environment.
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Response Rulesets control how often Actions are taken in response to Conditions being met. They do this
by assigning additional criteria on top of the Condition itself, that must be met before an Action takes place.
To control the time frame of when an Action is processed apply a Window directly to any configured Action.

Configuring Actions
If you're upgrading from a previous version of SQL Sentry, you'll notice that the Conditions and
Settings pane has been updated.
The Conditions displayed in the Conditions pane change depending on which node or object you've selected
in the Navigator pane. If you don't see the Conditions pane once you've selected a node in the
Navigator pane, select View > Conditions.

Actions Overview

Conditions pane layout as noted in the image above from top to bottom:
The header reflects the currently selected object in the navigator.
The inherited section shows conditions and actions that are being passed down to the current level.
An inherited condition is grayed out in the inherited section when it's overridden or disabled.
The explicit section shows conditions and actions that have been set at the current level.

Disabled conditions display with red text in the explicit section.
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Select any condition in the inherited section to make the disable, override, and combine buttons
visible.
Select the All Targets node to see globally applied Conditions in the Conditions pane.

When you select any applicable object level below the All Targets node, you'll see two specific sets of applied
Conditions in the Conditions pane.
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The top section of the Conditions pane contains the Inherited section, which shows any applied
Conditions that are being passed down to the current object level. The Inherited section also contains an
Object column, which shows the object level the Condition is being inherited from. When an
Inherited condition is overridden or disabled, it still shows up in the Inherited section, but its text is grayedout, and its status says Overridden.
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Directly beneath the Inherited section, is the Explicit section. The Explicit section contains applied
Conditions that have been set at the current object level. The Explicit section also displays a
Behavior column. Each Action that's set up in your environment has an associated behavior. This behavior
controls how the Action is carried out relative to any inherited actions.

Adding a New Action
1. To add a new Action, select the desired node in the Navigator pane.

2. Select Add in the Conditions pane (View > Conditions) . This opens the Action Selector window.
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3. Expand the applicable object and Condition. Use the check box(es) to select which Actions should be
taken in response to this Condition being met. Select OK to save your changes.
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 Note: You may also choose to quickly Disable, Override, or Combine any inherited actions. To do so,
select a Condition in the Inherited section of the Conditions pane and choose the desired command
(Disable , Override, or Combine).

Action Behaviors
Each action that's setup in your environment has an associated behavior. This behavior controls how the
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action is carried out relative to any inherited actions.
The user can change the Behavior of any Action to one of the following:

Behavior

Description

Actions defined with this behavior override all actions that are being inherited
from a higher level. This Behavior acts as a special set of instructions that are
followed instead of the passed down (inherited) instructions.

Override
Inherited
Actions

When a Condition occurs that triggers an action defined with the Override
Inherited Actions behavior, inherited actions aren't executed, but the action
that's defined at that specific level is executed.
The Override Inherited Actions behavior is the default behavior assigned for any
newly defined action.
For an example scenario, see the Override Inherited Actions Example.

Actions defined with this behavior combine with all inherited actions. This
behavior acts as a set of instructions that are followed in addition to the passed
down (inherited) instructions.
Combine with
Inherited
Actions

When a Condition occurs that triggers an Action defined with the Combine with
Inherited Actions behavior, all inherited actions execute, and all actions that are
defined at that specific level also execute.
For an example scenario, see the Combine with Inherited Actions Example.

When an action is defined with the Disabled behavior it disables any action of the
same action type that's being inherited for a certain Condition. This behavior acts
as a special set of instructions that disallow the passed down (inherited) set of
instructions.
Disabled
When a Condition occurs that triggers an Action defined with the Disabled
behavior, inherited actions aren't executed.
For an example scenario, see the Disabled behavior example in this article.

Multiple Actions per Condition
One of the new improvements made to the alerting and response system is the ability to add multiple
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versions of the same action type per condition. Use this ability, in combination with Response Rulesets to
implement escalation procedures when certain Conditions take place.

 Note: Configured actions of the same action type, defined at the same object level, have their
behavior types bound together because inherited actions can't simultaneously be in more than one
state (Disabled, Combined, and Overridden).

 Note: For any condition you can choose multiple actions.

Examples

Override Inherited Actions Example
Actions defined with the Override Inherited Actions behavior override all actions that are being inherited
from a higher level. This behavior acts as a special set of instructions that are followed instead of the passed
down(inherited) instructions.
For this example assume the following:
There's a Send Email action configured at the Global level that has a selected target of DBA1 for the SQL
Server Agent Job: Failure condition.
With this Action configured as above, anytime a SQL Sever Agent Job fails across the entire monitored
enterprise the following will occur:
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1. The SQL Server Agent Job: Failure condition is met.
2. In response to the Condition being met, the Send Email action executes, sending a notification email to
DBA1.
Now suppose there's a development server (DEVServer ) in the environment, that's not managed by DBA1.
For this server, when an Agent Job fails, you'd like notification emails sent to the developer or user DEV1
instead of the user DBA1 being alerted.
To accomplish this, add a Send Email action with a selected target of DEV1, for the SQL Server Agent Job:
Failure condition at the instance level with a behavior of Override Inherited Actions.
With this Action configured as above, anytime a SQL Sever Agent Job fails on the development server the
following occurs:
1. The SQL Server Agent Job: Failure condition is met.
2. In response to the condition being met, the Send Email action executes, sending a notification email to
DEV1.
Only the development server is impacted by this change. The rest of the monitored enterprise is still subject
to the globally configured Send Email action that has a selected target of DBA1 .

Combine with Inherited Actions Example
Actions defined with the Combine with Inherited Actions behavior are combined with all inherited actions.
This behavior acts as a set of instructions that are followed in addition to the passed down(inherited)
instructions.
For this example assume the following:
There's a Send Email action configured at the global level that has a selected target of DBA1 for the SQL
Server: Offline condition.
With this Action configured as above, anytime a SQL Sever is detected to be offline across the entire
monitored enterprise, the following occurs:
1. The SQL Server: Offline condition is met.
2. In response to the Condition being met, the Send Email action executes, sending a notification email to
DBA1.
Now suppose there's a SQL Server (ASPServer) in the environment that has an internet facing workload.
When the SQL Server: Offline condition is met you'd still like to notify DBA1, but you'd also like to notify the
web developer, WEBDEV1.
To accomplish this, add a Send Email action, with a selected target of WEBDEV1 , for the SQL Server: Offline
condition at the instance level with a behavior of Combine with Inherited Actions.
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With this Action configured as above, anytime that the ASPServer is detected to be offline, the following
occurs:
1. The SQL Server: Offline condition is met.
2. In response to the condition being met, the Send Email action executes, sending a notification email to
DBA1 and WEBDEV1.
Only the ASPServer is impacted by this change. The rest of the monitored enterprise is still be subject to the
globally configured Send Email action for the SQL Server: Offline condition, that has a selected target of
DBA1.

Disabled Behavior Example
When an Action is configured for a Condition with the Disabled action behavior, it disables any action of the
same action type that's being inherited. This behavior acts as a special set of instructions that simply disallow
the passed down(inherited) set of instructions.
For this example assume the following:
On TestServer1 there's a Send Email action configured that has a selected target of DBA1 for the SQL Server
Agent Job: Runtime Threshold Max condition. This action is configured at the instance level.
With this Action configured as above, anytime any SQL Agent Job meets the Runtime Threshold Max
condition on TestServer1 the following occurs:
1. The SQL Server Agent Job: Runtime Threshold Max condition is met.
2. In response to the Condition being met, the Send Email action executes, sending a notification email to
DBA1.
Now suppose there's a job, LongRunningJob , that's known to be long running on TestServer1 . DBA1 doesn't
need to be alerted about it and would like to disable runtime notifications about this job.
To accomplish this, add a Send Email action for the SQL Server Agent Job: Runtime Threshold Max
condition at the object level(the LongRunningJob) with a behavior of Disabled.
With this Action configured as above when the LongRunningJob runs long, the following occurs:
1. The SQL Server Agent Job: Runtime Threshold Max condition is met.
2. In response to the Condition being met, the inherited Send Email action isn't executed.
Only the individual SQL Agent Job LongRunningJob is impacted by this change. The rest of the SQL Agent
Jobs on TestServer1 are still subject to the instance level Send Email action configured for the SQL Server
Agent Job: Runtime Threshold Max condition.

Available Actions
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Kill Task
The Kill Task action kills, or cancels the current job. This action is typically associated with Runtime
Maximum, Performance Threshold Maximum, Block, or Conflict conditions, to prevent resource contention
situations.

 Note: It's not applicable to the Started condition, or any conditions implying event instance
completion.

Log to Windows Event Log
The Log to Windows Event Log action sends data relevant to the condition to the application Event Log on
the SQL Sentry monitoring service computer.

Settings
Within the Actions Settings tab, select the Log type (Information, Warning, or Error) and then assign an
Event ID.
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In this example, there is an Log Type of Information and an Event ID of 9990. When the associated Advisory
Condition evaluates to true, the event is logged to the Windows Event Log on the computer running the SQL
Sentry monitoring service.

 Note: To find the logged Advisory Condition event, use the Windows Event Viewer. The logged
events are under Windows Logs and are of Application type. The Source is SQL Sentry.

Additional Information: SQL Sentry is capable of interfacing with SCOM for purposes of alerting
through SNMP traps or by passing alerts through the Windows Event Log. See the SQL Sentry and System
Center Operations Manager blog for more details.
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Log to Disk
The Log to Disk action sends data relevant to the condition to the specified text file on the SQL Sentry
monitoring service computer's file system.

Settings
Within the Actions Settings tab, enter the Log file where you want to store the condition data.

Send Email
The Send Email action sends an email alert to the Users or Groups specified in the Action Settings. For more
information about Users and Groups, see the Contact Management topic. Certain alert emails in version 7.0
now include a View in SQL Sentry client section. You'll notice that the Event View section contains a
hyperlink that begins with the SQL Sentry (or SentryOne) URL protocol. Selecting this link opens the Event
View in the SentryOne client for the specific condition that triggered the alert.
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 Note: Stop receiving the Outlook Security Notice when you select an alert email link by enabling
trust for the SQL Sentry protocol. Enable the SQL Sentry protocol by entering the appropriate key in the
Windows Registry Editor:
For Outlook 2010

[HKEY_CURRENT_USER\Software\Policies\Microsoft\Office\14.0\Common\Security\Trusted
Protocols\All Applications\sqlsentry:]
For Outlook 2013

[HKEY_CURRENT_USER\Software\Policies\Microsoft\Office\15.0\Common\Security\Trusted
Protocols\All Applications\sqlsentry:]
For Outlook 2015 or higher

[HKEY_CURRENT_USER\Software\Policies\Microsoft\Office\16.0\Common\Security\Trusted
Protocols\All Applications\sqlsentry:]

Additional Information: For more information about enabling trust to a specified protocol, see this
MSDN article.

Settings
The Actions Settings tab allows the following configurations:
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Option

Description

Select Targets

Specifies which Users or Groups receive the
email alert.

Importance

Specifies the importance level of the email alert.

From Address

Specifies the from email address of the alert. To
use the default email address leave this blank.
For more information, see the SQL Sentry
Monitoring Service Settings topic.

Execute SQL
The Execute SQL action executes the T-SQL statement(s) on the specified SQL Server.

Settings
Use the server list to select a server, and enter the desired T-SQL in the command text box. Selecting the
Target option executes the T-SQL statement against the server that triggered the condition.
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 Note: In an environment with multiple monitoring services, it's important to note that the service
that detects the condition is the service that fires the action. If that service doesn't have connectivity to
the targeted server, the action fails.

Send SNMP Trap
The Send SNMP Trap action sends a Simple Network Management Protocol (SNMP) trap notification. For
more information about configuring SNMP, see the SQL Sentry Monitoring Service Settings topic.

 Note: Locate the files for configuring SNMP MIBs in the SentryOne application folder C:\Program

Files\SentryOne\2021.0\SNMP MIBs.
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Additional Information: SQL Sentry is capable of interfacing with SCOM for purposes of alerting
through SNMP traps. See the SQL Sentry and System Center Operations Manager blog for more details.

Log To Database
The Log To Database action logs data relevant to the condition to the Actions log in the SQL Sentry
database.

 Note: Any of the other actions also write to the database, so if you’ve chosen another action this
may be redundant.

Execute Process
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The Execute Process action executes the defined command text on the specified SQL Server.

Settings
Within the Execute Process Action Settings tab you'll see the Execute Process section. Use the server list
to select a server. Selecting the Target option from the server list executes the process against the server
that triggered the condition. Use the Command Text box to enter the desired literal command.

 Note: You can pass certain system parameters, as well as user defined parameters through output
text.

Send Page
The Send Page action sends an alert to the pager address for the specified Users or Groups. For more
information about Users and Groups, see the Contacts Management topic.
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Settings
The Actions Settings tab for the Send Page action allows the following configurations:

Option

Description

Select Targets

Specifies which Users or Groups receive the
pager alert.

Importance

Specifies the importance level of the pager alert.

From Address

Specifies the From address of the alert. To use
the default email address leave this blank. For
more information see the SMTP configuration
section of the SQL Sentry Monitoring Service
Settings topic.

Run QuickTrace™
The Run QuickTrace™ action executes a QuickTrace™ against a specified target server. A QuickTrace™ is a
comprehensive snapshot of activity created by combining process-level data and trace events collected during
a brief sample period. A QuickTrace™ isn't filtered, so it collects all events on the specified SQL Server.

1575

 Note: The QuickTrace™ action is now available for a wide range of conditions.

Configuring the Run QuickTrace™ Action for a Condition
Enable the Run QuickTrace™ action to take place when a specified condition is met by completing the
following steps :
1. Select the desired node in the Navigator pane, and then open the Conditions pane ( View > Conditions).

2. Select the desired Condition type from the drop-down list, and then select Add to open the Action
Selector window.
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3. Select the desired Condition parameters on the left, and then select the Run QuickTrace™ action on
the right. Select Ok to save your Action for the Condition.
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To avoid impacting the performance of the target SQL Server, QuickTrace™ is time and size limited. Only one
simultaneous QuickTrace™ can be run against any target server. QuickTraces are throttled to control the
time between successive runs. The current allowed frequency is one minute, meaning that once a
QuickTrace™ is completed, another QuickTrace™ can't begin on the same specified server until one minute
has elapsed.

 Note: To avoid impacting server performance on very busy systems, there are certain cases where
SQL Sentry further restricts QuickTrace™ functionality. If one of these cases is detected the
QuickTrace™ action doesn't fire. For more information, see Quick Trace Restrictions.

Settings
Configure settings for the Run QuickTrace™ action using the Actions Settings tab on the Conditions pane.
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The Actions Settings tab for the Quick Trace™ action allows the following configurations:

Option

Description

Run QuickTrace Against

Specifies the Target server where the
QuickTrace™ runs.

Run QuickTrace for

Specifies the length of time that the
QuickTrace™ runs against the target server.

Collect Statement Events

Specifies whether to collect Statement Level
Events. Enabling the Collect Statement Events
option dramatically increases the amount trace
data collected.

Limit Trace Data to

Specifies the maximum number of rows that the
QuickTrace™ collects.

Execute Job
The Execute Job action executes a SQL agent job on the current server, or any other watched server in your
enterprise. This action enables you to create one-to-one job chains by associating it with Completed,
Success or Failure conditions. For more advanced chaining features, see Event Chains.
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Settings
Within the Action Settings tab you'll see the Jobs To Execute section. Select a server from the server list.
Specify the SQL agent job to run by using the job list. Once a target job has been specified for this action, it
shows up in the Event Calendar view with a grid pattern background as an indication of its conditional
execution.

Execute PowerShell
The Execute PowerShell Action executes the entered PowerShell script on the monitoring computer, the
target computer, or any valid Windows target.
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 Note: You may also use system parameters in the PowerShell script, with a format of
<%ParameterName%> (e.g, $ServerName = '<%ServerName%>').

Settings
Within the Action Settings tab you'll see the Server section. Select the server where the script will be
executed from the server list (on the monitoring server, on the target server, or on a specific watched
server).Select whether the defined PowerShell Execution Account, a domain account, or a local account runs
the script from the account list.

 Note: A valid user name and password must be provided in the Action Settings if the domain
account or local account options are selected.

Enter or load (selecting Load from File beneath the text area) PowerShell script text into the PowerShell
Script Text section. Select Test PoSh Script to test the entered script on a specified target.
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Additional Information: See the Using the SQL Sentry PowerShell Action blog post for in-depth
coverage of the Execute PowerShell action, including how to send notifications to Slack and Microsoft
Teams.

Send To Alerting Channels
This is the default action for all Advisory Conditions. The Send to Alerting Channels action allows open
Advisory Condition events to display in various places throughout the client. You can use the Send to
Alerting Channels action to highlight applicable charts on the alerting channel of the Performance Analysis
Dashboard. In addition to the highlight, a glyph also appears in the top left corner of the chart and provides
additional information pertaining to the Advisory Condition event. You can also use the Send to Alerting
Channels action to send a JSON post request to your configured webhook endpoints.

Performance Advisor Dashboard Example
In the image below, the High Disk Waits and Latency condition has been sent to the DISK IO chart. There is a
caution glyph on the chart as well as a highlighted area for when the condition was true.

This action must be configured in both the condition Action Settings and the condition definition.
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Within the Action Settings tab, selecting the Performance Analysis Dashboard option shows the open
Advisory Condition events on the Performance Analysis Dashboard provided that the Advisory Condition
involves a performance counter that's associated with one of the charts on the Dashboard.
If desired, select a user to be automatically assigned to an Advisory Condition event from the Automatically
Assign Event Log Entries To drop-down list.

With the above settings, the user Melissa Connors is automatically assigned to these occurrences in the
Events Log:

 Note: Response Ruleset options are not available for this action.

To complete the configuration, within the condition definition (Edit Advisory Condition), select the
appropriate option(s) from the Highlight on Dashboard Chart list. In the Color drop-down, select the desired
color to use when highlighting the Dashboard for this condition.
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In this example, a strong orange color is selected to highlight the Disk and SQL Server Waits charts on the
Performance Analysis Dashboard.

Additional Information: You can integrate with IFTTT (If This Then That) to received notifications. See
the Get SQL Sentry Alerts on Slack blog post for an example. See the SQL Sentry Integrations article for
more ideas.

Webhook Example

Feature Availability: Support for Webhooks is currently in a preview status. It is available in Version
2021.18 to those who are part of the feature preview program for this release.

For any Condition with a configured Send to Alerting Channels action, you can select to send a POST JSON
request to your desired endpoint. For more information about SQL Sentry Monitoring Service webhook
settings, see SQL Sentry Monitoring Service Settings.
In this example, the Audit: Settings Changed condition has the Send to Alerting Channels action
configured. Within the Action Settings tab, (if a webhook has been configured), selecting the webhook will
send a JSON POST request to the configured endpoint once the Audit: Settings Changed condition has been
met.
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SQL Sentry SQL Server Settings
Last Modified on 22 February 2022

Blocking SQL
Setting

Description

Related Condition

Maximum
Duration
Threshold

Sets the maximum allowed duration for the object.

Blocking SQL:
DurationThreshold
Max

Blocking SQL Source
Setting

Description

Related Condition

Maximum Rows
To Synchronize

Sets the maximum rows of historical event data to
collect from this source.

N/A

Minimum Block
Duration

Sets the time that must elapse before a Block
Condition is triggered.

All Blocking SQL
Conditions

Databases Source
For more information, see the Fragmentation Manager topic.

Deadlocks Source
Setting

Description

Related Condition

Maximum Rows
To Synchronize

Sets the maximum rows of historical event data to
collect from this source.

N/A
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Setting

Description

Related Condition

The filter used for history synchronization. Only
events that meet the filter criteria are written to the
database. For more information, see History Filter.
History Filter

 Note: The Deadlocks History Filter only impacts

N/A

what displays on the Event Calendar and doesn't
impact deadlock collection. For more information, see
Synchronization of Performance Analysis sources
section of the History filter topic.

Collect Deadlock
Events

Specifies whether a deadlock statement collection is
enabled.

All Deadlock SQL
Conditions

Index Defragmentation
For more information, see the Fragmentation Manager topic.

Maintenance Plan Source
Description

Related Condition

Auto-watch New
Objects

Specifies whether new objects are set to
watched when they are discovered.

All Maintenance Plan
Conditions - An
object must be
watched in order for
Conditions to be
evaluated for it.

Maximum Rows
To Synchronize

The maximum rows of historical data to collect for this
source.

N/A

Setting

Reporting Services Report
Setting

Description

Related Condition
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Setting

Description

Related Condition
Reporting Services
Report: Runtime
Threshold Max

Maximum
Runtime
Threshold

Defines the maximum allowed runtime for the object.

Maximum
Runtime
Threshold
Percent

Defines the maximum allowed runtime percent for the
object.

Reporting Services
Report: Runtime
Threshold Max

Minimum
Runtime
Threshold

Defines the minimum allowed runtime for the object.

Reporting Services
Report: Runtime
Threshold Min

Minimum
Runtime
Threshold
Percent

Defines the minimum allowed runtime percent for the
object.

Reporting Services
Report: Runtime
Threshold Min

Reporting Services Report Source
Description

Related Condition

Auto-watch New
Objects

Specifies whether new objects are set to
watched when they are discovered.

All Reporting
Services Report
Conditions -An object
must be watched for
Conditions to be
evaluated for it.

Maximum Rows
To Synchronize

The maximum rows of historical data to collect for this
source.

N/A

History Filter

The filter used for history synchronization. Only
events that meet the filter criteria are written to the
database. For more information, see History Filter.

N/A

Setting

SQL Server Agent Alerts Source
Setting

Description

Related Condition
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Description

Related Condition

Auto-watch New
Objects

Specifies whether new objects are set to watched
when they are discovered.

All SQL Server Agent
Alert Conditions - An
object must be
watched in order for
Conditions to be
evaluated for it.

Maximum Rows
To Synchronize

The maximum rows of historical data to collect for this
source.

N/A

History Filter

The filter used for history synchronization. Only
events that meet the filter criteria are written to the
database. For more information, see History Filter.

N/A

Setting

SQL Server Agent Job
Setting

Description

Related Condition

Maximum
Runtime
Threshold

The maximum allowed runtime for the object.

SQL Server Agent
Job: Runtime
Threshold Max

The maximum allowed runtime percentage for the
object.

SQL Server Agent
Job: Runtime
Threshold Max

Minimum
Runtime
Threshold

The minimum allowed runtime for the object.

SQL Server Agent
Job: Runtime
Threshold Min

Minimum
Runtime
Threshold
Percent

The minimum allowed runtime percent for the object.

SQL Server Agent
Job: Runtime
Threshold Min

Queue Others
for up to

The maximum length of time this job will queue other
jobs. For more information, see Job Queuing.

N/A

Maximum
Runtime
Threshold
Percent
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Setting

Description

Related Condition

Auto-Start
Threshold

Any job whose next scheduled run time is beyond the
specified threshold starts automatically upon leaving
the queue. If a job's next scheduled run time is before
the threshold it won't auto-start.

N/A

Queue Type

The behavior when this job is queued. For more
information, see Job Queuing.

SQL Server Agent
Job: Queued

Queue For Up To

The maximum length of time this job can queued. For
more information, see Job Queuing.

N/A

Auto-Start Type

Controls the auto-start behavior for the job when it
leaves the queue. Use default setting causes the
queuing job's Auto-Start Threshold setting to be
used.

N/A

SQL Sever Agent Jobs Source
Description

Related Condition

Auto-watch New
Objects

Specifies whether new objects are set to watched
when they are discovered.

All SQL Server Agent
Job Conditions - An
object must be
watched for
Conditions to be
evaluated for it.

Missed Run
Threshold

The length of time that must pass before an object run
is considered to be missed.

SQL Server Agent
Job: Run Missed

Maximum Rows
To Synchronize

The maximum rows of historical data to collect for this
source.

N/A

Setting

SQL Server Agent Log Source
Setting

Auto-watch New
Objects

Description

Related Condition

Specifies whether new objects are set to
watched when they are discovered.

All SQL Server Agent
Log Source
Conditions - An
object must be
watched in order for
Conditions to be
evaluated for it.
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Setting

Description

Related Condition

Maximum Rows
To Synchronize

The maximum rows of historical data to collect for this
source.

N/A

History Filter

The filter used for history synchronization. Only
events that meet the filter criteria are written to the
database. For more information, see History Filter.

N/A

SQL Server Instance
Setting

Description

Related Condition

Auto-enable SQL
Server Agent
Tokens

On SQL Server 2005 and above, SQL Agent Tokens are
disabled as a security measure. They must be enabled
to allow SQL Sentry to watch Alerts.

All SQL Server Agent
Alert Conditions

Specifies whether to automatically recycle large
Agent Log files. SQL Sentry polls the Agent Log for
history synchronization. If an Agent Log file becomes
Auto-recycle
large SQL Server
Agent Logs

too large, this polling causes timeout problems. To
prevent this, SQL Sentry stops polling and issues a
Client Alert if the Agent Log file exceeds one MB.

N/A

 Note: This problem often manifests when
informational level logging is enabled.

Maximum Queue
Length

The maximum number of objects that can be queued
at one time.
 Note: This setting always applies to the

SQL Server Agent
Job: Queued

instance level.

Synchronize
Type

This setting refers to how the SQL Sentry client
responds if it discovers the data in the SQL Sentry
Database isn't up to date. The default is to show a
message box warning of the condition and ask if the
SQL Sentry client should synchronize the information
itself.

N/A
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Setting

Description

Related Condition

Synchronization
Threshold

The amount of time that passes since the last
successful synchronization by the SQL Sentry
monitoring service before the client attempts to
synchronize directly with the target.

N/A

Max User
Databases to
Synchronize
(largest first)

The maximum number of user databases to
synchronize, ordered by total size. This includes
system databases.

N/A

Max User
Database Files
to Synchronize
(most active &
largest first)

The maximum number of user database files to
synchronize, ordered by most active and total size.

N/A

Used to set a schedule for the Maintenance Window.
Only Log Actions are triggered for Failsafe conditions
inside the Maintenance Window. Maintenance
Maintenance
Window

Window settings allow a time frame to be specified
while daily maintenance activities take place on that
instance.

Failsafe Conditions

For more information, see the Schedules and Windows
topic.

Top SQL
Setting

Description

Related Condition

Maximum
Runtime
Threshold

The maximum allowed runtime for the object. This
default value is one hour.

Top SQL: Runtime
Threshold Max

Top SQL Source
Setting

Description

Related Condition

Maximum Rows
to Synchronize

The maximum rows of historical data to collect for this
source.

N/A
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Setting

Description

Related Condition

Minimum
Duration

Determines the required duration for a Top SQL event
to be collected. The default setting is five seconds. For
safety reasons, it can't be reduced below 100ms
unless one of the CPU, Reads, or Writes filters is >
zero.

All Top SQL
Conditions

Minimum CPU

The minimum required CPU for a statement to be
logged.

All Top SQL
Conditions

Minimum Reads

The minimum required reads for a statement to be
logged.

All Top SQL
Conditions

Minimum Writes

The minimum required writes for a statement to be
logged.

All Top SQL
Conditions

Collect Trace
Events

Specifies whether to collect Trace Events. If Collect
Trace Events is disabled, SQL Sentry won't start a
trace or collect any Top SQL events from a monitored
target.

N/A

Specifies whether to collect Statement Events. If
Collect Statement Events is disabled, statementlevel information won't be available in the Plan
Explorer Statements Tree when viewing a query
plan.

 Warning: On systems with very high
transaction volumes that make extensive use of
Collect
Statement
Events

scalar functions, enabling Collect Statement
Events can cause a negative impact on
performance of the monitored target, regardless

N/A

of the effective Top SQL filter settings or the
number of events actually collected.

Additional Information: For more information,
see the MSDN article Unintended Consequences
of Scalar-Valued User Defined Functions.
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Setting

Description

Related Condition

Specifies whether to collect Execution Plans.
If Collect Execution Plans is disabled, Top SQL event
Collect
Execution Plans

collection occurs as normal; however, query plan
information won't be automatically collected for those
events.

N/A

 Note: Plan information can still be collected on
demand from within a Plan Explorer session.

Max Plan Size to
Collect (MB)

Specifies the max plan size to collect in MB. Default
value is three.

N/A

Running Events
Polling Interval

Specifies how often the service checks for running
events.

N/A

Collect Query
Stats

Specifies whether Query Stats collection is enabled.
This setting must be set to True for Procedure Stats
and Query Stats to function.

N/A

Query Stats
Sample Interval

Specifies how often to sample query stats.

N/A

Filter Time Span

Specifies the base length of time over which the
collection filters are applied to Query Stats.

N/A

Filter Factor

Calculated by dividing the Query Stats Sample
Interval by the Filter Time Span. The collection filters
such as Minimum Duration are multiplied by this
value when applied to Query Stats collection.

N/A

 Note: Top SQL Source:
There is an And relationship that exists between the Minimum Duration, Minimum CPU, Minimum
Reads, and the Minimum Writes collection settings. This means, that to be collected as Top SQL, the
event needs to satisfy each individual collection setting. For example, if you set the Minimum Duration
at 10 seconds and the Minimum Reads at 25, an event needs to meet both a Minimum Duration of 10
seconds And a Minimum Read of 25 to be captured in Top SQL.
Minimum Duration can't be set below 100ms unless Minimum CPU, Minimum Reads, or Minimum
Writes is greater than zero. This lower limit is enforced because setting this thresholds below 100ms for
an extended period of time could dramatically increase the volume of data collected and stored by SQL
Sentry, and have a negative impact on the monitored server. SQL Sentry's QuickTrace functionality is
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better suited to analyze extremely short duration events.
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SQL Sentry SQL Server Analysis Services Settings
Last Modified on 18 May 2021

Analysis Services Instance
Setting

Description

Collect Memory
by Category
Data

Enables or disables Memory by Category Data. This
setting is used to provide more detail than the basic
cleaner memory data, but is higher overhead to
collect. Use caution when enabling this setting to
ensure it doesn't impact performance.

Related Condition

N/A

 Note: The default value for this setting is False.

This setting refers to how the SQL Sentry client
responds if it discovers the data in the SQL Sentry
Synchronize
Type

Synchronization
Threshold

Maintenance
Window

database isn't up to date.
N/A
 Note: The default settings shows a message box
warning of the condition and asks if the SQL Sentry
client should synchronize the information itself.

The amount of time that must pass since the last
successful synchronization by the SQL Sentry
monitoring service before the client attempts to
synchronize directly with the target.

Used to set a schedule for the Maintenance Window.
Only Log Actions trigger for Failsafe conditions
inside the Maintenance Window. Maintenance
Window settings allow a time frame to be specified
while daily maintenance activities take place on that
instance.

N/A

Failsafe conditions

For more information, see the Schedules and Windows
topic.

Top Commands
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Setting

Description

Related Condition

Maximum
Runtime
Threshold

Defines the maximum allowed runtime for the object.

Top Commands:
Runtime Threshold
Max

Top Command Source
Setting

Description

Related Condition

Maximum Rows
to Synchronize

The maximum rows of historical event data to collect
from this source.

N/A

History Filter

The filter is used for history synchronization. Only
events that meet the filter criteria are written to the
database. For more information, see History Filter.

N/A

Sets the minimum required duration for a statement
to be logged.

All Top Commands
Conditions

Specifies whether command collection is enabled.

N/A

Minimum
Duration
Collect
MDX/DMX/XMLA
Events
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SQL Sentry Windows Settings
Last Modified on 18 May 2021

Windows Instance
Setting

Synchronization
Type

Description

Related Condition

This setting refers to how the SQL Sentry client
responds if it discovers the data in the SQL Sentry
database isn't up to date.
N/A
 Note: The default shows a message box warning of
the condition and asks if the SQL Sentry client should
synchronize the information itself.

Synchronization
Threshold

The amount of time that must pass since the last
successful synchronization by the SQL Sentry
monitoring service before the client attempts to
synchronize directly with the target.

N/A

Used to set a schedule for the Maintenance Window.
Only Log Actions trigger for Failsafe conditions

Maintenance
Window

inside the Maintenance Window. Maintenance
Window settings allow a time frame to be specified
while daily maintenance activities take place on that

Failsafe conditions

instance.
For more information, see the Schedules and
Windows topic.

Collect
Processes

Specifies whether process collection is enabled.

N/A
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Setting

Description

Related Condition

The filter controls which uncategorized processes are
collected.
Uncategorized
Process Filter

 Note: Categorized or Well-Known processes are
always collected. For more information, see the

N/A

Processes topic.

Windows Event Logs Source
Description

Related Condition

Auto-watch New
Objects

Specifies whether new objects are set to
watched when they are discovered.

All Windows
Conditions - An
object must be
watched in order for
Conditions to be
evaluated for it.

Maximum Rows
to Synchronize

The maximum rows of historical data to collect for this
source.

N/A

History Filter

For more information, see History Filter and
Windows Event Logs source topics.

Windows Event log:
Event

Setting

Windows Task
Setting

Description

Related Condition

Maximum
Runtime
Threshold

The maximum allowed runtime for the object.

Windows Task:
Runtime Threshold
Max

Maximum
Runtime
Threshold
Percent

The maximum allowed runtime percentage for the
object.

Windows Task:
Runtime Threshold
Max

Minimum
Runtime
Threshold

The minimum allowed runtime for the object.

Windows Task:
Runtime Threshold
Min
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Setting

Description

Related Condition

Minimum
Runtime
Threshold
Percent

The minimum allowed runtime percentage for the
object.

Windows Task:
Runtime Threshold
Min

Windows Task Source
Description

Related Condition

Auto-watch New
Objects

Specifies whether new objects are set to
watched when they are discovered.

All Windows Task
Conditions - An
object must be
watched in order for
Conditions to be
evaluated for it.

Maximum Rows
to Synchronize

The maximum rows of historical data to collect for this
source.

N/A

Setting
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SQL Sentry Message Editing
Last Modified on 06 December 2021

This feature allows you to fully customize the messages that are generated by SQL Sentry. Add or remove
information, change how the information is formatted, and change the order that the information is
displayed.

Additional Information: See these blogs for more details and examples:
Customizing Your Alert Emails in SQL Sentry
Customizing SQL Sentry Message Text

Access the Message Editor
To access the Message Editor, select the Condition that you'd like to change in the Conditions pane (View >
Conditions), select the Message tab on the bottom of the pane, and then select Edit.
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How does customization work?
Understanding XML
To understand how customizing messages works in SQL Sentry, it's important to understand the following
about XML:
The format of the XML that describes the format of the messages
The elements added to the XML
How these elements are related
At the root level (the Message element), each message formatted XML document (called a Template) uses
the Imports attribute to inherit from another template. That template inherits from another template and so
on, creating a chain of Parent/Child relationships. These chains are used extensively throughout the
Template files to reduce the repetition of reused elements. The middle pane of Message Editor combines
these chains into the single, complete XML document that's used to generate the final message. Sometimes
the finale Template, sometimes referred to as a Leaf Template, has very little information because almost
all of the XML is in the inherited Templates. In these cases, it can be useful to look at the complete XML to
understand what's in the message and how to change it.
Inside the root message element, there are three parts to a template:
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the Format element
the TokenSets element
the Body element
See the following table for more information about each element and its contents.

Element Name

Element contents

Format element

Contains definitions for section, item, and token styles.

tokenSet element

Contains a list of all of the tokenSets associated with the Template.

Body element

Contains all of the sections, items and tokens that describe the
message format itself.

 Note: All of these elements are combined with their imported parent elements during the import
process so that inheritance is used.

The Format element is a list of style definitions that are referred to in the body of the Template. Leaf
templates often don’t contain a Format element because they rely on a group of standard inherited styles.
Add a format element if one doesn't exist or add to an existing one to define new styles. Only one format
element is allowed per template.
The tokenSets element is a list of all of the tokenSets associated with a Template. A tokenSet is a logical
grouping of tokens that exists in SQL Sentry. You can't add tokenSets to messages because the data for the
tokens in the tokenSet needs to be created and assigned in the program. A list of all of the tokens in the
tokenSets is available in the Message Editor. Only one tokenSets element is allowed per template.
The Body element describes all of the things that a message is made of. These things can be categorized as
items (and things that inherit from items) and sections, which are groups of items. Only one body element is
allowed per Template.

Items and sections
An item is the base element in the body section. TokenItems, textItems, breakItems and
blankLineItems are all specialized types of items. See the following table for more information about these
items:

Item/Section Name

Item/Section Description
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Item/Section Name

Item/Section Description

TokenItems

Special items that represent a name/value pair. A common example in
SQL Sentry messages is [Condition]: SQL Server: Blocking SQL. The
name (Condition) is a description of the value ( SQL Server: Blocking
SQL). The value for these tokenItems is set during the program
execution.

MultiTokenItems

Special tokenItems that convert one or more tokenItems into a single
token with specialized formatting. They have a converter attribute
that's the name of a registered converter, and they reference one or
more tokenItems.

TextItems

A special type of item that displays a literal text value.

BreakItems

A specialized textItem with pre-set text for ease of use. The
breakItem takes whatever the current section format break is and
places that in the message.

blankLineItems

A specialized textItem with pre-set text for ease of use. The
blankLineItem inserts a blank line in a message.

section element

A way to group the above items. Sections can contain other sections.
Nested sections are indented using the indentStyle from the current
sectionStyle.

Item and Section Attributes
All items have the following attributes:
Item/Section Attribute

Description

id

A unique string identifying the item.

visible

A boolean that determines if the item is visible in the message.

before

The id of the item, token or section that this item should be placed
before.

after

The id of the item, token or section that this item should be placed
after.

requires

The id of an item, token or section that must be visible for this item to
be visible.

indent

A boolean that determines if the item should be indented.
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Item/Section Attribute

Description

itemStyleId

The id of the itemStyle (format) that should be used for this item.

TextItems have one additional attribute:
TextItem Attribute

Description

text

The text that will be displayed in the final message.

TokenItems have additional attributes:
TokenItem Attributes

Description

name

The token name to be displayed in the message. If none is assigned, a
default name based on the item id is displayed.

hideIfNoValue

A boolean that when set to true, hides the token if no value is
assigned.

tokenItemStyleId

The id of the tokenStyle (format) that should be used for this token.

MultiTokenItems have all of the tokenItem attributes plus an additional
attribute and element:
Attribute:
MultiTokenItems
Addittional Attribute

Description

converter

The name of the registered converter.

Element:
MultiTokenItems
Addittional Element

Description

token

An element that represents a token to be passed to the converter. It
has a single attribute—id—that's the id of a valid token.
MultiTokenItems may have one or more token elements.
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Sections have similar attributes to items:
Section Attribute

Description

id

A unique string identifying the item.

visible

A boolean that determines if the item is visible in the message.

before

The id of the item, token or section that this item should be placed
before.

after

The id of the item, token or section that this item should be placed
after.

requires

The id of an item, token or section that must be visible for this item to
be visible.

indent

A boolean that determines if the item should be indented.

sectionStyleId

The id of the sectionStyle that should be used for this section.

itemStyleId

The id of the itemStyle (format) that should be used for this item.

tokenItemStyleId

The id of the tokenStyle (format) that should be used for this token.

Styles
Styles are a very important part of how message customization works. There are three types of styles:
Section styles
Item styles
Token styles

 Note: Styles are defined in the format section of the XML. The styles are then referenced by their IDs
in the sections, items and tokens. These styles use format strings to identify how to change an item,
token or section when the message is built. The format strings use keywords to represent the data so
you can add formatting content around them.

For example, token styles use %itemname% to represent the name of a token and %itemvalue% to
represent its value. To create the finished message value of [Condition]: SQL Server: Blocking SQL, use the
format string: [%itemname%]: %itemvalue%. If the desired finished value is Condition-->SQL Server:
Blocking SQL the format string needs to be changed to %itemname%-->%itemvalue%. You can also add
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whitespace characters such as newline (\r\n) or tab (\t).

Style Attributes
Section styles (sectionStyle elements) have three attributes:
Section Style
Attribute

Description

Keyword

Example

id

A unique string
identifying them.

NA

NA

indentStyle

A format string to
determine how a
nested section
should be indented.

%sectionitem%
represents each item
in the section.

%sectionitem%
places four spaces
before each item in
the section.

formatStyle

A format string to
determine how a
section should be
formatted.

%sectionitems%
represents the entire
section as a whole.

%sectionitems% ---------\r\n places a line of
dashes as a break
after the section.

Item styles (itemStyle elements) have two attributes:
Item Style Attribute

Description

Keyword

Example

id

A unique string
identifying this style.

NA

NA

indentStyle

A format string to
determine how an
item should be
indented (when the
indent attribute is
set to true).

%item% represents
the item.

\t%item% places a
tab character in front
of the item.

Token styles (tokenItemStyle elements) extend item styles and have
three additional attributes:
Token style Attribute

Description

Keyword

Example
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Token style Attribute

Description

Keyword

Example

formatStyle

A format string to
determine how a
token should be
formatted.

%itemname%
represents the token
name; %itemvalue%
represents the value
of the token.

[%itemname%]:
%itemvalue% creates
the standard "
[Name]: Value" token
style.

itemStyleId

The id of the
itemStyle this
tokenStyle
references. Because a
token is an item
underneath, the
format needs to
specify the item style
as well.

NA

NA

itemValueStyle

A .NET format string
for the item value.
This string gives you
the ability to format
the token value itself
using .NET format
string which is useful
for date or number
formatting.

NA

0.## formats a
decimal value to a
maximum of two
decimal places.

Customizing a Message
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Sections of the Message Editor
Message
Editor
Section

Description

Tokens
pane

Displays a list of tokens that are available for use in
the message.

Text
Items
pane

Contains various XML elements that can be copied
and pasted into the Message Level XML pane to
add custom text and line breaks to the message.

Image
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Message
Editor
Section

Description

Formats
pane

Contains XML attributes that can be used with an
element to adjust the formatting of the element.

Message
Level
XML pane

The Message Level XML pane is where you can edit
the message. Changes made in this pane are
reflected in the Complete XML and Message
Sample panes.

Complete
XML pane

Displays the final product of the template displayed
in the Message Level XML pane plus all of the
templates that are imported by it. You can use this
pane as guideline when making changes to the
Message Level XML.

Message
Sample
pane

Displays a mock-up of what the complete XML
becomes.

Conditions
That Use
Template
pane

Displays a list of conditions that are currently using
the template you're editing. The check boxes give
you the ability to quickly save a new template and
apply it to multiple conditions.

Image

Editing a Message
Adding Additional Information
New items can be added inside or outside of a section. Available nodes are listed in the Tokens pane and can
be copy-and-pasted, highlighted-and-dragged, or typed directly into the editor. Set the before or after
attributes to place the item in a particular spot in the message.

Removing or Hiding an Item
If an item is only in the Message Level XML, you can delete that node from the XML. If the item is in an
imported template, you can hide the item in the finished message by setting the visible attribute to False.
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You can also set the hideIfNoValue attribute to True which hides the item if there's no value assigned to it.

Moving an Item
Items are displayed in the final message as they are placed in the XML, top to bottom, unless before or
after attributes are placed on the items or sections.

 Note: This quickly gets confusing with the inheritance chain, so the easiest way to move an item is to
set its before or after attribute.

Adding, Hiding, or Moving a Section
Sections are a lot like items (by design). Add one by typing in a new
, hide one by setting its visible property to False and move one by setting its before or after attribute.

Changing a Token Name
Change the displayed name of a token by setting its name property.

Indenting an Item
Indent an item by setting the indent attribute for an item to true.

 Note: All items have an inherited default indent style.

For custom indents, create a new itemStyle with your custom indent and apply that style to a body, section or
item.

Formatting a Token
Each template has several inherited token styles that are listed in the Formats pane of the Message Editor.
Copy-and-paste or highlight-and-drag these attributes into the body, section or token item. For custom
formatting, define a new tokenItemStyle in the Format section and set the formatStyle string to suit your
needs. Reference this new style by id in the attributes of the body, section or tokenItem.

Example:
tokenItemStyle definition to get a token like {Condition}-->Name of Condition:
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Formatting a Section
Each template has at least one inherited section style that's listed in the Formats pane of the Message
Editor. Copy-and-paste or highlight-and-drag the attribute into the body or section. For custom formatting,
define a new sectionStyle in the Format section and set the formatStyle string to suit your needs. Reference
this new style by id in the attributes of the body or section.

Example section:
Style definition to replace the standard line of dashes after a section with a line of equal signs:

Formatting a Token Value
Define a .NET format string to format a token value itself. This is especially useful in formatting dates and
number values. Define a new tokenItemStyle in the format section, set up the formatStyle and itemStyleId
attributes (or copy them from another style) and then set the itemValueStyle to a .NET format string.
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SQL Sentry Response Rulesets
Last Modified on 06 December 2021

Response Rulesets control how often Actions are taken in response to Conditions. The default ruleset is
Notify Every Time, meaning that the Action is taken every time the Condition is met. Response Rulesets
allow for an extra level of configurability for certain notifications by allowing you to define additional criteria
that must be met in order for the Action to be taken.
For example, you may receive false-positive Database Offline/Online messages throughout the day on
servers/networks that are highly utilized. An example Response Ruleset for this scenario might specify that
this Condition must be true for five minutes before an email is sent. Additionally, you can specify under which
criteria subsequent actions for this same Condition occur.
Actions and their configured Response Rulesets have a hierarchical configuration. When you configure an
Action with a Response Ruleset the Action and the Action's Response Ruleset are inherited by each object
below that level. For a visual representation of how inheritance works within SQL Sentry, see the Alerting and
Response System Hierarchy diagram.

 Note: Response Rulesets are a powerful tool that help adjust Alerts. Response Rulesets are
available globally, meaning the same Response Ruleset can be applied to multiple Conditions. Any
changes made to a Response Ruleset affect every Condition where the Response Ruleset is applied.

Windows are also available to help you adjust Alerting in your environment. Windows may be applied directly
to any configured Action to control the time frame of when that Action is processed. Apply a Window in the
Response Ruleset tab of any configured Action. For more information about configuring Windows, see the
Schedules and Windows topic.
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Ruleset Types
There are two ruleset types, Count Based and Time Based.

Ruleset Type

Description

Count Based rulesets control:

Count Based

How many times a Condition occurs within
a specified time frame before Actions are
taken.
How many times a Condition reoccurs
before subsequent Actions are taken.
How long to continue taking Action when a
Condition is occurring.
For more information, see the Response
Ruleset Count Based example.

Time Based rulesets control:

Time Based

How long a Condition exists before
Actions are taken.
How much time elapses before subsequent
Actions are taken.
How long to continue taking Action when a
Condition is occurring.
For more information, see the Response
Ruleset Time Based example.

 Note: Blocking Response Rulesets trigger based on the blocking chain (not the head block). Each
block will have a head blocker that is assigned a unique SPID, and each SPID attached to the head
blocker will have a unique SPID(s). A Blocking Response Ruleset will trigger once the requirements for
the blocking chain (whether count based, or time based) are met.
Consider the following example:
You have a count based blocking ruleset that notifies you of a blocking event if four blocks occur within
25 minutes.
In one scenario , this ruleset would trigger if there was one blocking event SPID 123, that caused four
blocks SPID 77, SPID 98, SPID 99, and SPID 103 within 25 minutes.
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In a second scenario, this ruleset would not trigger if there were multiple blocking events: SPID 174
blocks SPID 99, then SPID 87 blocks SPID 65, SPID 275 blocks SPID 84, and SPID 88 blocks SPID 54. The
blocking events in the second scenario were four separate events that occurred within 25 minutes, but
they were not part of one single blocking chain, and would not trigger the blocking response ruleset.

Managing Rulesets
Response Rulesets are managed by selecting the Tools menu > Manage Response Ruleset command.
Create, edit, and delete rulesets in this window. Assign rulesets to all Actions configured within your
environment. Once a Response Ruleset has been defined, it can be associated with a Condition.

Response Rulesets can also be managed for individual Actions from the Response Ruleset tab found within
the Conditions pane (View > Conditions).
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Creating a New Response Ruleset
Create a new Response Ruleset by completing the following:
1. Open the Response Rulesets window by selecting Tools > Manage Response Ruleset.

2. Select New Ruleset to open the Response Ruleset Editor.
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3. Enter a name for the Response Ruleset, and then select Count based or Time based from the Ruleset
Type box.

Depending on the Ruleset type you're creating, the configuration options are as follows:

Ruleset Configuration Options
Count Based

Configuration Options
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Count Based

Configuration Options

Process Actions After:
Occurrences – number of times the event
must occur prior to processing actions.
within (checked) – the window of time in
which the events needs to occur.
within (not checked) – ignores time limit,
enables subsequent actions.

Process Subsequent Actions Every:
Occurrences – number of times the event
must occur prior to processing subsequent
actions.
for up to – how long to follow the
subsequent actions setting before starting
ruleset over.

Time Based

Configuration Options

Process Actions After:
The amount of time a condition must exist
prior to processing actions.

Process Subsequent Actions Every:
The amount of time a condition must
continue to exist between processing
actions.
For up to – how long to follow the
subsequent actions setting before starting
ruleset over.
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 Important: Time-based rulesets are additive when used in conjunction with runtime threshold max
settings. If the duration of the runtime threshold max alert is 5 minutes, and a ruleset is configured to
process after 6 minutes, then the ruleset will not process until 11 minutes after the event (job, blocking,
SQL Statement, etc.) began.

 Note: Modifications to a Response Ruleset trigger an Audit Condition.

Assigning a Response Ruleset to an Action
Assign a Response Ruleset to an Action from within the Manage Response Ruleset dialogue by completing
the following:
1. Open the Manage Response Ruleset dialogue (Tools > Manage Response Ruleset ).

2. Select any Action found within the Configured Actions section, and then select the drop-down arrow in
the Ruleset column to see Response Rulesets applicable for the Action.
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3. Select the Response Ruleset that you'd like to apply, and then select Close to save your selection.
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You can also assign a Response Ruleset to an Action from the Response Ruleset tab found within the
Conditions pane (View > Conditions).
1. In the Navigator pane (View > Navigator) select the node where you'd like to configure the Action.

2. Select the Action that you'd like to apply a ruleset for in the Conditions pane (View >
General/Failsafe/Audit ), and then select Rulesets tab found directly beneath the Action.
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3. Select the Response Ruleset that you'd like to apply.

 Note: The following are the best practices for using Response Rulesets:
Name global rulesets by their behavior.
Name custom rulesets by the object and event/condition they apply to.
Use count based rulesets for event driven rules.
Use time based rulesets for condition driven rules.
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Response Ruleset Examples
Response Rulesets control how often Actions are taken in response to Conditions. The default ruleset is
Notify Every Time, meaning that the Action is taken every time the Condition is met. Response Rulesets
allow for an extra level of configurability for certain notifications by allowing you to define additional criteria
that must be met in order for the Action to be taken. For a general overview, see the Response Ruleset topic.
Count Based Example

As a reminder Count Based rulesets control:
How many times a Condition occurs within a specified time frame before Actions are taken.
How many times a Condition reoccurs before subsequent Actions are taken.
How long to continue taking Action when a Condition is occurring.
This Count Based ruleset example deals with a SQL Server Agent job that often fails.

For this example assume the following:
You have a Send Email action configured at the instance level for the SQL Server Agent Job: Failure Condition .
There's a SQL Server Agent Job FrequentJob, that runs every minute. The occasional failure is expected and
can be disregarded, but if this job begins failing repeatedly it usually indicates a problem.
To prevent getting an alert on every failure, set a Response Ruleset to limit the processing of the Send
Email action for the SQL Server Agent Job: Failure Condition so that an email is only sent after the job
failed multiple times within a specified time frame. For the example we configure a Count Based Response
Ruleset that requires the job to fail three times within five minutes.
To accomplish this you need to apply a Count Based Response Ruleset at the job level ( FrequentJob). Apply
this Response Ruleset at the individual job level as opposed to the instance level to avoid suppressing email
notifications for the rest of your Agent Jobs belonging to that instance.
Configure a Send Email action for the SQL Server Agent Job: Failure Condition for the Agent Job
FrequentJob.
1. Select the FrequentJob node in the Navigator Pane.
2. Open the General Actions section in the Conditions pane (View > Conditions).
3. Select Add found in the Explicit section of the General Actions section. This opens the Select Action
window.
4. Expand the SQL Server Agent Job: Failure Condition . Select the Send Email action from the checkbox.
Select OK to add the configured action. Be sure to specify a Selected Target in the Action Settings
tab.
Next, apply a Response Ruleset to the configured Action.
1. Select the configured email action in the Explicit section of the Conditions pane, and then change the
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behavior to Override Inherited Action.
2. Select the Response Rulesets tab found directly beneath the Explicit section of the Conditions pane.
The default Response Ruleset, Notify Every Time is applied. Select New to open the Response
Ruleset Editor.
3. Give the Response Ruleset a name.

4. Fill in the information as specified above and select Save to apply the newly created Response Ruleset
to the configured Action.
Now that the Send Email action configured for the SQL Server Agent Job: Failure Condition has the above
Response Ruleset applied, an email only sends alerting you that the FrequentJob failed, if it does so three
times within five minutes.
Only the SQL Agent Job FrequentJob is impacted by this change. Other Agent Jobs are still subject to the
Send Email action configured at the instance level that has the default Response Ruleset of Notify Every
Time .

 Note: Consider the following:
With this ruleset in place on the Send Email action, you could still have the failure execute the Log
To Database action using the default ruleset. This way every failure is recorded.
You could also apply an additional Send Email action for the SQL Server Agent Job: Failure
Condition with a different ruleset. This could be useful for escalation purposes or if a different
team member prefers to be notified every time the job fails.

Time Based Example

Time Based rulesets control:
How long a Condition exists before Actions are taken.
How much time elapses before subsequent Actions are taken.
How long to continue taking Action when a Condition is occurring.
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This Time Based ruleset example deals with Instance Offline/Online Alerts.

For this example assume the following:
You have a Send Email action configured at the Global level for the SQL Server: Offline Condition.
You have a site, TransientSite in your environment that contains several instances. You're being alerted by
email that these instances are going offline and online, but when you check these instances they seem to be
false notifications. This can happen if there's transient network issues and the monitoring service is unable to
connect to the monitored servers. If these problems are truly transient, you may not necessarily want to be
notified every time this happens.
To prevent getting an alert for every occurrence of these transient network issues set a Response Ruleset to
limit the processing of the Send Email action for the SQL Server Instance: Offline Condition . This Response
Ruleset adds additional criteria to the processing of the Send Email action so that an email is only sent after
the instance is detected to be in an offline state for a specific period of time.
For this example we do this by:
1. Configuring a Time Based Response Ruleset that requires the SQL Server: Offline Condition to be
true for five minutes.
2. Disabling the SQL Server Instance: Online Condition.
To accomplish this apply a Time Based Ruleset at the site level for the TransientSite. Apply this Response
Ruleset at the site level as opposed to the global level to avoid suppressing email notifications about the rest
of your instances going offline and online.
Configure a Send Email action for the SQL Server Instance: Offline Condition at the TransientSite level.
1. Select the TransientSite node in the Navigator pane (View > Navigator).
2. Open the Failsafe Actions section in the Conditions pane (View > Conditions).
3. Select Add found in the Explicit section of the Failsafe Actions section. This opens the Select Action
window.
4. Expand the SQL Server Instance: Offline Condition. Select the Send Email action from the checkbox.
Select OK to add the configured action. Be sure to specify a Selected Target in the Actions Settings
tab.
Next apply a Response Ruleset to the configured Action.
1. Select the configured email action in the Explicit section of the Conditions pane, and then change the
behavior to Override Inherited Action.
2. Select the Response Ruleset tab found directly beneath the Explicit section of the Conditions pane.
The default Response Ruleset, Notify Every Time is applied. Select New to open the Response
Ruleset Editor.
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3. Give the Response Ruleset a name.

4. Fill in the information as specified above and select Save to apply the newly created Response Ruleset
to the configured Action.
Now that the Send Email action configured for the SQL Server Instance: Offline Condition has the above
Response Ruleset applied, an email only be sends alerting you that one of the instances belonging to the
TransientSite is offline, if it's detected to be in that state for longer than five minutes. You receive an
additional email every 10 minutes for up to one day as long as the instance remains offline.
Next, disable the Send Email action for the SQL Server Instance: Online Condition at the TransientSite
level. This stops any SQL Server online email notifications. With the above Response Ruleset applied, once
you stop receiving emails for the SQL Server Instance: Offline Condition the server is online again.
To disable the Send Email action for the SQL Server Instance: Online Condition at the TransientSite level.
1. Select the TransientSite node in the Navigator pane (View > Navigator).
2. Open the Failsafe Actions section in the Conditions pane (View > Conditions).
3. Expand the SQL Server Instance: Online Condition. Select the Send Email action from the checkbox.
Select OK to add the action.
4. Select the configured email action in the Explicit section of the Conditions pane. In the
Behavior column select the drop down box and choose the Disabled behavior. For more about action
behaviors, see the Actions topic.

 Note: Consider the following:
You may also want to follow the same procedures for the SQL Server Agent: Offline/Online
conditions, by applying the same Response Ruleset for the Offline condition and disabling the
Online condition.
By default all Failsafe conditions are configured with a Log To Database action, so there's always
a record of each time the SQL Server Instance: Offline Condition is met if you need to review it.
You could also apply an additional Send Email action for the various Offline/Online conditions
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with a different Response Ruleset. This could be used for escalation purposes in the event of an
long term server outage.
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SQL Sentry Output Content Match
Last Modified on 06 December 2021

The Output Content Match condition assigns an action based on a match of the output text of an event
object. Use this feature to watch for specialized conditions that may be undetected otherwise. This may prove
useful when handling Exit Codes from Windows Tasks.

 Note: Condition Setting filters introduced in v7.2 offer a greater degree of flexibility in managing
alerts.

Setting Up Actions for the Output Content Match
Condition
Output Content Match Actions, like all other General Actions, are set up from the global level to the
individual event object level. Set up Actions for the Output Content Match Condition by completing the
following:
1. Select the appropriate node on the Navigator pane (View > Navigator), and then select Add in the
Conditions pane (View > Conditions) to open the Actions Selector dialog.
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2. Expand the desired Object and Output Content Match Condition.
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3. Select the desired Action to be completed when the Condition is met, and select OK on the Actions
Selector to save your settings.
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 Note: Output Content Match options are accessed in the Condition Settings tab.

Editing Actions for the Output Content Match Condition
To edit Actions for the Output Content Match condition, complete the following:
1. Select the Edit button in the Condition Settings tab to open the Output Content Match form.
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2. Specify all conditions that the output text from the object meets before responding with the desired
action. Select OK to enable and save the Action.
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 Note: The matched text can either be in the form of a string literal, or you can enter a regular
expression. To use regular expressions, prefix the match string with regex:, i.e. regex:[a-z]* to
match any character a-z.

 Note: The Step Name listbox is only available when settings match the criteria for an individual
SQL Agent Job.

Condition Inheritance
All Output Content Match criteria can be set at the global level and inherited like any other setting.

 Important: Any match criteria defined at a lower level effectively overrides the inherited
criteria. Even if there isn't a match at that level, SQL Sentry won't look farther up the inheritance
chain to see if there's any other match criteria set at a higher level. Inherited actions, remain
enabled.

For example, a Send Email action is configured at the global level for the SQL Agent Job:Output
Content Match condition when the text string overflow appears in any job's output text. You then
select on your Data Import job on Server A and enable a Log to Database action for the SQL Agent
Job:Output Content Match condition and change the match criteria for this job to insufficient. From
now on, the only text string that is checked when the Data Import job runs is insufficient. Even if that
string isn't found, it won't look for the overflow string set at the global level. If the insufficient string is
matched for that job's output, both the Send Email and Log to Database actions are taken.
When you override the Output Content Match settings at a lower level, you're asked if you'd want to
use the higher level Output Content Match criteria as the baseline for this setting.

 Note: This feature saves you from doing extra work when many content match strings are
involved because overriding the Output Content Match criteria generally only requires minor
changes.
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SQL Sentry Reporting Overview
Last Modified on 29 December 2021

SQL Sentry offers an expansive list of reporting options, and reports are generated using SQL Server
Reporting Services (SSRS) technology. The SQL Sentry client includes the Reporting Services Report Viewer
that allows the SQL Sentry reports to be viewed from within the SQL Sentry client. All reports are accessed
from the Reports menu.

SQL Sentry Reports can be deployed to the Reporting Services 2005 and above server for distribution. Report
Deployment Settings is accessed from the Reports menu. For more information about these settings and
deploying SQL Sentry Reports, see the Reports topic.

Report Parameters
Once a report is selected, depending on the type of report, the user specifies parameters, including a date and
time range for the report. Options are available to save these parameters for later use. To save a set of
parameters, select Save on the Report Parameters dialog screen. To load a saved set of parameters, choose
a parameter set from the Load Saved Parameters drop-down list. For certain reports, such as the SQL Server
Performance report, an option is available to select multiple sets of parameter values. Select Add to
Parameter List to add a parameter set to the selected report.
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Exporting Reports
SQL Sentry Reports are exported in a variety of formats for distribution purposes. After a report is run, from
the Report Viewer screen, select the Export icon on the toolbar to export a report.

Report Deployment
Deploy any SQL Sentry report to one or more Reporting Services 2005 and above servers. Deploy reports to
your own SSRS instance to create custom deployment schedules.

 Note: Before the reports can be deployed, specify the name of the server where you wish to deploy
the reports.

Deployment Preferences
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The Report Deployment Settings may be accessed from the Reports menu (Reports > Report Deployment
Settings). The following Reporting Service endpoints are supported for deploying SQL Sentry Reports:

When you choose to deploy your reports, you're given the ability to decide where on your reporting server
you'd like to store these reports. Select the desired folder, and then select OK. Create new folders by rightclicking on an existing folder and selecting New Folder.

 Note: Windows Authentication must be enabled to immediately run reports from the web interface.

Additional Reporting Features
Features

Descriptions

List Views

All List views inside the SQL Sentry client are easily exported.

Runtime Stats

All Runtime Stats in the SQL Sentry client are printable.

Performance
Graphs

All Performance Graphs in the SQL Sentry client are printable.

Event Chains

All Event Chain diagrams in the SQL Sentry client are printable.

Calendar Views

All Calendar views in the SQL Sentry client are printable.
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SQL Sentry Reports Menus
Last Modified on 29 December 2021

Accessing Reports
SQL Sentry offers a variety of built-in reports from the Reports menu.

Events Reports

Reports

Descriptions

Current
Failures

The Current Failures report provides data
about all failures that have occurred in the given
time frame for any monitored objects in your
SQL Sentry environment. The report includes
various information about the associated
failures including: name of the event, parent
instance name, last step output, start and end
times. Report parameters show either Open
Failures only or All Failures. Any user notes
added to the job failure instance are available
on this report. Use the Current Failures report
to identify object failures over the selected time
frame.

Screenshots
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Reports

Descriptions

Management
Summary

The Management Summary report provides a
high-level overview of the monitored servers in
your SQL Sentry environment. The report
includes a count of all monitored objects, and as
applicable, the associated number of failures
recorded for those objects, grouped in the
following ranges: last 30 days, last 7 days, and
last 24 hours. Use the Management Summary
report to help you determine which servers are
the most active in your environment.

Performance
Counters List

The Performance Counters List report
provides data about Performance Counters
currently associated with specific event objects
or Custom Event Views within your SQL Sentry
environment. Information about each
Performance Counter is displayed for the
specified time range, including the minimum,
maximum, and average of the recorded metric.
Use the Performance Counters List report to
identify active Performance Counters in your
environment.

Watched
Object
Summary

The Watched Object Summary report provides
information about the different types of objects
found on each watched instance. The report
breaks down the watched and unwatched
objects by instance type and event source.
Counts for the number of child objects
belonging to the instance that are enabled or
disabled are also provided in this report. Use the
Watched Object Summary report to identify
the number of monitored objects on your
watched instances.

Screenshots

Performance Analysis Reports
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The Performance Analysis reports are the companion to SQL Sentry Performance Analysis. For more
information about the various metrics contained in the Performance Analysis reports, see the Performance
Metrics topic.

 Note: On applicable reports, the Load Saved Parameters drop-down box allows the user to save the
parameters for future use.

Performance

Reports

Descriptions

Global Server
Performance

The Global Server Performance report
provides a summary of the performance
metrics collected for each of the servers in
your SQL Sentry environment. Use the Global
Server Performance report in conjunction
with the Performance Analysis Global view
for a high-level understanding of server
performance across your entire monitored
environment.

Performance
Counter Date
Range
Comparison

The Performance Counter Date Range
Comparison report provides graphical and
textual data for the selected Performance
Counter(s) over the specified time range.
Various parameters can be configured
including: Server, Instance, Category, Counter,
and Instance. This report is like the
Performance Counter History report, except
two different time ranges can be selected.

Screenshots
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Reports

Descriptions

Performance
Counter History

The Performance Counter History report
provides both graphical and textual data for
the selected Performance Counter(s) over
the specified time range. Various parameters
include: Server, Connection, Category,
Counter, and Instance that can be configured.

SQL Server
Performance

The SQL Server Performance report
provides detailed SQL Server performance
data for the instance over the selected time
range. Use the SQL Server Performance
report in conjunction with the Performance
Analysis dashboard to gain an understanding
of SQL Server performance in your monitored
environment.

SQL Server
Transactions Top Databases

The SQL Server Transactions - Top
Databases report provides detailed data
about transactions and log flushes for the
selected instance over the specified time
range. The report includes a minimum,
maximum, average, and total column for each
metric. The report includes the top 10
databases for the instance as determined by
the total number of log flushes and
transactions.

SQL Server Wait
Stats Analysis

The SQL Server Wait Stats Analysis report
provides detailed data about SQL Server waits
for the instance over the selected time range.
Several aggregate waits groupings are
incorporated into the report, including waits
by category, by class, and by type. Each
grouping breaks down the waits data by
Resource Waits, CPU Waits, and Total
Waits. Metrics are displayed in milliseconds
(MS).

Screenshots
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Reports

Descriptions

SQL Server Wait
Stats Analysis By Resource
and CPU Waits

The SQL Server Wait Stats Analysis - By
Resource and CPU Waits report provides
detailed data about SQL Server waits for the
instance over the selected time range. Several
aggregate waits groupings are incorporated
into the report, including waits by category,
by class (CPU or Resource), and by type (CPU
or Resource). Metrics are displayed in
milliseconds (MS).

SSAS
Performance

The SSAS Performance report provides
detailed graphical information regarding the
SSAS performance for the selected instance
over a given time range.

Windows + SQL
Server
Performance

The Windows + SQL Server Performance
report provides detailed performance metrics
for each instance on the selected server
regarding Windows and SQL Server
performance. Use the Windows + SQL Server
Performance report in conjunction with the
Performance Analysis dashboard to gain an
insight into the performance of your
monitored environment.

Windows
Performance

The Windows Performance report provides
detailed Windows performance data for the
instance over the selected time range. Use
the Windows Performance report in
conjunction with the Performance
Analysis dashboard to gain an understanding
of Windows Performance in your monitored
environment.

Screenshots
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Disk
/ File Space Descriptions
Reports

Screenshots

Use the Disk/File Space reports in conjunction with the Disk Activity and Disk Space tabs of Performance
Analysis to identify data disk capacity issues and possible performance bottlenecks.

Reports

Descriptions

SQL Server
File
Growth Top Files All Servers

The SQL Server File Growth - Top Files - All
Servers report provides data and log file growth
over the selected time range for the Top N files, as
selected in the report parameters, across your
entire installation. There are representations for
total size and used size over the selected time
frame.

Screenshots
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Reports

Descriptions

SQL Server
File
Utilization
- Top Files
- By Logical
Disk
- By
Database

The SQL Server File Utilization report provides
data and log file growth over the selected time
range for the Top 5 files on the specified instance.
There are representations for total size and used
size over the selected time frame. Each of the SQL
Server File Utilization reports group the data by
its respective category name.

Screenshots
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Reports

Descriptions

Screenshots

The Windows Disk Forecast report provides the
amount of space you've already used and provides
an example of to how to expand the volume of
your disk space so that you don't run out in the
future.
Windows
Disk
Forecast

All Servers—Displays all volumes that will
run out of memory within a specified time
frame.
Individual Servers—Capacity planning that
provides a secondary chart with a forecasted
amount of disk space.

Windows
Disk
Utilization
- By Server

The Windows Disk Utilization -By Server report
provides the amount of used and free space for the
selected server over the specified time range. The
report provides data for both
Physical and Logical disk utilization.

Windows
Disk
Utilization
- All
Servers

The Windows Disk Utilization - All Servers report
provides the disk size, used space, free space, and
used space history for all the monitored servers
within your SQL Sentry environment.

Misaligned
Partitions
- By Server
- All Servers

The Misaligned Partitions reports provides a
summary of the misaligned partitions for the
selected server.

1644

Reports

Descriptions

Screenshots

High VLFs
- By Server
- All Servers

The High VLFs reports provides data about
transaction logs that have a high number of Virtual
Log Files (VLFs).

Databases
without
Recent
Backups

The Databases without Recent Backups report
provides information about databases without a
recent backup in your monitored environment.
Information is included for both data and log files,
including the Last Backup Time, Last Backup
Type, and Used Size (MB). The default time range
for this report covers the last 15 days, but is
configurable. Transaction Log files aren't included
in this report if the database is in simple recovery.

Top SQL

The Top SQL reports provide a summary of Top SQL data captured over the given time range. Top
SQL contains high impact, worst performing stored procedures, batches, and statements. The information
captured by Top SQL can be based on any combination of duration, CPU, reads, or writes. Use this data along
with other metrics available in the Top SQL tab of Performance Analysis to identify and target problem
areas. Each of the Top SQL reports group the Top SQL data by its respective category name.

Report

Description
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Report

Description

- By User

- By Database
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Report

Description

- By Application

- By Server

- All Servers

Blocking
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The Blocking reports provide a summary of blocking data over the given time range. They are designed to
aggregate by blocking query, blocked query, and wait resource for the selected time frame. Use this data
along with other blocking-level metrics available in the Blocking SQL tab of Performance Analysis to
identify and target problem areas.

Report

Description

- By Application

- By Application
Matrix

- By User
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Report

Description

- By SQL Server

- By Wait
Resource

- By Wait Type

Deadlocks
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The Deadlocks report provides information regarding Deadlocks in various ways over a specified time range.
When used in conjunction with the Deadlocks tab in Performance Analysis, these reports can help track
down problematic Deadlocks.

Report

Description

- By Application

- By Application Matrix

- By Resource
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Report

Description

- By SQL Server

- By User

Fragmentation Manager

Reports

Descriptions

Index
Defragmentation
Details - By
Database

The Index Defragmentation Details
report provides a summary of the
defragmentation details for the indexes in
your environment. Defragmentation
metrics provided include fragmentation
percentages, defrag method,
fragmentation percentage post defrag,
and start/end times.

Screenshots

1651

Reports

Descriptions

Index
Fragmentation And
Usage

The Index Fragmentation and Usage
report provides a graphical representation
of the overall fragmentation, disk space
usage, and buffer usage of the indexes in
your environment.

Screenshots

General Reports

Report

Description

Action
Counts

The Action Counts report provides a count,
broken down by object and parent object, of
actions that have taken place during the selected
time range. This report gives you valuable
information for adjusting alerts in your
environment. Use the Action Counts report to
quickly identify where the alerts in your
environment are coming from, and then make
adjustments as needed.

Screenshots
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Report

Description

Active
Settings List

The Active Settings List report provides details
on every setting configured in your environment
at all levels combined into one resource. This
report gives you valuable information about how
settings are effecting your configured actions
and collection settings.

Configured
Actions List

The Configured Actions List report provides a
list on every action that's configured for a given
condition, specifying at what level the action's
configured.

Configured
Notification
List

The Configured Notification List report allows
you to view all conditions that are specifically
configured to send notifications by email or
pager.

Downtime By Server

The Downtime - By Server report provides a
listing of all server downtime activity for the
specified time range. Included in the reports are
metrics such as total incidents, total downtime in
seconds, average downtime per incident, uptime
percentage, and first/last incident times.

Screenshots
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SQL Sentry Forecasting
Last Modified on 29 December 2021

Overview

Disk Forecasting uses advanced predictive analytics and machine learning technology to show you when you'll
run out of storage space and predict how much space you'll need going forward.

 For more information about storage forecasting in SQL Sentry, please see the follow blog posts:
Introducing Storage Forecasting with SQL Server Machine Learning Services provides details around
the forecasting methods as well as accessing and customizing features.
Storage Forecasting and Machine Learning with SQL Sentry discusses the conceptual details of the
design and development behind SQL Sentry storage forecasting.

Available Disk Forecasting Methods
Standard
Standard forecasts use an enhanced linear regression algorithm. It's able to analyze your disk’s
usage history, identify manual interventions such as someone truncating or deleting a large file to
free space, and ensures those events don’t skew your forecast.
Advanced
Advanced forecasts learn from the workload on your storage volumes and use R/ML Services (InDatabase) on the SQL Server hosting the SQL Sentry database.
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Getting Started
Follow these steps to configure your SQL Server (hosting the SQL Sentry database) and SQL Sentry client to
use storage forecasting:
1. Verify SQL Server requirements and configure environment as needed
2. Configure SQL Sentry monitoring service settings
Once your environment has been configured, you'll need to wait at least 24 hours to have disk forecasting
data available. Then you'll be able to use the following features with disk forecasting:
Disk Space Analysis view
Advisory conditions for disk forecasting
The Windows Disk Forecasting report

Step 1. Requirements & Configuration
Disk Forecasting
Mode

Additional Requirements

Standard

There are no additional requirements for Standard Disk Forecasting. You can
proceed to Step 2 to configure the monitoring service settings.
The Advanced Disk Forecasting feature requires:

Advanced

1. A SQL Sentry database on SQL Server 2016 or later with R/ML Services
in-Database enabled.
2. You must turn on the external scripts enabled option in SQL Server for
the instance hosting the SQL Sentry database.
Instructions are provided below. If needed, see the External
Scripts Enabled server configuration option article in Microsoft
Docs for additional help on setting that option.
3. The SQL Server Launchpad service must also be running before using
Advanced Disk Forecasting.
Instructions for checking this are provided below. If needed, see
the SQL Server Launchpad service configuration article from
Microsoft Docs for more information.
 Note: If any of the above features or settings were not in place, you
should restart the SQL Sentry client after setting them, then select the
Advanced Disk Forecasting mode in Monitoring Service Settings as described
in the Settings section of this article.

 Important:
If you are configuring Advanced Disk Forecasting on SQL Server 2019, you may run into installation errors
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during package installation due to changes in how SQL Server 2019 handles permissions. To configure
Advanced Disk Forecasting on SQL Server 2019, complete the following steps:
1. Create C:\ProgramData\Sentryone and C:\Users\Public\SentryOne folders.
2. Give the ALL APPLICATION PACKAGES user full control over the folders created in step 1.
3. Continue the package installation.

SQL Server Feature: R/ML Services
How do I know if the Advanced Analytics Extensions feature is installed?
If you're unsure about the installation status of the R/ML Services in-Database feature for your existing SQL
Server installation, you'll know for certain when you attempt to turn on the external scripts enabled option
and the following error appears:
Msg 39020, Level 16, State 1, Procedure sp_configure, Line 166 [Batch Start Line 0] Feature 'Advanced
Analytics Extensions' is not installed. Please consult Books Online for more information on this feature.

How do I install R/ML Services in Database (Advanced Analytics Extensions)?
Follow the instructions provided from the Install SQL Server 2016 R Services article on Microsoft Docs to add
this feature to your existing SQL Server installation.

SQL Server Configuration: External Scripts Enabled
How do I verify that external scripts enabled is turned on in SQL Server?
Check external scripts enabled by running:
EXECUTE sp_configure 'external scripts enabled'

In this example, the run_value is set to 0, meaning that external scripts enabled is false/turned off. If your
run_value is set to 1, then this feature is already enabled.

 Note: The config_value displays what the run_value will be the next time that SQL Server restarts. If
it is set to 0, then the feature will be disabled after a restart.

How do enable external scripts enabled in SQL Server?
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Execute the following to turn on external scripts enabled and reconfigure the SQL Server option:
sp_configure 'external scripts enabled', 1;
RECONFIGURE WITH OVERRIDE;

This is the success message:
Configuration option 'external scripts enabled' changed from 0 to 1. Run the RECONFIGURE statement to install.

At this point, the config_value is changed, but a restart is required to set the run_value.

Do I need to restart SQL Server to complete the process?
Yes, restart the SQL Server Instance to complete setting the run_value.

Additional Information: If needed, follow the instructions from Microsoft Docs to restart the database
engine.

Verify that the config_value and run_value are both set to 1. Check external scripts enabled by running:
EXECUTE sp_configure 'external scripts enabled'

How do I verify that SQL Server Launchpad is running?
Open the Services window to verify that MSSQLLaunchpad / SQL Server Launchpad (MSSQLSERVER) is
running:

Additional Information: If needed, see the Microsoft article for more details on verifying and testing a
successful installation.

1657

Step 2. Monitoring Service Settings
You have the option to select either Advanced or Standard mode.

Adding a Forecast Schedule
1. Select Global Settings in the Navigator pane, and then select Forecasts.

2. Select either Standard or Advanced from the Disk Forecasting drop-down menu.

3. Select the  to open the Select a Schedule window, and then select New to add a new Forecast
Schedule.
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4. Select the desired parameters from the Schedule Properties window, and then select OK to save your
schedule.

5. Select the number of days desired for the Days Forward to Forecast. The default is 180 days.
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6. Select the Save icon

to save the Disk Forecast.

Editing or Deleting a Forecast Schedule
Edit a Forecast Schedule by completing the following steps:
1. Open the Monitoring Service Settings (Navigator > Global Settings) and select the Forecasts tab.
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2. Select the  to open the Select a Schedule window, and then select Edit to change the Schedule
Properties parameters.

3. Select OK to close the save the changes, select the Save icon

, and then select Regenerate Global

Forecasts to refresh the Disk Forecast.

Deleting a Forecast Schedule
To delete a Forecast Schedule, complete the following steps:
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1. Open the Monitoring Service Settings ( Navigator > Global Settings) and select the Forecasts tab.
Select the  to open the Select a Schedule window. Select the desired Forecast Schedule from the list,
and then select Delete.

2. Select Yes to remove the Forecast Schedule from the list, or select No to keep the Forecast Schedule in
the list. Select OK in the Select a Schedule window to save your changes.

 Note: A Disk Forecast runs automatically each day even if there is no schedule selected. A Forecast
Schedule is applied to better control when the forecast runs.

Disk Space Analysis View
 Note: Disk space data is not generated until 24 hours after a Disk Forecast runs.

Select your desired target from the Navigator pane, and then select the Disk Space tab. Select the desired
Logical Drive, and the Disk Forecasting chart appears at the bottom of the screen. On the Disk Space chart a
tool tip displays with the Free Space and Forecasted Exhaustion Date.
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 Note: The cell under Forecasted Exhaustion will be highlighted orange if the Forecasted Exhaustion
date is within 180 days, and it will be red if it is within 90 days.

The Free Space chart displays the following parameters:

Free Space Chart
Parameters

Description

Disk Free Space

Amount of available (free) hard drive space on a given disk.

Prediction Interval

An estimated interval that represents the range of values that a future
observation will lie within at a specific point in time based on the provided
probability. The forecast is generated using a 70% prediction interval, so
there is a 70% probability that the actual free disk space on a given date will
fall within the forecasted prediction interval.

Forecasted Free Space

Estimated amount of Disk Free Space that will be available for a given disk
and date.

 Note:
The forecast displayed is out 180 days, but it can be scheduled for up to 3 years.
The length of the Disk Forecasting will impact the storage and accuracy of the data.
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Advisory Conditions
There are advisory conditions available (on GitHub) to work with storage forecasting:
Windows Volume Exhaustion Date Changed
Windows Volume Forecasted Exhaustion Within 90 Days

Reports
See the Windows Disk Forecast report available under Reports > Performance Analysis > Disk/File Space:

Additional Information: For more information about this report, see the Reports Menus article.
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SentryOne Power BI Content Pack for SQL Sentry
Last Modified on 18 May 2021

Unsupported: The SentryOne Power BI Content Pack for SQL Sentry is provided as-is and is intended as
a sample to get you started with reporting on the SQL Sentry database through Power BI. Once you have
it connected and configured, you can make changes as desired.

Desktop Configuration

Configuring the Power BI Content Pack
The following steps walk through downloading, opening, and configuring the SentryOne Power BI Content
Pack through Power BI Desktop.

 Note: The SentryOne Power BI Content Pack connects to directly to your SQL Sentry database over
your local network.

1.  Download: Get a copy of the SentryOne Content Pack PBIX file.
2. Open the PBIX file with Power BI Desktop:

3. Select Home -> Edit Queries -> Edit Parameters:
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4. Update the Database and ServerInstance parameters to reflect your SQL Sentry database and
server\instance name, then select OK:

5. After selecting OK, a banner appears prompting you to apply the changes. Select Apply Changes:

6. Select File -> Options and Settings -> Options:
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7. Select Security, then deselect Require user approval for new native database queries under Native
Database Queries.

 Important: You will receive a series of prompts for each query if you do not deselect Require
user approval for new native database queries.

 Success: You are now ready to use the SentryOne Power BI Content Pack with Power BI Desktop!

Using the Content Pack
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Using the Content Pack
Server Health Overview
The Server Health Overview page provides a high-level view of the overall health and events across your
monitored environment. There are metric cards to show the total number of monitored servers, critical
events, and high events.

Default view

CPU Events Selected

Server Health by Alert Level
The alert level is derived from the number and severity of conditions that are triggered in your monitored
environment. Relative scores are calculated and your monitored targets are divided into 5 alert levels, with 5
being the most severe. Within the alert level, servers are ranked from highest overall score to lowest overall
score. As you view the treemap, your targets with the highest number and overall severity appear to the
upper left in the Level 5 grouping.

 Note:
Use the Alert Level checkboxes to filter all the cards on this page to the selected levels.
You have the ability to filter the page by other values by selecting them within a chart. For
example, the image on the right shows that CPU has been selected from the Events Count by
Category chart and all charts are updated to reflect the selection of CPU events. Select a day or
server on the page to explore how these filters work.

Event Counts by Category
This shows a stacked column chart of the total number of events per monitored target, with the stacks
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representing the event categories (e.g. CPU, Memory, or Other).

Event Count by Day
This stacked column chart displays the total count of events by day for all monitored targets. It will show
highlighted stacks if you select a category, server, or alert level.

Server Health Events
The Server Health Events page provides insight into the events used to calculate the overall server health.
This page includes a filter for alert level, as well as metric cards for the total number of servers, number of
servers with an alert level of 5, and the total number of events.

Default view

High Compiles and Level 5 selected

Events Count by Condition
A stacked column chart of the total count of conditions (events) per monitored target, stacked by the
condition name (e.g. High Compiles , High Recompiles , etc.).

Events Count by Severity
A stacked column chart of the total count of conditions (events) per monitored target, stacked by the severity
level (high , medium, or low).

Event Counts
A table of the total counts for each condition (event) across the monitored environment.

Server Availability
The Server Availability page provides charts related to downtime and uptime. There is a slicer to divide
between >= 99.9 & < 99.99% or < 99.9% as well as metric cards for the total number of servers, servers with <
99.9999% uptime, and the average number of downtime minutes.
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Default view

Filtered by < 99.9% on the Uptime slicer

Downtime Minutes vs Incidents
This scatter chart plots the servers based on the total downtime minutes on the x-axis vs the total number of
incidents (events) on the y-axis. The size of the dot indicates the alert level, with 5 being the largest dot.

Uptime % vs Downtime %
This 100% stacked bar chart depicts the relative amount of downtime to uptime percentage by server for all
servers which have had less than the standard SLA amount of 99.999% uptime.

Downtime in Minutes
A bar chart to display the total number of downtime minutes per server, ordered by most to least minutes
(left to right).

Server Health - Memory & CPU
The Server Health - Memory & CPU page provides insight into which servers are suffering from events that
may be reduced by increasing available memory or number of CPUs, or finding servers with workloads in need
of performance-tuning to reduce memory or CPU requirements. The page includes an alert level filter as well
as metric cards for number of servers, critical events, high events, and total events.

1670

Filtered by server QW60S86-105A
Default view

Memory Events by Server
This scatter chart displays dots for each server with the number of memory-related events that have occurred
on the x-axis and the amount of available memory on the y-axis. The size of the dot indicates the alert level
for that server, with 5 being the largest dot.

Available Memory by Server
A pie chart to show how many servers are in each range of of available memory. In the default view example,
there are 2 servers with 0-16 GB of available memory (16.67% of all monitored servers) and 10 servers with

16-32 GB of available memory (83.33% of all monitored servers).

CPU Events by Server
This scatter chart displays dots for each server with the number of CPUs on the y-axis and the number of
triggered CPU-related events on the x-axis. The size of the dot indicates the alert level for that server, with 5
being the largest dot.

CPUs by Server
A pie chart to show how many servers grouped by number of CPUs. In the default view example, 1 server has
8 CPUs (8.33%), 4 servers have 4 CPUs (33.33%), and 7 servers have 2 CPUs (58.33%).
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Disk Space
The Disk Space page provides insight into the remaining free space on monitored servers. There are filters
for the free space ranges (<= 10% , > 10 & <= 40% , > 40 & <= 70% , and > 70% ) and the drives (C: vs. all other
drives). Metric cards are included for the total number of servers as well as the number of disks with < 10%
free space remaining.

Default view

Filtered by <= 10% and C:

Least Free Space GB
A stacked column chart displaying the 10 drives with the least amount of free space available in GB. The disks
are ordered from fewest GB of space remaining to the greatest.

Disks by Free Space Range
This pie chart displays the percentage of servers in each free space range. In the default view example, there
are 3 servers (17.65%) in the < 10% free space range, 6 servers (35.29%) in the > 10 & < 40% range, 5 servers
(29.42%) in the > 40 & <= 70% range, and 3 servers (17.65%) in the > 70% range.

Lowest Free Space %
A stacked column chart displaying the 10 drives with the least amount of free space available by percentage.
The drives are ordered from lowest percentage remaining to greatest.

Most Free Space GB
A stacked column chart of drives with the most free space in GB. The drives are ordered from greatest free
space in GB to least.
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Tableau Report Pack for SQL Sentry
Last Modified on 18 May 2021

Additional Information: Tableau Report Pack for SQL Sentry Monitoring Is Now Available!

The Tableau Report Pack for SentryOne Monitoring allows you to view and analyze SQL Sentry monitoring
data with Tableau visualizations. The file contains a free set of reports to get you started. Remember, you can
also mine the SQL Sentry database for additional reports you may need. For more information on that, see our
Mining Performance Data from SQL Sentry blog series.

Install the Tableau Report Pack
 Download: Tableau Report Pack for SQL Sentry Monitoring

1. Unzip the file: Tableau Report Pack for SentryOne Monitoring.twb
2. Open the Tableau workbook file.
3. Accept the custom SQL prompt.
4. Enter the connection information (server name and database name) for your SQL Sentry database.
5. When you click another tab, you will be prompted again for the connection information.  Note: It asks
twice because the first connection brings in server health data and the second pulls in disk data.
6. Run the reports.
7. Deploy to Tableau Server.  Note: This step is optional.
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Getting Started: SQL Sentry Platform on AWS
Last Modified on 05 January 2022

 Download: The SQL Sentry platform solution is available on the AWS Marketplace.

 Note: For information about Elastic Compute Cloud (EC2) Monitoring Through SQL Sentry, see the
AWS EC2 article.

Support
For support, please visit support.sentryone.com
This PDF outlines our Support SLA. Support costs are explained on the Perpetual License & Subscription
Options page.

 Note: Support is available during the free trial period. Please contact us should you need any
assistance with the installation and onboarding, or have any other questions during your SQL Sentry
evaluation.

Licensing
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For information on licensing, annual maintenance, and subscription costs of the SQL Sentry platform
software, please visit our Perpetual License & Subscription Options page. We offer the option to bring your
own license (BYOL) or request a trial inside the application when it starts up in your installation.
See the License Management article for a license overview, instructions on applying a new license, solutions
to common licensing errors, and tips on hosting the SQL Sentry database on an availability group.

Costs
Total costs for deploying and running the SQL Sentry platform solution on AWS will depend on a number of
factors such as the size of the required EC2 VM and configured data storage, as well as the bandwidth of
accessing the targets and SQL Sentry components.
The SQL Sentry database server recommended specifications section of the Installation Recommendations
article provides guidance for required storage space with the SQL Sentry platform solution. See the Data
Capacity Planning article for additional information.
See the Amazon EBS Pricing topic from AWS documentation for information and calculators EBS Volumes
Pricing. See EC2 Pricing from AWS documentation for more information on the VM costs.
Total bandwidth and costs are dependent on how many targets are being watched and which regions the
targets reside. If you have the SQL Sentry monitoring service running EC2 instances or RDS for SQL Server in
other regions there will be bandwidth costs for egress from the other regions. Due to egress costs,
SolarWinds recommends placing a SQL Sentry database in each region.
See the Licensing section above for additional SQL Sentry costs.

Additional Services
SolarWinds offers professional services as an option. If you have any interest in this, please contact us.

Architecture
See the SQL Sentry Components and Architecture article for more information on the SQL Sentry solution.
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SentryOne on AWS Architecture Diagram

 Note: All collected customer data is stored in the SQL Sentry database on the EC machine in which
the marketplace installed. The SQL Sentry database encrypts and stores supplied credentials for the
connection strings for all watched targets.

Sizing
See the recommended and example EC2 Classes for the SQL Sentry database on the Installation
Recommendations article and select the appropriate Amazon EC2 Instance Type for your environment
and usage needs.
See the AWS Service Limits topic in AWS documentation for the default limits in an AWS account.
The SQL Sentry platform solution on AWS does not have any managed AWS services (e.g. RDS,
DynamoDB, RedShift).

System Requirements & Prerequisites
An AWS account is required in order to deploy the image into your subscription.
It is not necessary to have access to the AWS Account's root credentials.
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You should be familiar with creating virtual machines in EC2 and handling networking and security
groups before getting started.
See the System Requirements article for SQL Sentry requirements.
You should be familiar with SQL Sentry software to begin using it in your environment. Please see our
documentation or free training courses to get started.
Any Amazon RDS for SQL Server instances that will be monitored must be associated with a security
group that allows access from the EC2 instance running SQL Sentry. This can be completed via direct IP
addresses configuration, or the full VPC that will contain the EC2 instance running SQL Sentry. For more
information see the Amazon AWS documentation regarding Security Group Considerations.

Deployment
How long should I expect the deployment to take?
The deployment process should not take longer than ten minutes to complete.

What does the deployment include?
After the solution is deployed in Amazon AWS, you will have an EC2 instance with SQL Server Standard
installed, along with the SQL Sentry Platform software, which currently includes:
Specific products based on the license entered
Plan Explorer

 Note: Only an EC2 instance is deployed as part of this solution.

Does deployment involve more than a single element (e.g. launching an
EC2 node with a partner AMI)?
No, this does not apply to our solution.

Which AWS products integrate with SQL Sentry?
SQL Sentry monitors AWS RDS for SQL Server .
SQL Sentry uses EC2 instances and EBS volumes as part of the AWS solution.

Launching SQL Sentry and Onboarding
1. RDP to the EC2 instance that contains the SQL Sentry image you have created.
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See Connecting to Your Windows Instance from Amazon for additional RDP instructions.
2. Launch the SQL Sentry client from the Desktop icon.
3. The Onboarding process begins when the client launches.
Onboarding allows you to apply your license, set up alerts, enable your email server, configure
notifications for Advisory Conditions, and set up the SQL Sentry Portal.
Follow all instructions on the screen.
Visit the Onboarding article for additional information on the steps.
4. You must apply a license or retrieve an evaluation license through the on-demand license feature.
5. Once Onboarding completes, you are ready to add new targets and instances to watch, including your
AWS RDS targets.
6. Select where to add your target.
We’ll use Amazon RDS for SQL Server as the target type and Default Site in the Navigator for this
example.
See the Adding an AWS RDS for SQL Server Target topic for step-by-step instructions and a visual
guide.
7. Right-click Default Site > Add > Amazon RDS for SQL Server as the target type.
8. Enter your AWS RDS target information to connect via the Add Target screen.
9. Your target will now appear on the SQL Sentry Navigator node.
10. You may install the client on additional machines (with proper access to your environment) without the
need for additional licenses.
11. View the Getting Started section for SQL Sentry to learn more about using the SQL Sentry platform.

 Note: Each RDS for SQL Server Instance counts as an instance of SQL Server and consumes one SQL
Sentry license.

Additional Installation Items
Depending on your environment, you may need additional SQL Sentry monitoring services or wish to install
the SQL Sentry client on additional machines. See the Installation Recommendations article for guidance on
the suggested number of monitoring services as well as machine sizing and selection.

 Note: The SQL Sentry installation file is available on the image in the following location:

C:\SentryOneInstall\SentryOneSetup-x64.exe
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Copy the executable to the EC2 instances where you will install additional SQL Sentry monitoring
services or clients.

Review the Installation article for instructions on installing additional SQL Sentry monitoring services or the
SQL Sentry client on additional machines.
Refer to the AWS Elastic Compute Cloud (EC2) article for step-by-step instructions on setting up a new
machine for the SQL Sentry monitoring service or client.
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AWS Security
Last Modified on 05 January 2022

Additional Information: See the Security Guidance topic from AWS for current best practices in
securing your AWS resources.

Security Overview
For information on security of the SQL Sentry platform solution, please see the SQL Sentry Security section.

Security Questions
Are there any requirements for using root credentials for access?
No, this is not necessary for the SQL Sentry solution on AWS.
See the AWS documentation topic on The AWS Account Root User for more information.

How are all IAM policies, S3 bucket policies, and other security policies (e.g. SQS, SNS, etc.) vetted
to ensure that there is no unintended exposure of sensitive data to the public?
We do not create any of these policies as part of our deployment.

Are there any resources that are intentionally publicly available?
The EC2 image is created with RDP ports open so that you may access the image.

How do I create IAM Roles and Policies that are scoped down for minimal access?
We do not create any of these roles or policies as part of our deployment.
See the Examples of Policies for Delegating Access and Identities (Users, Groups, and Roles) topics in
AWS documentation for more information.

How do I authenticate with AWS using IAM user credentials or roles?
The VM created as part of the SQL Sentry offering can be secured using IAM like any other EC2 machine.
See the What is IAM? topic from AWS documentation for more information.

Are there any keys, secrets, or rotation policies used in this deployment?
We do not create any of these keys, secrets, or rotation policies as part of our deployment.
See the Working with Keys and What is AWS Key Management Service? topics in AWS documentation
for more information.
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How do I manage VPNs when using AWS?
See the VPN Connections topic in AWS documentation for more information.
Put the SQL Sentry components into a VPN that can see the targets you need to monitor.

How do I set my connection to trust server certificates?
See the Advanced Properties section of the Connecting to an Installation article for instructions on
trusting server certificates.

How do I encrypt the network traffic between the SQL Sentry components?
See the Advanced Properties section of the Connecting to an Installation article for instructions on
encrypting the network traffic.

How do I create EC2 security groups and VPC access control lists?
We do not create any of these groups or lists as part of our deployment.
See the Security Groups for Your VPC and Network Access Control Lists topics in AWS documentation
for more information.
Any Amazon RDS for SQL Server instances that will be monitored must be associated with a security
group that allows access from the EC2 instance running SQL Sentry. This can be completed via direct IP
addresses configuration, or the full VPC that will contain the EC2 instance running the SQL Sentry. For
more information see the Amazon AWS documentation regarding Security Group Considerations.

How do I perform any necessary data encryption configuration (e.g. S3 SSE, EBS encryption, LUKS,
etc.)?
This is not necessary as we do not create any of these as part of our deployment.
For information on applying SQL Server data encryption methods, see the SQL Server Encryption topic at
Microsoft Docs.
This includes guidance on choosing an encryption algorithm, Transparent Data Encryption (TDE),
SQL Server database encryption keys, Always Encrypted, SQL Server certificates and asymmetric
keys, and more.

How do I create any necessary risk audit mechanism (e.g. CloudTrail, S3 Access Logs)?
This is not necessary as we do not create any of these as part of our deployment.
See the AWS Risk and Compliance Overview PDF from AWS for more information on this topic.

How do I tag resources?
See the AWS topic on Working with Tag Editor to learn about tagging via the console and the AWS
Tagging Strategies topic for additional guidance and best practices on applying tags.
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What do I need to know about the purposes of IAM Roles and IAM Policies created for this
solution?
We do not create any of these as part of the SQL Sentry solution.
For more information on IAM Roles and IAM Policies in general, see the IAM Roles topic in AWS
documentation.

How do I change the Monitoring Service Logon Account credentials?
Refer to the Monitoring Service Logon Account article for information on using the Service
Configuration Utility to update the stored credentials of the SQL Sentry monitoring service.
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AWS Availability and Maintenance
Last Modified on 05 January 2022

Availability
How do I ensure maximum uptime and reliability for the SQL Sentry AWS
solution?
Ensure you are following the recommended SQL Sentry database maintenance.
Follow Best Practices for Amazon EC2 .
Include the SQL Sentry database in your existing disaster recovery plans.
Consider installing an additional monitoring service.
See the Monitoring Service Load Balancing article for additional information.
Consider using availability groups.
Monitor the SQL Sentry database server and other replica(s).
You should monitor the SQL Sentry database server with SQL Sentry.
The first SQL Sentry database is included for free.
Refer to our documentation on License Management and Installation Recommendations for more
information.
The SQL Sentry software is not Region and Availability Zone aware.
Refer to AWS documentation on Regions and Availability Zones for additional information on
these topics.

Additional Information:
Adding the SQL Sentry Database to an Availability Group
Configure a SQL Server Always On Availability Group (AWS documentation)
Test the Cluster and Availability Group (AWS documentation)
Amazon RDS for SQL Server Now Supports Always On Availability Groups (AWS documentation)
Using Windows Server Failover Clustering (WSFC) and SQL Server Always On Availability Groups
(AWS documentation)

Health Checks
How do I know if the SQL Sentry monitoring system has an issue?
There are Failsafe Error Conditions which check for errors related to the SQL Sentry monitoring service.
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There are many Failsafe Conditions available for the monitoring service including SQL Sentry
Database Offline, Performance Collection Failed, Send Heartbeat Error, Synchronization Error, and
more.
See the Failsafe Conditions article for details and a complete list of available conditions.
Check the Monitoring Services List to view the status of a SQL Sentry monitoring service.

How do I detect server security certificate expiration?
While we do not create certificates by default, you have the option to use them in the Connection
screen. Please see the Connecting to an Installation article for additional information on this option.
For AWS-specific information, please see the Working with Server Certificates topic which includes a
command to retrieve the expiration date.

How do I detect storage capacity issues?
SQL Sentry contains storage-related Advisory Conditions (SQL File Auto-growth Disabled, SQL File Autogrowth Exceeds Free Space, Windows Volume Exhaustion Date Changed, and Windows Volume
Forecasted Exhaustion Within 90 Days included out-of-box) to create Alerts for storage-related
conditions.
The Disk Space tab in Performance Analysis contains information about disk space utilization within your
environment.
The Disk Forecasting feature on the Disk Space tab provides advanced insights into future storage
capacity needs.
See the Introducing Storage Forecasting with SQL Server Machine Learning Services blog post for
additional details.

How do I integrate CloudWatch with SQL Sentry?
CloudWatch may be used to monitor the EC2 instance; however, we do not directly integrate with
CloudWatch at this time.

Additional Information: See the Amazon CloudWatch documentation for details on monitoring your
AWS resources and applications.

Backup and Recovery
What do I need to know about backing up the SQL Sentry database?
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You should follow a regular backup schedule of the SQL Sentry database.
Incorporate the SQL Sentry database into your existing backup and recovery strategy to meet your
business requirements.
Refer to the Microsoft documentation for a complete overview of SQL Server Backups.

Additional Information: When monitoring the SQL Sentry database with SQL Sentry, you should build
a custom event view to see all backup failures.

Routine Maintenance
How do I know when a new build of SQL Sentry software is available?
As noted in the Upgrading SQL Sentry article, the SQL Sentry client notifies you when an update is
available, if the client has internet access.
See the Latest Builds of SQL Sentry Software page for the Latest Version number as well as the Change
List.

How do I upgrade the SQL Sentry software?
See the Upgrading SQL Sentry article for step-by-step instructions.

What type of Maintenance is recommended for SQL Sentry?
See the SQL Sentry Database Maintenance article for information on weekly and nightly maintenance
recommendations concerning index rebuilds, database integrity checks, index defragmentation, and
configuring the SQL Sentry database maintenance window.
For information about SQL Sentry database growth, see the Data Capacity Planning article.

Emergency Maintenance
There is a possibility of data loss in the SQL Sentry database if the system goes down. Follow best practices
for backups and recovery to minimize potential data loss in an emergency situation.
Remember to check the current AWS status through the Service Health Dashboard.
Use the AWS Personal Health Dashboard for a personalized view of service health, events, proactive
notifications, detailed troubleshooting guidance, and more.
The SQL Sentry AWS solution uses EBS storage and EC2 — check the status page for those items.
Follow Amazon EC2 Best Practices to prepare for successful failover if you need to replace an EC2
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instance.
Amazon EBS Snapshots
Amazon Machine Images (AMI)

Additional Information:
Troubleshooting Amazon Relational Database Services (RDS) (AWS documentation)
Amazon EC2 Troubleshooting Windows Instances (AWS documentation)
Amazon EC2 Troubleshooting Linux Instances (AWS documentation)

 Important: Should the system go down, it's important to ensure all services are running correctly
once it is back up. SQL Server may have stopped, ensure it has restarted on the SQL Sentry database
server. Different components may come back online in an unexpected order. You should restart all SQL
Sentry monitoring services to confirm that there are good connections and everything is running fully.
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AWS RDS for SQL Server
Last Modified on 05 January 2022

 Download: The SQL Sentry platform solution is available on the AWS Marketplace.
Additional Information: See the Getting Started article for important deployment information.

Since the 18.4 release of SQL Sentry, we offer support for monitoring AWS RDS for SQL Server . RDS for SQL
Server is a fully hosted SQL Server instance, letting you focus on just the data and code within the database
and not the hosting or caring of the underlying infrastructure. For more information about RDS for SQL
Server, see the AWS documentation.

SQL Sentry AWS RDS for SQL Server Overview
Dashboard
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Monitor waits, backups, transactions, latency along with other performance metrics in the Performance
Analysis Dashboard. View Deadlocks, Top SQL, Index usage and, support RDS for SQL Server targets for our
Advisory Conditions engine.

Advisory Conditions
The addition of SQL Sentry Advisory Conditions for SQL Server on RDS removes lingering concerns for
performance management and process automation. Quickly define logic for a limitless array of automated
performance tests, and take action ranging from sending an email to executing PowerShell commands in
response to these tests. For more information about Advisory Conditions, see the Advisory Conditions topic.

Adding an AWS RDS for SQL Server Target
To add an AWS RDS for SQL Server target, install the latest release of SQL Sentry (v18.4+) from the Customer
portal. For more information about installing the newest version of SQL Sentry, see the Upgrading SQL Sentry
topic.

 Note:
The credentials provided for an AWS RDS for SQL Server target must be the Master User Account
created for Amazon RDS for SQL Server so that full access is available for monitoring.
The Amazon RDS for SQL Server instances must be reachable by the EC2 instance running the SQL
Sentry platform software. Ensure that the database instance is accessible via a related security
group on the database instance. For more information see the Amazon AWS documentation
regarding Security Group Considerations.
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Right-click the desired site in the Navigator, and then select Add > Amazon RDS for SQL as the target type.

Next, complete the target information on the Add Amazon RDS for SQL Server Target screen.
1. Enter the Fully Qualified Domain Name (FQDN) of the RDS target.
2. Enter Credentials to monitor the RDS target.
3. Select Connect to test feature availability and the connection.
4. Wait for the green dot on Monitoring Service Available.
5. Select Next to complete the process of adding an RDS target.
1. See the Adding Targets and Instances to Watch topic if additional information is needed.
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 Success: After adding your Amazon RDS target, it's available to select in the Navigator pane.
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 Note: This is only a guide to adding an RDS target. For complete information on using SQL Sentry,
continue with the SQL Sentry section.
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AWS Elastic Compute Cloud
Last Modified on 05 January 2022

 Download: The SQL Sentry platform solution is available on the AWS Marketplace so that you do not
have to manually install it. See the Getting Started with SQL Sentry on AWS article for more information.
 Note: If you want to manually install our software, please follow the instructions below.

Elastic Compute Cloud (EC2) Monitoring Through SQL
Sentry
Amazon Elastic Compute Cloud (AWS EC2) provides web-scale cloud computing with secure, resizable
compute capacity in the cloud. Host SQL Sentry on EC2, and monitor EC2 instances by completing the
following steps:

Step One Spinning up your EC2 instances
Spin up an instance that will be hosting the SQL Sentry components and a target instance to monitor:
1. Select Launch a virtual machine with EC2, and then select advanced EC2 Launch Instance wizard link.

EC2 Launch a virtual machine
EC2 advanced Launch instance wizard

2. Select an Amazon Machine Image (AMI) in the advanced EC2 Launch Wizard. Select your instance type,
and then select Review and Launch.

EC2 select AMI
Review and Launch

3. Edit the security group as shown in the following image. Select Review and Launch, and then select
Launch.
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 Note: You can edit this security group later to lock down access to specific IP addresses.

4. Select Create a new key pair from the drop-down list and give it a name. Select Download Key Pair,
select Launch Instances, and then select View Instances on the next screen.

5. Right click on your instance and select Connect. Select Get a Password in the Connect to your Instance
window.

Connect to your instance

Get a password

6. Find the key pair that you downloaded earlier, and then select Decrypt Password.
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7. Copy your password and select Download Remote Desktop File.

8. Connect and log into your new instance.

 Note: Repeat these steps for each EC2 instance. To launch an EC2 instance to be monitored, select
Launch Instance from the EC2 screen.

Step Two Preparing for installation of SQL Sentry
1. Right click on the Windows button and select Computer Management.
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2. Select the Users folder and then select Add New User from the context menu.

3. Enter the appropriate information for your user, select Password never expires, and then select Create
to create your user.
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4. Add the account as a member of the Windows Administrators Group.

5. Add the account with the required permissions (as listed in the Monitoring Service Security article) for
the SQL Server instance.

6. Change the server properties to set security to SQL Server and Windows Authentication mode, and then
restart the SQL Server Service.
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Step Three Completing the SQL Sentry installation
Install the latest version of SQL Sentry onto your workspace. For more information about installing SQL
Sentry, see the Installation, and Onboarding topics.

Step Four Successfully monitoring additional EC2
instances
Add additional EC2 instances to your environment as desired. For more information about installing
additional instances with SQL Sentry see the Monitoring Additional Targets topic.

1697

1698

